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Welcome
Welcome to the System Configuration Tool (SCT) Help. This help file contains information on how to
use the SCT user interface software. This section provides links to the major sections of the help file.
It also provides an overview of SCT, its modes, and its access types.

Note: Throughout this help file, the term SMP refers to the user interface of the online
Metasys engines and servers as well as the offline SCT, unless otherwise indicated.

Summary of changes
The following information is new or revised for SCT Release 14.2:

• Updated Equipment Definition Object Attributes to include the Category column to the
Equipment Definition Tab.

• Updated SCT Troubleshooting to document how SCT fails when sending Activate Pending Files
to an IP controller.

• Added a note to state that it is not supported to add an ADS, ADX, OAS, or ODS server to report
to another ADS, ADX, OAS, or ODS server in SCT. See Adding a Metasys Server (ADS/ADX/OAS/
ODS) to an Archive Database.

• Documented workaround for when you cannot use trunk utilities on an IP controller. See SCT
Troubleshooting.

• Added new controllers to the list of devices that you can configure in CCT. See Controller
Configuration Tool (CCT).

Related documentation
Table 1: SCT related documentation
For Information On See Document
SCT features, benefits, and requirements System Configuration Tool Catalog Page

(LIT-1900198)
SCT installation and upgrade SCT Installation and Upgrade Instructions

(LIT-12012067)
Licensing SCT and field controller packages Software Manager Help (LIT-12012389)
Daily use of the Metasys system, and database
backup/restore

Metasys Site Management Portal Help
(LIT-1201793)

Daily use of the Metasys ODS system, and
database backup/restore

Open Data Server Help (LIT-12011942)

SCT interaction with the ADS/ADX ADS/ADX Commissioning Guide (LIT-1201645)
SCT interaction with the ODS ODS Commissioning Guide (LIT-12011944)
SCT interaction with the NAE/NIE NAE Commissioning Guide (LIT-1201519)
SCT interaction with the NIEx9 NIEx9 Commissioning Guide (LIT-12011922)
Backing up and restoring driver and license files
before updating the NIEx9 image

NIEx9 Driver Manager Application Note
(LIT-12011919)

Adding users and roles to the system Security Administrator System Technical Bulletin
(LIT-1201528)

Configuring the ADS/ADX as a trusted server
with https

Metasys Server Installation and Upgrade
Instructions (LIT-12012162)
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Table 1: SCT related documentation
For Information On See Document
General network and information technology
concepts

Network and IT Guidance Technical Bulletin
(LIT-12011279)

Metasys configuration Metasys System Configuration Guide
(LIT-12011832)

Metasys system Metasys System Extended Architecture Overview
Technical Bulletin (LIT-1201527)

uLearn training videos
uLearn training videos are available to anyone who wants to learn about how to use Johnson
Controls® products, including Metasys software and tools such as SCT and SCT Pro. Customers
can access these videos at this link: https://jcpublic.kzoplatform.com/library. Johnson Controls
employees can find the videos at this link: https://jc.kzoplatform.com/library.
When you browse to the uLearn site, use the All Content tab or use the Search box to find what
products you want to learn about.

SCT and supervisory device package licensing
With SCT Release 14.1, you require supervisory device package files that you need to import
then license using the Software Manager, an application that is installed with SCT. For further
information on software licensing, refer to the Software Manager Help (LIT-12012389).
SCT now extends its functionality for supervisory devices across two brands, Metasys and Facility
Explorer (FX). Use the Metasys Device Packages for Metasys supervisory devices and use the FX
Device packages for the FX supervisory devices. Once you obtain the supervisory device package,
import the package by double-clicking on the package collection file or use the Package Importer,
located in the Start menu. The Package Importer displays the message Finished importing
when the import completes.
To license SCT software and supervisory packages, open the Software Manager from the Start
menu. To add a license, click Add License and then choose an activation method, either: Online
with a Product Key, or Offline with a License Activation File. Once added, SCT software and
supervisory device package licenses display in the License Inventory.
If SCT is licensed, the first time you open the application you must accept the End User License
Agreement before you can use SCT. If SCT is not licensed, the Software License Check displays
the following message: This software is currently unlicensed. Click the Open Software
Manager button to launch Software Manager and license SCT software.
If you do not license supervisory device packages, certain limitations occur:

• The transfer of CAFs to devices is disabled for unlicensed devices.
• Manage Archive operations are restricted through licensing. Upload, Download, Sync,

Upgrade, all are restricted.
SCT and SCT Pro block initiating unlicensed jobs in the UI, as well as block them on the server side.

System overview
The major components of the Metasys system are:
ADS/ADX:  The Application and Data Server (ADS) is a software package that you can use to
monitor and control the entire Metasys system. The ADS also serves as a long-term storage
device for alarm and event messages, trend data, and user transactions. For customers with large
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facilities, the Extended Application and Data Server (ADX) is available to provide extended user
access and historical data storage capabilities. You can use an ADS/ADX to access the user interface
and to serve as the location for user graphics. The ADS/ADX typically coordinates multiple user
access from web browsers to the network. Hereafter, the term Metasys Server applies to either the
ADS or the ADX.
You can also install the ADX in a split configuration with the ADX software/user interface on
one computer (the web/application server computer) and the historical trend data on another
computer (the database server computer).
ODS: The Open Data Server is a BTL-Listed BACnet Operator Workstation that conforms to the
B-OWS profile and is BTL-Certified in Europe. To differentiate between the user interface of an
ODS and ADS or OAS, the ODS UI window and minimized icon have green shading. Three ODS
configurations are available: BACnet Workstation, Site Manager Workstation, or a combination of
both.
The BACnet Workstation is a computer with an operator UI that you use to monitor and control the
Metasys or general BACnet system at your facility. In this configuration, BACnet communication
occurs directly between the ODS and the networked BACnet devices. BACnet integration maps in
NxEs to the ODS. NxEs are treated the same as BACnet devices. The BACnet Workstation does not
serve as a Site Director.
The Site Manager Workstation is a computer with an operator UI you use to monitor and control
the Metasys system at your facility. In this configuration, web services communicate to the
supervisory devices. The BACnet integration allows communication with BACnet devices. The ODS
serves as the Site Director.
In the combined configuration, the ODS serves as a Site Manager Workstation and a BACnet
Workstation. In this configuration, the NAE reports to the ODS as its Site Director and BACnet
devices can be directly mapped to the ODS through the BACnet integration.
OAS: The Open Application Server was introduced in Metasys Release 10.1. You can use an OAS
as the point of access into a building automation system (BAS) and to archive historical and
configuration data for a site. You can use an OAS as the supervisory device for 200 or fewer field
devices through BACnet/IP or Remote Field Bus protocols. As a Site Director, an OAS can also
support two child NxE or SNx devices. The OAS is an ideal solution to add the Metasys UI to an
engine-only site. Hereafter, the term Metasys Server also applies to the OAS.
Network Engine: The network engine is a family of devices that supervise lower-level field
controllers over the Metasys BAS. Network engines include the Network Automation Engines
(NAEs), Network Integration Engines (NIEs), Network Control Engines (NCEs), Series of Network
Controllers (SNCs), and Series of Network Engines (SNEs):

• The NAE and SNE are Ethernet-based supervisory engines that monitor and supervise
networks of field-level building automation devices that typically control HVAC equipment,
lighting, security, fire, and building access. The features of NAEs and SNEs include alarm and
event management, trending, archiving, energy management, scheduling, and password
protection through their embedded Site Management Portal. Different models and options
support various communications protocols, including BACnet® over IP, BACnet MS/TP,
Johnson Controls® N2 Bus, LonWorks, Modbus®, M-Bus, and KNX. The NAE55 and SNE2200x
Series support a comprehensive set of supervisory features and functions for large facilities
and technically advanced buildings and complexes. The NAE35, NAE45, SNE1050x, and
SNE1100x Series support the same features and functions of the NAE55 and SNE2200x engines,
but are designed for smaller buildings (or small areas of larger buildings) and enable the
wider distribution of supervisory functions in larger facilities. Lastly, the NAE85 supports large
BACnet/IP integrations with over 10,000 objects.
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• The secure NAE-S is a hardened, secure version of the standard Network Automation Engine
(NAE) 55 supervisory engine that uses embedded encryption technology to protect and secure
the building management system at the endpoint. The engine meets the Federal Information
Processing Standard (FIPS 140-2), Security Level 2, that specifies the use of a cryptographic
module and a tamper-proof housing. The engine is also Common Criteria certified.

• The NCE and SNC combine the network supervisor capabilities and IP network connectivity
of a network engine with the Input/Output (I/O) point connectivity and direct digital control
capabilities of a field controller. The NCE and SNC are a cost-effective solution designed for
central plants and large built-up air handler applications. All NCE and SNC models include
IP Ethernet network connectivity, the Site Management Portal, and the network supervisory
functions featured on network automation engines. Some NCE and SNC models include an
onboard display with keypad. The NCE and SNC support a wide variety of building networks
such as BACnet/IP, BACnet MS/TP, Johnson Controls N2 Bus, LonWorks, Modbus, M-Bus, and
KNX.

• The NIEx5 is an Ethernet-based, supervisory engine for integration of Metasys N1 Networks.
The NIEx5, which includes the NIE55 and NIE85, is a specialized version of the NAE and is
designed to provide for the migration of existing N1 networks into the Metasys system. The
NIEx5 has the same Site Management Portal as the NAE. Unlike the NAE, the NIEx5 does not
support integration of BACnet MS/TP or BACnet/IP, N2, and LonWorks networks. Two models
of the NIEx5 are available. The NIE55 supports smaller N1 networks, while the NIE85 supports
larger N1 integrations. The NIE55 and NIE85 engines were retired at Metasys system Release
9.0.

• The NIEx9 is an Ethernet-based, supervisory engine for integration of building control devices
that communicate over the Modbus®, MBus, or KNX protocol. The NIEx9 also communicates
over the BACnet MS/TP, BACnet/IP, N2, or LonWorks networks. This specialized version of the
NIE is designed to provide for the migration of these existing third-party networks into the
current generation Metasys system. The NIEx9 provides the same Site Management Portal UI
as the NAE or NIE. Several models are available: NIE29, NIE39, NIE49, NIE59, and NIE89. The
NIE29, NIE39, and NIE49 engines were retired at Metasys system Release 9.0.7.

SCT: You can use the System Configuration Tool in all phases of engineering, installing, and
commissioning of devices that make up the Metasys system. You can use the SCT offline to create
archive databases that can be downloaded to an Engine or Server. You can also use the SCT to
upload and archive databases that were created or edited online from an Engine or Server. With the
SCT, you can view and configure multiple sites in one archive.
SCT no longer requires the Site Director to be of an equivalent release version as the tool. You can
use the SCT also to maintain a variety of engines from Release 5.2 and later. The Site Director must
now be at an equivalent or greater release version than the highest versioned engine. For example,
if you have a 10.1 engine and an 8.0 engine in the archive, the Site Director needs to be at Release
10.1 or later.
The SCT has the same look and feel as the Engine and Server Site Management Portal.
Metasys system configuration requires that you define a single device as the Site Director. The Site
Director device may be a network engine or server, and its primary role is to coordinate multiple-
user access from the web browser to the network. If a Metasys server exists in the system, it is
defined as the Site Director automatically. When communicating directly to Metasys servers or
network engines, you are in the online mode. For information on the online and offline modes of
operation, see the mode section.

Note: In order to use HTTPS communications between Metasys SMP and SCT, you must have
SCT Release 11.1 or later, SMP Release 8.1 or later, and the latest version of Launcher installed.
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SCT Overview
SCT is used for offline configuration of Metasys system engines and Metasys server. The SCT assists
in all phases of engineering, installing, and commissioning of devices that make up the Metasys
system. The key features and functions that SCT provides include the following:

• The NAE/NIE Update Tool is bundled with SCT. When you install SCT, the NAE/NIE Update Tool
is also installed in the background. At SCT Release 13.0 or later, the tool is renamed to the
NAE Update Tool. To launch the NAE Update Tool, navigate to Start > Johnson Controls > NAE
Update Tool. The NAE Update Tool does not have a desktop icon and you cannot uninstall the
NAE Update Tool without also uninstalling SCT because the tool is bundled with SCT.

Note: From SCT Release 14.0, you can use SCT Pro in lieu of the NAE Update Tool because
all of the NAE Update tool functions are available in SCT Pro.

• SCT uses the same user interface format as the Site Management Portal UI. This similarity
makes the transition between online and offline access intuitive.

• SCT supports sites back to Release 5.2, except in cases where there are wireless supervisor
devices on the site.

• SCT creates and restores site archive backups. Site archives with supervisory controllers and
servers at Metasys Release 5.2 or later can be managed with SCT Release 10.0 and later.

• Multiple site archives can be managed in one local instance of SCT.
• SCT can fully manage a mixed-release site with supervisory devices at different versions. You

can add and manage supervisory devices at Metasys Release 5.2 and later.

Note: To perform a code download for site devices, you need to have the appropriate
release version of device's image stored on the SCT computer. The device being updated
through download must be at an equal or lower release than the Site Director.

• The Manage Archive function lets you upgrade a device from a previous release to a later
release. Once you upgrade a device, Manage Archive coordinates the upload, download,
upgrade, and synchronization of the devices on a site.

• As part of the upload function, SCT provides the ability to upload the Controller Application
Files (called .caf files) from field controllers attached to the supervisory device into the archive
database. The supervisory device must be at version 6.0 or later. During the upload process,
SCT creates or updates the Resource extension for the field controller.

• SCT provides import database and export archive database functions. These capabilities
eliminate the need for Tools for different Metasys releases at version 5.2 or later that were
created against different versions of Microsoft® SQL Server® software. SCT can import
archives that were created with any supported version of SQL Server software (that is, SQL-
independence). For archives created prior to Release 5.2, continue to use vTools as a resource
when working with Metasys systems. (Note that you should not use the export database
function as a substitute for backing up the archive database periodically.)

• SCT also provides a Site Discovery feature that lets you create the archive database from
an online system when the archive is not readily available or corrupt, the existing archive
is outdated, or the archive has not been maintained. For devices at Metasys Release 5.2 or
later, the Site Discovery feature creates the archive at the SCT release version and discovers
the devices as their physical device release version. For devices earlier than Release 5.2, the
devices are treated in the archive as 5.2 version devices.

• SCT can update the software disk image of a supervisory engine, offering a convenient
alternative to the NAE Update Tool. As a prerequisite to this option, the images of the
supervisory engines that you want to update must be stored on the SCT computer.
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• You can use SCT to download software patch files to NxE55-2, NxE55-3, and NIE59 supervisory
engines that are currently at Release 6.5 or later. The NxE55-0, NxE55-1, NxE3x, NxE4x,
NxE55-3, and NxE2x engines require a full image download using the Download Code option
built into the SCT to deliver complete image files.

• As a configuration step for downloading an image or patch for an NxE, select which Ethernet
adapter the SCT computer uses to perform the operation using the Tools > Select Ethernet
Adapter menu item.

• When you have uploaded the .caf file from a field controller, you can use the Export CAF File
option in SCT to export this file from the SCT archive database to the computer for use with the
Controller Configuration Tool (CCT). An option is also available to export every .caf file from all
field controllers on a single Field Bus.

• SCT allows you to create and manage the User Security System database for a site. The security
databases for all the devices on a site are optionally uploaded and downloaded as part of the
manage archive functionality. A selection called SCT Security is available under the Security
Copy feature that lets you copy the existing set of SCT users to any supervisory engines on the
site.

• Starting at 7.0, installations that have SCT installed on the same machine as the Metasys server
have separate security databases for user access credentials for SCT and the Metasys SMP.

• Diagnostic features are available to review the upgrade process logs, assess if an archive
has points that have been created that are no longer used or unbound, and summarize the
makeup of the features and objects that have been created on each engine in a site's archive.

• Multiple users can access a single database at once, enabling simultaneous updates. However,
keep in mind that simultaneous database updates exhibit a last user wins behavior. For
example, User A and User B open the same focus view for an engine. User A makes an
attribute change and saves the change. User B makes an attribute change and saves the
change. User A's changes are gone, superseded by User B's changes.

• SCT includes a Certificate Management option that you can use to configure a network
engine for secure, trusted communication. Supported operations for network engines include
requesting, importing, exporting, downloading, and uploading certificates. To configure the
ADS/ADX/OAS/ODS for secure communication, you use the certificate management functions
within the operating system. For details, refer to the Metasys Server Installation and Upgrade
Guide (LIT-12012162) and ODS Installation and Upgrade Guide (LIT-12011945).

Note:  At Metasys Release 8.1, the Metasys server and all network engines are installed
with self-signed certificates by default. You only need to use the SCT Certificate
Management functions if you want to deploy trusted certificates.

SCT in a Metasys Network
Figure 1 shows SCT as part of an overall Metasys network. The SCT is installed on, and can be
accessed by, a computer on the building network.
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Figure 1: SCT as Part of a Metasys Network

Prerequisite Software Checklist for SCT Installation
The computer operating system that you want to use for SCT software must have the proper
components installed. SCT software does not install or function correctly if any of these
components is missing. The SCT Installation wizard verifies that the computer has these
prerequisites, but make sure you carefully review the software requirements listed in Table 2
before you install SCT. The table also indicates where you can obtain each software component.
For detailed information about installing the SCT software, refer to the SCT Installation and Upgrade
Instructions (LIT-12012067).
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Table 2: Prerequisite Software Checklist for SCT
Software Component Product Where to Obtain
Operating System (select one)
Windows® 10 Pro and Windows 10
Enterprise Editions versions 1903,
1909, and 2004 (64-bit). For all future
Windows 10 updates after version
2004, we will evaluate and certify
that Metasys software can support
the updates before we provide
guidance on support.
Windows® 8.1 Pro and Windows
8.1 Enterprise Editions with Update
(KB2919355) (64-bit)

ADS/ADX
SCT

Windows® Server® 2019 (version
1803) (64-bit)
(Standard or Enterprise Edition)
Windows Server 2016 with Update
(KB4512495) (64-bit)
(Standard or Enterprise Edition)

ADS/ADX
SCT

Microsoft Corporation

Operating System (OS) Components (select all)
Internet Information Services (IIS)
(included with OS)

ADS/ADX
SCT

Microsoft Message Queuing
(MSMQ)

ADS/ADX
SCT

OS media

Miscellaneous (select all)
Daylight Savings Time (DST) Patch
for OSs

http://www.microsoft.com/downloads

Microsoft .NET Framework 3.5 SP1 or
3.5.1
For Windows 8.1, Windows 8,
Windows 7, Windows Server 2012
R2, and Windows Server 2012, the
required Microsoft .NET Framework
version is 3.5.1 and is built into the
operating system and installed as a
Windows component.

ADS/ADX
SCT

http://www.microsoft.com/downloads

Microsoft .NET Framework 4.7.2 ADS/ADX
SCT

SCT Media. Microsoft .NET Framework
4.7.2 is installed with the Metasys System
Configuration Tool Setup if it does not
already exist on the computer.

Microsoft Silverlight® 5.0 or later.
Required for viewing Graphics+ files
on Site Management Portal software
clients.

ADS/ADX
SCT

http://www.microsoft.com/silverlight

Database (select one)
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Table 2: Prerequisite Software Checklist for SCT
Software Component Product Where to Obtain
SQL Server 2019 Standard,
Enterprise, and Express CU6 (64-bit)
SQL Server 2017 Standard,
Enterprise, and Express CU21 (64-
bit)
SQL Server 2016 Standard,
Enterprise, and Express SP2 CU14
(64-bit)
SQL Server 2014 Standard,
Enterprise, and Express SP3 CU4 (64-
bit)

ADS/ADX
SCT

ADS/ADX or SCT media
Note: For an ADX installation use the
Standard or Enterprise version of SQL
Server, which you can obtain from the
Microsoft Corporation.

Database Tools (select if required)
Microsoft SQL Server Management
Studio Express

ADS
SCT

ADS/ADX or SCT media
Note: A software database management
tool for SQL Server Express software edi-
tions without management tools. This
tool ships bundled with the Standard and
Enterprise editions of SQL Server 2014
and earlier software.

Metasys System Software Upgrades
Keep in mind this information about upgrading the Metasys system software:

• Upgrade to SCT Release 14.0 if your computer has the Metasys Server software that is at
Release 11.0. You must have SCT 14.0 to add and commission the new SNC and SNE engines.

• When you upgrade an archive database to Release 14.0, the site is upgraded to Release 11.0,
but its network engines can continue to run at, and be managed with, Metasys Release 5.2 and
later. However, if you have a mixed site with network engines at older releases, make sure
that you disable Advanced Security on the Metasys Server and on all devices that report to the
server.

• With SCT at Release 14.0, you can still add supervisory devices at older releases, but only
from Metasys Release 5.2 and later. For example, if you upgrade the Site Director to Release
11.0, you can add and maintain supervisory engines at Releases 5.2, 8.1, 9.0.7, 10.0, and 11.0.
However, you cannot add or maintain supervisory engines that are at a later release than
the Site Director. For example, if the Site Director is at Release 10.0, you can add engines at
Releases 5.2, 8.1, and 10.0, but you cannot add engines at Release 11.0.

• You can configure your Metasys site into logical representation of spaces and equipment.
However, you cannot edit spaces and equipment in the SMP UI.

• You can upgrade devices to the latest release at any time.
• If you are upgrading SCT from Release 11.0 or earlier, you must uninstall the older release

of SCT before installing Release 14.0. However, if you are upgrading SCT from Release 11.1 or
later, you can upgrade to SCT 14.0 without uninstalling the older release of SCT.

• When you install SCT, the software is configured with a self-signed certificate by default. To
indicate the security level, an orange connection status icon appears on the SCT login and user
interface screens.
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• As part of upgrading network engines, use SCT to download their archive databases after
the upgrade is complete. The download also restores the Security System database. After
the download completes, issue the Archive Device command to each downloaded N40-class
device (NAE35, NIE39, NAE45, NIE49, NCE25, or NIE29s) to ensure that the security database is
archived to non-volatile memory. This step is not required for N50-class devices (NAE55s and
NIE59s).

• You can view the upgrade logs with SCT. To view the upgrade logs, use the Upgrade Log option
under the Diagnostics menu.

Metasys System Modes of Operation
With Metasys software, you can access and operate specific system features in the online mode or
the offline (SCT) mode:

• In online mode, you can perform tasks with the SMP UI such as monitoring and commanding
a network of field devices or configuring a security database by using an Internet browser
connected to an engine or Metasys server.

• In offline mode, you can perform system configuration tasks, such as building an archive
database or configuring point objects and features when using a computer with SCT. You can
configure your Metasys sites into spaces and equipment. The configuration for spaces and
equipment allows you to display your site in the new Metasys UI.

Table 3 shows some key differences in functionality between the online and offline modes.
Table 3: Using Metasys System Features and Functions by Mode of Operation
Features and Functions Offline Mode

MS-SCTSWO-x
Online Mode
(Using Launcher to reach the
Site Management Portal)

Administer Site Security Full capability when SCT is
installed on ADS/ADX/ODS.
Otherwise, only User Add and
User Delete functions are
available.

Full capability

Auto-Create a Site Archive
from a Live Site (Site
Discovery)

Yes No

Automatically Discover and
Create Field Devices and
Field Points on a Network
Connected to an Engine

No Yes

Back up, Restore, and Index
Archive Databases

Yes No

Copy or Paste Items and their
Children

Yes No

Copy Security Database
(Security Copy)

Yes No

Create a System Using Logic
Connector Tool

Yes Yes

Create a User-Defined
Navigation Tree

Yes Yes
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Table 3: Using Metasys System Features and Functions by Mode of Operation
Features and Functions Offline Mode

MS-SCTSWO-x
Online Mode
(Using Launcher to reach the
Site Management Portal)

Create Certificate Requests for
Engines

Yes No

Create Diagnostic Archive
Reports

Yes No

Create or Edit Summary
Definitions for Tailored
Summaries

Yes Yes

Create or Import Integrations,
Objects, and Items Supported
by an Engine, ADS, or ADX

Yes Yes

Create Spaces and Equipment
for Spaces Tree (ADS/ADX
only)

Yes No

Create UGT Graphics Yes Yes
Download a Software Disk
Image for an NxE

Yes No

Export .caf Files from Field
Controllers

Yes No

Import and Export Archive
Databases

Yes No

Import and Export Secure
Certificates for Engines

Yes No

Integrate Graphic Generation
Tool Updates

Yes Yes

Manually Create a Site,
Metasys Server, and
Supervisory Devices

Yes No

Pair a network engine to its
Site Director

No Yes

Patch NxE55 Engines
Originally Loaded with Release
6.5

Yes No

Query, Report, and Global
Search Functions

Yes Yes

Rename Site or Engine Devices Yes No1

Simulate a Single Engine Yes No
Support N2 or MSTP Passthru
Mode

Yes Yes

Upgrade, Upload, Synchronize,
or Download Configuration
Databases

Yes No
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Table 3: Using Metasys System Features and Functions by Mode of Operation
Features and Functions Offline Mode

MS-SCTSWO-x
Online Mode
(Using Launcher to reach the
Site Management Portal)

Upload and Download Secure
Certificates for Engines

Yes No

View and Edit Items Displayed
in the All Items Navigation
Tree

Yes Yes

View Tailored Summaries Yes, but these are separate to the
offline tailored summaries.

Yes, but these are separate to
the online tailored summaries.

View User-Defined Navigation
Trees (User Views)

Yes Yes

1 You can use the SMP to rename an engine, but bound references in other devices are not updated. As best practice, use
the SCT to rename devices.

Metasys Modes
Metasys software can operate in two different modes: online using the Site Management Portal UI
and offline using the SCT UI. When you are connected to the network engine or Metasys Server, you
can perform online mode operational activities such as monitoring and commanding. When you
are connected to the SCT only, you can perform offline mode system configuration tasks such as
configuring point objects and features. At SCT Release 13.0, simulation mode is not supported.

Offline Mode
You can use SCT to configure servers and network engines without connecting to the live Metasys
system server and network engines. This function is called offline (or system configuration) mode.
In offline mode, use SCT to set up the system database. Then, load configuration changes created
in offline mode to the network engine for the settings to take effect.
Two features are available only with SCT: ActionQ and Manage Archive. You can add servers and
network engines in offline mode only.
The offline mode is available to users with the Access Type of Standard Access. See the Access
Types section.

Access Types
Metasys system administrators determine the type of access a user has to the Metasys system
through user accounts in the Security Administrator tool. The three access types are Standard
Access, API Access, and Tenant Access.

Standard Access
Standard Access allows the Metasys local system user or Active Directory service user to access all
authorized features of the online Site Management Portal (SMP) UI and the SCT. Users who were
assigned Basic Access accounts with previous releases of the SMP UI are converted to Standard
Access user accounts during the archive upgrade process.

Note: If you want to use the Metasys Advanced Reporting System, you must have Standard
Access with the Advanced Reporting privilege.
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API Access
With Application Programming Interface (API) Access, users can retrieve information from the
Metasys system network. Use API Access to read and write Metasys system data from a custom
application with the same high level of security as when you access system data through the
SMP UI. To perform a data request using a custom application, you need an API Access account
and the appropriate network and application privileges. The API type access works with public
APIs. However, an API user has limited access capabilities on the Metasys SMP UI and Metasys UI.
Therefore, if you need the full capabilities of either UI, define a Standard Access user.

Tenant Access
Tenant Access allows the local system user or Active Directory service user to access all authorized
features of the Metasys UI. Tenant Access users can log on the Metasys UI, but do not have log on
privileges to the SMP UI.

Launcher
About this task:  
The Metasys system relies on a private internal Java Runtime Engine (JRE) that is installed when you
download the Launcher application. This private JRE is not exposed to the same security risks as the
public version of the JRE. The Launcher manages a list of all supervisory engines, Metasys Servers,
and SCT computers at your facility. You can also add the Metasys UI, Metasys Advanced Reporting
System, and any web address to its managed list of websites. You can access any release of the
Metasys system with the Launcher, but opening the SMP or SCT UI at Release 5.2 or earlier requires
the public JRE on the client computer. To install the Launcher application:

1. Open your web browser and enter the URL for the Site Management Portal. Examples:
https://MAIN-ADX/metasys

https://MAIN-ODS/metasys

https://main-adx.my-domain.com

https://10.10.15.100/metasys

Note: If your site has self-signed certificate and you attempt to install the Launcher
application through the HTTPS site, a security certificate error appears. Continue to the
website in order to continue installing the Launcher application.

The Windows Launcher Download screen appears.
2. Click Full Launcher Installer to access SMP or SCT, which allows you to run or download the

Launcher installation file.
3. Click Run to start the installer. For more details, refer to the Launcher Installation Instructions

(LIT-12011783).
4. After installation, close the web browser. By default, the Launcher screen appears after

installation.
5. Refer to the Adding a New SMP or SCT Device Profile and Adding a New Other Profile sections of

Launcher Help (LIT-12011742) for instructions on how to manage a list of all engines, Metasys
Servers, ODS, SCT, Metasys Advanced Reporting System, or any generic website links that
require a login.

Launching the SCT User Interface
You use the Launcher application to start SCT. The Launcher provides easy and convenient access
to any release of the Site Management Portal (SMP) or SCT user interfaces.
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Launching and Logging in to the SCT UI
About this task:  

Note:  If you are defined as an Active Directory user, you do not need to manually log in to the
SCT. This process occurs automatically.

To launch and log in to the SCT UI:

1. On the SCT computer, double-click the Launcher icon on the computer desktop, or go to
Start > Programs > Johnson Controls >  Launcher. The Launcher application appears.

2. Click the SCT tab.
3. Select the device you want and click Launch. The Welcome screen appears.

Note: If the device is not listed, click Add to add the device that you want to use.

4. Type your user name and password.
5. If the Login to list box appears, choose your domain.

Note:  The Login to list box appears only if the Microsoft Active Directory service is
enabled. Refer to the Security Administrator System Technical Bulletin (LIT-1201528) for
details.

6. Click Login.
7. If more than one archive database is available, the Open Archive window appears. Select the

desired database and click OK. The SCT screen appears.
If only one archive database is available, the database automatically opens and the SCT
screen appears.
If an archive database has not been created, the Create New Archive wizard starts. See Creat-
ing a New Archive Database in this document.

Logging Out
Save your changes before you log out. Logging out closes the Alarms window and all other open
windows except the login screen and Help. If your system is configured with a timed logout, the
system times out after a specific period of inactivity. For more information on exiting, see Exiting.
To log out, click the Logout button in the menu bar.
If you are an Active Directory service user who accessed the Metasys system by using an automatic
login and want to access the Metasys system again in the same manner, close the login screen
and navigate to the Metasys URL. Alternatively, you can regain access to the Metasys system by
entering your Active Directory service user name and password and selecting your Active Directory
service domain at the login screen.

Note: If you are editing an item in a display panel, the Metasys software cancels the logout
process and notifies you that you cannot exit or log out while in Edit mode. You must exit Edit
mode by saving or canceling your changes before you can log out of the application.

Exiting
Save changes before exiting. Exiting closes all open windows (except the Help) associated with the
session, including the Alarms Window and login screen. For more information on logging out, see
the Logging Out topic.
To exit, click the Exit button in the menu bar.

Note: If you are currently editing an item in a display panel, the Metasys software cancels the
exit process and notifies you that you cannot exit or log out while in Edit mode. You must exit
Edit mode by saving or canceling your changes before you can exit the application.
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User Interface

Working in the SCT UI
Objects in the SCT user interface are now easily searchable in the navigation trees through the
Locate in Tree feature. The Locate in Tree feature displays the expanded Equipment, Spaces, or All
Items tree location for an object selected from the focus window.
To use this search feature, right-click one of the following object name locations and select Locate
in Tree:

• Global Search table rows
• An object's Focus window title bar

Figure 2: Locate in Tree Option

Note: Locate in Tree search feature is not compatible with User Views and the Unlicensed Item
trees.

User Interface Object Icons and Class IDs
The SCT user interface shows object icons in the All Items tree based on class IDs and use cases. For
example, some class IDs display differently if the device is a Site Director. If a class ID does not have
a designated icon, the default icon is used. The following table contains all class ID icons.
Table 4: User Interface Object Icons
Icon Object Class ID

Default NA
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Table 4: User Interface Object Icons
BACnet Analog Input 0
N2 Analog Input 147
XL5K Analog Input 202
Lon Analog Input 351
N1 Analog Input 417
VND Analog Input 428
BACnet Analog Input Mapper 500
Analog Input Mapper 599
BACnet Analog Output 1
N2 Analog Output 149
XL5K Analog Output 203
Lon Analog Output 352
N1 Analog Output 419
VND Analog Output 429
BACnet Analog Output Mapper 501
Analog Output Mapper 600
BACnet Analog Value 2
JCI Analog Value 165
BACnet Analog Value Mapper 502
Analog Value Mapper 601
BACnet Binary Input 3
N2 Binary Input 148
XL5K Binary Input 204
Lon Binary Input 353
N1 Binary Input 418
VND Binary Input 430
BACnet Binary Input Mapper 503
Binary Input Mapper 602
BACnet Binary Output 4
N2 Binary Output 150
XL5K Binary Output 205
Lon Binary Output 354
N1 Binary Output 420
VND Binary Output 431
BACnet Binary Output Mapper 504
Binary Output Mapper 603
BACnet Binary Value 5
Binary Value 168
BACnet Binary Value Mapper 505
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Table 4: User Interface Object Icons
BACnet Calendar 6
JCI Calendar 161
N1 Calendar 423
Calendar Mapper 762
BACnet Event Enrollment 9
JCI Event Enrollment 190
BACnet Event Enrollment Mapper 509
BACnet File 10
Resource File 357
BACnet File Mapper 510
File 554
BACnet Group 11
JCI Group 191
BACnet Group Mapper 511
BACnet Loop 12
Proportional, Integral, and Derivative Loop 252
JCI Loop 264
BACnet Program 516
BACnet Multistate Input 13
N2 Multistate Input 151
XL5K Multistate Input 206
LON Multistate Input 355
N1 Multistate Input 421
VND Multistate Input 432
BACnet Multistate Input Mapper 513
JCI Multistate Input Mapper 605
BACnet Multistate Output 13
XL5K Multistate Output 207
LON Multistate Output 356
N1 Multistate Output 422
VND Multistate Output 433
BACnet Multistate Output Mapper 514
BACnet Notification 15
JCI Notification 313
BACnet Notification Mapper 515
JCI Notification Mapper 763
BACnet Schedule 16
JCI Schedule 263
BACnet Schedule Mapper 517
JCI Schedule Mapper 761
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Table 4: User Interface Object Icons
BACnet Multistate Value 19
JCI Multistate Value 141
BACnet Multistate Value Mapper 519
JCI Multistate Mapper 606
BACnet Accumulator 23
N2 Program Control 153
XL5K Program Control 208
Flex Accumulator 209
BACnet Accumulator Mapper 220
N1 Program Control 245
BACnet PE 129

Subscription Server 135
Subscription Client 661
DLLR 137
IEIEJ Electric Demand Monitoring 214
IEIEJ Electric Demand Control 215
IEIEJ Generic Load Control 216
BACnet Load Control 225
BACnet Electric Demand Control 228
BACnet Generic Load Control 245
Load 138

Multiple Control 144
BACnet Command 507
Interlock 146

Trend 155
BACnet Trend Log 520
Trend Mapper 760
Analog Alarm 156

Multistate Alarm 172

Optimal Start 174
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Table 4: User Interface Object Icons
Container 176
User View Folder 2000
Controller Folder Template 2006
SCT Summary Definition Folder 2011
Container 176

Container 176

Reference 176

Global Data 177

Signal Select 178

Pulse Meter 181
BACnet Pulse Converter 221
N50 (NAE55) 185
NAE 45 192
NAE 35 193
BACnet Router 219
Gateway 282
N50 Integration (NIE) 358
NAE 35 613
Site Director N50 185
Site Director NAE 45 192
Site Director NAE 35 193
Site Director BACnet Router 219
Site Director Gateway 282
Site Director N50 Integration (NIE55) 358
Site Director NAE 35 613
SNC 448

SNE1100x 871
SNE1050x 872
SNE110L
x

873

SNE2200x 877
Site Director SNC 448
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Table 4: User Interface Object Icons
Site Director SNE1100x 871
Site Director SNE1050x 872
Site Director SNE110Lx 873
Site Director SNE2200x 877
Programming 450

Local Application 236

Local Hardware IO 449

Auto Shutdown 186

Field Bus 195
SA Bus 196
XL5K Integration 200
WRS Class 210
N2 Integration 290
MSTP Integration 307
N1 Integration 346
LON Integration 349
Field Device 197
XL5K Controller 201
Controller 278
NCM 347
LON Controller 350
VND Controller 427
BACnet Device 508
REM Device 597
RIOM Device 598
Fire Control Device 199
Wireless Receiver 211
Fire Control Device N/A
Wireless Sensor 212
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Table 4: User Interface Object Icons
Supervisor Status Primitive 213
Net Sensor Device 627
IEIEJ Electric Demand Monitoring 214
BACnet Electric Demand Monitoring 227
BACnet Trend Log Multiple 224
Trend Log Multiple 300
Solar Clock 249

Diagnostic 255

Analog Totalization 274

Runtime Totalization 275

Event Totalization 276

ODS Workstation 283
OAS Workstation 393
ADS Workstation 425
ADS Lite E 752
ADS Lite A 753
Initial Device Configuration 2004
Site Director ODS Workstation 283
Site Director OAS Workstation 393
Site Director ADS Workstation 425
Site Director ADS Lite E 752
Site Director ADS Lite A 753
Site 286

Ethernet IP 292

Data Broadcast 319

System Class 336

BACnet IP Integration 343

Graphic 344

Trend Study 345
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Table 4: User Interface Object Icons
Navigation Tree 348

P2000 Server 377
P2000 Host Engine N/A
P2000 Panel 378

P2000 Portal 379

P2000 Door 380

P2000 Report N/A
Standards Table 585
BACnet Averaging 518
Averaging 677
BACnet Life Safety Point 521

BACnet Life Safety Zone 522

Input Float Block 526

Output Float Block 527

Input Enumeration Block 528

Output Enumeration Block 529

Input Boolean Block 530

Output Boolean Block 531

Summer Winter Compensation Primitive 532

Control Activity 536

Float Constant 551

Boolean Constant 552

Control Point 555
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Table 4: User Interface Object Icons
Sensor Primitive 556

Comparison 560

Math Primitive /561

ABH Primitive 563
DP Primitive 564
Enth Primitive 565
RH Primitive 566
WB Primitive 567
Flow 570
Enumeration Constant 568

Sequence 575

Variable Speed Drive 632

NCE 651

Site Director NCE 651

Summary Definition 699

Xaml Graphic 717

Legacy Equipment 805

Space 806

Equipment Definition 807

BACnet Character String 820

BACnet Integer 825

BACnet Positive Integer 828

Archive Object 2000
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Table 4: User Interface Object Icons
Controller Template 2008

SCT Summary Definition 2010

Navigation Tree
The navigation frame can display several navigation trees in offline mode (the All Items tree, the
Equipment tree, and the Spaces tree). The All Items tree is generated during system configuration
and represents the network layout of your system. You can add additional user-defined navigation
trees (also referred to as user views) that provide navigation capabilities for viewing particular parts
of your system.

Note: The navigation trees that appear for a particular user, including the All Items tree, are
defined by the system administrator when the user's access permissions are created.

Navigation trees support standard browsing concepts such as the plus sign (+) for expanding
items in the tree and the minus sign (-) for collapsing or hiding items in the tree. The maximum
number of items that you can nest under an item in the All Items tree is 7. User-defined trees have
no restrictions on the number of nested items.
To see more details on an item in the navigation tree, drag and drop the item or double-click the
item in the navigation tree. The navigation frame also supports scroll bars and both right-click and
left-click options.
You can display user views as either a set of tabs (default) or a drop-down list. This interface
helps with large jobs that have many user views, as the tabs can occupy a large percentage of the
viewable navigation screen area. Configure the default navigation display in the General Display
Settings on the Display Settings Tab of the Metasys Preferences.

Click the Detach icon  to detach the navigation frame. You can minimize and maximize the
navigation frame, but if you click the X button, the frame is restored to its default position.

Drag and Drop
You can drag items into various content areas of the SCT. The following table summarizes the
source items and their destinations.
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Table 5: Drag and Drop
Source Location Types of Items Valid for Destination

To Drop To
Notes

Navigation Trees
All Items Tree,
Equipment Tree, and
Spaces Tree

• Attribute Reference field: fully
qualified reference

• Equipment Definition: Points or
User View folder

• Equipment Discovery: Engines or
Devices

• Global Search – Search Locations:
Various

• Global Search – Search Results:
Various

Note: Dragging an item in to the
search Results table adds the
item to the table. You can then
save the results as an Object List
for scheduled reports.

• Interlock Object
• Interlock Object Action Tables
• Interlock Definition Table
• List of Attribute Reference field:

fully qualified reference
• List of Object Reference field: fully

qualified reference
• Multiple Command Object (MCO)

Action Tables: Various
• Object Reference field: fully

qualified reference
• Served By Fields: Space Object or

Equipment Object into
• Spaces Tree: Spaces Object, User

View folder, or other folder

If the view has an edit mode,
the view must be in edit mode
in order to drag an item into a
field.

Global Search Viewer • Search Locations field: Various
Note: Dragging an item in to
the search locations field adds
the item to the locations for the
search query.

• Search Results table: Various
Note: Dragging an item in to
the search Results table adds
the item. You can then save
the results as an Object List for
scheduled reports.

• Tailored Summary Viewer: Global
Search Results Object
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Navigating to an Item
To navigate to and select an item, click the plus (+) and minus (-) signs in the Navigation Tree to
expand and collapse folders until the desired item appears on the tree.

Note: Use the Ctrl or Shift key to select multiple items.

Pop-up Menus
Pop-up menus provide an efficient way to quickly access important item information. Pop-up
menus are also referred to as right-click menus. To access pop-up menus, right-click an item in
the Navigation Tree. Content of the menu depends on the type of selected item and your level of
authorization. For example, point object pop-up menus usually show the options View, Command,
Modify, and Show Extensions. For Engines, pop-up menus usually show View, Event Viewer, Audit
Viewer, Command, Modify, Show Extensions, Alarm Report, Offline Report, Disabled Report,
Operator Override Report, Supervisory Override Report, Trouble Report, Out of Service Report, and
Remove from Site.

Screen Layout and Frames
The screen contains four frames and provides a consistent look and feel in every mode (online, or
offline). Your access to certain features depends on the mode in which you are operating and your
assigned access type and privileges.

Note: If the navigation frame or a display frame is active, the header bar of the active frame
or pane is highlighted. The Menu and Status frames are not highlighted even when you click in
them.

Figure 3: Site Management Portal (SMP) UI Screen Frames
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Figure 4: System Configuration Tool (SCT) UI Screen Frames

Table 6: System Configuration Tool (SCT) UI Screen Frames
Number Name Description

1 Menu Displays the menu bar and the first three characters of the logged-
in user name. Active Directory service user names display as the fully
qualified user name (for example, user@engineering.jci.com).
Logging Out or exit from the system using buttons in the menu frame.

2 Display Presents data or information in the user-selected Panel Layout. See the
Display Frame Layout section for more information on the Display Frame.

3 Navigation Displays navigation trees that organize items in the system. The All Items
tree generates automatically when you configure the system database.
You can create one or several user navigation trees (also referred to as
user views) for defining your own navigation concept.
For more information on the navigation tree, see the Navigation Tree
section.

4 Status Displays information about current user actions and the current time/
time zone of the server that you are logged into (supervisory device or
Site Director).

Items
The Metasys system uses the term item as a generic reference to an object or selection in the
navigation tree. Items in the All Items navigation tree include the site, devices, control systems
(logic), graphics, objects, integrations, schedules, files, trend studies, field points, user-defined
navigation trees, and other system data. Each item can have another item under it, and so on as the
system hierarchy continues. Items have right-click pop-up menus that provide commanding and
viewing options. A symbol represents each item in the navigation tree, and status symbols indicate
the status of each item.
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Status Indicators
Status indicators show the status of items in the system on the user interface. For example, these
status indicators appear in the navigation tree, in a column on Summary views, and in a column on
the Global Search Viewer’s Search Results table. Also, a connection status indicator appears on the
SCT login screen and Main screen to denote the current security level of the certificate. If you place
the cursor over the icon, a tooltip appears to further describe the certificate. The following table
shows examples of the status indicators and the mode in which they may appear.

Note: In Simulation mode, status indicators only appear in the Summary views in the display
frame. The indicators do not appear in the navigation tree in this mode.

Table 7: Status Indicators
Indicator Indicator

Description
Status Mode

Green arrow Item has been edited since it was last loaded to the
Engine.

Offline

Blue triangle Local Site Director: Device is the Local Site
Director.

Online
Offline

Key with slash
mark

Network engine is not paired with the Site
Director.

Online

Green shield with
check mark

Security level between the client computer and the
SCT computer is encrypted and trusted.

Online
Offline

Orange shield
with exclamation
point

Security level between the client computer and the
SCT computer is encrypted, but not trusted.

Online
Offline

Red shield with X
symbol

Security level between the client computer and
the SCT computer cannot be verified because
the certificate has expired, is not valid, or is not
present. However, if the client computer is using
Launcher 1.6 and the SCT computer is at Release
11.1, communication is still encrypted.

Online
Offline

User-Defined Navigation Trees
User-defined navigation trees (also referred to as user views, user navigation views, and user-
defined trees) allow you to organize items and folders for specific users or functions.

Display Panel Tabs
Each display panel contains tabs that vary depending on the item displayed.
For example, most of the point objects, such as the OAT contain the following tabs:
Table 8: Tabs
Tab Description
Alarm Becomes available when you define an Alarm Extension for a point. The New and

Delete buttons allow you to add or delete Alarm Extensions for the point. The Basic
and Advanced radio buttons allow you to filter the attribute display in this tab. The
Edit button allows you to change configurable attributes.

Focus Becomes available when you define a point object. The Focus tab shows operation
attributes available for the object type to which the object belongs. Note that the
Basic and Advanced radio buttons allow you to filter the attribute display in this tab.
The Edit button allows you to change configurable attributes.
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Table 8: Tabs
Tab Description
Hardware Becomes available when you define a point object that has a reference to a physical

input or output. The Hardware tab shows hardware-related attributes available for
the object type to which the point object belongs.

BACnet
Alarm

Becomes available when you define a BACnet intrinsic alarm for a point. The
Intrinsic Alarming Defined attribute is explained in Trend Extension Attributes
section. The BACnet Alarm tab shows BACnet Alarm-related attributes available for
the object type to which the point object belongs. The Basic and Advanced radio
buttons allow you to filter the attribute display in this tab. The Edit button allows
you to change configurable attributes.

Totalization Becomes available when you create a Totalizator Extension. New and Delete
buttons allow you to add or delete Totalization Extensions for the point. The Edit
button allows you to change configurable attributes.

Trend Becomes available when you create a Trend Extension for a point object. New and
Delete buttons allow you to add or delete Trend Extensions for the point. The Chart
view allows you to view data samples in a graphical format and retrieve new trend
data. The Table view of the Trend Extension allows you to view the trend’s data
samples in a table format. The Definition view of the Trend Extension allows you to
view and edit the attributes of the trend extension object.

Averaging Becomes available when you create an Averaging Extension for a point object. The
New button allows you to add Averaging Extensions for the point.

Load Becomes available when you create a Load Extension for a point object. The New
button allows you to add Load Extensions for the point.

Other items may contain fewer or more tabs. For example, the item representing a network engine
or Metasys Server contains the following tabs:

• Focus
• Summary
• Diagnostic
• Communication
• Network
• Email (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)
• Pager (removed from the ADS/ADX at Release 10.1 and later)
• SNMP (disabled in the ADS/ADX at Release 10.1, but enabled in Metasys UI)
• Alarm
• Trend
• Syslog (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)
• Printer (disabled in the ADS/ADX at Release 10.1 and later, but enabled in Metasys UI)

For information on the tabs available in the system, see the Object and Feature Tabs section.

Display Panel Buttons
Table 9 shows the display panel buttons.
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Table 9: Display Panel Buttons
Button Description

Allows you to edit attributes for the displayed item. The values you can edit vary
depending on the displayed item. Click Save to save your changes.

Note:

• This button does not appear in Simulation mode.
• This button appears dimmed if the user has Standard Access mode,

but does not have Modify Items permission for the object being
viewed.

• The term edit refers to changing items using the Edit button. See the
Modify section. The term modify refers to changing items using the
Modify menu item and the Modify dialog box. See the Modify Dialog
section.

Displays the content previously displayed in that panel. Each panel can have a
display history of up to five items.
Displays the content of the next panel saved in the history.

Locks the selected display panel (prevents another item from being dropped in
this panel and overwriting it). A locked panel can be resized. This button toggles
between locked and unlocked.
Maximizes the active panel to the full size of the Display Frame. You can
also maximize the pane by double-clicking the header bar. The other panels
reappear if you click the restore button.
Restores the panels to their original size and position. You can also restore the
pane by double-clicking the header bar.
Closes just the currently displayed view in the display panel.

Closes all of the views in the display panel (including views stored in history).

Displays commonly used information about the displayed item.

Displays all the information the system contains pertaining to the displayed
item.

Working with Items

Displaying Information About an Item
To display information about an item you selected in the navigation tree:
Do one of the following and click the desired tab:

• Drag and drop the item from the navigation tree into a display panel.
• Select an item in the navigation tree, open the View Menu, and click Selected Item. The data

displays in the default display frame.
• Double-click the item in the navigation tree; it displays in the default display panel.
• Right-click an item in the navigation tree or a feature in the display panel (such as Global

Search or a Tailored Summary) and select View.
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Notes:
• When you display information in a panel that already contains data, the older data is

replaced and added to the panel history. To access up to five previously displayed items in
the panel history, click the back button in the display panel.

• If all available panels are locked and you try to display information about an item, a
message appears stating that all panels are locked. Click OK and unlock a panel to display
other item information.

Wizards
Wizards make complex tasks easy and guide you through creating and configuring objects and
features. A wizard typically consists of a series of steps, each corresponding to a screen presented
to the user.
A wizard may appear when you select an option from the Insert menu and when you prompt
certain actions such as copying and pasting an item in the Navigation Tree. For example, a wizard
appears when you select Object from the Insert menu. Wizards that are available in different
modes (for example, any combination of online or offline) appear the same.

Wizards Concepts

Wizard Navigation Buttons
The buttons in Table 10 are common to most of the wizards and allow you to move through wizard
screens.
Table 10: Common Wizard Navigation Buttons
Button Description
Cancel Closes the wizard without saving any data. This button is always active.
< Back Takes you back one screen in the wizard. This may not be the last screen viewed, since

you can move between screens. This button is active on all screens except the first.
Next > Takes you to the next screen in the wizard. If the current screen requires user input or

you are on the last screen in the wizard, the Next button is disabled.
Last If available, presents a summary screen for the wizard. If your input is required in any

previous screen, the Last button is disabled. The Last button takes the user to the last
wizard screen, which is the summary screen. Once the summary screen is displayed,
the Last button is replaced by the Finish button.

Finish Exits the wizard and saves the data. Selecting Finish is the normal method of exiting
a completed wizard. If any prior screens require your input, this button is disabled. If
a wizard has a summary screen, the Finish button is not available until the summary
screen is displayed.

Wizards Steps

Creating Items with Wizards
About this task:  

1. Select the item to create. The corresponding wizard appears. If more than one type of item is
available, select the desired type. Click Next.

- Select Action menu > Show Extensions to launch the Extension Wizard to create
extensions to objects that support them.
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- Select Tools menu > Manage Archive to launch the Manage Archive Wizard within SCT.
The following options are available within the archive databases: Upload from Device,
Download to Device, Synchronize, and Upgrade Device. The Upload function has an
option to upload the CAF files of connected field controllers into the archive database.
The Download function has an option to download the code of the supervisory device.
The Upgrade Device function has an option to patch the supervisory device. Also, for
a network engine only, both the Upload and Download options have an option for
uploading and downloading certificates.

- Select Tools menu > Security Copy to launch the Security Copy Wizard within SCT.
- Select Tools menu > Database to launch the Restore Archive Wizard in the SCT.
- Select Insert menu > Site, Supervisory Device, Metasys Server, Integration, Field

Device, Field Point, Folder, Control System, Object, Graphic, Trend Study, User View,
or Summary Definition to launch their respective wizards.

2. Complete the information on the wizard screens, using the navigation buttons to move
through the screens. The screens vary depending on the item you are creating. See the Using
Wizards section for information specific to each wizard.

Note: All items appear in the wizard, not just valid destinations. When you click an item
that is not a valid destination for the item being added, an error message appears on the
right side of the wizard and the Next button is disabled.

3. Select Finish on the summary page to create the item. If an error occurs, a message displays
and the wizard returns to the summary page. If the item supports extensions, the Extension
Wizard displays after the item is successfully created.

Using Wizards
Browse the following Menu Topic chapters for more information on using wizards, including:

• selections for accessing each wizard
• descriptions
• tips
• related information

Right-Click Menus
The contents of the menus vary depending on the item or feature selected. The contents are
either feature-specific based on the active panel or item-specific based on the selected item in the
navigation tree.

Right-Click Menus and Menu Bar Equivalents
The following table shows the menu items that may appear in a right-click menu and their
equivalent in the menu bar.
Table 11: Right-Click Menus and Menu Bar Equivalents
Right-Click Menu Item = Menu Bar Item
Audit Viewer = View > Audit Viewer
Command = Action > Command
Modify = Action > Modify
Edit
Copy = Edit > Copy
Paste = Edit > Paste
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Table 11: Right-Click Menus and Menu Bar Equivalents
Right-Click Menu Item = Menu Bar Item
Delete Items = Edit > Delete Items

Note: The Edit menu or right-click > Delete functions can-
not be used to delete items from a User View while the
User View Editor is open. Using either function perma-
nently deletes selected items from the archive.

Show Extensions = Action > Show Extensions
Site Discovery = Action > Site Discovery
Export CAF File = Action > Export CAF File
Export CAF Files = Action > Export CAF Files
Refresh = Action > Refresh
Refresh All Tabs = Action > Refresh All Tabs
Refresh Current Tab = Action > Refresh Current Tab
View = View > Selected Item
Rename = Action > Rename
Remove From Site = Action > Remove From Site
Add Annotation = Action > Add Annotation
View Annotations = Action > View Annotations
Import Integration = Action > Import Integration
Import Definition = Action > Import Definition
Locate in Tree = Action > Locate in Tree

Object Help
The Object Help describes each object in the system, the attributes of the objects, and the
characteristics and functions of each attribute. The Object Help provides detailed information
to aid in creating objects, entering values for configuring attributes, understanding how to read
attributes, and defining the interaction between objects in regard to the attributes.

Object Help Concepts

Objects
Objects are self-contained functional items in the Metasys system that contain processes to
manage building automation system components. Objects appear as items in the Navigation Tree
that shows the hierarchical physical or logical relationship between the objects as created by the
user. These objects are generally referred to as items in the Metasys user interface.
Each object that exists in a system is based on a specific object type. There is an object type to
manage the functions of the site, object types to manage the operation of the various device types
installed on the site, object types to manage the physical input/output points of each field device,
and others.
Examples: Site Object, Engine Device Object, Analog Input Object, Program (Control System) Object.
Objects communicate with the rest of the system and with the user through their attributes. The
object type defines the basic function of the object, but the actual behavior of each object also
depends on the values assigned to its configuration attributes and received by its input attributes
from other objects. The object writes its status conditions and the results of internal processes to its
output attributes.
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When an object type has an equivalent BACnet Object Type, the attribute list includes the BACnet
Properties required by the BACnet protocol specification and some of the optional properties.
These objects may be accessed from a BACnet network. For detailed information on BACnet objects
and properties, refer to ANSI/ASHRAE Standard 135-2008 - A Data Communication Protocol for Building
Automation and Control Networks.

Object Extensions
Object extensions provide additional features to objects and include Alarm, Trend Log, Totalization
(Analog, Runtime, and Event), Load, Averaging, and Resource File. Object extensions do not appear
in the navigation tree. The attributes of Object Extensions are displayed under specific tabs when
viewing object details. You may define object extensions when the object is first created using the
configuration wizard or add them later.
For more information on extensions, see the Extensions section.

Attributes
Attributes contain data that an object exposes to the system. The data in some attributes is set by
the user or by other objects and features in the system and is used by the object to perform its
function. Other attributes contain data produced by the object itself. The Attribute table for each
object lists the characteristics of each attribute to help you configure the object.
There is a set of attributes common to many Metasys system objects. These attributes are
described in the Common Object Attributes section. Each object attribute section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to that object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of the object (for example, the Hardware and Options tab
appear on point objects and the Email tab appears on Engine and Server objects). The attributes
listed in the tables appear in alphabetical order.
The column headings in the Attribute table are defined as follows:

Attribute Name
Gives the name of the attribute as it appears on the user interface.
Example: High Limit
See the Status and Display Attribute Location topic.

Data Type
Lists the data type of the attribute value. The following table defines the various data types used in
the Metasys system.
Table 12: Data Types
Data Type Formal Name Definition
Attribute Reference Attribute

Reference
Reference of an attribute from which data is read
or to which data is sent. The format is <Object
Reference.Attribute Name>

Date Date Day of week, day, month, year
Example: Wednesday, February 19, 2003

List List List of attributes or properties of other objects that is
created or used by a particular function of this object.
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Table 12: Data Types
Data Type Formal Name Definition

Byte Number from 0–255 with no decimal point. Allowable
range appears in column headed Values/Options/Range

Unsigned
Integer Short

Number from 0 to 65,535 with no decimal point. Allowable
range appear in column headed Values/Options/Range.

Unsigned Long Number from 0 to 4,294,967,295 with no decimal point.
Allowable range appears in column headed Values/
Options/Range.

Number

Signed Integer Signed number that is also an integer with no decimal
point. The value may be positive or negative. Allowable
range appears in column headed Values/Options/Range.
Examples:

• DLLR: Shed Pending, Shed Lost
• Accumulator: Scale As Integer

Object Reference Object
Reference

Item Reference of an object to which a command is sent

One State/Type/
Node from a Set

Enumeration Discrete state/type/mode taken from a set of numbered
possible values and normally represented on the user
interface by text.

Real Value Float Number with a decimal point to show required precision
Example: 24.5

Set of Related
Values

Structure A set of values of mixed data types representing one
physical entity

Series of True or
False States

Bit String Series of true/false states that each have an independent
meaning but together define the overall state of an
attribute or object

Set of Values Array A set of a specified number of values of the same data
type

Text String A line of characters (letters and numbers)
Time Time Hours, minutes, seconds

Example: 12:30:56 AM
Each Time data type has a time chooser for graphical time
selection, where writable.

True or False Boolean Data that can only be true or false

Notes
The Notes column lists specific characteristics of the attribute and its value. The characteristics
(or flags) in Notes specify how the attribute is used in the object and how it can be set within the
Metasys system.
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Table 13: Notes
Note Definition
C - Configurable Indicates if the value of the attribute is defined by the user when first creating

the object and cannot be changed by the object itself. Configurable (C)
attributes that are writable (W) can be changed by the user online or by a
process or feature in the running system after the object has been created.

D - Default
Attribute for
Display

Indicates that this is the primary value of this object, and is used when the
user interface needs to display a single value from the object. For example, this
attribute is displayed in the header bar of the display panel for an object.

N - Value Not
Required

Indicates that this configurable attribute may contain a blank value. (Other
configurable [C] attributes without N must contain a valid value for the object
to function.) For example, a value for a high or low limit attribute is not required
and a blank value indicates that the alarm processing is not required.

R - Affected by
Object Reliability

Indicates that the reliability of the value of this attribute is dependent on the
object being in a reliable state.

W - Writable Indicates that the user can edit the value of the attribute online or by a process
or feature in the running system or network. A write to a configurable (C)
attribute replaces the existing value. A write to other attributes is handled as an
override to the value calculated by the object or as a command for some action
by the object.

BACnet Notes
The BACnet Notes column specifies if the attribute is exposed as a standard BACnet property and if
it can be modified from a BACnet network.
Table 14: BACnet [System] Notes
Note Definition
B - Exposed as
Standard BACnet
Property

Indicates that the attribute can be accessed as a standard BACnet Property of
the equivalent BACnet Object Type from a BACnet network.

W - Writable Indicates that the value of the attribute can be modified by a message from a
device on the BACnet network.

Note: The types listed in Table 13 may also appear in the Note column, as applicable.

Initial Value
A configurable attribute takes the initial value when the object is being created if the user does not
enter another value. Other attributes take the initial value on startup and until the object calculates
a new value.

Values/Options/Range
Based on the attribute’s data type, this column may show the range of valid values or a reference to
the set of possible values for this attribute. If the complete set of values for the attribute is small, all
possible values are shown in this column.

Status and Display Attribute Location
The Status and default display attribute (typically the Present Value) of objects appear just below
the header of the Display Panel displaying the object.

SCT: System Configuration Tool Help48



Object Naming Attributes
Every object can be identified by one of three naming attributes.
Name - a freely definable user name for the object
Item Reference - a fixed name used internally by the system
BACnet Object Name - the name exposed to a BACnet network based on the Item Reference, or
the name based on the User Name Is BACnet Obj Name common attribute setting
See the Object and Feature Tabs section for more information on these attributes.

State, Mode, and Type Sets
State, Mode, and Type Sets provide the source of readable text for the user interface when the
displayed value can be one of many states, modes, or types. For example, the Status attribute of
every object is displayed as one of the texts listed in the Object Status (Set 505).
References to specific sets appear throughout the Object Help, usually in the Values/Options/Range
column of the object’s attribute table.

Enum Finder
The Enum Finder provides users advanced searching capabilities of enum sets for objects with the
States Text attribute. With the object displayed in the focus window, click the Search (magnifying
glass) icon next to the States Text attribute in the Configuration Tab in Edit mode to access the
Enum Finder.
Table 15: Enum Finder Dialog Box
Screen Area Description
Search Criteria Allows you to enter enum set search criteria.
Results Displays the prioritized search results for cross column searching of Set ID,

Set Name, Enum ID, and Enum Value based on search criteria.
Additional Search
Criteria (+) icon

Adds additional Search Criteria rows.

Ok Applies the selected enum set to the States Text attribute of the object
displayed in the focus window.

Cancel Closes the Enum Finder without applying changes.

1. With the object displayed in the focus window, click Edit in the Configuration tab.
2. Click the Search icon next to the States Text attribute drop-down. The Enum Finder dialog box

appears.
3. Enter enum search criteria text or numerical strings in the Search Criteria text box. The

Results table auto-populates with results listed in priority order by best matches against
search criteria.

Note: For optimal searching, add more search criteria by clicking the Additional Search
Criteria (+) icon.

4. Select the enum set from the Results table and click Ok. The Enum Finder closes and the set is
populated in the States Text attribute of the object displayed.

5. Click Save.

Common Object Attributes
The Object and Feature Tabs are used by most of the object types in the Metasys system. Each
particular object in the object list contains a reference to the use of common object attributes.
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Object List
The entire list of objects that are available in the Metasys system appears in the table of contents in
the Help system and PDF. Also see the Extensions section for object extensions.

Object Creation
Objects can be created offline in the system database on the SCT and later downloaded to the
host device as part of the edited database. You can also create objects online with a browser if you
have the Access Privileges to configure objects using the Security Administrator System. The user
interface screens and procedures are similar in either case. Creating an object involves placing it
at the desired position in the Navigation Tree and defining all the attributes that are required for
it to operate. The procedure begins with the Insert Menu, and a wizard guides you through all the
necessary configuration steps.
See the Creating Items with Wizards section for the steps to create objects/items.

Object Deletion
Objects can be deleted offline in the system database on the SCT and later downloaded to the
host device as part of the edited database. You can also delete objects online with a browser if you
have the Access Privileges to configure objects using the Security Administrator System. The user
interface screens and procedures are similar in either case. Deleting an object involves selecting it
in the Navigation Tree and using the Delete Items command.
See the Deleting Objects or Items section for more information.

Note: Before deleting an object, you should delete all references to the object within other
objects and reconfigure any objects that are referenced in the object to be deleted. If the
references are not edited or deleted, the referenced objects may not operate correctly. See the
Engine Device Object for an example of how to locate incomplete references.

Common Object Attributes
The Common Object Attributes are used by most of the object types in the Metasys system. Each
object type also has specific attributes that apply only to that object type. A reference to the use
of Common Object Attributes and a description of specific object attributes are given under each
particular object in the Object List.

Common Attributes
This section lists the attributes that are common to Metasys system objects.

Note: For detailed information on BACnet properties, refer to ANSI/ASHRAE Standard 135-2008 -
A Data Communication Protocol for Building Automation and Control Networks.
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Table 16: Common Metasys Object Attributes
Name / View Group
Attribute ID Writeable (W)
Configurable (C)

Attribute Description

Name -- Object
2390 W C

Contains a freely definable user-friendly name for the object that is
independent of the Item Reference or the location of the object in
the physical network. The Name is used as the label in the All Items
navigation tree. The Name is shown in alarm reports, the event and
audit viewers, and in summaries. The Name does not need to be
unique to the site unless the name is used as the BACnet Object
Name. When the name is used as the BACnet Object Name, it must
be unique among the BACnet Object Names in the device (if it is not
a Device object) or unique among the other device objects (if it is a
Device object). ].
The following characters cannot be used in an object name:
@ ? * # [ ] " ‘ “ ” \ : / < > | $ . , ' _ &
The Name defaults to the object identifier you used during manual
object creation, but can be edited later. For integrated BACnet
objects, the name defaults to the BACnet Object Name in the remote
BACnet device. For integrated N1 network objects, the name defaults
to the System.Object Name in the Network Communication Module
(NCM).
Example: ConferenceCenter-Room2-SpaceSetPoint
For devices, both the Computer Name and Name attributes default
to the object identifier you used during manual object creation.
But do not confuse the Computer Name attribute with the Name
attribute. Changing the NAE Name attribute does not impact the
object references or network communication with other devices on
the site.
Changing the Computer Name online breaks any existing references
between the NAE object and other objects on the site, and may
break the existing network connection to other devices on the
network. We do not recommend changing the Computer Name
online. If you change the Computer Name attribute in the SCT (right-
click the NAE in the navigation tree and select Rename), both the
Computer Name and Name attributes are changed to the new
name you select. The Item Reference then updates to show the new
Computer Name.

Description -- Object
28 W C

Contains a user-defined description of the object or, for some
integrations, the device description. After the description is defined
by the user, the description is not read from the device again.

Enabled -- Object
673 W C

Indicates whether the object is set to execute/enabled (True) or not
execute/disabled (False).

Authorization Category --
Object
908 W C

Classifies the object by the category of system or equipment that it
monitors to aid in the determination of user access privileges and
alarm routing.
Examples: HVAC, Fire, Security
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Table 16: Common Metasys Object Attributes
Name / View Group
Attribute ID Writeable (W)
Configurable (C)

Attribute Description

Object Type -- Object
79 W C

Indicates the Object Type as displayed in the Metasys software and as
exposed to a BACnet network.
Example: AI (Analog Input)

Archive Date -- Object
849

Indicates the date of the last successful archive of object instances.
The value of this attribute is valid if a valid archive exists and during
the archive download process. The value of this attribute is 0xFF at
all other times.

Object Name -- BACnet
77 W C

Indicates the Object Name as exposed to a BACnet network. This
attribute is equivalent to the Item Reference without the site
identifier. You cannot edit this attribute, but it changes when the
Item Reference attribute updates.
In addition, you can change the Object Name attribute by editing the
User Name attribute and setting the User Name Is BACnet Obj Name
attribute to True.
Example: NAE3/N2 Trunk1.AHU4.Supply Temp

Object Identifier -- BACnet
75 C

Indicates the instance number of the Object Type used in the BACnet
Object ID as exposed to a BACnet network. The object ID must be
unique within the host device. The object ID of the Device object
must be unique within the BACnet network.

User Name Is BACnet Obj
Name -- BACnet
1092 W C

Controls whether the object’s User Name attribute is also the Object
Name attribute. The Object Name attribute is not writable, so the
only way to change the Object Name attribute is to edit the User
Name attribute and set the User Name Is BACnet Obj Name attribute
to True.
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Table 16: Common Metasys Object Attributes
Name / View Group
Attribute ID Writeable (W)
Configurable (C)

Attribute Description

Firmware Version --
Engineering Values
44

Displays the version number of the object software code. As the
functionality of objects is enhanced, the version numbers are
incremented.
Example: 3.1 where 3 is the major revision and 1 is a minor revision

Item Reference --
Engineering Values
32527 C

Contains a unique reference name for the object that is the full
path name of the object through the All Items navigation tree using
the unique identifier you specified when you manually created the
object. The Item Reference begins with the site and device identifiers
(separated by a colon), followed by the identifiers of any parent
objects, such as an integration object, field device, or any nested
folders, and ends with the identifier of the object itself.
You define the identifier of each object as it is created and the
system builds the Item Reference automatically. Once the object
is defined, the Item Reference cannot be changed directly. But
the Computer Name attribute of a Site Director or device is the
object identifier. If you change the Site Director or device Computer
Name attribute, the Item Reference then updates to show the new
Computer Name.
If a device has a domain specified in the Domain Name attribute,
the name for the domain appears in the Item Reference after the
Computer Name:
Computer Name.Domain Name
The following characters are not allowed in references:
@ ? * # [ ] " ‘ “ ” \ : / < > | $ . , ' _ &
Figure 5 shows an example for a field point object in an N2
integration.

Figure 5: Example of Item Reference

Object and Feature Tabs
This section describes the tabs of the display panel for the objects and features in the system. Each
display panel can contain different tabs depending on the item being viewed, and each tab shows
different information.

Note: This section contains detailed information about the tabs used by multiple objects/
features. When a tab only appears for a specific object/feature, the details of that tab are
defined in that object/feature section. However, this section includes a brief description of
such tabs and provides links to the detailed object/feature sections.
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Action Tables Tab
The Action Tables tab appears on Interlock and Multiple Command objects. See the Interlock Object
and Multiple Command Object sections for details.

Alarm Tab
The Alarm tab appears on an object that has an alarm extension. See Alarm Extensions in the
Extensions section.

Associated Graphic Tab
The Associated Graphic tab appears when a graphic is referenced from the object using the Graphic
attribute. Refer to the User Graphics Tool section in the Metasys SMP Help (LIT-1201793) for details on
working with this tab.

Averaging Tab
The Averaging tab appears on an object that has an averaging extension. See Averaging Extensions
in the Extensions section.

BACnet Alarm Tab
Attributes associated with the BACnet Intrinsic Alarming for an object are shown under the BACnet
Alarm tab of the display panel. This tab appears when the site is defined as a BACnet site and the
object has intrinsic alarming enabled (that is, Intrinsic Alarming Defined set to True).

Note: In the notes columns, attributes marked with the letter C are configurable, and
attributes marked with the letter W are writable. In the BACnet notes column, attributes
marked with the letter B are exposed as a standard BACnet property. For more information
about attribute characteristics, see Attributes.

Table 17: BACnet Alarm Tab Attributes
Attribute Name Notes BACnet Notes Values/Options/Range Description
Acked Transitions B To Offnormal, To Fault,

To Normal
Applies to all point
objects and the
Accumulator.

Displays three states that independently indicate
the receipt of acknowledgments for To Offnormal,
To Fault, and To Normal events. Transitions to High
Limit and Low Limit Event States are considered
Offnormal events.
These states are set to False when the
corresponding event occurs and an
acknowledgment is expected as defined in the
Notification Class Object referenced by the
Notification Class attribute of this object.
The states are set to True upon receipt of the
corresponding acknowledgment.

Alarm Message
Text

W W Maximum 256
characters
Applies to all point
objects and the
Accumulator.

Specifies the body of the user-defined alarm
message. Starting at Release 10.0, this attribute
is replaced by Event Message Texts Config. The
value of this attribute is kept in sync with the
first element of the Event Message Texts Config
attribute. Any modification to either one changes
the other. Also, for upgraded systems that use
Alarm Message Text, any text in this field is moved
to the first element of the Event Message Texts
Config field.
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Table 17: BACnet Alarm Tab Attributes
Attribute Name Notes BACnet Notes Values/Options/Range Description
Alarm Values C,W W Inactive, Active

States Text attribute
identifies the value set
for this attribute.
Applies to BI, BV, MI, and
MV objects.
For MI and MV objects,
you can select multiple
values from a list, unlike
the other objects that
are limited to one value.

Specifies the value (or list of values for multistate
objects) that Present Value must reach before an
event generates. If the object supports intrinsic
reporting, this attribute is required.
To Offnormal event generates under these
conditions:
– Present Value maintains the value(s) specified
by Alarm Value(s) for a minimum period of time,
specified in the Time Delay attribute.
– To Offnormal flag is enabled in the Event Enable
attribute.
Once equal to the Alarm Value(s), the Present
Value must become not equal to Alarm Value(s)
before a To Normal event is generated under these
conditions:
– Present Value remains not equal to the Alarm
Value(s) for a minimum period of time, specified by
the Time Delay attribute.
– To Normal flag is enabled in the Event Enable
attribute.

BACnet Deadband C,W B,W Applies to AI, AO, and AV
objects.

Defines the value by which the Present Value must
change below the High Limit or above the Low
Limit before the object generates a To Normal
event.

Error Status Applies to the BO object. Indicates whether the Present Value was
successfully written to the object defined by the
Feedback Reference. The Error Status displays Ok if
the object was able to send its latest Present Value
to the feedback object. Otherwise, the Error Status
displays the error of the first failed command.

Event Enable C,W B,W To Offnormal, To Fault,
To Normal
Applies to all point
objects and the
Accumulator.

Contains three states that independently enable
To Offnormal, To Fault, and To Normal events.
Transitions to High Limit and Low Limit Event
States are considered Offnormal events. An
unreliable condition generates a Fault event.

Event Message
Texts

C, W To Offnormal, To Fault,
To Normal
Applies to all point
objects and the
Accumulator.

An array of three character strings that holds
the message texts that identify the last state of
the object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL. If a
particular event is yet to occur, the respective entry
in the array is blank (null).

Event Message
Texts Config

C, W To Offnormal, To Fault,
To Normal
Applies to all point
objects and the
Accumulator.

An array of three character strings that defines
the message texts used to identify the last state
of the object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL,
which you may customize by entering text in each
field. What you enter here appears in the Event
Message Texts attribute array. Starting at Release
10.0, this attribute replaces Alarm Message Text,
but the two attributes are kept in sync so that any
modification to either one changes the other.
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Table 17: BACnet Alarm Tab Attributes
Attribute Name Notes BACnet Notes Values/Options/Range Description
Event State B Normal, Fault

(unreliable), High Limit,
Low Limit
Applies to all point
objects and the
Accumulator.

Indicates the active alarm state of the Intrinsic
Alarming feature if enabled for the object. In
BACnet terms, High Limit and Low Limit states are
Offnormal.

Event Time Stamps B BACnet formatted Time
Stamps
Applies to all point
objects and the
Accumulator.

Indicates the times of occurrence of the last
To Offnormal, To Fault, and To Normal event
transitions. Time and Date time stamps are
shown as * if no transition of that type has been
generated. Sequence time stamps are 0 if no
transition of that type has been generated. If
intrinsic reporting is supported by the object, this
attribute is required.

Fault Values C,W W Numbers: 0 to 65,535
States Text attribute
identifies the value set
for this attribute.
The list of numbers
come from a list of the
Alarm Values.
Applies to MI and MV
objects.

Specifies any states the Present Value must equal
before a To Fault event issues. If Present Value
becomes equal to any of the states in the Fault
Values list, and no physical fault is detected for
any inputs represented by the Present Value
attribute, then the Reliability attribute has the
value Multistate Fault. If the object supports
intrinsic reporting, the Fault Values attribute is
required.

Feedback
Reference

C,W W Applies to BO and MO
objects.

Indicates the object reference of the feedback
object.

Feedback Value C,W W Inactive, Active
States Text attribute
identifies the value set
for this attribute.
Applies to BO and MO
objects.

Indicates the status of a feedback value from
which Present Value must differ before an event
generates. The amount Present Value differs from
Feedback Value to generate an event is locally
determined. This attribute is required if the object
supports intrinsic reporting.
A To Offnormal event generates under these
conditions:
– Present Value differs from the Feedback Value for
a minimum period of time, specified in Time Delay.
– Event Enable attribute enables the To Offnormal
flag.
Once equal to the Feedback Value, the Present
Value must become different from the Feedback
Value before a To Normal event generates under
these conditions:
– Present Value remains not equal to the Feedback
Value for a minimum period of time, specified by
Time Delay.
– Event Enable attribute enables the To Normal
flag.

Graphic C,W C,W Applies to all point
objects and the
Accumulator.

Indicates the graphic associated with the alarm
extension.

Graphic Alias C,W C,W Maximum 256
characters
Applies to all point
objects and the
Accumulator.

Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.
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Table 17: BACnet Alarm Tab Attributes
Attribute Name Notes BACnet Notes Values/Options/Range Description
High Limit C,W B,W Applies to AI, AO,

AV, and Accumulator
objects.

Defines the high limit that the Present Value
attribute must exceed before an event is
generated.
The object generates a To Offnormal event when
the Present Value exceeds the High Limit for a
minimum period of time, defined in the Time Delay
attribute; the High Limit Enable is True in the Limit
Enable attribute; or the To Offnormal is True in the
Event Enable attribute.
The object generates a To Normal event when the
Present Value falls below the High Limit minus the
Deadband for a minimum period of time, specified
in the Time Delay attribute; the High Limit Enable
flag is set in the Limit Enable attribute; or the To
Normal flag is set in the Event Enable attribute.
For the Accumulator object, this attribute indicates
the upper limit of the Pulse Rate range.

Life Safety Alarm
Values

Uses BAC LifSfty State
(BACnet Lifesafety State)
(Set 186).
Applies only to Life
Safety Zone and Life
Safety Point objects.

Specifies any states that the Present Value must
equal before the point generates a To Offnormal
event and enters the Life-Safety-Alarm event state.

Limit Enable C,W B,W Applies to AI, AO,
AV, and Accumulator
objects.

Contains two flags that independently enable
and disable reporting of High Limit and Low Limit
events and their return to Normal. This attribute is
required if the object supports intrinsic reporting.

Low Limit C,W B,W Applies to AI, AO,
AV, and Accumulator
objects.

Defines the low limit that the Present Value
attribute must fall before an event generates.
The object generates a To Offnormal event when
the Present Value falls below the Low Limit for a
minimum period of time, defined in the Time Delay
attribute; the Low Limit Enable is True in the Limit
Enable attribute; or the To Offnormal is True in the
Event Enable attribute.
The object generates a To Normal event when
the Present Value exceeds the Low Limit plus the
Deadband for a minimum period of time, specified
in the Time Delay attribute; the Low Limit Enable
flag is set in the Limit Enable attribute; or the To
Normal flag is set in the Event Enable attribute.
For the Accumulator object, this attribute indicates
the lower limit of the Pulse Rate range.

Notification Class C,W B,W 0 to 4,294,967,295
This is the BACnet
Object Identifier of the
Notification Class Object
used for routing.
Applies to all point
objects and the
Accumulator.

Defines the notification class for handling and
generating event notifications for the object. This
attribute implicitly refers to the Notification Class
Object that has a Notification Class attribute of the
same value.
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Table 17: BACnet Alarm Tab Attributes
Attribute Name Notes BACnet Notes Values/Options/Range Description
Notification Object
Reference

C,W C,W Set to Notification Class:
1
Applies to all point
objects and the
Accumulator.

Allows selection of a Notification Class object.
When the Notification Object Reference is written,
the value of the Notification Class attribute is
updated to reflect the referenced object’s instance
number. The value of the Notification Object
Reference attribute is restricted to Notification
Class objects on the same device as the Alarming
object.

Notify Type C,W B,W Alarm, Event
Applies to all point
objects and the
Accumulator.

Defines whether the transitions generated by the
object are Events or Alarms.

Pulse Rate C,W Applies to the
Accumulator object.

Indicates the number of input pulses received
during the most recently completed period
specified by the Limit Monitoring Interval. This
value is monitored by the Intrinsic Alarming logic
for this object. This attribute is writable only when
the object is out of service.

Time Delay C,W B,W 0 to 65,535
Units = seconds
Applies to all point
objects and the
Accumulator.

Defines the minimum number of seconds that
the Present Value must remain outside the range
defined by the High Limit and Low Limit attributes
before the object generates a To Offnormal event.
Also defines the minimum time the Present Value
must remain within the range defined by the
High Limit and Low Limit attributes, including
the Deadband attribute value, before the object
generates a To Normal event.
When used with the Feedback Value, this value
specifies the minimum number of seconds that the
Present Value must remain equal to the Feedback
Value before a To Offnormal event generates or
different from the Feedback Value before a To
Normal event generates.
For the Accumulator object, this value defines
the minimum number of seconds that the Pulse
Rate must remain outside of the range defined by
the High Limit and Low Limit attributes before the
object generates an event or alarm.

Calendar Tab
The Calendar tab appears on Calendar objects, which are used behind the scenes by the Scheduling
feature.

Communications Tab
The Communications tab appears on Engine Device objects.

Configuration Tab
The Configuration tab appears when you define an object in the SCT or in a wizard. The
Configuration tab shows operation attributes available for the object type to which the object
belongs. The attributes displayed on the Configuration tab vary by object type. For example, the
Analog Input object’s Configuration tab has different attributes than the Metasys server object’s
Configuration tab. See the specific object section for details on its Configuration tab.

Note: This tab is called the Focus tab in the online Site Management Portal.
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Diagnostic Tab
The Diagnostic tab only appears for objects containing diagnostic data. The attributes displayed
on the Diagnostic tab vary by object type. For example, the Diagnostic tab of the BACnet Protocol
Engine Object has different attributes than the Engine Device Object. See the specific object section
for details on its Diagnostic tab.

Email Tab
The Email tab appears on Engine or Server objects. The Email DDA Attributes appear on the Shared
Configuration section of the Email Tab. The Email DDA Destination Configuration Attributes appear
when you edit a specific Email destination on the Email tab.
Notes:

• At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS. For
these devices, use the Metasys UI to modify the attributes on this tab.

• At Metasys Release 7.0 or later, Email Tab Destinations and all DDA communications feature
alphabetical sorting. See table below.

Table 18: Email Sorting Icons
Icon Icon Name Description

Ascending Sorts destinations in
alphabetical order

Descending Sorts destinations in reverse
alphabetical order

Table 19: Email DDA Shared Configuration Attributes
Attribute Name Description
SMTP Server Host Specifies either a host name or IP address of a SMTP server. A host

name can be specified only if a DNS is available to the device. This
attribute is used in conjunction with Email DDA attribute. If no Email
DDA destinations are configured, this attribute is ignored.

SMTP Port Signifies the TCP port on which Email DDA should connect to deliver
an email message. By default, this field is set to 25 (SMTP); however,
some internal SMTP servers may be set up to non-standard ports,
which require that this field be changed to match the listening port
of the mail exchanger. If no Email DDA attribute exists, this attribute
is ignored.

Authentication Type Specifies the type of authentication used to send and receive emails.
Depending on the selection you make, the fields on the Email tab
become enabled or disabled to help you fill in only the fields required
for that authentication type. If you select SMTP, the SMTP User Name
and SMTP Password attributes become enabled. If you select POP-
before-SMTP, the POP User Name and POP Password attributes
become enabled.

SMTP User Name Specifies a user name for the SMTP server. This attribute is ignored
if the SMTP Server Host is empty. This attribute applies only when
using SMTP authentication. If no Email DDA destinations are
configured, this attribute is ignored. See SMTP Password.
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Table 19: Email DDA Shared Configuration Attributes
Attribute Name Description
SMTP Password Specifies the password for the SMTP user name. This attribute is

ignored if the SMTP Server Host is empty. This attribute applies only
when using SMTP authentication. If no Email DDA destinations are
configured, this attribute is ignored. See SMTP User Name.

POP Server Hostname Specifies the hostname for the POP server. This attribute applies only
when using POP authentication. If no Email DDA destinations are
configured, this attribute is ignored.

POP User Name Specifies a user name for the POP server. This attribute is ignored
if the POP Server Hostname is empty. This attribute applies only
when using POP authentication. If no Email DDA destinations are
configured, this attribute is ignored.

POP Password Specifies the password for the POP user name. This attribute is
ignored if the POP Server Hostname is empty. This attribute applies
only when using POP authentication. If no Email DDA destinations
are configured, this attribute is ignored.

From Email Address Specifies the email address from which all emails are sent. The From
Email Address is a required field. If this attribute is not populated,
the Email DDA does not attempt to send an email message.

SSL Email Enabled When enabled or set to True, emails attempt to send over an SSL
encrypted connection. If SSL is not supported, the email sends
unencrypted unless SSL Email Ignoring Errors option is set to False.
This attribute is disabled by default.

SSL Email Ignoring Errors When True, the email is still sent even if the email server certificate
appears to be invalid. When false, the email is sent only if the
operating system can verify that the server sent a valid SSL
certificate. The feature is only enabled if SSL Email Enabled is True.

Note: Make sure that proper certificate revocation, such as Online
Certificate Status Protocol (OCSP) stapling, is enabled and con-
figured. For more information about OCSP configuration, refer to
https://docs.microsoft.com/en-us/openspecs/windows_protocols/ms-
ocsp/5792b4c4-c6ba-439a-9c2a-52867d12fb66.

Email Diagnostics Displays diagnostic information regarding the communication
between the Email DDA (SMTP Client) and the SMTP Server. This
attribute displays both successful and unsuccessful email message
deliveries.
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Table 20: Email DDA Destination Configuration Attributes
Attribute Name Description
Label Identifies the user-friendly destination name in the list of Email

DDAs. Maximum characters: 80
Email Address Specifies the email address of one or more recipients. You must use

valid email addresses set up on an email server for the device to
successfully send the email alarms. When entering more than one
email address, separate the addresses with a comma (for example,
Jonathan.Smith@jci.com,Jane.Smith@jci.com).
Click the Browse icon to select email addresses defined by the user
accounts in the Security Administrator system.
Maximum characters: 256

Priority Specifies the priority of the outbound email message. This attribute
defines the X-Priority field within the email’s MIME header. X-
Priority is one of several ways to define the significance of an email.
Not all email clients interpret it the same way. Refer to your email
client’s documentation for more information.
You can choose from the following values:

• High
• Normal
• Low

See the Hi Normal Low (Set 100).

Subject Specifies the user-defined text that appears in the subject field of
the email message.
Maximum characters: 256

Retries Specifies the number or attempts made to send a message if there
is a failure before the system discards it.
Range: 0–10

Enabled Defines whether or not the destination is enabled. When this
attribute is False, the Engine or Server does not deliver alarms to
the configured recipients.
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Table 20: Email DDA Destination Configuration Attributes
Attribute Name Description
Filters Specifies the rules to filter alarms. This attribute uses Alarm Value

(Set 108).
See Filters for more information.

Format Defines the format of the message, indicating which fields are
present in the received message.
The following fields are optional:

• Acknowledge Required (not an option for pager)
• Authorization Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Refer to the Event Message Routing, Filtering, and Destinations section of the Metasys SMP Help
(LIT-1201793) for more information on this DDA.

Filters
Defines the rules used to filter alarms. This attribute appears on the Email, Pager, Printer, and
SNMP tabs. For more information, refer to the Event Message Routing, Filtering, and Destinations
section of the Metasys SMP Help (LIT-1201793).
Table 21: Filter Parameters
Filters Operators Allowed Values
Acknowledge Required == or != True or False
Current Status == or != Object Status Set
Start Day of Week <, <=, >, >=, ==, or != Day of the week.

Any value from Monday to Sunday
Start Time <, <=, >, >=, ==, or != Time
End Day of Week <, <=, >, >=, ==, or != Day of the week.

Any value from Monday to Sunday
End Time <, <=, >, >=, ==, or != Time
Item Type == or != Object Type Set
Authorization Category == or != Authorization Category Set
Previous Status == or != Object Status Set
Priority <, <=, >, >=, ==, or !=

Note: If you specify
a filter with a value
of >10, you receive
only alarms with
priorities between
11 and 255.

Number value
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If you define multiple filters for a destination, the DDA combines all the criteria with an AND
condition (all filter criteria must be met).

Engineering Tab
About this task:  
The Engineering tab appears on integration objects in the system. This tab allows you to view and
edit attributes of items such as devices and points on an integration.

To use the Engineering tab to view and edit attributes:

1. Right-click the integration object on the Navigation tree and select View. The Integration
object appears.

2. Click the Engineering tab, and navigate to an item in the Integration Tree.

Note: You may need to click Relearn to discover the integrated devices and points on
the network and populate the Integration Tree with the data.

3. Double-click the selected item. The Details screen for the selected item appears.
4. Click the Edit button.
5. Make the desired changes and click Save.

Event Tab
The Event tab appears on Event Enrollment objects.
For detailed information, refer to the BACnet Event Enrollment Object Alarming and Event Enrollment
Configuration Examples topics in the Alarm and Event Management for Metasys Systems Integrated with
BACnet Devices section of the Metasys SMP Help (LIT-1201793).

Focus Tab
The Focus tab appears when you define an object in the online Site Management Portal. The
Focus tab shows operation attributes available for the object type to which the object belongs. The
attributes displayed on the Focus tab varies by object type. For example, the Analog Input object’s
Focus tab has different attributes than the Metasys server object’s Focus tab. See the specific object
section for details on its Focus tab.

Note: This tab is called the Configuration tab in the SCT or in a wizard.

Graphic Tab
The Graphic tab appears on a device object that has an associated Graphic defined. See the Graphic
Object for details on working with this tab.

Group Tab
The Group tab appears on Group objects.

Hardware Tab
The Hardware tab shows hardware-related attributes associated with the hardware source of an
integration, device, or a point (for example, when an object has a reference to a physical input or
output).

Note: Each Hardware attribute table is organized and divided into sections of Integration
Hardware attributes, Device Hardware attributes, and Point Hardware attributes (calling out
when attributes are shared between these object types). These sections are indicated by
headings that span across the table.
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BACnet Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network.

Note: Each Hardware attribute table is organized and divided into sections of Integration
Hardware attributes, Device Hardware attributes, and Point Hardware attributes (calling out
when attributes are shared between these object types). These sections are indicated by
headings that span across the table. Attributes marked with the letter C are configurable and
attributes marked with the letter W are writeable.

Table 22: BACnet Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Instance Number C None 0–65,535 Contains the number of mapped BACnet objects
that are being polled on a periodic basis or are
part of the BACnet Object Identifier (along with
the Object Type). The BACnet Object Identifier is
used to establish communication with the object.

Remote Device
Addr

None BACnet device address Contains the BACnet address of the remote
BACnet device where the integrated BACnet
object resides.

Remote Object
Name

None Contains the BACnet Object Name of the
integrated BACnet object as defined in the remote
BACnet device.

IP Field Controller Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 23: IP Field Controller Hardware Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Computer Name W Contains the host name of the device.

Controller Number C,W 0 Range = 000–999 Contains the three rotary switches that identify
the device within the various levels of your site.
Each rotary switch is selectable from 0 to 9,
producing a number ranging from 000 to 999.

DHCP Enabled C,W True False
True

Specifies whether a unique IP address is assigned
automatically (True) or manually (False). A unique
IP address is assigned automatically by the DHCP
server or manually by the user.
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Table 23: IP Field Controller Hardware Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Domain Name W Contains the network domain in which the device
belongs to.

Ethernet MAC
Address

W 00:00:00:00:00:
00

Contains the unique hardware number that
identifies the device within a network.

Instance Number C,W 0 Range = 0–4,194,303 Contains the Object Instance part of the BACnet
Object Identifier, which is used with the Object
Type value to define the full BACnet Object
Identifier value. The BACnet Object Identifier is
used to establish communication with the object.

IP Mask C,W 0.0.0.0 Contains the bit mask that defines which bits are
used to separate between the host portion of the
address and the domain portion of the address.
The IP Mask consists of four numbers ranging
from 0 to 255 separated by three periods.

IP Router Address C,W Listof[0] Contains the address of the device which is used
to forward messages to a remote IP network.

JCI IP Address C,W 0.0.0.0 Contains the unique address other networks
connected to the IP use to identify the device. The
JCI IP address consists of four separate numbers
ranging from 0 to 255 separated by three periods.

LonWorks Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable, and attributes marked with the letter W are writable.
Table 24: LonWorks Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Alarm Event State C,W True False

True
Specifies whether Node State changes will cause
alarms. The value of True allows Node State
alarms to be processed by the NxE. The value of
False masks Node State alarms from the NxE.

Command Status
Mapping Table

C,W Applies to BI, BO, MI, and
MO objects only.

Limits or modifies the mapping to the field
states/commands used by the object. This string
refers to one of the conversion identifiers in the
CommandStatusMap.xml file.

Custom Scale/
Offset

C,W Applies to AI and AO
objects only.

Provides a customs scaling function for
converting the field data to the defined units of
the object. This attribute is for AI and AO objects
only.

Device Class Maximum Length = 40
Category = Default

Indicates the class of a device. The LonWorks
network server is responsible for populating the
Program ID (which includes the Manufacturer,
Device Class, Device Subclass, Transceiver, and
Model). If no standard Program ID exists, the
value is n/a.
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Table 24: LonWorks Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Device Subclass Maximum Length = 40

Category = Default
Indicates the device subclass usage of a device.
The LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.

Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Domain ID C 01 Maximum Length = 12
Category = Default
Hex bytes of length 0,1,3,
or 6

Defined by MCL software for the particular
LonWorks network trunk. The validation code
checks for proper format (zero, one, three, or six
hexadecimal bytes).

Driver Name Ipcdrv Maximum Length = 30
Category = Default

Displays to the name of the installed LonWorks
network driver.

DSN 1 C Maximum Length = 30
Category = Default

Displays the native LonWorks network address
(in Domain-Subnet-Node format). DSNs must
be unique on the LonWorks network. DSN 1 is
required. Use the format xx/xx/xx.

DSN 2 C Maximum Length = 30
Category = Default

Displays the native LonWorks network address
(in Domain-Subnet-Node format). DSNs must
be unique on the LonWorks network. DSN 1 is
required, but DSN 2 can be left blank. Use the
format xx/xx/xx.

Enable Polling C,W Applies to AO, BO, and
MO objects only.

Indicates whether polling is enabled or disabled
when the Engine is in complete control of this
item.

Field Units C,W DegF Uses Unit Set (Set 869).
This attribute is for AI
and AO objects only.

Lists the engineering units that pertain to the
LonWorks network data. This attribute is for AI
and AO objects only.

File Filter W Maximum Length = 40
Category = Default

Lists the types of files that can be used as file
extensions to the LON Integration object. The list
includes:

• eng
• enm
• enu
• fmt
• fpt
• typ
• xif

File Filter can be edited for alternate languages
and must be in the xxx file format.

Interface Value Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.
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Table 24: LonWorks Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
LNS Database
Name

C,W Maximum Length = 30
Category = Default

Displays the name of the LNS database used to
build the LonWorks network trunk.

Location Label Maximum Length = 30
Category = Default

Describes the location of the controller.

Manual Control Applies to AO, BO, and
MO objects only.

Indicates that an HOA switch on the referenced
item is set to Hand or Off.

Manufacturer Maximum Length = 40
Category = Default

Indicates the manufacturer of a device. The
LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.

Message Retry
Count

C,W 1 Range = 0–15 Indicates the number of retry attempts to use
when communicating with this controller.

Model 0 Indicates the model number of a device. The
LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.

Neuron ID Fixed Length = 6
Category = Default

Displays the Neuron ID of the local LonWorks
network interface board or contains the Neuron
ID of the remote LonWorks network controller.
The Neuron ID must be unique to the LonWorks
network.

Offline Indicates whether the connected LonWorks
network hardware is online or offline.

Overridden Indicates if the hardware is overridden (if
supported).

Priority 1–3 Indicates the Priority (1–3) at which to poll this
item.

Program ID Number of Elements = 40
Category = Default

Displays the Standard Program ID for the device
in hex characters. The LonWorks network server is
responsible for populating the Program ID (which
includes the Manufacturer, Device Class, Device
Subclass, Transceiver, and Model). If no standard
Program ID exists, the value is n/a.

Resource File
Language

C,W ENU Maximum Length = 3
Category = Default

Defines the language extracted from the resource
file.

Status Launch
Interval

C,W 0 Range = 0–10,000
milliseconds

Indicates how often the LON integration launches
a status request to the field. A value of 0 means
as often as needed. This attribute limits the LON
bandwidth usage for the LON integration.

Target Reference C Defines the path into a controller for the data
being mapped by the object.

Temporary Status
Item Expiration
Time

C,W 60 Range = 0–65,535
seconds
Immediate (0), Never
(65,535)

Indicates the time to poll the temporary objects in
the status list.

Transceiver Maximum Length = 40
Category = Default

Indicates the transceiver type for a device. The
LonWorks network server is responsible for
populating the Program ID (which includes the
Manufacturer, Device Class, Device Subclass,
Transceiver, and Model). If no standard Program
ID exists, the value is n/a.
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Table 24: LonWorks Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Trouble Applies to BI and BO

objects.
Indicates whether the hardware device is
currently under a trouble condition. Applies to BI
and BO objects.

Update Interval C,W Units = Seconds
0–65,535
Applies to AO, BO, and
MO objects only.

Specifies how often (in seconds) to repeat the last
command. This attribute provides a heartbeat
for controllers needing it. Use this attribute
sparingly.

XIF Present Indicates whether a XIF file matching this
controller’s Program ID was found.

MS/TP Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 25: MS/TP Hardware Tab
Attribute Name Notes Initial Value Values/Options/Range Description
Baud Rate Selection C,W 0 Uses MSTPDL Baud Rate

See the attribute
description.

Indicates the baud rate of the NAE FC bus.
• Auto: Uses baud rate of running network.

This value is the recommended setting for
everything on the FC bus except the bus
supervisor port.

• 1200: Uses 1200 baud only. This value is not
recommended and may not be allowed on
some devices.

• 9600: Uses 9600 baud only. This value is the
lowest standard MS/TP baud rate.

• 19200: Uses 19200 baud only. This value is
not recommended.

• 38400: Uses 38400 baud only. This value
is the recommended baud rate for bus
supervisor ports.

• 76800: Uses 76800 baud only.
Device Type Indicates the type of device. This value comes

from CCT.
Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

FC Bus MAC
Address

Displays the MAC address of the device on which
the object exists (if the object physically resides
on a device on the FC bus) or the FEC/VMA
field controller MAC Address that the point is
connected to (if the object physically resides on
the SA bus).
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Table 25: MS/TP Hardware Tab
Attribute Name Notes Initial Value Values/Options/Range Description
Instance Number Displays the Instance Number of the object on the

remote field device. The Instance number, along
with the object type, defines the remote object’s
BACnet Object Identifier. The BACnet Object
Identifier is used to establish communication with
the object.

MAC Address C 1–255 Indicates the MAC address of the device on the
field bus.

Network Address C,W 0 1–65,534
0 = Local network
65,535 = Reserved for
broadcast

Contains the network number of the MS/TP bus
used for BACnet message addressing. A value
of 0 indicates a local network (the device is not
intended as a router). Do not change this number
after you start device mapping or discovery
because it may invalidate the devices that have
been found.

Offline Specifies whether or not the point is offline.

SA Bus MAC
Address

This attribute applies
to AI, AO, BI, BO, and
Accumulator objects.

Displays the MAC address of the device on which
the object exists (if the object physically resides
on a device on the SA bus).

Slot This attribute applies to
AI, BI, and Accumulator
objects.

Defines the physical location of a point data
source on the device.

Slot A This attribute applies to
AO and BO objects.

Defines the physical location of a point data
source on the device.

Slot B This attribute applies to
PAO and BO objects.

Defines the physical location of a second data
point source on the devices (if present). Only a
PAO would have Slot B defined.

Trunk Number Displays the trunk number where the device (on
which the point resides) is located.

N1 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable and attributes marked with the letter W are writeable.
Table 26: N1 Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Interface Value Indicates the current value from the hardware

interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.

NCM Name None 8 characters maximum Contains the name of the NCM where the
integrated N1 object resides, as defined in the N1
network. Read from the NCM.

Network Name None 8 characters maximum Contains the network name of the NCM where
the integrated object resides as defined in the N1
network. The network name is obtained at startup
through the N1 Migration Object.

Offline False Indicates whether the object is online or offline as
determined by the communication status to the
NCM.

Overridden False Indicates if the point is overridden in the NCM.
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Table 26: N1 Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Reference None <system>.<object> Contains the name of the hardware object in the

format of system.object, that the N1 object is
associated within the NCM.

Remote Object
Name

C,W None <system>.<object>
8 characters each
maximum

Contains the name of the object in the format of
system.object.

N2 Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. These attributes are not exposed to a BACnet network. Attributes marked with
the letter C are configurable and attributes marked with the letter W are writeable. The writeable
attributes in the N2 Master Datalink object are writeable only if the UDP Port attribute is not zero. If
the UDP Port attribute is zero and you attempt to write these attributes, an error message appears.
Table 27: N2 Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Controller Type C AHU, VAV, UNT, PHX,

VND, MIG, VMA, DX, TC,
XTM, LCP, ILC, IFC

Defines the N2 controller type assigned to this
object.

Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Error Log W See Table 28 Lists up to 100 error log entries. Each entry
contains the N2 Controller Type, N2 Address,
Error Description, and a Timestamp (time error
occurred). Logging stops once the 100th entry
is added. This list is stored in memory only. The
Clear Statistics command clears the Error Log.

Host Name Indicates the host name of the Ethernet (or
wireless) converter. When a host name is given,
the system attempts to resolve the Host Name
and IP Address using DNS/DHCP (assuming
that the installer assigned a host name to the
converter and enabled DHCP). If the device can
be located using the ping hostname command,
the system can resolve the host name to an
IP address. After resolving the host name, the
system updates the IP address.

Interface Value Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes.

Message Timeout W 250 250–3,000
Milliseconds

Specifies the delay in milliseconds between the
last character going out and the first character
received. The timeout for VMA devices is three
times this value. The actual timeout can be
extended dynamically when at least one character
of a response message is received before the
timeout.
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Table 27: N2 Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Net N2 Address C 0 1–254 Defines the host controller Address (1–254) on the

N2 bus.
Net Point Address Defines the hardware address associated with the

point.
Net Point Type Indicates the type of point (for example, AI or BI).

Offline Offline (True), Online
(False)

Indicates whether the hardware device is
currently communicating with the system (True =
Offline; False = Online).

Online Point Delay C,W Range = 0–8
Units = Minutes

Indicates the number of minutes that must elapse
before bringing an N2 Controller online. This
attribute allows integration devices, such as the
MIG or VND, to gather status from their many
field points before being reported online by the
engine. With no delay, the N2 Controller reports
unreliable and causes nuisance alarms. This timer
is ignored when the Controller Type is not MIG or
VND.

Overridden Indicates whether the hardware device is
currently overridden.

Poll Delay W 100 0–65,535
Milliseconds

Specifies the time to wait in milliseconds for a
response to an offline poll.
The Poll Delay attribute is writable only if UDP
Port is not zero. If UDP Port is zero and you
attempt to write Poll Delay, an error message
appears.

Retries W 3 3–10 Specifies the number of message retries allowed
when the device is online, including the initial
attempt. Only one retry is attempted to an offline
device.
The Retries attribute is writable only if UDP Port
is not zero. If UDP Port is zero and you attempt to
write Retries, an error message appears

Trouble Applies to BI and BO
objects.

Indicates whether the hardware device is
currently under a trouble condition. Applies to BI
and BO objects.

Trunk Number 0–65,535 Specifies the number of the trunk on which the
object resides.

UDP Port W 0 Indicates the Ethernet UDP Port used for
N2 communication over the IP network. The
recommended UDP Port for N2 Trunk 1 is 4096
and for N2 Trunk 2 is 4097. Only valid on NAE5512
and NAE5513 models.

Table 28: N2 Errors
Error Number Description
0 Controller has reset and is waiting for the Identify Yourself command
1 Undefined Command: command not understood by addressed controller
2 Checksum Error detected by controller
3 Input buffer overflow detected by controller
4 Invalid ASCII character detected by controller
5 Data field error: size of message not correct for command type
6 Invalid Data: one of the fields contains a value that is out of the expected range
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Table 28: N2 Errors
Error Number Description
7 Invalid command for data type: command not appropriate for this field or

record
8 Command not accepted due to problems with the controller, the command is

ignored
9 Device at address is the wrong type
10 No additional records are available (end of search)
11 Controller not ready
12 Data not matching the item or function type
13 Nonexistent item or function
14 Temporarily impossible to access the item
15 Not a programmable item
16 Table programmed with illegal item
17 Trend programmed with illegal item
18 Invalid Function Module
19 Exceeding Addressing Range
20 Password Not Enabled
21 I2C bus communication error (see I2CE)
22 Hardware not available (see OPMO)
23 Illegal item number
24 Counters unreliable
25 Power supply unreliable
26 Checksum Error detected by NxE
27 Block Checksum Error detected by NxE
28 Controller type does not match NxE database
29 Controller revision is less than C03
30 Controller revision is less than B03
31 Controller revision is less than A03
32 Controller revision is less than C05
33 VMACOV error
34 VMA BAC error
35 VMA FMT error
36 Retry error not due to a NAK
37 Unknown NAK error

VND Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
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Table 29: VND Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Disable Automatic
Alarming

C,W False Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Field Value Applies to only AI, AO,
BO, MI, and MO objects.

Indicates the current value of the field point.
Applies to only AI, AO, BO, MI, and MO objects.

Interface Value Applies to only AI, AO,
BO, MI, and MO objects.

Indicates the current value from the hardware
interface. The Interface Value updates when the
hardware is read or when the hardware’s current
value changes. Applies to only AI, AO, BO, MI, and
MO objects.

Max Value C,W 250.0 deg F Applies to only AO
objects.

Defines the highest reliable value for the Present
Value. Applies to only AO objects.

Min Value C,W -50.0 deg F Applies to only AO
objects.

Defines the lowest reliable value for the Present
Value. Applies to only AO objects.

Offline Applies to only AI, AO, BI,
BO, MI and MO objects.

Specifies whether or not the point is offline.
Applies to only AI, AO, BI, BO, MI and MO objects.

Overridden Applies to only AI, AO,
BO, MI, and MO objects.

Indicates whether the hardware device is
currently overridden. Applies to only AI, AO, BI,
BO, MI and AO objects.

Priority C,W Applies to only AI, AO,
BO, MI, and MO objects.

Specifies the priority for polling the vendor point.
Applies to only AI, AO, BI, BO, MI and MO objects.

Protocol
Description

C VendorDriver Indicates the protocol supplied by the Vendor
DLL.

Protocol Revision C Indicates the revision of the protocol for reference
purposes.

Protocol Revision
Date

C Indicates the date the Vendor DLL protocol was
compiled.

Protocol Review
Time

C Indicates the time the Vendor DLL protocol was
compiled.

Temporary Status
Item Expiration
Time

C,W 0–65,535
Units = Seconds

Indicates how long a point remains in the polling
list.

Trouble Applies to only BI and BO
objects.

Indicates whether the hardware point is currently
under a trouble condition. Applies to only BI and
BO objects.

Vendor
Configuration Data

C,W Maximum characters =
80
Maximum entries = 128

Contains data for proper configuration of the
integration.

Vendor DLL C,W VENDOR.DLL Specifies the name of the vendor DLL to load at
startup.

Vendor Integration
Size

Units = bytes Specifies the name of the vendor DLL to load at
startup.

Vendor Reference C Specifies the address of the vendor device.

Vendor Revision
Date

C Indicates the date of the Vendor integration
revision.

Vendor Revision
Time

C Indicates the time of the Vendor integration
revision.
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XL5K Hardware Tab
Attributes associated with the hardware source for object data are shown under the Hardware tab
of the display panel. Attributes marked with the letter C are configurable and attributes marked
with the letter W are writeable.
Table 30: XL5K Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options Ranges Description
Baud Rate C,W 9600 Indicates the baud rate of the integrated

Honeywell XL-5000 field device. Baud rates
typically encountered include: 4800, 9600, 19200,
38400, and 76800.

Data Bits W 8 Uses Databits Indicates the data bits used by the XL-5000
equipment. The valid data bits/stop bits value for
Honeywell protocol is 8/1.

Device Configured
OK

Indicates if the Honeywell field device is fully
configured, ready to run, operational, and if its
database has objects.

Device Database OK Indicates if the Honeywell field device has a
fully populated database containing no errors,
corruptions, or missing parts.

Device Health OK or Fault Indicates if the Honeywell field device is fully
operational, running, and has correct operations.

Device Number C,W 30 Range = 1–30 Indicates the number assigned to the NIE (as a
Honeywell field device on the C-bus).

Device Type C Maximum Length = 18
characters

Indicates the type of Honeywell field device.
For example, the XL-5000 family: XL-10, XL-20,
XL-50, XL-80, XL-100, XL-300, XL-500, XL-600, Zone
Manager.

Disable Automatic
Alarming

C,W False False
True

Specifies whether automatic online/offline device
event reporting is disabled (True) or enabled
(False). This attribute only applies to the device
and not to the device’s mapped objects. Devices
with the Disable Automatic Alarming attribute
set to True suppress the alarm event but still
indicate they are offline in the navigation tree with
a red X. Alarm extensions are not affected by this
attribute.

Download Date Displays the Date stamp returned from the
Honeywell field device (if extractable, otherwise
displays the date when the object was defined).

Download Time Displays the Time stamp returned from the
Honeywell field device (if extractable, otherwise
displays the time when the object was defined).

Driver Name XL5Kdrvr Indicates the protocol DLL driver name for this
integration (for example, XL5Kdrvr).

Firmware Version Indicates the firmware version of the receiver
module.

Hardware Version Indicates the hardware version of the receiver
module.

Parity W Even Uses Parity Indicates the parity used by the XL-5000
equipment. The valid parity for Honeywell
protocol is Even.

Protocol Revision Indicates the current version number of the XL5K
Protocol Engine (PC104).

Remote Name C,W Honeywell device name Indicates the existing name of the Honeywell field
device.

Remote Object Type C Undefined Indicates the type of remote object (for example,
Analog Input, Digital Output, and Pulse Input).
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Table 30: XL5K Hardware Tab Attributes
Attribute Name Notes Initial Value Values/Options Ranges Description
Reset Date Indicates the date of the last Clear Statistics

command.
Reset Time Indicates the time of the last Clear Statistics

command.
Stop Bits W 1 Uses Stopbits Indicates the stop bits used by the XL-5000

integration. The valid Data Bits value for
Honeywell protocol is 8/1.

Trunk Number W 1 Range = 0–6 Indicates the trunk number used for the
integration. This number is typically 1.

Input Category Tab
The Input Category tab appears on GIO objects and includes the status, description, and value of
the items in the category. See the Generic Integration Object section for details.

Interlock Definition Tab
The Interlock Definition tab appears on Interlock objects.

Load Tab
The Load tab appears on an object that has a load extension.

Load Summary Tab
The Load Summary tab appears on DLLR objects.

Logic Tab
The Logic tab appears on Program (Control System) objects, which are used for the LCT feature.

Members Tab
The Members tab appears on Life Safety Point and Life Safety Zone point objects.

Network Tab
The Network tab appears on Engine Device objects.

Options Tab
Attributes associated with the default state, control source, and restart options for an object
are shown under the Options tab of the display panel. Attributes marked with the letter C are
configurable and attributes marked with the letter W are writeable.
Table 31: Options Tab
Attribute
Name

Notes Initial
Value

Values/Options/
Range

Description

Auto Restore C,W True Applies to AO, BO,
MO, AV, BV, and
MV objects.

When True, the point restores the last
command on field device online/offline
transition.

Connected
Status

Ok
Applies to AV, BV,
and MV objects.

Indicates the current status of the
connection between the AV/BV/MV
and the object that is specified in the
Connected To attribute.
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Table 31: Options Tab
Attribute
Name

Notes Initial
Value

Values/Options/
Range

Description

Connected To C, W, N Object Name,
Reference,
Attribute
Applies to AV, BV,
and MV objects.

Specifies an optional attribute
reference of another object in the
system to which the AV/BV/MV is
connected. The direction of the data
flow depends on the value of the
Direction attribute.

Direction C, W Not
Connected

Sends Value
To; Receives
Value From; Not
Connected
Applies to AV, BV,
and MV objects.

Specifies the directional flow of
data if the Connection To attribute
is configured. If the Connected To
attribute is not set, this attribute is not
used. Three direction states can be
written:

• Sends Value To: changes to
Present Value are sent to the
object/attribute configured in
Connected To.

• Receives Value From: changes to
Present Value are received from
the object/attribute configured
in Connected To. If the AV/BV/MV
is set to Monitor Only=True, you
cannot set the Direction.

• Not Connected: the object is
not connected to any source
or destination; the value of the
Connected To attribute is ignored.

Ignore
Relinquish
Default

C,W True Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

When True, the Relinquish Default
attribute is not used and has no effect.

Local Control C,W True True or False
Applies to AO, BO,
MO, AV, BV, and
MV objects.

When True, the point is under local
control and the Present Value can be
commanded only with an operator
override command.

Relinquish
Default

C,W Values and ranges
depend on object
type.
Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

Used as the default value for Present
Value when all command values in
Priority Array are Null.

Restore
Command
Priority

C,W Operator
Override

Uses Restore
Priority
Applies to AO, BO,
MC, MO, AV, BV,
and MV objects.

Allows you to select which commands
(at a selected priority) persist through
a supervisory device restart. When the
bit is set, the command (at the selected
priority) is saved at shutdown and
restored at startup.
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Output Category Tab
The Output Category tab appears on GIO objects and includes the status, description, and value of
the items in the category. See the Generic Integration Object section for details.

Pager Tab
The Pager tab appears on some older Engine models that run a version of Windows Embedded
operating system. The newer Engine models that run a Linux operating system do not support
pagers. The Pager DDA Attributes appear on the Shared Configuration section of the Pager
Tab. The Pager DDA Destination Configuration Attributes appear when you edit a specific Pager
destination on the Pager Tab.
Table 32: Pager DDA Shared Configuration Attributes
Attribute Name Data Type Initial Values Description
Connect Using One from a list of

values
Internal Modem (0) Refer to the modem type.

Access Number Text Be sure to check the Access Number and Password
after an upgrade. In some cases, these values are
not maintained after upgrade.

Redial Attempts Number 3 Minimum Value = 0, Maximum Value = 32767
Range Check = Use Limits

Time Between Redial
Attempts

One from a list of
values

1 Second (0) Refer to the Redial Delay (Set 565).

Idle time Before Hanging Up One from a list of
values

1 Minute (1) Refer to the Idle Time (Set 566).

Redial if Line is Dropped True or False True Whether the modem redials the number if the line
is dropped.

Databits One from a list of
values

7 Refer to the Pager Databits

Parity One from a list of
types

Even Refer to the Pager Parity

Stopbits One from a list of
values

1 Refer to the Pager Stopbits

Password Text 000000 Supports alphanumeric and special ASCII
characters.
000000 is the standard default password for the
Telocator Alphanumeric Protocol used by the
pager.

Pager Diagnostics Text Displays the communication between the Pager
DDA, modem, and customer's paging Service. It
displays both successful and unsuccessful attempts
to send a page.

Table 33: Pager DDA Destination Configuration Attributes
Attribute Name Description
Label Identifies the user-friendly name for a pager destination in the list of

Pager DDAs.
Pager Phone Number Specifies the phone number for the user’s pager.
Max Characters Specifies the maximum number of characters supported by the pager

service provider.
Retries Specifies the number or attempts made to send a message if there is a

failure before the system discards it.
Range: 0–10
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Table 33: Pager DDA Destination Configuration Attributes
Attribute Name Description
Enabled Defines whether or not the destination is enabled. When this attribute

is False, the Engine or Server does not deliver pager messages to the
configured recipients.

Filters Specifies the rules to filter pager messages.
See Filters for more information.

Format Defines the format of the message, indicating which fields are present
in the received message.
The following fields are optional:

• Acknowledge Required (not an option for pager)
• Authorization Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

Refer to the Event Message Routing, Filtering, and Destinations section of the Metasys SMP Help
(LIT-1201793) for more information on this DDA.

Parameter Category Tab
The Parameter Category tab appears on GIO objects and includes the status, description, and value
of the items in the category.

Printer Tab
The Printer tab appears on Server objects. The Printer DDA Destination Configuration Attributes
appear when you edit a specific Printer destination on the Printer tab.

Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.

Table 34: Printer DDA Destination Configuration Attributes
Attribute Name Description
Printer Specifies the name of the printer where reports are routed.

The Printer DDA can send alarms to one or multiple printers.
Note: If you are uncertain about the proper printer name to use, print a
test page from the printer and look for the Printer name line in the test
printout. Copy the name and syntax exactly.

Font Face Specifies the font used by the printed report.
Font Size Specifies the font size used in the printed report.
Orientation Defines the orientation of the printed report (landscape or portrait).
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Table 34: Printer DDA Destination Configuration Attributes
Attribute Name Description
Line Out Defines how many lines of data are required before the Printer DDA

routes reports to the printer. Setting this value to 0 enables tractor-
feed/line printing. For more information, refer to the Printer topic in
the Alarm and Event section of the Metasys SMP Help (LIT-1201793).
Range: 0 to 60

Timeout Timer (in minutes) that begins when the first alarm is stored in the
DDA line out buffer (Line Out). Upon expiration, the contents of the
line out buffer prints.

Printing Priority Threshold Specifies the priority for printing alarm messages. You can print
multiple alarms in a normal priority range at once using the Line
Out and Timeout attributes. You also can set the Printing Priority
Threshold to print the contents of the line out buffer immediately
when a higher priority alarm (such as a fire alarm) is detected. You
can set the Printing Priority Threshold to a value from 0 to 255.
When an alarm is received that has a lower priority number than the
Printing Priority Threshold (lower priority numbers have a higher
alarm priority), the contents of the line out buffer print immediately
when the higher priority alarm (such as a fire alarm) is detected, thus
printing the high priority alarm in addition to the contents of the line
out buffer.
For example, if the Printing Priority Threshold is set to 20, alarms with
a priority number of 20 or greater are buffered using the Line Out
and Timeout attributes. Receiving an alarm with a priority number
of 19 or less forces an immediate printout of the currently buffered
alarms plus the new high priority alarm.
This functionality applies when the Line Out attribute is set to 1 or
greater. For more information, refer to the Printer topic in the Alarm
and Event section of the Metasys SMP Help (LIT-1201793).
See the Hi Normal Low.

Retries Specifies the number or attempts made to print a report if there is a
failure before the system discards it.
Range: 0 to 10

Enabled Defines whether or not the destination is enabled. When this attribute
is False, the Server does not deliver reports to the configured printer.
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Table 34: Printer DDA Destination Configuration Attributes
Attribute Name Description
Filters Specifies the rules to filter messages.

For more information, refer to the Event Message Routing, Filtering, and
Destinations section of the Metasys SMP Help (LIT-1201793).

Format Defines the format of the message, indicating which fields are
present in the received message.
The following fields are optional:

• Acknowledge Required (not an option for pager)
• Authorization Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

See the Event Message Routing, Filtering, and Destinations section of the Metasys SMP Help
(LIT-1201793) for more information on this DDA.

Profile Tab
The Profile tab appears on DLLR objects.

Recipient List Tab
The Recipient List tab appears on Notification Class objects.

Resource Tab
The Resource tab appears on an object that has a resource file extension.

Schedule Tab
The Schedule tab appears on Schedule objects.

Site View Tab
The Site View tab appears on Site objects.

SNMP Tab
The SNMP tab appears on Engine or Server objects. The SNMP DDA Attributes appear on the
Shared Configuration section of the SNMP Tab. The SNMP DDA Destination Configuration Attributes
appear when you edit a specific SNMP destination on the SNMP tab.

Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.
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Table 35: SNMP DDA Shared Configuration Attributes
Attribute Name Description
SNMP Enabled Specifies whether the SNMP feature is enabled. Once this attribute

is enabled, the ability to send and receive messages (Traps and
Gets) can be enabled or disabled on an individual basis using the
other SNMP DDA attributes.

SNMP Trap Version Specifies the version used to send SNMP traps. The versions are
v1, v2c, and v3.

SNMP Management Device Specifies an IP address or Host Name on which to filter Get
requests. SNMP only responds to requests from the device listed
in this attribute. If this attribute is 0.0.0.0, SNMP responds to all
requests.

SNMP Request Port Specifies the port on the destination device that requests
information from the Engine or Server. The direction of
communication is from the destination device to the Engine or
Server. Currently, this function is supported only on hardware and
software-based network engines. For hardware network engines
that run with a Windows operating system, changing the value
of this attribute requires a restart for the change to take effect,
but for engines running the Linux operating system, a restart is
not required. Setting this attribute to 0 disables the Get feature of
SNMP.

Contact Person Specifies the IT person who is responsible for managing SNMP
communications.

Public Community Name A case-sensitive string used to authenticate v1 and v2c Get and
Get Next messages. This attribute contains the community string
used by the Network Management System to edit data in objects
maintained by managed devices.

SNMP Trap Message Format Defines the message format used for generating SNMP Traps,
including the startup Trap. The options are:

• String Based (default) - SNMP Traps are sent as a string of
characters

• MIB Based - SNMP Traps are sent using the OIDs defined in
the Johnson Controls MIB (called, JCI MIB).

Table 36: SNMP DDA Destination Configuration Attributes
Attribute Name Description
Label The name of this destination when it appears in the Destinations

list.
Trap Community Name A case-sensitive string used to authenticate v1 and v2c SNMP

Traps. This attribute contains the community string used by the
Network Management System to edit data in objects maintained
by managed devices.

JCI IP Address Specifies the IP address or host name of the system that receives
the traps.
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Table 36: SNMP DDA Destination Configuration Attributes
Attribute Name Description
Destination Port Number Specifies the port on the destination device that receives

messages from the Engine or Server. The direction of
communication is from the Engine or Server to the destination
device. Setting this attribute to 0 disables the Get feature of SNMP.

Enabled Specifies whether this SNMP destination is enabled or disabled.
Filters Specifies the rules to filter alarms. This attribute uses Alarm Value

(Set 108). See Filters for more information.
Format Allows you to select which attributes of a Metasys event are in the

SNMP Trap.
The following fields are optional:

• Acknowledge Required (not an option for pager)
• Authorization Category
• Item Description
• Item Fully Qualified Reference
• Message
• Previous Status
• Priority
• Site Name
• Value

See the Event Message Routing, Filtering, and Destinations section of the Metasys SMP Help
(LIT-1201793) for more information on this DDA.
For detailed information on SNMP, refer to the SNMP Agent Protocol Implementation appendix
located in the Network and IT Guidance Technical Bulletin (LIT-12011279).

Syslog Tab
The Syslog tab appears on Engine or Server objects. The Syslog DDA Attributes appear on the
Shared Configuration section of the Syslog Tab. The Syslog DDA destination Configuration
Attributes appear when you edit or create a new Syslog Destination on the Syslog tab.

Note: At Metasys Release 10.1 and later, the edit button is disabled for an ADS, ADX, or OAS.
For these devices, use the Metasys UI to modify the attributes on this tab.

Syslog has one Share Configuration attribute—Syslog Reporting Enabled. When the Syslog
Reporting Enabled attribute is set to True the feature is active and your error logging is forwarded
to your destination server.
For more information on Syslog and configuring other DDAs, see the Configuring Destination
Delivery Agents (DDAs) section in Metasys SMP Help (LIT-1201793) .
Table 37: Syslog DDA Destination Configure Attributes
Attribute Value / Description
Label Destination name
Syslog Server IP Address for the destination server
UDP Send Port The designated port on the device for error transmitting to your

server.
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Table 37: Syslog DDA Destination Configure Attributes
Attribute Value / Description
UDP Receive Port The designated port on your server for receiving the error transmits.
Event Filters To add or remove Events from displaying
Audit Filters To add or remove Audits from displaying

Summary Tab
The Summary tab provides summary data for items in the navigation tree. For example, the
Summary tab of the MSTP Field Bus object shows summary data for the devices on the field bus.
The Summary tab shows the status, icon, item, value, and description information of the items. You
can view and edit items on this tab using the right-click menu options.

Note: Data appears in the Status column of the Summary tab when the status is not Normal
(for example, High Alarm).

Summary Definition Tab
The Summary Definition tab appears on Summary Definition objects used by the Tailored Summary
feature. This tab allows you to view and edit the Summary Definition object.

Tailored Summary Tab
The Tailored Summary tab appears when you view the folder containing the Tailored Summary in
the associated User View. This tab allows you to view the Tailored Summary you defined using the
User View and the Summary Definition tab.

Totalization Tab
The Totalization tab appears on an object that has a totalization extension.

Tree View Tab
The Tree View tab appears on User Navigation Tree objects, which are used by the User Views
feature.

Trend Tab
The Trend tab appears on an object that has a trend extension.

Trend Study Tab
The Trend Study tab appears on the Trend Study feature.

User Defined Enumeration Editor Tab
The User Defined Enumeration Editor provides the user interface for the quick modification,
creation, or deletion of User Defined Enumerations on a Metasys Site. Authorized users can modify
one or more User Defined Enumerations. This tool provides a solution for various change requests,
and satisfies requirements for new and future Metasys system features that need to provide the
user with the ability to define the displayed text for multiple User Defined Enumerations. The User
Defined Enumeration Editor is available in both the online (runtime) and offline (SCT) modes of the
Metasys system supervisory user interface. Access the tool by selecting the Custom Enumeration
tab of the Site Object.

• For Release 5.2 and later, the Rediscover Text Strings operation generates custom
enumerations from all mapped BACnet and MS/TP objects. These custom enumerations are
backed up when the Site Director is uploaded in the Release 5.2 database. During the upgrade
process, a restored, upgraded, or downloaded Release 5.2 database maintains these custom
enumerations during the upgrade process.
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• For Release 6.5 and later, the User Defined States Text attribute is set to true whenever an
object has a custom enumeration set assigned to it.

• Engines at Release 8.0 and later automatically read custom state sets text created in CCT and
display them in the SMP user interface, instead of the generic State 0 to State X text.

Figure 6: User Defined Enumeration Editor

Table 38: User Defined Enumeration Editor Areas
Item Name Use
1 Add and Delete Custom

Enumeration buttons.
Add new or Delete existing User Defined Enumeration
Sets.

2 Edit OR Save and Cancel
Buttons.

When you select the Custom Enumeration tab there is
an Edit button here; upon selecting Edit, the button is
replaced by the Save and Cancel buttons.

3 Name Name of the new or selected Enumeration set - limited
to 32 characters.

4 Size Enumeration set size. This is the number of values
within the selected enumeration. You may not see
optimal performance if this exceeds 5 members.
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Table 38: User Defined Enumeration Editor Areas
Item Name Use
5 Enumeration Entries Entries within the selected enumeration. Cannot

be blank or white space. You may not see optimal
performance if this exceeds 10 characters.

6 List of existing user defined
enumeration sets.

Displays the current list of User Defined Enumerations.
This list is limited to 256 entries.

Item Menu

New Archive
Menu Selection: Item > New Archive
Creates a new archive database in the SCT.

Tip: If you create an empty archive, after the new archive is created, the Create Site dialog box
appears. Select Yes to open the Insert Site wizard.

See Site.

Creating a New Archive Database
About this task:  

Note:  You cannot create a new archive database if another archive database is already open.
You are prompted to close any open archive database before creating a new archive database.

1. From the Item menu, select New Archive.
The New Archive wizard screen appears.

2. Enter a name for the new archive. Note the following restrictions:

- Archive names are not case sensitive. All archive files are created in the same directory.
- Archive names cannot be longer than 120 characters.
- The first character can only be an alphabetical character from a to z.
- No special characters can be in the name. For example, ! @ # $ % . and & are not

allowed.
- Archive names cannot include spaces.
- HVAC PRO controllers have name restrictions. See HVAC PRO Naming

Recommendations.
3. Choose the type of archive to create:

- To discover devices and add them to the archive, see Creating a New Archive Using
Device Discovery to complete the required steps.

- To create an empty archive, see Creating a New Empty Archive to complete the required
steps.

Creating a New Archive Using Device Discovery
About this task:  
Use the Scan the site for engines (fast) feature of the New Archive wizard, to retrieve site
information from a Site Director, and quickly build an archive database that includes all of the
engines in the site. Be aware that only limited information about the engines is transferred to the
archive. An engine's objects, security, and certificates are not transferred.
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Important: If you scan a site for engines, the only IP address that is transferred to the archive
is that of the Site Director. If you have assigned a static IP address to an engine, and the
engine's IP address is not stored in the archive, you cannot communicate directly with the
engine. To transfer the IP addresses of an engine to the archive, perform an Upload for the
engine, and on the Site Login page, select Communicate via Site Director.

1. In the New Archive wizard, click Scan the site for engines (fast).
2. In the Site Director Reference field, enter the name of the Site Director.

Note: The Site Director Reference field is case sensitive.

3. Optional:  In the Site Director IP field, enter the IP address of the Site Director.

Important: If you are using a static IP address for your Site Director, you must enter its
IP address in the Site Director IP field.

4. Verify that you can communicate with the Site Director by entering a valid User Name
and Password that is defined in the Site Director's security database. The user must
have administrative privileges on the Site Director. Click Test Login. If communication is
established, Login ID is OK appears. If the message Login ID is not OK appears, enter
the correct login details, then click Test Login.

5. Click Create.
A new archive is created. The SCT creates a site in the archive that has the same name as the
Site Director.

6. Optional:  Perform an Upload to transfer an engine's full information to the archive.

Creating a New Empty Archive
1. In the New Archive wizard, click Empty Archive.
2. Click Create.

A new archive is created. You are prompted if you want to add a site to the new archive. See
Adding Sites to an Archive Database for more information.

Populating an Archive Database
About this task:  
The following procedures can assist you in configuring an archive database for a Metasys system.
The steps appear in the order in which they should be performed when creating a new archive
database. For example, to add a supervisory device to a database archive, you must first have a
site defined in the archive. In addition to the following procedures, you can speed up your work by
starting with copies of archive databases, by importing previously exported portions of databases,
by importing an entire database, and by copying and pasting items within an archive database.
Importing and exporting portions of databases, and importing entire databases, are described later
in this document.

The Rapid Archive feature of SCT offers simplified configuration of the SMP or SCT navigation trees
and the Metasys UI by leveraging CAF, Rapid Archive Schedules, and Point Schedules files. For more
information, see Rapid Archive Creation.

These instructions are written from the point of view of building an archive database for an MS/TP
network. Perform the same procedure for a BACnet/IP network but select the appropriate BACnet/
IP trunk. See Figure 7 for an example.

To populate an archive database:

1. Add a site to an archive database. In the example (Figure 7), the archive database is
DemoArchive and the site is Site1.
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Note:  Do not create multiple sites in an archive. The SCT does not allow multiple devices
to have the same name under different sites in an archive.

2. Add Metasys servers to an archive database if applicable. In the example (Figure 7), the
Metasys server is an ADS labeled ADS1.
The Authorization Category list box shown in the right panel allows you to select a category
for the object. Permission to view or act on different object categories is assigned to users or
roles.

3. Add supervisory devices to an archive database. The example shows supervisory device
NAE55-1.

4. Select an MS/TP trunk from the (default) engine archive database. The archive database in
Figure 7 shows one MS/TP trunk (MS/TP Trunk 1) added to NAE55-1.

5. Add MS/TP Field Devices to an archive database. Visible field devices in Figure 7 are AHU-1
and TC-2.

6. Add MS/TP Field Points to an archive database. See ZN-T under TC-2 in Figure 7 for an
example of an added MS/TP field point.

Figure 7: SCT with Archive Database

Adding Sites to an Archive Database
About this task:  
You must have at least one archive database defined. See Creating a New Archive Database for
details.
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To add sites to an archive database:

1. If the Insert Site wizard is visible, proceed to Step 2. Otherwise, with the Archive Database
open, from the Insert menu, click Site. The Insert Site wizard’s Destination page opens.

Note:  Do not create multiple sites in an archive. The SCT does not allow multiple devices
to have the same name under different sites in an archive.

Figure 8: Insert Site Wizard - Destination Screen

2. Select the root archive database and click Next.
3. Follow the prompts on the screen to configure the site in the archive. See the following table

for details.
Table 39: Insert Site Wizard Screens
Screen Purpose
Destination Type or select the archive database to which you are adding the

site.
Identifier Type a unique name for the site.
Configure Set the editable attributes of the Site object you are configuring,

including Connection type and Site Time Servers. To access the
BACnet system features of the Site object, click Advanced.

Summary View the basic parameters of the site just added.

4. Click Finish. A site is created with the parameters you have selected.
5. In the Create Device window, select the type of device to create:

- Site Discovery. Use this feature to retrieve site information from a Site Director. For
more information, see Site Discovery.

- Supervisory Device. For more information, see Adding Supervisory Devices (Engines) to
an Archive Database.

- Metasys Server. For more information, see Adding a Metasys Server (ADS/ADX/OAS/
ODS) to an Archive Database.

- None.
6. Click OK.
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If you choose to create a device, a new wizard window appears.

Adding a Metasys Server (ADS/ADX/OAS/ODS) to an Archive Database
About this task:  
When an ADS, ADX, OAS, or ODS exists on a site, it is automatically the Site Director. If you add
multiple Metasys servers to a site, the first ADS, ADX, OAS, or ODS that you add is the Site Director
by default.

To add an ADS, ADX, OAS, or ODS to an archive database, complete the following steps:

1. With the Archive Database open, from the Insert menu, select Metasys Server.
2. In the Insert Metasys Server wizard, follow the prompts on the screen to configure the

Metasys Server. See the following table for details.
Table 40: Insert Metasys Server Wizard
Screen Purpose
Object Type Select the type of Metasys server you are adding and the version

number; for example, ADS at Version 10.1.
Destination Select the site where the Metasys server resides.
Identifier Type a unique name for the Metasys server. A unique name is

required for each Metasys server in an archive. By default, the
name of the object has a number appended to keep it unique.
Therefore, if adding an ADS to a site for the first time, the default
name is ADS1.

Configure Access features of the Metasys server, including:
Email - SNMP and POP destinations. Add email addresses for the
Metasys server to send messages.
Pager - Enter phone number information for sending messages
to a pager.
SNMP - Enable SNMP and add destinations.

Summary View the basic parameters of the Metasys server just added.

3. Click Finish.

Note: You can add an ADS, ADX, OAS, or ODS child server report to another ADS, ADX,
OAS, or ODS server as site director in SCT; however, it is not supported.

Adding Supervisory Devices (Engines) to an Archive Database
1. With the archive database open, from the Insert menu, select Supervisory Device. The Insert

Device Wizard Select Object Type screen appears.
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Figure 9: Insert Device Wizard - Select Object Type Screen

2. Select the model of the supervisory device and its version.
You can add supervisory devices at Release 5.2 and later, and devices can be at different ver-
sions. Use SCT to fully manage a mixed-release site for supervisory devices at Release 5.2 or
later. For example, if you add an NAE55 at Release 9.0 and an NAE45 at Release 7.0, SCT man-
ages the NAE55 at Release 9.0 and the NAE45 at Release 7.0.

Note: The archive database's Site Director must be at the same release or later than the
device you are adding.

3. Follow the prompts on the screen to configure the supervisory device. See the following table
for details.
Table 41: Insert Device Wizard Screens
Screen Purpose
Object Type Select the type of supervisory device you are adding and its

version (release) number.
Destination Select the site where the supervisory device resides.
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Table 41: Insert Device Wizard Screens
Screen Purpose
Identifier Type a unique name for the supervisory device. A unique name

is required for each supervisory device in an archive. By default,
the name of the object being entered has a number appended
to keep it unique; therefore, if adding an NAE55 to a site for the
first time, the default name is NAE551.

Configure Access engine features, including:
Configuration - If Basic is selected, you can edit parameters
such as name and description. If you select Advanced, you can
configure additional parameters such as engineering values,
alarm snooze, audit trail, and site.
Communications - Configure the serial port, internal, and
external modems.
Network - Enter the LAN settings and configure dial-up settings
for accessing the network over dial-up connections.
Email - Set up SMTP and POP destinations. Allows you to add
email addresses for the engine to send messages.
Pager - Enter phone number information for sending messages
to a pager.
SNMP - Enable SNMP and add destinations.
Refer to Metasys SMP Help (LIT-1201793) or the Open Data Server
Help (LIT-12011942) for the Engine Device object for a description
of the attributes on these screens, including default values and
ranges.

Summary View the basic parameters of the supervisory device just added.

4. Click Finish.

Site Discovery
About this task:  
The Site Discovery feature automatically inserts objects and attributes uploaded from an online
site to your SCT archive database. You can select the Site Discovery feature after you create a
new, empty archive, and use the Insert Site wizard to create a new site. For more information, see
Creating a New Archive Database. To use the Site Discover feature on an existing site, in the All
Items tree, right-click the site name, then click Site Discovery.

Note:
• To ensure the efficiency of the process, .caf files from field controllers are not uploaded

during Site Discovery. Use the Include Field Controllers option when uploading a
supervisory engine to upload the .caf files separately. See Upload.

• For SCT Release 10.0 or later, the site discovery process has changed. Site Directors at a
release before 5.2 must be added to the archive at Release 5.2 for proper discovery. Site
Directors after Release 5.2 must be defined at the same software version as the physical
device. Version 5.2 and later devices discovered through Site Discovery are added to the
archive as their physical device release version, regardless of the release version within
the archive. Devices at a release before 5.2 are added as 5.2 devices. Existing Site Director
devices must match the physical device, or the upload and discovery fail.
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• For SCT Release 12.0 and later, users can select the Upload Discovered Devices check
box to upload newly discovered devices with all objects, security, and certificates (Figure
10), or leave it unselected to add newly discovered devices without objects, security, and
certificates (Figure 11).

Figure 10: Completed Upload Discovered Devices - Check Box Selected

Figure 11: Completed Upload Discovered Devices - Check Box Unselected
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To perform a Site Discovery:

1. In the Site Discovery wizard, select the site.

Figure 12: Site Discovery Wizard - Destination Screen

2. Click Next. The Site Discovery page appears.

Figure 13: Site Discovery Wizard - Site Discovery Screen

93SCT: System Configuration Tool Help



3. Choose the amount of information to retrieve from devices:
- Select the Upload Discovered Devices check box to upload any newly discovered

devices including objects, security, and certificates (if applicable) locally to the All Items
tree.

- Clear the Upload Discovered Devices check box to add any newly discovered devices
locally to the All Items tree with network attributes, but without objects, security, or
certificates. You can still add objects, security, or certificates to newly discovered devices
at a later time through the Manage Archive wizard.

Important: If you clear the Upload Discovered Devices check box, the only IP address
that is transferred to the archive is that of the Site Director. If you are using static IP
addresses on your site, and an engine's IP address is not stored in the archive, you
cannot communicate directly with that engine. To transfer the IP addresses of an engine
to the archive, perform an Upload for the engine, and on the Site Login page, select
Communicate via Site Director.

4. In the Site Director Reference field, enter the name of the Site Director. The Site Director
Reference field is case sensitive.

5. Optional:  In the Site Director IP field, enter the IP address of the Site Director.

Important: If you are using a static IP address for your Site Director, you must enter its
IP address in the Site Director IP field.

6. Verify that you can communicate with the Site Director by entering a valid User Name
and Password that is defined in the Site Director's security database. The user must
have administrative privileges on the Site Director. Click Test Login. If communication is
established, Login ID is OK appears. If the message Login ID is not OK appears, enter
the correct login details, then click Test Login.

7. Click Next on the Configure screen, then click Finish on the Summary screen.
The ActionQ window opens with the Completed tab selected. Click Actions in Progress tab to
view the current action.

8. After the site discovery process is complete, verify that the Completion Status column in the
ActionQ window reports OK and the Navigation tree is refreshed to show the site contents.

Note:
- The SCT device order may differ from the order displayed in the ADS/ADX until

you upload the Site Director. If the SCT device order remains unordered after you
upload the Site Director, use the All Items Organizer to manually specify the order
of devices.

- You can also verify additional process details through the Archive Log. To view the
Archive Log Viewer click Tools > Diagnostics > Archive Log.

9. Close the ActionQ window.

Open Archive
Menu Selection: Item > Open Archive
Opens an existing archive database in the SCT.
Archives appear locked when someone else is accessing that archive. If a user has an archive open
and closes the UI incorrectly (by not clicking the Exit or Logout button), the database appears
locked to all users with a different username and password. To reverse the lock, a user with the
same username and password as the user who closed the UI incorrectly must open that archive,
then close the UI properly.
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Opening an Archive Database
About this task:  

Note: If an archive has been restored but not yet upgraded, the action of opening an archive
initiates the upgrade process.

• For archives prior to Release 5.2, the Open Archive process automatically upgrades the archive
database, ADS/ADX, and engines to match the installed release of SCT.

• For archives Release 5.2 and later, the Update Archive screen prompts you to either update the
archive database or cancel the process.

To open an archive database:

1. On the Item menu, click Open Archive. The Open Archive wizard appears.
2. Select an archive from the list and click Open.

Note: If an archive database is already open, you are prompted to close it before the
selected archive database opens.

Note: If you open an archive between Release 5.2 and 9.0, the Update Archive screen
appears.

3. Select Update Archive to promote the archive to the latest release of SCT but leave all the
devices at their current release. The ActionQ appears and displays the status of the update
process.

4. When the update completes, repeat Steps 1 and 2 to open the updated archive.

Close Archive
Menu Selection: Item > Close Archive
Closes an open archive in the SCT.

Copy Archive
Menu Selection: Item > Create Archive Copy
Creates a copy of the existing and currently open archive database in the SCT.
The copy is intended as a second backup in case the original backup file is deleted. Do not rename
the backup file because the file does not restore properly using a different name (it is case
sensitive). If you want to rename a backup file, create a copy of the archive and give it the new
name before you create a backup. You cannot rename the backup after it is created.

Copying an Archive Database
About this task:  
The Archive copy must have a unique name. By default, the new archive has the same name as the
one you are copying with a number appended to the name.

To copy an archive database:

1. With an archive database open, select Create Archive Copy from the Item menu. The Copy
Archive wizard appears.

2. Select the archive to copy from the list.
3. Type a name for the new Archive database copy in the right pane of the wizard.
4. Click Copy.
5. Click Yes when prompted to close the current database. The new Archive copy opens.
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Delete Archive
Menu Selection: Item > Delete Archive
Removes (deletes) an existing archive database from the SCT.

Deleting an Archive Database
About this task:  
Only one archive can be deleted at a time. An open archive can be deleted.

To delete an archive database:

1. On the Item menu, select Delete Archive.
The Delete Archive wizard opens.

2. Select the archive to delete and click Delete.
3. Confirm the deletion.

Import Item
About this task:  
Menu Selection: Item > Import Item

Imports a previously exported archive file to overwrite the selected item and its child objects
displayed beneath it in the navigation tree into the currently open archive database in the SCT. See
the Export Item.

1. Select the item and its child objects displayed beneath it the navigation tree in the Site
Management Portal UI, select Item > Import Item.

2. The Import wizard dialog box appears; select the file to import and click Import.

Figure 14: Import Item wizard

An exported data file must be stored in C:\ProgramData\Johnson Controls\Meta-
sysIII\DatabaseFiles.
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Click the Details button for the Notice Information dialog box which displays the Reference,
Class, Class Version, Parent Exists and Objects Exists information.

3. A Verify Overwrite dialog box appears to confirm overwriting the selected item and its child
object in the navigation tree.

Note: Importing a Site Director device into a database with existing User Views is not
supported and may cause loss of User View data.

Importing a Portion of an Archive Database from a File
About this task:  

Note: For more information, see Import Item.

The data file to be imported must be in the following directory:

C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles

To import part of an archive database from a file:

1. Open an Archive database.
2. On the Item menu, select Import Item. The Import wizard appears.

Figure 15: Import wizard

3. Select the file you want to import and click Import.
Importing a file discards all change status indicators (the little green arrows in the navigation
tree) from your database. Importing a Site Director into a database with existing User Views
is not supported and may cause loss of User View data.
When the import is complete, the new item appears in your navigation tree.

Export Item
About this task:  
Menu Selection: Item > Export Item

In the SCT, this feature exports the selected item and its child objects. During export, the selected
item is exported and no change is made to the Instance number, Host name, or IP address of
a device. You can import exported items into another archive database. See the Import Wizard
section for more information.

1. Select the item in the navigation tree in the Source selection.
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2. In the File Name selection, add a new file name or select an existing file name for the file you
are exporting and check the Overwrite check box.

Figure 16: Export Item wizard

The exported data file is stored in C:\ProgramData\Johnson Controls\Meta-
sysIII\DatabaseFiles.
For a Notice Information dialog box which displays the Reference, Class, Class Version, Parent
Exists and Objects Exists information, click Details.

3. Click Finish in the Summary Selection to confirm the export configuration information.

Exporting a Portion of an Archive Database to a File
About this task:  

Note: For more information, see Export Item.

The exported data file is stored in the following directory:

C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles

To export part of an archive database to a file:

1. Open an archive database.
2. On the Item menu, select Export Item. The Export Archive wizard starts.

The source must be at a level lower than a Site object. You cannot export an entire site as an
item.
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Figure 17: Export Archive wizard - Source Screen

3. Select the item to export and click Next. The Export Archive wizard Identifier screen appears.

Figure 18: Export Archive wizard - Identifier Screen

4. Enter a unique name for your export file. This is the name that appears in the Import wizard
Select File screen.

Note: If an item or file name of the same name already exists, a message appears to
verify that you want to overwrite the existing item or file. Click Yes to overwrite or No to
cancel the save process.

5. Click Next. The Export Archive wizard Summary screen appears.
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Figure 19: Export Archive wizard - Summary Screen

6. If the Summary appears correct, click Finish. Otherwise, click Back and edit as necessary.

Print
1. Select the navigation tree or display panel you wish to print.

Note: You must select either the navigation tree or a display panel to enable Print. If you
selected a display panel, the entire contents of the visible display panel prints out. If you
selected the navigation tree, all visible parts of the tree print out (even parts of the tree
that you need to scroll to view). Collapsed parts of the tree (not visible in the tree) do not
print. You cannot print the contents of the Alarms Window.

2. Select Page Setup from the Item menu if you wish to change the paper, orientation, or
margin size. Click OK when done.

3. Select Print Preview from the Item menu to see what the printout looks like. Click Print or
click OK.

4. On the Item menu, select Print.

Note: If the panel you selected is not printable, Print is disabled.

Edit Menu

Copy
Menu Selection: Edit > Copy
Copies the selected item to the clipboard in SCT.
For details on copying and pasting items, see Paste Item Wizard.

Paste
Menu Selection: Edit > Paste
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Pastes the clipboard contents to the user-specified location in the SCT.
For details on copying and pasting items, see Paste Item Wizard.

Paste Item Wizard
Menu Selection: Edit > Copy > Paste.
Copies an item from the navigation tree such as an AV object, field device, or supervisory device,
and pastes it into another location in the navigation tree in the SCT.

1. Select the item you want to copy in the All Items tree.
2. From the Edit menu, click Copy.
3. Select the item under which you want to paste the copied item.
4. From the Edit menu, click Paste. The Paste Item Wizard appears.
5. Rename the object in the Paste as text box or leave the name as it appears.
6. Click Paste.

Tips:
• You can copy and paste a device without creating duplicate values. When copied, devices

are assigned a new instance number, and the host name and IP address remain blank.
• When you copy and paste a field point, the new point automatically receives a unique

hardware address.
• You can copy an item and paste it into the same node or another equivalent node in the

navigation tree, but you must select a new name for the item. For example, if you have
an NAE called NAE1 and two sites called Site1 and Site 2 you can copy NAE1 into Site1 or
Site2, as long as you rename the coped NAE. Also you cannot paste an NAE under an NAE,
field device, or object. You must paste an NAE under a Site.

• You can copy a user view and paste it into another site. For example, use this option
to add an ADS/ADX/OAS/ODS to a site that previously had an engine defined as a Site
Director.

Delete Items
Menu Selection: Edit > Delete Items

Deletes one or more items selected in the All Items tree from the site.

Note: The Edit menu or Right-click > Delete functions are not used to delete items from a User
View while the User View Editor is open. Using either function permanently deletes selected
items from the archive.

For details on deleting items, see Deleting Objects or Items.

Deleting Objects or Items
About this task:  
To delete objects or items:

1. Select the object or item you want to delete in the All Items tree. This option is not available in
user views.

2. On the Edit menu, select Delete Items.
Notes:

- You cannot select an object or item in the display frame and delete it from the system.
You can only delete objects or items by selecting them in the navigation tree.
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- After deleting objects or items in the online mode, perform an upload to store the
updated system configuration in the archive. Perform a download of your site to verify
that the changes are visible online.

- After deleting objects or items in SCT, perform a download to update the online
configuration of the device.

- If you are deleting an object or item that is used in other processes (for example, as
a scheduled item or in a graphic), the Delete Items wizard appears and displays the
list of unbound references to be created. To avoid creating unbound references, we
recommend modifying the items that point to that object in the Action Tables tab before
you delete it.

- You cannot delete the Site Director and its child supervisory device at the same time
because the archive would then have no Site Director. The Delete Items Wizard appears
to indicate the child device was not deleted. Therefore, delete only one Site Director or
supervisory device at a time.

View Menu

Tailored Summary Viewer

Tailored Summary Viewer
Use the Tailored Summary Viewer to view and modify large quantities of similar data in a tabular
format.
The Tailored Summary Viewer uses SCT Summary Definitions (Insert > SCT Summary Definition)
in SCT to define how the similar data is displayed. Once created, the SCT Summary Definitions are
located under the Configuration Data object in the All Items tree in SCT only.
You can use one of the following two workflows for the Tailored Summary Viewer:

• In the All Items Tree, select the desired objects. Click View > Tailored Summary Viewer. In SCT,
you can select the SCT Summary Definition of what and how the information for the selected
objects is displayed.

• Click Query > Global Search. Select the search location, enter the desired criteria, and click
Search. From the search results, select the desired objects. In SCT, you can select the SCT
Summary Definition of what and how the information for the selected objects is displayed.

In SCT, you can use the Tailored Summary Viewer to view and modify large quantities of data.
Once data appears in a Tailored Summary View, you can select data in the view, right-click the
data you want to modify, and select the Modify function to edit the data pertinent information.
After you make modifications to data in the viewer, you must right-click the header of the view to
refresh the screen.

Factory Supplied SCT Summary Definition Templates
Table 42 describes the pre-built SCT Summary Definition Templates. The templates include the
definition name, default columns (in English only), and overview description indicating typical rows,
key data, and other useful information that you can import into the SCT Summary Definition folder.
You can use the SCT Summary Definition editor to rename and edit these definitions.
You can access a set of pre-built Summary Definitions through the License Portal. You can
download the Summary Definitions when you download the SCT software, or as a separate
download. To Download the Summary Definitions, complete the following steps:

• Log on to the License Portal.
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• Click the Download icon for the System Configuration tool.
• Select the SCT Summary Definitions check box, and then click Download.
• Import the pre-built Summary Definition files into your site.

We designed the pre-built Summary Definitions to meet the needs of the users based on common
tasks and functions. The Summary Definitions fit into the following main categories: Configuration,
Diagnostics, and Monitoring (HVAC). The Site Administrators are the intended audience for the
Device and Network Diagnostics definitions. Service Professionals will find the links to graphics and
Key Point definitions in the Mechanical Equipment definitions especially useful.

Note: The SCT installer does not include the factory provided Summary Definitions Templates.
You can download these templates from the License Portal, which you can then import into the
SCT Summary Definitions folder. To import, right-click the SCT Summary Definitions folder
and use the Import Definition selection to add the templates to a site's archive.
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Description 28
Firmware Version 44
Max message
Buffer

848

Internode Comm
Timer

845

Alarm Repository
Size

32543

Alarm Snooze Time 32544
Event Action When
Full

4296

Ack Forward
Enable

64025

Audit Repository
Size

32545

Audit Forwarding
Threshold

32546

Audit Action When
Full

32547

Audit Generate
Alarm When Full

32548

Enabled Audit
Level

32549

Power Sampling
Interval

32550

Power Consecutive
Samples

32551

JCI Exception
Schedule

2573

ADS Repository 32558
ADS Connection
Type

32559

ADS Priority
Threshold

2586

ADS Delivery Time 32560

Engine
Config and
Diagnostic
Tabs

After you select Engine Devices in the
All Items tree, all of the configurable
attributes of the selected devices in the
Configuration and Diagnostic tabs appear
in the columns.

Network Tolerance 864
Description 28
User Name is
BACnet

1092

Object Identifier 75

Engine Config
BACnet

After you select Engine Devices in the
All Items tree, all of the configurable
attributes of the selected devices in the
BACnet tab appear in the columns.

BACnet IP Port 1223
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Process ID List 64010
Location 58
Restart
Notifications
Recipients

202

Time Sync
Recipients

116

UTC Time Sync
Recipients

206

Time Sync Interval 204
Align Intervals 193
Interval Offset 195
IEIEJ A List 755
IEIEJ A Period 756
Description 28
SMTP Server Host 32537
SMTP Port 32538
Authentication
Type

3814

SMTP Username 3815
POP Server
Hostname

32540

POP Server
Username

35239

From Email
Address

32568

SSL Email Enabled 64590

Engine Email
Tab

After you select Engine Devices in the
All Items tree, all of the configurable
attributes of the selection devices in the
Email tab appear in the columns.

SSL Email Ignoring
Errors

64591

IP Address 1135
IP Mask 1136
IP Router Address 1137
Obtain DNS
Address

32533

DNS Server IP
Addresses

32534

ADS Dialup -
Connect Using

32575

Engine
Network Tab

After you select Engine Devices in the
All Items tree, all of the configurable
attributes of the selection devices in the
Network tab appear in the columns.

ADS Dialup - ISP
Username

64603
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

ADS Dialup -
Enable DHCP

1138

ADS Dialup - IP
Address

1135

ADS Dialup -
Obtain DNS

32533

ADS Dialup - DNS
Server IPs

32534

BACnet Routing -
Mode

4307

BACnet Routing -
Integrated Objects

4302

Description 28
SNMP Enabled 32552
SNMP Trap Version 32622
SNMP
Management
Device

32553

SNMP Request
Port

1180

Contact Person 32554
Public Community
Name

32555

Engine SNMP
Tab

After you select Engine Devices in the
All Items tree, all of the configurable
attributes of the selection devices in the
SNMP appear in the columns.

SNMP Trap
Message Format

4188

Item Reference 32527
Description 28
Enabled 673
Event Enable 35
Report Delay 2294
High Alarm Limit 631
Low Alarm Limit 632
Single Setpoint Ref 109
Warning Ref 627
Cooling Setpoint
Ref

1417

Heating Setpoint
Ref

1418

Occupancy Ref 1419

Extension -
Analog Alarm

After you select Alarm Extensions from
the Global Search results, all of the
configurable attributes of the extension
appear in the columns.

Unoccupied State 1420
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Differential 637
High Warning
Offset

635

Low Warning
Offset

636

Reference Delay
Time

551

Alarm Ack
Required

530

Alarm Priority 534
Warning Ack Req 520
Warning Priority 524
Normal Ack
Required

525

Normal Priority 529
Alarm Message
Text

536

Graphic 32581
Graphic Alias 32623
Object Identifier 75
User Name is
BACnet

1092

Item Reference 32527
Name 2390
Description 28
Enabled 673
Event Enable 35
Report Delay 2294
Normal State 646
Reference Delay
Time

551

Command
Reference

2394

Capture Changes 3400
Alarm Ack
Required

530

Alarm Priority 534
Normal Ack
Required

525

Extension -
Multistate
Alarm

After you select Alarm Extensions from
the Global Search results, all of the
configurable attributes of the extension
appear in the columns.

Normal Priority 529
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Alarm Message
Text

536

Alarm Values 7
Graphic 32581
Graphic Alia 32623
BACnet Object ID 1223
User Name is
BACnet

1092

Description 28
Object Type 79
Enabled 673
Item Reference 544
Timebase 2035
Totalize Limit 2037
Rollover 2038
Units 117

Extension -
Totalization

After you select Totalization Extensions
from the Global Search results, all of the
configurable attributes of the extension
appear in the columns.

Display Precision 661
Item Reference 544
Enabled 673
Start Time 142
Stop Time 143
Repository Enabled 2549
Transfer Setpoint 2550
Buffer Size 126
Client COV
Increment

127

Sample Interval 2566

Extension -
Trend

After you select Trend Extensions from
the Global Search results, all of the
configurable attributes of the extension
appear in the columns.

Stop When Full 144
Point Description 28
Number of Extensions
Alarm Extensions
Quantity

Note: Child
Item ::clas-
sid:156,172

65535

Trend Extension

Extension
- Checker
Advanced

A selection of points from a device in the
All Items tree of the result set of a Global
Search can be viewed to check if Alarm,
Trend, Totalization, Average, or Load
extensions have been setup for the points.

Quantity
Note: Child
Item ::clas-
sid:155

65535
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Average Extension
Quantity

Note: Child
Item ::clas-
sid:677

65535

Totalization Extension
Quantity

Note: Child
Item ::clas-
sid:274

65535

Load Extension
Quantity

Note: Child
Item ::clas-
sid:659

65535

Point Reference 544
Description 28
Object Type 79
Authorization
Category

908

System Subtype
Set

12169

Facility -
Equipment
Definitions

After you select the Equipment
Definitions Templates under the
Definitions Folder, you can view all of the
key attributes of the definitions to ensure
consistency between all the definitions.

System Subtype 12168
Equipment
Definition Used

6050

Equipment Served
By

6049

Description 28

Facility -
Equipment
Serving

After you select Equipment objects from
the Equipment tab, you can view all of
the serving relationships for a piece of
equipment to ensure that the proper
relationships have been created.

Authorization
Category

908

Space Type 3060Facility -
Spaces to
Equipment

After you select Space objects from the
Spaces tab, you can view all of the serving
relationships for a Space to ensure that the
proper relationships have been created.

Equipment Serving
Space

6049

Item Reference 544
Description 28
MAC Address 2858
Disable Auto
Alarming

1396

Enabled 673
Model Name 70

Field
Controller -
MSTP

After you select MSTP devices from the
All Items tree, all of the configurable
attributes of the devices appear in the
columns.

Firmware Version 44
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Fixed Boot Version 884
Last Upload Date 64032
Last Upload Time 64301
Graphic 32581
Graphic Alias 32623
BACnet Object ID 75
User Name is
BACnet

1092

Manual Time Sync
Type

64030

Item Reference 32527
Description 28
Controller Type 1357
Net N2 Address 806
Host Name 750
Disable Automatic
Alarming

1396

Online Point Delay 758
Enabled 673
Graphic 32581

Field
Controller - N2

After you select N2 devices from the
All Items tree, all of the configurable
attributes of the devices appear in the
columns.

Graphic Alias 32623
Item Reference 32527
Description 28
Hardware - Neuron
ID

32593

Resource File
Language

32596

Domain ID 32594
Temporary Status
Expire Time

3510

Integration -
LON

After you select LON Integrations from
the All Items tree or from a Global Search
result set, all of the configurable attributes
of the integration appear in the columns.

Status Launch
Interval

3511

Item Reference 32527
Description 28
Hardware - Trunk
Number

549

Hardware - Baud
Rate Selection

2860

Integration -
MSTP

After you select MSTP Integrations from
the All Items tree or from a Global Search
result set, all of the configurable attributes
of the integration appear in the columns.

Hardware -
Network Address

875
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Table 42: Factory Supplied Default SCT Summary Definitions
Summary
Definition
Name

Description / Use Case Default Column
Headings

Attribute ID
Number

Object Type 79
Max Master 64
Max APDU Length 62
APDU Time out 11
APDU Segment
Timeout

10

APDU Retries 73
Periodic Update 2192
Page Size 1181
Poll Delay 1163
Sync Time 32616
Sync Time Zone 64003
Discover All As Gen 1264
Requested Vendor
ID

3675

Internode Comm
Timer

845

Execution Priority 2197
Object ID 75
User Name is
BACnet

1092

Item Reference 32527
Trunk Number 549
UDP Port 2558
Retries 1162
Poll Delay 1163

Integration -
N2

After you select N2 Integrations from
the All Items tree or from a Global Search
result set, all of the configurable attributes
of the integration appear in the columns.

Message Timeout 1165
Description 28
ZN-T
ZN-H
ZNT-SP - NI
ZN-SP - AI
WC-ADJ
ZN-TOCC
HTG-O
SA-T

VAV Box Point
Tester

After you select VMA controllers from
the All Items tree or from Global Search
result set, common VAV mapped points
appear in the columns based on point
name matches.

DA-T
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Using a Tailored Summary
For information about using a Tailored Summary, see Using a Tailored Summary.

Tailored Summary Viewer User Interfaces in SCT

Tailored Summary Definition Editor
On a Site Director, the Summary Definition Editor allows you to define and edit an SCT Summary
Definition object. The SCT Summary Definition Editor appears when you view an SCT Summary
Definition object. In the SMP user interface, you view large quantities of live data in a tabular
format. SCT Summary Definition objects always reside on a Site Director in the Configuration
Data > SCT Summary Definitions folder of the All Items tree (that is, you cannot put a SCT Summary
Definition object in another location).

Summary Definition Tab
The SCT Summary Definition Editor's Summary Definition tab allows you to define the table that
appears in the Tailored Summary Viewer.

Figure 20: SCT Summary Definition Editor - Summary Definition Tab

Table 43: SCT Summary Definition Editor - Summary Definition Tab
Button/Field Description
Label Defines the label to display in the first column (that is, the row header

column) in a Tailored Summary. The label is limited to a maximum of
50 characters. This field also can be left blank.

Add/Plus Allows you to add a column at the end of the column configuration
table. To select a column, click the column heading.

Note: One column is created by default when you create the defini-
tion. You must define a minimum of at least one column. You can add
an unlimited number of rows or columns, but performance is resource-
dependent and may be affected by large queries.

Remove/Minus Allows you to remove the currently selected column from the column
configuration table. To select a column, click the column’s header.

Note: One column is created by default when you create the definition.
You must define a minimum of at least one column, and if there is only
one column, you cannot delete it.
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Table 43: SCT Summary Definition Editor - Summary Definition Tab
Button/Field Description
Column Configuration
Table

Lets you configure the columns that appear in the Tailored Summary:

• Column Heading - Defines the name of the column heading. The
name can have a maximum of 50 characters.

• Child Item - Indicates the item for which the column data is
retrieved based on its item name attribute. You can use the
Select Item dialog box to pick a name, or type in the text box. The
name must match a user-specified pattern (such as ZN-* or ZN-
T, Zone-T). You can define an unlimited number of wildcards. The
first item found that matches this item name pattern appears in
the Tailored Summary view column. To display an attribute of the
row item, leave this field blank. Otherwise, specify the name of
the child item to display.

Note: To mass search child-item strings, separate your search cri-
teria with commas. For example, ::classid:156,172,155.

• Attribute - Defines the attribute information for the column. To
display the default attribute, no change is required (that is, leave
the Attribute box set to Default). The attributes are grouped
into categories for easy selection. To specify an attribute, select
a category in the Attribute Filter section of the Select Column
Attribute dialog box, and then select the desired attribute from
the list.

• User Definable Attributes
Note: To change the order of the columns, select a column and drag it to
the desired placement.

Note: When you display a Tailored Summary, the system searches for
data within all levels of a field device (VMA, for example). For all other
objects (NAE, for example), the system searches for data only one level
down (no subsequent levels).
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Table 43: SCT Summary Definition Editor - Summary Definition Tab
Button/Field Description
Browse (Child Item) Opens the Select Item dialog box where you can specify the item

name.
Note: This dialog box provides an easy way to fill in the item name of a
child item. It does not mean that the selected item displays in that col-
umn.

Browse (Attribute) Opens the Select Column Attribute dialog box where you can select
the attribute to display in the column of the table. This process is
necessary only when selecting an attribute other than the default
attribute.
This dialog box has two list boxes to aid in selection:

• Attribute Filter - Allows you to filter the items appearing in the
Attribute list using common attribute categories. If you filter on
Alarms, for example, the supported alarm attributes appear in
the list for selection.

• Attribute - Lists the available attributes for selection.

Note: To display the default attribute of the row item, leave the Attribute
box set to Default (Attribute Filter: Common Attributes and Attribute:
Default).

SCT Summary Definition Configuration Tab
The SCT Summary Definition Configuration tab allows you to edit the configuration data for the SCT
Summary Definition.
Table 44: SCT Tailored Summary Definition - Configuration Tab
Attribute Description
Name Allows you to enter a name for the SCT Summary Definition object.

There is a plain text limit of 400 characters.
Description Allows you to enter a description of the SCT Summary Definition object.

There is a plain text limit of 40 characters.
Object Type Indicates the Object Type.

SCT Summary Definition Wizard Descriptions
Use the Create New SCT Summary Definition Wizard to create an SCT Summary Definition object
from scratch. Access this wizard using the SCT Summary Definition option on the Insert menu.
Table 45: Create New SCT Summary Definition Wizard
Screen Description
Destination Displays the save location of the new SCT Summary Definition. You can only

save files in the Configuration Data > SCT Summary Definitions folder.
Identifier Specifies a name for the SCT Summary Definition object. A maximum of 32

characters.
Configure Defines the data of the Summary Definition and Configuration tabs.
Summary Displays the summary data of the SCT Summary Definition object.
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Tailored Summary Viewer Workflows
The following tables are high-level workflows for creating and using SCT Summary Definitions in the
Tailored Summary Viewer. These workflows assume a desired SCT Summary Definition exists.
Table 46: Tailored Summary Viewer Workflow - Using the All Items Tree
Step Description
1 In the All Items tree, select the objects you would like the SCT Summary Definition to apply

to in the Tailored Summary Viewer.
2 Click View > Tailored Summary Viewer. The Tailored Summary Viewer appears.

Select an SCT Summary Definition to apply to the objects.
3 Select an SCT Summary Definition to apply to the objects.

Table 47: Tailored Summary Viewer Workflow - Using Query > Global Search
Step Description
1 Click Query > Global Search. The Global Search Viewer appears.
2 Click Add to select the Search Locations. You can select multiple locations.
3 Enter the search criteria. You can enter an object name, object type, include child objects,

and include search locations in the search criteria. For more information, see Global
Search.

4 Click Search.
5 Select the rows you would like the SCT Summary Definition to apply to in the Tailored

Summary Viewer.
6 Click View > Tailored Summary Viewer. The Tailored Summary Viewer appears.
7 Select an SCT Summary Definition to apply to the objects.

Column Attributes for SCT Summary Definitions
When creating or editing an SCT Summary Definition, the Select Column Attribute dialog box allows
you to select the attributes to display in the Tailored Summary Viewer.
The following table lists examples of the attributes available for display in the Tailored Summary
feature according to the attribute filter. Click an attribute in the table to view its description. For
information on other attributes that do not appear in this table, search within this Help system PDF
by holding down Ctrl + F, or see the Index.
Table 48: Example Column Attributes for SCT Summary Definitions
Attribute Filter Example Attributes
BACnet • BACnet IP Port

• Instance Number
• Intrinsic Alarming Defined
• Object Name

Common Attributes • Authorization Category
Field Devices (General) • Disable Automatic Alarming
Field Devices (LON) • DSN1

• Neuron ID
• Program ID
• XIF Present
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Table 48: Example Column Attributes for SCT Summary Definitions
Attribute Filter Example Attributes
Field Devices (MSTP) • Memory Usage

• Object Count
• Trunk Number

Field Devices (N1) • Device Status
• NCM Name
• Object Count
• Poll Delay

Field Points (N2) • Controller Type
• Trunk Number

Field Points (General) • Device Type
• Max Value
• Min Value
• Out of Service

Field Points (LON) • Command Status Mapping Table
• Interface Value
• Target Reference
• Update Interval

Field Points (N1) • Feedback
• Setpoint

Integrations (MSTP) • APDU Retries
• Buffer Overflow
• Bus Health Index
• Bus Performance Index

Integrations (LON) • Missed Messages
• Transmit Errors
• Transaction Timeouts
• Transmits Per Minute

Integrations (N2) • Command Count
Space • Served By

• Type
Supervisory Devices • ADS Repository

• JCI IP Address
• Model Name
• Object Count

Trends • Buffer State
• Enable
• Sample Interval
• Transfer Setpoint
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Creating a New SCT Summary Definition
1. Click Insert > SCT Summary Definition. The Create New SCT Summary Definition wizard

appears.
2. On the Identifier screen, enter a name for the SCT Summary Definition. Click Next.
3. On the Configure screen, define the data of the SCT Summary Definition tab and the

Configure tab.

Note: One column is created by default when you create the definition and the user
interface does not let you remove the last column. You must define a minimum
of at least one column. You can add an unlimited number of rows or columns, but
performance is resource-dependent and may be affected by large queries.

4. Click Next. The Summary screen appears.
5. Click Finish. The new SCT Summary Definition appears in the Configuration Data > SCT

Summary Definitions folder.

Editing an Existing SCT Summary Definition
1. In the Configuration Data > SCT Summary Definitions folder, double-click the SCT Summary

Definition. The SCT Summary Definition appears in the display panel.
2. On the Summary Definition tab, click Edit.
3. To edit the attributes of the SCT Summary Definition, use the following table.

Table 49: Editing the SCT Summary Definition Attribute
Attribute How to Edit:
Label Enter the text to display as the label for the row header

column (that is, the first column).
The label is limited to a maximum of 50 characters. This
field also can be left blank.

Add, Remove, or Rearrange
columns in the table

• Click the Add icon to add a column at the end of
the table.

• Click a column header and then click the Remove
icon to remove the column from the table.

• To change the order of the columns, select a
column and drag it to the desired placement.

Column Headings Enter the text to display as the label for the column
header column (maximum 50 characters).
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Table 49: Editing the SCT Summary Definition Attribute
Attribute How to Edit:
Child Item Leave this field blank to display an attribute of the row

item.
Or, add a child item name using any of the following
methods:

• enter the name of the child item to display
Note: The child item is just an item name, not a
Fully Qualified Reference (FQR).

• select an item from the All Items Tree and drag it
to the Child Item text box

Note: This functionality is not available in the Cre-
ate New SCT Summary Definition wizard.

• click the Browse icon and the Select Item dialog
box appears. Select an item and click OK.

Note: You can define an unlimited number of item
names in a comma-delimited list.

Note: You can define an unlimited amount of wildcards.
The first item found that matches this item name pat-
tern is displayed.

Attribute Select the attribute to display (only when selecting an
attribute other than the default attribute):

1. Click Browse. The Select Column Attribute dialog
box appears.

2. In the Attribute filter list box, select a filter
category. The attributes of that type appear in the
Attribute list box.

3. In the Attribute list box, select an attribute.
4. Click OK.

4. Click Save.
5. On the Configuration tab, click Edit.
6. Click Save.

Viewing a Tailored Summary
For more information on Tailored Summaries, see the following sections:

• Viewing a Tailored Summary
• Exporting a Summary Definition
• Importing a Summary Definition

Parameter Sheet Viewer
Use the Parameter Sheet Viewer to view and edit CAF file data for selected field devices. To edit
CAF file data for a field device, complete the following steps:
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1. In the All Items tree, select the field device you want to view. To edit multiple field devices, hold
down shift while clicking each field device.

2. Click  View > Parameter Sheet Viewer.
3. In the Parameter Sheet window, select Parameter Sheet.
4. Click Edit to modify CAF file data. By default, the parameter sheet displays five standard VAV

CAF parameters: SA-Area, SA-KFactor, CLG-MaxFlow, CLGOCC-MinFlow, and HTGOCC-MinFlow.
5. To create CAF parameter columns and views, select Manage Views from the View drop-down

list.

Note: For information on how to edit CAF file data for an integration, see  CAF Parameters.

You can use the Parameter Sheet Viewer to view and issue commands to selected field devices.
You can command CAF file data after it is downloaded using the Tools > Trunk Utilities feature.
For information on how to download a CAF file, see Downloading a CAF to Devices Through Trunk
Utilities.

To view commands issued to a field device, complete the following steps:
1. In the All Items tree, select the field device that you want to view. To view multiple field devices,

hold down shift while clicking each field device.
2. Click View > Parameter Sheet Viewer.
3. In the Parameter Sheet window, select the Application Options view and switch the

parameter sheet mode to Online.

To modify commands issued to a field device, complete the following steps:
1. In the Application Options view, select the desired devices and click Edit to open the Trunk

Utilities wizard. The Commands radio button is automatically selected.
2. Specify the Commands and the Connection Type and click Next.

Note: Select one command to perform against selected devices. For an overview of
connection parameters and command features, see Downloading a CAF to Devices
Through Trunk Utilities.

3. Verify that the correct devices are selected and click Next.
4. Enter the connection parameters specific to your connection type and click Next.
5. Validate the information in the Trunk Utilities Summary window and click Finish.

Note: For information about how to command CAF file data for an integration see CAF
Parameters.

ActionQ

ActionQ Overview
The ActionQ receives time consuming jobs such as an upload or download from wizards, allows you
to edit and monitor the jobs, and sends the job information to the SCT for scheduled execution. You
can only access the ActionQ from the View Menu in SCT.
The ActionQ communicates with network engines over HTTP or HTTPS depending upon the Metasys
system release. At Release 8.1 and later, the ActionQ communicates with engines over HTTPS. At
Release 8.0 and earlier, the ActionQ communicates with engines over HTTP. The HTTPS column in
the Completed Actions and Actions in Progress window of the ActionQ indicates the connection
status for each engine.
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Improved ActionQ infrastructure at Release 12.0 provides you with more detailed statuses,
progress updates, and additional information in the log file entries for troubleshooting assistance.
The updated ActionQ Log file can be found through the C:\ProgramData\JohnsonControls
\MetasysIII\Diagnostics\ActionQueue path.

Note: In addition to the ActionQ Log, you can also view the Archive Log summary found under
the Tools < Diagnostics menu for a log of all actions processed as you update an archive or a
site.

ActionQ Operation
About this task:  
The ActionQ shows the status of jobs and allows you to monitor, enable, disable, delete, or
reschedule jobs. At Release 12.0 the improved ActionQ infrastructure provides you with more
detailed statuses and additional information in the log file entries. The updated ActionQ Log file can
be found under C:\ProgramData\JohnsonControls\MetasysIII\Diagnostics\ActionQueue

See the ActionQ Interface section. The ActionQ receives a job from one of the software wizards and
executes the command based on the date, time, and other resource specific parameters.

The order of operation is as follows:

1. The ActionQ receives a job from the Manage Archive wizard with a time to start (now or in the
future).

2. The ActionQ initiates the job (for example, starts the Upload process) at the specified start
time.

3. The ActionQ interface displays the progress and final status of the job.
Notes:

- The final status remains on the ActionQ screen until you delete it or it is automatically
deleted after a user-defined number of days (1–30).

- At this time, the ActionQ only supports Upload, Download, Upgrade/Migrate, and
Synchronize commands from the Manage Archive wizard.

ActionQ Interface
The ActionQ contains three main screens.
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Table 50: ActionQ Screens
Screen Description
ActionQ Allows you to view active, scheduled, and completed jobs. This screen is the

main screen of the ActionQ interface and has three tabs:
• Actions in Progress - Allows you to monitor, enable/disable, delete,

and reschedule jobs that are in progress or pending.
• Scheduled Actions - Allows you to view, enable/disable, delete, and

reschedule upcoming scheduled commands.
• Completed Actions - Allows you to view the status of completed jobs,

reschedule commands, and clear them from the screen.

Notes:

• A job is pending when it has not been issued because the recipient
device is busy as a result of too many incoming jobs.

• Once a job is issued, it may be complete before a command to
disable, delete, or reschedule reaches it.

ActionQ Reschedule
a Command Dialog
Box

• Allows clicking the Reschedule button from the Action in Progress,
Scheduled actions, or Completed Actions tabs of the ActionQ main
screen.

• Allows you to edit the scheduled start date and time of a job.

Note: If you schedule multiple jobs to occur at the same time, not all jobs will
begin at the specified time because they are waiting for others to complete.

ActionQ View Status
Dialog Box

• Appears after clicking the View Status button from the Completed
Actions tab of the ActionQ main screen.

• Allows you to view the completion information of a job, such as
destination, start time, end time, final status, error status, and any
additional information.

• Provides a new detailed view on the status of a completed job including
success and/or troubleshooting information.

ActionQ Steps

Launching the ActionQ

Note: You must be in offline mode (SCT) to access the ActionQ. The ActionQ automatically
launches after the Load wizard completes.

To launch the ActionQ Interface, select ActionQ from the View menu.

Enabling/Disabling a Job
1. Launch the ActionQ and select either the Actions in Progress tab or the Scheduled Actions

tab.
2. Click the job.
3. Click Enable or Disable on the Scheduled Actions tab or Disable on the Actions in Progress

tab.
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Rescheduling a Job
1. Launch the ActionQ and select a tab.
2. Click the job.
3. Click Reschedule. The ActionQ Reschedule a Command dialog box appears.
4. Edit the date and time using the drop-down menus.
5. Click OK.

Viewing the Status of a Job
1. Launch the ActionQ and select the Completed Actions tab.
2. Click the job.
3. Click View Status. The ActionQ View Status dialog box appears.
4. Click OK to return to the ActionQ screen.

Deleting a Job
1. Launch the ActionQ and select a tab.
2. Click the job.
3. Click Delete.

Automatically Deleting Completed Jobs
1. Launch the ActionQ and select the Completed Actions tab.
2. Enter the desired amount of days in the Number of days after which entries are

automatically deleted (1–30) text box.

Change Results Viewer
The Change Results Viewer allows you to view, save, and print the results of global commands and
global modifications sent using the Global Commands and Global Modify features. See the Modify
Dialog section for information on these features.

Change Results Viewer Overview
The Change Results Viewer displays the result entries for the global commands and global
modifications sent during the current user session. You can access the Change Results Viewer by
selecting Change Results from the View Menu.

Note: The Change Results Viewer screen is available for global commands and global
modifications only. Single object commands and modifications do not appear in the Change
Results Viewer.
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Figure 21: Change Results Viewer Screen

Table 51: Change Results Viewer Screen Components
Column/Button Description
Change Results Table Displays the results of all global commands/modifications sent during the

current user session.
If you select an item in the table and place your cursor over it within each
column, tooltips appear providing more information, if available.
Any data that does not fit within the columns is identified by an ellipsis
(. . .). You can resize the column or place your cursor over the table cell to
see its tooltip text.
If you send another global command/modification at a later time during
the current user session, the result entries are added to any existing result
entries from prior commands/modifications sent during the session.
The most recent entry appears at the top of this table by default. If
desired, you can sort the results.
See the Working with the Change Results Viewer section for more
information on manipulating and using the table data.

When Displays the date and time the command/modification was sent.
Item Displays the name of the object to which the command/modification was

sent. The object’s full reference identifier appears in a tooltip when you
place the cursor over the name.

Change Type Displays the type of command/modification sent.
Parameters Displays the list of parameters for the command/modification that was

sent. For example, for a Release command, an attribute and priority such
as Present Value, 15 (Scheduling) appear in the Parameters column.
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Table 51: Change Results Viewer Screen Components
Column/Button Description
Status Displays the status of the command/modification that was sent (for

example, OK or an explanation of failure).
Notes:

• An OK status for a command indicates the supervisory device
validated and accepted the command, but does not necessarily
indicate the command executed successfully. There may be cases
where the command is accepted, but fails execution. For example,
a Route command to a trend extension may be accepted by the
supervisory device with a status of OK; but if the actual routing of the
trend data fails due to the ADSADS/ODS offline or other error, the
failure is noted in the Audit log at that point in time.

• An OK status for a modification indicates the modification executed
successfully.

Clear Results Viewer Deletes all the entries from the Change Results Viewer and adds an entry
to indicate when it cleared those entries.

Copy Copies the selected change results to the Clipboard for pasting into other
applications such as Microsoft Excel® or Word®.

Save to File Saves the current content of the change results table to a text file.

Change Results Viewer Steps

Working with the Change Results Viewer

Displaying the Change Results Viewer
To display the Change Results Viewer, select Change Results from the View menu. The Change
Results Viewer appears in the display panel.

Note: If no global commands/modifications were issued during the current user session,
the Change Results Viewer appears with a message stating No global commands or
modifications have been issued within the current session.

Selecting Entries in the Change Results Viewer
To select entries in the Change Results Viewer, click an individual entry in the change results table
or use the Ctrl or Shift keys when clicking to select multiple entries.

Note: You also can click and drag your cursor over entries in the change results table to select
entries that appear consecutively. With an entry in the change results table selected, you can
press Ctrl+A to select all entries.

Sorting Change Results in the Change Results Viewer
To sort change results in the Change Results Viewer, click the heading of the desired column in the
change results table. The results sort and a small arrow appears indicating the order of the sort
(ascending or descending). Click the column heading again to change the sort order.

Reordering Columns in the Change Results Viewer
To reorder the columns in the Change Results Viewer, drag the heading of the column to the
desired location.
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Printing the Change Results
To print the contents of Change Results Viewer, follow the Printing Specific Help Topics section
instructions.

Saving Change Results to File
About this task:  
To save the contents of the Change Results Viewer to a file:

1. Click Save to File. The Save dialog box appears.
2. Specify the desired location to save the results.

Note: The default name for the text file is ChangeResultsLog.txt. You can change the
name as you wish to further identify these results, or to prevent overwriting previously
saved results.

3. Click Save.

Copying Change Results to the Clipboard
About this task:  
To copy change results in the Change Results Viewer to the clipboard:

1. Select the desired results according to the Selecting Entries in the Change Results Viewer
section.

2. Click Copy.

Note: You also can use Ctrl+C to copy the data.

3. Open the program to paste the results (for example, Microsoft Excel or Word).
4. Paste the results according the program’s conventions (generally, Edit > Paste or Ctrl+V).

Clearing the Change Results Viewer
About this task:  
If the size of the results log becomes too large, the Global Command or Global Modify feature
prompts you to clear the change results.

To clear all change results in the Change Results Viewer:

1. Click Clear Results Viewer. A dialog box appears asking if you want to permanently clear all
command results.

2. Click Yes.

Extended Labels
Menu Selection: View > Extended Labels (select the check box)
Toggles the display of the item labels in the All Items navigation tree or user navigation tree from
standard to extended. An extended label shows the BACnet object name that was defined when the
object was initially created in braces next to the standard label. This is the name used in the object's
Fully Qualified Reference. The Metasys object name may be the same as the BACnet object name, or
it may have been edited as a label that is more recognizable to the user.
Example:
Standard Label = N2 Trunk1
Extended Label = N2 Trunk1{N2-1}
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Product Version Labels
Menu Selection: View > Product Version Labels (select the check box)
Toggles the display of the item labels in the All Items navigation tree or user navigation tree from
standard to product version. A product version label shows the software revision of servers and
engines in parentheses next to the standard label.
Example:
Standard Label = NAE-Building-1
Extended Label = NAE-Building-1 (10.1)
Notes:

• SCT allows you to maintain a mixed-release archive that contains devices at varying release
versions from 5.2 through 10.1.

• Site Directors can be upgraded to any release and do not require the current release version.
Devices that are not Site Directors must be at an equal or lower release version than the Site
Director. For example, a site with a Release 10.0 Site Director cannot contain a Release 10.1
child-device.

Validation Labels/Settings
Menu Selection: View > Validation Labels > Validation Settings (in the SCT UI) (select the check box)
In the SCT, this setting toggles the display of the item labels in the All Items navigation tree or
user navigation tree to show extra label information for MVE. When selected, this menu item also
displays the Validation Settings attribute section for objects on the Focus/Configuration tab.
This setting has no effect in the online UI (the validation labels are always visible).

Panel Layout
The Display Frame can be divided into up to four display panels. When viewing an item in a display
panel, the name, status, and default attribute (usually the present value) of the item you display
appear at the top of the display panel. Each display panel can contain different tabs, depending
on the item selected from the navigation tree, and each tab shows different information. Dynamic
attributes displayed in a panel automatically refresh when changes are detected.
The default display panel is the first empty panel or last unlocked panel if all displayed panels are
filled. Display panels are locked while in Edit mode, or may be locked using the Lock button of the
selected display panel. If all available panels are locked, you cannot display an additional item in
any of the display panels.
You can resize each display panel by dragging its borders, or using an available splitter bar. With
some items, an Edit button appears (except in Simulation mode), allowing you to edit the item’s
configuration attributes.
You can drag and drop items into a display panel and navigate among them using the Back and
Forward display panel buttons. The display panel holds a maximum history of five items.
The data presented in a report comes from a snapshot of the system at the time you request the
report. The displayed data does not automatically refresh and does not support an Edit mode. You
can manually refresh the report through the Action Menu.

Display Frame Layout
The user interface allows you to define your own display frame layout. Six options are available:
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Figure 22: Panel Layout Options

To change the way the panels are arranged, see Changing the Display Panel Layout. If you have a
multi-panel display and you change to a layout with fewer panels, the locked items/newest items
in the view stay, depending on how many panes are available in the new layout. The other panels
close, and they do not reappear if you switch back to the multi-pane view.
To resize the panels, drag the borders of the panel until it reaches the desired size. To make one
panel (in a multi-panel arrangement), take up the entire Display frame temporarily, click the
maximize button. To restore a maximized panel in a multi-pane view, click the restore button. A
panel can also be maximized/restored by double-clicking its header bar.

Changing the Display Panel Layout
To change the Display Panel layout, on the View menu, select Panel Layout and choose one of the
six layouts.

Action Menu
In addition to the four modes of operation that determine the items appearing in menus, the Action
menu is context specific. Different item specific options appear in the Action menu based on what is
currently selected in the navigation tree. Also, different feature specific options appear in the Action
menu based on the active panel or feature displayed in the selected display panel.

Note: The options available in the Action Menu are also accessible through the right-click
functionality.

Action Menu Introductions

Action Menu Items

Note: Many Action menu features are also accessible through the All Items tree. For more
information see Right-Click Menus and Menu Bar Equivalents.

Import Definition
Menu Selection: Action > Import Definition
Imports the pre-built summary definition that is stored on the computer and is only available when
the Summary Definitions folder is selected in the All Items tree. After importing a definition, the
imported Summary Definitions appear in the Summary Definitions folder in the All Items tree.

Note: You also can import Summary Definitions that were previously exported.

Locate in Tree
Menu Selection: Action > Locate in Tree
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Displays the expanded Equipment, Spaces, or All Items tree location for an object selected from the
focus window. Locate in Tree is particularly useful in SCT when you are modifying an archive in the
focus window and you need to locate an object in the All Items tree.

Note: Locate in Tree is not compatible with either User Views or the Unlicensed Item trees.

Export Definition
Menu Selection: Action > Export Definition
Exports the summary definition that is stored in the Summary Definitions folder in the All Items tree
to a location on the computer. You can now share the Summary Definition with others and import it
to other sites as desired.

Note: If you import the Summary Definition to another site, you may need to update the key
data references.

Rename
Menu Selection: Action > Rename
Renames the selected Engine device in the SCT.
Notes:

• When renaming a Metasys server, the name must match the host name of the computer on
which the Metasys server is installed.

• This rename option may take a while to complete because it changes the database references
to the device.

Refresh All Tabs
Menu Selection: Action > Refresh All Tabs
Refreshes the data displayed in all tabs of the active display panel or the navigation frame.

Refresh Current Tab
Menu Selection: Action > Refresh Current Tab
Refreshes the data displayed in the current tab of the active frame or panel.

Import Integration
Menu Selection: Action > Import Integration
This command is only available when an Integration under an engine is selected in the All Items
tree. After adding an Integration, you can select the integration in the navigation tree and use this
menu selection to add existing devices and points under the integration.

Export CAF File
Menu Selection: Action > Export CAF File
Exports the Controller Application File (.caf) file that currently resides in the field controller. The .caf
file contains all the logic components needed to represent a system. You can save the exported .caf
file anywhere on your computer. The name of the .caf file matches what is defined in the File Name
field on the Resource screen. This command is only available when a field controller under an
engine is selected in the All Items tree.

Export CAF Files
Menu Selection: Action > Export CAF Files
Exports the Controller Application File (.caf) file that currently resides in each field controller under
the field bus. For example, if 10 controllers are defined under the field bus, 10 individual .caf
files are exported. Each .caf file contains all the logic components needed to represent a system.
You can save the exported .caf files to any location on your computer. The name of each .caf file
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matches what is defined in the File Name field on the Resource screen. This command is only
available when a field controller under an engine is selected in the All Items tree.

Remove From Site
Menu Selection: Action > Remove From Site
Removes (deletes) the selected engine, Metasys Server, or ODS from the site. The selected engine ,
Metasys Server, or ODS must be offline to use this option. You also can remove a device from the
site in a Tailored Summary with Engine device data.

Site Discovery
Menu Selection: Action > Site Discovery
Creates the archive database of the site by accessing object data from all Metasys devices on the
building network. This function is helpful if the archive database has not been maintained by
Johnson Controls or the customer. For sites at Release 5.2 or later, the archive is automatically
created at the released version of the site. For sites earlier than Release 5.2, the site archive is
created at the version of SCT currently installed. The Site Discovery option is available when a Site
object is selected in the All Items tree.
For the ODS, Site Discovery works best when the ODS is used in the Site Manager Workstation
configuration. When the ODS is used in the BACnet Workstation configuration, the Metasys engines
are discovered, but any database content in and under the engines is not discoverable.
Notes:

• To ensure Site Discovery performance, the local application (Controller Application File/CAF
file) for any field controller is not uploaded during the process.

• You can use the Manage Archive/Upload function after the initial site discovery of devices to
upload and add the CAF files into the archive.

• Discovering objects within a device that contains a large number of objects can require several
minutes to complete.

• The SCT device order may differ from the order displayed in the ADS/ADX until you upload the
Site Director. If the SCT device order remains unordered after you upload the Site Director, use
the All Items Organizer to manually specify the order of devices.

After Site Discovery, immediately perform an upload of the engine to ensure the archive database is
current with the online database.

Action Menu - Feature Specific
The following table describes the different menu items that appear in the Action menu based on
the active panel or feature displayed in the selected display panel. Click each active panel or feature
for a description. For more information on the modes of operation, see Metasys Modes.

Note: The Refresh, Refresh Current Tab, and Refresh All Tabs menu items appear in the Action
menu for all other features or active panels.
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Table 52: Action Menu - Feature Specific
Active Panel/Feature Content

Event Viewer • Refresh
• Add Annotation (available on the only.)
• View Annotations (available on the only.)
• Ack
• Discard

Audit Viewer • Refresh
• Add Annotation (available on the only.)
• View Annotations (available on the only.)
• Clear Audit Log

ActionQ

Tailored Summary Viewer
The menu options available are item-specific
(that is, they depend on the type of item
selected in the Summary Definitions and Key
Data tables).

• Command
• Modify
• Add Annotation (available on the only.)
• View Annotations (available on the only.)
• Show Extensions
• Remove From Site (available for a network

engine only).
• Import Integration (available for a Tailored

Summary with trunk/integration data. For
example, trunk diagnostics).

Global Search • Refresh

Change Results Viewer No Action menu options for this feature.

Action Menu - Item Specific
The following table describes the different menu items that appear in the Action menu based
on what is currently selected in the navigation tree. Click each item for a description. For more
information on the modes of operation, see Metasys Modes.

Note: The Refresh Current Tab and Refresh All Tabs menu items appear in the Action menu for
all of these items.
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Table 53: Action Menu - Item Specific
Contents In ModeItem

Online (Standard
Access)

Offline (SCT) Simulation

Metasys Server • Command
• Modify
• Add Annotation
• View Annotations
• Remove From Site

• Modify
• Rename

Integration • Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions
• Import Integration

• Modify
• Show Extensions
• Import Integration
• Export .caf files on

a MSTP Field Bus
integration

• Command
• Show Extensions

Site Object • Command
• Add Annotation
• View Annotations

• Site Discovery • Command

Supervisory Device
(Network Engine)

• Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions
• Remove From Site

• Modify
• Show Extensions
• Start Simulation
• Rename

• Command
• Show Extensions

All Other Objects • Command
• Modify
• Add Annotation
• View Annotations
• Show Extensions

• Modify
• Show Extensions

• Command
• Show Extensions

Modify Dialog

Note: The term edit refers to changing items using the Edit button. See the Modify section.
The term modify refers to changing items using the Modify menu item and the Modify dialog
box as described in this section.

The Modify dialog box allows you to modify attributes of a single item (single modify feature) or
multiple items at once (global modify feature). For example, you can open the Global Search Viewer
or a Tailored Summary in a display panel and select one or more items from the table to modify; or
you could send a modification to change the Authorization Category of all VAV boxes in your facility
from General to HVAC. Only attributes common to all items being modified appear in the Global
Modify dialog box.
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The single modify feature uses the Modify dialog box. The global modify feature uses the Global
Modify dialog box for sending modifications and uses the Change Results Viewer for viewing,
saving, and printing the sent global modifications.
For information on the Change Results Viewer and how to use it, see the Change Results Viewer
section. The Change Results Viewer is used by both the Global Modify and the Global Commands
features.
See Using Global Modify with Global Search in this section for steps on using the Global Search and
Global Modify features together.

Modify
About this task:  
The term modify refers to changing items using the Modify menu item and the Modify dialog box.
See the Modify Dialog section.

To edit items in the UGT, refer to the User Graphics Tool section in the Metasys SMP Help
(LIT-1201793).

To edit the attributes of an item:

1. View the details of the item in a display panel.
2. Select an item tab (for example, Focus).

Note: Some items contain an Advanced radio button. If you select this button, additional
attributes appear.

3. Click Edit.
4. Edit the attributes as needed.

Note: If you place your cursor over an edit field, the ToolTip provides information about
the valid format or range for that value. ToolTips also appear for strings.

5. Click Save.
For information on using the Modify dialog box to modify single or multiple items, see the
Modify Dialog section.

Modify Dialog Box
The Modify dialog box allows you to modify attributes of a single item in the Metasys system. You
can access the Modify dialog box for the selected item by selecting the Modify menu option from
the Action Menu or the right-click menu. The attributes shown in the modify box are different for
different object types.
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Figure 23: Modify Dialog Box

Table 54: Modify Dialog Box Components
Screen Area/Item Description
Instructions Area Provides tips to help you send a modification.
Attributes Table Displays the list of attributes available to modify for the selected item.

Unauthorized modifications are disabled. Attribute value fields appear
after the attribute name.
The check box next to an attribute is automatically selected when you
make a modification in its value field. Modifications are sent for only the
selected (checked) attributes.

Send Sends the selected modifications to the object/item.
Cancel Closes the Modify dialog box without sending the changes.

Global Modify Dialog Box
The Global Modify dialog box allows you to modify common attributes of multiple items in the
Metasys system. You can access the Global Modify dialog box for the selected items by selecting the
Modify menu option from the Action Menu or the right-click menu.
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Figure 24: Global Modify Dialog Box - Attributes Tab

Figure 25: Global Modify Dialog Box - Items Tab
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Table 55: Global Modify Dialog Box Components
Screen Area/Item Description
Instructions Area Provides tips to help you send global modifications.
Attributes Tab Displays the list of common attributes available to modify for the selected

items. Unauthorized modifications are disabled. Attribute value fields
appear after the attribute name.
The check box next to an attribute is automatically selected when you make
a modification in its value field. Modifications are sent for only the selected
(checked) attributes.

Items Tab Lists the selected items in table format and indicates:

• if you are authorized/unauthorized to modify the items
• the number of items to be modified

Send Sends the selected modification to the objects/items listed in the Items tab.
Cancel Closes the Global Modify dialog box without sending the changes.
Show Modify Results Displays the Change Results Viewer in the display panel after clicking Send

(when this box is checked).

Modify Attributes
The following table lists the attribute groupings and examples of the attributes available for
modification.

Note: You can easily enter each controller's Fully Qualified Reference (FQR) by entering an
asterisk (*) in the Graphic Alias field.

Table 56: Modify Attributes
Attribute Grouping Example Attributes
General • Change of Value (COV) Increment

• Display Precision
• Authorization Category
• Units

BACnet Intrinsic Alarming • BACnet Deadband
• High Limit
• Low Limit

Alarm Values • Differential
• High Alarm Limit
• Low Alarm Limit

Alarm Setup • Alarm Ack Required
• Alarm Message Text
• Alarm Priority
• Event Enable

Graphic Setup • Graphic
• Graphic Alias
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Modify Dialog Steps

Modifying a Single Item
About this task:  
This procedure is for modifying a single item. To modify multiple items, see Performing a Global
Modify. For information on editing an item using the Edit button in the display panel, see the
Modify section.

You can modify an item from the navigation tree, display panel view (for example, Tailored
Summary view), or Global Search Results table.

To modify a single item:

1. Select and right-click a single item in the navigation tree, display panel view, or global
search results. Select the Modify menu item. Or, select a single item and select the Modify
command from the Action menu. The Modify dialog box appears.

2. Make changes to one or more attributes as desired.
3. Click Send.

Performing a Global Modify
About this task:  
This procedure is for modifying more than one item in a single operation. To modify a single item,
see Modifying a Single Item. For information on editing an item using the Edit button in the display
panel, see the Modify section.

You can globally modify items online and in the SCT. You can perform a global modification on
items from the navigation tree, display panel view (for example, Tailored Summary view), or Global
Search Results table.

Note: Once sent, you cannot undo a global modification; however, you can send another
global modification to readjust values as needed.

To perform a Global Modify:

1. Select multiple items in the navigation tree, display panel view, or global search results. Right-
click the items and select the Modify menu item. The Global Modify dialog box appears.

Note: The Items tab lists the selected items and your permissions to modify them.

2. On the Attributes tab, make changes to one or more attributes as desired.

Note: You can easily enter each controller's Fully Qualified Reference (FQR) by entering
an asterisk (*) in the Graphic Alias field.

3. Select the Show Modify Results check box to display the results of the modifications, if
desired.

4. Click Send. If you selected to view results, the Change Results Viewer appears in a display
panel. The Change Results Viewer has options to copy the results, save the results to a file,
and clear the results.
Notes:

- If you are not authorized to send a global modification to one or more objects, a dialog
box appears stating the modification can not be sent to unauthorized objects. Click Yes
to continue to send the modification to the authorized objects. Click No to return to the
Modify dialog box without sending the modification to any objects. Click Cancel to close
the Modify dialog box without sending the modification to any objects. Your system
access and category-based privileges set in the Security Administrator System determine
your authorization.
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- On a Metasys for Validated Environments (MVE) site, you are prompted to authorize this
action (only once) with the defined annotation and/or electronic signature requirements.

Note: If you are not authorized to send a global modification to one or more objects,
a dialog box appears stating the modification can not be sent to unauthorized objects.
Click Yes to continue to send the modification to the authorized objects. Click No to
return to the Modify dialog box without sending the modification to any objects. Click
Cancel to close the Modify dialog box without sending the modification to any objects.
Your system access and category-based privileges set in the Security Administrator
System determine your authorization.

After the modification has been sent to all selected items, the Global Modify Completed dia-
log box appears indicating:

- the attributes that were modified (appears in a comma delimited list)
- the date/time the modification started and completed
- the number of successful/failed modifications
- if any modifications were not sent because they were unauthorized
- the total modifications attempted

Figure 26: Global Modify Completed Dialog Box

Note: The Succeeded value in the Global Modify Completed window reflects the number
of objects modified, not the number of object attributes modified.

5. Click OK.

Result  
See Working with the Change Results Viewer in the Change Results Viewer section.

Using Global Modify with Global Search
About this task:  
To use Global Modify with Global Search:

1. Perform a global search according to the Performing a Global Search procedure in the Global
Search section. For example, search for alarms that you plan to modify.

2. Save the object list if this is a common search (for example, you plan to modify the alarms or
review their status often). See Working with Search Results in the Global Search section.
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3. Select the items in the search results and send a global modify according to the instructions
in the Performing a Global Modify section.

Extensions
Extensions add features, such as trending, alarming, and totalization, to an item.
Click one of the following for more information on extensions:

• For information on searching for extensions, see the Global Search section.
• For information on commanding extensions, see Commanding Extensions.

Alarm Extensions
Alarm extensions monitor an attribute of an object and send alarms using the Alarm and Event
Management feature. There are two types of alarm extensions, Analog Alarm and Multistate Alarm.
Use the Analog Alarm extension to monitor attributes with real values. Use the Multistate Alarm
extension to monitor attributes with True or False, or Multistate data types.
For general information on Metasys system objects, see the Object Help section.

Alarm Extensions Concepts

Analog Alarm Extension
The Analog Alarm extension adds the alarming capability for attributes with real values, such as
the Present Value of an Analog Input Object. This extension detects an alarm based on up to four
limits and can be configured to report that alarm. It also sets the Alarm State attribute of the object
to which it is added. The Analog Alarm Extension is also used with the Graphic Setting Preferences,
which are used to establish color choices for alarm conditions in graphics.
For example, you can configure the Analog Alarm extension to issue an alarm if the temperature in
a room falls below 15.6˚C (60˚F).

Multistate Alarm Extension
The Multistate Alarm extension adds the alarming capability for an attribute with True or False, or
Multistate data types, such as the Present Value of a Binary Input Object.
The Multistate Alarm extension detects the alarm with respect to a difference from a defined
normal state and sets the Alarm State attribute of the object to which it is added. In addition, you
can configure the Multistate Alarm extension to report alarms and True or False and/or Multistate
events.

Normal State
Normal state occurs when the alarm extension is in an acceptable, expected condition, as indicated
by the attribute point to which it is added.

Warning State
Warning state occurs when the analog alarm extension transitions from Normal into the high or
low warning conditions.

Alarm State
Alarm state occurs when the extension transitions into the high alarm, low alarm, or unreliable
conditions.

AO/BO Feedback
The Alarm extensions provide feedback in points to prevent the detection of alarm conditions
that are really false alarms. For the Analog Alarm Extension, this feedback is done through the
configuration of the Setpoint Reference attribute. For the Multistate Alarm Extension, this feedback
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is done through the configuration of the Command Reference attribute. When you reference other
attributes using the Setpoint Reference or Command Reference attributes, the alarm analysis works
differently.
Analog Points:
For example, add an Analog Alarm extension to an Analog Input Object (zone temperature). Define
the Present Value of the Analog Input Object as the Input Reference and define the Define the
Present Value of an Analog Output Object (setpoint) as the Setpoint Reference of the Analog Alarm
extension.
If you edit the Setpoint (Define the Present Value attribute of the Analog Output Object), the
Warning Reference attribute of the Analog Alarm extension of the Zone Temperature Analog Input
Object changes to the same value. The Reference Delay Time of the Analog Alarm extension resets
at this same time and prevents a false alarm condition from being detected.
Binary or Multistate Points:
For example, add a Multistate Alarm extension to a Binary Input Object or Multistate Input Object.
Define the Present Value of a Binary Input (fan status) or Multistate Input as the Input Reference;
then define the Present Value of a Binary Output Object (command state) or Multistate Output
Object as the Command Reference of the Multistate Alarm extension.
If you edit the Command State (Present Value attribute of the Binary Output Object or Multistate
Output Object), the Normal State attribute of the Multistate Alarm extension of the Fan Status
Binary Input Object or Multistate Input Object changes to the same value. The Reference Delay
Time of the Multistate Alarm extension resets at this same time, preventing a false alarm condition
from being detected.

Delay Timer Interaction
There are two timers used to delay the analysis or reporting of an alarm. These timers are used to
allow normal functions to occur before an object’s behavior appears abnormal and generates an
alarm. The first timer is the Alarm State: Reference Delay Timer, which allows a preset amount
of time to pass between commanding an object and making sure that the commanded object has
obeyed the command before considering an alarm condition to be present. The second timer is the
Alarm State: Report Delay Timer, which prevents the analysis of an object’s condition until the
preset time has passed after that object has appeared to obey a command.
The length of the reference delay time is a combination of the reference delay time and the report
delay time settings. If you change the warning reference, both delays go active; and if the reference
delay time is greater than or equal to the report delay time, then the total delay is the sum of both
timer settings. However, if the reference delay time is less than the report delay time, then the
delay is equal to the report delay time setting.
The delay timers of the alarm extensions interact as follows:

Note: If no Warning Limits are defined, the Reference Delay Time and Reference Delay Timer
Active attributes do not apply.
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Figure 27: Delay Timer Interaction

Table 57: Delay Timer Interaction Description
Callout Name User Action
1 Warning

reference
command

Commands the Warning reference to change, moves the setpoint
and the corresponding High and Low warnings.

2 Reference Delay
Timer

Timer starts when the Warning Reference changes.

3 Report Delay
Interval

Interval starts if high or low warning is exceeded. The delay is
applied on both the entrance into the alarm condition and the exit
out of the alarm condition.

4 After Report
Delay Interval

Input reference is analyzed for alarm conditions.

See the Multistate Alarm Delay Examples section.
See the Analog Alarm Attributes and the Multistate Alarm Attributes for more information.

Multistate Alarm Delay Examples
About this task:  
When attaching alarm extensions to Binary objects, we recommend that the Alarm extension be
attached to a Binary Input Object (BI). When the Binary Output Object (BO) is commanded On, the
command is seen by the command reference of the BI and triggers the Alarm State: Reference
Delay Timer, which changes the Normal state of the associated BI. The Reference: Input of the BI
should change to match the new Normal state during the time set by the Alarm State: Reference
Delay Timer. If it does not, the BI immediately goes into Alarm upon expiration of the Reference
Delay Time. If the BI Reference: Input changes to match the new Normal state, then the Alarm
State: Report Delay Timer starts. The Alarm State: Report Delay time does not delay delivery of a
previously generated report. It delays the analysis of the BI object for an alarm condition until the
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Report Delay time has passed. Once the Report Delay time passes, the BI is analyzed for Alarm
conditions.

For example, with a BO controlling a fan and a BI with an Alarm Extension set using the BO as an
Input reference, two possible conditions are affected by the Alarm State delay timers:

1. Fan On and Operating Normally—In the following figure, a fan has been commanded On
and is operating normally. In this case, when the BO commands the Fan On, the Normal State
of the BI changes to On and the Reference Delay Time starts. Within the interval set by the
Reference Delay Time, the Input Reference of the BI changes to On and the Report Delay time
starts. After the Reference Delay Time and Report Delay Time have passed, the BI is analyzed
for Alarm conditions.

Figure 28: Fan On and Operating Normally

Table 58: Fan On and Operating Normally Example Description
Callout Name User Action
1 BO Command Fan is commanded On from BO.
2 BI Normal

State
BI Normal State switches to On.

3 Alarm State:
Reference
Delay Timer

Reference Delay Timer interval starts when BI Normal State
switches to On.

4 BI Input BI Input switches On during the Reference Delay Timer
interval.

5 Alarm State:
Report Delay

Report Delay interval starts when BI Input switches to On.

6 After Report
Delay Interval

BI is analyzed for alarm conditions.
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2. Fan Is Commanded On but the Fan Is Not Working—In the following figure, the fan is
commanded on but does not turn on due to a problem. In this case, the BO commands the
Fan On, the Normal State of the BI changes to On, and the Reference Delay Time starts.
However, the Input Reference of the BI never changes to On because the Fan does not turn
on. Therefore, the Alarm State: Report Delay Timer never starts. After the interval set by the
Alarm State: Reference Delay Time, the BI goes into an Alarm condition.

Figure 29: Fan Is Commanded On but the Fan Is Not Working

Table 59: Fan Is Commanded On but the Fan Is Not Working Description
Callout Name User Action
1 BO Command Fan is commanded On from BO.
2 BI Normal

State
BI Normal State switches to On.

3 Alarm State:
Reference
Delay Timer

Reference Delay Timer interval starts when BI Normal State
switches to On.

4 BI Input BI Input does not turn On during the Reference Delay Timer
interval due to problem with Fan.

5 Alarm State:
Report Delay

After Reference Delay Timer interval. BI is analyzed and goes
into Alarm.

Analog Alarm Attributes
The Analog Alarm Extension contains attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Analog Alarm extension. The list of Attribute
names are displayed in the Focus Window of the Site Management Portal view of the Alarm
Extension. Click the attribute name in the table for a description of the attribute.
Notes:

• In the Notes column, letters indicate the following: C - Configurable, D - Default Attribute for
Display, N - Value Not Required, R - Affected by Extension’s Reliability, W - Writable.
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• In the SUM (Tailored Summary Pick) column, attributes marked with an X can be used in
the Tailored Summary User View. See the Defining User Views with Summary Definitions
section for information about recommended groupings of Summary Definitions in a Tailored
Summary.

• In the MOD (Global Modify) column, attributes marked with an X can be mass edited from a
Tailored Summary or Global Search Results.

• In the SCT (SCT Configuration Attribute) column, attributes marked with an X are viewable in
the SCT Alarm Extension Focus Window.

Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Alarm Ack
Pending

False Ack not pending,
Ack pending

Indicates that an event concerning
a transition into the Alarm state is
waiting for acknowledgment.

X

Alarm Ack
Required

C,W False Ack not required,
Ack required

Indicates that a transition into the
Alarm state created a message that
requires acknowledgment.

X X X

Alarm Date Indicates the last date this extension
transitioned into the Alarm state. Each
time this transition occurs, a message
is created and this date is updated.

X

Alarm Message
Text

C,N,W Indicates the text you assigned to give
further information in the event of
an alarm. Only status changes to an
alarm state add the alarm message
text reference.

X X X

Alarm Priority C,W 70 Indicates the priority assigned to the
Alarm state.

X X X

Alarm Time Indicates the last time this extension
transitioned into the Alarm state. Each
time this transition occurs, a message
is created and this time is updated.

X

Cooling
Setpoint

C,N,W Null Indicates the actual monitored Cooling
Setpoint value based on the Setpoint
Reference mapping. You can either
define the Cooling Setpoint and High
Alarm Limit or the Setpoint Reference.
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Cooling
Setpoint
Reference

C,W Null When specified, indicates the Above
Setpoint limit. You must define both
the Cooling Setpoint Reference and
Heating Setpoint Reference, or leave
both blank. If the Cooling Setpoint
Reference is defined, the High Warning
Offset is added to the Cooling Setpoint
Reference value to calculate the High
Warning Limit.
The Heating and Cooling Setpoint
References are typically mapped to the
Actual Heating and Cooling Setpoints
created for all FEC based VAV and
Terminal Unit control applications.
The High and Low Warning Offsets are
added to these references to calculate
the High and Low Warning Limits.
These reference points are used in
conjunction with the Room Control
Module Graphics Symbol to provide
indication of above and below setpoint
conditions.

X X X

Date Indicates the date of the last change
in the Present Value or Reliability
reported by this extension.

Description C,W Maximum 40
characters before
Release 8.0.
Maximum 64
characters at
Release 8.0 and
later.

Identifies the alarm extension in detail. X

SCT: System Configuration Tool Help144



Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Differential C,W 0.00 Positive value Specifies a deadband range used for
analog object state transitions from
High Alarm Limit, Low Alarm Limit,
High Warning Offset, and Low Warning
Offset. If the Differential is applied to
an object in High Alarm, the object
remains in the state until it changes to
a value less than the High Alarm Limit
minus the value of the Differential.
When the Cooling Setpoint and the
Heating Setpoint are configured, the
Differential specifies:

• The deadband range for
transitions to the Above and
Below Setpoint states.

• The deadband range for
transitions from Above and
Below Setpoint states to return
to a Normal state. In this case,
half of the value specified for the
Differential is used. This allows
the value to return to normal
in cases where the control
algorithm controls to a value
close to the setpoint, but may not
achieve or cross the setpoint.

X X X

Enabled W True Indicates whether the alarm extension
is enabled.

X

Error Log Indicates the reliability of the following
references:

• Input Ref Status
• Warning Ref Status
• Setpoint Ref Status
• Cooling Setpoint Ref Status
• Heating Setpoint Ref Status
• Occupancy Ref Status

If a reference is not defined, the value
will be No Input.

Event Enable C,W True Determines if an alarm condition is
reported back to the event viewer and
if alarm pop-ups are created.

X X

Graphic C,N,W Null Object Type =
Graphic

Indicates the graphic associated with
the extension.
Do not set the Graphic attribute for
an alarm extension to an aliased
graphic. Aliased graphics do not display
properly when displayed from the
Alarms Window or Event Viewer.

X X
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Graphic Alias C,W Maximum 256
characters

Indicates a portion of the graphic’s
item reference, up to and including
the name of the folder containing this
extension or the controller containing
this extension.

X X

Heating
Setpoint

C,N,W Null The Heating and Cooling Setpoint
References are typically mapped to the
Actual Heating and Cooling Setpoints
created for all FEC-based VAV and
Terminal Unit control applications.
The High and Low Warning Offsets are
added to these references to calculate
the High and Low Warning Limits.
These reference points are used in
conjunction with the Room Control
Module Graphics Symbol to provide
indication of above and below setpoint
conditions.
You can either define the Cooling
Setpoint and Low Alarm Limit or the
Setpoint Reference.

Heating
Setpoint
Reference

C,W Null Indicates the value of the Below
Setpoint limit. You must define both
the Cooling Setpoint Reference and
Heating Setpoint Reference, or leave
both blank.

X X X

High Alarm
Limit

C,N,W Specifies the actual High Alarm Limit. If
blank, the limit is not used.

High Alarm
Limit

Null Specifies the actual High Alarm Limit. If
blank, the limit is not used.

X X X

High Warning
Offset

C,N,W Positive value Indicates the value added to the
Warning Reference or Setpoint
Reference variable to determine the
actual High Warning Limit. If blank, the
offset is not used and warning analysis
is disabled. Both the High Warning
Offset and Low Warning Offset must be
defined, or both must be blank.

X X X

Input Indicates the last value received from
the Input Reference.

Input
Reference

C Specifies the object and attribute
monitored by this alarm extension.
The reliability of the Input Reference
is monitored and sets the Reliability
attribute of this extension. It also can
be reported in an alarm message.

Item Reference Specifies the name of the alarm that
the alarm extension is referencing.

Low Alarm
Limit

C,N,W Specifies the actual Low Alarm Limit. If
blank, the limit is not used.

X X X
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Low Warning
Offset

C,N,W Positive value Indicates the value subtracted from
the Warning Reference or Setpoint
Reference variable to determine the
actual Low Warning limit. If blank, the
offset is not used and warning analysis
is disabled. Both the High Warning
Offset and Low Warning Offset must be
defined, or both must be blank.

X X X

Name C,W Maximum 400
characters

Name of the alarm extension attribute. X X

Normal Ack
Pending

False Ack not pending,
Ack pending

Indicates if an event in transition
to the Normal state is awaiting
acknowledgment.

X

Normal Ack
Required

C,W False Ack not required,
Ack required

Indicates that a transition into the
Normal state created a message that
requires acknowledgment.

X X X

Normal Date Indicates the last date this extension
transitioned into the Normal state.

X

Normal Priority C,W 200 Indicates the priority assigned to the
Normal state.

X X X

Normal Time Indicates the last time this extension
transitioned into the Normal state.
Each time this transition occurs, a
message is created and this time is
updated.

X

Object
Identifier

Specifies an internal identifier assigned
to the alarm extension.

X

Object Name Identifies the name of the object
associated with the alarm extension.

Object Type Analog
Alarm

Identifies the type of alarm extension. X

Occupancy
Reference

C,W Null When mapped, the Occupancy
Reference provides a specific graphic
preference color indication of a zone’s
occupancy status. When the reference
is in an unoccupied state, warning
states are not displayed; only alarm
states are displayed. This capability is
typically used in conjunction with the
Room Status symbol graphic floorplan.

X X X

Present Value D,R Normal Normal,
Low Warning,
High Warning,
Low Alarm,
High Alarm

Represents the current value of the
extension.
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Reference
Delay Time

C,W 0 0 to 65,535 seconds Specifies the amount of time that the
Input has to move within the Warning
Limits after a Warning Reference
change before the object reports the
warning. The Normal state is reported
until the Reference Delay Time expires.
If the Reference Delay Time is changed,
any current timer is canceled and reset
to the new Reference Delay Time.

X X X

Reference
Delay Timer
Active

False The Reference Delay Timer Active is
True while the alarm extension waits
for the Input value to respond to the
Warning Reference change.

X X

Reliability Input Un-
reliable

Uses Reliability (Set
503).

Indicates the Reliability of the Analog
Alarm extension. Reliability changes
in response to communication
errors between the Analog Alarm
extension and the Input Reference or
Setpoint Reference. When the Analog
Alarm extension is unreliable due to
communication problems, any further
execution of the main logic of the
Analog Alarm extension is cancelled
and no report is issued.
The reliability also indicates when the
Input or Setpoint Reference becomes
unreliable. When reliability changes
due to the Input being unreliable, an
event is issued if reporting is enabled.
The exception is Comm Loss reliability,
which results in the same behavior
as the communication problems
described above.
If a Setpoint Reference, High Alarm
Limit, and Low Alarm Limit are defined,
and the value of the setpoint is outside
of the range defined by the limits, then
the Analog Alarm becomes unreliable
and an event message is generated (if
reporting is enabled).

Report Delay C,W 0 0 to 65,535 seconds Indicates the number of seconds that
the extension waits before generating
a warning or alarm after the Input
value moves outside of the Heating
or Cooling Setpoint or warning limit.
After this time, the Input value is
reevaluated. If the value is still outside
the limit, a report generates. Report
Delay applies only to changes from the
Normal state to the Alarm state. High
or Low Alarms returning to the Normal
state are reported immediately.

X X X
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Report Delay
Active

C,W False The Report Delay Active is True while
the alarm extension waits for the alarm
or warning to stabilize.

X

Setpoint
Reference

C,W Null A Setpoint Reference or Warning
Reference is established for controllers
that only provide a Single Setpoint
value. The value established by either
one of these references is used in
conjunction with the High Warning
Offset and Low Warning Offset to
establish the High Alarm Warning Limit
and Low Alarm Warning Limit.

X X X

Status The Common Object Attributes section
details this attribute. Of the three
states that can be assumed by this
attribute (Disabled, Unreliable, and
Normal), two of these, Disabled and
Normal, are managed outside the
scope of this extension. A complete
list of relevant states follows (listed
in hierarchical order from highest to
lowest):

• Disabled: Enabled attribute
value is False.

• Unreliable: Reliability attribute
is not reliable.

• Normal: Expected operating
condition.

Time Indicates the time of the last change
in the Present Value or Reliability
reported by this extension.

Version Specifies the version number for the
alarm extension.

Unoccupied
State

C,W 1 Set re-directed to
Unoccupied_Set
Attribute

Indicates the value of the Occupancy
Reference (if defined) that is
considered the Unoccupied State.

X X X

Unoccupied
State Set

Indicates the set used to select the
Unoccupied State. If Occupancy
Reference is defined, the Unoccupied
State Set uses the same value.

Username is
BACnet Object
Name

False Controls whether the object’s User
Name attribute is also the Object Name
attribute. The Object Name attribute is
not writable, so the only way to change
the Object Name attribute is to edit the
User Name attribute and set the User
Name Is BACnet Obj Name attribute to
True.

X

Warning Ack
Pending

False Ack not pending,
Ack pending

Indicates whether an event concerning
a transition into the Warning state is
waiting for acknowledgment.

X

Warning Ack
Required

C,W False Ack not required,
Ack required

Indicates whether a transition into the
Warning state creates a message that
requires acknowledgment.

X X X
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Table 60: Analog Alarm Attributes (SUM=Tailored Summary; MOD=Global Modify; SCT=SCT
Configurable)
Attribute
Name

Notes Initial
Value

Values/ Options/
Range

Description SUM MOD SCT

Warning Date Indicates the last date this extension
transitioned into the Warning state.
Each time this transition occurs, a
message is created and this date is
updated.

X

Warning
Priority

C,W 120 Indicates the priority assigned to the
Warning state.

X X X

Warning
Reference

C,W 0.00 A Setpoint Reference or Warning
Reference is established for controllers
that only provide a Single Setpoint
value. The value established by either
one of these references is used in
conjunction with the High Warning
Offset and Low Warning Offset to
establish the High and Low Warning
limits.

X X X

Warning Time Indicates the last time this extension
transitioned into the Warning state.
Each time this transition occurs, a
message is created and this time is
updated.

X

Analog Alarm Extension Examples
The Analog Alarm extension adds the alarming capability for attributes with real values, such as the
Present Value of an Analog Input Object. This extension detects an alarm in two different modes:
the Single Setpoint method, or the Cooling/Heating Setpoint Method.

Single Setpoint Mode
The Single Setpoint Mode uses up to four configurable limits to report an alarm. This method also
sets the Alarm State attribute of the object to which it is added. You can configure Single Setpoint
Mode using either a mapped setpoint reference or a fixed number set in the warning reference. For
example, you can configure the Analog Alarm extension to issue an alarm if the temperature in a
room falls below 15.6˚C (60˚F).
The Analog Alarm Object determines its new alarm state based upon receipt of a change. The new
alarm state is based on the following:

• Newly reported value and reliability
• Current alarm state (present value)
• Differential
• Defined alarm and warning limits. Once you set the High and Low Alarm Limits, the High

Warning Limit is calculated by adding the High Warning Offset to the Cooling Setpoint
Reference Value. The Low Warning Limit is calculated by subtracting the Low Warning Offset
from the Heating Setpoint Reference Value.

• Value reported by the Setpoint Reference (if defined) written to Warning Reference Value
• Delay Timer Active
• Reference Delay Timer Active
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Figure 30: Single Setpoint Mode

Figure 30 shows the Present Value of the Analog Alarm as it changes.
The Delay Time period begins when the Warning Reference changes. The Input Value is not
calculated during this time. The Input is normal at the end of the Reference Delay Time, so the
Present Value stays normal.
The Report Delay period begins when the Present Value transitions to any state from the Normal
state, or the value of the Command Reference changes. Transitions to and from states other than
Normal are reported immediately.

Cooling/Heating Setpoint Mode
Using the Cooling/Heating Setpoint Mode, the object calculates up to seven different statuses
based on the Cooling Setpoint Reference and the Heating Setpoint Reference. You can also
define an optional Occupancy Reference to suppress the status of the extension and display an
unoccupied status indication color unless there is a high or low alarm.
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Figure 31: Cooling/Heating Setpoint Mode

Figure 31 shows the Present Value of the Analog Alarm as it changes.
The Delay Time period starts when the Cooling Setpoint Reference or Heating Setpoint Reference
value changes. Since the Input is in Low Warning state at the end of the Reference Delay Time, the
Present Value is in a Low Warning state.
The Report Delay period starts when the Present Value transitions to any Alarm or Warning state
from a Normal, Above Setpoint, or Below Setpoint state, or if the value of the Command Reference
changes. All other State Transitions are reported immediately.

Multistate Alarm Attributes
The Multistate Alarm Extension contains attributes common to Metasys system objects. For details,
see the Common Object Attributes.
The following table lists the attributes specific to the Multistate Alarm extension. Click the attribute
name in the table for a description of the attribute.

Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.
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Table 61: Multistate Alarm Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Alarm Ack Pending False Ack not pending, Ack

pending
Indicates that an event concerning a
transition into the Alarm state is waiting to be
acknowledged.

Alarm Ack Required C,W False Ack not required, Ack
required

Indicates that a transition into the Alarm
state created a message that requires
acknowledgment.

Alarm Date Indicates the last date this extension transitioned
into the Alarm state. Each time this transition
occurs, a message is created and this date is
updated.

Alarm Message Text C,N,W Indicates the text you assigned to give further
information in the event of an alarm. Only status
changes to an alarm state cause the alarm
message text reference to be added.

Alarm Priority C,W 70 Indicates the priority assigned to the Alarm state.

Alarm Time Indicates the last time this extension transitioned
into the Alarm state. Each time this transition
occurs, a message is created and this time is
updated.

Alarm Values C,W Associates an alarm state with a specific priority
and text. Multiple states can be defined for
each alarm, but each state must be unique
and no state can be set to the current alarm
extension normal state. The text and priority are
customizable. Alarm Priority and Alarm Message
Text are used as defaults when custom text and
priority values are not defined.

Capture Changes False If True, this attribute forces an event notification
to be generated for each change of the object
input state. If the input goes from one alarm
state to another alarm state or back to normal, an
event notification is generated.

Command
Reference

C,W If specified, the value of this referenced attribute
is treated as the normal state by the alarm
extension. The normal state then follows a
feedback value.
For example, define the Present Value of a Binary
Input Object (fan status) as the Input Reference
and define the Present Value of a Binary Output
Object (command state) as the Command
Reference.
For more information on how this attribute works
with regard to AO/BO point feedback, see AO/BO
Feedback.

Date Indicates the date of the last reported condition.

Event Enable C,W True Indicates that this value must be True for the
extension to report a warning message.

Graphic C,N,W Null Object Type = Graphic Indicates the graphic associated with the
extension.
Do not set the Graphic attribute for an alarm
extension to an aliased graphic. Aliased graphics
do not display properly when displayed from the
Alarms Window or Event Viewer.

153SCT: System Configuration Tool Help



Table 61: Multistate Alarm Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Graphic Alias C,W Maximum 256 characters Indicates a portion of the graphic’s item

reference, up to and including the name of the
folder containing this extension or the controller
containing this extension.

Input Derived from Input
Reference, the object
to which the Multistate
Alarm extension has
been attached.

Indicates the multistate value processed for
alarms by the extension as defined by the Input
Reference. The value of the Input is compared to
the Normal State.

Input Reference C Specifies the object and attribute monitored by
this alarm extension. The last value received from
Input Reference is written to the Input attribute.
The reliability of the Input Reference is monitored
and sets the Reliability attribute to this extension.
It is also reported in an alarm message.

Normal Ack
Pending

False Ack not pending, Ack
pending

Indicates whether an event concerning a
transition into the Alarm state is waiting to be
acknowledged.

Normal Ack
Required

C,W False Ack not required, Ack
required

Indicates whether a transition into the
Normal state creates a message that requires
acknowledgement.

Normal Date Indicates the last date this extension transitioned
into the Normal state. Each time this transition
occurs, a message is created and this date is
updated.

Normal Priority C,W 200 Indicates the priority assigned to the Normal
state.

Normal Time Indicates the last time this extension transitioned
into the Normal state. Each time this transition
occurs a message is created and this time is
updated.

Normal State C,W State 0 Derived from Input
Reference, the object
to which the Multistate
Alarm extension has
been attached.

Indicates the attribute value to which the Input is
compared. If the Input value is different from the
Normal State, an alarm state occurs.

Present Value D,R Normal Normal, Alarm, Hold Represents the current value of the extension.
Reference Delay
Time

C,W 0 0–65,535 seconds When a Binary Output Object (BO) (supply fan
command) is commanded On, the Normal State
for the associated Binary Input Object (BI) (supply
fan status) alarm extension is also On. After the
Reference Delay Time, the current state of the BI
is compared to the Normal State. If the BI is still
Off, an alarm is detected. The Reference Delay
Time is also used when the BO is commanded Off.
Specifies the feedback delay in seconds. The
purpose of the Reference Delay Time is to allow
time for equipment to start or stop before the
status is compared to the command.

Reference Delay
Timer Active

False The Reference Delay Timer Active is True while the
alarm extension waits for the equipment to start
or stop.
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Table 61: Multistate Alarm Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Reliability Input

Unreliable
Uses Reliability (Set 503). Indicates the reliability of the Multistate

Alarm extension. Reliability changes due to
communication errors between the Multistate
Alarm extension and the Input Reference or
Command Reference. When the Multiple Alarm
extension is unreliable due to communication
problems, any further execution of the main logic
of the Multistate Alarm extension is canceled and
no report is issued.
The reliability also indicates when the Input
or Command Reference becomes unreliable.
When reliability changes due to the Input being
unreliable, an event is issued if reporting is
enabled. The only exception is Comm Loss
reliability, which results in the same behavior as
the communication problems described above.

Report Delay C,W 0 0–65,535 seconds Indicates the delay between detecting an alarm
and actually reporting the alarm. The purpose of
this delay is to make sure that the alarm is stable.
If a status feedback device is fluctuating, an alarm
is detected numerous times. The alarm must
be True at the end of the duration of the Report
Delay before the alarm is reported.

Report Delay Active C,W False The Reference Delay Timer Active is True while the
alarm extension waits for the equipment to start
or stop.

Status The Common Object Attributes section details this
attribute. A list of relevant states follows (listed in
hierarchical order from highest to lowest):
Disabled: Enabled attribute value is False.
Unreliable: Reliability attribute is not reliable.
Normal: Expected operating condition.

Time Indicates the time of the last reported condition.

Alarm Commands
The following table lists the commands supported by the Alarm Extensions feature.
Table 62: Alarm Extension Commands
Command
Name

Parameters Description

Cancel Delay
Time

None Cancels Reference Delay Timer, if active. A
warning occurs if the delay time on an Alarm
extension is canceled in this state.

Cancel Report
Delay

None Cancels the Report Delay Timer, if active. A
warning occurs if the delay time on an Alarm
extension is canceled in this state.

Totalization Extensions
Totalization Extensions track an attribute over time. There are three types of totalization extensions:

• Analog Totalization  - Tracks and records analog attribute values over time.
• Event Totalization  - Tracks the number of events/transitions of an attribute over time.
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• Runtime Totalization  - Tracks the total time that an attribute resides in a specified state.
For more information on managing time in the Metasys system, see the NAE and ADS or ODS
commissioning documents listed in the Related documentation table in the Welcome section.

Totalization Extensions Concepts

Analog Totalization
The Analog Totalization extension tracks and records the usage of any consumable monitored
through an analog attribute. Some examples of consumables include electricity, gas, steam, and
chilled water.
These three essential parameters determine the Analog Totalization extension’s mode of operation:

• the Input Reference to be monitored
• the Timebase on which the computation is based
• the Low CutOff Value that the input must meet or exceed

Use the Analog Totalization extension to determine the usage of the given consumable. For
example, you can determine the amount of gas or steam used by the facility for a given month.
Also, use Analog Totalization to determine how many kilowatt/hours were used in a week or to
totalize a calculated value (for example, degree days).
For general information on Metasys system objects, see the Object Help section.
For detailed information on the Analog Totalization extension, see Analog Totalization Attributes.

Event Totalization
The Event Totalization extension tracks the number of binary events or pulses over time, meaning it
counts the number of transitions that occur at an input reference. Unlike other types of totalization,
event totalization increases the value each time the event occurs, instead of calculating the value
once each minute.
These three essential parameters determine the mode of operation for the Event Totalization
extension:

• the monitored Input Reference
• the types of recorded Transitions or events
• the recorded Value Per Pulse (event)

You can use this extension to determine the number of changes in an input value, which may
be helpful for maintaining and monitoring equipment. For example, use Event Totalization to
determine how many times a motor started, how often a sensor was in alarm, or how many cars
entered a parking lot.
For detailed information on the Event Totalization extension, see Event Totalization Attributes.

Runtime Totalization
The Runtime Totalization extension tracks the time that elapses while a designated input, such as a
binary or multistate value, matches a specified state.
These two essential parameters determine the Runtime Totalization extension’s mode of operation:

• the monitored Input Reference
• the Reference (state) that identifies active runtime

Use this extension to track the amount of time that a piece of equipment, such as a fan or a pump,
is operational. This extension also determines the amount of time that a point is in alarm or the
runtime of fixed loads (such as lighting) for energy consumption and tenant billing.
For detailed information on the Runtime Totalization extension, see Runtime Totalization Attributes.
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Analog Totalization Attributes
The Analog Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Analog Totalization extension. Click the
attribute name in the table for a description of the attribute.

Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.

Table 63: Analog Totalization Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Display Precision C,W 10ths Uses Display Precision

(Set 0)
Indicates the rounded position and the number of
decimal places to display for this extension.

Executing Active Active
Totalize Limit
Inactive

Reflects the status of this extension.
Active: The extension is calculating and has not
reached the Totalize Limit.
Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.
Inactive: The extension is unreliable or disabled
and is not calculating.

Input Reference C Specifies the object and attribute monitored by
this extension. If this attribute is unreliable or
falls below the Low CutOff Value, totalization is
temporarily suspended.

Low CutOff Value C,W Specifies the object and attribute monitored by
this extension. If this attribute is unreliable or
falls below the Low CutOff Value, totalization is
temporarily suspended.

Present Value C,D,R,W Represents the current value of the extension.

Reliability Reliable Uses Reliability (Set 503) Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.

Reset (This attribute
does not appear in
a view, but may be
scheduled, trended,
and so on.)

W False False
True

Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Reset Date Represents the date of the last Reset condition of
the extension.

Reset Time Represents the time of the last Reset condition of
the extension.

Rollover C,W False False
True

Defines the special action that the totalization
extension must take when the Present Value
reaches the Totalize Limit value. If the Rollover
attribute is set to False, the Analog Totalization
extension ceases further operation when the
Present Value equals or exceeds the Totalize Limit
value. If it is True, it resets the present Value to 0.0
and resumes a new cycle of totalization.

Rollover Count 0 0–4,294,967,295 When the Rollover attribute is True, this value
increases each time Present Value reaches a value
equal to or greater than the Totalize Limit value.
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Table 63: Analog Totalization Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Scale Factor C,W 1.0 Minimum Value > 0 Indicates the value used to scale the totalized

value to either a larger or smaller value than
otherwise results.

Timebase C,W Hours Seconds
Minutes
Hours

Establishes the time frame on which the
calculated totalization value is based.

Totalize Limit C,N,W Limit > 0 Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.

Units C,W IP
SI

Indicates the measurement units of this
extension.

Value Before Reset Indicates the value of the Present Value at the
time of the last reset operation.

Event Totalization Attributes
The Event Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Event Totalization extension. Click the attribute
name in the table for a description of the attribute. Letters in the Notes column indicate the
following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R - Affected by
Extension’s Reliability, W - Writable.
Table 64: Event Totalization Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Display Precision C,W 1s Uses Display Precision

(Set 0).
Indicates the rounded position and the number of
decimal places to display for this extension.

Executing Active Active
Totalize Limit
Inactive

Reflects the status of this extension.
Active: The extension is calculating and has not
reached the Totalize Limit.
Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.
Inactive: The extension is unreliable or disabled
and is not calculating.

Input Reference C Specifies the object and attribute totalized by
this extension. If this attribute is unreliable,
totalization is temporarily suspended.

Present Value C,D,R,W Represents the current value of the extension.

Reference C,W State 0 States Text attribute
identifies the
enumeration set for this
attribute.

Defines the value that the extension processes
for totalization, as defined in the Input Reference
attribute.

Reliability Reliable Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.
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Table 64: Event Totalization Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Reset
(This attribute does
not appear in a
view, but may be
scheduled and
trended.)

W False False
True

Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Reset Date Represents the date of the last Reset condition of
the extension.

Reset Time Represents the time of the last Reset condition of
the extension.

Rollover C,W False False
True

Defines the special action that the totalization
extension takes when the Present Value reaches
the Totalize Limit value. If the Rollover attribute
is set to False, the Runtime Totalization extension
ceases further operation when the Present Value
equals or exceeds the Totalize Limit value. If the
attribute is set to True, it resets the present Value
to 0.0 and resume a new cycle of totalization.

Rollover Count R,W 0 0–4,294,967,295 When the Rollover attribute is True, this value
increases each time Present Value reaches a value
equal to or greater than the Totalize Limit value.

Scale Factor C,W 1.0 Minimum Value > 0 Indicates the value that is used to scale the
totalized value to either a larger or smaller value
than would otherwise result.

States Text
(This attribute does
not appear in a
view, but may be
scheduled and
trended.)

C,W States Indicates the displayed strings for the Present
Value.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Totalize Limit C,N,W Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.

Transition C,W Entering State Entering State
Count All

Describes the behaviors of the transitions to be
counted. If the value is 0, the system counts the
transition of entering a given reference. If the
value is 1, the system counts all state transitions.

Units C,W IP
SI

Indicates the measurement units of this
extension. IP=Imperial units; SI=International
System of Units.

Value Before Reset Indicates the value of the Present Value at the
time of the last reset operation.

Value Per Pulse C,W 1 Indicates the unit value of the Input Reference for
pulse totalization. For the event totalization, the
value is 1.

Runtime Totalization Attributes
The Runtime Totalization extension contains attributes common to Metasys system objects. For
details, see Common Object Attributes.
The following table lists the attributes specific to the Runtime Totalization extension. Click the
attribute name in the table for a description of the attribute.

159SCT: System Configuration Tool Help



Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.

Table 65: Runtime Totalization Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Display Precision C,W 10ths Uses Display Precision

(Set 0).
Indicates the rounded position and the number of
decimal places to display for this extension.

Executing Active Active
Totalize Limit
Inactive

Indicates the execution status of this extension:
Active: The extension is calculating and has not
reached the Totalize Limit.
Totalize Limit: The extension has reached
the limit and has stopped calculating because
Rollover is set to False.
Inactive: The extension is unreliable or disabled
and is not calculating.

Input Reference C Specifies the object and attribute totalized by
this extension. If this attribute is unreliable or
changes from the Reference (state) to another
state, totalization is temporarily suspended.

Present Value C,D,R,W Represents the current value of the extension.

Reference C,W State 1 States Test attribute
identifies the
enumeration set for this
attribute.

Defines the value that is processed for totalization
by the extension as defined in the Input Reference
attribute.

Reliability Reliable Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference becomes unreliable, the
totalization extension monitoring the input
becomes unreliable.

Reset
(This attribute does
not appear in a
view, but may be
scheduled, trended,
and so on.)

W False False
True

Forces the extension into a reset condition.
(Terminates any ongoing calculations, restores
the Present Value to initial state, and, for each
triggerable attribute, forces a COV report.)
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Reset Date Represents the date of the last Reset condition of
the extension.

Reset Time Represents the time of the last Reset condition of
the extension.

Rollover C,W False False
True

Defines the special action that the totalization
extension takes when the Present Value reaches
the Totalize Limit value. If the Rollover attribute
is set to False, the Runtime Totalization extension
ceases further operation when the Present Value
equals or exceeds the Totalize Limit value. If it
is True, it resets the present Value to 0.0 and
resumes a new cycle of totalization.

Rollover Count R,W 0 0–4,294,967,295 When the Rollover attribute is True, this value is
incremented each time the Present Value reaches
a value equal to or greater than the Totalize Limit
value.

States Text
(This attribute does
not appear in a
view, but may be
scheduled, trended,
and so on.)

C,W States Indicates the displayed strings for the Present
Value.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

SCT: System Configuration Tool Help160



Table 65: Runtime Totalization Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Timebase C,W Hours Seconds, minutes, hours,

days
Establishes the time frame on which the
calculated totalization value is based.

Totalize Limit C,N,W Hours Defines a threshold value that the Present
Value must meet or exceed for the totalization
extension to take special action. When the
Rollover attribute is set to False, the totalization
process ceases further operation. When it is set
to True, Present Value is cleared to 0, and the
totalization process starts over.

Units C,W No Units Indicates the measurement units of the Present
Value, Totalize Limit, and Value Before Reset
attributes.

Value Before Reset Indicates the value of the Present Value at the
time of the last reset operation.

Totalization Commands
The following table lists the commands supported by the Totalization Extensions. Click the
command name for a description of the command.
Table 66: Totalization Commands
Command Name Parameters Description
Disable None Locks out all outputs and

prevents functionality of
the Totalization extension
and temporarily suspends
totalization.

Enable None Forces a Reset on the
Totalization extension and
returns it to normal operation.

Reset None Terminates any ongoing
calculations, restores the
present value to its initial
state, creates a reset date
and time stamp, and, for each
triggerable attribute, forces a
COV report.

Reset Rollover Access level = Supervise Resets the Rollover Count
attribute.

Trend Extensions
The Trend Extension monitors and records the changes in the behavior of an individual attribute
over time, thereby assisting you with diagnosing various system-wide behavioral characteristics.
The Trend extension collects sample values at timed intervals or only upon changes in the given
value. Trend data is still collected if the object is unreliable. The Trend extension continues to log
data using the previous value preceded by ???, which indicates an unreliable status.
For example, use a Trend extension to collect data from the Analog Input object of a controller on
the N2 Bus, which reports information such as outdoor air temperature or room air temperature.
Trend extensions are different from Trend Studies because Trend Studies query both the ADS/OAS/
ODS and Engine for historical data. Trend Extensions query only the Engine.
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Note: Although multiple trend extensions can be added to an object on an NxE, these
extensions are combined as a single trend if sent to a Historical Data Repository. This may
not yield the expected result. To use multiple trends on a single object in a Historical Data
Repository, create duplicate AV or BV objects that map to the point in question, then create a
new trend on the parallel AV or BV.

For trend performance information, refer to the Metasys System Configuration Guide (LIT-12011832).

Trend Extensions Concepts

Views
There are three views in the Trend Extension: Chart View, Table View, and Definition View.
Table 67: Views
Button View Description

Chart View Allows you to view trend data in a chart
format.

Table View Allows you to view trend data in a table
format.

Definition View Allows you to view the trend extension
attributes.

Trend Extension Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data.
You can zoom, unzoom, and pan within the Chart view. You can also specify the X-axis and Y-axis
ranges.
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Table 68: Chart View
Button Name Description

Update When initially displayed, the Trend Extension view shows
the data samples currently in the local trend buffer. Click
Update to retrieve and display new data samples (for
example, any trend buffer data later than the currently
displayed samples). The Update button adds the new
samples to the display without removing the old samples.

Note: Gaps may appear in the data if the trend buffer has
rolled over since the last update. If you wish to clear the
Trend Extension view and re-display only those samples cur-
rently in the trend buffer, use the Refresh Current Tab menu
option (right-click or Action menu).

 (Zoom)

 (Normal)

Zoom Toggles the mouse behavior for the chart between zoom
mode and normal mode.
While in zoom mode:

• drag the mouse over an area of the chart to zoom in
on that area.

• click Zoom to exit zoom mode and restore the mouse
to normal mode.

• left-click to zoom out one level.

When you exit zoom mode, the chart remains at the
current zoom level. Use the Restore button to fully zoom
out on the chart.

Note:

• You cannot pan while the mouse is in zoom
mode.

• You can also zoom and unzoom in normal mode
by using the Shift key and the mouse. To zoom,
hold the Shift key down while dragging the
mouse across the chart. To zoom out one level,
left-click the mouse while holding the shift key
down.

Restore Allows you to return to an unzoomed view and switches the
mouse back to normal mode if the chart’s zoom mode is
active.

Pan Allows you to pan the view of the chart vertically or
horizontally by dragging the mouse across a zoomed chart.
Panning is not available for unzoomed charts or when
zoom mode is active. To pan left or right, drag the mouse
over the X-axis. To pan up or down, drag the mouse over
the Y-axis.

Points Line Displays the data using lines and point markers. This is the
default.

Area Displays the data using an area chart.
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Table 68: Chart View
Button Name Description

Bar Displays the data using a bar chart.
Note: Only use the bar chart when the number of data sam-
ples can reasonably be expected to display as bars. If too
many data samples exist when you click this option, the
display becomes unstable and fails to properly update the
screen. To recover, select any other display option.

Points Displays the data using markers, with no lines.

Line Displays the data using lines, with no markers.

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click
in the panel to display the menu.
Table 69: Chart View Right-Click Menu
Menu Item Description
Background Color Opens the Select a Color dialog box and allows you to configure the

background color.
Gridlines Allows you to select what type of gridlines to appear on the chart. You can

choose: None, X and Y, X Only, and Y Only.
Chart Type Allows you to select what type of chart to display. You can choose: Points

Line, Area, Bar, Points, and Line.

Trend Extension Table View
The Table view of the Trend extension allows you to view the trend’s data samples in a table format.
You can copy the trend data to the clipboard for pasting into Microsoft Excel or other applications.
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Table 70: Table View
Button/Field Name Description

Update When initially displayed, the Trend
Extension view shows the data samples
currently in the local trend buffer. Click
Update button to retrieve and display new
data samples (for example, any trend buffer
data later than the currently displayed
samples). The Update button adds the new
samples to the display without removing
the old samples.

Note: Gaps may appear in the data if the
trend buffer has rolled over since the last
update. If you wish to clear the Trend
Extension view and re-display only those
samples currently in the trend buffer,
use the Refresh Current tab menu option
(right-click or Action menu).

Copy to Clipboard Allows you to copy selected trend data
to the system clipboard for pasting into
Microsoft Excel or other applications.
You can also use Ctrl + C to copy data.

Trend Extension Definition View
The Definition view of the Trend Extension allows you to view and edit the attributes of the trend
extension object. For more information on the Definition view attributes, see the Trend Extension
Attributes section.

Trend Buffer
The trend buffers reside in the NAE and store the trend samples for the NAE. The number of
samples stored in each individual trend buffer is user-configurable (see Trend Extension Attributes).
When the buffer gets full, you can choose to have the new trends overwrite the old ones or to have
the trending stop. Whether the trends are overwritten or trending stops, you can configure the
system to issue an alarm when the buffer gets full. You can also configure to transfer samples to a
configured ADS, OAS, or ODS.
Table 71 shows the relationship between the buffer size and the sample interval. Determine
the sample interval, in seconds, by converting minutes to seconds. Determine the buffer size by
examining the interval, in seconds, against the desired time period size to retain data.
Table 71: Buffer Size and Sample Interval Relationship

Buffer for Previous Time PeriodInterval
(Min.)

Interval
(Sec.) 1 Hr. 2 Hrs. 4 Hrs. 8 Hrs. 16 Hrs. 1 Day 2 Days 3 Days

1 60 60 120 240 480 960 1,440 2,880 4,320
2 120 30 60 120 240 480 720 1,440 2,160
5 300 12 24 48 96 192 288 576 864
10 600 6 12 24 48 96 144 288 432
15 900 4 8 16 32 64 96 192 288
30 1,800 2 4 8 16 32 48 96 144
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Table 71: Buffer Size and Sample Interval Relationship
Buffer for Previous Time PeriodInterval

(Min.)
Interval
(Sec.) 1 Hr. 2 Hrs. 4 Hrs. 8 Hrs. 16 Hrs. 1 Day 2 Days 3 Days

60 3,600 1 2 4 8 16 24 48 72
120 7,200 1 2 4 8 12 24 36

Trend Sampling
Trend sampling for the trend buffer occurs periodically (samples taken after a set time expires) if
you set the Sample Interval to a value higher than zero. To sample based on COV reporting of the
object, set the Sample Interval attribute to zero. You can stop or start sampling manually (using the
Enable or Disable command) or control the start and stop with Interlocking a Trend Extension or
scheduling. With interlocking, the trend samples are taken when a defined event occurs. If you use
the scheduling feature, trend samples are taken at certain times on certain days.

Trend Extension Attributes
Alarm Extensions contains attributes common to Metasys system objects. For details, see Common
Object Attributes.
The following table lists the attributes specific to the Trend extension. Click the attribute name in
the table for a description of the attribute.

Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.

Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Acked Transitions C,W False, False,

False
Conveys three separate flags that each indicate
if the most recent To Offnormal, To Fault,
or To Normal event transitions have been
acknowledged (if the transition requires
acknowledgement).

Buffer Size C 144 1–5,000 Specifies the maximum number of records the
buffer may hold.

Buffer State Operational Operational, Buffer Full Indicates whether the buffer is full or operational
when the Stop When Full attribute is set to False.

Client COV
Increment

C,W Specifies the increment used to determine that a
change of value occurred (when this trend object
collects data by COV). If the referenced object
and attribute support COV reporting, then this
attribute may have a Null value. In this case, the
value of the trended object for COV increment is
used. This value only applies to trended values of
the real value (floating point) type.

COV Resubsc
Interval

C,W 3,600 Units = Seconds Specifies the number of seconds between COV
resubscriptions (when this trend object collects
data by COV). This attribute is only used when
the trended object is a BACnet Integration point
on the IP network. The Subscribe COV requests
specify twice during this interval for the actual
subscription. The first subscription is issued
when the trend object begins operation or when
enabled.

Enable C,W False Indicates and controls whether logging is enabled
(True or False).
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Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Event Enable C,W True, False Determines whether notifications are enabled

for To Fault and To Normal events. A To Normal
transition occurs when the value of the Records
Since Notify attribute is equal to or greater than
the value of the Notify Threshold attribute. A To
Fault transition occurs when an attempted COV
subscription fails. The To Normal transition must
be enabled and set by default. The Read and Write
methods ensure this value cannot be set to False.

Event State Normal, Fault Determines whether an active event state is
associated with this extension. The value is set
to Normal when there is no intrinsic alarming
defined for this object. If intrinsic alarming is
enabled (Enable Intrinsic Alarms = True), then this
value is either Normal or Fault (problem occurred
with the object subscribing for Change of Value
[COV]s). This attribute appears on the view when
the site is defined as a BACnet site.

Event Time Stamps Conveys the times of the last event notifications
for To Offnormal, To Fault, and To Normal events.
Time stamps of type Time or Date have FF if no
event notification of that type has generated since
the object was created.

Input Reference C Defines the attribute of the object being sampled.
This attribute is used for consistent references to
an object or attribute. The Input Reference and
the name of the object and attribute you want to
trend must match exactly.

Intrinsic Alarming
Defined

C,W False Enables (True) or disables (False) BACnet intrinsic
alarming for this object. When disabled, writing
to any of the intrinsic alarming attributes returns
a Write_Access_Denied error. When disabled,
reading the intrinsic alarming attributes returns
the default value of each attribute.

Last Notify Record 0 Indicates the sequence number associated
with the most recently collected record whose
collection triggered a notification (that is, it
caused the value of the Records Since Notify
attribute to be equal to or greater than the
value of the Notify Threshold attribute). If no
notification has occurred since logging began, the
value of this attribute is 0.

Logging Type Polled Polled, COV, Trigger Specifies the method for which the referenced
property is logged (Polled, Change of Value [COV],
or Trigger).

Log Interval C,W 60,000 Units = 100ths of a
second

Specifies the periodic time in seconds for which
the referenced property is logged.
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Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Notification Class C,W 1 Specifies the notification class used for handling

and generating event notifications for this
object. Notification occurs based on the value
of the Records Since Notification attribute. The
Notification Class attribute implicitly refers to a
Notification Class object that has a Notification
Class property with the same value. If the class
number references a non-existent Notification
object, no Notification occurs.
When the Notification Class attribute is written
online, the Notification Object Reference
is updated to the Object Reference of the
Notification Class object with that instance
number, if found. If the Notification Class object
for a Johnson Controls proprietary object is not
found, the reference is left blank.
If both the Notification Object Reference and
the Notification Class attributes are written
simultaneously online (or both are configured
and downloaded), the Notification Class attribute
value is set to the value that was written to the
Notification Object Reference, and the Notification
Class value in the write message is ignored.

Notification Object
Reference

C,W Limited to Notification
Class on the same
device.

Specifies the Notification Class object used to
route alarms for the object being configured
(through tree selection). When the Notification
Object Reference is written, the value of the
Notification Class attribute is updated to reflect
the referenced object’s instance number. The
value of the Notification Object Reference
attribute is restricted to Notification Class objects
on the same device as the alarming object.
Validation only occurs during a write, not during a
create (the download does not fail).

Notify Threshold C,W 130 (90% of
Buffer Size)

Indicates when notification occurs based on the
value of the Records Since Notification attribute.

Notify Type C,W Events Conveys if the notifications generated by the
object are Events or Alarms. This attribute is
required if the object supports intrinsic reporting.

Record Count C,D,W 0 0–5,000 Represents the number of samples recorded since
the creation of the trend extension or the last
time the buffer was cleared, when the Stop When
Full attribute is set to True.
Represents the position of the next sample
recorded, when the Stop When Full attribute is set
to False.
A value of zero for this attribute deletes all
records in the log buffer and resets Samples Not
Sent to ADS and Total Record Count to zero. If the
buffer overflows, the Record Count resets to zero.

Records Since
Notify

0 Indicates the number of records collected since
the last notification occurred or since logging
began if no notification occurred.
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Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Reliability Reliable Uses Reliability (Set 503). Represents the reliability of the Present Value.

If the Input Reference becomes unreliable, the
trend extension monitoring the input becomes
unreliable.

Repository Enabled C,W False Enables transferring of the trend sample data to
the Metasys Server or ODS when this attribute
is set to True and the buffer fills to the level
specified by the Transfer Setpoint attribute.
If you create multiple trend extensions on a single
point and send it to a Historical Data Repository,
then setting Repository Enabled to true causes
the Trend Viewer and/or Trend Study to display a
combination of 15-minute and 1-minute samples.
If Repository Enabled is set to False, then the
Trend viewer displays only the data from the
selected Trend Extension. To use multiple trends
on a single object in a Historical Data Repository,
create duplicate AV or BV objects that map to the
point in question, then create a new trend on the
parallel AV or BV.

Sample Interval C,W 600 0–604,800
Units = Seconds

Specifies the periodic time in seconds for
which the referenced property is logged. If this
attribute is zero, samples are recorded using COV
reporting.
Notes:

• If you want to take samples on a COV, set
the value of this attribute to 0 seconds.

• If you are not sampling on a COV, configure
the Sample Interval at 60 seconds or higher
to prevent loss of trend data and reduction
in performance of the network engine and
Metasys Server or ODS devices that receive
samples from the configured trend.

Samples Not Sent
to ADS

0 0–5,000 Represents the total number of samples requiring
delivery to the Metasys Server or ODS repository
during the next transfer.

Start Time C,W Specifies the time and date to enable logging
when the Enable attribute is set to True. If the
Start Time contains any wildcard values, then the
conditions to enable logging based on time are
ignored. When the Trend object is inactive due to
the current time being outside of the Start Time
or Stop Time, the Status attribute reflects this
state (assuming it is the highest priority status).
If you define a Stop Time that is before the Start
Time, the Trend object is disabled.
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Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Status Flags Indicates the general status of the object in

BACnet terms and contains four independent
states.
The four flags are:
In Alarm—False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is  not
reliable; otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service—Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Stop Time C,W Specifies the time and date to disable logging.
If the Stop Time contains any wildcard values,
then the conditions to disable logging based on
time are ignored. Logging is disabled if the Stop
Time is prior to the Start Time. When the Trend
object is inactive due to the current time being
outside of the Start Time or Stop Time, the Status
attribute reflects this state (assuming it is the
highest priority status). A change in the active/
inactive state due to the Start Time/Stop Time
value has no impact on the Enable attribute. If
the Trend object was disabled due to the Stop
Time, the Trend object attempts to send the trend
samples to the server. If you define a Stop Time
that is before the Start Time, the Trend object is
disabled.

Stop When Full C,W False When set to False, logging continues. If the
Repository Enabled attribute is set to False, the
previously recorded samples are overwritten.
If the Repository Enabled attribute is set to
True and the buffer fills to the level specified by
the Transfer Setpoint attribute, the previously
recorded samples are sent to the Metasys Server
or ODS. The buffer must be cleared for logging to
continue.
Specifies whether logging ceases when the buffer
is full. When set to True, logging ceases and all
accumulated samples remain in the buffer.

Total Record Count Represents the total number of records collected
by the Trend Extension since creation. When the
value of Total Record Count reaches its maximum
possible value of 0XFFFFFFFF, the next value it
takes is zero. Once this value has wrapped to
zero, its semantic value (the total number of
records collected) is lost, but its use in generating
notifications remains.
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Table 72: Trend Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Transfer Setpoint C,W 130 (90% of

Buffer Size)
1–5,000 Represents the amount of buffer memory (in

number of samples) that must fill before the
trend extension requests a transfer of the
current samples to the Metasys Server or ODS for
permanent storage. The value cannot be greater
than the buffer size when Repository Enabled is
true.

Trigger C,W Causes the collection of data when changed
from False to True, Enable is set to True, and the
trend is within the Start/Stop times. When data
collection completes, this attribute resets to False.
This attribute does not trigger Johnson Controls
COVs.

Trend Extension Commands
The following table lists the commands supported by Trend Extensions. Click the command name
for a description of the command.
Table 73: Trend Extension Commands
Command Name Parameters Description
Clear None Clears all samples in the buffer.
Disable None Stops collection of samples.
Enable None Resumes collection of samples.
Execute None Takes a single sample.
Route None Routes all trends that have not

been previously sent to the
Metasys Server or ODS, if defined.

Load Extensions
The Energy Management feature consists of two major components: one DLLR object, and one
or more Load extensions. A Load extension is added to an output object (only one load extension
for each object) to specify that the object should be controlled by Energy Management. Each Load
extension object is configured with the load (energy) rating of its output and the attribute value or
state to write to its output object when the Load object is shed.
The DLLR object determines how much energy needs to be reduced, based on its configuration and
the energy rate from a meter, if the demand limiting strategy is defined. The DLLR object orders as
many Loads as needed to shed to reduce the energy usage by the required amount. The Loads can
be on the same supervisory device as the DLLR object, or on another supervisory device, but must
be within the same site. Each shed Load writes its configured Output Shed Command attribute
value to the Present Value attribute of its output, which decreases energy usage.
For information on the features and operation of DLLR, refer to the DLLR Technical Bulletin
(LIT-12011288).
The Demand Limiting/Load Rolling (DLLR) Object chapter contains information relevant to the DLLR
Object.

Load Extension Attributes
Three types of Load Extension objects are available: Binary, Multistate, and Analog. The following
table describes the attributes of these objects.
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Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, W - Writable.

Table 74: Load Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Active Timer None Active Timer set Indicates which Load timer is in effect: Minimum

Shed, Maximum Shed, Minimum Release, or
None. The Time Remaining attribute indicates
how much time remains for the active timer.

Actual Shed Level 0 Indicates the level of power shed when a shed
request is active. When the Present Value
attribute value is Shed Compliant, the Actual Shed
Level equals the value of the Shed Levels array
element; otherwise, it equals zero.

Alarm Reference for
Ineligibility

C,N,W Prevents the Load from being shed if the
reference is in alarm. This is an optional reference
to an object that can be set to any object,
including the output object. For example, if the
referenced object is a room temperature sensor,
and the object goes into alarm (a room becomes
too warm), it prevents the supply fan (the Load
object) from being shed. If the Load object is
already shed when the referenced object goes
into alarm, the shed expires as it would normally
but cannot be shed again until the referenced
object exits the alarm state.

Comfort Override C,W Inactive Comfort Override set Configures the Comfort Override command
behavior for this load. From time to time, you
may need to override a load to turn on lights in
a normally empty conference room or provide
more airflow to a zone. The Comfort Override
command is meant for this purpose. You can
issue this command directly from DLLR’s Load
Summary to release loads if they are shed, and
prevent them from being shed. The load cannot
be shed again until the Release Comfort Override
is issued.
This attribute can be set to the following values:
Inactive—No comfort override is in effect.
Override And Release Immediately—Comfort
overrides the Load immediately and prevents it
from being shed. If the Load is currently shed, the
output write is immediately released.
Override But Release After Timer Expires—
Comfort overrides the Load immediately and
prevents it from being shed. If the Load is
currently shed, the output write is released
after the Load’s Minimum Shed Time expires.
If the Minimum Shed Time has already expired
when the command is issued, the output write is
immediately released.
This attribute is synchronized to the Comfort
Override/Release Comfort commands.

Current Available
Energy Savings

Indicates how much energy would be saved if the
Load were shed now.

Display Precision C,W 10ths Uses Display Precision
(Set 0).

Indicates the rounded position and the number of
decimal places to display for this extension.
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Table 74: Load Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Display Reference C,W Synchronized to the

output object’s Display
Precision.

Indicates the current display precision of the
load’s output object.

Duty Window W 0 1–65,535 Indicates the time window for determining shed
compliance.

Eligibility Load Eligibility set Indicates to DLLR whether the Load can be shed
and identifies for which strategy or strategies (DL,
LR, or both) the Load can be shed.

Event State Normal, Fault Determines whether an active event state is
associated with this extension. The value is set
to Normal when there is no intrinsic alarming
defined for this object. If intrinsic alarming is
enabled (Enable Intrinsic Alarms = True), then
this value is either Normal or Fault (problem
occurred with the object subscribing for COVs).
This attribute appears on the view when the site is
defined as a BACnet site.

Expected Shed
Level

0 Indicates the level of power that the Load object
expects to shed when a shed request is active or
pending. When the Present Value attribute value
is Shed Request Pending or Shed Compliant, the
Expected Shed Level equals the value of the Shed
Levels array element; otherwise, the value of the
Expected Shed Level equals zero.

Input Reference C Specifies the object and attribute monitored
by this extension. The reliability of the Input
Reference is monitored and sets the Reliability
attribute of this extension.

Last Shed Date Indicates the date on which the Load was last
shed (since download).

Last Shed Time Indicates the date on which the Load was last
shed (since download).

Load Locked W False Specifies whether the Load is locked. A Load that
is locked while released cannot be shed until
the Load lock is released. A Load that is locked
while shed remains shed until the Load lock is
released. This attribute is synchronized with the
Lock/Unlock commands.

Load Priority C,W 10 1–10 Indicates how critical the Load’s output is and
determines the order in which loads are shed.
You can define up to 10 load priorities: Priority 1
through Priority 10. Loads at Priority 10 are first to
shed; loads at Priority 1 are the last to shed. The
configured Load Priority is shown with the load
on the Load Summary of the DLLR object. The
shedding order is from top to bottom as listed in
the Load Summary when the Load Priority column
is sorted with the lowest priority loads listed first.

Note: Even though the capacity for
10 priority levels is provided, you can
implement fewer than 10 levels; in an
example with, Priority 1 through Priority
4, Priority 4 loads shed first, and Priority 1
loads shed last.

Load Rating C,W See Load Rating.
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Table 74: Load Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Enabled W True Indicates whether the Load object responds to

shed requests.
Maximum Shed
Time

C,N,W 15 1–65,535
Undefined = 65,535
Units = Minutes

Specifies the maximum number of minutes that
a load can be shed before it is automatically
released. If the Maximum Shed Time value is not
defined, the default value of 65,535 is used. The
range is 0 to 65,535 minutes. It is possible for the
Load to be released before this time. A Load does
not remain shed longer than the maximum shed
time unless the load has been locked shed.

Minimum Release
Time

C,W 5 1–65,535
Units = Minutes

Specifies the minimum number of minutes that a
load must be released from shed before it can be
shed again. Although DLLR does not shed a load
before this time expires, a load can be manually
shed before this value expires.

Minimum Shed
Time

C,W 5 1–65,535
Units = Minutes

Specifies the minimum number of minutes that a
load must be shed before it can be automatically
released. A load can be manually released before
this value expires.

On Release C,W Release
Immediately

Comfort Override Type
set

Specifies how soon the Load should be released
when a Release Load command is issued or when
the Shed command attribute is set to Release. If
this attribute is set to Release Immediately, the
load releases immediately even if its Minimum
Shed Timer is active. If this attribute is set to
Release After Timer Expires, the load remains
shed until the Minimum Shed Time expires. If a
release is issued but the Load remains shed until
the Minimum Shed Time expires, the Load’s Shed
Status attribute indicates this using one of the
following states. The state that is used depends
on whether the Load was shed for demand
limiting or load rolling.
Shed For DL—Release Issued
Shed For LR—Release Issued

Output Shed
Command

Set is specified by
output’s States Text
attribute.

The state that is written to the output’s Present
Value attribute when the Load is shed. DLLR does
not shed the Load if the output’s Present Value
equals the Output Shed Command value, as no
energy would be saved.

Present Value Inactive Uses BACnet Shed State
set.

Indicates the current Load shedding state of the
Load object.

Rate Units C,W kW Units set Specifies the energy units used for the Load
Rating Energy Savings display.

Reliability Reliable Uses Reliability (Set 503). Represents the reliability of the Present Value.
If the Input Reference goes unreliable, the
extension monitoring the input goes unreliable.
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Table 74: Load Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Requested Shed
Level

W 0 1–65,535 Controls the desired level of Load shedding for
one shed. Specifying a value greater than the
value configured in the Shed Levels attribute
sheds to the Shed Levels value. Specifying a value
less than the value configured in the Shed Levels
attribute (such as zero) cancels a shed.
The DLLR object writes this attribute to one and
sheds the Load object. Once the shed completes,
the Load object resets this value to zero.
If the Load object sheds through a non-BACnet
method, such as the Shed command, the Load
sets this attribute to one and returns it to zero
after the shed completes.

Shed Command W None Shed Command set Indicates the current shed/release state of the
Load. This attribute also offers the option of
shedding or releasing a Load.
Release—Releases the Load. The On Release
attribute determines when the Load is released. If
the Load is already released, there is no change.
Shed—Immediately sheds a released Load
regardless of its Minimum On Time. If the Load is
already shed, there is no change.

Shed Duration W 0 1–65,535 Indicates the number of minutes to shed the
Load. Writing this attribute to a value less than
the current time minus the Start Time attribute
value cancels a shed.
The DLLR object sets this attribute to shed the
load. After the shed completes, the Load sets it to
zero.
If the Load object sheds through a non-BACnet
method, such as the Shed command or Shed
Command attribute, it sets this value to the
Max Shed Time and returns it to zero when the
shed completes. If no Max Shed Time is defined,
the Load sets this value to its maximum value
(0xFFFF), which is the maximum number of
minutes that a Load can shed without being
locked shed.

Shed Level
Descriptions

Shed All Load Uses Shed Level
Descriptions set.

Provides a description of the shed level supported
by the Load object.

Shed Levels C,W 1 1–65,535 Specifies the shed levels used for the Requested
Shed Level attribute. Set this attribute to a value
of one (1) for the DLLR to automatically shed the
Load. If this attribute is set to another value, the
DLLR does not shed or release the Load; although
the Load can be shed and released manually or
by another feature, the Load is automatically
released upon expiration of its Maximum Shed
Time, unless the Load is Locked Shed.

Shed Status Released Shed Status set Indicates if the Load is shed or released, and, if
shed, which strategy was used to shed the Load
(DL or LR).

Shed Ineligibility Load Ineligibility set Indicates whether a load is eligible to be shed at
the current time, and, if ineligible, the cause of
ineligibility.
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Table 74: Load Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Shed Strategy C,W 0 Shed Strategy set Indicates which strategy is permitted to shed the

Load (DL, LR, or both).
Time Remaining C,W Indicates how much longer a Load timer is in

effect. The Active Timer attribute indicates which
timer is in effect.

Start Time W BACnet Date Time
structure

Indicates the date and time that the Load sheds.
Writing this attribute to a wildcard releases a shed
load.
The DLLR object sets this attribute to shed
the Load. Once the shed completes, the Load
object sets the value to date and time wildcards
(NONE_FFFF).
If the Load object sheds through a non-BACnet
method, such as the Shed command, it sets this
attribute to the current time, and returns it to
NONE_FFFF after the shed completes.

Status Flags False, False,
False, False

In Alarm, Fault,
Overridden, Out of
Service

Indicates the general status of the object in
BACnet terms and contains four independent
states.
The four flags are:
In Alarm—False if the Event State attribute value
is Normal; otherwise, the In Alarm flag is True.
(Set only by BACnet Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is  not
reliable; otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the
Present Value is overridden from the hardware
source level.
Out of Service—Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Units C,W IP
SI

Indicates the measurement units of this
extension.

Load Commanding
Objects with a Load extension and intended for use with the DLLR feature permit the following
operator or scheduled commands.
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Table 75: Commands Available to Load Objects
Command Parameters Description
Shed Type

Percent, Level, or Amount
Value
New shed value

Sheds the load immediately. The output is written
at priority 13 (LR) if the Shed Strategy is set to
Load Rolling Only. Otherwise, it is written at
priority 11 (DL). When this command is issued, the
output is commanded regardless of whether DLLR
is in Shed or Monitor Only mode.
Select only the Level command and use the
default value of 1. The Percent and Amount
command options are intended for future use.

Release Load None Releases the load, which releases the command
at the priority at which it was previously written
by the shed command (11 or 13). The On Release
attribute defined in the Load object determines
whether the release occurs immediately when
the command is issued, or waits for the Minimum
Shed timer to expire.

Comfort Override Release Immediately
Release After Timer
Expires

Releases a shed load that is resulting in occupant
discomfort. This command releases the shed and
prevents a future shed until the Release Comfort
Override command is issued. You can either
select to release the load immediately when the
command is issued, or only after the Minimum
Shed Timer expires. If no parameter is selected,
the default is to release the load immediately.

Release Comfort
Override

None Releases the Comfort Override command and
allows the load to be shed.

Lock None Locks the load in its current shed or released
state. The load remains in this state until an
Unlock (or Disable) command is issued.

Unlock None Releases a Lock command. If the load was locked
shed and its Maximum Shed Time expired, it now
releases.

Disable None Disables the load, which causes it to release its
output command immediately if it is shed, and
clears any Lock or Comfort Override commands
that have been issued. While disabled, the load is
not eligible to be shed.

Enable None Enables the load, which permits it to be controlled
by DLLR.

Load Command Interactions
Table 76 illustrates command interactions that pertain to Load objects.
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Table 76: Load Command Interactions
Load Command(s)
Currently in Effect

Load Command
Not Allowed

Explanation

Shed Shed Load cannot be shed because it is already shed.
Shed + Locked Comfort Override

or
Release Load

Lock must be removed with Unlock command.

Comfort Override Shed Comfort Override must be released with Release
Comfort Override command.

Released + Locked Shed Lock must be removed with Unlock command.
Released + Locked
and
Comfort Override

Shed Comfort Override must be released with Release
Comfort Override command.
Lock must be removed with Unlock command.

Resource File Extensions
The Resource File extension represents an actual physical file that gets placed in the System
Configuration Tool’s database or in the file system (Flash Memory of an Engine device). The
resource file is an extension of another object called the parent object. The parent objects for
Resource File extensions can be field devices.
After completing the Field Device, the wizard prompts you to add a resource file extension. The
resource file extension allows you to define the attributes that represent a defined resource file and
allows you to populate resource files for integrations. For example, you can define a set of resource
files to support communication with field devices. The resource file notifies its parent object when
any changes are made to the extension.

Note: When using an HVAC PRO file as a resource file, be sure you use the long print file
format because it provides the Metasys system with more information than the short print
file format. For example, the long print file format imports the units of measure while the
short print file format uses defaults based on the HVAC PRO units setting. For analog values,
it uses the default units of Deg F or Deg C (based on the Metric versus Imperial units specified
in the PRN file). If you use a short form PRN file, the User Interface displays a warning
message stating that you have selected a short format PRN file that does not contain the unit's
information. The warning message indicates the Metasys system is using the default setting
that may not match the original units.

For more information on resource file extensions, see Resource File Attributes.

Resource File Attributes
Resource File Extensions contain attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Resource File extension. Click the attribute
name in the table for a description of the attribute. Attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.
Table 77: Resource File Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
File Name C Category = File See the File Name section.

Information C,W Size = 80
Category = Default

Indicates the text you assigned to provide further
information about the resource file. This attribute
can be written to from an integration server after
reading the resource file.
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Resource File Extension Attribute Details

File Name
The following table indicates the file containing resources located within the host computer.
Table 78: Resource File - File Name Elements
Element Name Initial

Value
Values/Options/
Range

Description

Exportable False Available in a future
release

Indicates whether you can export the file.
If True, you can export the file. If False, you
cannot export the file. This element of the
File Name attribute is to be available in a
future release.

Object
References

Indicates the object references embedded
in the file.

References False Indicates whether the file has references.
If True, the file has references. If False, the
file has no references.

Relative Path Size = 100
Category = Default

Indicates the file name of the file relative to
the directory containing the MOI file for the
device.

File Name: Exportable
Indicates whether you can export the file. If True, you can export the file. If False, you cannot export
the file. This element of the File Name attribute is to be available in a future release.

File Name: Object References
Indicates the object references embedded in the file.

File Name: References
Indicates whether the file has references. If True, the file has references. If False, the file has no
references.

File Name: Relative Path
Indicates the file name of the file relative to the directory containing the MOI file for the device.

Information
Indicates the text you assigned to provide further information about the resource file. This attribute
can be written to from an integration server after reading the resource file.

Averaging Extensions
The Averaging extension calculates the average, minimum, and maximum value of an attribute
over a specific interval (for example, space temperature over 24 hours). The extension is able to
sample Boolean, Integer, Unsigned, Enumerated, or Float attribute value types for any extendable
objects within a BACnet device.
For more information on averaging extensions, see Averaging Attributes.

Averaging Attributes
Averaging Extensions contain attributes common to Metasys system objects. For details, see
Common Object Attributes.
The following table lists the attributes specific to the Averaging extension. Click the attribute name
in the table for a description of the attribute.
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Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.

Table 79: Averaging Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Input Reference C Defines the object and attribute pair to be

sampled. The sampled object must be on the
same device as the Averaging object.

Max Value
Timestamp

Invalid
DateTime

If Average Value,
Minimum Value,
or Maximum Value
is Unreliable, the
timestamp is Undefined.

Indicates the date and time that the Maximum
Value has changed in the sampling buffer.

Min Value
Timestamp

Invalid
DateTime

If Average Value,
Minimum Value,
or Maximum Value
is Unreliable, the
timestamp is Undefined.

Indicates the date and time that the Minimum
Value has changed in the sampling buffer.

Object Property Ref Designates the particular object and attribute
referenced by the Averaging object. This is a
BACnet Device Property Reference structure type
attribute that specifies bind information from the
object/attribute defined by the Input Reference
attribute. The binding information consists of the
Device Identifier, Object Identifier, Array Index,
and Property Identifier of the trended property.
An on-box object returns nothing for the Device
Identifier. The Device Object configures this
attribute during object creation. Changing Object
Property Ref may change Input Ref, and changing
Input Ref may change Object Property Ref. Since
Object Property Ref is based on Input Ref, and
Input Ref does not support Array Index, Object
Property Ref does not support Array Index either.

Valid Samples Indicates the number of samples in the sampling
buffer that are valid. A sample is marked invalid
if a read error occurs when reading requested
attributes from the host object. The number of
invalid samples can be determined by subtracting
Valid Samples from Attempted Samples. If the
difference is greater than zero, it indicates an
error during sample collection. After Attempted
Samples, Window Samples, or Window Interval is
written, until a sample is taken, this attribute is set
to zero.

If any of these variables are Unreliable and a BACnet read is performed on the following three attributes, the values
returned are NaN for Average Value, -INF for Minimum Value, and INF for Maximum Value. If these values are Unreliable
and a BACnet read is not performed, the attributes return zero.
Average Value D,R NaN Units of the extended

attribute
Indicates the sum of all valid samples in the
sampling buffer divided by the number of
samples in the buffer. This attribute is set to
NaN with its Reliability set to Unreliable until a
sample is taken and Attempted Samples, Window
Samples, or Window Interval is written.
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Table 79: Averaging Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Maximum Value R -INF Units of the extended

attribute
Indicates the highest value of the valid samples
in the buffer. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to -INF with its
Reliability set to Unreliable.

Minimum Value R INF Units of the extended
attribute

Indicates the lowest value of the valid samples
in the buffer. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to -INF with its
Reliability set to Unreliable.

If any of the following three attributes are written or changed, all samples in the sampling buffer become invalid (set to
zero, NaN, -INF, or INF), which makes them Undefined for the UI.
Attempted Samples W The only acceptable

value that can be written
to this property is
zero using the Clear
command.

Indicates the total number of samples in the
buffer. The only acceptable number that can be
written to this attribute is zero. After Window
Samples or Window Interval is written, until a
sample is taken, this attribute is set to zero.

Window Interval C,W 3,600 Units = seconds
Range: 900–360,060

Indicates the period of time in seconds over
which the Minimum Value, Maximum Value, and
Average Value are calculated. Samples are taken
at a specific sample rate, which cannot be less
than 4 seconds. The sample rate is calculated
by dividing the Window Interval by the number
of samples as defined in the Window Samples
attribute. The default value is 3,600 seconds.

Window Samples C,W 15 Range: 2–200 Indicates the sum of all valid samples in the
sampling buffer divided by the number of
samples in the buffer. This attribute is set to
NaN with its Reliability set to Unreliable until a
sample is taken and Attempted Samples, Window
Samples, or Window Interval is written.

The following four attributes do not appear in a view, but may be scheduled, trended, and so on.
COV Increment C,W 0.01 Any value > 0

Floating point value of
the Display Precision.

This attribute does not appear in a view, but may
be scheduled, trended, and so on.
Specifies the minimum change in Present Value
required for the object to report a change in the
Average Value, Minimum Value, and Maximum
Value attributes.

Display Precision C,W 100ths Uses Display Precision
(Set 0).

Defines the decimal rounding and the decimal
places to display for the Present Value and
associated attributes. Average Value, Minimum
Value, and Maximum Value use the same display
precision.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.
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Table 79: Averaging Extension Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Reliability Reliable Uses Reliability (Set 503). Indicates whether the Average Value, Minimum

Value, and Maximum Value attributes are
Unreliable. After Attempted Samples, Window
Samples, or Window Interval is written, until a
sample is taken, this attribute is set to Unreliable.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Units No Units Units of the extended
attribute

Indicates the units of the mapped attribute of the
extended object. Average Value, Minimum Value,
and Maximum Value use the same units.
This attribute does not appear in a view, but may
be scheduled, trended, and so on.

Averaging Commands
The following table lists the commands supported by the Averaging Extensions. Click the command
name for a description of the command.
Table 80: Averaging Extension Commands
Command Name Parameters Description
Enable None Clears the sampling buffer and

restarts the sampling process. This
command has the same effect as
the Clear command.

Disable None Stops the sampling process.
Clear None Writes zero to the Attempted

Samples attribute, clears the
sampling buffer, and restarts the
sampling process. This command
has the same effect as the Enable
command.

Extensions Steps

Creating Extensions
About this task:  
To create extensions:

1. Select the item from the Navigation Tree and select Show Extensions from the Action menu.

Note: Alternatively, you can create extensions when prompted upon completion of a
wizard, or when the item is in the Panel Layout by selecting the tab for the extension and
clicking new.

2. Select New for the type of extension that you want to create. The corresponding Extension
Wizard appears.

3. Select the attribute that you want to associate with the item.
4. Complete the information on the wizard screens. The screens vary depending on the type of

extension you are creating.
5. Select Finish on the summary page to create the extension.

SCT: System Configuration Tool Help182



Viewing Extensions
About this task:  
To view extensions:

1. Drag and drop the object into the Panel Layout.
2. Click the tab along the top for the desired extension.

Editing Extensions
About this task:  
To edit extensions:

1. View the extension.
2. Select the tab for the extension.
3. Select the extension you want to edit.

Note: For trend extensions, make sure you select the Definition View button to display
the trend’s attributes.

4. Click Edit.
5. Make your changes.
6. Click Save.

Copying and Pasting Extensions
About this task:  

Note: You can perform this procedure only in the System Configuration Tool (Offline Mode).
You must first create extensions before you can copy and paste them from one item to
another. See Creating Extensions for details on how to create extensions.

To copy and paste existing extensions:

1. Select the item from the Navigation Tree that contains the existing extensions that you want
to copy, and select Show Extensions from the Action menu. The Extension wizard appears.

Note: Alternatively, you can right-click the item in the navigation tree and select Show
Extensions from the menu that appears.

2. Select the check box for one or more of the existing extensions that you want to copy.
3. Click Copy Checked Extensions.
4. Click Done.
5. Select the item from the navigation tree that you want to receive the copied extensions, and

select Paste from the Edit Menu.

Note: Alternatively, you can right-click the item in the navigation tree and select
Edit > Paste from the menu that appears.

When you paste an extension, the extension retains the name of the copied extension and
appends it with a number.

Deleting Extensions
About this task:  
For a trend extension that is configured to automatically transfer data to a Metasys Server or ODS
(Repository Enabled = True), be sure to route unforwarded data to the Metasys Server or ODS
before deleting the trend extension. If you do not, unforwarded trend data is lost.

1. To delete extensions (using the Navigation Tree):
a. Select the item from the navigation tree and select Show Extensions from the Action
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menu.
b. Select the check box of the extension you want to delete.
c. Click Delete.

2. To delete extensions (when the item is in the Panel Layout):
a. View the extension.
b. Select the tab for the extension.
c. Select the extension.
d. Click Delete.

Searching for Extensions
You can search for Alarm, Trend, or Totalization extensions using the Global Search feature. This
allows you to find up to 100 extension objects and view their current values.

Commanding Extensions
You can command Alarm, Trend, or Totalization extensions from an Extension View or from the
Global Search Viewer. You can also command Trend extensions from a Trend Viewer or Trend Study
view.

Single Extension
About this task:  
To command a single extension object:

1. Right-click the extension object you wish to command.
2. Select Commands from the right-click menu. The Commands dialog box appears.
3. Choose the command to send.
4. Click Send.

Multiple Extension
About this task:  
To command multiple extension objects together (Global Commanding):

1. Use the Global Search feature to find the extension objects (Alarm, Trend, or Totalization).
You may also open a saved Object List containing extension objects. See Interlocking a Trend
Extension for more information.

2. Select the extensions you wish to command (must be of the same type).
3. Select Commands from the Action menu. The Global Commands dialog box appears.
4. Choose the command to send.
5. Click Send.

Interlocking a Trend Extension
About this task:  
To interlock a Trend Extension:

1. Create a trend extension. See the Creating Extensions and the Trend Extensions sections for
information.

2. Create an Insert Object - Interlock that references the trend extension. See the Insert Object -
Interlock section.

Extension Wizard

Note: You cannot add or delete extensions in Simulation mode.
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Menu Selection: Actions > Show Extensions (menu option is available only when an item that
supports extensions is selected)
Adds features, such as trending, alarming, averaging, loading and totalization, to an item. Extension
types include:

• Resource File—Adds a resource file to a field device or integration, if supported.
• Trend—Adds trending capabilities to an item.
• Totalization—Adds totalization capabilities to an item.

Note: Select either the Event Totalization or Runtime Totalization radio button if they
appear on the right side of the Select Attribute screen of this wizard. If these selections do
not appear, the attribute you selected uses Analog Totalization.

• Alarm—Adds attributes for generating alarm and event messages to an item. For more
information, refer to the Alarm and Event section of the Metasys SMP Help (LIT-1201793).

• Averaging—Adds averaging capabilities to an item.
• Load—Adds the load capability of the Energy Management feature. You can add only one load

extension to an object.
See the Extensions section.

Insert Menu

Site
Menu Selection: Insert > Site
Inserts a site into the archive database in the SCT.

Tip: The Create Device? dialog box appears after inserting a site that asks if you want to
create a device in the site. To invoke the Insert Device wizard, select Supervisory Device, then
click OK. To invoke the Insert Metasys Server wizard, select Metasys Server, then click OK. If
you do not want to add a device at this time, select None, then click OK.

Site Object
The Site object defines the attributes that represent the characteristics of a site. If the Site object
exists on a device, that device is considered a Site Director. Starting at Release 10.0, you can
no longer configure a connection to a cloud-based platform with the attributes in the Remote
Services Connection tab of the Site object. The tab still appears, but you should no longer define its
attributes.
Notes:

• In SCT, a Site object may exist without a Site Director. In this case, you can open the edit
window and make changes to the custom authorization category; however, you cannot save
any changes until you add a Site Director.

• When you promote or demote a Site Director offline in SCT, the custom categories are rebuilt
using their default settings.

• If you need to change the name of the Site object, make sure you first close all user views. This
action ensures that all object references throughout the site reflect the new Site object name.

Site Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
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Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
For information on the Custom Enumeration tab, see User Defined Enumeration Editor Tab.

Note: In the Notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable.

Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Advanced Security Enabled C,W True Indicates whether the site uses the advanced security settings. This

attribute provides an improved layer of security between Metasys
Site Directors and devices. With this attribute set to true, backward-
compatible methods of communication between the Site Director
and its network engines are disabled, which means a Site Director
at Release 10.0 or later discards all communication attempts from
network engines prior to Release 10.0.
This attribute, which SCT sets to True for any site archive that is
created at, or upgraded to, Release 10.1, applies to the entire site.
Therefore, if you have any network engine on the site that is running
a Metasys release prior to Release 10.0, change Advanced Security
Enabled for the Site object to False.
If you change this attribute from False to True, a user message
appears to indicate that all network engines prior to Release 10.0
remain online, but are disconnected from the site because they no
longer communicate with the Site Director.
If this message appears, click OK to continue and set the attribute to
True, or Cancel to keep the attribute set to False.

All Items Update in Progress C,W False Indicates when the cache update completes after executing an
Update All Items Cache command. Starting at Release 5.0, the All
Items navigation tree in the Metasys UI depends on the data cached
in the Site Director, which is called the All Items cache. The All Items
cache automatically updates for engines at Release 5.0 or later. The
cache does not automatically update for engines at a release prior
to 5.0 after making changes when the UI is logged directly into the
engine (that is, not through the Site Director), or when downloading
an engine from the SCT (not through the Site Director). For these
scenarios, you must use the Update All Items Cache command
to update the All Items cache on the Site Director. This attribute
appears only in the online UI.

Annotation Alarm Priority
Threshold

C,W 140 Specifies the value that represents the range of alarm priority
thresholds. The default value is 140. This attribute is checked when
determining whether an event requires annotation on an ADX
MVE installation. If the Event Priority value is below the threshold,
annotation is required. This attribute appears only when you have
MVE installed.
For more information, refer to Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Annotation Exclude C,W Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
does not require an annotation on an ADX MVE installation. This
attribute appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).
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Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Annotation Include C,W Specifies a list of editable reference strings (fully qualified

references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
requires an annotation on an ADX MVE installation. This attribute
appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

BACnet Encoding Type C,W ISO 10646
(UCS-2)

Specifies the type of string encoding to use in BACnet messages.
Unicode should be specified unless third-party BACnet devices are
employed on the site. In this case, specify the BACnet encoding
type supported by the third-party BACnet devices. This attribute is
automatically distributed to the site devices.

Note: When a site is upgraded to Release 10.1 with SCT
13.2, and the BACnet Encoding Type for the Site object is
automatically changed to ISO 10646 UTF-8 during the archive
upgrade process. If you require UCS-2 as the BACnet Encoding
Type, make sure you set this attribute back to UCS-2 after the
archive upgrade is complete.

For information on how to set up an NAE as a BACnet system
integrator in a Metasys system network, see the BACnet® Controller
Integration with NAE/NCE Technical Bulletin (LIT-1201531).

BACnet Site C,W False Specifies whether specific information from the BACnet device
for each Metasys object is shown in the UI. When true, BACnet
information integrates into the UI for objects. When false, the
information is omitted. Internally, the BACnet protocol is used at a
certain level regardless of this attribute. This attribute is distributed
automatically to site devices.
For information on how to set up an NAE as a BACnet system
integrator in a Metasys system network, see the BACnet® Controller
Integration with NAE/NCE Technical Bulletin (LIT-1201531).

Broadcast Disabled C,W False Specifies if broadcast messages are sent by the device. When false
(default value) or no Broadcast Management object exists, the device
sends broadcast messages as defined by BACnet communication.
When the Broadcast Management object is configured and this
attribute is true, the device does not send network broadcast
messages. This attribute appears only in the Snapshot Focus view on
a Site Director engine.

Certificate Renewal Period C,W 60 Regulates when certificate expiration reminders begin. It specifies
the number of days prior to security certificate expiration before
the operator is notified daily that a certificate is about to expire.
For example, if you use the default period of 60 days, and a server
certificate on a network engine expires on January 1, beginning on
November 1, an event requiring acknowledge is sent to the Site
Director once a day or until the self-signed certificate is renewed or a
new trusted certificate is installed.
The Certificate Renewal Period applies only to engines at Release 8.1
or later, and is synchronized to all affected child network engines. A
change to the Certificate Renewal Period may take up to five minutes
to synchronize with all network engines.
For more information about certificate management, see Metasys
SCT Help (LIT-12011964) and Network and IT Guidance Technical Bulletin
(LIT-12011279).

Default Language C,W Specifies the site's default language. All devices on the site have a
dictionary using this language. This attribute appears only in the
Snapshot Focus view on a Site Director engine.
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Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
DNS Refresh Period C,W 20 Specifies the time in minutes between DNS lookups to update the

IP address of a BACnet Broadcast Management Device (BBMD)
referenced by host name. If an IP address is changed within a DNS
server, the BBMD system automatically obtains the new IP address
upon the expiration of this period. A value of 0 is used to disable
periodic DNS lookups.

Default ADS Priority
Threshold

C,W 255 Allows you to specify the priority of an event that triggers the Engine
to connect (dial-up or LAN connection) to the defined Metasys
server and deliver the event messages from the Engine local event
repository to the event repository of that Metasys server. This
attribute is used for Alarm and Event Management only.
For example, a value of 20 for this attribute means that any event
having a priority of 20 or higher (1 is highest) forces a connection to
the Metasys server and forwards event messages from the Engine
local event repository to the event repository of that Metasys server.

Default ADS Connection Type C,W LAN Specifies whether the Metasys server (identified in the Default
ADS Repository attribute) is connected through a LAN or dial-up
connection. This attribute is distributed automatically to the site
devices.

Default ADS Delivery Time C,W 12:15 AM Specifies the time of day when a connection should be established
to the Metasys server (identified by the Default ADS Repository
attribute). A connection is attempted at least daily at the specified
time to deliver audit, alarm, and trend data to the Metasys server.
This attribute is distributed automatically to the site devices.
All Metasys devices that are part of the Site use the time zone they
are located in.

Default ADS Repository C,W 0.0.0.0 Specifies the resolvable host name or IP address of a Metasys server.
The Metasys server is the device to which local audit, alarm, and
trend data is delivered. Repository refers to the files in the Metasys
server in which this data is stored. A host name may be specified only
if a DNS server is available to the device. This attribute is distributed
automatically to the site devices.
The Default ADS Repository of the Site is intentionally left blank
and must be updated by the user (online or offline). If the user
does not populate the Default ADS value and leaves the Default
ADS Repository value for all devices at 0.0.0.0, the Metasys server
does not receive any audit, alarm, or trend data. The SCT does not
automatically populate the Default ADS Repository value because
of the many different possibilities that could exist during archive
creation, including multiple Metasys server on a site or no Metasys
server for a site. In these cases, it would not be immediately clear
which Metasys server should be the Default Metasys server under
the Site object.

Default Time Zone C,W Central Time
(US and
Canada)

Specifies the site’s default time zone. The Site object determines and
updates the UTC offset from this value. Once set in the Site object,
the time zone is propagated to the other devices on the site.
All Metasys devices that are part of the Site use the time zone of the
Site Director, even if some of those devices are physically located in a
different time zone.

SCT: System Configuration Tool Help188



Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Device Time Servers C,W This attribute is used only for Windows time synchronization.

Leave this attribute blank if you are not using Windows time
synchronization. Specifies a list of resolvable host names or IP
addresses of Simple Network Time Protocol (SNTP) server devices
that the devices on the site (except the Site Director) use as their
time server. Do not use an SNTP server name that has a dash (-) as
its last character (for example, SNTP_Server-).
Periodically, each device on the site (except the Site Director)
attempts to sync time from an SNTP server from this list. Contact
with an SNTP server is attempted one at a time in list order until one
successful contact is made.
A host name may be specified only if a DNS server is available to
the site server. If the site server is also an SNTP time server, the site
server may be specified in this attribute. This attribute is distributed
automatically to the site devices.
The NxE or Metasys server designated as the Site Director is the
device time server for the site and provides the time management
for all other engines/servers on the site.
The Engine accepts BACnet Time Sync messages only if no SNTP
server is defined for that Engine.

Dynamic Broadcast
Management

False (SMP)
True (SCT)

Configures the Metasys system with BBMDs automatically when a
Metasys system includes more than one IP subnet so that BACnet
protocol broadcasts reach all Metasys system devices. When set to
True, Dynamic Broadcast Management determines the number of
IP subnets and ensures that each IP subnet has exactly one BBMD.
The feature uses the Third Party BBMDs List attribute in the Site
object when determining the list of devices to be BBMDs. As devices
are added or removed from the site, the selection of broadcast
management devices occurs automatically.

Note: Do not edit the BBMD Broadcast Distribution Table
in the Ethernet IP Datalink network port object if Dynamic
Broadcast Management is set to True.

When Dynamic Broadcast Management is set to False, the BBMD
Broadcast Distribution Table in the Ethernet IP Datalink network
port object is used to determine BBMD devices. Do not use the Third
Party BBMDs List attribute in the Site object. At Release 11.0, you
can edit the BBMD Broadcast Distribution Table with the option of
specifying an IP address or a host name.

Enum Set Memory Used 0 Indicates amount of memory used by the created auto and custom
sets.

File Name C,W Specifies an XML file containing site organization data within the
file system of the host computer. This attribute appears only in the
Snapshot Focus view on a Site Director engine.

Multicast Group Address C,W 224.0.1.1 Specifies the IP address used to multicast the SNTP message. The
RFC-2030 defined standard address is 224.0.1.1. The address is
configurable to allow site-specific use.

Multicast Heartbeat Interval C,W 5 Specifies the number of minutes between forcing a multicast time
synchronization message.

Multicast TLL C,W 1 Specifies the Time-to-Live for a multicast message. The value
indicates the number of router hops allowed before the message is
not sent. Routers must be configured to pass multicast messages to
allow the time sync message to pass.

Multicast UDP Port C,W 123 Specifies the UDP port on which multicast time synchronization polls
and listens for messages. The RFC-2030 defined standard port is 123.
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Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Online Archive Transfer in
Progress

False Indicates whether the Metasys Server is currently archiving changes
to its database as a result of a network engine download from SCT.
This attribute changes to True during the archive process, then
changes to False after the archive update is complete.

Poll Rate C,W Fast Specifies the frequency at which the Site Director checks its
communication status with site devices. This setting affects
the detection time of offline NxEs, and the amount of network
bandwidth needed to support this detection. At the default setting
Fast, the detection time is short, but the network bandwidth use is
high. At a Slow setting, the detection time is longer, but network
bandwidth use is low. The calculated Detection Interval is shown in
the NxE.
This setting only affects communications with devices at Release 5.2
or later.

Remaining Auto Sets 1000 Indicates the number of remaining auto sets available.

Remaining Custom Sets 256 Indicates the number of remaining custom sets available.

Security Level C,W Medium (1) Specifies the security level to be used by this device. This attribute is
distributed to the site's devices automatically.
This attribute appears only in the Snapshot Focus view on a Site
Director engine. Valid options include:
Low [0]: Login required.
Medium [1]: Low plus authorization.
High [2]: Medium plus signatures.

Signature Alarm Priority
Threshold

C,W 140 Specifies the value that represents the range of alarm priority
thresholds. The default value is 140. This attribute is checked when
determining whether an event requires electronic signature on
an ADX MVE installation. If the Event Priority value is below the
threshold, a signature is required. This attribute appears only when
you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Signature Exclude C,W Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the
string. If an item reference appears in this attribute, an event for this
item does not require a signature on an ADX MVE installation. This
attribute appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Signature Include C,W Specifies a list of editable reference strings (fully qualified
references) that allow wild card notation at any location in the string.
If an item reference appears in this attribute, an event for this item
requires a signature on an ADX MVE installation. This attribute
appears only when you have MVE installed.
For more information, refer to the Metasys for Validated Environments,
Extended Architecture Technical Bulletin (LIT-12011327).

Site Director Reference C,W Specifies the object name of the Site Director for the site. If the site
has more than one Site Director, the attribute becomes a selection
list from which you can change the Site Director Reference. When
you change the Site Director, a message appears to request you to
log in to the new Site Director.
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Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Site Security Level C,W Encrypted

Only
Selects whether encrypted only communication or encrypted and
trusted communication is enabled between the Metasys server and
its network engines. Do not set this attribute to Encrypted and
Trusted until all network engines reporting to the Site Director have
been downloaded with trusted certificates. If the site has one or
more network engines with self-signed certificates only, but not
trusted certificates, set this attribute to Encrypted Only.

Site Time Servers C,W Specifies a list of resolvable host names or IP addresses of SNTP
server devices that the Site Director uses as its time server.
Periodically, the Site Director attempts to sync time from an SNTP
server from this list. Contact with an SNTP server is attempted one at
a time in list order until one successful contact is made. A host name
may be specified only if a DNS server is available to the site server.
Important items:
- The Site Director provides the time management for the site.
- On the NAE35/NAE45/NCE25, only the first listed address is used.
- An error message appears when you have configured one or more
Site Time Servers and attempt to change the time and date using the
Set Time and Set Date commands.
- The Engine accepts BACnet Time Sync messages only if no SNTP
server is defined for that Engine.
- The Site Time Servers attribute must be set to an SNTP server to
facilitate synchronization when in Multicast mode. Only the first Site
Time Server is used if more than one is specified in Multicast mode.
- When the Time Sync Method is set to Windows, also set the Internet
Time Server in the Windows operating system of the Site Director to
match the IP Address specified for the Site Time Server. In Control
Panel of the Site Director, search for Date and Time. On the Date
and Time dialog box, click the Internet Time tab. Click Change
Settings and enter in the Server field the same IP address that
you defined in the Site Time Server attribute. Click OK to apply the
change.
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Table 81: Site Object Attributes - Site View Tab
Attribute Name Notes Initial Value Description
Third Party BBMDs C,W The Third Party BBMDs attribute is used by the Dynamic Broadcast

Management feature to help determine the placement of BBMDs.
BBMDs are used in the BACnet protocol to eliminate broadcast
messages sent across multiple subnets on an IP network. A single
device on each subnet, referred to as the BBMD, receives messages
from other BBMDs and broadcasts them locally on its own subnet.
If one or more third-party BBMDs exist, this attribute should specify
the complete list of IP addresses of third-party BBMDs and Metasys
system devices that should act as a BBMD. Each IP subnet should
have exactly one BBMD, either a third-party or Metasys system
device. To function properly, each third-party BBMD must be
configured with the list of all other BBMDs within the system as well.
If the Metasys system does not include any third-party BBMDs, then
this attribute typically should be left empty. A possible exception
would be if you want to designate a particular Metasys system device
as a BBMD, then that device could be added to the Third Party BBMD
list. If no device is specified by this attribute for an IP subnet, the
Dynamic Broadcast Management feature automatically assigns
a Metasys system device. Do not specify more than one Metasys
system device per IP subnet.
The devices are configured in the Third Party BBMD list in the
following ways:
- Address-UDP Port: Use the BACnet UDP Port address. The default is
47808.
- Address-IP: Use the IP address of the device.
- IP Broadcast Mask: Use the BACnet Broadcast Mask as defined by
BACnet standard 135-2004, section J.4.3.2. Specify 255.255.255.255
if messages should be directly sent to remote BBMDs using a unicast
IP address or broadcast messages are not allowed through the IP
router to the remote subnet. Otherwise, specify the subnet mask of
the remote subnet if broadcast messages are allowed through the IP
router to a remote subnet.
In most cases, IP routers do not allow broadcast messages to be
passed to a remote subnet; therefore, the mask should be set to
255.255.255.255. If the IT department knows that broadcast
messages are allowed to the remote subnet, then set the mask to
the subnet mask that the BBMD resides upon.

Time Sync Method C,W Windows Determines which mode is used to synchronize time. The available
modes are Windows or Multicast. Windows mode uses the Microsoft
W32Time service. Multicast mode uses a specific implementation of
the standard SNTP, which includes periodic multicasting of system
time to maintain better time synchronization across devices.

Time Sync Period C,W 1 hour Specifies the interval at which the Site Director polls the defined site
time server (STS) (for example, the Atomic clock) for the time. We
recommend leaving the default value for this attribute. This attribute
applies only to the Engine.

Warning Banner C,W False Enables a special login feature that displays a warning statement
each time you access the Site Management Portal. The banner
appears for logging into the Site Director and any of its child devices.
Select one of the following warning banners: U.S. Department of
Defense (DoD), U.S. General Services Administration (GSA), U.S.
Department of Transportation (DOT) Federal Aviation Administration
(FAA), or None (no banner; default).
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Table 82: Configuring Metasys System Devices in the Third Party BBMD List
Field Description
Address-UDP Port Use the BACnet UDP Port address. The default is 47808.
Address-IP Use the IP address of the device.
IP Broadcast Mask Use the Broadcast Mask of the Metasys system device.

Important: This is not the subnet mask for Metasys system devices. Metasys sys-
tem devices automatically use 255.255.255.255 for the broadcast mask.

Note: The changes made to labels on Authorization Category in the Site object are shown
in the Security Administrator screens. Refer to the Authorization Category Assignment section
of the Security Administrator System Technical Bulletin (LIT-1201528) for more information on
changing Object Categories labels and how these changes affect the UI.

Table 83: Site Object Attributes - Object Categories Tab
Authorization Category Display Text
Standard Object Categories (Standard Object strings cannot be modified.)
HVAC HVAC
Fire Fire
Security Security
Services Services
Administrative Administrative
General General
Lighting Lighting
Refrigeration Refrigeration
Critical Environment Critical Environment
Air Quality Air Quality
Power Power
Energy Energy
System System
Custom Object Categories (Display text can be modified).
Custom 1 - Custom 150

Note: Devices at a release earlier than 5.2 are
limited to 12 categories.

Custom 1 - Custom 150 (default)

Supervisory Device
Menu Selection: Insert > Supervisory Device
Inserts a supervisory device into the archive database with SCT, including the following network
engines: NAE35, NIE39, NAE45, NAE451L, NIE49, NAE55, NIE59, NAE85, NIE89, NCE25, NIE29, NIE55,
NIE85, SNE10/SNE11/SNE22, and SNC16/SNC25. You can insert a device at a previous Metasys
system release with SCT, beginning with Release 5.2 and later. The SNE and SNC devices are only
available to SMP at Release 10.1 or later, and SCT Release 13.2 and later.

Note: The NAE451L and SNE110Lx network engines are available only to select regions
of Australia, China, Hong Kong, India, Indonesia, Japan, Korea, Malaysia, New Zealand,
Philippines, Singapore, Taiwan, Thailand, Vietnam, and select branches.
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On the Configure screen of this wizard, click any tabs that may appear for further device
configuration.

Engine Device Object
The Engine object defines the attributes that represent the externally visible characteristics of a
NAE/NIEx5/NIEx9/NCE or SNE/SNC controller. One Engine Device object exists per controller. The
Johnson Controls Engine object functions differently from the BACnet Device object.

Notes:
• In this chapter, Engines applies to all models of network engines, including the following:

- Network Control Engines: NCE25
- Network Automation Engines (small-capacity): NAE35 and NAE45
- Network Automation Engines (large-capacity): NAE55 and NAE85
- Network Integration Engines (small-capacity): NIE29, NIE39, NIE49
- Network Integration Engines (large-capacity): NIE59, NIE89
- Series of Network Controllers: SNC16 and SNC25
- Series of Network Engines: SNE10, SNE11, and SNE22

• The Object Type for this object is labeled Device in the software.
• If you open the Focus window for an Engine object but the window indicates the engine is

unreachable, you may need to the pair the engine to the Site Director. For details, see Pair
Network Engine with Site Director.

• For SNE and SNC engines upgraded to Release 11.0, you cannot change the Computer
Name and JCI IP Address at the same time. If you need to change both of these attributes,
change one at a time. The engine resets after each operation.

• Also, for SNE and SNC engines upgraded to Release 11.0, two USB Control attributes
protect the two USB ports on the engine from intrusion. Before you can use the USB
ports, you need to set the USB Port 1 Enabled and USB Port 2 Enabled attributes under
the Focus window to True. See Engine Attributes.

This object allows you to see data about the controller, such as the IP address and the current date
and time.
For general information on Metasys system objects, see the Object Help section.

Engine Concepts

Flash Memory
A type of nonvolatile memory within the Engine device. The Engine stores the operating system,
software, and archive within this memory. This memory is not used during normal operation of the
Engine device, except when a new graphic is added and the new image is uploaded and stored. The
flash memory is mostly used during shutdown and system restart.

Operating System
Engines use a Microsoft Windows Embedded or Linux operating system (specific operating system
depends on the model), which is shipped preinstalled on the Engine or can be updated after the
engine is installed. In general, the operating system cannot be modified by adding or deleting
programs or drivers, although provisions are made to install factory-authorized patches and
upgrades.

Software
The software is the Johnson Controls programs used in the Engine, also preinstalled at the factory.
This includes graphics, trending, logic, alarm, and other programs. Provisions are made for both the
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software and the operating system to be upgraded at the job site when new revisions of Metasys
Engine software are available.

Database
The database is the collection of objects and their parameters as defined by the user. Each
database is unique to the job. A database can be created or edited (with appropriate user authority)
either online using the Site Management Portal UI, or offline using SCT. SCT can also be used to
download a database or upload and create a backup copy of the database.

Archive
A copy of the database, called the archive, is kept in each Engine’s flash memory. This happens
automatically once a day or on operator command. Following restoration of power loss to an
Engine, the archive is copied into main memory to restore normal operation.

Background File Transfer
Network engine models at Metasys Release 10.1 or later support the Background File Transfer
feature. When you use SCT 13.2 or later to perform a download to the NAE55-2, NAE55-3, SNE, and
SNC models, you use the Background File Transfer feature. Background File Transfer permits you
to download a new image and database to a network engine while the engine is still running and
controlling the building. With previous releases, the engine was offline and inaccessible during this
process. The Background File Transfer feature is part of the Manage Archive Wizard > Download
To Device option in SCT.
The two background file transfer types offered in SCT are:
Code and Configuration: download and activate operating system, archive database, security
database, and HTTPS certificates. This file transfer type re-provisions the Flash memory of the
engine, including the operating system, application software, and device configuration.
Configuration only: download and activate archive database, security database, and HTTPS
certificates. This file transfer type updates the device configuration only, including the archive and
security databases, or certificates.
You can choose when to activate the downloaded files. If you activate the files immediately, the files
activate after the download completes. If you do not activate immediately, the files go into a staged
state in which the files are ready to deploy, but not until you are ready. The Staged Files attribute
of a network engine contains information about which files are downloaded but not yet applied.
Eventually, you can issue an Apply Staged Files command with the SMP UI to manually activate the
files you transferred. For more details, see Download.

Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, Q - BACnet Required, W - Writable.

When you promote or demote a network engine Site Director online using the Site Management
Portal UI, you are prompted for the user credentials of the Site Director you specified. These user
credentials are authenticated before the promotion or demotion is permitted.

195SCT: System Configuration Tool Help



Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Ack Forward Enable C,W Specifies whether all events acknowledged or discarded at a

network engine are forwarded to the ADS repository if an ADS
Repository is configured. What is included are:

• Events and BACnet intrinsic alarm notifications generated
by the engine and acknowledged by a user logged into
the engine SMP.

• BACnet intrinsic alarm notifications received by an
engine that are acknowledged at a BACnet device and
acknowledged by the engine without a user ID and
forwarded to the repository.

Acknowledgments are not forwarded to an ADS repository on
a dial-up connection.
When you acknowledge BACnet event notifications, events are
annotated with the source or device of the acknowledgment
and your user name as who acknowledged the event. If an
event notification from an engine is acknowledged at a third-
party BACnet workstation, the event annotation at both the
engine and the site include the source of the annotation. If,
however, an event notification from a third-party device is
acknowledged from a third-party workstation, any engine that
also receives the event notification does not include a source
for the acknowledgment. When that event acknowledgment
is forwarded to the Site Director, the user is specified as
MetasysSysAgent.
When this attribute is not enabled, events acknowledged at
engines are:

• not forwarded to the ADS repository. All events must be
acknowledged at the Site Director.

• locally acknowledged at the engine. This
acknowledgment includes sending a BACnet alarm
acknowledgment for alarm notifications received by an
engine.

Regardless of whether this attribute is enabled, when events
are acknowledged or discarded at the Site Director, the
Site Director attempts to forward the acknowledgment and
discards it to the engine that initiated the event.
The Ack Forward Enable attribute must always be false on
Engines configured for validated environments, that is,
whenever signatures are required when acknowledging
events.
The behavior for Ack Forwarding is not well defined when an
Engine is configured both as a site device and as a BACnet
integrated device at the same site. Although an Engine can be
configured both as a site device and as a BACnet integration
device, this configuration is not recommended.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
ADS Connection Type C,N,W Specifies whether the Metasys Server (defined in the ADS

Repository attribute) is connected through a LAN or dial-up
connection. If a value is specified, it overrides the value of the
Default ADS Connection Type attribute. If no value is specified,
the value of the Default ADS Connection Type attribute is used
(Default ADS Connection Type is a site level setting sent to the
site’s devices). ADS Connection Type is ignored if no Metasys
Server is defined for this site.

ADS Delivery Time C,N,W Specifies the time of day when a connection should be
established to the Metasys Server (determined by the
ADS Repository attribute). A connection is attempted at a
minimum of once a day at the specified time to deliver audit,
alarm, and trend data to the Metasys Server. If a value is
specified, it overrides the value of the Default ADS Delivery
Time attribute. If no value is specified, the value of the Default
ADS Delivery Time attribute is used (Default ADS Delivery
Time is a site level setting sent out to the site’s devices). ADS
Delivery Time is ignored if no Metasys Server is defined for
this site.

ADS Priority Threshold C,W Specifies the priority of an event that triggers the Engine
to connect (dial or LAN connection) to the defined Metasys
Server and delivers the event messages from the Engine
local event repository to the ADS event repository without
waiting for the ADS Delivery Time. The ADS Priority Threshold
attribute is used for alarm and event management only.
For example, a value of 20 for this attribute means that any
event having a priority of 20 or higher (events of higher
alarm priority have lower alarm priority numbers) forces
a connection to the Metasys Server and forwards event
messages from the Engine local event repository to the
repository of the Metasys Server.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
ADS Repository C,N,W Specifies the ADS Repository device. This device is the Metasys

Server computer that receives all audit, alarm, and trend data
from a network engine. Repository refers to the three files in
the Metasys Server that store this data. If a value is specified,
it overrides the value of the Default ADS Repository attribute
of the site. If no value is specified, the value of the Default
ADS Repository attribute is used (Default ADS Repository is
a site level setting sent to the site’s devices). When you save
a change to the ADS Repository value, no authentication
between the network engine and the Metasys Server is
required. This is normal operation.

Note:  If the Engine uses a dial-up connection to transmit data
to the Metasys Server, then the ADS Repository must be the first
IP address listed in the range specified when configuring the
Metasys Server to Allow Incoming Connections (see External
Modem Config section of the Communications tab).

The Default ADS Repository of the Site is intentionally left
blank and must be updated by the user (online or offline). If
the user does not populate the Default ADS value and leaves
the Default ADS Repository value for all devices at 0.0.0.0,
the Metasys Server does not receive any audit, alarm, or
trend data. The SCT does not automatically populate the
Default ADS Repository value because of the many different
possibilities that could exist during archive creation, including
multiple Metasys Servers on a site or no Metasys Server for a
site. In these cases, it is not immediately clear which Metasys
Server should be the Default ADS under the Site object.

Alarm Repository Size C,W Specifies the maximum number of alarms that can be
maintained on the local device.

Alarm Snooze Time C,W Specifies the amount of time to delay after an operator
temporarily ignores, or snoozes an alarm before re-
announcing the alarm.

Align Intervals Specifies whether clock-aligned periodic time synchronization
is enabled. If periodic time synchronization is enabled and
the time synchronization interval is a factor of an hour or a
day (that is, the value divides without remainder), then the
beginning of the period specified for time synchronization
aligns to the hour or day, respectively.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
APDU Retries C,W Indicates the maximum number of times that an Application

Layer Protocol Data Unit (APDU) (as specified by the BACnet
device) is retransmitted. If the device does not perform
retries, it is set to zero. If the value is greater than zero, a
nonzero value appears in the APDU Timeout attribute. If you
write the value of this attribute, you must reset the Engine for
the new settings to take effect. Recommended settings: high
or medium sensitivity: 4; low sensitivity: 5.

Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

APDU Segment Timeout C,W Indicates the amount of time in milliseconds between
retransmission of an APDU segment. Recommended settings:
high sensitivity: 4000 ms; medium sensitivity: 10000 ms; low
sensitivity: 20000 ms.

Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

APDU Timeout C,W Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received. Recommended
settings: high sensitivity: 6000 ms; medium sensitivity: 10000
ms; low sensitivity: 20000 ms.

Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

Appl SW Version Identifies the version of the application software installed in
the device. The content of this string is locally defined (date-
and-time stamp, a programmer’s name, a host file version
number, and so on).

Archive Date Indicates the date of the last successful archive of object
instances. The value of this attribute is valid when a valid
archive exists and during the archive download process. The
value of this attribute is *.*.*.* at all other times.

Audit Action When Full C,W Specifies the operation of the audit trail feature when the
audit repository is full. If the value is Stop, additional audit
entries are discarded. If the value is Rollover, additional audit
entries replace the oldest audit entries.

Audit Generate Alarm
When Full

C,W Specifies whether an alarm is generated when the audit
repository is full.

Audit Repository Size C,W Specifies the maximum number of audit trail entries that can
be maintained on the local device.

Backup And Restore State Describes the current state of the engine during the BACnet
backup or restore process. Possible values include Idle
(normal operation), Start, Downloading, Provisioning, Staged,
Activation, and Resetting.

Backup Fail Timeout C,W Specifies how long in seconds that the engine waits for the
BACnet backup or restore process to complete before timing
out and ending the process. Default is 120 seconds.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Backup Preparation Time Specifies how long in seconds that the engine remains

unresponsive after starting the BACnet backup procedure and
before timing out and ending the process. Value is fixed at 60
seconds.

BACnet Communications
Password

C,W Provides password protection of BACnet services, such as
DeviceCommunicationControl and ReinitializeDevice. Third-
party workstations may use these services and must provide
the password for the Engine to execute the services. This
attribute is user configurable if the BACnet Site attribute in
the Site object is set to True. Specify a value for the BACnet
Communication Password (maximum 20 characters)
before using any BACnet services. This password is saved in
encrypted form within the engine and within the engine's
archive in SCT. Third-party workstations cannot read or write
this password.

BACnet UDP Port C,W Specifies the UDP port number used to communicate with
other BACnet devices over the IP network. This value allows
multiple BACnet networks on a single IP network and prevents
communication between the multiple BACnet networks.
If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.

Note: If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.

BIOS Version Specifies the BIOS version in the Engine. The format of the
basic input/output system (BIOS) version is <V><major
release>.<minor release>. For example: V2.02. This attribute
is present only for NxE engines at Release 9.0 and earlier that
use a Windows Embedded operating system. It is blank or
does not appear for newer engines.
For NAE55/NIE55, if the BIOS version is earlier than V2.02,
update the BIOS using the BIOS Update Utility. This update
significantly improves overall product performance. For
information on the BIOS Update Utility, refer to the BIOS
Update Utility Technical Bulletin (Part No. 24-10110-42).

Configuration Files Identifies the files within the image of the engine that you can
back up.

Database Revision Specifies a logical revision number for the device’s database.
Database Revision is incremented when an object is created or
deleted, an object name changes, or a restore is performed.

Device Addr Binding W Contains a list of BACnet Object Identifiers of an Engine Device
object and a BACnet device address in the form of a BACnet
Address. Entries in the list identify the actual device addresses
that are used when accessing the remote device via a BACnet
service request. The list may be empty if no device identifier-
device address bindings are currently known to the device.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Device Object Identifier Identifies a numeric code assigned to the engine. The

identifier must be unique across the entire Metasys network.
This attribute appears in the Focus and Configuration tabs.

Dial-up Audit Forwarding
Threshold

C,W Specifies the size limit of the audit repository (as a percent
of the audit repository size) at which the network engine
attempts to deliver audit entries to the Metasys Server when
the engine has a dial-up connection. (For engines connected
over a LAN, audit entries are delivered immediately.) This
attribute applies only if a Metasys Server is configured as the
Site Director for the network engine. When this threshold is
reached, all audits in the Local Audit Repository that have not
been forwarded are forwarded to the defined ADS Repository.
The default is 80%, and to ensure good performance, you
should not change to a lesser number.

DST Status Indicates whether daylight saving time is in effect (True) or
not (False) at the device’s location.

Duplicate References Lists references that are duplicated in the system. Entries in
this list are object references that exist on more than one
device within the system.

Enable Application
Generated Audits

C,W Enables audits of system commands.
Note: If Display Object Generated Objects is set to true, these
audits appear in the audit viewer of the Engine or Metasys
Server, increasing the number of audits generated.

Enabled Audit Level C,W Specifies which level of audit entries are added to the Audit
Repository. Only audit entries of type Level 1 through (and
including) the specified level are included. All other levels are
not stored in the audit trail. Level 1 and Level 2 audit entries
are always stored in the audit trail.
• Level 1 and 2 (1): Stores all user action and system error
audit messages.
• Level 3 (2): Stores application audit messages in addition to
Level 1 and 2 auditing.
• Level 4 (3): Stores system audit messages in addition to Level
3 auditing.
• Level 5 (4): Stores diagnostic audit messages in addition to
Level 4 auditing.

Event Action When Full C,W Specifies the operation of the Alarm and Event Management
feature when the event repository is full. If the value is Stop,
additional event entries are discarded. If the value is Rollover,
additional event entries replace the oldest event entries.

Firmware Version Represents the release of firmware installed in the main code
section of the device. The first digit in the revision number
is advanced on major releases. The second digit is advanced
on minor releases. This attribute is in contrast to the Staged
Firmware Version attribute, which indicates the engine's
firmware version that is currently staged in the engine.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
IEIEJ Function A List C,W Provides a list of structures with the following elements:

Network Number, Device ID High Limit, and Device ID Low
Limit. The first set of Who-Is messages is broadcast once the
device reaches the Enable Field Commands phase of startup.
At this time, a timer starts running that calls a method to send
the Who-Is messages at the period specified by IEIEJ Function
A Period.

IEIEJ Function A Period C,W Sets the period at which the IEIEJ Function A List sends
the Who-Is message broadcasts. Clearing the value of this
property disables the function A feature. Each destination
is guaranteed to get a Who-Is message within the period
specified by this property; however, if the list contains multiple
destinations, the object attempts to spread out the Who-Is
messages so that they are not all sent out at the same instant.

Internode Comm Timer C,W Controls the frequency of communication with remote
Ethernet devices. This value is used by the Ethernet IP
Datalink object. Among other communications, this attribute
defines the frequency of the heartbeat to monitored devices
(monitored at a rate of two times the Internode Comm Timer).
Recommended settings: high sensitivity: 20 seconds; medium
sensitivity: 120 seconds; low sensitivity: 240 seconds.

Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

Interval Offset C,W Specifies the offset, in minutes, from the beginning of the
period defined for time synchronization until the actual time
synchronization requests are set. Interval Offset has no effect
when Align Intervals is False.

Is Validated C Enables the MVE feature at the engine, which includes
reauthentication with electronic signature and required
annotation when the user makes a change to the system,
such as commanding an object, acknowledging an alarm, or
changing the value of an attribute. This attribute can be set to
True for MVE sites only. This attribute is writable only with the
SCT, and is read-only online.

JCI Exception Schedule C,W Indicates how long exception schedules are kept after the
exception date has expired. The default value is Auto Delete
31 days, which is the same behavior prior to this release. New
options are Auto Delete 7 days and Manual Delete.
Notes:

• The Engine (using SCT and online UI) and FAC (at CCT)
allows selections for Manual Delete, Auto Delete 31 days,
and Auto Delete 7 days.

• Manual Delete is needed for locations like Japan
where the local standards state that only the BACnet
workstation can delete exception schedules.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Last Restart Reason Indicates the reasons for the last device restart. The possible

reasons are:

• UNKNOWN: The device cannot determine the cause of
the last reset. This may occur due to a startup error,
shutdown error, crash, or pushing the hardware reset
button. The state is UNKNOWN if the device is powered
without the battery or if the Device Manager service is
stopped.

• COLDSTART: A ReinitializeDevice request was received
with a Reinitialized State of Device of COLDSTART or
the device was made to COLDSTART through the user
interface.

• WARMSTART: A ReinitializeDevice request was received
with a Reinitialized State of Device of WARMSTART or the
device was made to WARMSTART by some other means.
WARMSTART also occurs after a download from SCT.

• DETECTED_POWER_LOST: The device detected that
incoming power was lost. This state occurs as the result
of a normal power down (with battery).

• DETECTED_POWERED_OFF: The device detected that its
power switch was turned off.

• HARDWARE_WATCHDOG: The hardware watchdog timer
reset the device.

• SOFTWARE_WATCHDOG: The software watchdog timer
reset the device. This state is reported when Device
Manager cannot communicate with the control engine
for any reason.

• SUSPENDED: The device was suspended. How the device
was suspended or what it means to be suspended is a
local matter.

Last Restore Time The time at which the engine was last restored. Clicking the
down arrow exposes date and time details.

Local Date Indicates the date to the best of the device’s knowledge. The
Date type is a series of four one-number elements.
The first number is the year (for example, 2005); the second
number is the month (1..12, 1=January); the third is the day of
month (1..31). To maintain compatibility with BACnet protocol,
a fourth number contains the day of week (1=Monday). A
value of FF * (asterisk) in any of the elements indicates the
value is not specified.

203SCT: System Configuration Tool Help



Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Local Site Director C,W Specifies a resolvable host name or IP address of the Site

Director. A host name may be specified only if a DNS server
or other means of name resolution is available to the device.
A Site Director may have more than one host name. The host
name specified here must be resolvable to an IP address on
the LAN or WAN on which the site’s devices exist.
The Local Site Director attribute is based on the Computer
Name attribute, not the Name attribute. When you change
the Site Director device’s Computer Name attribute, its Local
Site Director attribute automatically changes to match its
Computer Name. When you change a non-Site Director
device’s Computer Name, its Local Site Director attribute
remains unchanged.

Note: When you promote or demote a Site Director online in
SMP, you may be prompted for the user credentials of the Site
Director you specified. Enter these user credentials for valida-
tion before the promotion or demotion is permitted.

For information designating an Engine as the Site Director,
refer to the NAE Commissioning Guide (LIT-1201519).

Local Time Indicates the time of day to the best of the device’s
knowledge. The Time type is a series of four one-number
elements. The first number is the hour (0..23); the second
number is the minute (0..59); and the third number is
the seconds (0..59). A fourth number has been added to
maintain compatibility with BACnet protocol and contains
the hundredths of second (0..99). A value of * (asterisk) for
any number indicates the value is unspecified. This value
would be used, for example, when the hundredths value is not
important.

Location C,W Indicates the physical location of the device.
Max APDU Length C Indicates the maximum number of bytes that may be

contained in a single, indivisible application layer protocol
data unit.

Max Message Buffer C,W Specifies the largest piece of data that can be sent to a device
at one time, excluding all communications headers. Some
applications need to perform segmentation of data outside
the communications system. This value is used to size the data
in those situations.

Max Segments Accepted Indicates the maximum number of segments of an APDU
accepted by the device.

Model Name Indicates the device model, the hardware revision associated
with the firmware, and the code file name used to download
the device.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Network Address C,W Specifies the BACnet network address. A change to this

attribute takes effect after the next Engine restart (cold or
warm). If you write the value of this attribute, you must reset
the Engine for the new settings to take effect.

Note: If you write the value of this attribute, you must reset the
Engine for the new settings to take effect.

OS Version Indicates the version number of the operating system in use
by the Engine. This attribute is present only for engines that
are running the Linux operating system.

Power Consecutive
Sample

C,W Specifies the number of consecutive AC line status samples
(indicate a power loss) must be received before the device
concludes that a power failure has occurred. When the
device concludes that power has failed, the device begins an
orderly shutdown process. The process used for determining
whether a power failure has occurred protects the device
from shutting down during short power failures or certain
brownout conditions. Using default values, a power failure of
less than 5 seconds does not prompt a device shutdown.

Note: If you change the Power Consecutive Sample value on
a network engine with Metasys Release 9.0.7 firmware, you
must restart the engine before the new setting takes effect. A
restart is not necessary for engines that are running a different
releases.

Power Sampling Interval C,W Specifies the period at which the AC line status is sampled
to determine whether a power failure has occurred. This
attribute is used in conjunction with the Power Consecutive
Samples attribute.

Note: If you change the Power Sampling Interval value on
a network engine with Metasys Release 9.0.7 firmware, you
must restart the engine before the new setting takes effect. A
restart is not necessary for engines that are running a different
release.

Process ID List C,W Contains a list of unsigned 32-bit numbers used to compare
the Process ID sent with the BACnet events. If the event
Process ID is not found on this list, then the event is ignored.
An empty list or a list containing only one entry with the value
of zero allows all events to be processed.

Process Unmapped
Objects Alarms

Specifies whether the engine should process alarms that
originate from unmapped objects. This attribute applies only
to the ODS and is fixed at False for all other devices.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Protocol Obj Support Indicates which standard BACnet object types the device’s

protocol implementation supports.
This attribute is a bit string that uses the Object Type (Set
508). Each bit represents a BACnet object type in that set. For
example, bit 0 represents the BACnet AI object type, whereas
bit 17 represents the BACnet schedule object type. If the bit
is true (1), the object type is supported. If the bit is false (0),
the object type is not supported. The BACnet object types
supported can vary between device models.

Protocol Revision Indicates the minor revision level of the BACnet standard the
device supports.

Protocol Ser Support Indicates which standard BACnet protocol services the
device’s protocol implementation supports. For more
information on the Protocol Implementation Conformance
Statement (PICS) and BACnet Interoperability Building Blocks
(BIBBs) of the Engine. This object now supports both the
BACnet UTCTimeSynchronization message and the BACnet
TimeSynchronization message (non-UTC version). Third-party
devices now have the ability to send the TimeSynchronization
message to an Engine.
This attribute is a bit string that uses the Protocol Ser Support
(Set 136). Each bit represents a BACnet service in that set. For
example, bit 0 represents the Acknowledge Alarm service,
whereas bit 12 represents the Read Property service. If the bit
is true (1), the service is supported. If the bit is false (0), the
service is not supported.

Protocol Version Represents the BACnet protocol the device supports. Initial
releases are Version 1; subsequent releases increase the
number by one.

Restart Notification
Recipients

C,W Controls the restrictions on which devices, if any, are notified
when a restart occurs. The value of this attribute is a list of
BACnetRecipients. When the length of this list is empty, the
device cannot send a device restart notification.
The default value of this property is a single entry
representing a broadcast on the local network. If the list has
one or more entry, the device sends a restart notification, but
only to the devices or addresses listed.

Restore Preparation Time Specifies how long in seconds that the engine remains
unresponsive after starting the BACnet restore procedure and
before timing out and stopping the process. Value is fixed at
60 seconds.

Restore Completion Time Specifies how long in seconds that the engine remains
unresponsive after ending the BACnet restore procedure and
before timing out and stopping the process. Value is fixed at
600 seconds.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Segmentation Indicates if the device supports segmentation of messages

and (if so) if it supports segmented transmission, reception, or
both.

Site Director Online Indicates the communication status of this device with the Site
Director. This value is kept current by a command sent by the
Data Refresh COV Monitor task whenever the status changes.
The COV Monitor task performs this check every 80 seconds.
This attribute is triggered so it can be used for an alarm.

Staged Files List of staged files that are set for activation at a later time.
For example, if the code and archive database are set for later
activation, this field would read Code, Archive Database. If
this attribute is empty, no files are currently staged. Possible
values: Code, Archive Database, Security Database, HTTPS
Certificates.

Staged Firmware Version D Indicates the engine firmware version that is staged for later
activation. If this field is empty, no firmware files are currently
staged. This attribute is in contrast to the Firmware Version
attribute, which indicates the engine's firmware version that is
currently active.

System Status D Reflects the current physical and logical state of the device.
Time of Device Restart Indicates the time at which the device was restarted.

Time Sync Recipients C, W Lists one or more BACnet recipients to which the engine can
issue a Time Synchronization request. If the list is empty,
the engine cannot send a Time Synchronization request
to a BACnet recipient. The attribute requires several other
parameters that define each recipient, such as its device ID, IP
address information, or broadcast type and information.

Time Synchronization
Interval

C,W Specifies the periodic interval, in minutes, at which
TimeSynchronization and UTCTimeSynchronization requests
are sent. When set to zero, then periodic time synchronization
is disabled.

Time Zone C,W The current time zone in use at the location of the Engine.
Unbound References Lists references that are not bound in the system. This

attribute indicates that a process cannot find an object either
because the device on which the object is located is offline, the
object has been deleted, or the object reference is incorrect.

USB Port 1 Enabled C,W Specifies whether USB Port 1 on the SNE or SNC network
engine is enabled. This attribute applies only to the SNE and
SNC models. For enhanced security, the USB port is set to
Disabled by default. Before using the USB port, change this
attribute to Enabled.
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Table 84: Engine Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
USB Port 2 Enabled C,W Specifies whether USB Port 2 on the SNE or SNC network

engine is enabled. This attribute applies only to the SNE and
SNC models. For enhanced security, the USB port is set to
Disabled by default. Before using the USB port, change this
attribute to Enabled.

UTC Offset C Contains the Universal Coordinated Time (UTC). The UTC
Offset attribute indicates the number of minutes (-900 to
+900) offset between local standard time and Universal
Coordinated Time. The time zones to the west of the zero
degree meridian are indicated by positive values, and those
to the east are indicated by negative values. The value of the
UTC Offset attribute is derived from the Default Time Zone
attribute of the site.

UTC Time Synchronization
Recipients

C,W Lists one or more BACnet recipients to which the engine
can issue a UTC Time Synchronization request. If the list is
empty, the engine cannot send a UTC Time Synchronization
request to a BACnet recipient. The attribute requires the
following parameters that define each recipient: ID (Device
ID), Address (IP Address, Network Number, UDP Port), and
Broadcast (Broadcast Type, Network Number, UDP Port).
Three broadcast types are available: local, remote, and global.

Vendor ID Distinguishes proprietary extensions to the protocol using a
unique vendor identification code assigned by ASHRAE. The
Johnson Controls Vendor ID is 5.

Vendor Name Identifies the manufacturer of the device.

Version Indicates the version number of the firmware image in the
Engine.

Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Audit Rate Specifies the number of audit messages destined for the

Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.

Audits Lost Specifies the total number of audits that were not forwarded
to the configured repository and were deleted from the
Engine's local repository. This count does not persist through
an Engine reset. The count reflects the number of lost audits
since the last reset.

Average Intermittent
Failure Period

Specifies the average number of seconds that devices in
the transport layer are offline (for diagnostic purposes).
Only times less than one minute are used in this average, to
eliminate device resets. Ideally, this number should be zero,
indicating there are no failures.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
BACnet Broadcast Receive
Rate

Indicates the number of BACnet broadcast messages received
by the device in the previous minute. BACnet broadcast
messages are generated as part of the normal BACnet
operation, but are also generated when a BACnet device
searches for another device that does not exist, such as when
a device has objects with references to other nonexistent
objects (called unbound references). This number increases
when the number of unbound references increases on
network connected devices. If this number gets too high, it
indicates possible performance problems.

BACnet Routed Messages
Rate

Indicates the number of BACnet messages received by the
device on the IP network in the previous minute. If this
number is high, it indicates that the performance of the MS/TP
field bus network is affected by broadcast transmit traffic. This
attribute appears only in the Snapshot Focus view.

Battery Condition Specifies the current battery condition. It is updated every 60
seconds. For the NAE55/NIE55, a value of Fault implies the
battery is missing or defective and a value of OK implies there
is no known problem with the battery.
For the NCE25/NAE35/NAE45, the values are:

• Good - Battery is operating at normal specifications.
Provided the battery is fully charged, it should supply
backup power to the engine three times a day for 6
minutes each time.

• Service - Battery useful life is predicted to end soon. We
recommend you replace the battery. Backup power lasts
less than 72 hours.

• Replace - Battery useful life is over. Replace the battery.
Backup power may fail if the battery is not charged fully.

• Defective - Battery is either missing, disconnected,
incorrectly installed, or the battery is internally shorted
or otherwise defective. Take corrective action. Backup
power is not provided for any duration.

After a line power failure, the battery is used to supply power
to the device so the device can perform an orderly shutdown
without losing data. After the device shutdown process
finishes, the device discontinues its use of battery power. Valid
data is provided only on the Engine hardware.

Note: The SNC and SNE engines do not have this attribute
because these models use a supercapacitor, not a battery.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Battery Charging Specifies the current battery charging state in an NCE25/

NAE35/NAE45. A value of False indicates the battery contains
at least 80% of full charge capacity and is not currently
recharging. A value of True indicates the battery contains less
than 80% of full charge capacity and is currently charging. If
the Battery Charging value is True and the battery is charging,
the battery stops charging when it is 100% charged.
Trend this attribute value to determine the current battery
charge cycle time. In Simulation, this attribute is False.

Note: The SNC and SNE engines do not have this attribute
because these models use a supercapacitor, not a battery.

Board Temperature Specifies the current printed wire board (PWB) temperature in
degrees Celsius. It is updated every 60 seconds. It is obtained
from a temperature sensor built onto the PWB. The device
is designed to run reliably with a PWB temperature at or
below 67 degrees Celsius. If this temperature is exceeded,
appropriate measures should be taken to cool the device.

Note: The SNC and SNE engines do not have this attribute.
COV Rcv Rate Specifies the number of COV messages the Engine receives

from other supervisory devices or field controllers per minute.
This attribute value updates every minute. Each COV message
represents one object reporting a value change.

COV Tx Rate Specifies the number of COV messages the Engine sends to
other supervisory devices per minute. This attribute updates
every minute. Each COV message represents one object
reporting a value.

CPU Temperature Specifies the current CPU temperature in degrees Celsius for
a network engine. The value, obtained from a temperature
sensor built into the CPU, is updated every 60 seconds. For
NxEs and NCEs, set an alarm for the CPU temperature at 70°C;
for SNCs and SNEs, set an alarm for the CPU temperature at
88°C. If the temperature reaches these limits, take appropriate
measures to cool the device.

CPU Usage Specifies a running average of CPU usage over the last 50
minutes. The value is updated every 30 seconds. The running
average is calculated by adding or subtracting 1% of the
difference between the current and average CPU usage. The
value may not be meaningful until 50 minutes after a system
restart. A value of 0% means the CPU is 100% idle. A value
of 100% means the CPU is 0% idle. A value of 50% or less is
considered OK, although other performance indicators should
also be assessed.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Data Collection Rate Indicates the data value collection rate of the Ready Time

Series Data feature. It represents the rate of data values
collected, not the rate of data values delivered to the clients.
The feature buffers data values when the data collection rate
is within the maximum expected rate (83,333 data values per
minute) and the client is unknown or offline. In the event
of a remote connection failure, a minimum of 60 hours of
data is buffered locally for automatic delivery when the
error condition is resolved. This feature is only used by a Site
Director and is updated every minute.

Note: Starting at Release 10.0, the remote services connec-
tion to a cloud-based platform is no longer available, so this
attribute does not function.

Data Usage Indicates the number of data values currently locally stored by
the Metasys Ready Time Series Data feature as a percentage
of the maximum allowed. Typically, data samples are routinely
delivered to an online client and the data usage remains
small. When the client is unknown or offline, data values
continue to accumulate in local storage until limits are
reached. This feature is used by a Site Director and is updated
every minute.

Note: Starting at Release 10.0, the remote services connec-
tion to a cloud-based platform is no longer available, so this
attribute does not function.

Detection Interval Indicates the time, in seconds, determined by the HTTP
transport mechanism based on the Poll Rate and Network
Tolerance settings. This value determines how fast a site
detects a device going offline.

Duplicate References Lists references that are duplicated in the system. Entries in
this list are object references that exist on more than one
device within the system.

Estimated Flash Available Specifies the estimated flash memory available within the
device for use by the user’s database and applications.
This value can be used to determine whether additional use
of flash can be accommodated; however, other performance
indicators should also be assessed. This property’s value is
calculated at the same time as the Flash Usage attribute.
A negative value suggests that the flash usage should be
reduced. Also, a negative value can affect system reliability
now or in future releases of software.

Event Rate Specifies the number of event messages destined for the
Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Events Lost Specifies the total number of events which failed to be

forwarded to the configured repository and which were
deleted from the Engine's local repository. This count does
not persist through an Engine reset, and reflects the number
of lost events since the last reset.

Flash Usage Specifies the estimated percent of flash memory currently
in use. The percentage is based on the portion of flash that
is designated for use by the user’s database. The value is
updated on device startup, after a database archive, sync
or download from the SCT (offline mode), and by manual
command (Update Flash Usage). A value greater than 100%
can affect system reliability now or in future software releases.
No restrictions are in place to prohibit use of flash over 100%.
If you are simulating an NAE/NIE, your computer’s hard disk
must be formatted for NTFS. If your computer’s hard disk
is formatted to use FAT32 (32-bit File Allocation Table), the
simulated value for the Flash Usage attribute is not accurate.

Maximum Intermittent
Failure Period

Specifies the maximum number of seconds a device was
offline at the transport layer (for diagnostic purposes).
Only times under one minute are recorded, to eliminate
device resets. The value of this attribute does not match the
offline times determined from generated alarms. Ideally, this
number should be zero, indicating there are no failures.

Memory Usage Specifies the percent of system RAM that is currently in use.
It is calculated as follows:
Total commit charge x 100
Display Precision = 0.01
COV Increment = 0.1

Network Tolerance C,W Sets the timeout tolerance of the flexible polling feature (that
is, changes the lower level communication timeouts). When
edited by a user, this attribute is sent to the HTTP transport
layer and determines how long the device waits to connect,
send, and wait to receive HTTP Post responses. The setting
options are LOW, MEDIUM, and HIGH. LOW is the default and
matches the current behavior. The MEDIUM or HIGH setting
increases the tolerance by adding longer timeouts and more
retries and should be used for poor network connections.
Note that it takes longer to detect an offline device as the
tolerance gets higher.

Object Count Indicates the number (count) of all of the object instances
within the device. Objects of all classes are included.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Object Memory Usage Specifies the percent of the object database that is currently

in use. Each object created consumes memory within the
object database. This attribute can be used to help determine
the device’s capacity for additional objects; however, other
performance indicators should also be assessed. Generally,
the number of objects you define determines the object
memory usage. This attribute is valid on the Engine hardware.

Note: If you have a large number of objects, the object memory
usage increases and the archive.moi file size increases also. The
archive.moi file is stored in flash memory.

Also, an attempt to create an object known to require X bytes
of object database may fail even if more than X bytes are
available in the object database. This is because the object
database is composed of multiple blocks. If the free space
of each block is fewer than X bytes, the request for X bytes
fails even though the sum total of free space from all blocks is
greater than X bytes.

Pager Dial-up Status Specifies the current status of the pager dial-up connection.
Available only in network engines at Release 9.0 and earlier
that use a Windows Embedded operating system.

Registration Usage Indicates the number of registrations used by the Metasys
Ready Time Series Data feature. It is the total usage of all
clients of this feature. Each registration is a sign-up for an
attribute of an object. The feature supports up to 1,000
registrations per fully loaded field bus per site device. This
feature is only used by a Site Director and is updated every
minute.

Note: Starting at Release 10.0, the remote services connec-
tion to a cloud-based platform is no longer available, so this
attribute does not function.

Repository Status Indicates the status of the communication between the device
and the trend log sample repository (for diagnostic purposes).
This attribute uses the Repository Status set.
Uses Repository Status set:
0 = Offline
1 = OK
2 = Undefined
3 = Dialup
4 = RAP
5 = Incompatible Release

Samples Lost Specifies the number of trend samples lost because the
Metasys server did not retrieve them fast enough (for
diagnostic purposes). This value resets only when the device
restarts.
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Table 85: Engine Device Object Attributes - Diagnostic Tab
Attribute Name Flags Description
Sample Rate Specifies the number of trend samples destined for the

Metasys server in the last hour (for diagnostic purposes). The
value of this attribute updates every 5 minutes.

Note: The sample rate at the Engine is calculated based on the
actual raw samples taken by every trend object. The sample
rate at the Metasys Server is calculated once every poll cycle
and is based on the number of samples received from all the
Engines and the time it took to poll them. Most Engines do not
forward all the samples taken between polls because the Meta-
sys Server transfer setpoint is usually not set to 1 (that is, for-
ward on every sample). The result is that the sample rate at the
Metasys Server is less than the sum of the samples taken at all
the Engines. The total Metasys Server sample rate is 60,000 and
the total Engine sample rate is larger than 100,000.

Time Between Buffer
Reads

Indicates the time, in minutes, between Engine trend
consolidation buffer readings from the Metasys server (for
diagnostic purposes).

Transfer Buffer Full Indicates the percentage full of the Engine trend consolidation
buffer (for diagnostic purposes).

Transport Failure Rate Specifies the number of transport failures per day (for
diagnostic purposes). This number represents how often HTTP
posts from this engine failed when they were sent to another
device that is considered online. Failures include the inability
to open the connection, to send the message, or to receive
the reply. This value represents failures over the last 24 hours
and is updated hourly, but does not correlate directly to the
number of offline alarms generated by your system. Ideally,
this number should be zero, indicating there are no failures.

Unbound References Lists references that are not bound in the system. This
attribute indicates that a process cannot find an object either
because the device on which the object is located is offline, the
object has been deleted, or the object reference is incorrect.

Table 86: Engine Device Object Attributes - Communications Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Note: The Communications tab is only present for older network engines that have gray exteriors. The
tab has three different configurations: Serial Port Cable Config, Internal Modem Config, and External
Modem Config. Each configuration has the same set of attributes, which are described in this table.

Allow Incoming
Connections

C,W True Whether the communications port is enabled to
accept an incoming call from another device.

Baud Rate C,W 115200 The configured baud rate set for the communications
port.

Enabled C,W True Whether the communications port is enabled to
initiate a call to another device.

Extra Initialization
Commands

C,W An optional list of modem initialization commands,
such as characters and symbols, necessary to
establish a reliable connection.
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Table 86: Engine Device Object Attributes - Communications Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Maximum Baud Rate C,W 115200 The maximum configured baud rate set for the
communications port.

Wait for Dial Tone
Before Dialing

C,W False Whether the network engine should wait for the dial
tone before attempting to place a call.

Table 87: Engine Device Object Attributes - Network Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Allow Http C,W True Available at network engines at Release 8.1 or later. It
determines whether the operating system firewall in
the network engine blocks incoming traffic over the
HTTP port (port 80). If the attribute is set to True, all
incoming traffic over port 80 at the network engine is
allowed; if set to False, all incoming traffic over port
80 at the network engine is blocked. Changing this
attribute does not interfere with NAE Update Tool
operations.
You can set this attribute independently on each
network engine, and can modify it using a schedule
or other control action. You can configure a tailored
summary to view the value of the attribute on all
network engines at the site. You can also use the mass
editing capability in SCT to modify the attribute across
multiple devices.
To provide the highest level of security, it is
recommended that you set this attribute to False.
However, if the network engine is a Site Director and
has one or more child engines reporting to it that
have not been upgraded to Release 8.1 or later, set
the attribute to True. For a list of the tools and utilities
that require port 80, refer to the Allow Http section of
the NAE Commissioning Guide (LIT-1201519).

BACnet Integrated
Objects

C Include in
Object List

Specifies whether BACnet integrated objects are
included in the object list. The two selectable options
are Include in Object List and Exclude from Object List.
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Table 87: Engine Device Object Attributes - Network Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Completion Domains C,W Specifies a domain name that is appended to the
computer name of a network engine to help the
engine broadcast over the building network. For
example, if you specify a completion name of
mycorp.com and the name of the network engine
is NAE-1, the engine is identified on the network as
NAE-1.mycorp.com. Use this attribute for network
engines that have difficulty communicating with their
site director.
If DHCP is enabled on the engine, the DHCP
server populates the list of completion domains
automatically. In this case, if you manually delete a
domain from the list, it is readded when you save the
change.

Note:  Depending on the model of the network engine,
the full list of configured completion domains may not
appear under the drop-down box in View mode. In this
case, switch to Edit mode to view the full list of comple-
tion domains.

Computer Name C,W Identifies the network engine to the Metasys network.
Changing the Computer Name online breaks any
existing references between the NAE object and
other objects on the site, and may break the existing
network connection to other devices on the network.
We do not recommend changing the Computer
Name online. Instead, change the Computer Name
attribute offline with the SCT by right-clicking the NAE
in the navigation tree and selecting Rename. Both the
Computer Name and Name attributes are changed
to the new name you select. The Item Reference then
updates to show the new Computer Name.
Notes:

• If you change the value of this attribute, a
confirmation message appears informing you
that the Engine must be reset before the new
name can be applied.

• The Computer Name must not consist of all
numbers. For example, a computer name of
N1234 is acceptable but 1234 is not.

DHCP Enabled C,W True True = DHCP enabled; network engine requests IP
address from DCHP server; if no server is present,
APIPA addressing is used.
False = DHCP disabled; network engine uses a static IP
address.

DNS Server IP
Addresses

C,W List of IP addresses.
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Table 87: Engine Device Object Attributes - Network Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Domain Name C,W Note: If you change the value of this attribute, the
Engine automatically resets.

Ethernet 1 Speed The current connection speed of the network
engine on the first Ethernet port. Only SNC and SNE
engines have this attribute. The attribute shows Not
Connected if no connection is present.

Ethernet 2 Speed The current connection speed of the network engine
on the second Ethernet port. Only the SNC has two
Ethernet ports and therefore has this attribute. The
attribute shows Not Connected if no connection is
present.

Ethernet MAC Address The MAC address of the network engine.

JCI IP Address C,W The currently assigned IP address of the network
engine.

IP Mask C,W The currently assigned IP mask of the network engine.

IP Router Address C,W The currently assigned IP router that the network
engine is using.

Obtain DNS Address
Automatically

C,W True (1) Whether the DNS IP address is populated
automatically.

Routing Mode C,W Disabled The current state of the BACnet routing mode.
Options are Disabled, Enabled, Enabled Without
Broadcast.

Table 88: Engine Device Object Attributes - Hardware Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Note: The Hardware tab is present only for SNC network engines.
Application Class Set
Version

64 Indicates the version of the application class set for
the SNC.

Control Sequence In
Test

C,W 0 Indicates the number assigned to the control
sequence in testing mode.

Controller Number 999 Indicates the unique address of the field controller as
set by the rotary switch block on the engine.

Device Model Class
Set Version

65 Indicates the version of the device model class set for
the SNC.

Pcode Indicates the product code number of the SNC (for
example, M4-SNC25150-0).
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Table 88: Engine Device Object Attributes - Hardware Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Startup OFF State
Auto Release Time

C,W 0 Indicates the amount of time a BO is held in the
OFF state at the priority set by the Startup OFF State
Command Priority setting at field controller startup.
This instance only applies to BO objects that have
their Startup OFF State Enable parameter set to TRUE.
The default value is 0. A value of 0 disables this
parameter. The range is 0 to 3600 seconds.

Startup OFF State
Command Priority

C,W 9 Indicates the priority at which a BO is held in the OFF
state for the Startup OFF State Auto Release Time at
field controller startup. This instance only applies to
BO objects that have their Startup OFF State Enable
parameter set to TRUE.
The default value is 9. Priority 6 is not a valid selection.
The range is 1 to 16.

Metasys Server
Menu Selection: Insert > Metasys Server
Inserts a Metasys server (ADS/ADX, ADS-L-A, ADS-L-E, OAS, or ODS) into the archive database in the
SCT, beginning with Release 5.2 and later.
All Metasys servers on a computer platform and is installed within the Metasys network. You can
use a Metasys server as a location to send trend logs (Trend Studies), event logs (Alarm and Event
Management), and audit trails (Audit Trail). You can also configure the Metasys server to take the
role of the Site Director to coordinate system access and present data to the user in a web browser
running on the same computer or connected over the LAN, WAN, or Internet.

Note:
• The first Metasys server you add to the site becomes the Site Director. The Site Director

coordinates all Web browser communication to the Metasys network. You can only have
one Site Director per site. Any subsequent Metasys servers are primarily used for archiving
historical data.

• Do not add an ODS or OAS as a child device under an ADS, ADX, or network engine.
• Do not install the SCT on an OAS.
• Some products or models mentioned in this document are available only to specific

markets. Refer to the Application and Data Server (ADS) Lite for Europe (E) Product Bulletin
(LIT-12011690) and the Application and Data Server (ADS) Lite for Asia (A) System Product
Bulletin (LIT-12011694) for availability.

Tip: On the Configure screen, select each tab for further configuration options.

For information about server object attributes, see Server Attributes.

Trend Repository Database
The trend repository database resides within the server that stores the trend data. For more
information, click one of the following:

• Trend Studies
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• Trend Extensions

Event Repository Database
The event repository database resides within the server that stores the event data. For more
information, refer to the Alarm and Event Management section of the Metasys SMP Help (LIT-1201793).

Audit Repository Database
The audit repository database resides within the server that stores the audit data. For more
information, refer to the Audit Trail section of the Metasys SMP Help (LIT-1201793).

OAS and ODS Commands
The table below lists the commands supported by the OAS and ODS.
Table 89: OAS and ODS Device Object Commands
Command Name Description
Archive Archives the object instances to the nonvolatile memory.
Change Audit Enabled Class Level Changes the Audit Enabled Class Level attribute.

Integer (1 to 4)
Route Samples Routes all Trend samples to the Metasys Server. Use this

command before performing an engine upgrade to minimize
the risk of losing any trend samples.

Rediscovery Text Strings Resets the States Text across a supervisory device by
rediscovering text strings from all mapped BACnet objects.

Note: When the Rediscover Text Strings command is sent from
the Site Director device UI to another supervisory device and
the UI is running on the supervisory device, you must close and
restart the UI on the supervisory device in order for the text to
appear correctly.

Renaming a Metasys server
For information about ADS/ADX computer name guidelines and changing the computer name,
refer to the Appendix: Changing the ADS or ADX Name and the Computer Name in the ADS/ADX
Commissioning Guide (LIT-1201645).
For information about ODS computer name guidelines and changing the computer name, refer
to the Appendix: Changing the ODS Name and the Computer Name in the ODS Commissioning Guide
(LIT-12011944).

Server Attributes
Server objects contains attributes common to many Metasys system objects. These common
attributes are described in the Common Object Attributes section. This section includes attributes
of the Focus/Configuration tab and the Diagnostics tab that are specific to ADS/ADX, OAS, and
ODS server objects. See the Object and Feature Tabs section for information on the attributes that
appear on the other tabs of this object.

Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, Q - BACnet Required, W - Writable.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

ADS Repositories C,W ADS, ADX,
OAS, ODS

For an ADS, ADX, or OAS, this attribute
lists the ADS/ADX device host names or IP
addresses to which incoming trend and
Alarm/Event data forwards. An ADS, ADX,
or OAS cannot have its own host name or
IP address in this field. Refer to the ADS/
ADX Commissioning Guide (LIT-1201645) for
details on configuring repositories.
For an ODS, this attribute specifies a list of
ADS (ODS) Repository devices. The ODS is
the device to which local audit, alarm, and
trend data is delivered. Repository refers
to the three files in the ODS that store this
data. If a value is specified, it overrides
the value of the Default ADS Repository
attribute of the site. If no value is specified,
the value of the Default ADS Repository
attribute is used (Default ADS Repository is
a site level setting sent to the site’s devices).
For an ODS, the Default ADS Repository of
the Site is intentionally left blank and must
be updated by the user (online or offline). If
the user does not populate the Default ADS
value and leaves the Default ADS Repository
value for all devices at 0.0.0.0, the ODS does
not receive any audit, alarm, or trend data.
The SCT does not automatically populate
the Default ADS Repository value because
of the many different possibilities that could
exist during archive creation, including
multiple ODSs on a site or no ODS for a site.
In these cases, it is not immediately clear
which ODS should be the Default ADS under
the Site object.

ADS Repositories
Status

C,W ADS, ADX,
OAS, ODS

Indicates the status of the devices listed in
the ADS Repositories attribute.
Range: Offline, OK

Note: For an ADS/ADX server, if data is for-
warded to a secondary ADS/ADX (that is,
data forwarded to an ADS/ADX is forwarded
to another ADS/ADX), the status does not
calculate. This attribute shows only the sta-
tus for the initial forward.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Alarm Snooze
Time

C,W 5 ADS, ADX,
OAS, ODS

Specifies the amount of time to delay after
an operator temporarily ignores, or snoozes
an alarm before re-announcing the alarm.
Range: 0 to 75
Units: Minutes

Align Intervals OAS, ODS Specifies whether clock-aligned periodic
time synchronization is enabled. If periodic
time synchronization is enabled and the
time synchronization interval is a factor
of an hour or a day (that is, the value
divides without remainder), then the
beginning of the period specified for time
synchronization aligns to the hour or day,
respectively.

APDU Retries C,W Initial: 4 OAS, ODS Indicates the maximum number of times
that an APDU (as specified by the BACnet
device) is retransmitted. If the device does
not perform retries, it is set to zero. If the
value is greater than zero, a nonzero value
appears in the APDU Timeout attribute.
Range: 2 to 10

Note: If you write the value of this
attribute, you must reset the server for the
new settings to take effect.

APDU Segment
Timeout

C,W 10,000 OAS, ODS Indicates the amount of time in milliseconds
between retransmission of an APDU
segment.
Range: 1,000 to 65,535
Units: milliseconds

Note: If you write the value of this
attribute, you must reset the server for the
new settings to take effect.

APDU Timeout C,W 10,000 OAS, ODS Indicates the amount of time in milliseconds
between retransmissions of an APDU
requiring acknowledgment for which no
acknowledgment has been received.
Range: 1,000 to 65,535
Units: milliseconds

Note: If you write the value of this
attribute, you must reset the server for the
new settings to take effect.

Appl SW Version OAS, ODS Identifies the version of the application
software installed in the device. The content
of this string is locally defined (date-and-
time stamp, a programmer’s name, a host
file version number, and so on).
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

BACnet
Communications
Password

C,W Initial:
jci_bacnet
_comm

OAS, ODS Provides password protection
of BACnet services, such as
DeviceCommunicationControl and
ReinitializeDevice. Third-party workstations
may send these services and must provide
the password for the Engine to execute
the services. The default password is
jci_bacnet_comm. Third-party workstations
cannot read or write this password.

BACnet
Integrated
Object

OAS, ODS Specifies whether integrated objects are
displayed in the object list. The values are:

• Include in Object List - Makes
internal integration objects visible to
BACnet devices. This is the default
value.

• Exclude from Object List - Makes
internal integration objects unavailable
to BACnet devices.

When this attribute is set to Include in
Object List and Routing Mode is set to
Enabled, the same third-party object
appears in the list twice (as a native
object on the actual device and as an
integrated object within the Engine);
therefore, this setup is not recommended.
When Routing Mode is set to Enabled
Without Broadcasts, it prevents third-
party devices outside the network from
discovering devices on a routed network
using broadcast data.

BACnet IP Port C,W 47,808 OAS, ODS Specifies the UDP port number used to
communicate with other BACnet devices
over the IP network. This value allows
multiple BACnet networks on a single IP
network and prevents communication
between the multiple BACnet networks.
Range: 0 to 65,535

Note: If you write the value of this
attribute, you must reset the server for the
new settings to take effect.

Database
Revision

OAS, ODS Specifies a logical revision number for the
device’s database. Database Revision is
incremented when an object is created
or deleted, an object name changes, or a
restore is performed.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Device Addr
Binding

W OAS, ODS Contains a list of BACnet Object Identifiers
of an Engine Device object and a BACnet
device address in the form of a BACnet
Address. Entries in the list identify the
actual device addresses that are used when
accessing the remote device through a
BACnet service request. The list may be
empty if no device identifier-device address
bindings are currently known to the device.

DHCP Enabled ADS, ADX,
OAS, ODS

Indicates whether the DHCP protocol should
be used.
Range: true, false
The device may run in three modes:

• DHCP is enabled and a DHCP server
exists on the network. The DHCP
server assigns network configuration
information. The UI ignores the
following attributes and should not
attempt to write to them. The values
from the DHCP are assumed to be
more current than the tool interface:

- JCI IP Address
- IP Mask, ODS only
- IP Router Address, ODS only
- DNS Server IP Addresses, ODS

only, when the Obtain DNS
Address Automatically attribute is
True

• DHCP is enabled and no DHCP server
exists on the network. Using the
Automatic Client Configuration feature,
the device automatically defines the
network configuration.

• DHCP is disabled. You must manually
assign the JCI IP Address attribute. On
an ODS you must also manually assign
the IP Mask attribute.

Note: This attribute only appears in the
ADS object in the SCT and is used by the
SCT during a download or upload of the
ADS database.

DST Status OAS, ODS Indicates whether daylight saving time is in
effect (True) or not (False) at the device’s
location.

223SCT: System Configuration Tool Help



Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Duplicate
References

OAS, ODS Lists references that are duplicated in
the system. Entries in this list are object
references that exist on more than one
device within the system.

Enabled Audit
Level

C,W Audit Level
2 (1)

ADS, ADX,
OAS, ODS

Specifies which level of audit entries
are added to the Audit Repository. Only
audit entries of type Level 1 through (and
including) the specified level are included.
All other levels are not stored in the audit
trail. Level 1 and Level 2 audit entries are
always stored in the audit trail.
Range: 1 to 4 with 5 Audit Levels

• Level 1 and 2 (1): Stores all user action
and system error audit messages.

• Level 3 (2): Stores application audit
messages in addition to Level 1 and 2
auditing.

• Level 4 (3): Stores system audit
messages in addition to Level 3
auditing.

• Level 5 (4): Stores diagnostic audit
messages in addition to Level 4
auditing.

Ethernet MAC
Address

OAS, ODS Displays the Ethernet Media Access Control
(MAC) address of this device.

Firmware
Version

OAS, ODS Represents the release of firmware installed
in the main code section of the device.
The first digit in the revision number is
advanced on major releases. The second
digit is advanced on minor releases.

Host Name ADS, ADX,
OAS, ODS

Indicates the name of the supervisory
engine with the trend consolidation buffer
that was the most full during the last buffer
transfer scan (for diagnostic purposes).
This percent to which this buffer is filled is
indicated by the Transfer Buffer Full Worst
NxE value.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

IEIEJ Function A
List

C,W OAS, ODS Provides a list of structures with the
following elements: Network Number,
Device ID High Limit, and Device ID Low
Limit. The first set of Who-Is messages
is broadcast once the device reaches the
Enable Field Commands phase of startup. At
this time, a timer starts running that calls a
method to send the Who-Is messages at the
period specified by IEIEJ Function A Period.

IEIEJ Function A
Period

C,W 60 OAS, ODS Sets the period when the IEIEJ Function A
List sends the Who-Is message broadcasts.
Clearing the value of this property disables
the function A feature. Each destination
is guaranteed to get a Who-Is message
within the period specified by this property;
however, if the list contains multiple
destinations, the object attempts to spread
out the Who-Is messages so that they are
not all sent out at the same instant.
Range: 60 to 86,400
Units: seconds

Intermode
Comm Timer

C,W 120 OAS, ODS Controls the frequency of communication
with remote Ethernet devices. This value
is used by the Ethernet IP Datalink object.
Among other communications, this
attribute defines the frequency of the
heartbeat to monitored devices (monitored
at a rate of two time period the Internode
Comm Timer). A change to this attribute
does not take effect until the next server
restart (cold or warm).
Range: 5 to 255

Interval Offset C,W 0 OAS, ODS Specifies the offset, in minutes, from
the beginning of the period defined for
time synchronization until the actual time
synchronization requests are set. Interval
Offset has no effect when Align Intervals is
False.
Range: 0 to 144
Units: minutes
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Is Validated C ADS, ADX This attribute is only available on validated
sites.
Enables the MVE feature at the device,
which includes re-authentication with
electronic signature and required
annotation when the user makes a change
to the system, such as commanding
an object, acknowledging an alarm, or
changing the value of an attribute. This
attribute can be set to True for MVE sites
only. This attribute is writable only with the
SCT, and is read-only online.
Range: true, false

JCI IP Address ADS, ADX,
OAS, ODS

Represents the IP address of this Server.
The JCI IP address identifies the server on
the network and assists in the routing of
messages. Each server must have a unique
JCI IP address for the network to operate
properly. A write to this attribute is ignored
because configuration is completed through
the Windows network configuration. A read
of this attribute returns either the user
specified value or the value determined
from DHCP.
Certain IP addresses are invalid and cannot
be written successfully. The network
address portion of the JCI IP address is
computed by including all bits in which the
corresponding bit from the IP mask is 1.
The device address portion of the JCI IP
address is computed by including all bits
in which the corresponding bit from the
IP mask is 0. Neither the network address
nor device address can be all zero bits or
all one bits. For example, if the IP mask is
255.255.0.0, the following IP addresses are
invalid: 0.0.100.100 and 100.100.0.0.
The JCI IP Address attribute can be set
explicitly, or it may be automatically set
using the DHCP server. Using a DHCP server
may change this attribute even if you have
set it up explicitly. See the DHCP Enabled
attribute.

Note: For the ADS, this attribute only
appears in the ADS object in the SCT and
is used by the SCT during a download or
upload of the ADS/ADX database.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Last Restart
Reason

OAS, ODS Indicates the reasons for the last device
restart.
The possible reasons are:

• UNKNOWN: The device cannot
determine the cause of the last reset.
This may occur due to a startup error,
shutdown error, crash, or pushing the
hardware reset button. The state is
UNKNOWN if the device is powered
without the battery or if the Device
Manager service is stopped.

• COLDSTART: A ReinitializeDevice
request was received with a
Reinitialized State of Device of
COLDSTART or the device was made to
COLDSTART through the user interface.

• WARMSTART: A ReinitializeDevice
request was received with a
Reinitialized State of Device of
WARMSTART or the device was made
to WARMSTART by some other means.
WARMSTART also occurs after a
download from SCT.

• DETECTED_POWER_LOST: The device
detected that incoming power was
lost. This state occurs as the result of a
normal power down (with battery).

• DETECTED_POWERED_OFF: The device
detected that its power switch was
turned off.

• HARDWARE_WATCHDOG: The
hardware watchdog timer reset the
device.

• SOFTWARE_WATCHDOG: The software
watchdog timer reset the device. This
state is reported when Device Manager
cannot communicate with the control
engine for any reason.

• SUSPENDED: The device was
suspended. How the device was
suspended or what it means to be
suspended is a local matter.

Local Date ADS, ADX,
OAS, ODS

Displays the date on the server.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Local Time ADS, ADX,
OAS, ODS

Displays the time on the server.

Location C,W (empty
string)

OAS, ODS Indicates the physical location of the device.

Max APDU
Length

C,W 1,024 OAS, ODS Indicates the maximum number of bytes
that may be contained in a single, indivisible
application layer protocol data unit.
Range: 128 to 65,535
Units: bytes

Note: If you write the value of this
attribute, you must reset the server for the
new settings to take effect.

Max Message
Buffer

C,W 994 OAS, ODS Specifies the largest piece of data that can
be sent to a device at one time, excluding
all communications headers. Some
applications need to perform segmentation
of data outside the communications system.
This value is used to size the data in those
situations.
range: 98 to 65,535
Units: bytes

Max Segments
Accepted

123 OAS, ODS Indicates the maximum number of
segments of an APDU accepted by the
device.

Model Name ADS, ADX,
OAS, ODS

Indicates the name of the device model.

Network Address C,W 1,001 OAS, ODS Specifies the BACnet network address. A
change to this attribute takes effect after
the next server restart (cold or warm).

Number of NxEs
Reporting

ADS, ADX,
OAS, ODS

For an ADS/ADX, displays the number of
NxE devices that registered this ADS/ADX as
their trend repository.
For an ODS, displays the number of NxEs
reporting to your server.

Process ID List C,W empty list OAS, ODS Contains a list of unsigned 32-bit numbers
used to compare the Process ID sent with
the BACnet events. If the event Process ID
is not found on this list, then the event is
ignored. An empty list or a list containing
only one entry with the value of zero allows
all events to be processed.
Maximum 64 elements, values limited by
range of unsigned 32
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Process
Unmapped
Object Alarms

ODS If set to true, when an ODS receives an
alarm from a device that is not mapped,
the ODS maps the device and processes the
alarms for that device. If set to false, an ODS
ignores alarms from devices that are not
mapped.

Protocol Obj
Support

OAS, ODS Indicates which standard BACnet object
types the device’s protocol implementation
supports. This attribute is a bit string that
uses the Object Type (Set 508). Each bit
represents a BACnet object type in that set.
For example, bit 0 represents the BACnet
AI object type, whereas bit 17 represents
the BACnet schedule object type. If the bit
is true (1), the object type is supported.
If the bit is false (0), the object type is
not supported. The BACnet object types
supported can vary between device models.

Protocol Revision OAS, ODS Indicates the minor revision level of the
BACnet standard the device supports.

Protocol Ser
Support

OAS, ODS Indicates which standard BACnet
protocol services the device’s protocol
implementation supports. For more
information on the PICS and BIBBs of the
Engine, see the table in the section. This
object now supports both the BACnet
UTCTimeSynchronization message and the
BACnet TimeSynchronization message (non-
UTC version).
Third-party devices now have the ability to
send the TimeSynchronization message to
an Engine. This attribute is a bit string that
uses the Protocol Ser Support (Set 136).
Each bit represents a BACnet service in
that set. For example, bit 0 represents the
Acknowledge Alarm service, whereas bit 12
represents the Read Property service. If the
bit is true (1), the service is supported. If the
bit is false (0), the service is not supported.

Protocol Version OAS, ODS Represents the BACnet protocol the device
supports. Initial releases are Version 1;
subsequent releases increase the number
by one.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Restart
Notification
Receipts

C,W OAS, ODS Controls the restrictions on which devices,
if any, are notified when a restart occurs.
The value of this attribute is a list of
BACnetRecipients. When the length of
this list is empty, the device cannot send
a device restart notification. The default
value of this property is a single entry
representing a broadcast on the local
network. If the list has one or more entry,
the device sends a restart notification, but
only to the devices or addresses listed.

Sample Rate ADS, ADX,
OAS, ODS

Specifies the number of trend samples
destined for the Metasys server in the last
hour (for diagnostic purposes). The value of
this attribute updates every 5 minutes.

Note: The sample rate at the NxE is cal-
culated based on the actual raw samples
taken by every trend object. The sample
rate at the server is calculated once every
poll cycle and is based on the number of
samples received from all the NxEs and
the time it took to poll them. Most NxEs do
not forward all the samples taken between
polls because the server transfer setpoint
is usually not set to 1 (that is, forward on
every sample). The result is that the sam-
ple rate at the server is less than the sum of
the samples taken at all the NxEs. The total
server sample rate is 60,000 and the total
NxE sample rate is larger than 100,000.

Segmentation OAS, ODS Indicates if the device supports
segmentation of messages and (if so)
if it supports segmented transmission,
reception, or both.

Service Time ADS, ADX,
OAS, ODS

Displays the amount of time in seconds that
it takes for the server to poll all NxEs on the
site for trend samples.
Units: seconds

System Status D OAS, ODS Reflects the current physical and logical
state of the device.
Operational, Operational Read Only,
Download Required, Download in Progress,
Nonoperational, Backup in Progress

Time of Device
Reset

OAS, ODS Indicates the time at which the device was
restarted.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

Time Sync
Receipts

W OAS, ODS Defines how automatic BACnet time
synchronization updates are transmitted.
If the list is of length zero, a device is
prohibited from automatically sending a
Time Synchronization request. If the list is of
length one or more, a device automatically
sends a Time Synchronization request but
only to the devices or addresses listed. If it
is present, this attribute is writable.
Range: 0 to 1,440
Units: minutes

Time
Synchronization
Interval

C,W 0 OAS, ODS Specifies the periodic interval, in minutes,
at which TimeSynchronization and
UTCTimeSynchronization requests are
sent. When set to zero, then periodic time
synchronization is disabled.

Transfer Buffer
Full Worst NxE

ADS, ADX,
OAS, ODS

Indicates the percentage full of the Engine
trend consolidation buffer (for diagnostic
purposes).

Transport Failure
Rate

ODS Specifies the number of transport failures
per day (for diagnostic purposes). This
number represents how often HTTP posts
from this server failed when they were
sent to another device that is considered
online. Failures include the inability to open
the connection, to send the message, or
to receive the reply. This value represents
failures over the last 24 hours and is
updated hourly, but does not correlate
directly to the number of offline alarms
generated by your system. Ideally, this
number should be zero, indicating there are
no failures.

Unbound
References

OAS, ODS Lists references that are not bound in
the system. This attribute indicates that
a process cannot find an object either
because the device on which the object
is located is offline, the object has been
deleted, or the object reference is incorrect.
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Table 90: Server Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Server Description

UTC Offset C OAS, ODS Contains the Universal Coordinated Time
(UTC). The UTC Offset attribute indicates
the number of minutes (-900 to +900)
offset between local standard time and
Universal Coordinated Time. The time zones
to the west of the zero degree meridian are
indicated by positive values, and those to
the east are indicated by negative values.
The value of the UTC Offset attribute
is derived from the Default Time Zone
attribute of the site.

Vendor ID 5 OAS, ODS Distinguishes proprietary extensions
to the protocol using a unique vendor
identification code assigned by ASHRAE.
The Johnson Controls Vendor ID is 5.

Vendor Name JCI OAS, ODS Identifies the manufacturer of the device.

Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Audit Rate OAS, ODS

Average
Intermittent
Failure Period

ADS, ADX,
OAS, ODS

Specifies the average number of seconds
devices in the transport layer are offline (for
diagnostic purposes). Only time period less
than one minute are used in this average to
eliminate device resets. Ideally, this number
should be zero, indicating there are no
failures.
Units: seconds

BACnet
Broadcast
Receive Rate

OAS, ODS Indicates the number of BACnet broadcast
messages received by the device in the
previous minute. BACnet broadcast
messages are generated as part of the
normal BACnet operation, but are also
generated when a BACnet device searches
for another device that does not exist,
such as when a device has objects with
references to other nonexistent objects
(called unbound references). This number
increases when the number of unbound
references increases on network connected
devices. If this number gets too high, it
indicates possible performance problems.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

BACnet Routed
Messages Rate

ODS Indicates the number of BACnet messages
received by the device on the IP network
in the previous minute. If this number is
high, it indicates that the performance of
the MS/TP field bus network is affected by
broadcast transmit traffic.

COV Rcv Rate OAS, ODS Specifies the number of COV messages the
OAS or ODS receives from other supervisory
devices or field controllers per minute.
This attribute value updates every minute.
Each COV message represents one object
reporting a value change.

COV Tx Rate OAS, ODS Specifies the number of COV messages
the OAS or ODS sends to other supervisory
devices per minute. This attribute
updates every minute. Each COV message
represents one object reporting a value.

CPU Usage OAS, ODS Specifies a running average of CPU
usage over the last 50 minutes. The
value is updated every 30 seconds. The
running average is calculated by adding or
subtracting 1% of the difference between
the current and average CPU usage. The
value may not be meaningful until 50
minutes after a system restart. A value of
0% means the CPU is 100% idle. A value
of 100% means the CPU is 0% idle. A value
of 50% or less is considered OK, although
other performance indicators should also
be assessed.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Data Collection
Rate

ADS, ADX,
OAS, ODS

For the ADS, ADX, and OAS, this attribute
indicates the data value collection rate
of the Ready Time Series Data feature. It
represents the rate of data values collected,
not the rate of data values delivered to the
clients. The feature buffers data values
when the data collection rate is within the
maximum expected rate (83,333 data values
per minute) and the client is unknown or
offline. In the event of a remote connection
failure, a minimum of 60 hours of data
is buffered locally for automatic delivery
when the error condition is resolved. This
feature is only used by a Site Director and is
updated every 1 minute.
For the ODS, this attribute indicates the
data value collection rate of the cloud-
based platform Time Series Data feature.
Starting at Release 10.0, the remote services
connection to a cloud-based platform is no
longer available, so this attribute does not
function for the ODS.
Units: per minute
Maximum value: 83,333

Data Usage ADS, ADX,
OAS, ODS

This attribute indicates the number of data
values currently locally stored by the Ready
Time Series Data feature as a percentage
of the maximum allowed. Typically, data
samples are routinely delivered to an online
client and the data usage remains small.
When the client is unknown or offline, data
values continue to accumulate in local
storage until limits are reached. This feature
is used by a Site Director and is updated
every 1 minute. For the ADS, data values
are accumulated in memory and stored in
batches in a disk-based queue limited to
10,000 entries. This attribute is based on the
worst case queue usage of all clients of this
feature.
Units: %

Detection
Interval

OAS, ODS Indicates the time, in seconds, determined
by the HTTP transport mechanism based
on the Poll Rate and Network Tolerance
settings. This value determines how fast a
site detects a device going offline.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Event Rate OAS, ODS Specifies the number of event messages
destined for the Metasys server in the last
hour (for diagnostic purposes).
The value of this attribute updates every 5
minutes.

Events Lost OAS, ODS Specifies the total number of events which
failed to be forwarded to the configured
repository and which were deleted from
the server's local repository. This count
does not persist through a server reset, and
reflects the number of lost events since the
last reset.

Incoming Audit
Rate

Units = Per
Hour

ADS, ADX,
OAS, ODS

Specifies the average rate of audits, per
hour, received from other devices (NxEs
or ADS/ADXs) during the previous hour.
The value of this attribute updates every
5 minutes. This rate only includes audits
generated by devices at Release 5.2 or later.

Incoming Event
Rate

ADS, ADX,
OAS, ODS

For an ADS, ADX, or OAS, this attribute
indicates the average rate of events, per
hour, received from other devices (NxEs
or ADS/ADXs) during the previous hour.
This rate only includes events generated by
devices at Release 5.2 or later.
For an ODS, this attribute indicates the
number of event messages destined for the
Metasys server in the last hour, and is for
diagnostic purposes.
The value of this attribute updates every 5
minutes.
Units: per hour

Maximum
Intermittent
Failure Period

ADS, ADX,
OAS, ODS

Specifies the maximum number of seconds
a device was offline at the transport layer
(for diagnostic purposes). Only time
period under one minute are recorded,
to eliminate device resets. The value of
this attribute does not match the offline
time period determined from generated
alarms. Ideally, this number should be zero,
indicating there are no failures.
Units: seconds
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Memory Usage OAS, ODS Specifies the percent of system RAM that is
currently in use.
It is calculated as follows:
Total commit charge x 100
Display Precision = 0.1
COV Increment = 0.1

Network
Tolerance

C,W Low OAS, ODS Sets the timeout tolerance of the flexible
polling feature (that is, changes the lower
level communication timeouts). When
edited by a user, this attribute is sent to
the HTTP transport layer and determines
how long the device waits to connect, send,
and wait to receive HTTP Post responses.
The setting options are LOW, MEDIUM,
and HIGH. LOW is the default and matches
the current behavior. The MEDIUM or
HIGH setting increases the tolerance by
adding longer timeouts and more retries
and should be used for poor network
connections. Note that it takes longer to
detect an offline device as the tolerance
gets higher.

Object Count OAS, ODS Indicates the number (count) of all of the
object instances within the device. Objects
of all classes are included.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Object Memory
Usage

OAS, ODS Specifies the percent of the object database
that is currently in use. Each object created
consumes memory within the object
database. This attribute can be used to
help determine the device’s capacity
for additional objects; however, other
performance indicators should also be
assessed. Generally, the number of objects
you define determines the object memory
usage. This attribute is valid on the Engine
hardware.

Note: If you have a large number of
objects, the object memory usage increases
and the archive.moi file size increases
also. The archive.moi file is stored in flash
memory.

Also, an attempt to create an object known
to require X bytes of object database may
fail even if more than X bytes are available
in the object database. This is because the
object database is composed of multiple
blocks. If the free space of each block is
fewer than X bytes, the request for X bytes
fails even though the sum total of free
space from all blocks is greater than X bytes.

Outgoing Event
Rate

ADS, ADX,
OAS, ODS

For an ADS, ADX, or OAS, this attribute
indicates the average rate of events per
hour, sent to other repositories (ADS/ADXs).
This rate only includes events generated by
devices at Release 5.2 or later.
For an ODS, this attribute indicates the
number of event messages destined for
the Metasys server in the last hour (for
diagnostic purposes).
The value of this attribute updates every 5
minutes.
Units: per hour

Pager Dial-up
Status

OAS, ODS Specifies the current status of the pager
dial-up connection.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Registration
Usage

ADS, ADX,
OAS, ODS

For an ADS, ADX, or OAS, this attribute
indicates the number of registrations used
by the Ready Metasys Time Series Data
feature. It is the total usage of all clients of
this feature. Each registration is a sign-up
for an attribute of an object. The feature
supports up to 1,000 registrations per
fully loaded field bus per site device. This
feature is only used by a Site Director and is
updated every 1 minute.
For an ODS, this attribute indicates the
number of registrations used by the Metasys
Time Series Data feature in the cloud-
based platform. Starting at Release 10.0,
the remote services connection to a cloud-
based platform is no longer available, so
this attribute does not function on an ODS.

Repository
Status

OAS, ODS Indicates the status of the communication
between the device and the trend log
sample repository (for diagnostic purposes).
This attribute uses the Repository Status
set.
Uses Repository Status set:
0: Offline
1: OK
2: Undefined
3: Dialup
4: RAP
5: Incompatible Release

Sample Rate OAS, ODS Specifies the number of trend samples
destined for the Metasys server in the last
hour (for diagnostic purposes). The value of
this attribute updates every 5 minutes.

Note: The sample rate at the NxE is cal-
culated based on the actual raw samples
taken by every trend object. The sample
rate at the OAS or ODS is calculated once
every poll cycle and is based on the number
of samples received from all the NxEs and
the time it took to poll them. Most NxEs do
not forward all the samples taken between
polls because the OAS or ODS transfer set-
point is usually not set to 1 (that is, for-
ward on every sample). The result is that
the sample rate at the OAS or ODS is less
than the sum of the samples taken at all
the NxEs. The total OAS or ODS sample rate
is 60,000 and the total NxE sample rate is
larger than 100,000.
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Table 91: Server Object Attributes - Diagnostic Tab
Attribute Name Flags Initial

Value
Server Description

Samples Lost OAS, ODS Specifies the number of trend samples lost
because the Metasys server did not retrieve
them fast enough (for diagnostic purposes).
This value resets only when the device
restarts.

Time Between
Buffer Reads

OAS, ODS Indicates the time, in minutes, between
Engine trend consolidation buffer readings
from the Metasys server (for diagnostic
purposes).

Transfer Buffer
Full

OAS, ODS Indicates the percentage full of the Engine
trend consolidation buffer (for diagnostic
purposes).

Transport Failure
Rate

ADS, ADX,
OAS, ODS

Specifies the number of transport failures
per day (for diagnostic purposes). This
number represents how often HTTP posts
from this server failed when they were
sent to another device that is considered
online. Failures include the inability to open
the connection, to send the message, or
to receive the reply. This value represents
failures over the last 24 hours and is
updated hourly, but does not correlate
directly to the number of offline alarms
generated by your system. Ideally, this
number should be zero, indicating there are
no failures.
Units: failures per day

Integration
Menu Selection: Insert > Integration
Integrates the following types of buses or networks into the network engine:

• BACnet IP - Inserts a BACnet IP integration into the network engine.
• Field Bus MSTP - Inserts an MS/TP network integration for the network engine.
• SA Bus - Specifies the SA Bus under the Local Hardware IO folder of an SNC. The SA Bus is

prebuilt for the SNC; it is not manually defined.
• LON Trunk - Inserts a LonWorks network into the network engine. The LON trunk integration

is not available for network engines updated to Release 9.0.7, but is available on many
network engines at Release 10.0 or later.

• N1 Migration - Inserts an N1 Migration trunk into the NIE55.
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Note: Be sure to configure the Network Name attribute of the N1 Migration. Once you
insert the N1 Migration, you cannot edit the Network Name attribute. The workaround is
to delete the existing N1 Migration and insert a new N1 Migration ensuring you enter the
desired Network Name before completing the Insert Integration wizard.

• N2 Trunk - Inserts an N2 trunk into the network engine.
• VND Integration - Inserts a vendor integration into the network engine.
• Wireless Supervisor - Inserts a Wireless Sensor System integration into the system. (You can

have only one Wireless Integration per network engine.) The Wireless Supervisor integration is
not available for network engines updated to Release 9.0.7 or later.

• XL5K Integration - Inserts a Honeywell® Excel 5000 (XL-5000) network integration for the
NIEx5. (You can have only one XL5K Integration object per NIEx5.) - Inserts a Honeywell Excel
5000 (XL-5000) network integration for the NIEx5. (You can have only one XL5K Integration
object per NIEx5.) The XL5K integration is not available for network engines updated to
Release 9.0.7 or later.

Tip: Select the Hardware tab (if it appears) on the Configure screen for further configuration.

After adding an integration, you can select the integration in the navigation tree and click
Action > Import Integration to add existing devices and points under the integration.
See one of the following sections for more information:

• BACnet IP Integration Object
• MS/TP Field Bus Integration Object
•
• LON Integration Object
• N1 Migration Object
• N2 Master Datalink Object (N2 Trunk)
• Generic Integration Object
• VND Integration Object
• Wireless Receiver Supervisor Object
• XL5K Integration Object

BACnet IP Integration Object
The BACnet IP Integration object manages the communication with a BACnet/IP network. All
integrated BACnet devices and objects appear under the BACnet IP Integration object in the
Navigation Tree.
The BACnet IP Integration object serves as the root for all integrated BACnet/IP Field Controller
objects on an Ethernet trunk. The BACnet IP Integration object is a direct child of a supervisory
controller and integrates BACnet/IP devices using the Ethernet trunk.
For general information on Metasys system objects, see the Object Help section.
For detailed information on the BACnet IP Integration object, see BACnet IP Integration Attributes.

BACnet IP Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
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information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes marked with the letter C are configurable, attributes
marked with an N are not required, and attributes marked with the letter W are writable.

Table 92: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

Alarm State Indicates the current status of the object. The
expected state is Normal.

APDU Retries C,W Indicates the maximum number of times the
device can retransmit a data frame. If the device
does not perform retries, it has a value of 0. If
this value is greater than 0, a non-zero value
appears in the APDU Segment Timeout attribute.
Recommended settings: high sensitivity: 3
(default); medium sensitivity: 4; low sensitivity: 5.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

APDU Timeout C,W Indicates the amount of time in milliseconds
between retransmissions of a complete data
frame requiring acknowledgment for which no
acknowledgment has been received. This attribute
applies to smaller data messages where the
entire message fits within a single frame on the IP
network. Recommended settings: high sensitivity:
6000 ms; medium sensitivity: 12000 ms (default);
low sensitivity: 20000 ms.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

APDU
Segment
Timeout

C,W Indicates the amount of time in milliseconds
between retransmissions of a data frame
segment requiring acknowledgment for which no
acknowledgment has been received. This value
is not 0 if the device supports segmentation of
transmitted data frames. Recommended settings:
high sensitivity: 8000 ms; medium sensitivity:
11000 ms (default); low sensitivity: 20000 ms.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

Count Indicates the number of BACnet objects defined
for this integration.
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Table 92: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

Device
Discovery
Range

C,W Structure elements:
• network number

(see attribute
description)

• high limit device
instance (Range:
1–4,194,302)

• low limit device
instance (Range:
1–4,194,302)

Contains the destinations for the Who-Is message
sent during the device autodiscovery process.
When the list is empty, the object sends a global
broadcast in the form of the Who-Is. Adding
entries to the list limits the scope of the Who-
Is broadcast to only the networks and device
instance ranges specified. Multiple entries to
this list cause the object to send multiple Who-Is
messages sequentially.
The following are device discovery range network
numbers to use (broadcast type:network
numbers):
Local: 0 (locked for editing)
Global: 65,535 (locked for editing)
Remote: 1 to 65,345 (editable)

Discover All
as General
BACnet Device

C,W Default is False for all
engines and OAS
Default is True for
ODS

Toggles the integration between pure BACnet
mode and BACnet with proprietary messaging.
When set to True, proprietary messaging is
disabled. This may be useful for special cases
where customers do not want Private Transfer
messages on the BACnet/IP trunk. This attribute
must be set before devices are added to the
Integration.
Also, if you used device discovery prior to the
change, restart the supervisory device to complete
the change in the attribute value. You can do this
after the change or after you have added devices
to the integration. The default value is False.

Note: When this attribute is True, proprietary
Objects, Attributes, and Services on Johnson Con-
trols devices (such as FECs, FACs, and VMAs) are
not available.

Internode
Comm Timer

C,W Controls the frequency of communication with
MS/TP devices. Among other communications,
this attribute defines the frequency of the
heartbeat to monitored devices (monitored
at a rate of two times the Internode Comm
Timer). Recommended settings: high sensitivity:
30 seconds medium sensitivity: 120 seconds
(default); low sensitivity: 240 seconds.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.
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Table 92: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

JCI Network
Port APDU
Retries

C,W Indicates the maximum number of times the
device can retransmit a data frame. If the device
does not perform retries, it has a value of 0. If this
value is greater than 0, a non-zero value appears
in the JCI Network Port APDU Segment Timeout
attribute. Recommended settings: high sensitivity:
3 (default); medium sensitivity: 4; low sensitivity:
5.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

JCI Network
Port APDU
Timeout

C,W Indicates the amount of time in milliseconds
between retransmissions of a complete data
frame requiring acknowledgment for which no
acknowledgment has been received. This attribute
applies to smaller data messages where the
entire message fits within a single frame on the IP
network. Recommended settings: high sensitivity:
6000 ms; medium sensitivity: 12000 ms (default);
low sensitivity: 20000 ms.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

JCI Network
Port APDU
Segment
Timeout

C,W Indicates the amount of time in milliseconds
between retransmissions of a data frame
segment requiring acknowledgment for which no
acknowledgment has been received. This value
is not 0 if the device supports segmentation of
transmitted data frames. Recommended settings:
high sensitivity: 8000 ms; medium sensitivity:
11000 ms (default); low sensitivity: 20000 ms.

Note: If you change the value of this attribute, you
must reset the network engine for the new set-
tings to take effect. Also, this attribute is only visi-
ble in Snapshot Focus view.

JCI Network
Port Type

Specifies the Network Port type: BACnet IP
Integration Port.

Page Size C,W 10–65,535
Default=1,000

Determines how many points are discovered per
page.

Pending
Network
Number

1001 Specifies the network number that is assigned to
the integration when the user sends the Activate
Changes command to the engine. This command
has two options; select the Update All Changes
Pending Attributes and Restart Device option.
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Table 92: BACnet IP Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Values/Options/
Range

Description

Periodic
Update

C,W 0–65,535
Units = seconds
Default = 60

Specifies how frequently integrated BACnet
objects update their attribute values. Every period,
the BACnet IP Integration object prompts each
integrated BACnet object that needs to update
its attribute values. Also see the Execution Time
attribute. Default=60.

Poll Delay C,W Milliseconds
10–50

Specifies the time in milliseconds between BACnet
object polls for attribute values. The polls start at
the time specified in the Periodic Update attribute.
As the Poll Delay increases, the overall time in the
Execution Time attribute increases. It is useful
to specify a Poll Delay on sites where the rate of
reading the remote objects causes too high a
burden on the Metasys network or third-party
device. The initial value of the Poll Delay attribute
is blank (zero).
Recommended setting: high sensitivity: 20
seconds; medium sensitivity: 60 seconds; low
sensitivity: 120 seconds.

Preserve
Discovered
Devices

C,W Default = True Controls the behavior when field device discovery
is started. When this value is True (default), any
devices which were previously discovered or
already mapped remain in the list of discovered
devices, without any attempt to reestablish
communication with them. If this value is False,
an attempt is made to reestablish communication
with all devices, and devices which do not respond
are not shown in the list of discovered devices.
Set this value to False to rediscover devices which
have been re-addressed on the network.

Requested
Vendor ID

C,N,W 0–65,535 Specifies a Vendor ID when discovering new
devices to limit the device list displayed to that
specified Vendor ID. The default value of this
attribute is Null (stored as zero) which allows all
vendors to be discovered and displayed.
The current list of Vendor IDs can be viewed
at http://www.bacnet.org/VendorID/BACnet
%20Vendor%20IDs.htm.

Note:  If you do not want to display devices
already discovered or mapped, then set Preserve
Discovered Devices to False.
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Table 93: BACnet IP Integration Attributes - Diagnostic Tab
Attribute Name Notes Description
Duplicate Device
Identifier

Lists any duplicate BACnet Device Object Identifiers found
after you perform an auto-discovery of BACnet/IP devices.
The list contains the instance number of the BACnet Device
Object Identifier and the network address (represented in
hex notation) of each device with the same identifier instance
number as another device on the network. The devices in this
list are not included in the list of auto-discovered devices in
the integration tree under the Engineering tab of the BACnet
IP Integration object. The physical locations of BACnet/IP
devices with duplicate device identifiers must be determined,
and their object identifiers changed to make them unique
network-wide.

Execution Timer Records the amount of time taken for the last periodic
update of all integrated BACnet objects. You can use the
value for this attribute to tune the Periodic Update attribute.
If the Execution Time is greater than the Periodic Update,
this indicates that the attribute values of integrated BACnet
objects are constantly being updated over the network.
Range: 0 to 4,294,967,295
Units = seconds

Polled Object Count Indicates the number of mapped BACnet objects currently
being polled on a periodic basis. The polling is limited to
those mapped BACnet objects currently being accessed
either by a feature or by the UI. The Instance Number is
typically smaller than the total Count.

MS/TP Field Bus Integration Object
The MS/TP Field Bus Integration is the root for all Field Devices and BACnet objects on the MS/TP
Field Bus in the Metasys system. When you add a Field Bus integration to an NAE or NIEx9, you
create an MS/TP communication link on a specified hardware port. The MS/TP Field Bus Integration
object offers diagnostic data related to the MS/TP network. After you create a Field Bus integration,
you can use the Insert Field Device and Insert Field Point wizards within SMP to add BACnet devices
and associated BACnet objects to the trunk. The integration wizards support both manual object
creation and automatic Device and Point discovery. The Field Bus integration supports third-party
BACnet MS/TP devices and all FEC family BACnet MS/TP devices.

Important: When you add an MS/TP Field Bus Integration on an OAS for Remote Field Bus, do
not select a Trunk Number value of 1 or 2. The OAS reserves these trunks for the USB ports.

MS/TP Field Bus Integration Attributes
The MS/TP Field Bus Integration object contains attributes common to many Metasys system
objects. You can find a description of these common attributes in the Common Object Attributes
section. This section includes attributes of the Focus/Configuration and Diagnostics tabs.

Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter N
indicate values not required.
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Table 94: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Description

Alarm State Indicates the current status of the object. The expected state is
Normal.

APDU
Length

W Indicates the maximum number of octets that may be contained in
a single indivisible application on this port. Supports up to 65535.
This value must be greater than 50. This attribute appears only in the
Snapshot Focus view of the object.

APDU
Retries

C,W Indicates the maximum number of times the device can retransmit a
data frame. If the device does not perform retries, it has a value of 0.
If this value is greater than 0, a non-zero value appears in the APDU
Segment Timeout attribute. Recommended settings: high or medium
sensitivity: 3 (default); low sensitivity: 5.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

APDU
Timeout

C,W Indicates the amount of time in milliseconds between retransmissions
of a complete data frame requiring acknowledgment for which no
acknowledgment has been received. This attribute applies to smaller
data messages where the entire message fits within a single frame
on the MS/TP bus. Recommended settings: high sensitivity: 6000 ms;
medium sensitivity: 12000 ms (default); low sensitivity: 30000 ms. The
default number is 12000ms.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

APDU
Segment
Timeout

C,W Indicates the amount of time in milliseconds between retransmissions
of a data frame segment requiring acknowledgment for which no
acknowledgment has been received. This value is not 0 if the device
supports segmentation of transmitted data frames. Recommended
settings: high sensitivity: 8000 ms; medium sensitivity: 11000 ms
(default); low sensitivity: 29000 ms. The default number is 11000ms.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

Changes
Pending

Indicates whether an object configuration change has not yet been
activated. If this attribute is True, reset the engine or issue an Activate
Changes command to the network engine.

Command W Describes an attribute that initiates specific functionality dependent
upon the enumerated value written to it. In addition to basic defined
commands described by BACnet PR18, there may also be vendor
specific commands. Currently, only discarding of pending changes is
supported. The default value for this attribute is Idle.

Count Contains the number of FEC series and non-FEC series BACnet objects
mapped on the field bus.
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Table 94: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Description

Device
Discovery
Range

C,W Specifies the destinations for the messages sent during the device
auto discovery process. This list is empty by default. When the list
is empty, a global broadcast message is sent. Adding entries to the
list limits the scope of the broadcast message to only the specified
networks and device instance ranges. If multiple entries appear in the
list, the messages are sent sequentially. This attribute appears only in
the Snapshot Focus tab.

Discover All
As General
BACnet
Device

C,W Toggles the integration between pure BACnet mode and BACnet with
proprietary messaging. When set to True, proprietary messaging is
disabled. This may be useful for special cases where customers do not
want Private Transfer messages on the BACnet trunk. Note that when
this attribute is True, proprietary Objects, Attributes, and Services on
Johnson Controls devices (such as Field Equipment Controllers (FECs),
Advanced Application Field Equipment Controllers (FACs), and VAV
Modular Assemblies (VMAs)) are not available. This attribute must
be set before devices are added to the Integration. If you change the
value, restart the supervisory device to make the change effective.
You can restart immediately or after you have completed the mapping
process. The default value is False.

Execution
Priority

C,W Indicates the order in which any given object within a group of objects
is allowed to run or change data within a system. This attribute should
not be changed for this object. This attribute appears only in the
Snapshot Focus tab.

Internode
Comm
Timer

C,W Controls the frequency of communication with MS/TP devices. Among
other communications, this attribute defines the frequency of the
heartbeat to monitored devices (monitored at a rate of two times the
Internode Comm Timer). Recommended settings: high sensitivity: 30
seconds; medium sensitivity: 120 seconds (default); low sensitivity:
240 seconds.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

JCI Network
Port APDU
Retries

C,W Indicates the maximum number of times the device can retransmit
a data frame. If the device does not perform retries, it has a value
of 0. If this value is greater than 0, a non-zero value appears in the
JCI Network Port APDU Segment Timeout attribute. Recommended
settings: high or medium sensitivity: 3 (default); low sensitivity: 5.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.
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Table 94: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Description

JCI Network
Port APDU
Timeout

C,W Indicates the amount of time in milliseconds between retransmissions
of a complete data frame requiring acknowledgment for which no
acknowledgment has been received. This attribute applies to smaller
data messages where the entire message fits within a single frame
on the MS/TP bus. Recommended settings: high sensitivity: 6000 ms;
medium sensitivity: 12000 ms (default); low sensitivity: 30000 ms. The
default number is 12000ms.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

JCI Network
Port APDU
Segment
Timeout

C,W Indicates the amount of time in milliseconds between retransmissions
of a data frame segment requiring acknowledgment for which no
acknowledgment has been received. This value is not 0 if the device
supports segmentation of transmitted data frames. Recommended
settings: high sensitivity: 8000 ms; medium sensitivity: 11000 ms
(default); low sensitivity: 29000 ms. The default number is 11000ms.

Note: If you change the value of this attribute, you must reset the net-
work engine for the new settings to take effect.

Max APDU
Length

C,W Indicates the maximum number of bytes that may be contained in
a single, indivisible application layer protocol data unit. This value
should not be changed during normal installation or operation. The
default value is 1476 bytes.
If you write the value of this attribute, you must issue a Reset Device
command to the network engine or the new settings to take effect.

Max Info
Frames

C,W Specifies the maximum number of information frames the node may
send before it passes the token. This attribute is present if the device
is a node on an MS/TP network. If Max Info Frames is not writable or
otherwise user configurable, its value is one. If you change this value,
you must activate it with the Activate Changes > Update Changes
Pending Attributes Except Network Number command to the
Engine. The pending value is updated immediately but it is not applied
until you activate the change.

Note: If the device is an MS/TP master node, both the Max Info Frames
and Max Master attributes are required.

Max Master C,W Specifies the highest possible address for devices on this network and
is less than or equal to 127 (default). This attribute is present if the
device is a bus supervisor device on an MS/TP network. Typically this
address is kept at 127 to allow other devices on the bus to use any of
the lower valid addresses.

Out of
Service

Indicates whether the field bus is out of service. This value is always
false.

Page Size C,W Determines how many points are discovered per page. The default
value is 1,000.
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Table 94: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Description

Periodic
Update

C,W Specifies how frequently integrated BACnet objects that do not
support COV subscription update their attribute values. Every period,
the MS/TP Field Bus Integration object prompts each integrated
BACnet object that needs to update its attribute values. This attribute
applies only to non-FEC series devices. See the Poll Delay attribute
description for information on how these attributes interact. The
default value is 20 seconds.

Poll Delay C,W Specifies the time in milliseconds between BACnet object polls for
attribute values. The polls start at the time specified in the Periodic
Update attribute. As the poll delay increases, the overall time in the
Execution Time attribute increases.
It is useful to specify a Poll Delay on sites where the rate of reading
the remote objects causes too high of a burden on the Metasys
network or third-party device. The initial value of the Poll Delay
attribute is blank (zero).

Preserve
Discovered
Devices

C,W Controls the behavior when field device discovery is started. This
attribute exists for historical reasons and is ignored by the MS/TP
Field Bus Integration object for FEC series or non-FEC series devices.
The value of the attribute is shown in the snapshot view. If an auto
discovery has been completed since the last device restart, a complete
new auto discovery is performed for all FEC Series or non-FEC Series
devices for each subsequent auto discovery in which Restart is
selected. The default is True.

Reliability Indicates the current reliability of the integration. The normal state is
Reliable.

Requested
Vendor ID

C,N Used as a filter when discovering new devices to limit the device list
to whatever is specified as the Vendor ID value. The default value
of this attribute is Null (stored as zero), which allows all vendors
to be discovered and displayed. Note that this filter applies only to
non-Johnson Controls devices. Johnson Controls devices are always
included in the discovered device list.
The current list of Vendor IDs can be viewed at http://
www.bacnet.org/VendorID/BACnet%20Vendor%20IDs.htm.

Note: If you do not want to display devices already discovered or
mapped, then set Preserve Discovered Devices to False.
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Table 94: MS/TP Field Bus Integration Attributes - Focus/Configuration Tab
Attribute
Name

Notes Description

Status Flags Indicates the general status of the object in BACnet terms and
contains four independent states.
The four selections are:
In Alarm—False if the Event State attribute value is Normal;
otherwise, the In Alarm flag is True. (Set only by BACnet Intrinsic
Alarming.)
Fault—True (1) if the Reliability attribute is not reliable; otherwise, the
Fault flag is False.
Overridden—Overridden flag is True if the Present Value is
overridden from the hardware source level.
Out of Service—Out of Service flag is True if the Out of Service
attribute value is True; otherwise, the Out of Service flag is False.

Synchronize
Time

C,W Broadcasts time synchronization to all devices on the field bus
when the field device comes online or when the time changes by
a significant amount. When changed from false to true, a time
synchronization is sent immediately to all devices on the field bus. The
default is True.

Synchronize
Time Zone

C,W Enables and disables time zone synchronization messages to devices
(such as FACs) on a trunk that support real-time clock capabilities.
When this attribute is set to True (default), time zone synchronization
messages are broadcast to devices on the field bus. The broadcast
occurs either when individual devices come online or to all devices
when any of the time zone related attributes change (Default Time
Zone, UTC Offset, Standard Time Offset, Daylight Savings Time Offset,
Standard Time Start, and Daylight Savings Time Start). When changed
from false to true, time zone synchronization is automatically sent to
all devices on the field bus.

Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Active Baud Rate Displays the actual data rate on the wire for transmitting and

receiving. When set to Auto, the port is waiting to synchronize with
the network.

Broadcast Receive Rate Indicates the number of BACnet broadcast messages received on
the MS/TP field bus network of the device in the last minute. If this
number is high, it indicates that the performance of the specific MS/
TP field bus network is affected by broadcast receive traffic.

Broadcast Receives Indicates the number of broadcast messages received.
Broadcast Transmit Rate Indicates the number of BACnet broadcast messages transmitted on

the MS/TP field bus network for the device in the last minute. If this
number is high, it indicates that the performance for the specific MS/
TP field bus network is affected by broadcast transmit traffic.

Broadcast Transmits Indicates the number of broadcast message transmissions.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Buffer Overflows Indicates the number of data frames lost at this MS/TP device

because there was no buffer available to which to save it. This
number includes outgoing and incoming messages.

Bus Analysis Date Displays the date when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Time Displays the time when the last full MS/TP field bus scan finished.
The Analyze Field Bus command initiates the network scan.

Bus Analysis Progress Indicates the progress of the full MS/TP field bus scan initiated by the
Analyze Field Bus command.

Bus Device Configuration
List

Lists MS/TP devices that either have been detected on the FC bus or
have been configured on field devices existing under the MS/TP Field
Bus Integration Object.
The Bus Device Configuration List provides configuration information
for each device, including which devices are responding, which
devices may have been configured incorrectly, and the addresses of
all devices. Only bus supervisor devices provide all this information.
This object creates the list when you issue an Analyze Field Bus
command.

Bus Health Index Indicates the overall health of the MS/TP field bus based on the
number of errors occurring at the network engine. The most
desirable value is 0. The higher the number, the worse the bus
health/higher the number of errors. The Bus Health Index is re-
evaluated every 30 seconds and gradually returns to zero if no new
errors occur.
This object derives the value for the Bus Health Index from
periodically reading the Header CRC Errors, Data CRC Errors, Framing
Errors, and Lost Token attribute values to create a moving average of
total errors. The Weighted Bus Health Constant attribute determines
the responsiveness of the Bus Health Index.

Bus Performance Index Indicates the responsiveness of the bus supervisor device on the MS/
TP field bus. The most desirable value is 1. Values from 2.5 to 6 are
marginal and updates to devices on the bus may be slow. If the value
is greater than 6, the performance is poor and may indicate offline
conditions.
The device derives the value for the Bus Performance Index by
comparing the measured token loop time at the network engine
and the predicted token loop time calculated when the MS/TP Field
Bus Integration object is first created or when the network engine
device count changes. This object uses the difference as input for
determining the weighted moving average of the token loop time.
The Weighted Bus Performance Constant attribute determines the
responsiveness of the Bus Performance Index.

Bytes In Indicates the number of data bytes received by this device. This
number includes all messages from all devices.

Bytes Out Indicates the number of data bytes sent by this device. This number
includes all messages to all devices.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Data CRC Errors Counts errors detected in the data portion of data frames sent to the

device. Many data frames are used only for protocol control and do
not contain a data portion, and thus cannot have Data CRC Errors.
The Header CRC Errors check must be successful before the device
attempts a Data CRC check. This attribute supplies an error count for
the Bus Health Index attribute.

Data Expecting Reply
Frames Rxed

Displays the number of data frames received by the device that
require an immediate reply. This value includes proprietary frames
that have been received and are expecting a reply.

Data Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that requires
an immediate reply from the destination device.
This value includes proprietary frames that have been sent and are
expecting a reply.

Data Not Expecting Reply
Frames Rxed

Displays the number of data frames received by this item that do not
require an immediate reply. This value includes proprietary frames
that have been received and are not expecting a reply.

Data Not Expecting Reply
Frames Txed

Displays the number of data frames sent by the device that do not
require an immediate reply. This value includes proprietary frames
that have been sent and received a reply.

Duplicate Device Identifiers Lists any duplicate object identifiers found after an auto-discovery
of MS/TP BACnet devices finishes. If any devices are listed, then
the list of automatically discovered devices may be incomplete.
The list contains the instance number of the Object Identifier and
the network address (represented in hex notation) of each device
with the same identifier instance number as another device on the
same bus. MS/TP devices with duplicate device identifiers may be
integrated without problem, but should be physically located and
their object identifiers changed to make them unique network-wide.

Execution Time Records the amount of time taken for the last periodic update of all
referenced mapped BACnet objects. The value for this attribute can
be used to tune the Periodic Update attribute. If the Execution Time
is greater than the Periodic Update, attribute values of referenced
BACnet objects are constantly being updated over the network.
This attribute applies only to non-FEC series devices. See the Poll
Delay attribute description for information on how these attributes
interact.

Framing Errors Counts the number of errors detected in the individual data bytes
received by the device. A framing error occurs when the device
receives a stop bit in the wrong state. This attribute supplies an error
count for the Bus Health Index attribute. Framing errors are usually
caused by electrical noise on the bus, message collisions, incorrect
baud rate settings, bus wiring or termination errors, or devices that
are not operating within the BACnet specified timing. Framing errors
generally cause CRC errors since the frame has been corrupted.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Header CRC Errors Counts the number of errors detected in the header portion of

frames received by the device. Many frames are only used for
protocol control and only contain a header portion. This attribute
supplies an error count for the Bus Health Index attribute.

Internal Errors Indicates the number of internal MS/TP driver operation errors
resulting from an incorrect state, insufficient memory, errors from
the serial port driver, incorrect internal state transitions, and other
error states.

Logging Object Reference Indicates the object (by way of the BACnet Object Identifier) that
acquires, presents, and stores the Logging Record data (that is,
snapshot) from the underlying system. When the object specified
in the Logging Object Reference field issues the Get Monitor Data
command, the Logging Record is acquired and updated.

Lost Token Indicates the number of times the device detects a lost token. A
lost token indicates that the bus encountered a serious network
disruption. Serious disruption may occur when the bus first starts up
or when wiring changes are made. This attribute supplies an error
count for the Bus Health Index attribute.

Max Output Queue Used Displays the largest number of outgoing frames the device has
held in a queue for transmission. The largest possible value for this
attribute depends on the capabilities of the engine. Generally, the
maximum value is reached during device startup, but is not reached
during normal operation.

Maximum Token Loop Time Indicates the maximum time in milliseconds last seen at the device
for the token to complete one circuit of the MS/TP field bus (go
from the originating bus supervisor device through several other
devices and return to the original bus supervisor device). The value
is reset when the statistics are cleared. Maximum loop time is closely
associated with the worst-case performance encountered since the
last time the value was reset.

Overrun Errors Displays the number of times the MS/TP port hardware loses
received data because the device is too slow in reading the data. An
overrun error occurs when the hardware receives a byte before it
moves the prior byte to a buffer.

PFM Frames Rxed Displays the number of Poll For Master (PFM) frames received by
the device. On a clean network, this should only count the first PFM
frame received when the device (or another with a MAC address
below that of the device) comes online. These frames are used
to discover other devices on the network and should be seldom
received.

PFM Frames Txed Displays the number of PFM frames sent by the device. In normal
operation on a clean network, only the bus supervisor (MAC address
0) and the highest numbered master device on the network should
be sending PFM frames. These frames are used to discover other
devices on the network.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Packets Timed Out Counts the number of data frames expected by the device that did

not arrive within the time allowed.
Packets Too Long Counts any attempts to transmit or receive a data frame that is

longer than allowed by the device or by MS/TP.
Polled Object Count Indicates the number of mapped BACnet objects that are currently

polled on a periodic basis. This attribute applies only to non-FEC
series devices.

Port Status Indicates the state of the port.
Predicted Token Loop Indicates the theoretical time in milliseconds needed for the token to

complete one circuit of the MS/TP field bus.
The object derives this value from the defined bus baud rate, number
of devices on the bus, and an estimate of the type and amount
of messages transmitted on the bus during this time. This object
compares the value of this attribute with that of the Token Loop Time
attribute to help calculate the value of the Bus Performance Index
attribute.

Reply Postponed Frames
Rxed

Counts the number of data frames sent at the device that requires
an immediate reply where the destination device requests additional
time to prepare the reply. This may happen normally if the reply
involves a large amount of data. It may also indicate that a device on
the network is overloaded.

Reply Postponed Frames
Txed

Counts the number of data frames received at the device that
requires an immediate reply where this device requests additional
time to prepare the reply. This may happen normally if the reply
involves a large amount of data. It may also indicate that this device
is overloaded.

Reply to PFM Frames Rxed Counts the number of Reply to PFM frames the device receives. On
a clean network in normal operation, the device receives only one
Reply to PFM frame when either the device comes online or the next
higher numbered device comes online during normal operation.
These frames announce the presence of this device on the network.

Reply to PFM Frames Txed Counts the number of Reply to PFM frames the device transmits.
On a clean network during normal operation, only one Reply to PFM
frame needs to be sent when the device first comes online. These
frames are used to announce the presence of other devices on the
network.

Reply Too Slow Application
Errors

Counts the number of data frames received at this device that
requires an immediate reply where the device cannot assemble reply
data within the time allowed and cannot internally detect the need
for additional time. These errors generally indicate an overloaded
device if they occur frequently.

Reply Too Slow Datalink
Errors

Counts the number of data packets sent by the device that requires
an immediate reply from the destination device, but do not receive
any reply within the time allowed. This number does not include
Reply Postponed responses. The affected frames likely require a retry
and bus performance is reduced when this happens.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Reset Date Contains the date of the last Clear Statistics command (when the

statistics for the device were last reset).
Reset Time Contains the time of the last Clear Statistics command (when the

statistics for the device were last reset).
Retries Displays the number of times the device tried to pass a token as the

next node did not start using it within the time allowed by BACnet
protocol.

Test Request Frames Rxed Displays the number of Test Request Frames the device receives. Test
Request Frames are a normal part of bus analysis, but should not be
received during normal operation. A Test Response Frame should be
sent in reply to each Test Request Frame received.

Test Request Frames Txed Displays the number of Test Request Frames the device transmits.
Test Request Frames are a normal part of bus analysis, but should
not be sent during normal operation. A Test Response Frame should
be received in response to each test Request Frame sent to an online
device. Test Request Frames may also be sent to offline devices
where no response is received.

Test Response Frames Rxed Displays the number of Test Response Frames the device receives.
Test Response Frames are a normal part of bus analysis, but should
not be received during normal operation. A Test Response Frame
should be received in response to each test Request Frame sent to
an online device.

Test Response Frames Txed Displays the number of Test Response Frames transmitted by this
MS/TP port. Test Response Frames are a normal part of bus analysis,
but should not be sent during normal operation. A Test Response
Frame should be sent in response to each test Request Frame
received.

Token Frames Rxed Displays the number of Token Frames the device receives. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message; thus, the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.

Token Frames Txed Displays the number of Token Frames the device transmits. In MS/
TP, each master device passes a logical token to the next device
during normal operation. Only the master device currently holding
the token is allowed to initiate a message, thus the number of Token
Frames sent or received should be large. Normally the number of
Token Frames received should be almost the same as the number of
Token Frames transmitted.
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Table 95: MS/TP Field Bus Integration Attributes - Diagnostic Tab
Attribute Name Description
Token Loop Time Indicates how much time passes between the periods when the

device allows initiation of messages on the network. This time is a
strong indicator of network performance and is associated strongly
with the amount of traffic or errors on the network. Shorter time
period indicate a more responsive network. Longer time period
indicate an increasingly busy and slow network.
The object compares the value of this attribute with that of the
Predicted Token Loop Time attribute to help calculate the value of
the Bus Performance Index attribute.

Unexpected Frames Rxed Displays the number of data frames of an illegal type that the device
receives. During normal operation, only certain kinds of MS/TP data
frames are allowed to be sent during each phase of operation. If
the device receives some other kind of data frame (other than the
allowed types for the current phase of operation), the device counts
the data frame as an Unexpected Frame. The device may often
detect Unexpected Frames when connecting running devices to a live
MS/TP bus.

Weighted Bus Health
Constant

Determines the responsiveness of the Bus Health Index. The default
value is 0.50.

Weighted Bus Performance
Constant

Determines the responsiveness of the Bus Performance Index. The
default value is 0.50.
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Table 96: MS/TP Field Bus Integration Attributes - Hardware Tab
Attribute Name Flags Initial

Value
Values/Options/Range

Baud Rate Selection C,W 38400 Indicates the baud rate of the network engine FC bus.
Baud
Rate

Description

Auto Use baud rate of running network. This value
is the recommended setting for everything
on the FC bus except the bus supervisor port.
See Active Baud Rate.

1200 Use 1200 baud only. This value is not
recommended and may not be allowed on
some devices.

9600 Use 9600 baud only. This value is the lowest
standard MS/TP baud rate.

19200 Use 19200 baud only. This value is not
recommended.

38400 Use 38400 baud only. This value is the
recommended baud rate for bus supervisor
ports.

76800 Use 76800 baud only.
Configured Network
Number

C,W 2000 Contains the network number of the MS/TP bus
used for BACnet message addressing. A value of 0
indicates a local network (the device is not intended as
a router). Do not change this number after you start
device mapping or discovery because it may invalidate
the devices that have been found.

Trunk Number 1 Displays the trunk number where the field bus is
located.

LON Integration Object
The LON Integration object defines LonWorks network integration for the NAE. The object contains
pertinent attributes and holds a list of LonWorks network-related configuration resource files.

Note: The LON trunk integration is not available for network engines updated to Release 9.0.7.

LON Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Table 97: LON Integration Attributes - Diagnostic Tab
Attribute Name Data Type Description
Bind Retry Count Number Indicates the number of objects for which the Lon

Integration code is still verifying with the field controller
that it has the correct type information.

Count Number Displays the number of LonWorks network point object
defined for the trunk.

Device Offline Polling
Cycle Time

Number Indicates how often all offline devices are polled.

Device Online Polling
Cycle Time

Number Indicates how often all online devices are polled.

Error Log One value
from a set

Shows the error log according to the last standard
LonWorks network Query Status message.

LON Integration DLL
Date

Date Displays the current date stamp on the
LonIntegration.DLL.

LON Integration DLL
Size

Number Displays the current size of the LonIntegration.DLL.

LON Integration DLL
Time

Time Displays the current time stamp on the
LonIntegration.DLL.

Lost Messages Number Shows the number messages lost according to the last
standard LonWorks network Query Status message.

Missed Messages Number Shows the number messages missed according to the last
standard LonWorks network Query Status message.

Neuron Model One state
from a set

Shows the Neuron model according to the last standard
LonWorks network Query Status message.

Node State One state
from a set

Shows the state of the node according to the last standard
LonWorks network Query Status message.

Offline True or False Displays the offline or online status of connected
hardware. The LonWorks network server updates this
attribute value.

Permanent Status
Item Count

Number Displays the number of items polled as a result of COV
signups.

Point Scan Time Number Displays the calculated number of seconds the server
takes to read all defined points.

Priority 1 Poll Item Number Displays the number of items in the Priority 1 list.
Priority 2 Poll Item Number Displays the number of items in the Priority 2 list.
Priority 3 Poll Item Number Displays the number of items in the Priority 3 list.
Priority 1 Poll Time Number Indicates how often the items in the Priority 1 list are

polled.
Priority 2 Poll Time Number Indicates how often the items in the Priority 2 list are

polled.
Priority 3 Poll Time Number Indicates how often the items in the Priority 3 list are

polled.
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Table 97: LON Integration Attributes - Diagnostic Tab
Attribute Name Data Type Description
Receive Transaction
Full

Number Shows the number of times the transaction full message
appeared in the last standard LonWorks network Query
Status message.

Reset Cause One cause
from a set

Shows the cause of the last reset according to the last
standard LonWorks network Query Status message.

Reset Date Date Contains the date stamp of the last local Neuron statistics
reset command.

Reset Time Time Contains the time stamp of the last local Neuron statistics
reset command.

Status Cache Hits Number Displays the number of READATTRIBUTE calls that
occurred while the object was already being polled.

Status Cache Misses Number Displays the number of READATTRIBUTE calls that
occurred while the object was not being polled.

Temporary Status
Item Count

Number Displays the number of items polled as a result of
READATTRIBUTE calls.

Transaction Timeouts Number Shows the timeouts that appeared in the last standard
LonWorks network Query Status message.

Transmit Errors Number Shows the number of transmit errors that appeared in the
last standard LonWorks network Query Status message.

Transmits Per Minute Number Displays the calculated number of transmissions per
minute.

Version Number Number Shows the version number according to the last standard
LonWorks network Query Status message.

XIF Present True or False Indicates whether the XIF is present. The XIF is a resource
file required for the NAE to understand a particular device
type. This attribute is not used in the SCT.

N1 Migration Object

Note:  This object is for use with the NIEx5 only. For more information on N1 migration, see
the Related documentation table in the Welcome section.

The N1 Migration object contains all the necessary information to communicate with points on an
existing Metasys network. Add the new Metasys system hosting the migration server to the existing
Metasys network as an OWS at a fixed IP Address. All existing Metasys networks are defined as N1
Migration objects in the host NIE. Many of the existing point objects are defined as mapped devices
to the NIE.

Note: The N1 Migration object is not available for network engines updated to Release 9.0.7 or
later.

N1 Migration Concepts

Migration Overview
When you add a new Metasys system N1 Migration object, the N1 migration component establishes
communication with the N1 network. The N1 Migration object is only an object on the new Metasys
system controller to which it was added.
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After the N1 Migration object establishes communication with the existing Metasys system, the
N1 Migration object creates 2 new calendars that are a portal to the existing NCM calendar. One
calendar is a list of alternates, and one calendar is a list of holidays.

Note: An Ethernet connection is the only method for the NIE to connect to the N1 network.
ARCnet jobs must use an Ethernet router.

See the N1 Migration Attributes section for more information on N1 migration attributes.

Mapped Points
Existing features of the Metasys system are supported by moving their functionality to the host
NIE. These features are: trend, totalization, point history, and scheduling. When possible, existing
objects maintain their configuration parameters in the new Metasys system. For example, alarm
limits, alarm state, and units. The table below lists points specific to the Metasys system.
Table 98: Mapped Points
Existing Metasys System
Object

New Metasys System Mapped Object

Accumulator Object N1 Pulse Counter Object
Analog Input Analog Input Object
Analog Output Analog Output Object
Analog Data Analog Output Object
Binary Input Binary Input Object
Binary Output Binary Output Object
Binary Data Binary Output Object
Control System Generic Integration Object (GIO)
Multistate Input Multistate Input Object
Multistate Output Multistate Output Object
Multistate Data Multistate Output Object

Multiple NIEs
Migration can be split across multiple NIEs with the following constraints:

• Only one N1 Migration object can exist per NIE per N1 network.
• Multiple NIEs can reference the same N1 network.
• Only one NCM object can exist per NCM per N1 Migration object.
• Multiple NCM objects can reference the same NCM as long as they exist on different NIEs.
• Only one point object can exist per NIE per N1 object.
• Multiple point objects can reference the same N1 object as long as they exist on different NIEs.

N1 Migration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
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Table 99: N1 Migration Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Discovery Gate Number --
Engineering Values
2559 W C

Displays the defined NCM Gate address on the existing Metasys
system. Use for self discovery of the existing Metasys system. You
need at least 1 NCM in the existing N1 network that the NIE can talk
to, to find the other N1 devices and get N1 points.

Discovery Node Number --
Engineering Values
2560 W C

Displays the defined NCM Node address on the existing Metasys
system. Use for self discovery of the existing Metasys system. You
need at least 1 NCM in the existing N1 network that the NIE can talk
to, to find the other N1 devices and get N1 points.

Discovery IP Address --
Engineering Values
2561 W C

Displays the defined NCM IP address of the existing Metasys system.
Use for self discovery of the existing Metasys system. You need at
least 1 NCM in the existing N1 network that the NIE can talk to, to
find the other N1 devices and get N1 points.

Network Name --
Engineering Values
2555 C

Displays the defined network name.
Note:  Be sure to configure the Network Name attribute of the N1
Migration. Once you insert the N1 Migration, you cannot edit the
Network Name attribute. The workaround is to delete the existing
N1 Migration and insert a new N1 Migration ensuring you enter the

Device Name --
Engineering Values
907 W C

Displays the defined case-insensitive device name. The device name
is required for the existing Metasys system to detect the On-Line
status and Off-Line status of the NIE. This attribute must match the
name of the NIE in the existing N1 network.

Gate Number --
Engineering Values
2556 W C

Displays how the NIE is defined in the existing N1 network. This
attribute is read from the NCM.

Node Number --
Engineering Values
1378 W C

Displays how the NIE is defined in the existing N1 network.

Migrate Object
Configuration --
Engineering Values
32611 W C

When True, this attribute displays the basic object configuration from
the existing Metasys system object used to write basic configurations
for newer Metasys objects. For example, units or descriptor. This
attribute (when True) tells the new Metasys system to bring alarm
setup information from the existing N1 network and creates Alarm
Extensions (Analog Alarm and Multistate Alarm) for new objects that
are added.

Migrate Trend
Configuration --
Engineering Values
32613 W C

Displays the trend configuration from the existing Metasys system
object used to create the newer Metasys system Trend Extension
when an existing object is mapped to a newer object. This attribute
creates one or more trend extensions for existing N1 network trends.

Migrate Totalization
Configuration --
Engineering Values
32614 W C

Displays the totalization configuration from the existing Metasys
system object used to create the newer Metasys system Totalization
Extensions when an existing object is mapped to a newer object.
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Table 99: N1 Migration Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Migrate Schedules --
Engineering Values
32615 W C

Displays the attached existing Metasys system schedules used to
create the newer Metasys system Schedule. The schedules that
appear in the new Metasys systems are portals to the schedules in
the existing N1 network. Schedules appear in the new format and
offer the same functionality. Changes made to the schedules in the
new Metasys system are also made to the N1 schedules in the NCM.

Synchronize Time --
Engineering Values
32616 W C

Displays whether the NIE is the master time keeper for the existing
N1 network system. Time updates are sent to the existing system
once daily and when the time changes.

Enable Polling -- Advanced
Setup
3531 W C

When True, this attribute causes the integration in the NIE to place
any system into a 20 second fast polling table being viewed. This
attribute also places a system into this table on an object’s Focus
view. This provides faster updates to objects being viewed in any
Metasys system UI. When viewing points from several systems, the
Service Time for the NCM increases. Take care when enabling this
fast polling feature as it may affect the service times.

Notes:

• To prevent delays in event reporting due to the fast scan
operation, follow the existing report routing guidelines.

• Do not set this attribute to True when for NIEs used with
validated environments (that is, when Trend data must be
collected within 2 minutes).

Duty-Standby -- Advanced
Setup
2557 W C

Displays whether the existing Metasys system is a Duty/Standby
network. The NIE has to know if the existing N1 network is a Duty/
Standby.

Broadcast Address --
Advanced Setup
2045 W C

Edits the address to use directed broadcasts. The user typically does
not edit this attribute.

UDP Port -- Advanced
Setup
2558 W C

Displays the UDP Port as defined in the existing Metasys system.

Retry Wait Time --
Advanced Setup
625855 W C

Contains the time between communication retries (in seconds). This
attribute is the time the NIE waits for a low-level Ack from the NCM.
The user typically does not edit this attribute.

Retry Counter Limit --
Advanced Setup
63854 W C

Contains the number of retry attempts made. The NIE waits for the
Message Timeout, then retries sending messages the number of
times defined in this attribute.

Message Timeout --
Advanced Setup
1165 W C

Displays the reply timeout in seconds. The reply timeout is how long
the NIE waits for a reply from an NCM. The user typically does not
edit this attribute.

Poll Delay -- Advanced
Setup
1163 W C

Displays the polling time for non-triggerable attributes in
milliseconds. The poll delay is the time between NIE polls to the N1
network points.
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N2 Master Datalink Object (N2 Trunk)
The N2 Master Datalink object creates the communication link between the N2 controllers and the
supervisory controller. The N2 Master Datalink object is the root for all N2 objects in the Metasys
system. When you add an N2 Trunk to an engine, you establish communication with the specific N2
controller network. The N2 Master Datalink object offers diagnostic data related to the N2 controller
network. This object allows you to see N2 Bus communication statistics.

Note: The Object Type for this object is labelled N2 Trunk in the software.

N2 Master Datalink (N2 Trunk) Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects). The
writable attributes in the N2 Master Datalink object are writable only if the UDP Port attribute is not
zero. If the UDP Port attribute is zero and you attempt to write these attributes, an error message
appears.
Table 100: N2 Master Datalink Object Attributes - Diagnostic Tab
Attribute Name Values/Options/

Range
Description

Buffer Overflow Indicates the number of input buffer overflows.

Checksum Errors 0 to 4,294,967,295 Indicates the number of checksum errors.
Command Count Indicates the number of N2 user or process commands.

Count 0 to 65,535 Specifies the number of N2 point objects defined for this
trunk.

COV-COS Count 0 to 4,294,967,295 Indicates the number of Changes of Value/Changes-of-
State since the last reset.

Data CRC Errors Indicates the number of System 9100 checksum errors.

Framing Errors Indicates the number of UART framing errors.

Hardware
Overflows

Indicates the number of UART hardware overruns.

HP Point Scan
Time

0 to 65,535
Seconds

Indicates the calculated number of seconds the N2
master takes to scan high priority N2 point objects, such
as those used in alarming and interlocks.

LP Point Scan
Time

0 to 65,535
Seconds

Indicates the calculated number of seconds the N2
master takes to scan low priority N2 point objects (all
N2 point objects that do not fall in the high priority
category).

Message Receives 0 to 4,294,967,295 Indicates the number of messages received from the N2
controllers.

Message
Transmits

0 to 4,294,967,295 Indicates the number of message transmissions to the
N2 controllers.

263SCT: System Configuration Tool Help



Table 100: N2 Master Datalink Object Attributes - Diagnostic Tab
Attribute Name Values/Options/

Range
Description

NAK Errors 0 to 4,294,967,295 Indicates the number of negative acknowledge errors.
A NAK is returned by an N2 device to indicate that it
received and decoded a command correctly, but the
command did not make sense or could not be carried
out. An example of a NAK is an attempt to read an
Analog Input beyond the range of the device.

Offline
Occurrences

0 to 4,294,967,295 Indicates the number of offline occurrences by the N2
controllers.

Offline Polls 0 to 4,294,967,295 Indicates the number of offline polls to the N2 devices.
Online Polls 0 to 4,294,967,295 Indicates the number of online polls to the N2 devices.
Parity Errors Indicates the number of messages that contain invalid

hexadecimal characters (hexadecimal characters are 1-9
and A-F).

Poll Scan Times 0 to 65,535 Seconds Indicates the calculated number of seconds the N2
master takes to poll all defined N2 devices.

Reset Date Indicates the date of the Clear Statistics command.

Reset Time Indicates the time of the Clear Statistics command.

Retry Attempts 0 to 4,294,967,295 Indicates the number of message retry attempts.
Transmits Per
Minute

65,535 Indicates the calculated number of message
transmissions per minute.

VMA BAC Errors 0 to 4,294,967,295 Indicates the number of VMA BACnet errors
VMA COV Errors 0 to 4,294,967,295 Indicates the number of VMA Change-of-Value errors.
VMA FMT Errors 0 to 4,294,967,295 Indicates the number of VMA Format errors.

N2 Master Datalink (N2 Trunk) Commands
The table below lists the commands supported by the N2 Master Datalink Object (N2 Trunk).
Table 101: N2 Master Datalink Object Commands
Command Name Parameters Description
Clear Statistics None Allows the user to clear the N2 statistics.
Latch Statistics None Updates the displayed statistics with the current values.

Generic Integration Object
The GIO is a single software representation of the hardware/internal data points from a device
that has been integrated into your Metasys network. One GIO can represent one or more control
strategies (for example, temperature control or static pressure control). Up to 256 data points can
become attributes of the GIO and each attribute of the GIO works with Metasys features, such as
historical data management, alarm and event handling, and basic monitoring and commanding
capabilities.
You can map data points to the GIO in either online or offline mode. When you map the data points,
you define their label, units, display precision, category, and whether or not the data point should
be commandable. You can command points from the GIO using Generic Integration Attributes
commands.
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The GIO is useful when you have multiple hardware/internal data points from an integrated device
and it logically makes sense to view them as a single entity rather than individual Metasys objects
(that is, AI, BI, AO, BO, and so on). While you may be able to browse to each device, there may only
be a few data points you need to see on a regular basis. The GIO lets you group the data points you
need to see in one place and organize them in the following categories:

• inputs
• outputs
• parameters

When the GIO appears in Metasys software, the attributes are organized by tabs bearing the names
of the three categories (Input Category, Output Category, and Parameter Category tabs). Each tab
includes the status, description, and value of the items in that category.

Note: Currently, the GIO supports N1 Migration Object and LON Integration Object. You can
no longer manually add a GIO to a LON trunk; however, the GIO is still supported in existing
databases, even after upgrading to the next software release.

For general information on Metasys system objects, see Common Object Attributes.

Generic Integration Concepts

N1 Integration and the GIO
For N1 integration, use the Control System object from your existing Metasys network. Hardware
and internal points are already defined in the Control System object so there is one to one mapping
between a Control System object and the GIO. N1 point mapping is one to one and the Metasys
system restricts which characteristics of the GIO (for example, label, display precision) can be edited
once they are added to the system.

LonWorks Network Integration

Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still
supported in existing databases, even after upgrading to the next software release.

In LonWorks network integration, the GIO presents multiple LonWorks network variables (with
their individual data elements) and/or NexSys controller points of an integrated LonWorks network
controller as a single Metasys object. During the configuration of a GIO for an integrated LonWorks
network controller, the user is presented with the internal network variables and NexSys controller
points in a tree structure which then allows the user to add these data points as attributes of the
GIO object. The characteristics of the GIO attributes (label, units, display precision, field units,
category) and the commandability of the GIO attributes can be edited.

Generic Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.

Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, attributes marked with the letter D are default
display attributes, and attributes marked with the letter N indicate values not required.

Table 102: Generic Integration Object (GIO) Attributes
Attribute Name Notes Description
Display Reference N Represents the label of the Display Attribute. The Display

Reference is not stored in the object, but read when
requested.

Target Reference Identifies the source that provides the data elements linked
to the individual attributes of the GIO.
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Table 102: Generic Integration Object (GIO) Attributes
Attribute Name Notes Description
Attribute Info C,W Contains a list of structures that store data about each

attribute defined within a GIO. The elements listed in
this table appear as columns on the Hardware tab of the
Configure screen of the Insert Point Wizard - GIO.
Table 103: Hardware Tab Configuration Columns
Element
Name

Description

Adjust
Allowed

Indicates whether or not this attribute
supports the Adjust command.

Category Specifies the attribute category (input,
output, or parameter). 0 - Input, 1 - Output,
2 - Parameter

Display
Precision

Specifies the display precision for an
attribute with a real value (floating point).

Element Ref Specifies the element within the target
reference associated with this attribute to
provide it data for value/status/reliability.

Field Units Represents the units that can be used for
the attribute. Uses Unit Set (Set 869)

Label Contains the user label for the attribute
name. This is the name used whenever you
view the attribute in Metasys software.

Override
Allowed

Indicates whether or not this attribute
supports the Override command.

Units or
Enum Set

Specifies the units for an attribute that is
a real value (floating point). If an attribute
is one value from a set, this attribute sets
the states text from the sets listed in the
Alphabetical Set List.
Use Unit Set (Set 869) to set the units of a
real value.

Display Attribute C Specifies the attribute that represents the value of the
GIO. The value of this attribute is used as the Present
Value of the GIO. For example, for a GIO representing
a temperature control strategy, you might choose the
attribute representing room temperature to be the Display
attribute. Then, the room temperature appears as the GIO
Present Value.
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Table 102: Generic Integration Object (GIO) Attributes
Attribute Name Notes Description
Remote Object
Name

C,W Contains the name of the object in the format of
system.object.

GIO 1 Attr. . .GIO
256 Attr

W Represents user-definable attributes that can be part of
a GIO. Each attribute represents a potential entry in the
Attribute Info attribute which in turn represents a physical
or logical piece of data within an integrated device.
These attributes only appear on the Hardware tab of the
Configure screen of the Insert Point Wizard - GIO.

VND Integration Object
The VND (Vendor) Integration object defines a vendor integration for the NAE.

VND Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.

Table 104: VND Integration Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Enabled C,W True If True, allows the use of the vendor integration. If

False, prevents the use of the vendor integration.
Offline True Displays the offline or online status of connected

hardware.

Table 105: VND Integration Attributes - Diagnostic Tab
Attribute Name Notes Initial Value Description
Count W 0 Displays the number of vendor device and point

objects defined for the trunk. This count does not
include extensions.

Errors In W 0 Indicates the number of field communication
errors (bad format, for example) received. The
Clear Statistics command resets this value.

Errors Out W 0 Indicates the number of field communication
attempts that failed. The Clear Statistics
command resets this value.

Function Time
Exceeded

0 Indicates the number of functions to the Vendor
DLL that took longer than 100 milliseconds to
execute. The Clear Statistics command resets this
value.
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Table 105: VND Integration Attributes - Diagnostic Tab
Attribute Name Notes Initial Value Description
Message Receives 0 Indicates the number of messages received field

devices. This value resets to zero at midnight. The
Latch Statistics command updates this value.

Message
Transmits

0 Indicates the number of messages sent to field
devices. This value resets to zero at midnight. The
Latch Statistics command updates this value.

Permanent Status
Item Count

0 Displays the number of items polled as a result of
COV signups.

Priority 1 Poll Time 0 Indicates how often the items in the Priority 1 list
are polled. Units = Seconds

Reset Date Contains the date stamp of the last Clear Statistics
command.

Reset Time Contains the time stamp of the last Clear Statistics
command.

Temporary Status
Item Count

0 Displays the number of items polled.

Transmits In 0 Indicates the rate of transmissions received by
the integration.

Transmits Out 0 Indicates the rate of transmissions sent by the
integration.

Wireless Receiver Supervisor Object
The Wireless Receiver Supervisor object is the root of the Wireless Sensor integration. The Wireless
Sensor integration allows the NAE to communicate with the wireless sensing system over the
Ethernet network. The Wireless sensing system consists of wireless receivers and wireless sensors.
Each integrated wireless field device (Wireless Receiver Object) and field point object (Wireless
Sensor Object) appears under the Wireless Receiver Supervisor object in the Navigation Tree. Only
one Wireless Receiver Supervisor object can be configured in each NAE or NIEx9.

Note: The Wireless Receiver Supervisor object is not available for network engines updated to
Release 9.0.7 and later.

Wireless Receiver Supervisor Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Table 106: Wireless Receiver Supervisor Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

UDP Port -- Setup
2258 W C

Indicates the UDP Port on the NAE used to communicate to the
Ethernet to RS-485 converter. The port must be 1024 or higher, but
cannot be equal to the BACnet UDP Port, the N2 Trunk UDP Port, or
9999.

Retries -- Setup
1162 W

Displays the number of times the device tried to pass a token as
the next node did not start using it within the time allowed by the
protocol.

Poll Delay -- Setup
1163 W

Specifies the time in milliseconds between BACnet object polls for
attribute values. The polls start at the time specified in the Periodic
Update attribute. As the poll delay increases, the overall time in the
Execution Time attribute increases.
It is useful to specify a Poll Delay on sites where the rate of reading
the remote objects causes too high of a burden on the Metasys
network or third-party device. The initial value of the Poll Delay
attribute is blank (zero).

Message Timeout -- Setup
1165 W C

Specifies the delay in milliseconds between the last character going
out and the first character received.

Note: The Message Timeout attribute is writable only if is not zero. If
User Datagram Protocol (UDP) Port is zero and you attempt to write
Message Timeout, an error message appears.

Low Battery -- Status
620

Indicates if any wireless sensors defined as children of the Wireless
Receiver Objects have a low battery. The Low Battery status is an
advanced warning that can occur many days before a wireless sensor
ceases to function. You can configure an alarm for this attribute to
allow the building operator time to locate the sensor and change the
battery.

Alarm State -- Status
1006

The Alarm State attribute indicates that the object transitioned into
alarm or unreliable conditions. This attribute does not appear in the
SCT UI.

P2000 Integration
The P2000 system integration enables you to view access control objects in the P2000 security
system from a single user interface, the Metasys Site Management Portal UI. You also can view the
objects from other building systems controlled by the Metasys system. The integration leverages
Web Services technology to integrate the P2000 system.
The P2000 integration provides many features, allowing you to:

• see P2000 objects in the navigation tree.
• perform door and output point control tasks.
• see P2000 events in the Metasys Event Viewer.
• use P2000 events to initiate actions on the Metasys system.

For information, refer to the P2000 Metasys System Extended Architecture Integration Manual (Part No.
24-10618-82).
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Ethernet IP Datalink Object
The Ethernet IP Datalink object manages the Ethernet communications bus and the messages
transmitted on it. By working with this object, you can access Ethernet card statistics.
For general information on Metasys system objects, see the Object Help section.

Ethernet IP Datalink Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. The set of attributes varies based on the version
of the network engine. For example, a network engine at Release 11.0 on a BACnet site has a set
of Status and BACnet attributes that do not apply to a network engine at Release 10.1 or earlier.
Attributes that are marked with a letter C are configurable and attributes marked with the letter W
are writable.
Table 107: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

Address
Length

6 Indicates the number of octets for the device address (Data
Link Address).

APDU Length
or
Max APDU
Length

C,W 1024 Indicates the maximum number of bytes that may be
contained in a single, indivisible application layer protocol
data unit (APDU). Units = bytes

Note: If you write the value of this attribute, you must reset
the Engine for the new settings to take effect.

APDU Retries C,W 4 Indicates the maximum number of times that an APDU is
retransmitted. If the device does not perform retries, it is set
to zero. If this value is greater than zero, a non-zero value
appears in the APDU Timeout attribute.

APDU Segment
Timeout

C,W 10000 Indicates the amount of time in milliseconds between
retransmission of an APDU segment. This value is non-zero
if the device supports segmentation of transmitted APDUs.
Units = milliseconds

Note: At Metasys Release 10.0 and later the default value is
10,000. In earlier releases, the default value is 4,000.

APDU Timeout C,W 10000 Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received.
Units = milliseconds
1,000–65,535

Note: At Metasys Release 10.0 and later the default value is
10,000. In earlier releases, the default value is 6,000.

BACnet IP
Mode

BBMD IP
Mode

Indicates whether the network port object is in use by the
BBMD. Possible values: Normal IP Mode or BBMD IP Mode.

BACnet IP UDP
Port

47808 Indicates the IP UDP Port number that the device uses to
transmit and receive messages.

BACnet UDP
Port

47808 Indicates the UDP Port number that the device uses to
transmit and receive messages.
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Table 107: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

BBMD
Accept F.D.
Registrations

C,W False Determines whether a BBMD is allowed to register foreign
devices, either True or False. If you change this value,
you must activate it with the Activate Changes > Update
Changes Pending Attributes Except Network Number
command to the Engine. The change is updated immediately
online but it is not fully applied until you activate the change.

BBMD
Broadcast
Distribution
Table

C,W Specifies a list of BBMDs on the building network by IP
address or hostname. The hostname must be in the DNS
table of the DNS server in order to be resolved. If you
change this value, you must activate it with the Activate
Changes > Update Changes Pending Attributes Except
Network Number command to the Engine.

Note: Do not edit this table if Dynamic Broadcast Manage-
ment is set to False in the Site object.

BBMD Foreign
Device Table

Specifies a list of any foreign devices registered with the
BBMD and described in the sequence of IP address, time to
live, and remaining time to live.

Broadcast
Address

Indicates the address used when sending broadcast
messages. Maximum length = 6 octets

Changes
Pending

False Indicates whether a change to a network port object
attribute has yet to be activated. Possible values: True or
False. If True, issue an Activate Changes command to the
network engine.

Command Idle Indicates the BACnet command specific to the network port
object. Possible values: Idle or Discard Changes. Discard
Changes discards any pending changes to the network port
object.

Configured
Network
Number

C,W 1001 Indicates the BACnet network number configured for the
data link.

Device Address Indicates the address of the device (Data Link Address).
Maximum length = 6 octets

DNS Refresh
Period

C,W 20 Specifies the time in minutes between DNS lookups to
update the IP address of a BACnet Broadcast Management
Device (BBMD) referenced by host name. If an IP address
is changed within a DNS server, the BBMD system
automatically obtains the new IP address upon the
expiration of this period. A value of 0 is used to disable
periodic DNS lookups.
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Table 107: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

Internode
Comm Timer

C,W 120 Controls the frequency of communication with IP devices
over the Ethernet. Among other communications, this
attribute defines the frequency of the heartbeat to
monitored devices (monitored at a rate of two times the
Internode Comm Timer). Recommended settings: high
sensitivity: 30 seconds; medium sensitivity: 120 seconds
(default); low sensitivity: 240 seconds.

Note: If you change the value of this attribute, you must reset
the network engine for the new settings to take effect.

IP Address Indicates the currently assigned IP address of the network
engine.

IP Default
Gateway

Indicates the IP address of the network engine's default
gateway.

IP DHCP
Enable

Indicates whether the network engine is set for DHCP or
static IP address assignment. Possible values: True or False.

IP DNS Server C,W Lists the DNS server(s) assigned to the network engine.

IP Subnet
Mask

Indicates the currently assigned IP subnet mask address of
the network engine.

JCI Network
Port APDU
Retries

C,W 4 Indicates the maximum number of times that an APDU is
retransmitted. If the device does not perform retries, it is set
to zero. If this value is greater than zero, a non-zero value
appears in the APDU Timeout attribute.

JCI Network
Port APDU
Segment
Timeout

C,W 10000 Indicates the amount of time in milliseconds between
retransmission of an APDU segment. This value is non-zero
if the device supports segmentation of transmitted APDUs.
Units = milliseconds

JCI Network
Port APDU
Timeout

C,W 10000 Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgment for
which no acknowledgment has been received.
Units = milliseconds
1,000–65,535

JCI Network
Port Type

Indicates the type of port in use by the network engine.

Link Speed Indicates the Ethernet link speed of the network engine.
Possible values: 1.0E8, 1.0E7, or 1.0E6.

MAC Address Contains the unique hardware number that identifies the
network engine within a network.

Network
Number
Quality

Describes how the network number was acquired. Possible
values: Network Number Configured (always for NAE or
SNx), Network Number Learned/Configured, Network
Number Learned, Network Number Unknown.

Network Type Indicates the type of network that the network engine is
using. Example: BACnet/IP over IPv4
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Table 107: Ethernet IP Datalink Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

Out of Service De-couples the object from the physical input. When Out of
Service is True, the object decouples the Present Value and
Reliability from the hardware. The Reliability is writable when
Out Of Service is True. When de-coupled, the Present Value
can be changed to simulate specific conditions or for test
purposes.
Additionally, the Out of Service state of the Status Flags
attribute is set to True and the Fault state is decoupled from
the physical input when Out of Service is True.

Pending
Network
Number

1001 Indicates the BACnet network number that is currently
pending for configuring the datalink object. Once you
issue an Activate Changes command to the engine, the
Configured Network Number is set to the Pending Network
Number.

Protocol Level Indicates the protocol level of the engine. Example: BACnet
application

Reliability Indicates the current reliability of the integration. The
normal state is Reliable.

Status Flags Indicates the general status of the object in BACnet terms
and contains four independent states.
The four selections are:
In Alarm—False if the Event State attribute value is Normal;
otherwise, the In Alarm flag is True. (Set only by BACnet
Intrinsic Alarming.)
Fault—True (1) if the Reliability attribute is not reliable;
otherwise, the Fault flag is False.
Overridden—Overridden flag is True if the Present Value is
overridden from the hardware source level.
Out of Service—Out of Service flag is True if the Out of
Service attribute value is True; otherwise, the Out of Service
flag is False.

Table 108: Ethernet IP Datalink Attributes - Diagnostic Tab
Attribute Name Data Type Description
Broadcast
Receives

Number Indicates the number of broadcast messages received.

Broadcast
Transmits

Number Indicates the number of broadcast message transmissions.

Discarded
Frames

Number Indicates the count of received messages discarded due to
critical low resources (that is, the System Memory Resource,
Object Engine Queue Resource, or Protocol Engine Input Queue
Resource).

Message
Receives

Number Indicates the number of messages received.
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Table 108: Ethernet IP Datalink Attributes - Diagnostic Tab
Attribute Name Data Type Description
Message
Transmits

Number Indicates the number of message transmissions.

Reset Date Date Indicates the date of the last Clear Statistics command.
Reset Time Time Indicates the time of the last Clear Statistics command.
Retry Attempts Number Indicates the number of retry attempts.
Transmit
Failures

Number Indicates the number of message transmit failures.

XL5K Integration Object
The XL5K Integration object defines Honeywell Excel 5000 (XL-5000) network integration for the
NIEx5. The object contains pertinent communications attributes and statistics. Only one XL5K
Integration object can be configured in each NIE.

Note: The XL5K Integration object is not available for network engines updated to Release
9.0.7 or later.

XL5K Integration Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes that are marked with a letter C are configurable and
attributes marked with the letter W are writable.

Table 109: XL5K Integration Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Enabled C,W True If True, allows integration between the XL5K system and the Metasys

system extended architecture.
Offline False Indicates the offline/online state of the connected hardware.

Table 110: XL5K Integration Attributes - Diagnostic Tab
Attribute
Name

Data Type Description

Count Number Indicates the number of scannable points for all XL5K Controller
objects defined for this object.

Point Scan
Time

Number Indicates the total amount of time to scan for point data.

Reset Date Date Indicates the date of the last Clear Statistics command or due to
automatic midnight rollover.

Reset Time Time Indicates the time of the last Clear Statistics command or 12:00:00 if
due to automatic midnight rollover.

Transaction
Timeout

Number Indicates the number of transmissions (packets) since the last Clear
Statistics command where no response data was obtained and the
transmission was retried.
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Table 110: XL5K Integration Attributes - Diagnostic Tab
Attribute
Name

Data Type Description

Transmit
Error

Number Indicates the number of transmissions (packets) since the last Clear
Statistics command that have errors (for example, bad data was
returned).

Transmits
Per Minute

Number Indicates the calculated number of transmissions per minute.

Transmits
Today

Number Indicates the number of transmissions (packets) since midnight.

Field Device
About this task:  
Menu Selection: Insert > Field Device

Inserts one of the following types of field device objects under the selected integration:

• BACnet Integration
• MS/TP Field Bus Integration
• LonWorks Network Integration (LON Trunk)
• N2 Integration (N2 Trunk)
• VND Controller (Vendor)
• Wireless Supervisor Integration
• XL5K (Excel 5000/XL-5000) Integration

To insert a field device select the menu selection:

1. In the Destination selection, select the parent item for your new item.
2. In the Definition selection:

a. Select Assisted Device Definition and click the Invoke Auto Discovery button to discover
existing controllers or devices on the network. This is available in the Site Management
Portal (SMP) only.

Note: In the wizard Auto Detect Utility window, if Results are from a previous
discovery appears next to the Close button, the displayed results are from the last
time a discovery was run. These cached results may not reflect all items currently
on the network. To clear the old results and perform a new auto discovery, click
Restart. Click any column header to sort discovered devices.

b. Select Manual Device Definition and select the desired address from the menu.
3. In the Identifier selection, enter a unique identifier.
4. In the Configure selection, click any tabs that may appear for further device configuration.
5. Click Finish to confirm the field device configuration.

Note: If the navigation tree does not automatically update for defined points after
adding a field device using Auto Discovery (+ sign appears next to device in tree), select
Refresh All Tabs on the Action Menu to update.
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See one of the following sections for more information:

- BACnet IP Integration Object
- MS/TP Field Bus Integration Object
- N2 Master Datalink Object (N2 Trunk)
- LON Integration Object
- N1 Migration Object
- VND Controller
- Wireless Receiver Object
- XL5K Integration Object

BACnet Protocol Engine Object
The BACnet Protocol Engine object maintains diagnostic statistics on communications with the
BACnet devices on the network.

BACnet Protocol Engine Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
Table 111: BACnet Protocol Engine Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Alarm State Offline Indicates that the object transitioned into alarm or

unreliable conditions. This attribute appears only in
the Snapshot Focus tab.

Enabled C,W True If True, allows integration between the Metasys
system and the IP field controller.

Graphic Alias C,W Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.

Poll Delay C,W 120 Specifies the time in milliseconds between BACnet
object polls for attribute values. The polls start at
the time specified in the Periodic Update attribute.
As the Poll Delay increases, the overall time in the
Execution Time attribute increases. It is useful
to specify a Poll Delay on sites where the rate of
reading the remote objects causes too high a
burden on the Metasys network or third-party
device.
Recommended setting: high sensitivity: 20 seconds;
medium sensitivity: 60 seconds; low sensitivity: 120
seconds (default).

Table 112: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name Notes Description
Abort Rcv Contains the number of abort messages received. Aborts

occur in response to a number of situations, such as
communication or memory problems.

Abort Tx Contains the number of abort messages sent.
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Table 112: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name Notes Description
Ack Rcv Contains the number of complex acknowledgment

messages received.
Ack Tx Contains the number of complex acknowledgment

messages sent.
Allocated Record Count Indicates the number of state machines that have been

allocated.
Clear Statistics W Clears the statistics for the integrated BACnet Protocol

network.
Conf Req Rcv Contains the number of confirmed request messages

received.
Conf Req Tx Contains the number of confirmed request messages sent.

Error Rcv Contains the number of error messages received. An
example of an error is an attempt to rite to a read-only
attribute.

Error Tx Contains the number of error messages sent.

Latch Statistics W Updates the displayed statistics with the current values.
Local Abort Tx Contains the number of application layer abort messages

generated locally (for example, messages that used up
all allowed retries and did not get an acknowledge from
the remote device).

Net Messages Rcv Contains the number of messages received at the network
layer.

Net Messages Tx Contains the number of messages transmitted at the
network layer.

Net Rejects Rcv Contains the number of reject messages received at the
network layer.

Net Routed Messages Contains the number of messages routed through the
network layer from one network (for example, IP) to
another (for example, MS/TP).

Net Routes Busy Contains the number of messages not sent because the
network route is busy or not initialized.

Net Unknown Message Rcv Contains the number of unknown messages received at
the network layer.

Net Unknown Routes Contains the number of messages not sent due to
unknown route information.

Peak Pending Queue
Count

Indicates the largest number of client requests that were
queued for transmission.

Peak Unknown Queue
Count

Indicates the largest number of client requests the
unknown queue contained at one time.

Pending Queue Count Indicates the number of client requests currently queued
for transmission.
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Table 112: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name Notes Description
Rcv Messages Discarded Indicates the number of messages received from the

network that were not processed due to lack of resources
or because there were too many requests for the Metasys
Engine to process.

Rcv Message Rate Indicates the number of messages received in the last
minute.

Rcv Record Count Indicates the number of active state machines currently
in use for receipt of requests from other BACnet devices
(that is, the number of requests being processed at this
moment).

Record Count Indicates the number of active state machines holding
information on pending messages.

Reject Rcv Contains the number of reject messages received. Rejects
occur in response to a variety of communication problems
much like aborts and errors.

Reject Tx Contains the number of reject messages sent.

Req Retries Tx Contains the number of confirmed request messages re-
sent due to timeout.

Reset Date Indicates the date of the last Clear Statistic command.

Reset Time Indicates the time of the last Clear Statistic command.

Seg Ack Rcv Contains the number of segmented complex
acknowledgement messages received.

Seg Ack Tx Contains the number of segmented complex
acknowledgement messages sent.

Seg Conf Req Rcv Contains the number of segmented confirmed request
messages received.

Seg Conf Req Tx Contains the number of segmented confirmed request
messages sent.

Seg Retries Tx Contains the number of segmented confirmed request
messages re-sent due to timeout.

Segment Ack Rcv Contains the number of segment acknowledgment
messages received.

Segment Ack Tx Contains the number of segment acknowledgment
messages sent.

Segment Rcv Contains the number of segment messages received.

Segment Tx Contains the number of segment messages sent.

Simple Ack Rcv Contains the number of simple acknowledgment messages
received.

Simple Ack Tx Contains the number of simple acknowledgment messages
sent.
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Table 112: BACnet Protocol Engine Attributes - Diagnostic Tab
Attribute Name Notes Description
Transaction Timeouts Indicates the number of MS/TP Postpone messages

sent due to a late reply to a received Confirmed Request
message (that is, this device’s applications could not
process the request before a low-level MS/TP answer was
required).

Transmits Per Minute Displays the calculated number of transmissions per
minute.

Tx Messages Discarded Indicates the number of client requests aborted due to lack
of resources. Usually, this situation occurs due to memory
issues in the controller.

Tx Record Count Indicates the number of active state machines currently in
use for transmission of client requests.

Unconfirmed Rcv Contains the number of unconfirmed messages received.

Unconfirmed Tx Contains the number of unconfirmed messages sent.

Unknown Queue Count Indicates the number of current client requests that need
network address resolution.

BACnet Device Object
The BACnet Device object defines a standardized BACnet object with attributes that represent the
external, visible characteristics of a device. Only one device object exists in each BACnet Device.

Notes:
• The Johnson Controls network engine device object includes attributes and methods

not required by the BACnet Device object. For information on the network engine device
object, see the Engine Device Object section.

• The Object Type for this object is labeled Non-FEC BACnet Device in the software.

BACnet Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter D
indicate the default attribute for the display.

Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Alarm State Indicates the current state of the object.

Align Intervals W False Specifies whether clock-aligned periodic time synchronization is
enabled. If periodic time synchronization is enabled and the time
synchronization interval is a factor of an hour or a day (that is,
the value divides without remainder), then the beginning of the
period specified for time synchronization aligns to the hour or day,
respectively.
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Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
APDU Retries W 3 Indicates the maximum number of times that an Application

Protocol Data Unit (APDU) is retransmitted. The default value is 3.
If this device does not perform retries, then this attribute is zero. If
the value of this attribute is greater than zero, a nonzero value is
placed in the Device object APDU Timeout attribute.

APDU Segment Timeout W 4,000 Indicates the amount of time in milliseconds between
retransmissions of an APDU segment. This value is nonzero if
APDU Retries is nonzero. The APDU Segment Timeout attribute is
present if segmentation of any kind is supported.
In order to achieve reliable communication, the values of the
APDU Segment Timeout attributes of the Device objects of all
intercommunicating devices should contain the same value.

Note: If segmentation of any kind is supported, this attribute
is required.

APDU Timeout See next
column

Indicates the amount of time in milliseconds between
retransmissions of an APDU requiring acknowledgement for which
no acknowledgement has been received. This value is nonzero if
APDU Retries is nonzero.
In order to achieve reliable communication, the values of the APDU
Timeout attributes of the Device objects of all intercommunicating
devices should contain the same value.
The default is 6,000 milliseconds for devices that permit
modification of this attribute. The default value is 60,000
milliseconds for all other devices.

Active COV Subscriptions Contains a list of BACnet COV Subscriptions, each of which
consists of a Recipient, a Monitored Property Reference, an Issue
Confirmed Notifications flag, a Time Remaining value, and an
optional COV Increment. This attribute provides a network-visible
indication of those COV subscriptions active at any given time.
Whenever a COV Subscription is created with the Subscribe COV or
Subscribe COV Property service, a new entry is added to the Active
COV Subscriptions list. Similarly, whenever a COV Subscription is
terminated, the corresponding entry is removed from the Active
COV Subscriptions list.

Note: If the device supports execution of either Subscribe
COV or Subscribe COV Property service, this attribute is
required.

Alarm State Indicates the current status of the object. The expected state is
Normal.

Appl SW Version Identifies the version of the application software installed in the
device. The content of this string is locally defined (date-and-time
stamp, a programmer’s name, a host file version number, and so
on).

Backup Fail Timeout W 120 Indicates the number of seconds that the device being backed
up or restored waits before unilaterally ending the backup or
restore procedure. This attribute is writable (the device performing
the backup, or the operator, configures this with an appropriate
timeout).
Units = Seconds
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Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Configuration Files Identifies the files within the device that determine what device

image can be backed up. The contents of this attribute are only
required to be valid during the backup procedure. If the device
supports the BACnet backup and restore procedure, this attribute
is supported.

Note: If the device supports the backup and restore
procedures, the Configuration Files and Last Restore Time
attributes are required.

Database Revision Specifies a logical revision number for the device’s database.
Database Revision is incremented when an object is created or
deleted, an object name changes, or a restore is performed.

Device Addr Binding W Contains a list of BACnet Object Identifiers of a BACnet Device
object and a BACnet device address in the form of a BACnet
Address. Entries in the list identify the actual device addresses
that are used when accessing the remote device through a BACnet
service request. The list may be empty if no device identifier-device
address bindings are currently known to the device.

DST Status W Indicates whether daylight saving time (DST) time is in effect (True)
or not (False).
True, False

Graphic C,W Indicates the graphic associated with the object.

Graphic Alias C,W Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this object or the
controller containing this point. Maximum 256 characters

Interval Offset C,W 0 Specifies the offset, in minutes, from the beginning of the
period defined for time synchronization until the actual time
synchronization requests are set. Interval Offset has no effect
when Align Intervals is False. Units = Minutes

Last Restore Time Specifies when the device’s image was last restored. If the device
supports the BACnet backup and restore procedures, this attribute
is supported.

Note: If the device supports the backup and restore
procedures, the Configuration Files and Last Restore Time
attributes are required.

List of Session Keys Contains a list of the cryptographic keys used to communicate
with other security-conscious BACnet Devices. This attribute is not
readable or writable by any device except a device designated the
Key Server. A session key consists of a 56-bit encryption key and a
BACnet Address of the peer with which secure communications is
requested.

Local Date W Indicates the date. If the device has no knowledge of time or date,
Local Date is omitted.

Local Time W Indicates the time of day. If the device has no knowledge of time or
date, Local Time is omitted.

Location W Indicates the physical location of the device.
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Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Manual Time Sync Type C,W Automatic Configures the type of BACnet Time Synchronization to send to a

BACnet device.

• UTC: UTC time synchronization message is sent.

• Local: A local time synchronization message is sent.

• None: No message is sent.

• Auto: The mapper object's Protocol Services Supported
attribute is used to determine which type of time sync is
supported, and if:

• utcTimeSynchronization is set, the code functions as if
Time Sync Type is set to UTC.

• utcTimeSynchronization is not set and
timeSynchronization is set, local time is set.

• neither utcTimeSynchronization nor
timeSynchronization is set, an error is returned.

Max APDU Length Specifies the maximum number of octets contained in a single,
indivisible application layer protocol unit. Underlying data link
technology constrains the value of this attribute.
Greater or equal to 50

Max Info Frames 10 (FEC)
20 (NxE)

Specifies the maximum number of information frames the node
may send before it passes the token. This attribute is present if the
device is a node on an MS/TP network. If Max Info Frames is not
writable or otherwise user configurable, its value is one.

Note: If the device is an MS/TP master node, both the Max
Info Frames and Max Master attributes are required.

Max Master 127 Specifies the highest possible address for master nodes and is
less than or equal to 127. This is present if the device is a master
node on an MS/TP network. If Max Master is not writable through
BACnet services, its value is 127.

Note: If the device is an MS/TP master node, both the Max
Info Frames and Max Master attributes are required.

Max Segments Accepted Indicates the maximum number of segments of an Application
Protocol Data Unit (APDU) accepted by the device.

Model Name Contains a name assigned by the vendor to represent the model of
the device.

Offline False Displays the offline or online status of connected hardware.

Profile Name Contains a string of characters that represents the name of the
object profile to which the object conforms. A profile name must
begin with a vendor identifier code in base-10 integer format,
followed by a dash. The vendor identifier code indicates the
organization that administers the remaining characters of the
profile name, and publishes and maintains the profile document
identified by the profile name. The vendor identifier does not need
to match the vendor identifier of the device in which the object
resides.

Protocol Obj Support Indicates which standardized object types the device’s protocol
implementation supports. This attribute reflects the minimum
set of object types, but implementation often supports additional
standard and non-standard object types with their own set of
attributes. (The list of attributes supported for a particular object
may be acquired by use of the Read Property Multiple service with
an attribute reference of All.)
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Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Protocol Revision Indicates the minor revision level of the BACnet standard. This

starts at 1 and increases for each subsequent release.
If the Protocol Version attribute changes, this number reverts to
zero. This attribute is required for all devices with BACnet Protocol
Version 1, Protocol Revision 1 and above. If this attribute is not
present, the device is Protocol Version 1, Protocol Revision 0.

Protocol Ser Support Indicates which standardized protocol services the device’s
protocol implementation supports. This attribute reflects the
minimum set of services, but implementation often supports
additional standardized services.

Protocol Version Represents the BACnet protocol the device supports. Initial
releases are Version 1; subsequent releases increase the number
by one.

Restart Notification
Recipients

C,W Controls the restrictions on which devices, if any, are notified
when a restart occurs. The value of this attribute is a list of BACnet
Recipients. When the length of this list is empty, the device
cannot send a device restart notification. The default value of
this property is a single entry representing a broadcast on the
local network. If the list has one or more entry, the device sends a
restart notification, but only to the devices or addresses listed.

Segmentation Indicates if the BACnet device supports segmentation of messages.
If so, it supports segmented transmission, reception, or both.
Segmented Both, Segmented Transmit, Segmented Receive, No
Segmentation

System Status D Reflects the current physical and logical state of the device.
Operational, Operational Read Only, Download Required,
Download in Progress, Nonoperational, Backup in Progress

Time Synchronization
Interval

C,W 0 Specifies the periodic interval, in minutes, at which
TimeSynchronization and UTCTimeSynchronization requests are
sent. When set to zero, then periodic time synchronization is
disabled.

Time Sync Recipients W Controls the restrictions placed on a device’s use of the Time
Synchronization service. If the list is of length zero, a device is
prohibited from automatically sending a Time Synchronization
request. If the list is of length one or more, a device automatically
sends a Time Synchronization request but only to the devices
or addresses listed. If it is present, this attribute is writable. If
the PICS indicates that this device is a Time Master, then Time
Synchronization Recipients is present.

Note: If PICS indicates the device is a Time Master, this is
required. If present, this attribute is writable.

UTC Offset W Indicates the number of minutes offset between local standard
time and UTC. The time zones to the west of the zero degree
meridian are positive and those to the east are negative. Subtract
the value of the UTC Offset from the UTC received in the UTC Time
Synchronization service requests to calculate the correct local
standard time.
Range: -1440 though +1440

UTC Time Synchronization
Recipients

C,W Lists one or more BACnet recipients to which the device can issue
a UTC Time Synchronization request. If the list is empty, the device
cannot send a UTC Time Synchronization request to a BACnet
recipient. The attribute requires several other parameters that
define each recipient, such as its device ID, IP address information,
or broadcast type and information.
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Table 113: BACnet Device Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
VT Classes Supported Contains a list of BACnet Video Terminal (VT) Classes that indicate

a particular set of terminal characteristics. A device often supports
multiple types of behaviors for differing types of terminals or
differing types of operator interface programs. If either VT Classes
Supported or Active VT Sessions is present, then both are present.
Both are required if support of VT Services is indicated in the PICS.

Note: If either Video Terminal (VT) Classes Supported
or Active VT Sessions is present, both are present. If the
Protocol Implementation Conformance Statement (PICS)
indicates support for VT Services, both of these attributes are
present.

Vendor ID Distinguishes proprietary extensions to the protocol with a unique
ASHRAE vendor ID code.

Vendor Name Identifies the manufacturer of the device.

BACnet Device Object Commands
The following table lists the commands supported by the BACnet Device Object.
Table 114: BACnet Device Object Commands
Command Name Parameters Description
Rediscover Text
Strings

None Resets the States Text across a supervisory device by
rediscovering text strings from all mapped BACnet objects.

Note: When the Rediscover Text Strings command is sent from
the Site Director device UI to another supervisory device and
the UI is running on the supervisory device, you must close and
restart the UI on the supervisory device in order for the text to
appear correctly.

Reset Field Device Type: Cold
Start or
Warmstart
Password

Resets the BACnet device.

Sync Field Device
Times

None Sends a high-priority time synchronization command to child
devices, based on the device mapper object's Manual Time
Sync Type.

IP Field Controller Object
The IP Field Controller object defines a standardized BACnet object with attributes that represent
the external, visible characteristics of a device. Only one Device object exists in each IP Field
Controller. The IP Field Controller object appears as a child of a BACnet Integration object.

IP Field Controller Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab and the Diagnostics tab. See the Object and Feature Tabs section for
information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable.
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Table 115: IP Field Controller Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Description
Enabled C,W True If True, allows integration between the Metasys

system and the IP field controller.
Vendor Name W Identifies the manufacturer of the device.

Model Name W Indicates the product code for the device.

Fixed Boot Version Indicates the version of the Boot code in the field
device. The Boot code is responsible for loading the
Main code.

Last Update Date W Unspecified Indicates the date the device was last updated.
Last Upload Time W Unspecified Indicates the time the device received the most

recent upload.
Graphic C,W Object Name:

Reference:
Indicates the graphic associated with the object.

Graphic Alias C,W Indicates a portion of the graphic’s item reference,
up to and including the name of the folder
containing this object or the controller containing
this point.

MS/TP Field Device Object
The MS/TP Field Device object is used to represent FEC family MS/TP devices on the MS/TP Field
bus. The MS/TP Field Device object appears as a child of an MS/TP Field Bus Integration object.

Note: The Object Type for this object is labeled FEC Family BACnet Device in the software.

MS/TP Field Device Concepts

Supported Controllers
The Field Device object supports these MS/TP controllers:

• CGMs
• CVMs
• VMA16s
• IOMs
• FECs
• FACs

MS/TP Field Device Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the notes column, attributes that are marked with a letter C are configurable,
attributes marked with the letter W are writable, and attributes marked with the letter D
indicates the default attribute for the display.
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Table 116: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Description

Alarm State Indicates the current state of the object.

COV Min Send Time W 15 Configures the object to send COV messages on a
periodic basis instead of on every change of value
that exceeds the COV Increment.

Enabled CW True If True, allows communication between the
Metasys system and the MS/TP controller.

End of Line False Indicates whether the device is at the end of the
bus.

Fixed Boot Version Indicates the version of the Boot code in the field
device. The Boot code is responsible for loading
the Main code.

Graphic CW Indicates the graphic associated with the object.

Graphic Alias CW Indicates a portion of the graphic’s item
reference, up to and including the name of the
folder containing this object or the controller
containing this point.

In Test Displays True when a Control Sequence in the
device is currently in a test mode. When True, the
device is marked offline, although communication
with the device is acceptable.

JCI System Status Reflects the current status of the system.

Location Indicates the physical location of the device.

Manual Time Sync Type CW Automatic Configures the type of BACnet Time
Synchronization to send to a BACnet device.

• UTC: UTC time synchronization message is
sent.

• Local: A local time synchronization message
is sent.

• None: No message is sent.
• Auto: The mapper object's Protocol Services

Supported attribute is used to determine
which type of time sync is supported, and if:

- utcTimeSynchronization is set, the code
functions as if Time Sync Type is set to
UTC.

- utcTimeSynchronization is not set and
timeSynchronization is set, local time is
set.

- neither utcTimeSynchronization nor
timeSynchronization is set, an error is
returned.
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Table 116: MS/TP Field Device Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial

Value
Description

Model Name Indicates the product code for the device.

Offline Indicates whether the MS/TP controller is offline.

Pcode Displays the device orderable product code.

Protocol Obj Supported Indicates which standardized object types the
device’s protocol implementation supports.
Protocol Conformance Class reflects the
minimum set of object types, but implementation
often supports additional standard and non-
standard object types with their own set of
attributes. (The list of attributes supported for
a particular object may be acquired by use of
the ReadPropertyMultiple Web method with an
attribute reference of All.)

Protocol Ser Supported Indicates which standardized protocol services
the device's protocol implementation supports.
Protocol Conformance Class reflects the minimum
set of services, but implementation often supports
additional standardized services.

Startup Code Version Specifies the version of the Startup code running
in the controller. The Startup code is responsible
for initial power up operations.

Vendor ID Identifies the unique manufacturer’s identifier,
as defined by ASHRAE. For Johnson Controls, this
value is 5.

Vendor Name Identifies the manufacturer of the device (should
be Johnson Controls).

Table 117: MS/TP Field Device Object Attributes - Diagnostic Tab
Attribute Name Notes Initial

Value
Values/Options/Range

CPU Usage Specifies a running average of CPU use. The value
is updated every minute.

Flash Usage Specifies the estimated percent of flash memory
currently in use. The percentage is based on the
portion of flash that is designated for use by the
user’s database. A value greater than 100% can
affect system reliability now or in future software
releases. There are no restrictions in place to
prohibit use of flash over 100%.

Has Unbound
References

Indicates that a process cannot find an object
either because the device on which the object is
located is offline, the object has been deleted, or
the object reference is incorrect.
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Table 117: MS/TP Field Device Object Attributes - Diagnostic Tab
Attribute Name Notes Initial

Value
Values/Options/Range

Memory Usage Specifies the percent of field device RAM currently
in use.

Object Count Indicates the number (count) of all of the object
instances within the device. Objects of all types
are included.

Object Memory Usage Specifies the percent of the object database that
is currently in use. Each object created consumes
memory within the object database. This attribute
can be used to help determine the device’s
capacity for additional objects; however, other
performance indicators should also be assessed.
Also, an attempt to create an object known to
require X bytes of object database may fail even
if more than X bytes are available in the object
database. This is because the object database
is composed of multiple blocks. A free space
block of at least X contiguous bytes available for
allocation may not exist, even if the total free
space is more than X bytes.

LON Controller Object
The LON Controller object defines attributes that represent the external, visible characteristics of a
device residing on a LonWorks network.

Note: The LON Controller object is not available for network engines updated to Release 9.0.7
or later.

LON Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, attributes marked with the letter C are configurable and attributes
marked with the letter W are writable.

Table 118: LON Controller Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

Enabled C,W True If True, allows integration between the Metasys system and the
LON controller.

Graphic C,W Indicates the graphic associated with the object.

Graphic
Alias

C,W Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this object or the
controller containing this point.
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Table 118: LON Controller Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes Initial
Value

Description

Offline False Displays the offline or online status of connected hardware. The
LonWorks network server updates this attribute value.

Present
Value

Offline Displays the communication status of the object.

XIF
Present

Indicates whether a XIF file matching this controller’s Program
ID was found.

Table 119: LON Controller Object Attributes - Diagnostic Tab
Attribute Name Notes Initial Value Description
Command Count Displays the total number of commands sent to this

controller.
Error Log NOERROR Shows the error log according to the last standard

LonWorks network Query Status message.
Lost Message 0 Shows the number messages lost according to

the last standard LonWorks network Query Status
message.

Missed
Messages

Shows the number messages missed according to
the last standard LonWorks network Query Status
message.

Neuron Model Neuron_3150 Shows the Neuron model according to the last
standard LonWorks network Query Status message.

Node State Shows the state of the node according to the last
standard LonWorks network Query Status message.

Offline Poll
Count

0 Displays the total number of times this controller was
sent a poll while offline.

Receive
Transaction Full

0 Shows the number of times the transaction full
message appeared in the last standard LonWorks
network Query Status message.

Reset Cause Clear Shows the cause of the last reset according to the
last standard LonWorks network Query Status
message.

Reset Date Contains the date stamp of the last local Neuron
statistics reset command.

Reset Time Contains the time stamp of the last local Neuron
statistics reset command.

Total Messages
to Device

0 Displays the total number of messages sent to this
controller.

Total Single
Message Failures

0 Displays the total number of failures for single
messages sent to this controller.

Transaction
Timeouts

0 Shows the timeouts that appeared in the last
standard LonWorks network Query Status message.
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Table 119: LON Controller Object Attributes - Diagnostic Tab
Attribute Name Notes Initial Value Description
Transmit Errors 0 Shows the number of transmit errors that appeared

in the last standard LonWorks network Query Status
message.

Version Number 0 Shows the version number according to the last
standard LonWorks network Query Status message.

LON Controller Commands
The following table lists the commands supported by the LON Controller Object.
Table 120: LON Controller Commands
Comman
d Name

Paramete
rs

Description

Clear
Statistics

None Resets the statistics for the integrated LonWorks network. The contents
of the Query Status message reflect these statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Message
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model

Disable None Disables the entire LonWorks network integration. No requests are made
to the field trunk and no data broadcasts to the network are processed.

Enable None Allows the integration to function normally.
Latch
Statistics

None Resets the statistics for the integrated LonWorks network. The contents
of the Query Status message reflect these statistics:

• Transmit Errors
• Transaction Timeouts
• Receive Transaction Full
• Lost Message
• Reset Cause
• Node State
• Version Number
• Error Log
• Neuron Model
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N2 Controller Object
The N2 Controller object defines a physical device such as a DX-9100, VMA, or UNT controller on the
N2 Bus of the NAE and is required for mapping data from the controller into the system. The N2
Controller object monitors the device and reports online/offline transitions. This object also allows
you to access information about the N2 controllers.

N2 Controller Concepts

Supported Controllers
This table lists all N2 controllers supported by the system.
Metasys Integrator units, VAV, UNT, and AHU controllers are supported at all revision levels.
Table 121: Supported Controllers
Device/
Controller Type

Revision Protocol Type Comments

DR-9100 Rev 1.x - 2.x Sys91 Room Controller
DR-9101 Rev 2.x Sys91 Room Controller
DC-9100 Rev 1.x - 2.x Sys91 Plant Controller
DO-9100 Rev 1.x Sys91 Digital Optimizer
DX-9100 (V.1) Rev 1.x Sys91 Digital Controller
DX-9100 (V.2) Rev 2.x Sys91 Digital Controller
TC-9100
TC-9102
TC-9109

Rev 1.x - 3.x Sys91 Temperature Controller

XT-9100 Rev 1.x Sys91 Extension Module
XTM-101 Rev 1.x Sys91 Extension Module
XTM-105 Rev 1.x Sys91 Extension Module
XTM-905 Rev 1.x Sys91 Extension Module
LCP-100 Revs all Sys91 Lab and Central Plant Controller
Metasys
Integrator Unit

Revs all N2 Open Metasys Integrator Unit

UNT Revs all N2 Open Unitary Controller
VAV Revs all N2 Open Variable Air Volume Controller
AHU Revs all N2 Open Air Handling Unit Controller
PHX Revs all N2 Open Phoenix Interface Module
VMA (VMA14) Revs all N2B VAV Modular Assembly
VND N2 Open Metasys Compatible Vendor Devices (by

others)
ILC N2 Other Intelligent Lighting Controller

N2 Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Note: In the Notes column, letters indicate the following: C - Configurable, D - Default
Attribute for Display, N - Value Not Required, R - Affected by Extension’s Reliability, W -
Writable.

Table 122: N2 Controller Object Attributes - Focus/Configuration Tab
Attribute Name Notes Description
Graphic C,N,W Indicates the graphic associated with the N2 controller.
Graphic Alias C,W Indicates a portion of the graphic’s item reference, up to and including the name

of the folder containing this N2 controller.
Offline Indicates if the NAE is or is not currently communicating with this N2 controller.

Present Value D Represents the current communication state of the object.

N2 Controller Commands
The table below lists the commands supported by the N2 Controller Object.
Table 123: N2 Controller Commands
Command
Name

Description

Disable Puts the controller offline and leaves it offline (Comm. Disabled).
Enable Brings the controller from the offline state to the online state (Comm. Enabled).

NCM Object
Create NCM objects by adding NCMs to the system Navigation Tree. The attributes of the NCM
object are read from the NCM device. The NCM object attributes update periodically based on the
poll delay attribute of the parent N1 Migration Object. The NCM object can only be a child object to
the N1 Migration object. Add more NCM objects with the Field Device.
For general information on Metasys system objects, see Common Object Attributes.

NCM Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Table 124: NCM Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

NCM Name -- Engineering
Values
2562 C

Represents the defined name of the NCM as it appears in the
existing N1 network.

Poll Delay -- Engineering
Values
1163 W C

Displays the polling time for non-triggerable attributes in
milliseconds. The poll delay is the time between NIE polls to the N1
network points.

Disable Automatic Alarming
-- Engineering Values
1396 W C

Specifies whether automatic online/offline device event reporting
is disabled (True) or enabled (False). This attribute only applies to
the device and not to the device’s mapped objects. Devices with the
Disable Automatic Alarming attribute set to True suppress the alarm
event but still indicate they are offline in the navigation tree with a
red X. Alarm extensions are not affected by this attribute.
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Table 124: NCM Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Graphic -- Graphic
Association
32581 W C

Indicates the graphic associated with the NCM.

Graphic Alias -- Graphic
Association
32623 W C

Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this NCM.

NCM Commands
The table below lists the command specific to the NCM Object.
Table 125: NCM Object Commands
Command Name Number of Parameters Command Description
Clear Statistics 0 Resets the statistics at the NCM. The Message

Errors, Message Receives, and Message
Transmits attributes reflect these statistics.

VND Controller
The VND (Vendor) Controller object defines a physical vendor device on a bus of the NAE and is
required for mapping data from the controller into the system.

VND Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Table 126: VND Controller Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 W C

If True, allows communication to the vendor device. If False, prevents
communication to the vendor device.

Enabled -- Status
673 W C

If True, allows communication to the vendor device. If False, prevents
communication to the vendor device.

Offline -- Status
913

Displays the offline or online status of connected hardware.

Graphic Alias -- Graphic
Association
32623 W C

Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this vendor device.

Graphic -- Graphic
Association
32581 W C

Indicates the graphic associated with the vendor device.

Wireless Receiver Object
The Wireless Receiver object is the field device of the Wireless Sensor integration. The Wireless
Receiver object establishes communication with the wireless receiver hardware.
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All integrated wireless field devices (Wireless Receiver objects) and field point objects (Wireless
Sensor Object) appear under the Wireless Receiver Supervisor Object in the Navigation Tree.

Note: The Wireless Receiver object not available for network engines updated to Release 9.0.7
or later.

Wireless Receiver Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Table 127: Wireless Receiver Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Network Address -- Setup
875 C

Indicates the network address of the wireless receiver. You can define
only up to 50 wireless receivers per Wireless Receiver Supervisor
Object.

Host Name -- Setup
750 W C

Indicates the host name of the wireless receiver. When a host name is
given, the system attempts to resolve the Host Name and IP Address
using DNS/DHCP (assuming that the installer assigned a host name
to the wireless receiver and enabled DHCP). If the device can be
located using the ping hostname command, the system can resolve
the host name to an IP address. After resolving the host name, the
system updates the IP address.

JCI IP Address -- Setup
1135 W C

Indicates the IP Address of the wireless receiver.

Max Data Life -- Setup
3428 W C

Indicates the maximum amount of time in seconds that the wireless
receiver module waits for a transmission from a wireless sensor
before generating a report that tells the NAE that the Wireless Sensor
Object is unreliable due to Data Life Timeout.

Disable Automatic
Alarming -- Setup
1396 W C

Specifies whether automatic online/offline device event reporting
is disabled (True) or enabled (False). This attribute only applies to
the device and not to the device’s mapped objects. Devices with the
Disable Automatic Alarming attribute set to True suppress the alarm
event but still indicate they are offline in the navigation tree with a
red X. Alarm extensions are not affected by this attribute.

Low Battery -- Status
620

Indicates if any wireless sensors defined as children of the Wireless
Receiver object have a low battery. The Low Battery status is an
advanced warning that can occur many days before a wireless sensor
ceases to function. You can configure an alarm for this attribute to
allow the building operator time to locate the sensor and change the
battery.

Alarm State -- Status
1006

Alarm state occurs when the extension transitions into the high
alarm, low alarm, or unreliable conditions.

Graphic -- Graphic
Association
32581 W C

Indicates the graphic associated with the object.

Graphic Alias -- Graphic
Association
32623 W C

Indicates a portion of the graphic’s item reference, up to and
including the name of the folder containing this object or the
controller containing this point.
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Wireless Sensor Object
There is a Wireless Sensor object in the field point object for each wireless temperature sensor
mapped to the NAE. The Wireless Sensor object receives communications from the wireless sensor.
All integrated wireless field points (Wireless Sensor objects) appear under the Wireless Receiver
Objects (field devices), which appear under the Wireless Receiver Supervisor Object in the
Navigation Tree.

Note: The Wireless Sensor object is not available for network engines updated to Release 9.0.7
or later.

Wireless Sensor Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Table 128: Wireless Sensor Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Occupancy Time -- Control
2193 W C

Indicates the time in minutes that the Occupied Output (if defined)
is overridden to the Occupied state after pushing the Temporary
Occupied button on the Transmitter.

Min Value -- Control
69 W C

Indicates the minimum value allowed for the Setpoint. This is the
value of the Setpoint attribute when the Setpoint adjust dial on the
wireless sensor is in the fully counterclockwise position.
If the Min Value is greater than the Max Value, the Setpoint is forced
to the Min Value. Otherwise, these attributes are all used to compute
the Setpoint with the following formula:
SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Max Value -- Control
65 W C

Indicates the maximum value allowed for the Setpoint. This is the
value of the Setpoint attribute when the Setpoint adjust dial on the
wireless sensor is in the fully clockwise position.
If the Min Value is greater than the Max Value, the Setpoint is forced
to the Min Value. Otherwise, these attributes are all used to compute
the Setpoint with the following formula:
SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Reliability Action -- Control
630 W C

Indicates the action taken on the three output references (Zone Temp
Output, Setpoint Output, and Occupied Output) when the wireless
sensor object goes Unreliable. The actions are No Action or Release
commands.

Time Remaining -- Control
1081

Indicates the time remaining before the Occupied Output (if defined)
is released from the Occupied state.

Units -- Setup
117 W C

Indicates the engineering units displayed on the user interface (Deg F
or Deg C). All temperature and Setpoint values convert to the proper
units.

Offset -- Setup
956 W C

Indicates the offset value that is added to the zone temperature
reading before updating the Present Value, forcing the Present Value
to match a calibrated temperature measured at the wireless sensor.
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Table 128: Wireless Sensor Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Transmitter Id -- Setup
623 W C

Indicates the sensor transmitter Id address of the wireless sensor.
This setting must match the transmitter Id address switch setting of
the wireless sensor.

Property Code -- Setup
624 W C

Indicates the Property Code address of the wireless sensor. This
setting must match the Property Code address switch setting of the
wireless temperature sensor.

Setpoint -- Status
108

Indicates the Setpoint based on three variables: the Setpoint
Adjustment reading (the setpoint adjust dial position) at the wireless
sensor, the Min Value, and the Max Value.
The wireless sensor model determines the Setpoint Adjustment.
Options include:

• None
• Warmer/Cooler (Range = +/- 5 Deg F)
• Remote Setpoint (Range = 55 to 85 Deg F/13 to 29 Deg C)

If the Min Value is greater than the Max Value, the Setpoint is forced
to the Min Value. Otherwise, these attributes are all used to compute
the Setpoint with the following formula:
SP = [(Max Value - Min Value) x (dial position x 0.01)] + Min Value

Occupancy Status -- Status
50210

Changes to Occupied after pushing the Temporary Occupied button
on the Transmitter, if supported by that model. The Occupied state
is held for the minutes defined by the Occupancy Time attribute, or
until cancelled by a release command.

Low Battery -- Status
620

Indicates if any wireless sensors defined as children of the Wireless
Receiver Objects have a low battery. The Low Battery status is an
advanced warning that can occur many days before a wireless sensor
ceases to function. You can configure an alarm for this attribute to
allow the building operator time to locate the sensor and change the
battery. The sensor sends a low battery signal when there is 30 days
of battery life left.

Alarm State -- Status
1006

The Alarm State attribute indicates that the object transitioned into
alarm or unreliable conditions. This attribute does not appear in the
SCT UI.
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Table 128: Wireless Sensor Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Zone Temp Output --
Outputs
634 W C

Provides an optional reference to a temperature input object located
anywhere on the Metasys network. The temperature input object is
commanded when the wireless sensor reports an updated Present
Value.

Note:

The Present Value attribute of the referenced object at the
Priority Scheduling OST priority writes to the output commands.

The Present Value attribute of the referenced object at the
Priority Scheduling OST priority writes the None Data Type value
to the release commands.

These operations assume that the referenced object is an output
object that has a Present Value that can be written to. Keep this
in mind when mapping objects from controllers. You would
normally map these points as input points (AI, BI, MSI), but for
proper operation you must map the points as output points (AO,
BO, MSO).
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Table 128: Wireless Sensor Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Setpoint Output -- Outputs
638 W C

Provides an optional reference to a temperature Setpoint object
located anywhere on the Metasys network. The temperature Setpoint
object is commanded when the wireless sensor reports an updated
Setpoint value.

Note:

The Present Value attribute of the referenced object at the
Priority Scheduling OST priority writes to the output commands.

The Present Value attribute of the referenced object at the
Priority Scheduling OST priority writes the None Data Type value
to the release commands.

These operations assume that the referenced object is an output
object that has a Present Value that can be written to. Keep this
in mind when mapping objects from controllers. You would
normally map these points as input points (AI, BI, MSI), but for
proper operation you must map the points as output points (AO,
BO, MSO).

Occupied Output --
Outputs
640 W C

Provides an optional reference to a binary object located anywhere
on the Metasys network. The binary object is commanded to
Occupied/Unoccupied when the Occupancy Status attribute changes
states.

Note:

The Present Value attribute of the referenced object at the
Priority Scheduling optimal start (OST) priority writes to the
output commands.

The Present Value attribute of the referenced object at the
Priority Scheduling OST priority writes the None Data Type value
to the release commands.

These operations assume that the referenced object is an output
object that has a Present Value that can be written to. Keep this
in mind when mapping objects from controllers. You would
normally map these points as input points (AI, BI, MSI), but for
proper operation you must map the points as output points (AO,
BO, MSO).

XL5K Controller Object
The XL5K Controller object (Honeywell Excel 5000 [XL-5000]) maps a C-Bus field device to the
Metasys system. The object contains pertinent addressing information.

Note: The XL5K Controller object is not available for network engines updated to Release 9.0.7
and later.

XL5K Controller Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
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Table 129: XL5K Controller Attributes
Name / View Group
Attribute ID Writable
(W) Configurable (C)

Attribute Description

Enabled -- Object
673 W C

If True, allows the controller to be integrated into the Metasys system.

Enabled -- Status
673 W C

If True, allows the controller to be integrated into the Metasys system.

Offline -- Status
913

Indicates the offline/online state of the connected hardware.

Graphic -- Graphic
Association
32581 W C

Indicates the graphic associated with the object.

Graphic Alias -- Graphic
Association
32623 W C

Indicates a portion of the graphic’s item reference, up to and including
the name of the folder containing this object or the controller
containing this point.

Field Point
Menu Selection: Insert > Field Point
Inserts one of the following types of field points into a field device under an integration:

• • N2 Trunk
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO)

• • BACnet
All field points listed for the N2 trunk plus Analog Value Object (AV), Averaging Extensions,
Binary Value Object (BV), Calendar Object, Channel Object, Electric Demand Control
Object, Electric Demand Monitoring Object, Event Enrollment Object, Generator Load
Control Object, Group Object, Lighting Output Object, Life Safety Point Object, Life Safety
Zone Object, Multistate Value Object (MV), Notification Class Object, Schedule Object,
Trend Log

• • IP Field Controller
Analog Input Object (AI), Analog Output Object (AO), Analog Value Object (AV),
Accumulator Object, Binary Input Object (BI), Binary Output Object (BO), Binary Value
Object (BV), Calendar Object, Multistate Value Object (MV), Notification Class Object,
Schedule Object, Trend Log

• • MS/TP Field Bus Integration
Analog Input Object (AI), Analog Output Object (AO), Analog Value Object (AV),
Accumulator Object, Binary Input Object (BI), Binary Output Object (BO), Binary Value
Object (BV), Calendar Object, Multistate Value Object (MV), Notification Class Object,
Schedule Object, Trend Log

• • LON Trunk
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO), Generic Integration Object (GIO)
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Note: You can no longer manually add a GIO to a LON trunk; however, the GIO is still
supported in existing databases, even after upgrading to the next software release.

• • N1 Migration
All field points listed for the N2 trunk plus Generic Integration Object (GIO) and N1 PID
Loop Object.

• • VND Integration (Vendor)
Analog Input Object (AI), Analog Output Object (AO), Accumulator Object, Binary Input
Object (BI), Binary Output Object (BO), Multistate Input Object (MI), Multistate Output
Object (MO)

• • Wireless Supervisor Integration
Wireless Sensor Object

• • XL5K (Excel 5000/XL-5000) Integration
XL5K Integration Object

Tip: On the Select Definition Mode screen, select Assisted Point Definition to automatically
discover existing points on the network. Or on the Select Definition Mode screen, select
Manual Point Definition.

Tip: Specifying the Instance Number for a field device point is different depending on if you
are defining the point online or offline with SCT. If you are inserting the point online, you
specify the Instance Number on the Select Data Source screen. If you are inserting the point
offline with SCT, the Select Data Source screen is blank, and you define the Instance Number
on the Configure screen under the Hardware tab, which is two screens later in the Insert Point
wizard.

Tip: When adding a LonWorks point manually, the Target Reference appears blank. Manually
type the path for the Target Reference (path into the controller for the data being mapped by
the object) in the text box on the Select Data Source screen.

Tip: Select the Hardware tab on the Configure screen for further configuration.

See one of the following sections for more information:
• Related Documentation
• N2 Master Datalink Object (N2 Trunk)
• BACnet IP Integration Object
• MS/TP Field Bus Integration Object
• LON Integration Object
• N1 Migration Object
• VND Integration Object
• Wireless Sensor Object
• XL5K Integration Object

Analog Input Object
The AI object processes data from a physical analog input point that resides on a field device and
presents the data to the Metasys system in a consistent format that is independent of the source.
Analog Input Objects appear under the field device object in the All Items navigation tree.
When the source of the data is an analog input in an N2 controller on the N2 Trunk, a Network
Communication Module (NCM) on an integrated N1 network, or an integrated BACnet device, the
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Analog Input Object exchanges data with the native analog object in the source to synchronize
attribute data that are common to both. The source is identified under the hardware tab of the
Analog Input Object.
For general information on Metasys system objects, see Common Object Attributes.

Analog Input Attributes
This object contains attributes common to many Metasys system objects.
Table 130: Analog Input Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Display Precision -- Display
661 W C

Defines the decimal rounding and the decimal places to display for
the Present Value and associated attributes.

Units -- Display
117 C W

Indicates the engineering measurement units used by the object.

COV Increments -- Display
22 W C

Defines the minimum change in the Present Value required for the
object to report a change.

Intrinsic Alarming Defined
-- BACnet
569 W C

Enables the BACnet Intrinsic Alarming feature in the object and the
definition of related attributes. For detailed information, see BACnet
Intrinsic Alarming.

Use Remote Alarming --
BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that
are routed to the NxE. If the remote integrated object does not
contain attributes for originating alarms, then Use Remote Alarming
defaults to False causing the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms from the remote
integrated object are ignored at the NxE. If the value of Use Remote
Alarming is changed, a restart of the NxE may be required to assure
correct operation. This attribute applies only to BACnet integrations.

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the object.

Min Value -- Engineering
Values
69 W C

Defines the lowest reliable value (in engineering units) for the
Present Value.

Max Value -- Engineering
Values
65 W C

Defines the highest reliable value (in engineering units) for the
Present Value.

Analog Output Object
The AO object’s attributes represent the external, visible characteristics of an analog output. This
object integrates N1, N2, and BACnet controllers into supervisory controllers, resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

• flexibility in point mapping

301SCT: System Configuration Tool Help



• permanent update of setpoints in controllers. The user has the ability to write to the
permanent memory of some controllers.

• support for all Metasys controllers
• For example, this object allows you to command a damper to a given position from a

supervisory controller.
For general information on Metasys system objects, see Common Object Attributes.

Analog Output Attributes
This object contains attributes common to many Metasys system objects.
Table 131: Analog Output Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Min Value -- Engineering Values
69 W C

Defines the lowest reliable value (in engineering units) for the
Present Value.

Max Values -- Engineering
Values
65 W C

Defines the highest reliable value (in engineering units) for the
Present Value.

Relinquish Default --
Engineering Values
104 W C

Specifies the default value to be used for the Present Value
attribute when no commands are currently controlling this
object. If this attribute is configured to any value other than
None, the object sends commands for the value immediately.

Units -- Display
117 W

Indicates the engineering measurements units used by the
object.

COV Increment -- Display
22 W

Specifies the minimum change in Present Value required for the
object to report a change.

Display Precision -- Display
661 W C

Defines the decimal rounding and the decimal places to display
of the Present Value and associated attributes.

Use Remote Alarming -- BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that
are routed to the NxE. If the remote integrated object does
not contain attributes for originating alarms, then Use Remote
Alarming defaults to False causing the local mapper object to
originate alarms. When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at the NxE. If
the value of Use Remote Alarming is changed, a restart of the
NxE may be required to assure correct operation. This attribute
applies only to BACnet integrations.
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Table 131: Analog Output Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the BACnet Intrinsic Alarming feature in the object and
the definition of related attributes. For detailed information,
see BACnet Intrinsic Alarming. For more information, refer to
the BACnet Intrinsic Alarming section of the Metasys SMP Help
(LIT-1201793).

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the
object

Analog Value Object
Menu Selection: Insert > Object > AV
Analog Value (AV) objects have similar software characteristics and capabilities to Analog Input
Objects; however, Analog Value objects are not associated with any physical hardware and are
the result of a control process or operator entry. This object allows you to hold an analog value
for other objects to reference. For example, an LON Integration Object can reference and base its
operation on an analog value such as Outdoor Air Temperature Low Limit.
For general information on Metasys objects, see Common Object Attributes.

Analog Value Attributes
This object contains attributes common to many Metasys system objects.
Table 132: Analog Value Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Display Precision -- Display
661 W C

Defines the decimal rounding and the decimal places to display of
the Present Value and associated attributes.

COV Increment -- Display
22 W C

Defines the minimum change in the Present Value required for the
object to report a change.

Units -- Display
117 W C

Reflects the Units attribute of the object referenced by the Present
Value Reference attribute.

Use Remote Alarming --
BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that
are routed to the network engine. If the remote integrated object
does not contain attributes for originating alarms, then Use Remote
Alarming defaults to False causing the local mapper object to
originate alarms. When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at the network
engine. If the value of Use Remote Alarming is changed, a restart
of the network engine may be required to assure correct operation.
This attribute applies only to BACnet integrations.
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Table 132: Analog Value Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the BACnet Intrinsic Alarming feature in the object and
the definition of related attributes. For detailed information, refer
to the BACnet Intrinsic Alarming section of the Metasys SMP Help
(LIT-1201793).

Max Value -- Engineering
Values
65 W C

Defines the highest reliable value (in engineering units) for the
Present Value.
This value is not writable for Analog Value objects in the FEC.
This value is writable if the AV is the ZN-SP on a Net Sensor. This
method is the only way to set the range for the Net Sensor.

Min Value -- Engineering
Values
69 W C

Defines the lowest reliable value (in engineering units) for the
Present Value.
This value is not writable for Analog Value objects in the FEC.
This value is writable if the AV is the ZN-SP on a Net Sensor. This
method is the only way to set the range for the Net Sensor.

Relinquish Default -- Default
104 W C

Specifies the default value to be used for the Present Value attribute
when no commands are currently controlling this object. If this
attribute is configured to any value other than None, the object
sends commands for the value immediately.

Accumulator Object
Menu Selection: Insert > Object > Accumulator
The accumulator object allows you to count pulses, which are often provided by energy meters. The
accumulator objects can feed their Present Values to the Pulse Meter Object.

Note: The Accumulator’s Interface Value updates when the hardware is read by the Pulse
Meter Object or when the hardware’s current value changes.

The following table describes the types of accumulator objects and how to add them to the Metasys
system. The Integration (Device) Type column indicates the type of integration and device in which
the accumulator object resides.
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Table 133: Accumulator Types
Integration
(Device) Type

Description Steps and Tips

IP BACnet
Integration
(BACnet
Device)

Provides integration of BACnet
controllers with supervisory
controllers through a BACnet
accumulator mapper. This object
provides information on the UI
(including Present Value and Scale)
from a BACnet integration with an
accumulator that exists in a BACnet
device.

Note: A BACnet accumulator is
mapped at the engine through
the Insert Point wizard.

To add an accumulator from a BACnet
device on an IP BACnet integration:
1. From the SMP UI or SCT UI, add a

BACnet integration.
2. Add a BACnet device type compatible

with the field device that contains an
accumulator.

3. Map the accumulator at the engine
(that is, add the Accumulator point to
the mapped BACnet device using the
Insert Point wizard).

MS/TP Field
Bus
(BACnet
Device)

Provides integration of BACnet
controllers with supervisory
controllers through a BACnet
accumulator mapper. This object
provides information on the UI
(including Present Value and Scale)
from a BACnet Integration with an
accumulator that exists in a BACnet
device.

Note: A BACnet accumulator is
mapped at the engine through
the Insert Point wizard.

To add an accumulator from a BACnet
device on an MS/TP field bus:
1. From the SMP UI or SCT UI, add an

MS/TP field bus.
2. Add a BACnet device type compatible

with the field device that contains an
accumulator.

3. Map the accumulator at the engine
(that is, add the Accumulator point to
the mapped BACnet device using the
Insert Point wizard).

MS/TP Field
Bus
(FEC Family
BACnet Device)

Provides integration of pulse
meters integrated to the Dry
Contact Pulse (MISC-MTR) binary
input of an FEC family BACnet
device. CCT creates an Accumulator
object for the pulse meter input of
the FEC family BACnet device. This
FEC accumulator is shadowed by
the engine.

Note: An FEC accumulator object
is mapped at the engine through
the Insert Point wizard.

To add an accumulator from an FEC family
BACnet device on an MS/TP field bus:
1. From the SMP UI or SCT UI, add an

MS/TP field bus.
2. Add an FEC family BACnet device

compatible with the field device that
contains a visible accumulator (defined
by CCT).

3. Map the accumulator at the engine
(that is, add the Accumulator point
to the mapped field device using the
Insert Point wizard).
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Table 133: Accumulator Types
Integration
(Device) Type

Description Steps and Tips

N2 Trunk
(N2 Device)

Provides integration of the wide
variety of N2 controller binary
input/pulse counters, resulting
in a consistent interface for point
mapping any N2 controller types.

Note: An N2 accumulator or pulse
counter is mapped at the engine
through the Insert Point wizard.

To add an accumulator from an N2 device
on an N2 trunk:
1. From the SMP UI or SCT UI, add an N2

trunk.
2. Add an N2 device type compatible with

the field device.
3. Map the accumulator (Accumulator

or Pulse Counter type) at the engine
(that is, add the Accumulator point to
the N2 device using the Insert Point
wizard).

4. Define the Rollover Limit:

Note:

You must set the rollover limit in the
N2 accumulator to match the rollover
limit of the N2 field device selected.
For example, AHU or UNT devices
have a rollover limit of 4,294,967,295.
A DX-9100 CNT point has a rollover
limit set by the GX-9100 configuration
tool. An XT-9100 or XTM CNT point
has a rollover limit set by either the
GX-9100 configuration tool or XTM
configuration tool.

Map BI7 or BI8 for an AHU, BI4 for
a UNT or VAV, or ADI network point
types for a DX-9100 or XTM.

Other
Integrations
(For Example,
LonWorks, N1,
VND, and XL5K
Devices)

Allows you to monitor the
increasing pulse count from any
attribute that has an incrementing
value. This provides greater
flexibility for creating accumulator
objects.

Note: An object with an attribute
that has an incrementing value
is mapped at the engine through
the Insert Object wizard.

To add an accumulator from a device on
other integrations:
1. From the SMP UI or SCT UI, add the

desired integration.
2. Add a device type compatible with the

field device.
3. Map the accumulator at the engine

(that is, add the Accumulator object
using the Insert Object wizard).

4. Reference a value that continually
counts up until the value wraps back
to zero when it passes the Rollover
Limit value defined in the accumulator
object.
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The following figure illustrates the interaction between the different types of accumulators and the
accumulator in the engine, showing the key attributes and functionality.

Figure 32: Accumulator Interaction

An FEC family BACnet device that resides on the MS/TP field bus has a binary input with a Dry
Contact Pulse signal (MISC-MTR) created in CCT. This provides an FEC accumulator. A BACnet device
that resides on either the BACnet integration or the MS/TP field bus has an accumulator. Both the
FEC accumulator and BACnet accumulators have BACnet Prescale, Units, and Limit Monitoring
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Interval attributes that interact with the accumulator in the engine through the prescaled Present
Value.
An N2 controller resides on the N2 trunk, and has an attribute that counts. Similarly, other devices
that reside on other integrations (for example, a LonWorks device on a LonWorks integration) that
have attributes that count may take advantage of the accumulator functionality. The accumulator in
the engine uses the count value.
The accumulator in the engine uses the prescaled Present Value or counts from the devices with
the key engine accumulator attributes listed in the figure. For details on the calculations used by
and functionality of these attributes, see the Accumulator Attributes section.
The accumulator’s prescaled Present Value is used by the Pulse Meter, DLLR, or IEIEJ objects. You
can trend the prescaled Present Value, which may then be used by Energy Essentials. You also can
trend the accumulator’s Pulse Rate, Scaled Present Value, or Value Before Change attributes.

Note: The prescaled Present Value, as well as its associated commands and attributes (Preset
Value, Value Before Change, Max Value, Value Set), do not necessarily have the same units as
Scaled Present Value or the Units attribute.

The header of the focus window shows the Scaled Present Value after the scale factor has been
applied to the Present Value, as well as the units that apply to the Scaled Present Value.

Accumulator Attributes
This object contains attributes common to many Metasys system objects.
Notes for Anti Spike:

• Any mapper object used to deliver a raw count value to the Accumulator must provide an
unreliable value during startup if the value was not updated from the field controller at the
time it is read by the accumulator. For example, a LON counter mapped as an AI point object
reports as unreliable until it reads a value from the field controller. If the LON counter is
mapped as an AO point object, it reports as reliable even if the value is not initialized, causing
improper values to be recorded at the accumulator. This may occur regardless of the value of
Anti Spike.

• Any mapper object used to deliver a raw count value to the accumulator must be allowed
to count up without disruption from manual commands, schedules, interlocks, or any other
function that may change its value outside the normal counting process. Any such changes
may cause the Accumulator to record improper values regardless of the value of Anti Spike.

• When replacing the input device, set Anti Spike to True before the replacement is brought
online for the first time. This setting prevents the accumulator value from spiking upward due
to an uncontrolled count value change at the input device. Failure to set Anti Spike to True can
upset the accumulator value. You can use a manual preset to restore the correct value after
the new device is online.
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Table 134: Accumulator Object Attributes
Name / View Group
Attribute ID Writable
(W) Configurable (C)

Attribute Description

Input Ref -- Engineering
Values
545 C

Identifies the attribute reference to the object property that is
the pulse count input for the Accumulator object (for the Other
integrations type: LonWorks, N1, VND, and XL5K, for example). This
must be a continuously increasing positive numeric attribute of
another object, such as the present value of a totalization extension to
an analog meter.

Max Value -- Engineering
Values
65 W C

Indicates the maximum value allowed for the Present Value. The
Present Value is not allowed to exceed this value, and wraps back to
zero when this value is passed. Accumulation does not stop.

Note:  If the present value of the Accumulator object is being trended
and its data is sent to the ADS/ODS repository, change this value to
32,767 so that the historian database (JCIHistorianDB) can properly store
its value.

Limit Monitoring Interval
-- Engineering Values
182 W C

Specifies the monitoring period in seconds for determining the Pulse
Rate. The Pulse Rate is the number of pulses received during the
previous Limit Monitoring Interval period.

Rollover Limit --
Engineering Values
823 W C

Represents the actual rollover value of the input pulse counter. This
attribute applies to N2 and Other Accumulators. This value is used to
compute a change rate, which is added to the Accumulator property to
calculate the Pulse Rate and Present Value.
You must set the rollover limit in the N2 accumulator to match the
rollover limit of the N2 field device selected. For example, AHU or UNT
devices have a rollover limit of 4,294,967,295. A DX-9100 CNT point
has a rollover limit set by the GX-9100 configuration tool. An XT-9100
or XTM CNT point has a rollover limit set by the either the GX-9100
configuration tool or XTM configuration tool.

Units -- Display
117 W C

Contains the engineering units for the Scaled Present Value attribute.

Internal Units -- Display
3432 W C

Contains the engineering units for the Present Value, Value Set, Max
Value, and Value Before Change attribute.

Display Precision --
Display
661 W C

Determines how many decimal places to display in the Scaled Present
Value.
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Table 134: Accumulator Object Attributes
Name / View Group
Attribute ID Writable
(W) Configurable (C)

Attribute Description

Anti Spike -- Filter Setup
722 W C

When True, causes the object to use the first good input count value
received after previously being unreliable as strictly an initial value.
Any archived or last known value for input count is ignored. If the
input device resets or loses power, uncontrolled changes to the input
count value are filtered out and do not result in a spike in accumulator
values. Use this setting in cases where the input device is not known to
preserve its count value over a power loss (for example, in a LonWorks
integration an LN-PRG20 GPI, and in an N2 integration a UNT).
When False, causes the object to use the first good input device count
value received after previously being unreliable as a valid change
from the archived or last known value for input count. This means
the first good input device value is used to catch up on any counts
that were missed while the input device was unable to communicate
due to either an NAE restart or communication loss. Do not set this
value to False unless the input device is known to preserve its count
value during a power loss (for example, in an N2 integration, an
XTM-105 with a XPB-821 or in a LonWorks integration LN-PRG300-2,
LNPRG400-2, LN-PTRG500-2, LN-PRG600, or in a vendor integration
BTR Netcom GmbH device LC14 [Model # 11045013-US], an IDEC SX5L-
SBCN081, or a WATANBE Electric Industry WRBC-DI16F-A002).

Notes:

• Any mapper object used to deliver a raw count value to the
Accumulator must provide an unreliable value during startup
if the value was not updated from the field controller at
the time it is read by the accumulator. For example, a LON
counter mapped as an AI point object reports as unreliable
until it reads a value from the field controller. If the LON
counter is mapped as an AO point object, it reports as reliable
even if the value is not initialized, causing improper values to
be recorded at the accumulator. This may occur regardless of
the value of Anti Spike.

• Any mapper object used to deliver a raw count value to
the accumulator must be allowed to count up without
disruption from manual commands, schedules, interlocks,
or any other function that may change its value outside the
normal counting process. Any such changes may cause the
Accumulator to record improper values regardless of the
value of Anti Spike.

• When replacing the input device, set Anti Spike to True
before the replacement is brought online for the first time.
This setting prevents the accumulator value from spiking
upward due to an uncontrolled count value change at the
input device. Failure to set Anti Spike to True can upset the
accumulator value. You can use a manual preset to restore
the correct value after the new device is online.
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Table 134: Accumulator Object Attributes
Name / View Group
Attribute ID Writable
(W) Configurable (C)

Attribute Description

Intrinsic Alarming
Defined -- BACnet
569 W C

Indicates whether intrinsic alarming is enabled when the site is defined
as a BACnet site. When intrinsic alarming is defined for accumulators
on the MS/TP field bus, the pulse rate of the accumulated point can be
monitored.

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the object.

Use Remote Alarming --
BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then Use
Remote Alarming defaults to True, causing the local mapper object to
accept alarms from the remote integrated object that are routed to
the NxE. If the remote integrated object does not contain attributes
for originating alarms, then Use Remote Alarming defaults to False
causing the local mapper object to originate alarms. When Use Remote
Alarming is false, any alarms from the remote integrated object are
ignored at the NxE. If the value of Use Remote Alarming is changed, a
restart of the NxE may be required to assure correct operation.

Scale As Integer -- Scale
4692 W C

Indicates the power of ten to be multiplied with the value of the
Present Value attribute to get Scaled Present Value. This attribute only
applies if Scale As Float is zero. For example, when Scale As Integer is
set to two, the Present Value is multiplied by 100; while setting Scale
As Integer to -1 multiplies the Present Value by 0.1. When zero (the
default value), the Present Value and Scaled Present Value are equal
(see Scaled Present Value).

Scale As Float -- Scale
4693 W C

Indicates the floating conversion factor to be multiplied with the value
of the Present Value attribute to calculate the Scaled Present Value for
the chosen units. If set to zero (the default value), the Scale As Integer
value is used and Scale As Float is ignored.

JCI Logging Object
Reference -- Logging
4696 W C

Indicates the object (Johnson Controls proprietary reference) that
resides in the same device as the Accumulator object which, when it
acquires Logging Record data from the Accumulator object, causes the
Accumulator object to acquire, present, and store the Logging Record
data (that is, snapshot) from the underlying system. When the object
specified by the Logging Object Reference issues the Get Monitor Data
command, the Logging Record is acquired and updated.

Binary Input Object
The BI object’s attributes represent the external, visible characteristics of a binary input. As a
binary input, this object can be in either an Active or Inactive state. The Polarity attribute allows for
normally open relays that are Active when energized and normally closed relays that are Inactive
when energized.
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The Binary Input object integrates N1, N2, and BACnet controllers into supervisory controllers,
resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

• flexibility in point mapping
• support for all Metasys controllers. See the N2 Controller Object section.

For example, this object allows you to map a fan status into a supervisory controller.
For general information on Metasys system objects, see Common Object Attributes.

Binary Input Concepts

BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is
determined by the Polarity attribute.
The table below describes this relationship as defined by BACnet standards. Johnson Controls
Polarity is always Normal. Johnson Controls N2 protocol does not support changes to the Polarity
attribute.
Table 135: BACnet Polarity Relationships
Present Value Polarity Physical State of the

Hardware Input
Physical State of the
Monitored Device

Inactive Normal Off or Inactive not running
Active Normal On or Active running
Inactive Reverse On or Active not running
Active Reverse Off or Inactive running

Binary Input Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Table 136: Binary Input Object Attributes
Name / View Group Attribute Description

Elapsed Active Time --
Engineering Values
33 W C Attribute ID Writable
(W) Configurable (C)

Represents the accumulated number of seconds Preset Value is
Active since the Elapsed Active Time attribute was most recently
set to zero. This attribute value updates automatically a minimum
of once a day.

Attribute ID Writable
(W)Active Time Reset --
Engineering Values
114

Represents the last date and time Elapsed Active Time was set to
a zero value. If either Elapsed Active Time or Time of Active Time
Reset is present, all are present.

State Count Reset --
Engineering Values
115

Represents the date and time the COS Count attribute was most
recently set to a zero value. If COS Time or Change of State Count
is present, both are present.
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Table 136: Binary Input Object Attributes
Name / View Group Attribute Description

COS Count -- Engineering
Values
15 W

Represents the number of times the Present Value attribute
changes state since the COS Count attribute was most recently set
to zero. A change of state is any event that alters Present Value.
This attribute persists in the archive.

COS Time -- Engineering
Values
16

Represents the date and time at which the most recent change
of state occurred. A change of state is any event that alters the
Present Value attribute. When Out of Service is False, a change
to the Polarity attribute alters Present Value and is considered a
change of state. When Out of Service is True, changes to Polarity
do not cause changes of state.

States Text -- Display
931 W C

Indicates the displayed strings for the Present Value.

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the
object.

Use Remote Alarming --
BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that are
routed to the NxE. If the remote integrated object does not contain
attributes for originating alarms, then Use Remote Alarming
defaults to False causing the local mapper object to originate
alarms. When Use Remote Alarming is false, any alarms from the
remote integrated object are ignored at the NxE. If the value of
Use Remote Alarming is changed, a restart of the NxE may be
required to assure correct operation. This attribute applies only to
BACnet integrations.

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the BACnet Intrinsic Alarming feature in the object and the
definition of related attributes.

Binary Output Object
The BO object’s attributes represent the external, visible characteristics of a binary output. As a
binary output, this object can be in either an Active or Inactive state. The Polarity attribute allows
for normally open relays that are Active when energized and normally closed relays that are
Inactive when energized. This object integrates N1, N2, and BACnet controllers into supervisory
controllers, resulting in:

• a consistent interface to point objects for all controller types, so they appear as a homogenous
set to the user interface

• flexibility in point mapping
• support for all Metasys controllers. See N2 Controller Object.

For example, this object allows you to start or stop a fan from a supervisory controller.
For general information on Metasys system objects, see Common Object Attributes.
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Binary Output Concepts

BACnet Polarity Relationships
The relationship between the Present Value of an object and the physical state of the object is
determined by the Polarity attribute.

Note: The table below describes this relationship as defined by BACnet standards. Johnson
Controls Polarity is always Normal. Johnson Controls does not support changes to the Polarity
attribute.

Table 137: BACnet Polarity Relationships
Present Value Polarity Physical State of the

Hardware Input
Physical State of the
Monitored Device

Inactive Normal Off or Inactive not running
Active Normal On or Active running
Inactive Reverse On or Active not running
Active Reverse Off or Inactive running

Binary Output Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Table 138: Binary Output Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Min Off Time -- Engineering
Values
66 W C

Represents the fewest number of seconds Present Value remains in
the Inactive state after entering the Inactive state.

Min On Time -- Engineering
Values
67 W C

Represents the fewest number of seconds Present Value remains in
the Active state after entering the Active state.

Heavy Equip Delay --
Engineering Values
516 W C

Indicates the amount of time that this output point adds to the
Accumulated Delay attribute of the Heavy Equipment Controller
(HEC) object when this point is started. The next output point is
delayed by that amount of time of the HEC Accumulated Delay is
not already decremented to zero.
The NAE device’s five internal Heavy Equipment Controller objects
time their delays independently of one another. For example, HED 1
and HED 4 can count down their delays at the same time.
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Table 138: Binary Output Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

HED Controller --
Engineering Values
517 W C

Identifies the Heavy Equipment Controller (HEC) object managing
the delays.
The NAE device has five internal Heavy Equipment Controller
objects for use by BO and Multistate Output (MO) objects. The
BO and MO objects reference the heavy equipment delay (HED)
controller objects by number (1-5).
All BO and MO objects on an NAE share the five internal HED
controller objects. For example, if BO1 and MO3 on NAE-1 reference
HED controller 1, they are using the same HED controller.

States Text -- Display
931 W C

Indicates the displayed strings for the Present Value.

Use Remote Alarming --
Object
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that are
routed to the NxE. If the remote integrated object does not contain
attributes for originating alarms, then Use Remote Alarming
defaults to False causing the local mapper object to originate
alarms. When Use Remote Alarming is false, any alarms from the
remote integrated object are ignored at the NxE. If the value of Use
Remote Alarming is changed, a restart of the NxE may be required
to assure correct operation. This attribute applies only to BACnet
integrations.

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the
object.

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the definition of the intrinsic alarm related attributes.

Binary Value Object
Menu Selection: Insert > Object > BV
BV objects have similar software characteristics and capabilities to a Binary Input Object; however,
Binary Value objects are not associated with any physical hardware and are the result of a control
process or operator entry. This object allows you to hold a binary value for other objects to
reference. For example, an Interlock can reference and base its operation on a binary value such as
duty/standby.
For general information on Metasys system objects, see Common Object Attributes.

Binary Value Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
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Table 139: Binary Value Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

States Text -- Display
931 W C

Indicates the displayed strings for the Present Value. For BACnet
compliant objects, if no States Text is specified when the object is
created, the Inactive Text and Active Text are used to derive the
equivalent States Text if possible.

Use Remote Alarming --
Object
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that
are routed to the NxE. If the remote integrated object does not
contain attributes for originating alarms, then Use Remote Alarming
defaults to False causing the local mapper object to originate
alarms. When Use Remote Alarming is false, any alarms from the
remote integrated object are ignored at the NxE. If the value of Use
Remote Alarming is changed, a restart of the NxE may be required
to assure correct operation. This attribute applies only to BACnet
integrations.

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the definition of the intrinsic alarm related attributes.

Min Off Time -- Engineering
Values
66 W C

Represents the least number of seconds Present Value remains in
the Inactive state after entering the Inactive state.

Min On Time -- Engineering
Values
67 W C

Represents the least number of seconds Present Value remains in
the Active state after entering the Active state.

Restore Command Priority --
Restart Options
721 W C

Selects which commands (at a selected priority) persist through
a device restart. When the bit is set, the command (at a selected
priority) is saved at shutdown and restored at startup.

Relinquish Default -- Default
State
104 W C

Specifies the default value to be used for the Present Value attribute
when no commands are currently controlling this object. If this
attribute is configured to any value other than None, the object
sends commands for the value immediately.

Calendar Object
Menu Selection: Insert > Object > Calendar
The Calendar object is used behind the scenes by the Scheduling feature by maintaining a list of
dates designated as exceptions to the normal schedule. Exception Schedule days are days when
you do not want the Schedule to operate, such as holidays. They can be defined as specific dates or
ranges of dates. Typically, a Schedule object references a Calendar object, which lists the days the
weekly schedule should not operate. A Schedule object working from a chosen Calendar reads the
Present Value of the Calendar object, which indicates if the current day is within the Date List (Entry
Detail) of the Calendar.
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A different set of activities from those in the weekly schedule can be defined in the Schedule object
to occur on these exception days. Multiple Schedule objects can reference a single Calendar object
so that only the Calendar object needs to be changed to affect all schedules.
This object allows you to accommodate for a special day or days, like a holiday, in which the
building controls should run differently from usual, in accordance with the change in the number of
people and the amount of activity in the building.
When you create a Calendar object at a BACnet client and map the object to a network engine, a
new Calendar object is created under that folder in the navigation tree.
For general information on Metasys system objects, see Common Object Attributes.
For more information on the Scheduling feature and how to create a calendar, refer to the
Scheduling section in the Metasys SMP Help (LIT-1201793). For more information on Global Calendars,
refer to the Global Calendar section in the Metasys SMP Help (LIT-1201793). For detailed information
on the Calendar object, see the following table.

Calendar Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the Notes and BACnet Notes columns, attributes marked with the letter C are
configurable, attributes marked with the letter D are the default for display, and attributes
marked with the letter W are writable.

Table 140: Calendar Attributes - Calendar Tab
Attribute Name Notes BACnet Notes Initial Value Description
Date List (Entry Detail) C,W W Lists dates defined as entries to the Calendar object.

Each entry is either an individual date, range of
dates, or month/week-of-month/day-of-week
specification. If the current date matches any
calendar entry, the Present Value is set to True. Also,
individual fields of an entry can be left unspecified,
thus acting as wildcards, or include all options. If a
device allows writing to Date List, all date choices are
permitted.

Global Calendar Object
Reference

C,W W Specifies a globally referenced calendar (if any)
used as the master calendar for the site. Specifying
a global calendar allows a site to synchronize
many calendars so that only a single calendar
(master calendar) needs to be changed. If you are
using calendar references, you usually set up field
controllers that reference a calendar on the engine,
and engines that reference a calendar on a single
supervisory engine, which is designated as the
master calendar.
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Table 140: Calendar Attributes - Calendar Tab
Attribute Name Notes BACnet Notes Initial Value Description
Global Calendar Update Specifies a time and date when the local calendar

date list was last updated from the master calendar.
If no calendar is referenced by the device, then the
global calendar update remains unspecified.

Note: If a calendar references a master
calendar, the date list is not writable and the
Edit button within the SMP UI is unavailable.

Present Value D D False Indicates the current value of the Calendar. Present
Value is True if the current date is in the Date List
(Entry Detail) and False if the current date is not in
the Date List.

Date List (Entry Detail)
Lists dates defined as entries to the Calendar object. Each entry is either an individual date, range
of dates, or month/week-of-month/day-of-week specification. If the current date matches any
calendar entry, the Present Value is set to True. Also, individual fields of an entry can be left
unspecified, thus acting as Wildcards, or include all options. If a device allows writing to Date List, all
date choices are permitted.

Global Calendar Object Reference
Specifies a globally referenced calendar (if any) used as the master calendar for the site. Specifying
a global calendar allows a site to synchronize many calendars so that only a single calendar (master
calendar) needs to be changed. If you are using calendar references, you usually set up field
controllers that reference a calendar on the engine, and engines that reference a calendar on a
single supervisory engine, which is designated as the master calendar.

Global Calendar Update
Specifies a time and date when the local calendar date list was last updated from the master
calendar. If no calendar is referenced by the device, then the global calendar update remains
unspecified.

Note: If a calendar references a master calendar, the date list is not writable and the Edit
button within the SMP UI is unavailable.

Channel Object
Menu Selection: Insert > Object > Channel
The Channel object allows a third-party BACnet workstation to represent a Channel object in a
BACnet field controller. The Channel object allows for the efficient adjustment of lighting brightness
values to multiple lighting controllers. For example, with the Channel object, you can create logic in
a BACnet field controller to turn lights on based on the state of occupancy sensors provided by the
BACnet-based lighting system.

Channel Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab for this object. See the Object and Feature Tabs section for information on
the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).
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Table 141: Channel Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Object Identifier -- BACnet
75 C

Indicates the instance number of the Object Type used in the
BACnet Object ID as exposed to a BACnet network. The object ID
must be unique within the host device. The object ID of the Device
object must be unique within the BACnet network.

User Name Is BACnet Obj
Name -- BACnet
1092 W C

Controls whether the object’s User Name attribute is also the
Object Name attribute. The Object Name attribute is not writable,
so the only way to change the Object Name attribute is to edit the
User Name attribute and set the User Name Is BACnet Obj Name
attribute to True.

Event Enrollment Object
Menu Selection: Insert > Object > Event Enrollment
The Event Enrollment object’s attributes represent and contain information for managing
events. Events are changes in the value or state of an object that meet specific criteria. The Event
Enrollment object defines the event criteria and provides a connection between an event and a
notification message sent to recipients. A recipient device is enrolled for notification if:

• it is one of the recipients in a Notification Class Object referenced by the Event Enrollment
object

• a Notification Class object is not referenced and it is the recipient of the Event Enrollment
object

When you create an Event Enrollment object at a network engine using a BACnet client, a new Event
Enrollment object is created under that folder in the navigation tree.

Event Enrollment Concepts

Event Relationships
Event Types, Event States, and Event Parameters are interrelated attributes.

Note: Any Event Type generates a Fault Event State if the object referenced in the Object
Property Reference becomes unreliable and the Object Property Ref attribute is linked to
Reliability.

Table 142: Event Relationships
Event Type Event State Event Parameters
Change of Bitstring Normal

Offnormal
Time Delay
Bitmask
List of Bitstring Values

Change of Character String Normal
Offnormal

Time Delay
List of Values

Change of State Normal
Offnormal

Time Delay
List of Values
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Table 142: Event Relationships
Event Type Event State Event Parameters
Change of Value (COV) Normal Time Delay

Bitmask
COV Increment

Note: Only one of either the Bitmask or the
COV Increment property is used.

Command Failure Normal
Offnormal

Time Delay
Feedback Property Reference

Double Out of Range Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Floating Limit Normal
High Limit
Low Limit

Time Delay
Setpoint Reference
Low Diff Limit
Hi Diff Limit
Deadband

Out of Range Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Signed Out of Range Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Unsigned Out of Range Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit
Deadband

Unsigned Range Normal
High Limit
Low Limit

Time Delay
Low Limit
High Limit

Event Parameters
The table below lists the parameters in the Event Parameters attribute. For a description of the
algorithms to which these parameters apply, refer to ANSI/ASHRAE BACnet Standard 135 - 1995.
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Table 143: Event Parameters
Parameter Description
Bitmask This parameter applies to the Change of Bitstring event algorithm and

the Change of Value event algorithm in the special case where the
referenced attribute is a Bit String data type. It represents a bitmask
that is used to indicate which bits in the referenced attribute are
monitored by the algorithm. A value of one in a bit position indicates
that the bit in this position in the referenced attribute is monitored
by the algorithm. A value of zero in a bit position indicates that the
bit in this position in the referenced attribute is not significant for the
purpose of detecting this Change of Bitstring or Change of Value.

Deadband
High Diff Limit
Low Diff Limit
High Limit
Low Limit

These parameters apply to these event algorithms: Signed Out of
Range, Unsigned Out of Range, Unsigned Range, Floating Limit, Out
of Range, Double Out of Range. The only exception is that Deadband
does not apply to Unsigned Range.

Feedback Property
Reference

This parameter (BACnet Object Property Reference) applies to the
Command Failure algorithm. Feedback Property Reference identifies
the object and attribute that provides the feedback to ensure that the
commanded attribute changes value. This attribute may reference
only object properties that have lists of true and false values.

List of Bitstring Values This is a list that applies to the Change of Bitstring event algorithm.
This list defines the set of states for which the referenced attribute
is Offnormal. Only the bits indicated by the Bitmask are significant.
If the value of the referenced attribute changes to one of the values
in the List of Bitstring Values, then the Event State attribute of the
Event Enrollment object makes a transition To Offnormal and sends
the appropriate notifications.

List of Values This is a list of BACnet Property States that applies to the Change of
State event algorithm. This event algorithm applies to referenced
properties that have discrete or lists of values. The List of Values is
a subset of the possible values that the attribute may have. If the
value of the referenced attribute changes to one of the values in the
List of Values, then the Event State attribute of the Event Enrollment
object makes a transition to To Offnormal and sends the appropriate
notifications.

COV Increment This parameter applies to the Change of Value event algorithm. It
represents the increment by which the referenced attribute must
change in order for the event to occur.

Setpoint Reference This parameter (BACnet Object Property Reference), applies to the
Floating Limit event algorithm. Setpoint Reference indicates the
setpoint reference for the reference attribute interval.

Time Delay This parameter applies to all event types and represents the seconds
that the conditions monitored by the event algorithm persist before
an event notification is issued.

Referenced Property
Increment

This parameter represents the increment by which the referenced
property must change for an event to occur.
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Event Enrollment Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).

Note: In the Notes and BACnet Notes columns, attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.

Table 144: Event Enrollment Object Attributes - Focus/Configuration Tab
Attribute Name Notes BACnet

Notes
Description

Acked Transitions Conveys three separate flags that each indicate if the most recent To Offnormal,
To Fault, and To Normal event transitions have been acknowledged (if the
transition requires acknowledgement).

Alarm Message
Text

C,W Contains the user-defined text included with the event notification. Starting at
Release 10.0, this attribute is replaced by Event Message Texts Config. The
value of this attribute is kept in sync with the first element of the Event Message
Texts Config attribute. Any modification to either one changes the other. Also,
for upgraded systems that use Alarm Message Text, any text in this field is
moved to the first element of the Event Message Texts Config field.

Event Detection
Enable

Indicates if event detection and reporting is enabled for the Event Enrollment
object. This is a read-only attribute that is always set to True.

Event Enable C,W W Conveys three flags that determine if notifications are enabled for To Offnormal,
To Fault, and To Normal transitions. When a flag is set, this means that the
corresponding transition causes notification to be sent to all enrolled devices.
When a flag is cleared, this means that the corresponding transition is not
reported. The object’s Event State continuously updates, regardless of the value
of the Event Enable attribute.

Event Message
Texts

An array of three character strings that holds the message texts that identify
the last state of the Event Enrollment object. The states in sequential order are:
TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL. If a particular event is yet to
occur, the respective entry in the array is blank (null).

Event Message
Texts Config

An array of three character strings that defines the message texts used to
identify the last state of the Event Enrollment object. The states in sequential
order are: TO_OFF_NORMAL, TO_FAULT, and TO_NORMAL, which you may
customize by entering text in each field. The first element of this attribute is kept
in sync with the Alarm Message Text attribute so that any modification to either
one changes the other. Starting at Release 10.0, use this attribute instead of
Alarm Message Text.

Event State Indicates the current state of the event. The permitted values for Event State are
specific to the Event Type. The value of Event State is independent of the Event
Enable flags.

Event Time
Stamps

Conveys the times of the last event notifications for To Offnormal, To Fault, and
To Normal events.

Execution Priority C,W C,W Indicates the relative importance of performing the function of the object within
the device.

Graphic C,W C,W Indicates the graphic associated with the object.
Graphic Alias C,W C,W Indicates a portion of the graphic’s item reference, up to and including the

name of the folder containing this object or the controller containing this point.
Notification Object
Reference

C,W W Specifies the notification class used when handling and generating event
notifications for the object. This attribute implicitly refers to the Notification
Class Object that has a Notification Class attribute of the same value.

Note: The Notification Class attribute is used if the Recipient attribute is
not used. As best practice, use the Notification Class attribute.
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Table 144: Event Enrollment Object Attributes - Focus/Configuration Tab
Attribute Name Notes BACnet

Notes
Description

Notify Type C,W W Conveys if the notifications generated by the object are Events or Alarms.
Reliability W W Specifies the current reliability of the event enrollment object. Possible values:

No Fault Detected (reliable), Communication Failure, and Configuration Error.

Table 145: Event Enrollment Object Attributes - Event Tab
Attribute
Name

Flags BACnet
Notes

Values/Options/Range

Event
Parameters

C,W W Determines the method used to monitor the referenced object. This attribute
provides the parameter values used for the algorithm.

Event Type C Indicates the type of event algorithm used to detect events and report to enrolled
devices. See the BACnet standard for more information on algorithms. See Table
146 and Event Relationships for more information on the event types.

Object
Property
Ref (Input
Reference)

C Designates the particular object and attribute referenced by the Event Enrollment
object. This attribute applies the algorithm specified by Event Type to the referenced
attribute to determine the Event State.

Table 146: Event Types
Event Type Description
Change of
Bitstring

Generates an off-normal transition when the value of the referenced property
is equal to one of the user-defined Bitstring Values (List Elements after applying
the Bitmask) and the values are equal for the amount of seconds defined by the
Time Delay attribute you’re using. The Bitmask defines the bits important for
monitoring.

Change of
Character
String

Generates an off-normal transition when the value of the referenced property
includes one of the values in the List of Values (List Elements) and the values are
equal for the number of seconds defined by the Time Delay parameter.

Change of
State

Generates an off-normal transition when the value of the referenced property
(Input Reference) is equal to one of the values in the List of Values (List Elements)
and the values are equal for the number of seconds defined by the Time Delay
attribute of the object you’re using.

Change of
Value

Generates a normal transition when the value of the referenced property (Input
Reference) changes by an amount equal to or greater than the referenced
property increment (Change of Value [COV] Increment) for the number of
seconds defined by the Time Delay attribute of the object you’re using.

Command
Failure

Generates an off-normal transition if the values of the referenced property (Input
Reference) and the Feedback Reference are not equal for a time greater than
the number of seconds defined by the Time Delay attribute of the object you’re
using.

Double Out of
Range

Generates a transition to high limit alarm if the value of the referenced property
is higher than the High Limit for a time greater than the number of seconds
defined by the Time Delay parameter. This event type accepts a double data type.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the Low Limit for a time greater than the number of seconds
defined by the Time Delay parameter. This event type accepts a double data type.
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Table 146: Event Types
Event Type Description
Floating Limit Generates a transition to high limit alarm if the value of the referenced property

is higher than the range of values determined by the current values of the
Setpoint Reference, High Limit and Deadband for a time greater than the number
of seconds defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the
Setpoint Reference, Low Limit, and Deadband for a time greater than the number
of seconds defined by the Time Delay parameter.

Out of Range Generates a transition to high limit alarm if the value of the referenced property
is higher than the range of values determined by the current values of the High
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the Low
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.

Signed Out of
Range

Generates a transition to high limit alarm if the value of the referenced property
is higher than the range of values determined by the current values of the High
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.
Generates a transition to low limit alarm if the value of the referenced property
is lower than the range of values determined by the current values of the Low
Limit and Deadband for a time greater than the number of seconds defined by
the Time Delay parameter.

Unsigned
Range

Generates a transition to high limit alarm if the value of the reference property
is higher than the range of values determined by the High Limit for a time
greater than the number of seconds defined by the Time Delay parameter.
Generates a transition to low limit alarm if the value of the reference property
is lower than the range of values determined by the Low Limit for a time greater
than the number of seconds defined by the Time Delay parameter.

Group Object
Menu Selection: Insert > Object > Group
Notes:

• Click the Add button to select the items belonging to this group from the Select Item dialog
box.

• Click the item in the group list and use the up and down arrows to move the item in the list.
• Click the item in the group list and click Remove to remove the item from the group.
• Do not add a Group object to an equipment definition for the Metasys UI. The Metasys UI does

not support the Group object.
The Group object’s attributes represent a collection of other objects and one or more of their
attributes. This object provides the user with the ability to customize the organization of objects
within the site. The Group object simplifies the exchange of information between objects by
calling all members of the group at once. A group consists of any combination of object types. For
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example, you can use the Group object to monitor the temperature in different rooms throughout a
floor of a building.
For general information on Metasys system objects, see Common Object Attributes.
For detailed information on the Group object, see Group Attributes.

Group Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the Notes columns, attributes marked with the letter C are configurable, and
attributes marked with the letter W are writable. For more information about attribute
characteristics, see Attributes.

Table 147: Group Object Attributes - Group Tab
Attribute Name Notes BACnet

Notes
Initial Value Description

List of Group
Members

C,W W Contains the references (Input
References) that define the members of
the group. These group members are
referenced during a transaction. The
list of group members consists of two
parts:

• Object ID
• Element

All members of the group are objects
that reside in the same device that
maintains the Group object. Nesting
is not allowed. This attribute is only
shown in the Snapshot view.

Present Value Lists the values of all the attributes
specified in the List of Group Members.
This is a read-only attribute; it cannot
be used to write a set of values to the
members of the group. The Present
Value list reconstructs each time
the attribute is read by fetching the
member attributes. This attribute is
only shown in the Snapshot view.

IEIEJ BACnet System Objects
IEIEJ BACnet System Objects comply to the Institute of Electrical Installation Engineers of Japan
(IEIEJ) Standard Protocol based on BACnet specifications. Use these objects to comply with these
guidelines.
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For more information on IEIEJ BACnet System Objects, click one of the following:
• Electric Demand Monitoring Object
• Generator Load Control Object
• Electric Demand Control Object

IEIEJ BACnet System Object Descriptions

Electric Demand Monitoring Object
Menu Selection: Insert > Object > Electric Demand Monitoring
The Electric Demand Monitoring Object is a specialized object that monitors the power
consumption in a fixed 30-minute window. This object uses an Accumulator or Analog Input and
calculates the demand every minute. The object calculates a projected demand for the end of
the 30-minute window, and compares that demand value to the target demand. If the projected
demand value exceeds the target demand value, the object triggers an alarm notification. The
default view of the object is a graph of the demand values.

Note: In the Notes column, letters indicate the following: A - Archive, C - Configurable, D -
Default Attribute, F - PMI Refreshing R - Associate with Reliability, W - Writable.

Note: In the BACnet Notes column, letters indicate the following: O - BACnet optional property,
P - BACnet proprietary property, Q- BACnet required property.

Table 148: Electric Demand Monitoring Object Attributes
Attribute
Name

Notes BACnet
Notes

Initial Value Values\Options
\Range

Description

Present Value D,F,R Q 1 1=Normal
2=Alarm Level 1
3=Alarm Level 2

For the Electric Demand Monitoring object, the
Present Value displays the present demand
alarm level. There are three states:
- Normal State (no alarm generated)
- Alarm level 1
- Alarm level 2

Contract
Receiving
Power

W,C,A Q 0 0.0 kW to 99999.9
kW

This attribute represents the electric power
contracted from a power company as a value of
electric energy of 60 minutes.

Alarm Value
of Power

W,C,A Q 0 0.0 kW to 99999.9
kW

This attribute shows the alarm value of electric
power as a value of electric energy of 60
minutes. If this value is exceeded, the Present
Value becomes 3 and generates alarm level 2.

Target Value
of Power

W,C,A Q 0 0.0 kW to 99999.9
kW

This attribute shows the electric power that can
be supplied by a generator as a value of electric
energy of 60 minutes. If this value is exceeded,
the Present Value becomes 2 and generates
demand alarm level 1.

Units W,C,A Q kW Default - kW This attribute represents the engineering unit of
all real type properties that show electric energy.

JCI List of
Pulse Counter
Reference

C,A O Null Pulse Attributes
reference PV
of (AI, AV, or
Accumulator)

This attribute indicates the references to electric
power Pulse input devices. This reference can
be either an Accumulator, an AV, or an N2 Pulse
Counter object.
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Table 148: Electric Demand Monitoring Object Attributes
Time Synchro-
nization Mode

W,C,A P Internal
Normal

1=External
2=Internal Normal
(0 min, 30min)
3=Internal Custom
(arbitrary)

This displays three modes:
External: If the external signal is Pulse type, the
demand interval stops and starts whenever a
Pulse is received. If the external signal is Analog,
the demand interval stops and starts when the
value changes (increments or decrements).
Internal Normal: When the time is XX:00:00 and
XX:30:00, demand timing will stop and start.
Internal Custom: Demand interval begins after
startup of an NAE, the addition of the object, or
when a demand reset command is issued. The
demand interval stops and starts 30 minutes
from the starting time. For example, if it stops
and starts at XX:12:03, then it will stop and start
next at XX:42:03.

Time to Mask W,C,A P 5 0 min to 25 min This attribute indicates the time that is not
treated as an alarm even if the measured value
exceeds an Alarm Value of Power or Target
Value of Power after starting the demand
monitoring of a 30-minute-period.

EOI Object C,A P If operating in External mode, refer to the AI, AV,
or BI object to input the external interval signal.
Only this property is configurable.

Input Mode W,C,A P Pulse 1=Pulse(PI)
2=Analog(AI or AV)

This attribute switches the reference input signal
between Pulse signal such as PI, and Analog
signal such as AI and AV. When input mode is
Analog, any change of value is an EOI. In Pulse
mode (typically BI), only transitions to True are
EOI pulses.

JPN Rate
Constant

W,C,A P 50,000 0 to 50,000 The numeric value that is input onto a Pulse
object is the electric energy. Set a constant to
multiply.

Pulse
Constant

W,C,A P 100 0 to 50,000 The numeric value that is input onto a Pulse
object is the electric energy. Set a constant to
multiply.

Rollover Limit 0 This attribute specifies the highest counter value
before the Pulse Counter rolls over to zero.

Reliability
Time Interval

Q 1 0 min to 30 min For the Electric Demand Monitoring (EDM)
object, power usage is calculated from the
difference between one minute previous and the
value of JCI List of Pulse Counter Reference.
If the difference in usage is zero, recognize it as
an input error and set the status to unreliable.
However, even when the object is normal, this
property remains active, because the reliability
check is masked if the power usage is low and
the difference in usage is zero.
In addition, EDM is unreliable if the mask time
is set with this property, because the difference
in calculation is reset in a 30 minute period. If
it is unreliable at the start of 30 minutes, EDM
becomes unreliable. That is, it is unmasked at
the start time, for example HH:00 or HH:30, and
becomes unreliable.
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Generator Load Control Object
Menu Selection: Insert > Object > Generator Load Control
This object is similar to the Electric Demand Control Object but specifically controls the loads on a
backup generator. A given generator can supply a fixed maximum amount of power. A reference to
the current load on the generator and the value of the maximum generator output are configured
in the object. The Present Value is a value that indicates the level of shed activity needed so the
demand does not exceed the maximum power output of the generator. External logic must be used
to interpret this value and switch on/off loads.

Note: In the Notes column, letters indicate the following: A - Archive, B - BACnet Array, C -
Configurable, D - Default Attribute, F - PM Refresh, O - BACnet Optional, Q - BACnet Required, R
- Associate with Reliability, W - Writable.

Table 149: Generator Load Control Object Attributes
Attribute Notes Initial Value Values

\Options
\Range

Description

Present Value W,D,R,F,Q 1 (from Standard
object)

For the Generator Load Control and Electric Demand
Control objects, the Present Value attribute ranges
from 1 to 16. Level 1 represents all level release; 16
is the highest level and 2 is the lowest level. When
the Present Value increases from 2 to 16, turn ON
control to selected facilities. When the Present
Value decreases from 16 to 2, turn OFF control
to selected facilities. This value presets to 1 when
monitoring starts.

Control Type W,C,A Time Ctrl Control_ Type_
Enum_Set (New
Define)

This attribute provides the means for determining
the Present Value. Time Control refers to the
value of the Adjust Value of Load property, and
determines the Present Value. Value Control refers
to the values of Adjust Value of Load property, and
determines the Present Value.

Adjust Value of Load Q 0 Units = kW This attribute expresses the value of electric power
that can be supplied by a generator minus the
current electric power consumed by a generator in
kW units.

Priority for Writing W,C,A,Q 11 Low Limit = 3
High Limit = 16

This attribute defines the priority when instructed
to start or stop by demand control based on this
object. It is a 1 to 16 unsigned integer, with 1 being
the highest priority, and 16 being the minimum
priority.

Target Value to Supply W,C,A,Q 0 Units = kW This attribute shows the electric power that can be
supplied by a generator.

JCI Control Start
Reference

C,A NULL This attribute refers to the power voltage of
a generator. The Present Value of BI or BV is
configured as an object or a property to be set. If
the object referred to is not reliable, or the reference
of the input object is offline, the Generator Load
Control object is unreliable.

JCI Current Consumed
WH Reference

C,A NULL This attribute refers to the power consumption
of a generator. The Present Value of AI or AV is
configured as an object and a property to be set.
If the object is not reliable, or the reference of the
input object is offline, the Generator Load Control
object is unreliable.
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Table 149: Generator Load Control Object Attributes
Sampling Interval W,C,A 5 Units = seconds This attribute refers to the interval of time in

seconds needed to determine the Present Value.

The values of Sampling Interval and Consecutive
Samples should be configured in consideration of
the update time (polling period) of the object that
is set as the reference input. If the object reaches
the value that is set in Consecutive Samples, the
Present Value is obtained.

Transition Interval W,C,A,O 60 Units = seconds This attribute is the interval of time in seconds
needed to determine when the Present Value can
be increased by one level in Value Control. The
values of Transition Interval are configured in
consideration of the update time (ramping period -
how fast the Present Value can be ramped up from
one level to another) of the load controlled by the
object. This interval only applies to values that are
positively increasing. If the Present Value of the
object is decreasing, this interval does not apply.
When the Present Value is changed to a positive
direction such as from 1 to 4, the Present Value
should ramp up one level at a time to prevent
generator failure because of overload. This property
defines an interval to decide when the next increase
occurs. For example, if Generator Load Control
(GLC) changes the Present Value from 1 to 2, then
once the Time Transition Interval expires, GLC
changes the Present Value to 3, and so on, until it
reaches the desired level. While in transition, the
desired level can change and the ramping can be
adjusted to the new level.

Consecutive Samples W,C,A 6 See the Sampling Interval attribute for details.
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Table 149: Generator Load Control Object Attributes
Recovery Power Offset W,C,A 0 Units = kW This attribute represents the offset that counts

toward the determining conditions for performing
applying control (decrement of level).

Level Value ALL 0 This attribute represents the level of available
electric power of a generator, measured in a 60
minute period. It defines the load capacity to be
decreased when a device at a specified level is
turned off.
Although the Level Value attribute is an array of
16 values, only the values 1, 2, 3, 9, 15, and 16 are
configurable.
Level Value: Control Status of Register Points
Device
1:  All levels recovered (all demand controlled
devices are OFF).
2: Level 2 devices are turned ON. All other devices
are OFF.
3: Level 2 and 3 devices are turned ON. All other
devices are OFF.
<4-8>:n/a
9: Devices at level 1 to 9 are turned OFF. All other
devices are OFF.
<10-14>:n/a
15:  Devices at level 1 to 15 are turned ON. All other
devices are OFF.
16: All levels are recovered (all demand controlled
devices are ON).

Electric Demand Control Object
Menu Selection: Insert > Object > Electric Demand Control
The Electric Demand Control Object interacts with the Electric Demand Monitoring Object to control
electrical loads so the actual demand stays below the target demand. The Present Value is a value
that indicates the level of shed activity needed to stay within the target demand. External logic must
be used to interpret this value and to switch on/off loads.

Note: In the notes column, letters indicate the following: A - Archive, B - BACnet Array, C -
Configurable, D - Default Attribute, F - PM Refresh, O - BACnet Optional, Q - BACnet Required, R
- Associate with Reliability, W - Writable.

Table 150: Electric Demand Control Object Attributes
Attribute Name Notes Initial Value Values/Options/Range Description
Present Value W,D,R,F,Q 1 See the Present Value attribute in

Generator Load Control
Control Type W,C,A Time Ctrl Control_Type_ Enum_Set (New

Define)
See the Control Type attribute in
Generator Load Control.

JCI Demand
Monitoring Object
Reference

C,A NULL This attribute refers to the Electric
Demand Monitoring object
reference. The Electric Demand
Control object is unreliable if the
input source object is unreliable, or
if the reference is offline and data
acquisition with BACnet cannot be
performed.
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Table 150: Electric Demand Control Object Attributes
Priority For Writing W,C,A,O Low Limit = 3

High Limit = 16
This attribute defines the priority
when instructed to inject or trip
by demand control based on this
object. It is a 1 to 16 unsigned
integer, with 1 being the highest
priority, and 16 being the lowest
priority.

Level Value ALL 0 This attribute represents the level
of available electric power of a
generator, measured in a 60 minute
period. It defines the load capacity
to be decreased when a device at a
specified level is turned off.
Although the Level Value attribute is
an array of 16 values, only the values
1, 2, 3, 9, 15, and 16 are configurable.
Level Value: Control Status of
Register Points Device
1:  All levels recovered (all demand
controlled devices are ON).
2: Level 2 devices are turned OFF. All
other devices are ON.
3: Level 2 and 3 devices are turned
OFF. All other devices are ON.
<4-8>:n/a
9: Devices at level 1 to 9 are turned
OFF. All other devices are ON.
<10-14>:n/a
15:  Devices at level 1 to 15 are
turned OFF. All other devices are ON.
16: All levels are turned OFF (all
demand controlled devices are OFF).

Transition Interval W,C,A 30 Units = seconds See the Transition Interval
attribute in Table 149.

Lighting Output Object
Menu Selection: Insert > Object > Lighting Output
The Lighting Output object allows a third-party BACnet workstation to represent a Lighting Output
object in a BACnet field controller. The Lighting Output object represents in a linearized percentage
the externally visible characteristics of a lighting output level. By adjusting the present value of this
object, you can change the brightness level of banks of controlled lights. Typically, the adjustment
value is from 5% to 85%.
User commands to the Lighting Output object provide special lighting-specific functions such
as ramping, stepping, and fading. The lighting command also provides a blink-warn mechanism
to notify room occupants that the lights are about to turn off. The blink-warning mechanism is
internal to the Lighting Output object type and may cause a controlled set of lighting banks to blink
on and off or issue a notification.

Lighting Output Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab for this object. See the Object and Feature Tabs section for information on
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the attributes that appear on the other tabs of this object (for example, the Hardware and Options
tab appear on point objects).
Table 151: Lighting Output Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Use Remote Alarming --
BACnet
853 W C

When the attribute Intrinsic Alarming Defined is set to True,
determines where alarms for the object originate. If the remote
integrated object contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing the local mapper
object to accept alarms from the remote integrated object that
are routed to the network engine. If the remote integrated object
does not contain attributes for originating alarms, then Use Remote
Alarming defaults to False causing the local mapper object to
originate alarms. When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at the network
engine. If the value of Use Remote Alarming is changed, a restart
of the network engine may be required to assure correct operation.
This attribute applies only to BACnet integrations.

Intrinsic Alarming Defined --
BACnet
569 W C

Enables the BACnet Intrinsic Alarming feature in the object and
the definition of related attributes. For detailed information, refer
to the BACnet Intrinsic Alarming section of the Metasys SMP Help
(LIT-1201793).

User Name Is BACnet Obj
Name -- BACnet
1092 W C

Controls whether the object’s User Name attribute is also the
Object Name attribute. The Object Name attribute is not writable,
so the only way to change the Object Name attribute is to edit the
User Name attribute and set the User Name Is BACnet Obj Name
attribute to True.

Life Safety Point Object
The Life Safety Point object’s attributes represent the state of smoke detectors, fire detectors,
security alarms, and similar devices. As a Life Safety Point, the state of this object can be one of 24
states.
The Life Safety Point object is a standardized object that represents a BACnet Safety Point Object as
defined in the 2008 BACnet specification.

Life Safety Point Attributes
This object only contains the common Metasys system object attributes. These common attributes
are described in the Common Object Attributes section.

Life Safety Zone Object
The Life Safety Zone object represents a grouping of Life Safety Points. The Life Safety Zone can
also represent a grouping of Life Safety Zones.
The Life Safety Zone object is a standardized object that represents a BACnet Safety Zone Object as
defined in the 2008 BACnet specification.

Life Safety Zone Attributes
This object only contains the common Metasys system object attributes. These common attributes
are described in the Common Object Attributes section.
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Note: In the BACnet Notes column, letters indicate the following: B - Exposed as Standard
BACnet Property, C - Configurable, D - Default Attribute for Display, N - Value Not Required, O -
BACnet Optional, Q - BACnet Required, R - Affected by Object Reliability, W - Writable

Table 152: Life Safety Zone Object Attributes - Focus/Configuration Tab
Attribute Name BACnet

Notes
Values/Options/Range Description

Accepted Modes Q Uses BAC LifSfty Mode (BACnet
Lifesafety Mode) (Set 189).

Specifies all the values the Life Safety Mode
attribute accepts when written.

Event State B Uses BAC Event State (Set 5). Indicates if an active event state is associated
with the object. If the object supports intrinsic
reporting, this attribute indicates the event
state of the object. If not, the attribute is
Normal.

Life Safety Mode W,Q Uses BAC LifSfty Mode (BACnet
Lifesafety Mode) (Set 189).

Specifies the operating mode of the Life
Safety Point object. The Life Safety Point
object generates Change-of-Life-Safety event
notifications for any mode transition if the
flags in the Event Enable attribute are set.

Maintenance
Required

O Uses BAC LifSfty Maint (BACnet
Lifesafety Maintained) (Set 187).

Indicates that maintenance is required for the
life safety point. This may indicate periodic
maintenance or parameter-determined
maintenance, such as a dirtiness value for an
associated detector.

Operation Expected Q Uses BAC LifSfty Oper (Set 190). Specifies the next operation expected by this
object to handle a specific life safety situation.

Out of Service B,C,W Indicates (when True) that the Present Value
and Reliability attributes are decoupled from
the physical input to the object and their
values may be changed for simulation or
testing purposes. Functions that depend on
the values of the Present Value or Reliability
attributes continue to respond to changes
while Out of Service is True, as if those
changes had come from the physical input.
Additionally, the Out of Service state of the
Status Flags attribute is set to True and the
Fault state is decoupled from the physical
input when Out of Service is True.

Present Value W,D,R,Q Uses BAC LifSfty State (BACnet Lifesafety
State) (Set 186).

Indicates the current value of the Life Safety
Zone object. When Out of Service is True, this
attribute is writable.

Reliability B,W Uses Reliability (Set 503) Indicates whether the Present Value is
unreliable.

Silenced Uses BAC LifSfty SilState (BACnet Life
Safety Silent State) (Set 188).

Indicates whether the most recently occurring
transition for this object produced an audible
or visual indication that
has been silenced by the recipient of a Life
Safety Operation service request or a local
process.

Tracking Values O Uses BAC LifSfty State (BACnet Lifesafety
State) (Set 186).

Reflects the non-latched state of the Life
Safety Zone object. This attribute continuously
tracks changes in the latched
state of the object.
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Multistate Input Object
The Multistate Input object’s Present Value attribute represents results of an algorithmic process
within the device in which the object resides. For example, the Present Value of the Multistate Input
object could be either the result of a combination of multiple binary inputs, the threshold of one
or more analog inputs, or the result of a mathematical computation. Present Value is an integer
representing the state of the object. The State Text attribute associates a description with this state.

Note: Do not confuse the Present Value state with the Event State attribute, which reflects the
Offnormal state of the Multistate Input.

The Multistate Input object integrates N1, N2, and BACnet controllers with supervisory controllers,
resulting in:

• a consistent interface to point objects for all controller types
• flexibility in point mapping
• support for Metasys N2 controllers. See the N2 Controller Object.

For example, this object allows you to display the speeds of a multispeed fan at a supervisory
controller.
For general information on Metasys system objects, see Common Object Attributes.

Multistate Input Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.

Table 153: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Current
Command
Priority

B 1 - 16 Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.

Device Type C,W W Null Limit: 20
characters

Contains a description of the physical device
connected to the object.

Intrinsic
Alarming
Defined

C Not
Supported

False False
True

Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes.

Number of
States

C,W W 4 Minimum Value = 2
Maximum Value =
16

Defines the number of states Present Value can
have.
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Table 153: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Out of Service C,W W False False
True

Used to decouple the object from the physical
input that feeds its Present Value and Reliability.
When out of service is True, the object does not
read the Present Value and Reliability from the
hardware.
In addition, the Reliability attribute and the
corresponding state of the Fault flag of the
Status Flags attribute is decoupled from the
input when Out of Service is True. While the Out
of Service attribute is True, Present Value and
Reliability may be changed to any value either as
a means of simulating specific fixed conditions
or for testing purposes. Other functions that
depend on the state of the Present Value or
Reliability attributes respond to changes made to
these attributes while Out of Service is True, as if
those changes had occurred in the input.

Present Value D,N,R,W D,N,R,W States Text
attribute identifies
the value set for
this attribute.

Reflects the current value of the input as one of
n states, where n is the number of states defined
in the Number of States attribute. When Out of
Service is True, Present Value is writable.
This attribute is required to be writable if Out of
Service is True.

Reliability W W No Fault Detected
(Reliable), No
Sensor, Over
Range, Under
Range, Open Loop,
Shorted Loop,
Multi State Fault,
Unreliable Other
Uses Reliability (Set
503).

Indicates if the Present Value is unreliable and
why. When Out of Service is True, the Reliability
may be written directly.

State Text Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.

States Text C,W C Off Low
Med Hi

Indicates the displayed strings for the Present
Value.
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Table 153: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

States Text
Error Status

OK Out of Memory:
Indicates that
memory overrun
occurred while
the system was
adding custom
enumeration for
state text from the
field device to the
user dictionary.
OK: the addition
of custom
enumeration for
state text from the
field device to the
user dictionary is
successful, and
state text from
the device can be
used.

Specifies the status of States Text on the
supervisory device. This attribute cannot be
archived or configured.
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Table 153: Multistate Input Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Status Flags In Alarm, Fault,
Overridden, Out of
Service Uses BAC
Status Flags (Set
9).

Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status. The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if the
Present Value is decoupled from the hardware
output because operator intervention provided a
different value.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise
the Out of Service flag is False.

Use Remote
Alarming

B,C,W False When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Multistate Output Object
The Multistate Output object’s attributes represent the desired state of one or more physical
outputs or processes of the device in which the object resides. The actual functions associated with
a particular state are determined locally (not part of protocol). Present Value represents the state
with a number, and State Text associates a description with each state.
The Multistate Output object integrates N1, N2, and BACnet controllers with supervisory controllers,
resulting in:

• a consistent interface to point objects for all controller types
• flexibility in point mapping
• support for Metasys controllers

For example, this object allows you to command the modes of an access control device from a
supervisory controller.

Note: The N1 migration Multiple Command object maps to this Multistate Output object.
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For general information on Metasys system objects, see Common Object Attributes.

Multistate Output Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab, the Diagnostics tab (if applicable), and any other
tab specific only to this object. See the Object and Feature Tabs section for information on the
attributes that appear on the other tabs of this object (for example, the Hardware and Options tab
appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the notes and BACnet notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.

Table 154: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Current
Command
Priority

B 1 - 16 Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.

Device Type C,W W Limit: 20
characters

Contains a description of the physical device
connected to the object.

Heavy Equip
Delay

C,W Not
supported

0 Range: 0–255
Seconds

Indicates the amount of time that this output
point adds to the Accumulated Delay attribute of
the Heavy Equipment Controller object when this
point is started. The next output point is delayed
by that amount of time of the HEC Accumulated
Delay is not already decremented to zero.
The NAE device’s five internal Heavy Equipment
Controller objects (see HED Controller) time
their delays independently of one another. For
example, HED 1 and HED 4 can count down their
delays at the same time.

HED
Controller

C,W Not
supported

1–5 Identifies the Heavy Equipment Controller object
managing the delays.
The NAE device has five internal Heavy
Equipment Controller objects for use by Binary
Output and Multistate Output objects. The BO
and MO objects reference the HED controller
objects by number (1–5).
All BO and MO objects on an NAE share the five
internal HED controller objects. For example, if
BO1 and MO3 on NAE-1 reference HED controller
1, they are using the same HED controller.
Also see Heavy Equip Delay.

Intrinsic
Alarming
Defined

C Not
supported

False False
True

Enables the definition of the intrinsic alarm
related attributes.

Number of
States

C,W W 4 2–16 Defines the number of states possible for
Present Value.

Out of Service C,W W False
True

Used to decouple the object from the physical
output. When Out of Service is True, the object
decouples Present Value and Reliability from the
hardware. The Reliability will be writable when
Out Of Service is True. Not all devices support
setting this attribute to True.
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Table 154: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Present Value D,R,W D,R,W States Text
attribute identifies
the value set for
this attribute.

Indicates the current value of the output as
one of n states, where n is the number of states
defined in Number of States.

Priority Array Lists object commands in level of importance.

Reliability Reliable No Fault Detected
(Reliable), Open
Loop, Shorted
Loop, No Output,
Unreliable Other
Uses Reliability (Set
503).

Indicates if the Present Value is unreliable and
why. When Out of Service is True, the Reliability
may be written directly.

State Text Off Low
Med Hi

Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.

States Text C,W C,W Off Low
Med Hi

Indicates the displayed strings for the Present
Value.

States Text
Error Status

OK Out of Memory:
Indicates that
memory overrun
occurred while
the systems was
adding custom
enumeration for
state text from the
field device to the
user dictionary.
OK: The addition
of custom
enumeration for
state text from the
field device to the
user dictionary is
successful, and
state text from
the device can be
used.

Specifies the status of States Text on the
supervisory device. This attribute cannot be
archived or configured.
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Table 154: Multistate Output Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Status Flags In Alarm, Fault,
Overridden, Out of
Service
Uses BAC Status
Flags (Set 9).

Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status. The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if the
Present Value is decoupled from the hardware
output because operator intervention provided a
different value or local override is active.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W False When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Multistate Value Object
The Multistate Value object’s attributes represent the desired state of one or more physical outputs
or processes of the device in which the object resides. The actual functions associated with a
particular state are determined locally (not part of protocol). Present Value represents the state
with a number and State Text associates a description with each state.
Multistate Value objects have similar software characteristics and capabilities to a Multistate Input
Object; however, Multistate Value objects are not associated with any physical hardware and are
the result of a control process or operator entry.
The Multistate Value object provides a means to map up to 32 different states to an object.
This object allows you to hold a multistate value for other objects to reference. For example, a
specific multistate value can be available for the Interlock object to reference and to base its
operation on this value.
For general information on Metasys system objects, see Common Object Attributes.
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Multistate Value Attributes
This object contains attributes common to many Metasys system objects. This section includes
attributes of the Focus/Configuration tab. See the Object and Feature Tabs section for information
on the attributes that appear on the other tabs of this object (for example, the Hardware and
Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the Notes and BACnet Notes columns, letters indicate the following: B - Exposed as
standard BACnet property, C - Configurable, D - Default Attribute for Display, N - Value Not
Required, R - Affected by Object’s Reliability, W - Writable.

Table 155: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Connected
To Internal
Application

B,W No No or Yes Indicates whether the object is connected to an
internal application.

Current
Command
Priority

B 1 - 16 Indicates the command priority currently
assigned to the object. A blank in this field
indicates the object is not under any command.

Failsoft
Currently
Active

Yes or No Specifies whether the Failsoft feature is currently
overriding the input value to a reliable default. If
No, Failsoft is disabled or, if Failsoft is enabled,
the value is reliable. If Yes, Failsoft is enabled and
the value is unreliable. This attribute is only used
if Property Ref Value is defined to reference an
application.

Intrinsic
Alarming
Defined

C Not
supported

False False
True

Enables the BACnet Intrinsic Alarming feature
in the object and the definition of related
attributes.

Monitor Only False Defines the behavior of the object as an input
or output. If you do not specify a Property Ref
Value, the attribute is set to False. This attribute
appears only in the Snapshot Focus view.

Number of
States

C,W W 4 2 to 32 Defines the number of states possible for
Present Value.
This attribute is not writable through the MS/TP
integration. You must configure this attribute
through CCT.

Out of Service False Always False Indicates the offline/online state of the
connected hardware. This attribute exists for
compatibility with BACnet protocol and indicates
whether the physical input that the object
represents is in service. When out of service, the
object does not read the hardware. This attribute
is always False.
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Table 155: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Present Value D,R,W D,R,W States Text
attribute identifies
the value set for
this attribute.

Reflects the current value of the multistate value
object as one of n states, where n is the number
of states defined in the Number of States
attribute. The Present Value is equal to the last
value corresponding to the States Text attribute.
Present Value is optionally commandable. If
Present Value is commandable for a given object
instance, then Priority Array and Relinquish
Default are also present for that instance. If Out
of Service is true, Present Value is writable.

Note: If Present Value is commandable,
then it must be writable. If Out of Service is
True, this attribute is True.

Priority Array If Present Value
is commandable,
this attribute is
present.

Contains prioritized commands that are in effect
for this object. See the BACnet standard for a
description of the prioritization mechanism.
If either Priority Array or Relinquish Default is
present, both are present. If Present Value is
commandable, Priority Array and Relinquish
Default are both present.

Property Ref
Value

N Object Name,
Reference,
Attribute

Specifies an object and attribute (usually from an
application) for which the MV object is providing
the standard interface. The object and attribute
contained in this attribute must be a local object
and is often a non-BACnet data source and
destination. When this property is not defined,
the Monitor Only property is set to False. This
attribute appears only in the Snapshot Focus
view.

Referenced
Reliability

No Input Specifies the current reliability of the value sent
to or from the object/attribute referenced by
Property Ref Value. This attribute is only used
if Property Ref Value is defined to reference an
application.

Referenced
Value

Specifies the current value sent to or from the
object/attribute referenced by Property Ref
Value. This attribute is only used if Property Ref
Value is defined to reference an application.

Referenced
Value COS
Count

W 0 Counts how many times the Present Value and
Reliability have changed. This attribute helps
to diagnose excessive changes that can cause
logic to execute taking up too much bandwidth.
Reset the count by entering 0 for this attribute.
This attribute is only used if Property Ref Value is
defined to reference an application.

Reliability W W Reliable No Fault Detected
(Reliable),
Multistate Fault,
Unreliable Other
Uses Reliability (Set
503).

Indicates whether the Present Value is reliable
and why. If Fault Values is present, Reliability is
also present. A To Fault event generates under
these conditions: Reliability is not equal to No
Fault Detected, and the To Fault flag is enabled in
Event Enable.
The Reliability attribute is always present in NAE
implementations.
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Table 155: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

State Text Represents descriptions of all possible states
of Present Value. The number of descriptions
matches the number of states defined in
Number of States. Present Value (an integer)
serves as an index into this attribute.

States Text C,W C,W Indicates the displayed strings for the Present
Value.

States Text
Error Status

OK Out of Memory:
Indicates that
memory overrun
has been
encountered while
adding custom
enumeration for
state text from
field device to the
user dictionary.
OK: Indicates
that an addition
of custom
enumeration for
state text from
the field device
to user dictionary
is successful and
state text from
the device can be
used.

This attribute shows the status of States Text
on the supervisory device. This attribute is not
archivable or configurable.
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Table 155: Multistate Value Object Attributes - Focus/Configuration Tab
Attribute
Name

Notes BACnet
Notes

Initial Value Values/Options/
Range

Description

Status Flags In Alarm, Fault,
Overridden, Out of
Service
Uses BAC Status
Flags (Set 9).

Contains four true or false flags that indicate
the general health of the object. Three of the
four flags are associated with the values of other
attributes within the same object. By reading
these attributes, you get a clearer picture of the
object status.
The four flags are:
In Alarm - In Alarm flag is False (0) if the Event
State attribute value is Normal; otherwise, the In
Alarm flag is True (1).
Fault - Fault flag is True (1) if the Reliability
attribute is not reliable; otherwise, the Fault flag
is False (0).
Overridden - Overridden flag is Logical 1 if
the Present Value has been overridden by
some mechanism local to the BACnet device or
because the operator provided a different value.
Out of Service - Out of Service flag is True if the
Out of Service attribute value is True; otherwise,
the Out of Service flag is False.

Use Remote
Alarming

B,C,W False When the attribute Intrinsic Alarming Defined
is set to True, determines where alarms for the
object originate. If the remote integrated object
contains attributes for originating alarms, then
Use Remote Alarming defaults to True, causing
the local mapper object to accept alarms from
the remote integrated object that are routed to
the NxE. If the remote integrated object does not
contain attributes for originating alarms, then
Use Remote Alarming defaults to False causing
the local mapper object to originate alarms.
When Use Remote Alarming is false, any alarms
from the remote integrated object are ignored at
the NxE. If the value of Use Remote Alarming is
changed, a restart of the NxE may be required to
assure correct operation. This attribute applies
only to BACnet integrations.

Notification Class Object
Menu Selection: Insert > Object > Notification

Notes:
• On the Configure screen, click the Recipient List tab for further configuration.
• Click the Add button to add a BACnet device as a recipient item to the list. The Notification

Recipient dialog box appears. See the Tips for the Notification Recipient section that
follows.

• Click the check box next to an item in the list and click Remove if you want to remove the
item from the list.

• Click the check box next to an item in the list and click Details to view that item’s
Notification Recipient dialog box information.
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• Select an item in the list and use the up and down arrows to change the order of the item
in the list.

Tips for the Notification Recipient:

• To send a notification to a specific BACnet device, select the OID radio button and enter the
object identifier for that device in the Device OID box. Enter the Process ID.

• To send a notification to a specific address, select the Address radio button and enter the IP
Address, Network Number, UDP Port, and Process ID. See the Recipient List attribute of the
Notification Class object for details.

• Select the check boxes for the days that the notifications should be sent. To define the times
when the notification is active, slide the arrows on the time bar to define Start and Stop times.

The Notification Class object provides a means to send alarm messages (Event Notification
Messages) that are generated by other objects to any BACnet device. Typically, it is used to route
alarm messages to third-party BACnet devices. Notification Classes are useful for event-initiating
objects that have identical needs in terms of how their notifications should be handled, what the
destinations for their notifications should be, and how they should be acknowledged.
When you create a Notification Class object at a BACnet client and map the object to a network
engine, a folder called Notification is created and a new Notification Class object is created under
that folder in the navigation tree.
For more information about the wizard used to insert a Notification Class object, see Insert Object -
Notification. For general information on Metasys system objects, see Common Object Attributes.

Notification Class Concepts

Notification Class
A notification class defines how event notifications are prioritized according To Offnormal, To Fault,
and To Normal events; whether these categories of events require acknowledgment (nearly always,
by a human operator); and what destination devices or processes receive notifications.

Prioritization
Prioritization provides a means to ensure that alarms or event notifications with critical time
considerations are not unnecessarily delayed. Priorities may be assigned To Offnormal, To Fault,
and To Normal events individually within a notification class.

Acknowledgment
Acknowledgment provides assurance that a notification has been acted upon by some other agent,
rather than received correctly by another device. In most cases, acknowledgments come from
human operators. To Offnormal, To Fault, and To Normal events may, or may not, require individual
acknowledgment within a notification class.

Destinations
You can send event notifications to multiple destinations or to different destinations based on
the time of day or day of week. Notification Classes specify a list of destinations, each of which is
qualified by time, day of week, and type of handling. The Recipient List attribute describes how the
destination parameters relate to the Notification Class object. If an event that uses a Notification
Class object occurs, the day is one of the days of the week that is valid for a given destination,
and the time is within the window specified in the destination, then a notification is sent to the
destination defined in the Recipient List. You can qualify destinations by any combination of the
three event transitions: To Offnormal, To Fault, and To Normal.
The destination also defines the recipient device that receives the notification. The recipient
device is specified by either its unique Device Object Identifier or by its Network Address and MAC
Address. In the latter case, a unicast address or a broadcast, local/remote, or global address is
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used. The destination information specifies whether the notification is sent using a confirmed or
unconfirmed event notification.
The Ack Required attribute of the Notification Class object and the type of event transition
determine whether the event notification message requires acknowledgment.

Notification Class Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the notes and BACnet notes columns, attributes marked with the letter C are
configurable, and attributes marked with the letter W are writable.

Table 156: Notification Class Object Attributes - Focus/Configuration Tab
Attribute Name Notes BACnet

Notes
Initial Value Values/

Options/
Range

Description

Ack Required C,W W False,
False,
False

To Offnormal
To Fault
To Normal
Uses BAC
Event Bits (Set
525).

Conveys three separate flags that
represent whether acknowledgement is
required in notifications generated for To
Offnormal, To Fault, and To Normal event
transitions, respectively.

Notification Class
Object

0 to
4,294,967,295

Indicates the numeric value of this
notification class and equals the instance
number of the Notification Class object.
Event initiating objects use this number
to reference a specific Notification Class
object.

Priority C,W W 120
200
70

To Offnormal
To Normal
To Fault
Range = 0 to
255

Conveys the priority to be used for event
notifications for To Offnormal, To Fault,
and To Normal events, respectively. A
lower number indicates a higher priority.

Route to Metasys C,W Not
supported

True True, False Determines whether or not the
Notification Class object routes alarms to
the Metasys alarming system.

Send Notifications
to Supervisor

C,W Not
supported

True True, False Determines whether or not the
Notification Class object routes alarms to
the supervisory device.

Table 157: Notification Class Object Attributes - Recipient List Tab
Attribute Name Data Type Notes BACnet Notes Initial Value Values/Options/Range
Recipient List List of value

sets
C,W W See Recipient List.

Uses BAC Day Bitset (Set 176), Recipient
Choice (Set 526), and BAC Event Bits (Set
525).
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Recipient List
Conveys a list of one or more recipient destinations to which notifications are sent when event-
initiating objects using this class detect the occurrence of an event. Each destination structure
contains the following:

• From Time, To Time (Start and Stop Times) - The window of time (inclusive) during which
the destination may be used. To specify all times, use 00:00:00 for Start Time and 23:59:59 for
Stop Time.

• IP Address - The 4 byte IP Address of the destination if routing by IP address. This value is
ignored when Network Number is set to 65,535. When set to 255.255.255.255 IP Address or
the broadcast IP Address, notifications are broadcast based on the Network Number. A value
of 0 sends a local broadcast. A value of 1–65,534 sends a remote broadcast.

• Issue Confirmed Notifications (Confirmed, Unconfirmed) - Indicates whether to send
Confirmed or Unconfirmed event notifications through radio button selection. This selection is
ignored when using global broadcast notifications.

• MSTP Address - The MS/TP address of the destination if routing by MS/TP address.
• Network Number - The network number for the destination if routing by IP or MS/TP

address: 0 designates the address of the local network 1–65,534 identifies a destination
address on the specified network 65,535 specifies the use of global broadcast notification (note
that the IP Address is not used and the notifications are unconfirmed)

• Process Identifier - The process ID within the recipient device that receives the event
notification messages.

• Recipient (Device Object ID) - The destination devices to receive event notification
messages.

• Recipient Choice (Object ID or Address) - The choice of whether to use an Object Identifier
or the Address of the destination to route the notifications. If set to Address, the notification
is sent either to the specified address or broadcast. See IP Address and Network Number
descriptions for details.

• Transitions (Off Normal, Fault, Normal) - Three flags which indicate the types of transitions
(To Offnormal, To Fault, or To Normal) sent to the destination.

• UDP Port Number - The UDP Port number used to send the notification message to the
destination if routing by address. When the port is set to 0, this value when written is replaced
with the port used by the supervisory device on the IP network.

• Valid Days - The days of the week on which notifications may be sent to this destination
during the value of From Time, To Time (Start and Stop Times).

N1 Pulse Counter Object
The N1 Pulse Counter object aids in the integration of N1 controllers with supervisory controllers,
resulting in:

• consistent interface to N1 point objects for all controller types, so they appear as a
homogenous set to the user interface

• flexibility in point mapping
This object allows you to read pulses from an electric or gas meter at a supervisory controller.

Note: The Pulse Counter object may feed its Present Value to the Pulse Meter Object.

For general information on Metasys system objects, see the Object Help section.
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N1 Pulse Counter Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R -
Affected by Extension’s Reliability, W - Writable.

Table 158: N1 Pulse Counter Object Attributes - Focus/Configuration
Attribute Name Notes Initial Value Values/Options/Range Description
Present Value D,R,W 0 to 4,294,967,295 Actual value of the Pulse Count the last time it was

read.
Reliability Uses Reliability (Set 503). Indicates whether the Present Value is reliable

and why.

N1 Pulse Counter Commands
The following table lists the commands supported by the N1 Pulse Counter Object.
Table 159: N1 Pulse Counter Object Commands
Command Name Parameters Description
Preset Counter None Defines a preset value in the counter. This

command is available only if you have the
Supervise Access level command priority.

Enable Alarms None Enables alarms for the N1 pulse counter.
Disable Alarms None Disables alarms for the N1 pulse counter.

Schedule Object
The Schedule object works behind the scenes of the Scheduling feature. The Schedule object
updates attribute values of objects according to the time of day. These times can be specified for
days of the week and as exceptions.
When you create a Schedule object at a BACnet client and map the object to a network engine,
a folder called Schedule is created and a new Schedule object is created under that folder in the
navigation tree.
For more information on the Scheduling feature or the steps it takes to create one, refer the
Scheduling section in the Metasys SMP Help (LIT-1201793).

Schedule Object Attributes
The display of the Schedule object uses two tabs, the Schedule Object Schedule Tab and the
Schedule Object Focus/Configuration Tab. If you add extensions, see Extensions for information on
the extension tabs.

Schedule Object Features
Table 160 shows the icon of the Schedule object. The key words are included in the table to help
users who may search the help system using a description of the icon to find this chapter.
Table 160: Schedule Object Icon
Icon Key Words

Stopwatch, Pocket Watch, Clock
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Schedule Object Schedule Tab
Table 161: Operation and Display Attributes
Attribute Description
Effective Period The Effective Period attribute defines the range of dates

within which the Schedule object is active. By default, these
dates are unspecified, causing the Schedule object to be
active for all days. When the Schedule is not within the
Effective Period, the Schedule is considered Inactive and the
Schedule’s status is set to Inactive. Wildcard may be used
in the date fields. For more information on using wildcards,
refer to the Metasys SMP Help (LIT-1201793).

Schedule Output Type Schedule Output Type Options
• Binary: Select this option to set the schedule’s Value

type to Binary (one of two states, such as Off and On).
• Analog: Select this option to set the schedule’s Value

type to Analog (for example, 72.0).
• Multistate: Select this option to set the schedule’s

Value type to Multistate (one of a set of states, such as
Off, Low, Medium, and High).

• Derived from Key Item: Select this option to set the
schedule’s Value type to match the Value type of the
attribute scheduled for the Key Item. For example,
all values are Boolean (True/False) if the Key Item’s
Enabled attribute is scheduled.

• Derived from Value: This type is only set by the system
- it cannot be manually selected. This type indicates that
the current schedule type matches preexisting values.

Default Schedule Command The Default Schedule Command attribute indicates the
command of the Schedule object when no event is in effect,
due to no scheduled command or a conscious gap in the
schedule. The Default Schedule Command is executed
every midnight unless another event is in place to begin at
midnight.
The Default Schedule Command also supports the Release
command. The Release command releases the Scheduling
function’s control of the scheduled objects. Setting the
Default Schedule Command to Release is the only available
method to release the schedule’s control of scheduled
objects through the Schedule object. Release should only be
used for the Schedule Default Command if the scheduled
items support the Release command.
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Table 161: Operation and Display Attributes
Attribute Description
States Text The States Text attribute indicates the displayed strings for

the Present Value when the Schedule Output Type is either
binary or multistate. This attribute allows you to change what
states the Schedule’s Present Value displays if you want it to
be different from the key item.

Display Units The Display Units attribute indicates the displayed units of
the Present Value when the Schedule Output Type is analog.
This attribute allows you to change the units displayed with
the Schedule’s Present Value if you want them to be different
from the key item.

Schedule Object Focus/Configuration Tab
The online UI displays the Focus tab. The SCT displays the Configuration tab.
Table 162: Object Attributes
Name The Name attribute contains a freely definable user-friendly Name for the

object that is independent of the Item Reference or the location of the
object in the physical network. The Name is used as the label in the All
Items navigation tree. The Name is shown in alarm reports, the event and
audit viewers, and in summaries. The Name does not need to be unique
to the site.
The Name defaults to the object identifier you used during manual object
creation, but can be edited later. For integrated BACnet objects, the name
defaults to the BACnet Object Name in the remote BACnet device. For
integrated N1 network objects, the name defaults to the System.Object
Name in the NCM.
Example: ConferenceCenter-Room2-LightingSchedule
The Name attribute allows up to 400 characters, but 40 or less is best for
the display layout.
Name is a common object attribute; for more information, see Common
Object Attributes.

Description The Description attribute contains a user-defined description of the object.
The Description attribute allows up to 40 characters before Release 8.0
and up to 64 characters at Release 8.0 and later, but is not required.
Description is a common object attribute; for more information, see
stops the object from commanding the referenced attributes. Setting
the Enabled attribute to False does not change the Out of Service
attribute.See Common Object Attributes.
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Table 162: Object Attributes
Object Type stops the object from commanding the referenced attributes. The

Object Type attribute indicates the type of object as displayed in the
Metasys software and as exposed to a BACnet network. The Object type
of the Schedule object is Schedule. The Schedule object is a standard
BACnet schedule object and conforms to the BACnet protocol 135-2004
specification. Object Type is a common object attribute; for more
information, see Common Object Attributes.

Authorization
Category

The Authorization Category attribute classifies the object by the category
of system or equipment that it monitors to aid in the determination of
user access privileges and alarm routing.
Examples: HVAC, Fire, Security

Table 163: Status Attributes
Enabled Setting the Enabled attribute to False stops the object from updating its

Present Value and
Status Flags The Status Flags indicate the general health of the object. This attribute

does not appear in the SCT.
Reliability The Reliability attribute indicates the reliability of the object. If there are

data type mismatches in the weekly schedule, exception schedules, or
Default Schedule Command, the object reports that it is unreliable. This
attribute does not appear in the SCT.

Out of Service When True, the object no longer updates the Present Value itself. This
attribute does not appear in the SCT.

Note: Disabling the object does not impact the ability to put the Schedule
Out Of Service and write to its Present Value and thus to its Outputs.

Error Status The Error Status attribute indicates whether the Present Value was
successfully written to the list of property values in the Scheduled Items
list. The Error Status displays Ok if the object was able to send its latest
Present Value to every object in the Scheduled Items list. Otherwise,
the Error Status displays the error of the first failed command. See the
status log in the Scheduled Items view for the status for each attempted
command. This attribute does not appear in the SCT, and does not appear
for mapped third-party schedules.

Alarm State The Alarm State attribute indicates that the object transitioned into alarm
or unreliable conditions. This attribute does not appear in the SCT.

Table 164: Engineering Values Attributes
Item Reference The Item Reference attribute contains a unique reference name for

the object that is the full path name of the object through the All Items
navigation tree using the unique identifier you specified when you
manually created the object. Item Reference is a common object attribute;
for more information, see Common Object Attributes.

Version The Version attribute displays the version number of the object software
code. Version is a common object attribute; for more information, see
Common Object Attributes.
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Table 165: Execution Attributes
Execution Priority The Execution Priority attribute indicates the relative importance of

performing the function of the object within the device.
Priority for Writing The Priority for Writing attribute defines the priority at which the

referenced attributes are commanded. Seven is the highest priority and
16 is the lowest supported by the Schedule object, with the default of 15.

Note: We do not recommend using priorities 7 or 8 as they may interfere
with the operator override functionality.

Scheduled Commands

Disable
The Disable command stops all future scheduled events. Neither the Weekly Schedule nor the
Exception Schedule run again until the Schedule object is re-enabled. While disabled, the status log
in the Scheduled Items view lists the object as disabled. The schedule remains disabled until re-
enabled.

Enable
The Enable command allows the Schedule object to resume normal scheduling operation. The
Schedule object starts the schedule as soon as it is enabled. When it is re-enabled, the Schedule
object writes its current value to the scheduled items.

Folder
Menu Selection: Insert > Folder
Inserts a folder into the navigation tree of the system for grouping and categorizing items and
information in the navigation tree.

Folder
A Folder object helps support the hierarchical organization of objects.
A total of 1000 objects can be added per folder, and up to 10 consecutive levels of Folder objects
can be added within any other folder or object.

Note: You must name a new folder differently from the folders in the default set on the user
interface.

This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.

Program Object
Menu Selection: Insert > Program Object
Inserts a program control system into the site. See Logic Connector Tool (LCT) for more information
on program control systems and the Logic Connector Tool.

Program Object
The Program object (previously the Control System object) stores information needed for the user-
defined control strategies created (graphically) with the Logic Connector Tool (LCT). The Control
System object application now includes BACnet command object functionality and appears as the
Program object in the Metasys software. The Program object attributes allow manipulation of the
LCT application.
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For general information on Metasys system objects, see Common Object Attributes.

Program Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Click the attribute name in the table for a description of the attribute.

Note: In the notes column, attributes marked with the letter C are configurable, and attributes
marked with the letter W are writable. For more information about attribute characteristics,
see Attributes.

Table 166: Program Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Values/Options/Range
Description of Halt

Enabled C,W

Instance Of

Program Change W Ready 0 = Ready
1 = Load
2 = Run
3 = Halt
4 = Restart
5 = Unload

Program Location

Program State 0 = Idle
1 = Loading
2 = Running
3 = Waiting
4 = Halted
5 = Unloading

Reason for Halt 0 = Normal
1 = Load Failed
2 = Internal
3 = Program
4 = Other

Reliability Uses Reliability set.

Program Attribute Details

Description Of Halt
Displays the text matching the Reason for Halt attribute’s set value.

Enabled
Indicates whether the program/control system logic is enabled or disabled.

Instance Of
Reflects the LCT control system’s user name.
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Program Change
Requests changes to the current state of the LCT application. When written, the following actions
are carried out. After the action is carried out, the Program Change value returns to Ready.

• Ready - Specifies that the LCT control system is ready for a change request (normal state).
• Load - Enables the LCT control system.
• Run - Enables the LCT control system.
• Halt - Disables the LCT control system.
• Restart - Disables, then Enables, the LCT control system.
• Unload - Disables the LCT control system.

Program Location
Indicates the location of the program/control system.

Program State
Reflects the current state of the LCT application.

• Halted - The Program object is Disabled.
• Running - The Program object is Enabled.

Reason For Halt
Indicates that the LCT Control System has been disabled by a means other than the writing of the
Program Change attribute.

• Normal - The LCT control system is Enabled.
• Internal - The LCT control system has been disabled by a means other than writing of the

Program Change attribute.
• Program - The LCT control system has been disabled by writing the Program Change attribute.

Reliability
Indicates whether the connections between logic blocks are reliable.

Logic Connector Tool (LCT)
Use the Logic Connector Tool to create the logic within a control system using a graphical
presentation. The control logic may include System Blocks and Logic Blocks. The Edit Mode allows
you to edit logic, and the View Mode allows viewing and limited commanding capabilities. When
running the LCT on the SCT (Metasys system in offline mode), commanding is disabled.
The Logic Connector Tool allows control system viewing and editing through any browser logged in
to any online or configuration server with access to a Program (Control System) Object and Metasys
system.
Logic runs approximately every 5 seconds. It is important that control applications that require
particular timing use internal logic to determine time between executions.

Note: You cannot insert logic on a Metasys server.

Logic Connector Tool Concepts

Logic Connector Tool Workspace
The Logic Connector Tool runs inside an active display panel. The workspace for the Program
(Control System) Object defaults to a white background. You have the option to add a lined or
dotted grid to the workspace using the appropriate buttons on the Toolbar. The workspace displays
all building blocks and the connections between them, and serves as the destination for dragged
and dropped blocks.
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LCT Modes
The Logic Connector Tool runs in either Edit Mode or View Mode.
You can generate logic and make logic changes when you are using Metasys in offline mode (using
the SCT) or online mode. (See Metasys Modes.) After generating logic or making any changes to
existing logic in offline mode, download the database to the online device to ensure the latest
information is used.

Edit Mode
Access Edit mode by clicking the Edit mode button (see Toolbar). You must be in Edit mode to edit
logic or create logic. The LCT opens in View mode.
In Edit mode, you have access to all toolbar items, System blocks, and Logic blocks.
Right-clicking in Edit mode brings up basic choices such as cut, copy, paste, delete, duplicate, hide,
label, zoom, and connect, depending on the type of item you select.

Note: Do not start labels with a number and then follow it with any of these characters: $ . - ,

For mouse shortcuts in Edit mode, see Mouse Shortcuts: Edit Mode.

View Mode
The Logic Connector Tool displays in the View mode when you are browsing a site running Metasys
software in offline mode (using the SCT) or online mode. (See Metasys Modes.) See Errors in View
Mode.
In View mode, you have access only to a limited number of items on the toolbar. The System and
Logic blocks do not appear in this mode. The LCT opens in View mode. You must enter the Edit
Mode to edit any of the control system logic.
The View mode allows you to edit attributes (from the Configuration tab) and send commands to
any of the input reference blocks in the diagram.
Dynamic values display on the connection line between two logic blocks. Values refresh every
15 seconds unless you click the Refresh button on the Toolbar. Click the Trace mode icon on the
toolbar and the tool displays online values, but hides logical connections between blocks. If you
click a block, the tool traces all connections to and from that block (from the first input to the last
output).
Right-clicking in View mode has no effect.
For mouse shortcuts in View mode, see Mouse Shortcuts: View Mode.

Toolbar
The Logic Connector Tool uses the toolbar described here:

Note: When using a zoom tool in View mode, if you click outside of the display panel
containing the logic system, the zoom level automatically changes back to the default.

Table 167: LCT Toolbar
Visible InIcon

(Standard
Windows
Icons not
Shown)

Command
Edit

Mode
View
Mode

Action

Edit Mode X Changes the control system to Edit mode.

Refresh X Refreshes the values for control system
components.
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Table 167: LCT Toolbar
Visible InIcon

(Standard
Windows
Icons not
Shown)

Command
Edit

Mode
View
Mode

Action

Save X Saves the logic system and changes it to View mode.
If there are unconnected points, the logic system
warns to fix them prior to a save.

Cancel X Cancels current changes and returns to View mode.

Print X X Print dialog appears

Print
Preview

X X Print Preview dialog appears

Cut X Cuts an item of the control system.

Copy X Copies an item in the control system.

Paste X Pastes a cut or copied item into the logic system.

Undo X Undoes the previous action (except for a save) for
up to 4 actions.

Redo X Redoes the previous undone action (for up to 4
actions).

No Grid X Removes the grid from the diagram.

Lines Grid X Displays a line grid behind the diagram.

Points Grid X Displays a point grid behind the diagram.

Select X X Turns the cursor into a selection cursor.

Text X Turns the cursor into a text cursor that allows you to
create a text box.

Pan X X Turns the cursor into a hand that allows you to pan
over the diagram by dragging.

Zoom X X Zooms a selected area.

Interactive
Zoom

X X Zooms in and out on a diagram when you hold the
mouse down.

Zoom - Fit
Window

X X Zooms the diagram to fit within the window.

Trace Mode X Removes all the connection lines in the diagram.
Live values remain.

Selective
Zoom

X X Allows you to select the percentage zoom applied to
the diagram.

Logic
Checker

X Checks the control system logic and places a balloon
with an icon over unconnected points. See the Logic
Checker section.
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Table 167: LCT Toolbar
Visible InIcon

(Standard
Windows
Icons not
Shown)

Command
Edit

Mode
View
Mode

Action

Sequence
(Show

Sequence
Order)

X Shows the logical sequence order of the connected
blocks. A value of -1 indicates that logic does not
execute on the block.

Overview X X Shows an overview of the entire control system.

Logic
Logic contains the following components:

• System Blocks  that reference another control system
• Logic Blocks  that represent functions performed on objects
• Math Category  between the Logic blocks

Once a logic process completes, it runs again in approximately 5 seconds. For example, if a logic
process starts at 10:00:00 and completes at 10:00:04, it runs again at 10:00:09. It is important that
control applications that require particular timing use internal logic to determine time between
execution.
If your logic references multiple Engines or multiple Metasys servers, and one device needs to
be downloaded, upload all Engines and Metasys servers prior to making changes in SCT. This
procedure ensures your logic works consistently.

System Blocks
System blocks support drag and drop functionality. When you deposit a System block onto the
workspace, a configuration wizard guides you through the configuration of the control system.
System blocks are useful when you have complex logic because they allow you to nest one control
system in another control system. When you create a System block, the Metasys software creates a
Program (Control System) Object under the first Program object in the navigation tree.
See Adding Items to Logic.

Logic Blocks
Logic blocks support drag and drop functionality. If the list of Logic blocks is too long to fit into the
Logic block list area, use the scroll bar to expose additional blocks.
Logic blocks are not visible on the navigation tree. If the LCT window is not large enough to show
all the logic blocks, you cannot scroll down to see the hidden blocks. To make sure you see them all,
enlarge the panel displaying the logic by dragging the borders or reducing the number of panels.
See the following table for a list of Logic blocks.
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Table 168: Logic Blocks
Logic Block
Name

Description

Math Performs mathematical functions on one or more inputs, producing a single
output.
1–8 inputs

Bool Performs Boolean functions on 2–8 inputs, producing a single output. This
category also includes the Latch function.

Statistical Performs statistical functions on 2–8 inputs producing a single output.
Selector Performs multiplexing for 2–8 inputs, producing a single output. Based on the

current mode assigned to each input, the selector chooses which input to pass
through to the output.

Control Performs control functions on three inputs, producing a single output.
Psychro
(Psychrometric)

Performs psychrometric functions on the defined inputs, producing a single
output.

Attributes Gives the user the ability to expose values from within their control logic, either
as an input or output. These blocks are considered attributes of the Program
(Control System) Object in which they are included, and may be viewed or
configured from the standard Focus view. A control system is limited to a
combination of 24 inputs and 24 outputs. See the Program (Control System)
Object for more information.

Constant Passes a constant value to building block inputs.
Calculation Controls the amount an output can change per control system execution or

extrapolates an output using two inputs for reference.
Timing Passes its input to its output at the next execution of the control system (every

5 seconds). Timing blocks are used to break up feedback loops. The Timing
category also includes the Time and Timer blocks.

Math Category
Math blocks perform calculations on input. See the following table for details.
Table 169: Math Blocks
Block Math Type Inputs
* Multiply 2–8
+ Add 2–8
X/Y Divide 2
X-Y Subtract 2
Neg Negative 1
Abs Absolute 1
Sqr Square Root 1
Cos Cosine 1
Sin Sine 1
Tan Tangent 1
ATan Arc Tangent 1
ACos Arc Cosine 1
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Table 169: Math Blocks
Block Math Type Inputs
ASin Arc Sine 1
Exp Exponent 1
LN Natural Log 1
LOG Log 1
X^Y X^Y 2

The number of inputs to a Math logic block depends on the number of inputs supported by the
type of math function. The Logic Connector Tool allows you to add multiple connections to the
output of the block.

Note:  Trigonometry blocks (SIN, COS, TAN, ASIN, ACOS, ATAN) perform calculations based on
radians only.

See Editing Blocks in Edit Mode for information on editing Math blocks.

Bool Category
Bool blocks apply Boolean functions to input. The number of inputs to a Bool logic block depends
on the number of inputs supported by the type of Boolean function. The Logic Connector Tool
allows you to add multiple connections to the output of the block.
Table 170: Bool Blocks
Bool Type Inputs
AND 2–8
OR 2–8
XOR 2
NOT 1
LTCH See LTCH (Latch) for details.

See Editing Blocks in Edit Mode for information on editing Bool blocks.

LTCH (Latch)
The Latch block holds a binary value until you command it to reset. Latch blocks help capture
rapidly changing binary states that might otherwise be missed. The Input of the Latch block is
a binary attribute, sampled every time the logic system runs (every 5 seconds). Use an Attribute
Reference block to create the Input for Latch.
Reset determines if the Output of the block changes with a change in the value of the Input. When
Reset is True, the Output of the Latch block stays its original value, even if the Input changes value.
Reset is also a binary attribute. To change the value of Reset, double-click the binary attribute block
in View Mode and issue an Inactive or Active command.
This table translates the value of the Input or Reset binary attribute into True and False values for
the Latch block:
Table 171: Latch Blocks
Binary Attribute Value Command/State True or False
1.0 Active True
0.0 Inactive False

The following table and figure summarize the operation of the Latch block:
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Table 172: Latch Block Operation
Input Reset Output
Goes from False to True False True

Even if the Input goes to False, the Output stays
True as long as Reset is False.

Goes from False to True True False
Goes from True to False False True

Even if the Input goes to True, the Output stays
False as long as Reset is False.

Goes from True to False True False

Figure 33: Latch Block Example

Statistical Category
Statistical blocks perform statistics on input. The number of inputs to a Statistical logic block
depends on the number of inputs supported by the type of statistic. The Logic Connector Tool
allows you to add multiple connections to the output of the block.
Table 173: Statistical Block Connections
Statistical Type Inputs
AVG 2–8
MAX 2–8
MIN 2–8

See Editing Blocks in Edit Mode for information on editing Statistical blocks.

Selector Category
Selector logic blocks (Mux) have 2–8 inputs, one mode input, and one output. Depending on the
current value of the mode input, the Selector chooses which input passes through to the output.
The Logic Connector Tool allows you to add multiple connections to the output of the block.
See Editing Blocks in Edit Mode for information on editing Selector blocks.
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Control Category
Most control logic blocks have three inputs, and you can add multiple connections to the output
of the block. The blocks compare input number 1 with input number 2 using the differential (input
number 3). The type of control depends on the statistical type. The Sequencer functions differently.
See SEQ (Sequencer) for details.
Table 174: Control Blocks
Block Statistical Type Inputs
X>Y greater than 3
X<Y less than 3
X<=Y less than or equal 3
X>=Y greater than or equal 3
<> not equal 3
= equal 3
SEQ Sequencer See SEQ (Sequencer) for

details.

See Editing Blocks in Edit Mode for information on editing Compare blocks.

SEQ (Sequencer)
Sequencer blocks activate devices in a sequential order based on the rank of the device and
whether the device is enabled. Lower ranked devices are activated before higher ranked devices,
and higher ranked devices are deactivated before lower ranked devices.
The Input value at which the sequencer activates or deactivates each device is based on the make
and break limits configured for the Sequencer. See Editing SEQ (Sequencer) Blocks for information
on configuring the make and break limits. The defaults for a 3-stage Sequencer with a range of 0–
100 are the following:
Table 175: SEQ (Sequencer Blocks)

Make Limits (Activation
Points)

Break Limits (Deactivation
Points)

Stage 1 33 1
Stage 2 67 34
Stage 3 99 68

Sequencer blocks can output a value for minimum of 2 and maximum of 8 devices. The following
table describes the components of a Sequencer block:
Table 176: Sequencer Block Components
Component Description
Input Determines the number of activated stages.
Instant Shutdown Determines if the Sequencer is enabled or disabled. Use a binary object

attribute
(1.0=Enabled, 0.0=Disabled).
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Table 176: Sequencer Block Components
Component Description
Rotate Now Activates reordering of output sequence. The manner in which the outputs

Device 1 Output through Device 8 Output are reordered for activation is based
on a combination of two factors: the ranking defined for each device, and
whether the device is enabled. All enabled outputs are scheduled for output
selection prior to disabled outputs. And, within each of these categories
(enabled and disabled outputs), the selections are ordered beginning with
the lowest ranked and proceeding on through to the highest ranked output.
Unlike all other reordering scenarios, the issue of whether or not a device is
currently active is not taken into account in this situation.
Use a binary object attribute (1.0=Rotate now, 0.0=Do not rotate now).

Device 1–8 Enable Establishes whether or not the output is enabled. Use a binary object attribute
(1.0=Enabled, 0.0=Disabled).

Device 1–8 Rank Establishes the order in which device outputs are activated. Use an analog
object attribute (reference block) or a Constant block.

Table 177: Sequencer Block Example
Binary Attribute Value Command/State True or False
1.0 Active True
0.0 Inactive False

See Editing SEQ (Sequencer) Blocks for information on editing Sequencer blocks.

Psychrometric Category
Psychrometric logic blocks have 2 inputs, and you can add multiple connections to the output of the
block.
Table 178: Psychrometric Blocks
Symbols Description Upper Input Lower Input
EN-DP (EnDp) Enthalpy - Dew Point DB DP
EN-RH (EnRh) Enthalpy - Relative Humidity DB RH
RH-DP (RhDp) Relative Humidity - Dew

Point
DB DP

RH-WB (RhWb) Relative Humidity - Wet Bulb DB WB
WB-DP (WbDp) Wet Bulb - Dew Point DB DP
WB-RH (WbRh) Wet Bulb - Relative Humidity DB RH
ABH Absolute Humidity DB RH
DP Dew Point DB RH

See Editing Blocks in Edit Mode for information on editing Psychrometric blocks.

Attributes Category
Attribute blocks let you expose values in your logic and configure inputs and outputs. Control
systems can contain a maximum of 24 inputs and 24 outputs.
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Input and Output Attributes
In View Mode, a double-click on an Attribute Input or Output block has no effect. In the Edit Mode,
when you drag and drop an attribute block from the palette, configuration wizards launch to help
you configure the attribute.
Attributes support a maximum of 24 input or 24 output blocks of Numeric, Enum, or Bool.
Attributes expose values at different stages of the Metasys system for a user to see at a glance or
connect to/from.
See Editing Blocks in Edit Mode for information on editing Attribute blocks.

Note: Once an attribute is configured as Numeric, Enum, or Boolean, it cannot be changed.

Attribute Reference
After inserting an attribute reference (Input Ref or Output Ref), you can edit which object/attribute
is being referenced. See Editing Blocks in Edit Mode. If you double-click in View mode, a Command
dialog box appears for Input refs only.

Constant Category
Constant logic blocks can have multiple connections to the output of the block. Constant logic
blocks can be any one of the following:
Table 179: Constant Blocks
Block Statistical Type
Enum Enumeration
Float Float
Rel. Release

Note: Sends the Release command at a specific priority based on the connec-
tion.

See Editing Blocks in Edit Mode for information on editing Constant blocks.

Calculation Category

RL (Rate Limiter)
The Rate Limiter block controls the rate at which its Output changes with variations in its Input
value. If rate limiting is disabled, this block passes the value of the Input to the Output. If rate
limiting is enabled, this block limits changes to its Output to an increment determined by the Step
Equation, executed according to the rate limit. This table describes the components of the Rate
Limiter block:
Table 180: RL (Rate Limiter Blocks)
Symbol Description
IN Input
EN Enabled

Enables rate limiting. Use a binary object attribute reference for EN:
0 = Disabled (Inactive command)
1 = Enabled (Active command)

Rate Limiter blocks use the Step Equation to determine the maximum increment (step) the Output
can change to match the Input if the two differ. The Step Equation recalculates the step every time
system logic executes (every 5 seconds).
The Step Equation looks like this:
Step = Rate Limit/60,000 * Actual Period
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Where:

Rate Limit: Rate per minute to increase or decrease the Output until it matches the Input
Actual Period: Time in milliseconds since the last execution of the block. The system logic and

Step Equation execute every 5 seconds (5,000 milliseconds).

For example, if the Rate Limiter block is set up like this:
Rate Limit = 10
Actual Period = 5,000 (milliseconds)
The Step Equation looks like this:
Step = 10/60,000 * 5,000
Step = 0.8
So, the maximum increment the Output can change on its way to match the Input is 0.8.
See Editing Blocks in Edit Mode for information on editing Rate Limiter blocks.

Span
The Span block applies a range and extrapolated values to an input to produce an output. This table
describes the Span block components:
Table 181: Span Blocks
Symbol Description
IN Input
IL Input Low
OL Output Low
IH Input High
OH Output High

The Span block creates a linear relationship between the low input/output and high input/output
pair. If the Input for the Span block falls between the low and high input, the Output of the Span
block is found on the line between the low and high pairs.
The following example shows a graphical picture of how the Span block works:

Figure 34: Span Block Example 1
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The line connecting the low and high pairs (blue line) represents the linear relationship between
them. When you enter an Input for the Span block, the logic finds where the line crosses that input
and provides the corresponding output. (The output must lie on the thick blue line.) Using the
figure above, if you enter 5 for the Span block Input, the block would find 5 on the Input axis and
provide an output of 5.5 because that is where the line crosses an Input value of 5. (The green line
shows this relationship.)
If the Span block is set up to Clamp (see Editing Span Blocks) the value of the Output, the Output
of the block is restricted to the range between (and including) the low and high Output you enter
for the block. Range clamping is the default setting. For example, assume you are using the values
in the figure below and have clamping set to True. If you enter an Input of 5, you still generate
an Output of 5.5, because the original line crosses an Input of 5 at 5.5, which is between 4 and 8
(low and high output). If you enter an Input of 12, you generate an Output of 8, because where the
original line crosses an Input of 12 is higher than the high output (see where thin blue and thin
green lines intersect). If clamping is True for both high and low, the output must lie on the newly
drawn thick blue line.

Figure 35: Span Block Example 2

The Span block works for the reverse span as well (if the Output High is lower than the Output
Low). See Editing Blocks in Edit Mode for information on editing Span blocks.

Timing Category
Delay blocks have one input and one output and are commonly used to break up feedback loops.
The Timing category also includes the TMR (Timer) and Time blocks.
See Editing Blocks in Edit Mode for information on editing Timing blocks.

TMR (Timer)
This table describes the components of the TMR blocks:
Table 182: TMR (Timer) Blocks
Output Description
IN Input
RS Reset. Cancels the timer. Reset does not apply to Minimum On or Minimum

Off timers. Use a binary object attribute for Reset (1.0=Reset Active, 0.0=Reset
Inactive).
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The LCT contains five different types of timers. Each type uses a Duration (how long the timer is
active) and unique functions to generate an Output. The different types of timers are listed below.
Click the name of the timer for a description and figure of timer operation.

• Pulse Timer Function
• On Delay Timer Function
• Off Delay Timer Function
• Minimum On Timer Function
• Minimum Off Timer Function

For information on setting Duration and the type of Timer, see Editing Timing Blocks.

Pulse Timer Function
The following table and figures illustrate the function of the Pulse timer.
Table 183: Pulse Timer Function
Feature Description
Activation Goes active if the Input goes from low to high in two consecutive executions

(logic executes every 5 seconds. The Pulse timer remains active for the
amount of time specified in Duration, then goes to inactive. High to low
transitions do not activate this timer.

Output Stays high as long as the timer is active. After the Duration expires, the Output
goes low at the next logic execution.

Reset Cancels timer activity and makes the output low. If the Reset goes from high
to low, the timer re-evaluates the Input at the next low to high transition.

Example Captures a short pulse on a binary input and keeps the Output True long
enough so that the logic can react to it.

Figure 36: Pulse Timer Example 1
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Figure 37: Pulse Timer Example 2

On Delay Timer Function
The following table and figures illustrate the function of the On Delay timer.
Table 184: On Delay Timer Function
Feature Description
Activation Goes inactive in a low to high Input transition, depending on the state of

the input during the duration period. If the Input returns to a low state
(inactive), the timing cycle is canceled and the Output remains inactive. If the
Input remains in a high state, the Output goes to the high state at the next
execution of logic.
In a high to low Input transition, the Output becomes inactive the next time
the logic executes (logic executes every 5 seconds).

Output See row above.
Reset Cancels timer activity and makes the output inactive. If the Reset goes from

active to inactive, the timer re-evaluates the Input at the next low to high
transition.

Example Delays the supply fan start 20 seconds after the return fan starts.
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Figure 38: On Delay Timer Example 1

Figure 39: On Delay Timer Example 2

Off Delay Timer Function
The following table and figures illustrate the function of the Off Delay timer.
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Table 185: Off Delay Timer Function
Feature Description
Activation In a low to high Input transition, the Output becomes active the next time the

logic executes (logic executes every 5 seconds).
Goes inactive in a high to low Input transition, depending on the state of
the input during the duration period. If the Input returns to a high state
(active), the timing cycle is canceled and the Output remains active. If the
Input remains in a low state, the Output goes to the low state at the next
execution of logic.

Output See row above.
Reset Cancels timer activity and makes the output inactive. If the Reset goes from

active to inactive, the timer re-evaluates the Input at the next low to high
transition.

Example Keeps the fan running to purge the coils after a heating or cooling system is
turned off. Off Delay is useful when your building contains electrical heat and/
or DX cooling.

Figure 40: Off Delay Mode Example 1
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Figure 41: Off Delay Mode Example 2

Minimum On Timer Function
The following table and figures illustrate the function of the Minimum On timer.
Table 186: Minimum On Timer Function
Feature Description
Activation See row below.
Output Goes active when there is a low to high Input transition when the timer

executes (logic executes every 5 seconds). The Output remains active until the
time specified in Duration passes AND the Input returns to inactive.

Reset Has no effect on Minimum On timer.
Example Keeps a chiller running for a minimum time after startup to stabilize

equipment.
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Figure 42: Minimum On Timer Example 1

Figure 43: Minimum On Timer Example 2

Minimum Off Timer Function
The following table and figures illustrate the function of the Minimum Off timer.
Table 187: Minimum Off Timer Function
Feature Description
Activation See row below.
Output Goes inactive when there is a high to low Input transition when the timer

executes (logic executes every 5 seconds). The Output remains inactive until
the time specified in Duration passes AND the Input returns to active.
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Table 187: Minimum Off Timer Function
Feature Description
Reset Has no effect on Minimum Off timer.
Example Keeps a chiller off from a minimum time after shutdown to equalize

refrigerant.

Figure 44: Minimum Off Timer Example 1

Figure 45: Minimum Off Timer Example 2
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Time
A Time block has no configurable input because it extracts time and date information from the
network. Network time/date is set at the Site Director. The outputs of a Time block are six time/date
values:
Table 188: Time Blocks
Output Description Format
HH Hour 0–23 (24-hour time)
MM Minute 0–59
YR Year four-digit year
MO Month 1–12
DA Day 1–31
DOW Day of the Week 1=Monday

2=Tuesday
3=Wednesday
4=Thursday
5=Friday
6=Saturday
7=Sunday

Connections
Connection lines connect blocks in the logic. The LCT does not do a datatype check; that is, you
can connect Boolean and Constant values, and any other combination. But, the tool does not allow
inputs to connect to inputs, or outputs to outputs. The tool determines the connection line routing,
and the only way to change the routing is to move the blocks or use the hide feature.

Control Systems
Control systems are collections of subsystems, Logic Blocks, or combinations of both that may be
connected together.
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General Logic Connector Tool Rules
Table 189: General LCT Rules
What Are You
Doing?

What Components Are
You Using?

These Rules Apply:

Moving, Sizing,
Typing

All blocks • Left-click to drag and drop blocks
• Block size is fixed
• Font size and type are fixed

Connecting System blocks Attribute Properties:
• Read Only
• Writable
• Prioritized Write

Connection Type
Allowed:

• Output
• Input or Output
• Input, Output, or

Both
Connecting Math, Bool, Statistical,

Selector, Control,
Psychrometric, Calculation

All inputs should be connected for these Logic
blocks. If you attempt to save logic that is
missing inputs, an error message displays.
You may save anyway or supply inputs where
necessary. We do not recommend saving with
missing inputs. In the Edit view, blocks with
missing inputs have red input points. When
the inputs are connected, the connection point
turns blue.

Logic Checker
The Logic Checker is not the same logic check run with a LCT save. It must be selected from the
Toolbar. The Logic Checker scans the control system logic and reports any configuration issues it
finds.
Table 190: Logic Checker
Condition Message Text Message Text Position
An output is not connected. Missing Output Connection Top-center of the block
An input is not connected. Missing Input Connection Top-center of the block
A feedback loop exists in the
logic.

Feedback Loop Is Present Top-center of a connection in
the loop

An attribute is not connected. Attribute Is Not Connected Top-center of the attribute
Duplicate attribute name is
defined.

Duplicate Attribute Name Top-center of the attribute

Errors in View Mode
While in View Mode, the tool displays the status of System Blocks, references (Attribute Reference),
and Math Category. If any connection is unreliable, the tool inserts a red circle at the center of the
connection. If you place your cursor over the circle, the error condition appears as transparent text
over the block. For example, the error could be a write or offline error.
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Printing
The Logic Connector Tool supports printing of the following paper sizes in either landscape or
portrait orientation:

• Letter (8.5 x 11 in)
• Folio (8.5 x 13 in)
• Legal (8.5 x 14 in)
• Tabloid (11 x 17 in)
• A1
• A2
• A3
• A4
• A5

The Logic Connector Tool supports printing of just the existing control system.

Mouse Shortcuts
Use mouse shortcuts to speed up LCT use.

Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the LCT.
Table 191: Edit Mode Mouse Shortcuts
Component Single Left-

Click
Double Left-Click Right-Click

System Block Select Lets you edit the block (Editing
System Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Math Block Select Lets you edit the block (Editing
Math Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Bool Block Select Lets you edit the block (Editing
Bool Blocks) (except for LTCH
blocks).

Cut, Copy, Paste, Duplicate,
Delete

Statistical
Block

Select Lets you edit the block (Editing
Statistical Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Selector Block Select Lets you edit the block (Editing
Selector Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Control Block Select Lets you edit the block (Editing
Control Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Psychrometric
Block

Select Lets you edit the block (Editing
Psychrometric Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Attribute
Block

Select Lets you edit the block (Editing
Attribute Blocks: Input and
Output).

Cut, Copy, Paste, Duplicate,
Delete

Attribute
Reference
Block

Select Lets you edit the block (Editing
Attribute Reference Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Constant
Block

Select Lets you edit the block (Editing
Constant Blocks).

Cut, Copy, Paste, Duplicate,
Delete, Label
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Table 191: Edit Mode Mouse Shortcuts
Component Single Left-

Click
Double Left-Click Right-Click

Calculation
Block

Select Lets you edit the block (Editing
Calculation Blocks).

Cut, Copy, Paste, Duplicate,
Delete

Timing Block Select Lets you edit the block (Editing
Timing Blocks) (except for Time
blocks).

Cut, Copy, Paste, Duplicate,
Delete

Connection:
Prioritized

Select Calls up a box to set connection
priority.

Hide, Delete

Connection:
Non-
Prioritized

Select Has no action. Hide, Delete

Text Block Select Opens the box for editing. Cut, Copy, Paste, Duplicate,
Delete, Properties

Workspace Select (drag
to lasso
items)

Releases a connection if one is in
progress.

Cut, Copy, Paste, Duplicate,
Delete, Connect, Zoom (with
subcategories)

Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the LCT.
Table 192: View Mode Mouse Shortcuts
Component Single Left-Click Double Left-Click Right-Click
System Block Select - -
Math Block Select - -
Bool Block Select - -
Statistical Block Select - -
Selector Block Select - -
Control Block Select - -
Psychrometric Block Select - -
Attribute Block Select - -
Attribute Reference Block Select - -
Constant Block Select - -
Timing Block Select - -
Calculation Block Select - -
Connection Select - -
Text Block - - -

Logic Connector Tool Steps

Generating a Logic System (Overview)
About this task:  
To generate a complete logic system:

1. On the Insert Menu, select Control System. The Insert System wizard appears.
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2. Follow the instructions. The Program (Control System) Object appears in the Navigation Tree.
3. Drag the program/control system to the workspace. The LCT opens in View Mode.
4. Change to Edit mode (Changing LCT Modes) to add or edit items in the workspace.
5. Add symbol blocks (Adding Items to Logic) and add text blocks (Adding Text Blocks) to the

workspace.
6. Connect the blocks (Connecting Blocks).
7. Edit blocks (Editing Blocks in Edit Mode).
8. Save the program/control system (Saving a Control System).
9. Download the program/control system to the online controller, if you created or edited the

logic in offline mode (using the SCT).

Result  

Note:
• You must create a unique name for each program/control system created under the same

folder. You can create programs/control systems with the same names as long as they are
stored in different folders.

• When defining logic with scientific notation where the number of digits to the left of the
decimal point is large, the system extends the range of values displayed without scientific
notation to include all values with an absolute value less than 10 million and greater than
or equal to one millionth (0.000001 <= |value| < 10,000,000.0).

Changing LCT Modes
To change from View Mode to Edit Mode, click the Edit mode button on the Toolbar.
To change from Edit Mode to View Mode, click the Cancel or Save button on the Toolbar.

Viewing Existing Logic
1. Browse to either an archive database or an online controller.
2. Drag and drop the desired Program (Control System) Object from the tree structure to the

workspace. The Logic Connector Tool opens in View Mode.

Adding Items to Logic

Drag and Drop
About this task:  
To add items to a control system using the drag and drop method:

1. In the Edit Mode of the LCT, left-click and drag an item from the left side of the tool view and
drop it in the workspace.
Notes:

- If the item is a System block, a configuration wizard appears. Answer the questions to
set up the new object/system or create a reference to an object or control system.

- There is not interaction between the user navigation tree and logic.
2. Edit the block to match your needs. See Editing Blocks in Edit Mode.

Copy and Paste
About this task:  

Note: You can copy and paste existing objects into the workspace from the workspace only.
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To add items to a control system using the copy and paste method:

1. Right-click an existing object and select Copy.
2. Right-click in the workspace and Paste the object.

Note: The copy and paste method supports copying and pasting of multiple blocks. To
copy and paste more than one block, hold down the Shift key while selecting blocks with
the cursor or use the select tool to lasso the blocks.

Connecting Blocks
1. Make sure the Logic Connector Tool is running in Edit Mode.
2. Place the cursor over the starting connection point until it changes shape from an arrow to a

magic wand and click the point.
3. Click the ending connection point.

Notes:

- If the connection is valid, the cursor is a magic wand. If the connection is not valid, a
circle with an X through it appears, and the tool does not connect the points.

- After you successfully connect two points, the line between them turns blue until you
click somewhere else in the workspace.

- You do not need to click the exact connection point. If you click in the block, the tool
automatically creates a connection to/from the nearest block’s connection point. To
cancel the connection after clicking the first block, click anywhere in the workspace.

4. The Priority Connection dialog box appears. Choose a priority from 1–16 (1 is the highest
priority).

Note: To change the priority at a later time, you must delete the connection and reinsert
it.

Re-Routing a Connection
1. Make sure the LCT is running in Edit Mode.
2. Place the cursor over an existing end connection point until the cursor changes into a cursor

with lines protruding from the tip.

Note: You may only move the destination point. To completely change the connection,
see Deleting Connections.

3. Click the connection point. The tool removes the connection.
4. Click a new connection point. The tool creates the newly routed connection.

Hiding Output Connections
1. Make sure the LCT is running in Edit Mode.
2. Place the cursor over the output connection point and right-click and a menu appears.
3. Select Hide from the menu. The tool removes all connections from the output and replaces

the lines with numbered symbolic representations of the connections.
4. To see the connections again, right-click the starting connection point and select Unhide.

Note:

Double-click the hidden connection to label it. If multiple connections are from the
same hidden input, it is shown as Label: number where number is the number of
connections.

Do not start labels with a number and then follow it with any of these characters: $ . - ,
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Deleting Connections
1. Make sure the LCT is running in Edit Mode.
2. Select the connection and right-click.
3. Select Delete from the menu.

Result  
OR

1. Select the connection.
2. Press the Delete key on the keyboard.

Editing Blocks in Edit Mode
About this task:  
To edit blocks in Edit mode:

1. Enter Edit Mode (Changing LCT Modes).
2. See one of the following sections for information on the block you are editing.

Editing System Blocks
About this task:  
To edit System Blocks in Edit mode:

1. Double-click a System block. The Expose Attributes dialog box appears.
2. Configure the inputs, outputs, and attributes of the subsystem.

Note:
- Select the Add button to add an attribute to configure. To remove attributes from

the System, select the check box next to one or more attributes and click the
Remove button.

- To view the control system for the System block, drag and drop the control system
from the Navigation Tree to the Panel Layout.

- If you click Cancel to disregard your changes to the System block the changes are
not saved, as expected. However, if you once again edit the same System block,
and an error prompt appears stating An error occurred. Object does not
exist, simply try these steps again. The error does not reoccur with the second
attempt.

Editing Math Blocks
About this task:  
To edit Math blocks in Edit mode:

1. Double-click a Math block. The configuration dialog box appears.
2. Edit the fields and configure the number of inputs based on the selected type of logic.

Table 193: Math Block Configuration
Field Description
Input The number of inputs depends on the type of Math block you use.

You cannot reduce the input count lower than the number of current
connections.

OK Accepts changes.
Cancel Cancels changes.
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Editing Bool Blocks
About this task:  

Note: LTCH (Latch) blocks are not editable.

To edit Bool blocks in Edit mode:

1. Double-click a Bool block. The configuration dialog box appears.
2. Edit the fields and configure the number of inputs based on the selected type of Boolean

logic.
Table 194: Bool Block Configuration
Field Description
Input The number of inputs depends on the type of Bool block you use.

You cannot reduce the input count lower than the number of current
connections.

OK Accepts changes.
Cancel Cancels changes.

Editing Statistical Blocks
About this task:  
To edit Statistical blocks in Edit mode:

1. Double-click a Statistical block. The configuration dialog box appears.
2. Edit the fields and configure the type of statistical block and number of inputs.

Table 195: Statistical Block Configuration
Field Description
Type Allows you to switch between the statistical types.
Input You cannot reduce the input count lower than the number of current

connections.
OK Accepts changes.
Cancel Cancels changes.

Editing Selector Blocks
About this task:  
To edit Selector blocks in Edit mode:

1. Double-click a Selector (Mux) block. The Selector Edit dialog box appears.
2. Edit the fields and configure the number of inputs, the enumeration set, and the mode for

each input.
Table 196: Selector Block Configuration
Field Description
Input The number of inputs determines the list of inputs.
Enum Category Filters the enumeration set list based on the chosen category.
Enum Set When Enum Set changes, all modes are reset.
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Table 196: Selector Block Configuration
Field Description
Input 1
Mode(s)

Click the button and a dialog box appears that allows you to select which
modes associate with each input. In the dialog box, select the check box
next to the desired mode(s). If a mode is already assigned to another input,
the mode appears dimmed. Select Default to select all modes for an input
that are not currently selected by any other input.

Input 2
Mode(s)

Click the button and a dialog box appears that allows you to select which
modes associate with each input. In the dialog box, select the check box
next to the desired mode(s). If a mode is already assigned to another input,
the mode appears dimmed. Select Default to select all modes for an input
that are not currently selected by any other input. There is one of these per
input (2–8).

OK Accepts changes.
Cancel Cancels changes.

Editing Control Blocks
About this task:  
To edit Control blocks in Edit mode:

1. Double-click a Control block. The configuration dialog box appears.

Note: See Editing SEQ (Sequencer) Blocks for Sequencer configuration information.

2. Edit the fields to configure the type of comparison.
Table 197: Control Block Configuration
Field Description
Type The Type of comparison performed by the block. This field defaults to what

was dragged over, but may be changed.
OK Accepts changes.
Cancel Cancels changes.

Editing SEQ (Sequencer) Blocks
About this task:  
To edit SEQ (Sequencer) blocks in Edit mode:

1. Double-click a Sequencer block. The Sequencer dialog box appears.
2. Edit the fields to configure the sequencer.

Table 198: SEQ (Sequencer) Block Configuration
Field Description
Outputs Determines the number of binary outputs for the block.
Min On Time Specifies the minimum time an output must be on before being

deactivated to an off condition. When an output is activated, a timer
starts. Until the timer reaches the minimum time, the output cannot be
deactivated. However, an Instant Shutdown or a Rotate Now command is
applied immediately, and overrides the Min On Time value.
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Table 198: SEQ (Sequencer) Block Configuration
Field Description
Min Off Time Specifies the minimum time an output must be off before being

reactivated to an on condition. When an output is deactivated, a timer
starts. Until the timer reaches the minimum time, the output cannot be
activated. However, an Instant Shutdown or a Rotate Now command is
applied immediately, and overrides the Min Off Time value.

Interstage On
Delay

Defines the minimum time that must elapse between the sequential
activation of Sequencer stages.

Interstage Off
Delay

Defines the minimum time that must elapse between sequential
deactivation of Sequencer stages.

Make/Break
Limits

The box next to Make/Break indicates if Proactive is selected and, when
you click, launches the Make/Break Dialog box.
In the Make/Break Dialog box:

• Default check box: Disables all make/break limit text boxes and uses
the default values. The default values are set so that each device is on
for a proportional amount of time. If you do not select Default, you
must enter at least one set of values for a stage.

• Proactive check box: Disables the Stage 1 make/break limit boxes
(because that stage is always on) and shifts all the make/break limits
down one stage.

• Make Limit: Turns on the stage when the input value to the block
reaches this limit.

• Break Limit: Turns off the stage when the input value to the block
decreases to this value.

Make/Break Limit Rules:
• The current stage make limit must be less than the next stage make

limit.
• The current stage break limit must be less than the current stage

make limit,
• OR

the current stage make limit must be greater than the current
stage break limit.

• The current stage break limit must be less than the next stage break
limit.

OK Accepts changes.
Cancel Cancels changes.

Editing Psychrometric Blocks
About this task:  
To edit Psychrometric blocks in Edit mode:

1. Double-click a Psychrometric block. The configuration dialog box appears.
2. Edit the fields and configure the elevation based on the selected logic type.
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Note: If you double-click an ABH or DP block, the Unit Type field does not appear.

Table 199: Psychrometric Block Configuration
Field Description
Elevation Allows you to configure the current elevation of the site (in feet or meters).
Unit Type Allows you to choose International System of Units (SI) or Imperial (IP)

units.
Units for Unit Type SI are kilograms of water per kilogram of dry air.
Units for Unit Type IP are pounds per cubic foot.

OK Accepts changes.
Cancel Cancels changes.

Editing Attribute Blocks: Input and Output
About this task:  
To edit Attribute blocks in Edit mode:

1. Double-click an attribute block.
2. Edit the fields and configure the input/output (see Editing Attribute Inputs and Editing

Attribute Outputs).

Editing Attribute Inputs
Table 200: Attribute Input
Field Description
Name Name of the input
Units The units for the output.

This field only appears for floating inputs.
Display
Precision

Tells the Metasys software what precision to use when formatting data.
This field only appears for floating inputs.

Note: Display Precision is used in the Focus view of data, not the graphical view.
Enum Category Set category determined by the user interface (either Two State or Multi State).

This field only appears for Enum inputs.
Enum Set Set determined by the category selected in Enum Category.

This field only appears for Enum inputs.
Trigger This is checked if you want the attribute to trigger the control system to execute

if its value changes by more than the defined increment.
OK Accepts changes.
Cancel Cancels changes.

Editing Attribute Outputs
Table 201: Attribute Output
Field Description
Name Name of the output
Units The units for the output
Display
Precision

Tells the Metasys software what precision to use when formatting data.
This field only appears for floating outputs.

Note: Display Precision is used in the Focus view of data, not the graphical view.

383SCT: System Configuration Tool Help



Table 201: Attribute Output
Field Description
Enum Category Set category determined by the user interface (either Two State or Multi State).

This field only appears for Enum outputs.
Enum Set Set determined by the category selected in Enum Category.

This field only appears for Enum outputs.
OK Accepts changes.
Cancel Cancels changes.

Editing Attribute Reference Blocks
About this task:  
To edit Attribute Reference blocks in Edit mode:

1. Double-click an Attribute Reference block. The Attribute Reference Edit dialog box appears.
2. Edit the fields and configure the object or attribute to which the block refers (Editing Attribute

Reference Inputs or Editing Attribute Reference Outputs).

Editing Attribute Reference Inputs
Table 202: Attribute Reference Input
Field Description
Label Enter a label here for the block.

Note: Do not start labels with a number and then follow it with any of these charac-
ters: $ . - ,

Object Browses to the object to which the reference is linked. Leaving this field blank
leaves a placeholder for a future reference. The dragged object's name appears
in this field and the object's attributes appear in the drop-down list in the
attribute field.

Attribute The attribute to which the reference is linked. When you are configuring for an
Input reference, the drop-down list contains numeric attributes only.

Units Units for the attribute
Trigger This is checked if you want the attribute to trigger the control system to execute

immediately instead of waiting for the next control system scan if the value
changes by more than the defined increment. Otherwise, the control system
executes normally.

Increment Sets the increment.
OK Accepts changes.
Cancel Cancels changes.
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Editing Attribute Reference Outputs
Table 203: Attribute Reference Output
Field Description
Label Enter a label here for the block.

Note: Do not start labels with a number and then follow it with any of these charac-
ters: $ . - ,

Object Browses to the object to which the reference is linked. Leaving this field blank
leaves a placeholder for a future reference. The dragged object’s name appears
in this field and the object’s attributes appear in the drop-down list in the
attribute field.

Attribute The attribute to which the reference is linked. When you are configuring an
Output reference, the drop-down list contains numeric, writable attributes only.

OK Accepts changes.
Cancel Cancels changes.

Editing Constant Blocks
About this task:  
To edit Constant Category blocks in Edit mode:

1. Double-click a Constant block. One of two dialog boxes appears depending on the type of
constant you select.

Note: There are no configurable parameters for the Rel. (Release) constant. When you
double-click, nothing happens.

2. Edit fields and configure the constant value (Editing Constant Enum, Editing Constant Float).

Editing Constant Enum
Table 204: Constant Enum
Callout Description
Enum Category Set category determined by the user interface (either Two State or Multi State).
Enum Set Set determined by the category selected in Enum Category.
Enum Set state determined by the set and set category.
OK Accepts changes.
Cancel Cancels changes.

Editing Constant Float
Table 205: Constant Float
Callout Description
Value The value of the float.
Units The units used by the float.
OK Accepts changes.
Cancel Cancels changes.

Editing Calculation Blocks

Editing RL (Rate Limiter) Blocks
About this task:  
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To edit RL (Rate Limiter) blocks in Edit mode:

1. Double-click a Rate Limiter block. The RL dialog box appears.
2. Edit the Rate Limit and Startup Value for the RL block.

Table 206: RL (Rate Limiter) Block Configuration
Field Description
Rate Limit Specifies the rate per minute to increase/decrease the Output until it

matches the Input.
Startup Value Specifies the value the rate limiter block will start at when the engine is

restarted and block enable is true.
OK Accepts changes.
Cancel Cancels changes.

Editing Span Blocks
About this task:  
To edit Span blocks in Edit mode:

1. Double-click a Span block. The Span dialog box appears.
2. Edit the fields to enable or disable clamping.

Table 207: Span Block Configuration
Field Description
Clamp High Selects whether (True) or not (False) to clamp the Output at the Output

High (OH). For more information on clamping, see Span.
Clamp Low Selects whether (True) or not (False) to clamp the Output at the Output

Low (OL). For more information on clamping, see Span.
OK Accepts changes.
Cancel Cancels changes.

Editing Timing Blocks

Note: Time (logic) blocks are not editable.

Editing Delay Blocks
About this task:  
To edit Timing Category blocks in Edit mode:

1. Double-click a Delay block. The Delay dialog box appears.
2. Edit the field to configure the delay.

Table 208: Delay Block Configuration
Field Description
Startup Value Displays the initial value of the Delay block.
OK Accepts changes.
Cancel Cancels changes.

Editing TMR (Timer) Blocks
About this task:  
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To edit TMR (Timer) blocks in Edit mode:

1. Double-click a Timer block. The TMR dialog box appears.
2. Edit the timing functions of the block.

Table 209: TMR (Timer) Block Configuration
Field Description
Duration Specifies the length of the timer function in seconds. The range is 5–86,400

seconds.
Setup Determines the type of timer you use:

• Pulse
• On Delay
• Off Delay
• Minimum On
• Minimum Off

OK Accepts changes.
Cancel Cancels changes.

Adding Text Blocks
1. Click the Text icon on the Toolbar.
2. Click the workspace to select a location for the text. The text block appears.
3. Select the Select icon on the toolbar.
4. Double-click the text block to display the text editor. Edit the text and click OK.
5. Select the text block and drag the sides to resize the block.

Notes:

- To edit the text, double-click the block. The block opens for editing.
- To change the text properties, right-click the text block and select Properties from the

menu. You can change the font (type, size, bold, italic, bold italic), text color, background
color, and border visibility/color.

- Colon (:) and quote (“) characters cannot be entered by the user in this field.

Running the Logic Checker
About this task:  
To run the Logic Checker:

1. Select the Logic Checker icon from the Toolbar.
2. If the Logic Checker does not detect errors, a No Warnings Found dialog box appears. Click

OK to return to the logic.
3. If the Logic Checker detects errors, a Configuration Warnings Were Found dialog box

appears. After you click OK, the tool returns you to the logic with Information symbols over
the warning elements.

Note: The Information symbols remain unless you ignore them and save the logic or fix
the errors and run the Logic Checker successfully.

Saving a Control System
To save a control system, click Save on the Toolbar. The LCT scans for logic errors.
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Notes:
• The logic check done with the Save command is not the same as the Logic Checker run from

the toolbar.
• If inputs are missing, an error message appears asking if you want to continue with the save.

Click No to return to the logic. Click Yes to save anyway. We do not recommend saving with
errors.

Printing a Control System
To print a control system, click the print icon on the Toolbar.
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Object
The Insert Object wizard inserts one of the following object types.

Auto Shutdown Object
Menu Selection: Insert > Object > Auto Shutdown

Note: On the Configure screen, click the [...] button to select an object from the Select Item
dialog box. Then select the desired Control attribute from the drop-down menu.

When a selected multistate control point is in a specified shutdown state, the Auto Shutdown
object suppresses alarm reporting from a list of dependent objects to prevent nuisance alarms.
The Auto Shutdown object accomplishes this by sending an enable/disable command to each
of the dependent object's Alarm objects, based on the control point’s current state (the value of
the Control attribute) and the defined shutdown state. For BACnet intrinsic alarming and Event
Enrollment objects, these commands set and reset the BACnet Alarm Event Enable property flags
(To Off Normal, To Fault, and To Normal) that cause or prevent alarms. A startup delay is provided
so that points are not released immediately from shutdown.
An example of a use for the Auto Shutdown object is to prevent alarms set to monitor the discharge
air temperature of a fan when that fan is turned off. When the fan is turned off, the fan state value
is sent to the Auto Shutdown object. The Auto Shutdown object then evaluates the current state
of the point against the Shutdown State defined in the Auto Shutdown object. If the current point
state matches the Shutdown State, the Auto Shutdown object sends a Disable command to the
Alarm object of every referenced dependent object in the Dependents list.
Consequently, when the fan is turned back on, the Auto Shutdown object again evaluates the
current state and, if the current state does not match the Shutdown State, starts the Startup Delay
timer. Once the timer expires, the Auto Shutdown object sends an Enable command to the Alarm
object of every referenced dependent object in the Dependents list.

Note: Changing the Dependents or Shutdown State attribute causes an immediate
reevaluation of the current state. However, changes to the Startup Delay time do not take
effect until the next change in the control point state.

Auto Shutdown Attributes
This object contains attributes common to many Metasys system objects. These additional common
object attributes are described in the Common Object Attributes section.
Table 210: Auto Shutdown Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 W C

Indicates whether the Auto Shutdown object is enabled
(True) or disabled (False).

Control -- Engineering Values
887 C

Determines, in conjunction with the Shutdown State,
if an alarm shutdown should occur. This is the current
state of the references control point.

Dependents -- Engineering Values
888 W C

Uses each dependent object identified in this list of
object references to locate the Alarm object that is to
have its alarm reporting controlled by the control point.
Number of Entries = 1–32
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Table 210: Auto Shutdown Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Shutdown State -- Engineering Values
889 C W

Determines the definition of the shutdown state. When
the control point goes to the state defined as the
shutdown state, Auto Shutdown disables alarms from
the point.

Startup Delay -- Engineering Values
890 W C

Represents the time in minutes that must elapse before
alarm reporting is re-enabled, once the control point
changes from the Shutdown State to any other state.
Units = Minutes

Execution Priority -- Execution
2197 W C

Indicates the relative importance of performing the
function of the object within the device.

Data Broadcast Object
Menu Selection: Insert > Object > Data Broadcast

Note: On the Configure screen, click the [...] button to select the input reference object from
the Select Item dialog box. Then select the desired attribute to reference from the drop-down
menu.

The Data Broadcast object provides a means of sharing globally useful data with third-party BACnet
devices. The data value from an object/attribute to be shared is referenced by this object. Typically,
this data may be the outdoor air temperature, or a value indicating whether a building is occupied.
The Data Broadcast then broadcasts an Unconfirmed COV Notification message containing the
referenced data value when it changes.
On a site containing only Metasys devices, the Data Broadcast object is not useful, and should not
be created.
As the number of these objects on a site increases, the network performance may suffer due to
excessive broadcasts. Therefore, use Data Broadcast objects only when necessary.

Data Broadcast Concepts

Unconfirmed COV Notification
Unconfirmed COV Notification is a BACnet service that can be used to distribute object attributes of
wide interest to many devices simultaneously without a subscription.

Data Broadcast Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Table 211: Data Broadcast Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 C W

Indicates whether the Data Broadcast object is enabled or
disabled

Input Reference -- Engineering
Values
132 C

Specifies the object and attribute value that is monitored for
COVs. This object’s attribute value, if reliable, is then broadcast
in an Unconfirmed COV Notification message.

COV Period -- Engineering Values
180 C W

Broadcasts an Unconfirmed COV on a periodic basis. When set
to a value from 30 to 86,400, this object issues an Unconfirmed
COV containing the attribute value and status flags at least
once every period. This broadcast occurs even when the
value remains unchanged. If an actual change of value occurs
during the period and a COV is sent, the timer for the periodic
COV resets. To disable the periodic broadcast feature, clear the
value from the COV Period and save the change. The null entry
represents not sending period.

Demand Limiting/Load Rolling (DLLR) Object
Menu Selection: Insert > Object > DLLR
The Demand Limiting feature helps you save money by limiting peak energy usage. The Load
Rolling feature helps save money by reducing overall energy consumption. The DL portion of DLLR
selectively turns off (sheds) equipment, such as fans and lights, or adjusts setpoints to limit energy
use during peak times. The LR portion acts continuously to maintain a specified energy reduction
by shedding unnecessary loads. A facility can implement either one or both of these strategies.
The DLLR object represents the attributes, commands, and reports that define the DLLR
functionality. For information on the features and operation of DLLR, refer to the DLLR Technical
Bulletin (LIT-12011288).

DLLR Object Attributes
The DLLR object is divided into three tabs, the Focus/Configuration Tab, the Profile Tab, and the
Load Summary Tab. If you add extensions to this object, see Extensions for descriptions of the
extension tabs.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Object Type -- Object
79

The Object Type attribute indicates the Object Type as displayed in the
Metasys software and as exposed to a BACnet network.

Name -- Object
2390 C W

The Name attribute contains a freely definable user-friendly name for
the object that is independent of the Item Reference or the location of
the object in the physical network. The Name is used as the label in the
All Items navigation tree. The Name is shown in alarm reports, the event
and audit viewers, and in summaries. The Name does not need to be
unique to the site.
The Name defaults to the object identifier you used during manual object
creation but can be edited later.

Enabled -- Object
673 C W

The Enabled attribute provides a mechanism to stop DLLR operation.
When disabled, DLLR releases all shed loads except those that are locked
shed. Also, DLLR does not perform any calculations, report alarms, or
issue any commands to any loads when disabled. DLLR attributes can be
changed, but no actions are taken until DLLR is enabled.
When enabled, DLLR operation starts again. If Shed mode is active, the
configured DLLR strategies begin shedding loads as needed. If Monitor
Only mode is configured, simulated load shedding begins.

Authorization Category
-- Object
908 C W

The Authorization Category classifies the object by the category of
system or equipment that it monitors to aid in the determination of user
access privileges and alarm routing.
Examples: Energy, HVAC, Fire, Security

Description -- Object
28 C W

The Description attribute contains a user-defined description of the
object.

Shed Strategy -- Setup
4187 C W

The Shed Strategy attribute allows you to specify which shedding
strategy the DLLR uses. The Shed Strategies include:

• Demand Limiting and Load Rolling
• Demand Limiting Only
• Load Rolling Only (default)

Mode -- Setup
961 C W

The Mode attribute controls whether DLLR is actively shedding Loads
(Shed mode) or is simulating Load shedding (Monitor Only mode). The
mode pertains to both the Demand Limiting and Load Rolling strategies
simultaneously. The Modes include:

• Monitor Only - simulated shedding occurs, where loads appear shed
but output points are not actually commanded or turned off.

• Shed - true shedding occurs where output points are commanded.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Monitor Mode Release
-- Setup
1016 C W

The Monitor Mode Release attribute allows you to specify the load output
release behavior when DLLR is commanded to Monitor Only mode from
Shed mode. If set to Release immediately, the outputs of loads that
are not locked are immediately released regardless of whether their
Minimum Shed Time has expired. If set to Release After Min Shed Time,
the outputs of loads that are not locked are released only after their
Minimum Shed Time expires. Possible behaviors include:

• Release Immediately
• Release After Min Shed Time

Meter Object -- Setup
2110 C W

The Meter Object identifies the Metasys object (for example, Pulse Meter,
AI, AV) that is used for the energy rate if the Demand Limiting strategy
is configured. If only the Load Rolling strategy is used, a meter is not
required. The Meter Object should be defined on the same supervisory
controller as the DLLR Object. Do not use an N1 Integration object for the
meter unless you can guarantee that the NCM Service Time is always less
than 60 seconds because the DLLR algorithm requires an updated meter
value every minute.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Profile Tracking Period
-- Setup
4191 C W

The Monitor Mode Release attribute allows you to specify the load output
release behavior when DLLR is commanded to Monitor Only mode from
Shed mode. If set to Release immediately, the outputs of loads that
are not locked are immediately released regardless of whether their
Minimum Shed Time has expired. If set to Release After Min Shed Time,
the outputs of loads that are not locked are released only after their
Minimum Shed Time expires. Possible behaviors include:

• Release Immediately
• Release After Min Shed Time

Table 213: Load Output Release Options
Profile Tracking
Period

Start Time End Time

Hourly At the top of the
current hour.
Example: 08:00:00 A.M.

60 minutes from the
current hour.
Example: 09:00:00 A.M.

Daily 12:00:00 A.M. current
day

12:00:00 A.M. next day

Weekly 12:00:00 A.M. Monday
of current week

12:00:00 A.M. Monday
of the next week

Monthly 12:00:00 A.M. first day
of current month

12:00:00 A.M. first day
next month

Manual The moment when the
Reset Profile command
is issued.

Always Not Specified

There are three exceptions to when the Start Times and End Times can
vary from what is shown in Table 218. The Start Times and End Times
differ when:

• a Reset Profile command is issued to the DLLR object while in Shed
or Monitor Only mode

• a Reset Initialization Parameters command is issued to the DLLR
object while in Monitor Only mode

• the controller is downloaded or reset
Note: The Start Times and End Times are not reset when DLLR changes
from Monitor Only mode to Shed mode. Also, when the DLLR object is dis-
abled, the current profile is copied to the previous profile, the current profile
values are all set to 0, and the times are all set to undefined.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

DLLR Startup Behavior
-- Setup
4282 C

The DLLR Startup Behavior attribute selects which mode the feature is
set to whenever the supervisory controller is restarted or its database is
downloaded. Two selections are offered:

• Startup in Monitor Only mode - DLLR starts in Monitor Only mode,
even if it had been commanded or configured to Shed mode before
the restart or download. Also, if the DLLR object was disabled while
in Shed mode, it reverts to Monitor Only mode when enabled.

• Startup in last commanded mode - DLLR starts in the mode that
was active at the time the controller was restarted or its database
downloaded.

Regardless of the selection, the following also apply:

• Any Comfort Override commands that were in place before the
startup are persisted.

• Any previous Shed commands are not automatically persisted
to loads on startup. DLLR evaluates the current situation and
completes all calculations before issuing any new Shed commands
to loads.

• When DLLR starts issuing Shed commands to loads, it resumes
where it left off with the first eligible, lowest-priority load.

Stop DLLR audits in
Monitor Only mode --
Setup
4500 C W

The Stop DLLR Audits in Monitor Only Mode attribute specifies whether
an audit entry is created each time a load is shed or released when DLLR
is in Monitor Only mode and the NAE’s Enabled Audit Level is set to 3
or 4. (When DLLR is in Active mode, an audit entry is always created to
record that event.) The default is False, but if you set it to True, no audit
entries are created in Monitor Only mode.

Demand Interval
Length -- Demand
Limiting
2112 C W

The Demand Interval Length attribute specifies the length in minutes
of an interval for the Demand Limiting strategy. This value is normally
obtained from the energy utility. The DLLR Interval Lengths set specifies
the possible interval lengths (15, 30, or 60).

Algorithm
2114 C W

The Algorithm attribute specifies which algorithm is used for the Demand
Limiting strategy (Fixed Window or Sliding Window). In most cases, the
Sliding Window Algorithm is required by North American utilities, while
the Fixed Window Algorithm is used by European utilities.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

DL Tariff Targets --
Demand Limiting
4185 C W

The DL Tariff Targets attribute is the list of energy targets for the
Demand Limiting strategy. Each target consists of a target value and an
entry from the Target Description set identifying the type of target, such
as On-Peak. If the Demand Limiting strategy is used, there must be at
least one target defined. Only one target is active at any time. The Active
DL Target attribute specifies which target is currently active. The Target
Description set includes:

• Continuous
• Off-Peak
• On-Peak
• Semi-Peak
• Shoulder
• Summer Off-Peak
• Summer On-Peak
• Winter Off-Peak
• Winter On-Peak
• Summer Semi-Peak
• Winter Semi-Peak
• Summer Shoulder
• Winter Shoulder

Active DL Target --
Demand Limiting
4208 C W

The Active DL Target specifies which of the defined Demand Limiting
targets is currently active. When this attribute changes, the Active
DL Target Changed attribute indicates True until the start of the next
interval. This attribute uses the Target Description enumeration set.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

LR Tariff Target -- Load
Rolling
4186 C W

The LR Tariff Targets attribute lists the energy targets for the Load Rolling
strategy. Each target consists of a target value and an entry from the
Target Description set identifying the type of target, such as On-Peak.
If the Load Rolling strategy is used, there must be at least one target
defined. Only one target is active at a time. The Active LR Target attribute
specifies which LR Target is currently active. The Target Description set
includes:

• Continuous
• Off-Peak
• On-Peak
• Semi-Peak
• Shoulder
• Summer Off-Peak
• Summer On-Peak
• Winter Off-Peak
• Winter On-Peak
• Summer Semi-Peak
• Winter Semi-Peak
• Summer Shoulder
• Winter Shoulder

Active LR Target -- Load
Rolling
4209 C W

The Active LR Target attribute specifies which of the defined Load Rolling
targets is currently active. When this attribute changes, the Active LR
Target Changed attribute indicates True until the start of the next interval
if demand limiting is configured, or the next minute if load rolling only is
configured. This attribute uses the Target Description enumeration set.

EOI Attribute -- Fixed
Window Alg
2115 C W

The EOI attribute is a reference to the Metasys object (for example, BI, BV)
supplying the EOI pulse, which is used for the Fixed Window algorithm
only. The EOI pulse is used to synchronize DLLR’s demand interval to the
utility’s demand interval. If this is not specified, DLLR performs its own
interval timing, which is not as accurate.
This EOI attribute can be any binary type object, as long as the following
requirements are met:

• A permanent communication path must exist between this attribute
and the DLLR object; therefore, the EOI point and DLLR object
should reside on the same supervisory controller.

• The attribute must be a numerical attribute, in which a change from
0 to 1 indicates the end of interval and the beginning of the next
interval. The EOI Status attribute is set to Off Normal when the
object supplying the EOI pulse becomes offline or unreliable to the
DLLR object.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Display Precision --
Display
661 C W

The Display Precision attribute defines the decimal display precision for
all real values (floating values) in the DLLR object.

Rate Units -- Display
819 C W

The Rate Units attribute specifies the energy units used for
instantaneous energy demand attributes and referenced in the DLLR
Profile and Load Summary (for example, kW). If a meter is defined, the
Rate Units attribute indicates the units of the meter.

Consumption Units --
Display
820 C W

The Consumption Units attribute specifies the consumption energy units
(for example, kWh).

Unreliable Meter Shed
Rate -- Advanced
Demand Limiting
4190 C W

The Unreliable Meter Shed Rate attribute specifies how much load the
DLLR object should keep shed if the meter goes unreliable, provided
the Use Unreliable Meter Shed Rate option is selected for the Unreliable
Meter Options attribute.

Unreliable Meter
Options -- Advanced
Demand Limiting
4189 C W

The Unreliable Meter Options attribute allows you to specify what should
happen to Demand Limiting if the meter becomes unreliable or goes
offline. These options are as follows:

• Stop Shedding - no more shedding occurs until the meter is again
reliable. Currently, shed loads continue to be shed until their Max
Shed Time expires.

• Maintain the Current Shed Rate - as loads are released, DLLR
sheds other Loads to maintain the current amount of shed load.

• Use Unreliable Meter Shed Rate - sheds or releases loads as
needed to maintain the amount of load specified in the Unreliable
Meter Shed Rate.

The second and third options cause Demand Limiting to act similarly
to the Load Rolling strategy. If the Demand Limiting strategy is not
defined, an offline or unreliable meter prompts no actions. Also, when
the meter goes offline or unreliable, DLLR sets its Meter Status attribute
to Off Normal and continuously updates its Minutes Since Meter Failure
attribute (up to the interval length) until the meter is again reliable. The
Minutes Since Meter Failure value is listed under the Operational Data
section of the DLLR object - Advanced view.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Limit Elevation -- Fixed
Window Alg Advanced
2117 C W

The Limit Elevation attribute indicates the amount (in percent) by which
the demand limit is increased at the beginning of the next interval to
obtain the starting value of the demand limit profile. A high value may
result in increased shedding toward the end of an interval. Changing
this interval affects the next interval, not the current interval. As shown
in Figure 62, the demand limit profile specifies for each minute the
maximum allowed average power during the whole interval. If too much
energy is consumed during the first half of the interval, because the limit
elevation allowed this consumption, then more loads are shed during
the second half of the interval, even though the actual metered power
is then below the demand limit profile. In other words, the net effect of
limit elevation is to defer aggressive load shedding to the second half of
the fixed demand interval.

Figure 46: Use of Limit Elevation on a Demand Limit Profile

Sensitivity -- Sliding
Window Alg Advanced
2125 C W

The Sensitivity attribute specifies the level of aggression for shedding
Loads when using the Sliding Window algorithm. A High sensitivity sheds
more loads sooner than a Low sensitivity.

• Low setting - allows you to start shedding loads later and shedding
loads over a shorter period of time. This setting reduces the amount
of equipment that is turned off; however, it increases the possibility
of exceeding the target.

• Medium setting - (default) allows you to start shedding slightly
earlier than a low setting and later than a high setting. This setting
turns off equipment earlier than with a low setting, but does not
have to turn off as much equipment at once as with the high setting.

• High setting - allows you to begin shedding sooner into the
demand peak. This setting decreases the possibility of exceeding
the target; however, it increases the amount of equipment that is
turned off.
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Table 212: DLLR Object Attributes
Name / View Group
Attribute ID
Configurable (C)
Writable (W)

Attribute Description

Target Ramp Down
Enabled -- Sliding
Window Alg Advanced
1660 C W

The Target Ramp Down Enabled attribute specifies whether a target
reduction causes an incremental ramp down over the course of one
interval, as opposed to an immediate target drop that could result in
major immediate Load shedding.

Error Limit -- Sliding
Window Alg Advanced
34 C W

The Error Limit attribute limits the Smoothed ABS Error to a percentage
of the Active Demand Limit. It can be used to reduce the size of the
safety margin to avoid unnecessary overshedding. This value should
be changed with care, since it increases the possibility of exceeding the
demand limit target. The default value is 10%.

DLLR Object Features
DLLR Object Icon
Table 214: DLLR Object Icon
Icon Key Words

Gears, Spinning gears

Global Data Object
Menu Selection: Insert > Object > Global Data
The Global Data object provides a means for distributing information about changes in a single
attribute value to other attribute reference points. This minimizes hardware costs and system
complexity. For example, an NAE might have multiple AHUs on its network, but only one has an
outdoor air sensor. The Global Data object can share the value from the single sensor with the
other AHUs.
The data types defined for the Global Data object’s input and corresponding outputs should match.
Otherwise, each output attempts to convert the value being received to the data type defined for
it. The software does not check for data type consistency. Global data sharing is restricted to within
one site.
For general information on Metasys system objects, see Common Object Attributes.

Global Data Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes unique to
the Global Data object. See the Object and Feature Tabs section for information on the attributes
that appear on the other tabs of this object (for example, the Hardware and Options tab appear on
point objects).
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Table 215: Global Data Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 C W

Indicates whether the Global Data object is enabled or disabled

Set Up -- Engineering Values
518 C

Defines whether the Fail Soft or Last Reliable value needs to be the
output if the object becomes unreliable.

Master -- Engineering Values
1059 C W

Contains an attribute reference. The value associated with
this attribute is written to each of the designated subordinate
destinations.

Alternate Master --
Engineering Values
895 C W

Defines an alternate to the Master. When the Master becomes
unreliable, this attribute becomes the master attribute.

Subordinates List --
Engineering Values
1061 C W

Contains a list of attribute references. Each subordinate identified
in this list of attribute references receives its value from the
Master.

Refresh Timer -- Engineering
Values
2325 C W

Indicates the amount of time, in minutes, between updates to
the subordinates from the Master or Alternate Master. Updates
initiated by the refresh timer occur in addition to updates initiated
by a COV from the Master/Alt Master. For example, if the Refresh
Timer attribute’s value is 2, the Global Data object updates the
subordinates with information from the Master/Alt Master every 2
minutes and with each COV.
If this attribute is set to zero instead, updates are only sent upon
receipt of additional COV reports.

Failsoft -- Engineering Values
2567 C W

Routes to all the outputs if Setup is configured as Fail Soft. Fail Soft
routes when the object becomes unreliable and when the output
transitions from Reliable to Unreliable. This attribute is initialized
to a specific value.

Priority For Writing --
Engineering Values
88 C W

Defines the priority at which the referenced attributes are
commanded. Seven is the highest priority and 16 is the lowest
supported by the Global Data object, with the default of 15.

Note: We do not recommend using priorities 7 or 8 as they may
interfere with the operator override function.

Execution Priority -- Execution
2197 C W

Indicates the relative importance of performing the function of the
object within the device.

Interlock
Menu Selection: Insert > Object > Interlock
The Interlock object provides a means to establish conditional control over one or more other
objects. It consists of an IF conditional statement, True command statements, and False command
statements. Through these statements, the user specifies a set of conditional checks (using one or
more points) for which a series of commands is used to control a collection of one or more other
objects.
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Three essential parameters of the IF conditional statement, shown in the following list, determine
the Interlock object’s mode of operation:

• list of attribute references
• constants
• operators

This object allows a user to place a VAV controller in the occupied mode whenever the main fan is
on and in the occupied mode.

Note: On the Configure screen, click the Interlock Definition and Action Tables tabs for further
configuration.

Tips for the Interlock Definition tab of the Configure screen:

• Click the Add button to add items to the list from the Select Item dialog box.
• Click the check box next to an item in the list and click Delete to remove the item from the list.
• Select the type of logic to use for the items in the list from the Logic menu. See the Interlock’s

Logic attribute description for the types of logic.
Tips for the Action Tables tab of the Configure screen:

• Check the All Commands Priority check box if you wish to use the same priority for all
commands in the action tables. Clear the All Commands Priority check box to enable
individual priority selection for the commands in the action tables.

• For the Actions for Condition: True and Actions for Condition: False tables, click the Add
button to add items to the table from the Select Item dialog box.

• For the Actions for Condition: True and Actions for Condition: False sections, click the check
box next to an item in the table and click Delete if you want to remove the item from the table.

For general information on Metasys system objects, see Common Object Attributes.
For information on the logic used in the interlock object, see the Logic attribute description.

Interlock Configuration
Configure the attributes of the Focus/Configuration, Interlock Definition, and Action Tables tabs of
the Interlock object. See the Interlock Attributes section for descriptions of the attributes on these
tabs.
On the Focus/Configuration tab, click the Advanced radio button to view and edit all the attributes
available on this tab.
On the Interlock Definition tab, define the items/objects to control and the desired conditional
logic.
Tips for this tab include:

• Click the Add button to add items to the list from the Select Item dialog box. You can also
select items from the All Items tree or from the Global Search results and drop them into the
Interlock Definition table.

• Click the check box next to an item in the list and click Delete to remove the item from the list.
• Select the type of logic to use for the items in the list from the Logic menu. See the Logic

attribute description for the types of logic.
On the Action Tables tab, define the commands and the priority for the items/objects under
control.
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Figure 47: Example of Interlock Action Table Headers and Options

Tips for this tab include:
• Check the All Commands Priority check box if you wish to use the same priority for all

commands in the action tables. Clear the All Commands Priority check box to enable
individual priority selection for the commands in the action tables.

• Check the Add New Items to All Conditions check box if you wish to add new items to both
the Actions for Condition: True and Actions for Condition: False tables. The Add New Items
to All Conditions is selected by default.

• For the Actions for Condition: True and Actions for Condition: False tables, click the Add
button to add items to the table from the Select Item dialog box. You can also select items
from the All Items tree or from the Global Search results and drop them into the Interlock
Action tables.

• For the Actions for Condition: True and the Actions for Condition: False tables, click the
check box next to an item in the table and click Delete if you want to remove the item from the
table.

• To select all items within a table, click the Select All column header. To unselect all items within
a table, click the Select All column header again.

• To mass command items in the Actions for Condition: True or the Actions for Condition:
False, select similar items that have the same configured attributes and enumerations
(for example, select multiple BVs). Right-click the Command column header and click Set
Command. Or, click Set Command. The Set Command for Selected Items appears.

Figure 48: Right-Click Set Command Option

• To mass set delay, select multiple items (can be dissimilar items), input a delay in the Set Delay
field, and click Set Delay.

Interlock Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
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Table 216: Interlock Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 C W

Ensures object reacts to any changes it may have missed while it was
disabled, and returns it to normal operation.

Restore Command Priority
-- Restart Options
721 C W

Selects which commands (at a selected priority) persist through
a device restart. When the bit is set, the command (at a selected
priority) is saved at shutdown and restored at startup.

States Text -- Display
931 C W

Indicates the displayed strings for the Present Value.

Execution Priority --
Execution
2197 C W

Indicates the relative importance of performing the function of the
object within the device.

Interlock Commands
The table below lists the commands supported by the Interlock.
Table 217: Interlock Commands
Command
Name

Parameters Description

Disable None Locks out all outputs and prevents the Interlock
functionality.

Enable None Ensures object reacts to any changes it may have missed
while it was disabled, and returns it to normal operation.

Operator
Override

The value to be
written to the
Present Value
attribute. This
parameter has a True
or False data type.

Updates the Present Value at Command Priority Operator
Override.

Important: The Operator Override command sends the
specified command to the internal NxE object, which is
then only sent to the field device when one of the follow-
ing conditions is met: a) NOT Local Control and NOT Out

Release
Operator
Override

None Releases Command Priority Operator Override from
Present Value.

Re-command None Reissues the commands for the current state.
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Table 217: Interlock Commands
Command
Name

Parameters Description

Release Attribute name
Command priority

Releases the identified command priority from the
specified, writable attribute, and allows it to be controlled
by the
next highest priority.

Release All Attribute name Releases Command Priorities 3 through 16 from the
specified, writable attribute. Command Priorities1 and 2
remain.

Note: The Release All command may not cause an imme-
diate return to automatic operation. The Release All com-
mand clears all command priorities, including those that
come from applications and features. When this happens,
the output point goes to its Relinquish Default condition.
In some cases, the application or feature may have sent
a command that does not match Relinquish Default. In
this instance, the output point does not end in the state
that the applications or features intended. This situation
can cause unexpected operation to occur; for example, a
space could overcool or overheat, a fan might run longer
than expected, and so on. If an operator has overridden an
input, use the Release Operator Override command.

Loop Object
Menu Selection: Insert > Object > Loop
The Loop object allows a third-party BACnet workstation to represent a control loop in a
standard way. If you use the Site Management Portal as the primary mechanisms to view system
information, you do not need to use the Loop object.
The Loop object represents the key information from a PID logic module. The object does not
execute the PID algorithm but simply allows you to represent the key parameters of a PID logic
module in a Focus tab view.
The Loop object uses the data provided by mapped field points to execute the BACnet intrinsic
alarming algorithm. First, create a folder and map the field points representing the loop
information. Then use the Insert Object wizard to add the Loop object to the same folder and
configure references to the mapped points representing the loop information. The Loop object
reads the information indicated by the references, and presents the values received in the Focus
tab of the Loop object.
The behavior of the Loop object’s intrinsic alarming algorithm is as follows:

• The loop object generates a TO OFFNORMAL event when the difference between the Setpoint
Value and the Controlled Variable Value remain outside the band defined by the Error Limit
and the Time Delay has been exceeded.

• The loop object generates a TO NORMAL event when the difference between the Setpoint
Value and the Controlled Variable Value is within the band defined by the Error Limit.

Note: You must configure references to the BACnet required properties to successfully
create the Loop object. These references appear red in the wizard until configured. You may
optionally configure references for the BACnet optional properties. If you do not define the
optional references for some reason, the Loop object responds to a read for the corresponding
value with an Unknown Property error. These BACnet required and optional properties are
noted with footnotes in the attribute table. See Loop Attributes.
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Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 218: Loop Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Intrinsic Alarming Defined --
BACnet
569 C W

Enables the BACnet Intrinsic Alarming feature in the
object and the definition of related attributes. For detailed
information, see BACnet Intrinsic Alarming.

Manipulated Variable Reference --
Reference
4682 C

Defines the field point mapper that represents the
destination of the output of the control loop.

Controlled Variable Reference --
Reference
4683 C

Defines the field point mapper that represents the source of
the input to the control loop.

Setpoint Variable Reference --
Reference
4690 C

Defines the field point mapper that represents the setpoint
for the control loop.

Proportional Constant Reference --
Reference
4684 C

Provides the object reference for the Proportional Const
attribute. The Loop object reads and signs up for changes in
the Present Value attribute of the object referenced by the
Proportional Constant Reference. The value received is stored
as the Proportional Const.

Integral Constant Reference --
Reference
4685 C

Provides the object reference for the Integral Constant
attribute. The Loop object reads and signs up for changes in
the Present Value attribute of the object referenced by the
Integral Constant Reference. The value received is stored as
the Integral Constant.

Derivative Constant Reference --
Reference
4686 C

Provides the object reference for the Derivative Constant
attribute. The Loop object reads and signs up for changes in
the Present Value attribute of the object referenced by the
Derivative Constant Reference. The value received is stored
as the Derivative Constant.

Bias Reference -- Reference
4687 C

Provides the object reference for the Bias attribute. The Loop
object reads and signs up for changes in the Present
Value attribute of the object referenced by the Bias
Reference. The value received is stored as the Bias.

Maximum Output Reference --
Reference
4688 C

Provides the object reference for the Max Output attribute.
The Loop object reads and signs up for changes in the
Present Value attribute of the object referenced by the
Maximum Output Reference. The value received is stored as
the Max Output.
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Table 218: Loop Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Minimum Output Reference --
Reference
4689 C

Provides the object reference for the Min Output attribute.
The Loop object reads and signs up for changes in the
Present Value attribute of the object referenced by the
Minimum Output Reference. The value received is stored as
the Min Output.

JCI Out of Service Reference --
Reference
12201 C W

Provides the object reference for the JCI Out of Service
attribute. The Loop object reads and signs up for changes in
the Present Value attribute of the object referenced by the JCI
Out of Service Reference. The reference must be a BI, BO, or
BV object. When the state of the JCI Out of Service Reference
is True, the PID loop algorithm is placed out of service.

JCI Out of Service Value Reference
-- Reference
12202 C W

Provides the object reference for the JCI Out of Service Value
Reference attribute. The Loop object reads and signs up
for changes in the Present Value attribute of the object
referenced by the JCI Out of Service Value Reference. The
reference must be an AI, AO, or AV object. When the Loop
object is out of service, its Present Value assumes the value of
this referenced object.

Manual Tuning -- True or False
3408 C

Controls whether the gain values of the PID Loop object can
be changed. These values include Proportional Constant,
Derivative Constant, Integral Constant, Bias, Maximum
Output, and Minimum Output. When the value of this
attribute is False, these referenced values cannot be
changed.

Loop Commands
The table below lists the commands supported by the Loop Object.
Table 219: Loop Commands
Command
Name

Parameters Description

Disable
Alarms

None Disables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects. This command
restores the previous Event Enable values.

Enable
Alarms

None Enables all types of alarming: alarm extensions, BACnet intrinsic
alarming, and BACnet Event Enrollment objects. This command
sets the Event Enable values to False, False, False.

In Service None Places the PID loop object algorithm in service.
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Table 219: Loop Commands
Command
Name

Parameters Description

Manual
Tuning

None Enables or disables the ability to change gain values of the
PID Loop object, including Proportional Constant, Derivative
Constant, Integral Constant, Bias, Maximum Output, and
Minimum Output.

Out of
Service

Real value Places the PID loop object algorithm out of service. The value
specified in the command is written to the JCI Out of Service
Value Reference. The Present Value of the Loop object assumes
the value of the JCI Out of Service Value Reference while out of
service.

Multiple Command Object
Menu Selection: Insert > Object > Multiple Command

Note:
• On the Configure screen, click the Action Tables tab for further configuration.
• Select or enter the desired value for the Relinquish Default. Edit the States Text and

Number of States attributes on the Focus tab.
• Check the All Commands Priority check box if you wish to use the same priority for all

commands. Clear the All Commands Priority check box to enable individual priority
selection for the commands.

- For each of the Actions for Condition (State 0 - State N) tables, click the Add button
to add items to the table from the Select Item navigation tree.

- For each of the Actions for Condition (State 0 - State N) tables, click the
check box next to an item in the table and click Delete to remove the item
from the table.

The Multiple Command object issues a series of commands to multiple objects by means of a single
command action. Commanding this object results in the execution of the commands for the given
state. This object supports States 1–32.
This object allows a user to start building controls for the day with one command or to prevent
selected points from generating COS and alarm messages when a control point is in a specified
state (Auto Shutdown).
For example, based on a single input, such as Room Occupied, a defined set of actions can occur:
setpoint goes to 72˚, a fan comes on, lights come on, and the door unlocks.
For general information on Metasys system objects, see the Common Object Attributes section.

Multiple Command Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).

Note: In the Notes column, letters indicate the following: In the notes column, letters indicate
the following: C - Configurable, D - Default Attribute for Display, N - Value Not Required, R -
Affected by Extension’s Reliability, W - Writable.
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Table 220: Multiple Command Object Attributes - Focus/Configuration Tab
Attribute Name Notes Initial Value Values/Options/Range Description
Enabled Indicates whether the Multiple Command object is

enabled or disabled.
Executing False False, True Specifies the current execution status of the

object. It is True when the object receives a state
command and starts sending commands. When
all actions are completed for a given state, this
flag is set to False.

Execution Priority C,W Indicates the relative importance of performing
the function of the object within the device.

Last Executed Date N Indicates the date stamp for the beginning of
executing the current state.

Last Executed Time N Indicates the time stamp for the beginning of
executing the current state.

Table 221: Multiple Command Object Attributes - Action Tables Tab
Attribute Name Notes Initial Value Values/Options/Range Description
Action Table
(State0. . . StateN)

C,W Object Reference,
Delay, Command ID,
Parameters, Priority

Lists actions to take for each supported state.
Each action of the table contains a subordinate
object reference, a delay, a command and its
associated parameters, and a priority. The
priority in this table is used only when Commands
Priority is set to No Priority. The delay is the
number of seconds before the given command
is issued. Command delays can be lengthened
or shortened to result in commands being sent
out after, before, or at the same time as any other
command.
The total number of commands identified in the
Action Table command set should not exceed 40.

Command Priority C,W 16 Uses Write Priority (Set
1).

Determines the order by importance for all
commands sent. If it is set to Priority None,
commands will be sent at each individual priority
specified in the Action Table attribute.

Number of States C 4 1–32 Specifies the number of possible states this object
can have.

Relinquish Default Specifies the default value to be used for the
Present Value attribute when no commands
are currently controlling this object. If this
attribute is configured to any value other than
None, the object sends commands for the value
immediately.

States Text C States Indicates the displayed strings for the Present
Value.

Multiple Command Attribute Details

Action Table (State0. . . StateN)
Tips for the Action Tables tab:

• Click the Add button to add items to the list from the Select Item dialog box. You can also
select items from the All Items tree or from the Global Search results and drop them into the
Action table.

• Click the check box next to an item in the list and click Delete to remove the item from the list.
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• To select all items within a table, click the Select All column header. To unselect all items within
a table, click the Select All column header again.

• To mass command items, select similar items that have the same configured attributes and
enumerations (for example, select multiple BVs). Right-click the Command column header and
click Set Command. Or, click Set Command. The Set Command for Selected Items appears.

Figure 49: Right-Click Set Command Option

Command Priority
Determines the order by importance for all commands sent. If it is set to Priority None, commands
will be sent at each individual priority specified in the Action Table attribute.

Enabled
Indicates whether the Multiple Command object is enabled or disabled.

Executing
Specifies the current execution status of the object. It is True when the object receives a state
command and starts sending commands. When all actions are completed for a given state, this flag
is set to False.

Execution Priority
Indicates the relative importance of performing the function of the object within the device.

Last Executed Date
Indicates the date stamp for the beginning of executing the current state.

Last Executed Time
Indicates the time stamp for the beginning of executing the current state.

Number of States
Specifies the number of possible states this object can have.

Relinquish Default
Specifies the default value to be used for the Present Value attribute when no commands are
currently controlling this object. If this attribute is configured to any value other than None, the
object sends commands for the value immediately.

Send OK
Indicates the success or failure of the subordinate commands. If any subordinate commands failed,
this attribute is set to False. When a send error is detected, a 5-minute timer is set. When the timer
expires, the object is reevaluated and all commands are sent again. Commands may fail if the
subordinate object is off-box and offline or if the subordinate object is set for local control.

States Text
Indicates the displayed strings for the Present Value.

N1 PID Loop Object
The N1 PIDL object generates outputs to maintain a measured value at a desired level. The PIDL
performs Proportional, Integral, and Derivative control. The PID Loop object manipulates outputs
for closed loop control at a given Digital Control Module (DCM101 or DCM140).
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Note: For the PIDL object, the only difference between DCM101 and DCM140 operation is that
the DCM101 has up to 16 PID Loops, and the DCM140 has up to 20 PID Loops.

The PID Loop object generates outputs for closed loop control by using a collection of inputs and
other variables to perform calculations and issue commands. Each PID Loop object can accept up to
six analog inputs, and issue commands to a maximum of eight analog outputs. Inputs come from
AI objects. Outputs are sent to AOD objects or other PID Loops.
A primary function of the PID Loop object is to perform Proportional plus Integral plus Derivative
calculations in order to maintain steady and accurate control of a closed loop. PID calculations take
into account the past, present, and future (forecasted) performance of loop inputs for the purpose
of adjusting outputs to correct levels. You can configure the PID Loop object to compute any or all
of the following:

• Proportional Only: Present performance is analyzed by computing the difference between
the PID Loop setpoint and its feedback. This difference is called an error. With proportional
control, the output signal is directly proportional to the difference between the input and the
setpoint (that is, the error).

• Proportional plus Integral: Present and past performance are analyzed in this calculation to
affect the output. The error computed in the proportional calculation is now integrated (that is,
accumulated over time). If the loop failed to reach setpoint in the past, the integration causes
the output to increase or decrease to maintain setpoint.

• Proportional plus Integral plus Derivative: This calculation uses past, present, and future
(forecasted) performance. The derivative part of the computation analyzes the rate of change
of the feedback to predict the future value of the feedback. As the feedback changes faster, the
PID Loop issues outputs that slow down the rate of change.

You can use the PID Loop object with a variety of control schemes, including sequencing a number
of physical devices to maintain control of a closed loop. Additional functions of the PID Loop
object include Self-tuning PID Control, bumpless transfer, and an auxiliary switch. Self-tuning PID
Control automatically and continually self-tunes the PID Loop to ensure correct feedback levels. The
auxiliary switch allows another PID Loop object or a control process to take control of the closed
loop. When control of a closed loop is turned over to the PID Loop object, the bumpless transfer
function provides for a smooth and predictable transition.

N1 PID Loop Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. This section includes attributes of the
Focus/Configuration tab, the Diagnostics tab (if applicable), and any other tab specific only to this
object. See the Object and Feature Tabs section for information on the attributes that appear on the
other tabs of this object (for example, the Hardware and Options tab appear on point objects).
Table 222: N1 PID Loop Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Min Value -- Engineering
Value
69 W C

Defines the lowest reliable value (in engineering units) for the
Present Value.

Max Value -- Engineering
Value
65 W C

Defines the highest reliable value (in engineering units) for the
Present Value.

Units -- Display
117 W C

Contains the engineering units for the Present Value attribute.
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Table 222: N1 PID Loop Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Display Precision -- Display
661 W C

Defines the decimal rounding and the decimal places to display for
the Present Value and associated attributes.

COV Increment -- Display
22 W C

Defines the minimum change in the Present Value required for the
object to report a change.

Device Type -- BACnet
31 W C

Contains a description of the physical device connected to the
object.

N1 PID Loop Commands
The following table lists the commands supported by the N1 PID Loop Object.

Note: For the Release Operator Override, Release, and Release All commands, if all Command
Priorities have been released and a Relinquish Default is not defined, the supervisory
controller gives control to the actual hardware.

Table 223: N1 PID Loop Object Commands
Command Name Parameters Command Description
Adjust The value to be written to the

Setpoint. The value must be less
than Max Value and greater than
Min Value.

Releases Command Priorities 9 through
15 (Scheduling) and then writes to the
Setpoint at the Default (16) command
priority. The value must be less than
Max Value and greater than Min Value.
If Local Control is True, this command
is rejected.
The command is only sent when one
of the following conditions is met: a)
NOT Local Control and NOT Out of
Service, or b) NOT Local Control and
after issuing the In Service command.

Disable Alarms None Disables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.

Enable Alarms None Enables all types of alarming: alarm
extensions, BACnet intrinsic alarming,
and BACnet Event Enrollment objects.

In Service None Cancels the effect of an Out of Service
command and returns the Out of
Service attribute to False. The Setpoint
and Reliability revert back to the values
obtained from the physical hardware
output.

Note: For BACnet objects, support
of this command is dependent on
the ability to write the Out of Service
attribute.
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Table 223: N1 PID Loop Object Commands
Command Name Parameters Command Description
Operator Override The value to be written to the

Setpoint.
Updates the Setpoint at Command
Priority Operator Override (8).
The Operator Override command
sends the specified command to the
internal NxE object, which is then only
sent to the field device when not Out of
Service.

Out of Service None Allows a user to override the object's
hardware output. The Out of Service
command changes the Out of Service
attribute to True. The Setpoint and
Reliability no longer track the physical
output. No commands are sent to
the actual hardware. When the Out
of Service attribute is set to False, the
current Setpoint is sent to the actual
hardware.
When an Out of Service command is
issued, the NxE does not communicate
subsequent changes (operator or
system) to the field device.
For BACnet objects, support of this
command is dependent on the ability
to write the Out of Service attribute.

Release Operator
Override

None Releases Command Priority Operator
Override (8) from Setpoint.

Release Attribute name
Command priority

Releases the identified Command
Priority from the specified attribute
and allows the next highest priority to
control it.

Release All Attribute name Releases Command Priorities 3 through
16 (Default), from the specified,
writable attribute. Command Priorities
1 and 2 remain.

Optimal Start Object
Menu Selection: Insert > Object > Optimal Start

Note: On the Configure screen, click the [...] button to select the object from the Select Item
dialog box and then select the desired attribute for the Cooling Setpoint, Heating Setpoint, and
Zone Temperature.

The Optimal Start object aids in the reduction of energy costs during a building’s transition from
unoccupied to occupied. This scenario is accomplished by turning on the preheating/precooling as
late as possible to reach comfort levels prior to occupancy and turning off the heating/cooling as
early as possible while maintaining occupied zone comfort until zone vacancy.
This object allows you to save energy by coordinating the startup and shutdown times of
equipment according to when people occupy certain rooms or areas of the building.
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Optimal Start Concepts

Optimal Start Overview
After you create an Optimal Start Object using the known characteristics of your building, the
OST calculates the best times for startup and shutdown. For Optimal Start mode (Optimal Start
Equation), the OST commands the Zone WC Mode Obj attribute to occupied and starts the heating
or cooling sequence at the appropriate time. For Optimal Start mode, the OST commands the Zone
Occ Mode Obj attribute to unoccupied at the appropriate time.
If you set the Adaptation Enabled attribute to True (1), the OST automatically adjusts the Cooling
Constant and Heating Constant as needed.

Note: Warmup and cooldown (WC) is also referred to as the prestart period in the OST object.

Optimal Start
The goal of Optimal Start Object is to reach either the Heating Setpoint or Cooling Setpoint
at occupancy. The Optimal Start object selects the appropriate setpoint depending on the
temperature before starting the equipment. To meet this goal, the Optimal Start object calculates:

• Heating Constant and Cooling Constant represent the rate at which the temperature inside the
building changes when the heating or cooling equipment is running

• the temperature difference between the Zone Temperature and the Heating Setpoint or
Cooling Setpoint before occupancy

• how many minutes of precooling (cooldown) or preheating (warmup) are required based on
the above difference

• optimal start time when the Zone WC Mode Obj (BO, BV, MO, or MV object) is controlled by the
optimal start process

The Optimal Start object interacts with a Schedule Object, binary objects, and analog objects in an
Optimal Start application. See the Object Help section for information on these objects. See the
Optimal Start Object section for attribute information on the Optimal Start object.
Figure 50 illustrates optimal start.

Figure 50: Optimal Start - Heating

Optimal Start Equation
The following equation calculates the optimal start time:
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[(Heating or Cooling Constant/100) x Temperature Difference2] + Heating or Cooling Deadtime =
Optimal Start Time
Table 224: Optimal Start Equation
Variable Description
Heating or Cooling
Constant

This variable is the value of the Heating or Cooling Constant attribute of
the OST object and represents the rate of warmup or cooldown in the zone
after equipment startup. If Adaptation Enabled is Yes, the Optimal Start
object learns each day and sets a new value. This variable can be edited by
the user.

Temperature
Difference

This variable is the difference between the Zone Temperature and the value
of the Heating Setpoint or Cooling Setpoint attribute before the warmup or
cooldown period.
Units = delta deg F or delta deg K

Heating or Cooling
Deadtime

This variable is the value of the Heating or Cooling Deadtime attribute of
the OST object and is the amount of time required to raise or lower the
Zone Temperature 1.0 degree.
Units = minutes. If Adaptation Enabled is Yes, the Optimal Start object
learns each day and sets a new value. This variable can be edited by the
user.

Optimal Start Example
For an example of the optimal start process, assume:

• The Zone Occ Mode Obj is scheduled to be occupied at 7:00 A.M. and unoccupied at 5:00 P.M.
• Zone Temperature = 55˚F before the warmup period
• Heating Setpoint (since in Heating mode) = 70˚F
• Heating Deadpoint (since in Heating mode) = 5 minutes
• Heating Constant (since in Heating mode) = 10 (The optimal start process has run for several

days, and the Heating Constant has been adjusted to 10 based on past performance.)
• Temperature Difference = 70˚F - 55˚F = 15˚F

Therefore:

Optimal Start Time = [(10/100) x 152] + 5

= (0.1 x 152) + 5
= (0.1 x 225) + 5
= 22.5 + 5
= 27.5
= 28 minutes
The optimal start process turns on the Zone WC Mode Obj at 6:32 A.M. (28 minutes prior to the
scheduled 7:00 A.M. start time.)

Adaptation
Each day, at occupancy, the optimal start process adapts the Heating or Cooling Constant. It
checks the Zone Temperature at occupancy time. If the Zone Temperature did not reach a value
within the range defined by the Temp Differential and the Heating Setpoint or Cooling Setpoint
before the occupancy time, the Heating Constant or Cooling Constant is increased. This increase
moves the optimal start time closer to the earliest start time defined in the OST object. If the Zone
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Temperature reached a value within the range defined by Temperature Differential and the Heating
Setpoint or Cooling Setpoint prior to occupancy, the Heating Constant or Cooling Constant is
decreased. This decrease moves the optimal start time closer to the occupancy start time defined in
the Schedule Object.

Optimal Stop
The goal of optimal stop is to set the zone to the unoccupied mode prior to actual zone vacancy.
The OST must do this while the zone is still occupied, without causing comfort level alarms. The
Optimal Start object calculates the number of minutes before the zone is scheduled to change
from occupied to unoccupied. The OST then uses the same equation (Optimal Start Equation) for
deriving the optimal start time to determine the earliest stop time, except for two differences:

• To ensure occupancy comfort, the OST sets the Temperature Difference factor to the Temp
Differential attribute.

• The Deadtime is set to 0.
(Heating or Cooling Constant/100) x (Temperature Difference)2 + Heating or Cooling Deadtime
(always = 0) = Optimal Stop Time

Object Interaction
Different objects interact in an Optimal Start application. The following figure illustrates a sample
Optimal Start application. The table describes the objects and their role in an Optimal Start
application.

Figure 51: Optimal Start Object Interaction

Table 225: Optimal Start Application Object Interaction
# Object or

Attribute
Role

1 Optimal Start
(OST) Object

Receives temperature, setpoint, and scheduling data to determine
optimal start and optimal stop times for the building zone.

2 Schedule Object Provides occupied and unoccupied times for the building zone.

SCT: System Configuration Tool Help416



Table 225: Optimal Start Application Object Interaction
# Object or

Attribute
Role

3 Zone Occupancy
Mode

Refers to the binary or multi-state output and value objects that
command a zone to occupied or unoccupied. It is commanded by the
Schedule object to occupied and by the Optimal Start to unoccupied,
possibly earlier than scheduled if the Maximum Prestop Time attribute
is non-zero.

4 Zone Warmup
or Cooldown
Mode

Refers to the binary or multi-state output and value objects that
command the zone to warm up or cool down. It is commanded by
the Optimal Start object at the optimal start time and released at the
occupied time. It will not be released if the Zone Warmup or Cooldown
(WC) Mode and the Zone Occupancy Mode objects are the same.

5-8 Zone
Temperature,
Cooling
Setpoint,
Heating
Setpoint,
Outdoor Air
Temperature

Refers to the analog attributes (within Analog Input objects, Analog
Value objects, for example) that are referenced by the Optimal
Start object and provide the temperatures and setpoints for use in
calculations.

Object/Attribute Involvement
Building an Optimal Start application means that the OST object and its associated Schedule object
must have their attributes configured to reference the appropriate objects in order to achieve the
desired operation. The following table lists the objects and attributes involved and guidelines for
data entry.
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Table 226: Optimal Start Object/Attribute Involvement
Object Type/ Function Attributes Involved Data Entry Guidelines

Zone Schedule Object Enter the Object Name of the Schedule object that schedules
occupied and unoccupied times for the binary object
controlling the zone occupancy mode of the heating and
cooling equipment for the zone.
This object must be defined in the schedule and have valid
start and stop times for the current day for the Optimal
Start object to run. Only one start time and stop time can be
defined per day, and the start time must precede the stop
time.

Zone Occ Mode Obj Enter the Object Name of the binary object controlling the
occupancy mode of the heating and cooling equipment for
the zone.

Zone WC Mode Obj Enter the Object Name of the binary (BO, BV) or multi-state
(MO, MV) object controlling the warmup and cooldown mode
of the heating and cooling equipment for the zone. This can
be the same object as the Zone Occ Mode Object.

Note: If the Zone Occ Mode Obj and the Warmup/
Cooldown Mode Obj are the same point, then the point
is commanded by the Scheduling at the scheduled
time.

Cooling Setpoint Enter the Object/Attribute Name of the analog value that
represents the cooling setpoint.

Heating Setpoint Enter the Object/Attribute Name of the analog value that
represents the heating setpoint.

Zone Temperature Enter the Object/Attribute Name of the analog value that
represents the temperature in the zone being controlled.

Optimal Start Object

Outdoor Air Temp Enter the Object/Attribute Name of the analog value that
represents the outdoor air temperature.
If this attribute is not defined, or the referenced analog
attribute is offline, the outdoor air temperature is assumed
to be within the design temperatures limits for the OST
calculations.
If an analog attribute reference is defined for the outdoor air
temperature, its value determines if the Optimal Start object
should adapt heating and cooling constants and deadtimes.
If its value is outside the design temperature limits, deadtime
and constant calculations are skipped.
If its value is outside the design temperatures before the
warmup or cooldown period, the optimal start time is set to
the maximum prestart time.
If its value is outside the design temperatures before the
unoccupied period, Prestop does not occur.

Schedule Object List of Object Property
References

Enter the Object Name of the binary object controlling the
occupancy mode of the heating and cooling equipment for
the zone as one of the Property References.

Optimal Start Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
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Table 227: Optimal Start Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 W C

Indicates whether the Multiple Command object is enabled or
disabled

OST Type -- Object
933 W C

Defines the OST supported configuration. When the zone is in a
mode not supported by the OST object, the Present Value is idle.
OST-supported modes include:

• Heating and Cooling
• Heating Only
• Cooling Only

Adaptation Enabled -- Control
934 W C

Indicates whether OST uses adaptive learning to change the
building heating and cooling constants and heating and cooling
deadtimes.

Zone Schedule Obj -- Control
963 W C

Identifies the Schedule object, which schedules the Zone Occ
Mode Obj. This object must be defined in the schedule and
have valid start and stop times for the current day in order for
OST to run. Otherwise, the OST object’s Present Value is Not
Operational. Only one Start and Stop time can be defined per
day, and the Start time must precede the Stop time. The Start
time must be defined as binary State ON (1) and Stop time must
be defined as binary State OFF (0).

Zone Occ Mode Obj -- Control
935 W C

Identifies the object used to command a zone to occupied or
unoccupied. This object must be specified in the Zone Schedule
Obj. This is commanded by scheduling to occupied and by OST if
prestop is enabled.

Note: If the Zone Occ Mode Obj and the Warmup/Cooldown
Mode Obj are the same point, then the point is commanded by the
Scheduling at the scheduled time.

Zone WC Mode Obj -- Control
936 W C

Identifies the object used to command a zone to Warmup or
Cooldown mode. This object may be the same as the Zone Occ
Mode Obj. This object is commanded by the OST at the optimal
start time. This object is released at the occupied time unless
this object is also the value for the Zone Occ Mode Obj.

Heating Setpoint -- Control
937 W C

Identifies the attribute of an object used to define the zone
occupied target heating temperature. This attribute may be the
same as the Cooling Setpoint attribute.

Cooling Setpoint -- Control
939 W C

Identifies the attribute of an object used to define the zone
occupied target cooling temperature. This attribute may be the
same as the Heating Setpoint attribute.

Zone Temperature -- Control
941 W C

Identifies the attribute of an object used to determine the zone
temperature.
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Table 227: Optimal Start Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Outdoor Air Temp -- Control
32092 W C

Identifies the attribute of an object used to determine the
outdoor temperature:

• If this attribute is not defined, or is offline, the outdoor
air temperature is not used in the OST calculations and is
assumed to be within the design temperatures.

• If an Analog attribute reference is defined for the outdoor
air temperature, it aids in determining if the Optimal Start
object should adapt constants and deadtimes.

• If the attribute is defined and outside the design
temperatures, deadtime and constant calculations are
skipped.

• If the attribute is defined and is outside the design
temperatures during Prestart, the optimal start time is set
to early start time.

• If the attribute is defined and outside the design
temperatures during Prestop, do not Prestop.

Cooling Design Temp -- Setup
943 W C

Indicates the highest outside temperature at which the cooling
system maintains zone comfort in the cooling mode.

Heating Design Temp -- Setup
944 W C

Indicates the lowest outside temperature at which the heating
system maintains zone comfort in the heating mode.

Cooling Constant -- Setup
945 W C

Defines the rate at which the zone cools down after equipment
startup. If adaptation is enabled, this constant is adapted
without user intervention. If adapting and the OST object
Cooling Setpoint and Heating Setpoint attributes reference the
same object on a field controller, then the cooling constant
is adapted even if the mode is not cooling, meaning both
constants change.

Cooling Deadtime -- Setup
948 W C

Indicates the time required after startup to lower the
temperature by one degree. This value is adapted by the OST
algorithm, if adaptation is enabled. If adapting, cooling, and
heating setpoints are the same attribute, the Cooling Deadtime
is adapted even if the mode is not cooling, meaning both
deadtimes change.

Heating Constant -- Setup
946 W C

Defines the rate at which the zone heats up after equipment
startup. If adaptation is enabled, this constant is adapted
without user intervention. If adapting and the OST object
Cooling Setpoint and Heating Setpoint attributes reference the
same object on a field controller, then the heating constant
is adapted even if the mode is not heating, meaning both
constants change.
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Table 227: Optimal Start Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Heating Deadtime -- Setup
947 W C

Indicates the time required after startup to raise the
temperature by one degree. This value is adapted by the OST
algorithm, if adaptation is enabled. If adapting, cooling, and
heating setpoints are the same attribute, the Heating Deadtime
is adapted even if the mode is not heating, meaning both
deadtimes change.

Min Prestart Time -- Setup
949 W C

Indicates the minimum period of time before occupancy to start
the heating/cooling system. This time allows for the required
amount of air changes in the zone prior to occupancy (latest
optimal start time).

Max Prestart Time -- Setup
954 W C

Indicates the maximum period of time required to bring the
zone up to occupancy setpoint temperature under the worst
conditions (earliest optimal start time).

Max Prestop Time -- Setup
957 W C

Indicates the maximum period of time that the heating/cooling
system can be shut down and still maintain the occupied zone
temperature until entering the unoccupied mode (earliest
optimal stop time). By setting this time to zero (the default
value), optimal stop is disabled.

Temp Differential -- Setup
962 W C

Indicates the value added and subtracted to the zone setpoint to
define a temperature range.

Display Precision -- Setup
661 W C

Indicates the rounded position and decimal places to display for
this object.

Temperature Units -- Setup
972 C

Indicates the units associated with the attributes for
temperatures.

Relative Temp Units -- Setup
2167 C

Specifies the units associated with the Temp Differential
attribute.

Optimal Start Commands
The table below lists the commands supported by the Optimal Start Object.
Table 228: Optimal Start Object Commands
Command Name Parameters Command Description
Cancel Prestart None Delays pending start until latest prestart time. Only

valid during Prestart and before the optimal start time.
Cancel Prestop None Cancels the pending stop. Only valid during Prestop

and before the optimal stop time.
Disable None Prevents the object’s functionality; no calculations take

place.
Enable None Allows the object to perform its calculations once a

minute.
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Optimal Start Steps

Building an Optimal Start Application
About this task:  
To build an Optimal Start application:

1. Add the N2 Controller object and the analog and binary objects required for the OST
application to the database. See the Object Help section for information on objects and the
Related documentation table in the Welcome section for information on the SCT. See Creating
Items with Wizards for information on creating objects and other items.

2. Add the Schedule Object, referencing the binary object controlling Zone Occupancy Mode.
3. Make sure valid occupied and unoccupied times are entered into the Schedule object.
4. Add the Optimal Start Object referencing the above Schedule object, the Binary objects

designated as Zone Occupancy Mode and Zone Warmup or Cooldown Mode, and the analog
attributes of objects designated as temperatures and setpoints.

Result  

Note:  Refer to the Scheduling section in the Metasys SMP Help (LIT-1201793).

Optimal Start Troubleshooting
Table 229: Optimal Start Application Troubleshooting
Problem Solution
Present Value of the Optimal
Start Object indicates Not
Operational

The Optimal Start object’s Present Value attribute may indicate
Not Operational because of errors in its connection status to other
required objects.
To verify the Optimal Start object’s connection status to other
required objects:

• Verify that the required Schedule object, binary objects, and
analog objects are all defined and online.

• Verify that the binary object controlling Zone Occupancy Mode
is in the List of Prop Refs for the Schedule Object.

• Verify that valid occupied and unoccupied times for the current
day are defined in the Schedule object.

Optimal Start Object is not
adapting Constants and
Deadtimes

To ensure the Optimal Start object is adapting constants and
deadtimes:

• Verify that the Adaptation Enabled attribute indicates True.
• Verify that the value of the Zone Temperature attribute is not

within the value of the Temp Differential attribute relative to
the Heating or Cooling Setpoint (plus or minus one degree)
before the warmup or cooldown period.

• Verify that the value of the Outdoor Air Temp attribute is
within the values of the Cooling Design Temp and Heating
Design Temp attributes.

Pulse Meter Object
Menu Selection: Insert > Object > Pulse Meter
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The Pulse Meter object accumulates the differences between consecutive reads of the integer value
provided by an Accumulator Object or Counter Input Object (defined by CCT), and calculates the
rate of change between each reading of the value. This object also totals the counted pulses and
converts them into units of consumption.
The Pulse Meter object must reference a counter/accumulator object to access the counter value
that resides in the counter/accumulator hardware device (which is hardwired to the pulse input).
The counter/accumulator object is hardware specific, while the Pulse Meter object is hardware
independent.
Multiple Pulse Meter objects may share the same counter/accumulator object, and must reside on
the same device as the counter/accumulator hardware device.

Note: The Pulse Meter object only handles counters that count forward.

Each Pulse Meter object may have different purposes, such as one calculates the rate over a 60-
second period, while others calculate the rate over a 5-minute period. For example, some Pulse
Meters are supposed to run only during certain times of the day.

Pulse Meter Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
Table 230: Pulse Meter Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Enabled -- Object
673 W C

Indicates whether the Multiple Command object is enabled or
disabled

Meter Active -- Object
1260 W C

Specifies whether the pulse meter object currently should be
metering.

Counter Object -- Setup
821 W C

Specifies the associated Accumulator Object or Counter Input
Object (defined by CCT).

Rate Units -- Setup
819 W C

Indicates the measurement units for all rate attributes.

Rate Constant -- Setup
822 W C

Specifies the value multiplied by the Consumption Units to get
the Present Value units to match Rate Units.

Rate Limit -- Setup
826 W C

Specifies the highest allowed Present Value before using Rate
Default.

Rate Default -- Setup
827 W C

Specifies the value of Present Value when the calculated rate
exceeds the Rate Limit.

Consumption Units -- Setup
820 W C

Indicates the measurement units for all consumption attributes.

Pulse Consumption -- Setup
830 W C

Specifies the physical quantity that each single pulse represents.

Sample Time -- Setup
611 W C

Specifies the period of automatic executions of the algorithm in
seconds.

Rollover Limit -- Setup
823 W C

Specifies the highest counter value before the pulse counter rolls
over to zero. This value must match that of the counter, or the
Max Value of the Accumulator.

Display Precision -- Setup
661 W C

Specifies the rounded position and decimal places to display for
this object’s analog values.
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Pulse Meter Commands
The table below lists the commands supported by the Pulse Meter Object.
Table 231: Pulse Meter Object Commands
Command Name Parameters Command Description
Enable None Enables the calculation of the pulse count and

consumption for the Pulse Meter object.
Disable None Disables the calculation of the pulse count and

consumption for the Pulse Meter object.
Reset None Resets the Pulse Meter, including the Consumption

attribute.
Start Meter None Resumes metering.
Stop Meter None Stops metering.

Signal Select Object
Menu Selection: Insert > Object > Signal Select
The Signal Select object can process values from multiple zones to adjust various setpoints and can
function with either analog or binary points.
For analog point types, the Signal Select object determines (one or more of) the low input, average
input, and/or high input values for use in updating an attribute value of another object.
For binary point types, the Signal Select object determines (one or more of) the average state,
the logical Or state, and/or the logical And state values for use in updating an attribute value of
another object.
Computations take place at startup and at each time an input value experiences a change in value
or reliability. The results of these calculations are sent to specified output points as commands. For
example, this object allows you to average multiple zone temperatures and base a control, such as
adjusting a setpoint, on that average.

Signal Select Concepts

Average Output Computation
In the case of binary types of input references, if the majority of inputs are at State 1 or the inputs
are evenly split between State 1 and State 0, the Average output is commanded to State 1. If the
majority of inputs are at State 0, the Average output is commanded to State 0.

Logical OR Computation
If any input is at State 1, the OR output is commanded to State 1. If all inputs are at State 0, the OR
output is commanded to State 0.

Logical AND Computation
If all inputs are at State 1, the AND output is commanded to State 1. If any input is at State 0, the
AND output is commanded to State 0.

Signal Select Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.
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Table 232: Signal Select Object Attributes
Name / View Group
Attribute ID Writable (W) Configurable (C)

Attribute Description

Input List -- Engineering Values
1062 W C

Contains the list of attribute references used
in the Signal Select calculations. An analog
type defined as a binary input is converted to a
binary value prior to each computation, and vice
versa.

Average Output -- Engineering Values
1063 W C

Specifies the object attribute whose value is
updated using the calculated average of all of
the inputs of the Signal Select Object.

High OR -- Engineering Values
1064 W C

Specifies the object attribute whose value
is updated using the highest input of all the
inputs in the Signal Select object, for analog
point types. For binary point types, the value
is updated using a logical OR condition of all
inputs of the Signal Select object.

Low AND -- Engineering Values
1065 W C

Specifies the object attribute whose value
is updated using the lowest input of all the
inputs in the Signal Select object, for analog
point types. For binary point types, the value
is updated using a logical AND condition of all
inputs of the Signal Select object.

Point Type -- Engineering Values
1173 W C

Specifies the type of input values monitored
by the Signal Select object, the calculations it
performs, and the outputs it produces. Point
type can be analog or binary.

Failsoft -- Engineering Values
2567 W C

Routes to all the outputs if Setup is configured
as Fail Soft. Fail Soft routes when the object
becomes unreliable and when the output
transitions from Reliable to Unreliable.

Setup -- Engineering Values
518 C

Defines whether the Fail Soft or Last Reliable
value needs to be the output if the object
becomes unreliable.

Execution Priority -- Execution
2197 W C

Indicates the relative importance of performing
the function of the object within the device.

Solar Clock Object
Menu Selection: Insert > Object > Solar Clock
The solar clock object computes Present Value (Night/Day), Sun Position (Azimuth and Elevation),
and Sunrise and Sunset times based on the local position (Latitude and Longitude) and local time
and time zone information. This information is needed to control external motorized louvers as part
of bioclimatic facades for buildings and may also be used to position tracking photovoltaic solar
arrays. The Sunrise/Sunset times can be used for external lighting control.
This object runs on a periodic basis to compute its attributes. The equations to compute azimuth,
elevation, sunrise, and sunset attributes were obtained from the National Oceanic and Atmospheric
Administration (NOAA) Web site (http://www.noaa.gov/). The object obtains the Local Time, UTC
Offset, DST Status, and DST Offset from the BACnet Device object.
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Latitude and Longitude for this object are provided in decimal degrees. Often, these values are
provided as degrees, minutes, and seconds. There are numerous Web sites that can convert the
latitude and longitude values, if necessary. In addition, you can obtain your current location on
the planet from free tools such as Google Earth. Google Earth includes an option to provide your
location in decimal degrees.

Note: For correct sunrise and sunset calculations, you must apply north/south and east/west
rules. North latitudes are preceded by a plus, South latitudes are preceded by a minus. West
Longitudes are preceded by a minus, East Longitudes are preceded by a plus. See Table 233.

Table 233: Latitude and Longitude Examples
Location Landmark Latitude Longitude
Milwaukee, WI, USA Brengel Technology Center 43.037507 -87.904456
Paris, France Notre Dame Cathedral 48.854212 2.347641
Cape Town, South
Africa

Green Point Stadium -34.903488 18.411073

Sydney, Australia Opera House -33.857184 151.215176
Beijing, China Tiananmen Square 39.06514 116.391213

For general information on Metasys system objects, see Common Object Attributes.

Solar Clock Object Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.

Note: For correct sunrise and sunset calculations, you must apply north/south and east/west
rules. North latitudes are preceded by a plus, South latitudes are preceded by a minus. West
Longitudes are preceded by a minus, East Longitudes are preceded by a plus. See Table 233.

Table 234: Solar Clock Object Attributes
Name / View Group
Attribute ID Writable (W)
Configurable (C)

Attribute Description

Latitude -- Setup
1041 W C

Defines the angular distance, in decimal degrees, of the current
location north or south of the equator. Lines of latitude are also
known as parallels. The International standard defines north
latitudes as positive values.

Longitude -- Setup
1042 W C

Defines the angular distance, in decimal degrees, of the current
location east or west of the Prime Meridian. Lines of longitude are
also known as meridians. The International standard defines east
longitude as positive values.

Offset -- Setup
956 W C

Defines an offset to the computed Sunrise and Sunset times. The
offset value is used to compute Present Value. A positive value
makes the day longer and a negative value makes the day shorter.

Periodic Update -- Setup
2192 W C

Determines how often sun position and Present Value attributes
update during normal operation. The default value is 5 minutes.

Graphic
Menu Selection: Insert > Graphic
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Inserts a graphic into the site.

Note: Do not place graphics in the Facility Graphics folder or folders nested within it (displayed
in the All Items tree). Graphics saved in this folder are Metasys UI graphics saved by the system
and should not be edited in SMP or SCT.

Figure 52: Facility Graphics Folders

Graphic Object
The Graphics object defines the attributes that represent a defined user graphic for a given set of
objects. Graphic objects must exist under a container object or under another Graphic object (this
allows you to link graphics together).
For detailed information on the User Graphics Tool, refer to the User Graphics Tool  section in the
Metasys SMP Help (LIT-1201793).

Graphic Attributes
This object only contains the common Metasys system object attributes. These common attributes
are described in the Common Object Attributes section.

XAML Graphic Object
The Extensible Application Markup Language (XAML) Graphic object defines the attributes that
represent a defined Graphics+ file for a given set of objects. XAML Graphic objects are created
exclusively with the GGT and are saved on an ADS/ADX, ODS, SCT computer, or supervisory device
as a file with an .xaml file extension.

Note: The Object Type for this object is labeled XAML Graphic in the software.

For detailed information on viewing XAML Graphic objects, refer to the Graphics+ Runtime Help
(LIT-12011708).
For detailed information on the Graphic Generation Tool that is used to create and modify XAML
Graphic objects, refer to the Graphic Generation Tool Help (LIT-12011697).
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section.

Graphics+
Graphics+ files created with the Graphic Generation Tool (GGT) provide comprehensive and three-
dimensional views of building automation systems that allow you to monitor the status of a single
building or an entire campus of buildings. Unusual conditions are quickly identified on a dashboard
screen that can navigate deep into a building, floor, or zone. With minimal navigation, you can
diagnose a problem and take corrective action. You can view historical data directly within the
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graphic, further enabling effective problem diagnosis. You can also issue commands from the
graphic.
Graphics+ files are created offline with the GGT, a stand-alone application that runs on a computer
with a supported Microsoft Windows operating system. These graphics are then saved as Metasys
objects (typically on the Site Director) and viewed within the Site Management Portal UI in any
active display panel.
Graphics are usually made up of three parts:

• one or more background images
• animated HVAC elements, ductwork or piping, and/or floor plan information
• buttons that allow you to navigate to other graphics, applications, and Web addresses

You can access a graphic when you are logged in to the Site Management Portal UI through any
Web browser. The XAML Graphic Object represents a Graphics+ object in the All Items navigation
tree. You can open these graphics in any active display panel.
For information about Graphics+ symbol and element functions, refer to the  Graphics+ Runtime
Help (LIT-12011708).
For information about creating and editing Graphics+ files, then saving the graphic to an online
device (ADS, ADX, or supervisory controller) or offline to an SCT archive database, refer to the
Graphic Generation Tool Help (LIT-12011697).

Graphics+ Concepts

Graphics+ View
Graphics appear in the navigation tree as stand-alone items. You can access graphics from a
Tailored Summary, the Alarm Pop-ups window, or the Associated Graphic tab of a Field Controller
device. The icon below identifies a Graphics+ graphic.

Figure 53: Icon for Graphics+ Graphics

When you open the graphic, a Display Control tool appears in the upper left corner of the active
display panel. Use the Display Control to zoom and pan a graphic. You can also open the Trend
Module from this control. See Figure 54 and Table 235 for details on the Display Control tool.
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Figure 54: Graphics+ Control Tool

Table 235: Components of Display Control Tool
Callout Name Description
1 Collapse Hides the Display Control tool. After you hide the tool,

a faint arrow appears that allows you to restore the
tool.

2 Fit to Window
(center block)

Zooms the graphic to fit in the frame.

3 Zoom Ball with Zoom Ring Allows you to zoom by moving the ball clockwise
(zoom in) and counterclockwise (zoom out) along the
zoom ring.

4 Turn On/Off Panning Enables and disables the panning tool that allows you
to move the graphic in the workspace.

5 Move (four arrows) Allows you to pan up, down, left, and right over the
graphic in set increments.

6 Current Zoom Level Displays the current zoom level.
7 Turn On/Off Zoom Mode Enables and disables the manual zoom (magnifying

glass) that allows you to re-center the graphic and
zoom in an out.

8 Tools Menu Drops down a list of Tools. At this time, only the Trend
Module is available.
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Table 235: Components of Display Control Tool
Callout Name Description
9 Trend Opens and closes the Trend Module. This option

appears when you click the Tools down arrow.
10 Move Display Control Allows you to move the Display Control tool to a

different area of the graphic.

Navigation
You can navigate between graphics using various types of elements of a Graphics+ graphic or
by opening the desired graphic from the navigation tree. You can restrict user access to specific
graphics by setting security levels in the Security Administrator System.
You can also create user views that contain only graphics (hierarchy of graphics references).

Commands
You can command objects that are bound to graphic symbols using two methods. The first method
is to left-click the object’s Inline Command Box or Advanced Value Box, then edit the value of
the object. If commanding is disabled for that symbol, the value is not be editable. The second
method is to right-click the object’s Inline Command Box, Advanced Value Box, or other elements
of Graphics+ symbols such as gauges, to open the User Actions Panel, then select More Commands
to bring up the Metasys commands dialog box. With both methods, if you are not authorized to
command the object, the command selection is disabled.

Behaviors
Many elements of Graphics+ graphics support built-in or configurable behaviors.
Elements that support behaviors can flash if the bound object is in an alarm or warning state,
change color based on the bound object's state or status, or show or hide depending on the bound
object's state or status.
In the Metasys UI, the elements of the Graphics+ graphic display the behaviors as the bound
object's state or status changes.

Note: Support of behaviors is limited in SCT.

Opening the Trend Module
To open the Trend Module for an object on a Graphics+ graphic, click View Trend from the
element’s User Actions Panel. The Trend Module appears with the charted trend data. If more
than one trended attribute is available, click View Trend to display a submenu that lists all available
trended attributes. Click a trended attribute to open the Trend Module.

Figure 55: Selecting a Trend to Add to the Trend Module
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If you want to open the Trend Module without adding or changing its content, click the Tools drop-
down arrow on the Graphics+ Display Control tool and select Trend. The Trend Module reappears in
its last state and condition.

Figure 56: Reopening the Trend Module

Closing the Trend Module
You close the Trend Module by clicking the X in the upper-right corner of the Trend Module screen.

Trend Module Chart Functions
See Figure 57 and Table 236 for explanations of the Trend Module chart components.
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Figure 57: Graphics+ Trend Module - Chart Functions

Table 236: Descriptions of Trend Module Chart Components
Numbe
r

Name Description

1 Plot Area Plots the trend data for all objects added to the Trend Module.
2 Box Zoom Zooms in for the area that is highlighted. To enable box zoom,

place the cursor inside the plot area, hold down the mouse and
drag left or right. A white shadow appears to outline the zoom
area.

3 Callouts Indicates the name of the trended object with its value at the
selected moment in time (white vertical line).

4 Maximize Changes the size of the Trend Module to its maximum size
within the constraints of the Metasys display panel.

5 Close Removes the Trend Module from the screen.
6 Zoom Out Returns the chart to its original size. This option is only

available if the chart is currently zoomed in.
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Table 236: Descriptions of Trend Module Chart Components
Numbe
r

Name Description

7 Right Y Axis
(state data)

Indicates the axis that is plotting the discrete states for objects
currently displayed in the Trend Module. Metasys objects that
are displayed on this axis typically consist of Boolean or multi-
state values.

8 Right Pan Arrow Shifts the chart to display more recent trend data.
9 Newest Date/Time Displays date and time of the last value that appears on the

chart.
10 Moment in Time

(X Axis)
Indicates the date and time of the value at a particular location
on the chart. The date/time information as well as a vertical
moment in time line is displayed as you move the mouse over
the chart. The units along the x-axis always represent time.

11 Oldest Date/Time Indicates the date and time of first sample that appears on the
chart.

12 Left Pan Arrow Shifts the chart to display older trend data.
13 Left Y Axis

(numeric)
Indicates the axis that is plotting the numeric values for objects
currently displayed in the Trend Module. Metasys objects that
are displayed using this axis typically consist of analog values.

14 Scroll Bar Adjusts the range of data that appears on the chart. Also
zooms in and out when you resize the scroll bar. To zoom, click
and drag the left/right arrows of the scroll bar. To pan, drag
the scroll bar left or right.

15 Refresh Updates the trend data for all objects shown in the Trend
Module.

Trend Module Legend Functions
See Figure 58 and Table 237 for explanations of the Trend Module legend components.
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Figure 58: Graphics+ Trend Module - Legend Functions
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Table 237: Descriptions of Trend Module Legend Components
Number Name Description
1 Legend Splitter Bar Resizes the space taken by the legend. Move the

splitter to the bottom or double-click the splitter bar
to hide the legend and increase the size of the trend
chart.

2 Legend Icons Display both the color and the y-axis that is used to
display the trend data for the trended object in this row
of the legend. The legend color assigned to an object
matches its trended values in the chart, so that you
can correlate information between the legend and the
chart.
Four preset trend line colors are used: blue, orange,
violet, and white. The colors cannot be customized.
These icons are used:
Icon Description

The forward facing L indicates that
the left y-axis is used for this trend
series, which displays numeric values.
The backward facing L indicates that
the right y-axis is used for this trend
series, which displays state values.

3 Show/Hide Trend Selects which objects currently appear in the chart.
Click this box to hide and unhide trend data.

4 Object Name Displays the name for the trended Metasys object.
When you click the object name (or its row), the
corresponding line in the chart is highlighted.

5 Trend Name Displays the name of the trend that appears in the
chart. If more than one trend is available for this
trended object, a drop-down box appears from which
to select.

6 Navigate Navigates away from the Trend Module and the
graphic and opens the trend data for the attribute. If
you are not authorized to view the object, the navigate
button is disabled.

7 Remove Removes the trended object and its associated data
from the Trend Module.

Loading Indicator
A loading indicator appears in the chart area while the system is retrieving trend data.

Trend Module Repositioning
You can reposition the trend module anywhere within the graphic’s display panel, but not across
panels in a multiple-panel layout. To move the Trend Module, drag the title bar.
You can dock the Trend Module by dragging the module outside the panel boundary on the top,
bottom, right or left side of the Metasys display panel. The Trend Module does not support multiple
monitors.
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Zoom Operations
You can zoom in the chart by holding down the mouse and sliding across the chart (either to the
left or to the right). This action activates drag zoom. Zoom works for values on the x-axis, not values
on the y-axis. To zoom out, click the Zoom Out link that appears in the upper right corner on a
zoomed chart.
You can also zoom from the horizontal scroll bar by clicking and dragging on the ends of the scroll
bar.

Legend Operations
Once the trend data is plotted, use the check boxes in the legend to hide or unhide trend values
from appearing in the chart. If you want to remove the trended object from the legend and the
chart, click the Remove icon (X).
To highlight a specific trend object and its data, click on its name in the legend. This action sends
the selected series and its associated y-axis information to the foreground of the chart.
If you try to plot a trended attribute that was deleted or whose object is offline, its legend icon is
blank and a user message box appears.

Figure 59: User Message: No Trend Data Available

Trend Module Limitations
The limitations of the Trend Module are as follows:

• A maximum of 500 data points can be displayed for a single trended object. No data older than
2 years can be displayed.

• The trend data originates from the device’s online buffer; samples stored in a historical
database such as the JCIHistorianDB archive database are not included.

• You can open only one Trend Module per graphic.
• The Trend Module can chart a maximum of four trended Metasys objects. If you try to plot a

fifth object, a user message box appears.
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Figure 60: User Message Example: Full Trend Module

• The Trend Module does not support nested trend extensions. For example, the Trend Module
cannot chart totalization extensions that contain a trend extension.

• You cannot save the Trend settings for later use. Once you close the graphic, you need to
select the objects for the trend module again.

Refresh Function
The Trend Module does not automatically refresh with new data samples. Use the refresh button to
display the latest trend data within the Trend Module.

Error Handling
If an error occurs while stored trend samples are retrieved (for example, the bound trend object
does not exist or its supervisory device is offline), the chart line for this trend series does not
appear. The error message Could not retrieve trend information appears as a tooltip for
the existing legend item.

User Graphics Tool (UGT)
Graphics provide a visual representation of the monitored systems that enable you to quickly check
the status of system symbols and recognize unusual system conditions. Graphics can be designed
to allow the user to move through buildings, floors, and other areas, viewing building systems and
control processes. You can view, create, and edit graphics using the User Graphics Tool (UGT).
User graphics are usually made up of three parts:

• the Static Background image
• Symbols
• Hyperlinks that allow you to navigate to graphics and web addresses

The UGT operates in two modes:
• The Edit Mode allows you to edit an existing graphic or create new graphics.
• The View Mode allows you to view existing graphic to monitor and command all systems

integrated into the Metasys network.
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The UGT is available with the NAE, NIE, Metasys server, and SCT. You can access the UGT when you
are logged in to the Metasys user interface through any web browser. The Group Object represents
user graphics in the All Items navigation tree and can be displayed in any active display panel.

Note: If your graphics reference multiple Engines or multiple Metasys servers, and one device
needs to be downloaded, upload all Engine/Metasys servers prior to making changes in SCT.
This procedure ensures your graphics work consistently.

For information on default preferences for graphics (such as status colors, fan colors, state colors,
and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
For more information on configuring an NAE or NIE and for details on user access configuration,
see the Related documentation table.

User Graphics Tool Concepts

Graphic Workspace
When viewing an existing graphic or creating new graphics, the UGT runs in the Graphics
Workspace, which is displayed in an active display panel. The default workspace background
is gray. The graphic workspace displays all graphical symbols and a user-selectable Static
Background. The UGT Toolbar shows only the appropriate tools for the UGT Modes that you are
working in, either View Mode or Edit Mode.

UGT Modes
The User Graphics tool runs in either Edit Mode View Mode. When you are generating new graphics
or editing graphics, the User Graphics tool is in Edit mode. When you finish editing and click save
and the UGT switches to View mode.
You can generate graphics in the Metasys system with the online mode or with the offline mode:
Online: Use this method if your web browser is connected to an Engine or Metasys server. In this
case, a new graphic is generated online in the device where the graphic resides during normal
operation. When you are finished creating or editing graphics, Upload the database to the archive
database in the SCT.
Offline: If your web browser is connected to the SCT. If this case, the new graphic is generated
offline and stored in the archive database. When you are finished creating or editing graphics,
Download the database to the device where the graphic resides during normal operation.

Edit Mode
Edit mode is the mode used by the UGT to design and edit graphics. Access the Edit mode by
clicking the Edit button on the UGT Toolbar. In Edit mode, you have access to all toolbar items/
symbols and you can bind symbols to objects and link graphics to other graphics.
Right clicking in Edit mode brings up basic choices for editing graphics such as copy, paste, delete,
duplicate, hide, and zoom, depending on the type of item you select. Double clicking in Edit mode
brings up the binding information for a symbol.
For a list of mouse shortcuts, see the Mouse Shortcuts: Edit Mode topic.

View Mode
Graphics display in the View mode when you are navigating using graphics and when you first open
a graphic. Graphics appear in an active display panel. You must enter the Edit Mode (by clicking the
Edit button) to design or edit a graphic. In View mode, you have access only to a limited number of
items on the UGT Toolbar. The symbols in the palette on the left do not appear in this mode.
The View mode allows you to command an object bound to a Value Display Box or Analog Fill Bar
Graph and to click on Hyperlinks to access linked graphics. Double clicking on a bound symbol in
View mode displays the Focus view of the bound object.
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For binary point objects, the value and status update every 10 seconds. For analog point objects,
the value and status update every 10 seconds. Commands and value changes return a new state/
value or error message within 10 seconds or less. The error message could be related to priority (if
the system can’t perform the requested function now) or failure to reach a commanded state or
value. Error messages appear in dialog boxes.
For a list of mouse shortcuts, see the Mouse Shortcuts: View Mode topic.

Toolbar
The UGT toolbar shows only the appropriate tools for the current mode of the UGT. The table below
shows the toolbar options available in Edit Mode and View Mode.
For information on mouse shortcuts, see Mouse Shortcuts.
Table 238: UGT Toolbar Options in Edit Mode and View Mode

Visible In:Icon
(Standard
Windows
Icons not
Shown)

Description
Edit

Mode
View
Mode

Action Performed

Save X Saves all changes to the graphic and exits Edit
mode.

Cancel X Cancels any changes to the graphic (made
since the last save) and exits Edit mode.

Edit X Changes the UGT to Edit mode.
Note: This is the only toolbar item that
requires Configure Access (Security Adminis-
trator System).

Print X X Brings up the Print dialog.

Print Preview X X Brings up the Print Preview dialog.

Cut X Cuts the selected symbol out of the graphic.

Copy X Copies the selected symbol.

Paste X Pastes a cut or copied symbol into the system.

Undo X Undoes the previous action (except for a save)
up to 4 actions.

Redo X Redoes the previous undone action up to 4
actions.

Set
Background

Image

X Allows you to import the background of the
graphic.

Set Advanced
Image

X Allows you to import an advanced graphic.

Save
Background

Image

X Saves the background image.
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Table 238: UGT Toolbar Options in Edit Mode and View Mode
Visible In:Icon

(Standard
Windows
Icons not
Shown)

Description
Edit

Mode
View
Mode

Action Performed

Bind X Brings up the Bind Information dialog box
for the selected item. (This box is the same as
when you double click on an item.)

Select X X Turns the cursor into a selection cursor.

Text X Turns the cursor into a text cursor that allows
you to create a text box.

Pan X X Turns the cursor into a hand that allows you to
pan over the diagram by dragging.

Marquee Zoom X X Allows you to select an area to zoom in on.

Interactive
Zoom

X X Zooms in and out on a graphic when you hold
the mouse down.

Zoom - Fit
Window

X X Zooms the diagram to fit within the window.

Overview X X Shows an overview of the entire graphic in one
window.

Selective Zoom X X Allows you to select the percentage zoom
applied to the diagram.

Static Background
Backgrounds are static images displayed in the background of a graphic. Backgrounds represent
buildings, floor plans, mechanical equipment, and any other picture that represents the location
or function of the equipment in the graphic. By default, a newly created graphic has a gray
background. You can insert a background image using a file based on SVG, SVGZ, or JPEG graphic
format.
You can create SVG/SVGZ background images with graphic drawing packages or from established
libraries of images. We recommend using the Professional or Standard edition of Microsoft Visio
2003, 2007 or 2010 (32 bit) software and the AGSL to create background images. Alternatively,
you can use Microsoft Visio 2002 software with the GSL. SVGZ and SVG images must be created in
positive space (quadrant 1, on the positive X and positive Y axis).
Background images in JPG format are usually created with cameras or scanners. You cannot resize
a UGT background in JPG format, and if an area of the graphics workspace is not fully covered by
the JPG image, the exposed area defaults to gray.
Access available backgrounds with the background icon on the Toolbar.
For information on how to edit an existing background image, see Editing a Background Image.

Managing Graphic Creation
In general, you should store your graphic files on the Site Director. The Site Director provides
you with a uniform point of entry and traffic control. The Site Director allows information sharing
between users while minimizing network traffic.

SCT: System Configuration Tool Help440



NAE35/NAE45 Graphic Size Limitation
When you create or edit graphics with an online UI to an NAE35 or NAE45, changes you make
do not save if the graphic is too large. The total size of the graphic background, dynamics, and
static text must not exceed 700K bytes. A typical size for an SVGZ graphic is 100–200K. You do not
receive a warning that the graphic is too large to save. Transactions larger than 1 MB are rejected
by the NAE. The size limitation includes a 40% overhead from the HTML wrapper around the save
transaction.

Note: This size restriction does not apply to graphics that are created and saved through the
online UI to an NAE55, NAE85, or SCT.

When you work with NAE35/NAE45 graphics, use the following equation to help keep your graphics
at a manageable size:
(background image size x 140%) - 1 MB (1,048,576 bytes) = available space for graphic dynamic
symbols and text blocks

Note: Each graphic symbol is 3,000 bytes.

Example:
Background size: 700,000 bytes
Background + overhead: 700,000 x 140% = 980,000
Total Space for symbols and text = 1,048,576 - 980,000 = 68,576
Total symbol and text elements = 68,576 / 3,000 = 22

Symbols
Symbols are graphic elements or components that are inserted into graphics to represent the value
or status of equipment in your system. The UGT contains the set of symbols described in the table
below. In Edit mode, the symbols appear in a palette to the left side of the graphic workspace.
Symbols support drag and drop functionality. For more information, see Drag and Drop Shortcuts.
Table 239: Symbol Descriptions
Symbol Description
Buttons Buttons allow you to hyperlink from one graphic to an item, URL, or

application.
Value Display Boxes Value Display Boxes display the value and status of bound objects

and allow you to access the Focus view of the bound object. Value
Display Boxes also show the units used by the value.

Gauges Gauges display the value and status of bound objects with
graphs, dials, and standard colors. UGT offers the following gauge
categories:
Analog Fill Bar Graph
Dial Gauge

Dynamics Dynamic symbols indicate the value of bound objects. Some
of these symbols move as the object change. Members of this
category are:
Fans
Basic Shapes  (Block)
Switch (2 or 3 State)
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Button Symbols
Button symbols are useful when browsing to another graphic, object, or a website. Buttons support
the drag and drop functionality, allowing you to drag items from the navigation tree and drop them
in the graphic workspace with the following rules:
If you select multiple objects in the Navigation Tree and then drag a button to the Graphic
Workspace, the UGT creates buttons that Alias the selected objects.
If you select a graphic/object in the navigation tree and then drag a button to the graphic
workspace, the UGT creates a button bound to the selected graphic/object.
In Edit mode, after you drag and drop a button, click on it to add a label. If you double click on a
Button in the Edit mode, the Hyperlink Information box appears. Using this box, you can specify
to link the graphic to a graphic, object, or web page, choose display properties, and choose to hide
the button. See the Button Symbols topic for more information.
Only buttons support Hyperlinks.
In the View mode, left click on the Button to navigate to the bound object, graphic, or web page.
When your cursor passes over a button, the cursor changes into a finger pointer.
See the Buttons step section for information on binding Buttons.

Hyperlinks
Hyperlinks are links from one graphic to other items (graphics or other objects), URLs, or
applications using buttons. If you click on a button hyperlinked to an item, your view switches from
the current graphic to the hyperlinked graphic or object. If you click on a hyperlink to a URL, the
website appears in a separate browser window. If you click on a hyperlink to an application, the
application opens.
Only buttons support hyperlinks. Set hyperlinks when you bind a button symbol.

Value Display Boxes
Value Display Boxes are useful for displaying the value and status of a large number of objects in
a single graphic. The Value Display Box supports drag and drop functionality. If you select a single
item or multiple items in the navigation tree and then drag and drop a Value Display Box, the box/
es automatically binds to the selected item/s.
If a Value Display Box is configured to display the Status of the bound object, the text and box
background appear in the standard Status Colors.
In View mode, Value Display Boxes appear as if they are editable boxes, but they are not. Double
click on the Value Display Box to display the Focus view for the bound object and right click to show
the command menu.
See the Value Display Boxes step section for information on binding Value Display Boxes.

Gauges Category
Gauges provide an indication of the present value and status for the bound objects. If you select
a single item or multiple items in the navigation tree and drag a gauge to the workspace, the UGT
creates one gauge per item and binds each symbol to an item.
The following table lists the gauges included in the UGT.
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Table 240: Gauges
Gauge Type Symbol Animation
Analog Fill Bar Graph Bar moves to indicate value of bound

object.

Dial Gauge Dial needle moves to indicate value of
bound object.

Analog Fill Bar Graph
Analog Fill bar graph symbols show the present value of an object by changing the size of the
bar in the graph and indicating the present value as a number in the display box. The color of the
moving bar graph and the display box background color indicate the status of the bound object. We
recommend using Analog Fill Bar Graphs with analog objects.
You can define the minimum and maximum value of the bar graph range. If you don’t define the
minimum and maximum for the bar range, the gauge defaults to 0 for the minimum and 100 for
the maximum. Under the bar, a value box displays the numeric value of the bound object. Analog
Fill symbols can be configured to move vertically or horizontally. To change the orientation of the
Analog Fill box, see Gauges: Analog Fill.
In View mode, the display box appears as an edit box, but it is not editable. If you choose, the color
of the display box background shows the status of the bound object and the units used by the
symbol. Double click on the symbol to see the Focus view of the bound object and right-click to
show the command dialog box.

Dial Gauge
Dial gauges indicate the present value of a bound object with the position of a needle on a gauge.
A display box shows the present value as a number with units, and shows the status of the bound
object. We recommend using Dial Gauge with analog objects.
You can choose the minimum and maximum value for the dial range. If you don’t define the
minimum and maximum for the dial range, the gauge defaults to 0 for the minimum and 100 for
the maximum.
In the View mode, the Dial Gauge appears as a circular dial with a needle pointing to the position
that represents the value of the bound analog object. A value box below the dial shows the numeric
value of the bound object. Double click the dial gauge to display the Focus view for the bound
object and right-click to show the command dialog box.
See the Gauges: Dial Gauge Symbol step section for information on binding Dial Gauges.

Dynamics
Dynamic symbols display the status of bound objects. If you select a single item or multiple items in
the navigation tree and drag a dynamic symbol to the workspace, the UGT creates one symbol per
item and binds each symbol to an item.
The dynamics category includes the symbols listed in the table below.
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Table 241: Dynamics
Dynamics Type Symbol Animation
Fans Fan/pump blades spin or

remain stationary.

Basic Shapes (Square, Circle, and
Triangle)

Colors change.

Switch (2 or 3 State) Switch changes positions.

Fans
Fan symbols display rotational movement when bound to an object. Use this dynamic component
to provide animation capabilities for fans or pumps that appear in the background image. You
can choose either a clockwise or a counter-clockwise spin. We recommend using Fans with binary
objects.
In View mode, if the bound object has a value of 0, the fan appears stationary. If the bound object
has a value greater than 0, the fan/pump blade spins. The fan/pump color shows the state of the
bound object (red for Off, green for On).
If the fan is spinning, the bound object has a normal status or is unreliable, and the device that
the bound point resides on is online, the color of the fan is set to the color defined in the system
preferences for the On state. If the fan is not spinning, the bound object has a normal status or is
unreliable, and the device that the bound point resides on is online, the color of the fan is set to the
color defined in the system preferences for the Off state. If neither of these scenarios apply, the
color of the fan is defined by the status colors defined in the system preferences.
In the View mode, a double click on a fan symbol displays the Focus view of the bound object. A
right-click shows the command dialog box.
See the Dynamics: Fans step section for information on binding Fans.

Basic Shapes
Basic Shapes show the status of the bound object. Any basic shape can be bound to either an
analog, binary, or multistate object. You can resize these symbols, which include a square, triangle,
and circle.
If a basic shape is bound to an analog object, in the View mode, the color of the shape indicates the
status of the bound object. White is normal, but other colors are listed. See Status Colors.
If a basic shape is bound to a binary object, in the View mode, the color of the shape indicates the
state of the bound object. By default, if the state is 0, the shape is white and if the state is greater
than 0, the shape is green. These can be configured by the user when you bind the symbol.
Double click on the shape to display the Focus view for the bound object. Right-click to display the
commands.

Tip: Use the circles to depict temperature sensors on a floor plan graphic. Circles and
rectangles can be used as status lights.
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See the Dynamics: Basic Shapes step section for information on binding basic shapes.

Switch (2 or 3 State)
The Switch is a dynamic symbol that can be bound to an object, and can be configured to be either
a 2 or 3 state switch). User-defined text appears at the top of the Switch to show what state the
point is in. You can resize Switches. We recommend you bind a Switch to a binary or multistate
object.
In View mode, Switch symbols show the state of the bound object. Double click on the shape to
display the Focus view for the bound object. Right-click to show the command dialog box.
See the Dynamics: Switches step section for information on binding switches.

Binding Symbols to Objects
In the UGT you can bind symbols to objects, which allows the symbol to display the condition of
the bound object. Refer to each symbol section for details about which object type can be bound to
each symbol.
To speed up the binding process, select one item or several items (using the Shift or Control key)
in the navigation tree and then drag and drop a symbol into the graphic workspace. The symbol
automatically binds to the item or items selected in the tree.
To bind graphics in Edit Mode, see Binding Symbols to Objects in Edit Mode.
For information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

Status Colors
Status colors are used by symbols such as Value Display Boxes, Analog Fill Bar Graphs, and Basic
Shapes to indicate the status of a bound object. The following table lists the default status colors
used by the UGT.
Table 242: Status Colors
Status Symbol Text Color Symbol Background Color
Normal Black White
Alarm Black Red
Warning Black Yellow
Trouble Black Yellow
Offline White Black
Operator Override Black Orange
Out of Service Black Light Brown

Note: All status color defaults can be changed in the Graphic Settings Tab in the Preferences
chapter.

See Binding Symbols to Objects in Edit Mode for information on binding graphics.

Alias
Aliases simplify the process of binding symbols to objects during graphic generation when a site
has several graphics that contain a common set of objects. The Alias feature allows you to use a
wildcard character (*) to represent a single string of characters that may be part of the complete
object reference as part of the binding information for a symbol. When a graphic is displayed in
View Mode, the alias symbol (*) is replaced with the text from the alias box of the symbol you used
to access the graphic. If you navigate to a graphic using an aliased button, you cannot edit the
graphic. To edit the aliased graphic, access it through the navigation tree.
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For example, aliasing allows you to use a single aliased graphic for multiple field controllers, such
as VMAs, with similar configurations. See Creating Aliases.
Figure 61 shows an example of a main graphic and an aliased graphic. In the figure, the top panel
contains the main graphic, which has several buttons bound to the aliased graphic. Each button has
its alias string set to the reference for a different field device. The bottom panel shows the aliased
graphic, displayed directly from the navigation view (that is, with no alias strings passed in).
Figure 62 show the aliased graphic as it displays when the user clicks the corresponding buttons in
the main graphic (that is, with field device-specific values).

Figure 61: Alias Example - Main and Aliased Graphics
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Figure 62: Alias Example - Using the Aliases

For more information on binding graphics, see Binding Symbols to Objects in Edit Mode.

Navigation
You can navigate between graphics by using hyperlinked Button Symbols or by selecting graphics
from the navigation tree and displaying them in the Display Frame. You can restrict user access to
specific graphics by setting security levels in the Security Administrator System.
You can also create user views that contain only graphics (hierarchy of graphics references).

Commands
You can command objects that are bound to symbols by right clicking on the symbol in View Mode.
If you are not authorized to command the object, the command is disabled in the command dialog
box.

Mouse Shortcuts
Use mouse shortcuts to speed up User Graphics Tool use. See Mouse Shortcuts: Edit Mode and
Mouse Shortcuts: View Mode.

Mouse Shortcuts: Edit Mode
The following table lists the mouse shortcuts you can use in the Edit Mode of the User Graphics
Tool.
Table 243: Edit Mode Mouse Shortcuts
Item Single Left Click Double Left Click Right-Click
Static Background
Image

No action takes
place.

No action takes place. Remove Background

Button Select Hyperlink Information
dialog box appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Value Display Box Select Bind Information dialog box
appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Gauge: Analog Fill Select Bind Information dialog box
appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align
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Table 243: Edit Mode Mouse Shortcuts
Item Single Left Click Double Left Click Right-Click
Gauge: Dial Select Bind Information dialog box

appears.
Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Dynamics: Fan Select Bind Information dialog box
appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Dynamic: Basic
Shape

Select Bind Information dialog box
appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Dynamics:
Switches

Select Bind Information dialog box
appears.

Cut, Copy, Paste, Duplicate,
Delete, Format, Align

Format
The Format menu choice contains the choices listed in the following table.
Table 244: Format Menu Options
Choice Description
Copy Binding Copies the selected symbol’s binding information, which you can then

paste to a new symbol. With this feature, you can easily bind several
symbols to one object.

Paste Binding Pastes the previously copied binding information to the selected
symbol(s).

Copy Format Copies the selected symbol’s formatting (size and font information), which
you can then paste onto another symbol. This allows you to easily format
multiple symbols in the same way.

Paste Format Pastes the previously copied formatting information to the selected
symbol(s).

Align
The Align menu choice contains the choices listed in the following table.
Table 245: Align Menu Options
Choice Description

Note: When you select multiple objects by dragging the mouse across them,
the first selected symbol is not based on the symbol's location within the
graphic, but on the order in which it was originally added to the graphic. We
recommend that you first click on the symbol with which you want to align
other symbols. Once you have selected that symbol, hold down the Shift key
while you drag the mouse across additional symbols to select them (you can
also use Shift + click to select additional symbols).

Align Top Aligns all symbols to the top most edge of the first symbol you selected.
Align Bottom Aligns all symbols to the bottom most edge of the first symbol you

selected.
Align Left Aligns all symbols to the left most edge of the first symbol you selected.
Align Right Aligns all symbols to the right most edge of the first symbol you selected.
Align Horizontal
Center

Aligns all symbols to the horizontal center of the first symbol you selected.

Align Vertical Center Aligns all symbols to the vertical center of the first symbol you selected.
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Mouse Shortcuts: View Mode
The following table lists the mouse shortcuts you can use in the View Mode of the User Graphics
Tool.
Table 246: View Mode Mouse Shortcuts
Symbol Single Left Click Double Left Click Right-Click
Button Navigate to

hyperlink.
Navigate to hyperlink. No action takes place.

Value Display Box Select Display focus view of
bound object.

Command box appears.

Gauge: Analog Fill Select Display focus view of
bound object.

Command box appears.

Gauge: Dial Select Display focus view of
bound object.

Command box appears.

Dynamics: Fan Select Display focus view of
bound object.

Command box appears.

Dynamic: Basic
Shape

Select Display focus view of
bound object.

Command box appears.

Dynamics: Switches Select Display focus view of
bound object.

Command box appears.

Drag and Drop Shortcuts
Consider the following shortcuts when dragging and dropping items to the Graphic Workspace:

• If you select a Graphic Object in the navigation tree and then drag a button to the graphics
workspace, the UGT creates a button already bound to the selected Graphic object.

• If you select multiple field points in the Navigation Tree and drag a Value Display Box to the
graphics workspace, the UGT creates multiple Value Display Boxes each bound to a field point.

• If you select multiple field points in the navigation tree and drag a dynamic symbol or gauge to
the graphics workspace, the UGT creates multiple symbols each bound to a field point.

• If you select multiple field controllers along with a Graphic object in the navigation tree and
drag a button to the graphics workspace, the UGT creates buttons for all the controllers. All
buttons have the appropriate Alias string already entered.

• To change the binding information for a symbol or to add binding information (if you drag
and drop a symbol without selecting anything in the navigation tree), see Binding Symbols to
Objects in Edit Mode.

User Graphics Tool Steps

Generating Graphics (Overview)
About this task:  
Notes:

• This process is the same when the system is offline, except the binding is done to the archive
database instead of the online system.

• For information on default preferences for graphics (such as status colors, fan colors, state
colors, and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
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To create a complete graphic:

1. On the Insert Menu, select  Graphic. The Graphic appears.
2. Follow the wizard instructions.
3. Drag the graphic from the Navigation Tree to the display panel.
4. Click on the Background Image icon on the UGT toolbar to import a Static Background image

into the graphic.

Note: To scale imported SVGZ Floorplans from Visio, cut the rescaled image from Visio.
Paste the image into Paint. Cut the image from Paint and use paste special as a Device
Independent Bitmap into Visio.

5. Add  Symbols  as needed on top of the static background.
6. Bind the symbols to object.
7. Add Hyperlinks to the buttons and create aliases (if desired).
8. Save the graphic.
9. Download the graphic to the online device (if you have created the graphic with the Metasys

software offline using the SCT). Upload the graphic to the archive database of the SCT (if you
have created the graphic with Metasys software online).

Changing UGT Modes
To change from View mode to Edit mode, click the Edit button on the UGT Toolbar.
To change from Edit mode to View mode, click Save on the UGT toolbar.

Viewing User Graphics
To view user graphics, double click on or drag a graphic item from the Navigation Tree into the
Panel Layout.

Note: To be sure the graphic item drops completely, release the drop with your cursor over
the header section of the desired display frame.

Copying an Existing Graphic
About this task:  

Note: This is available when using the SCT only.

1. Click an existing graphic item in the Navigation Tree.
2. On the Edit menu, select Copy.
3. Click in the navigation tree where the new graphic is to appear.
4. On the Edit menu, select Paste and name the new graphic.

Binding Symbols to Objects in Edit Mode

Buttons
About this task:  
To bind buttons to items, URLs, or applications:

1. Double-click a button. The Hyperlink Information dialog box appears.
2. Use the information in the following table to edit the fields.
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Table 247: Button Options
Field Description
Hyperlink Type Selects whether the button provides a link to an item, URL, or

application.
Item/URL/
Application

If you link the button to a URL, type the address here. If you link to an
item or application, click the Browse icon and see below. Applications
configured using the Metasys Preferences Applications Tab appear on
the drop-down menu.

Browse icon Opens a dialog box for browsing to an item or application.
If you are linking to an item, UGT displays a navigation tree listing
graphics/objects you can bind to the button.
If you are linking to an application that is not in the Application drop-
down menu, UGT allows you to navigate to and select an executable
file for an application that resides on your local file system or a
network drive.

Note: The linked application does not close when you exit the UI.

Hidden Hides the button in the View mode, creating a virtual hyperlink on the
background image.

Alias Passes the defined Alias string to the linked graphic when you press
the button.

Properties Displays a dialog box to change font size and text justification for the
button label text.

OK Accepts changes.
Cancel Cancels changes.

Value Display Boxes
About this task:  
To bind Value Display Boxes to objects:

1. Double click a Value Display Box. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.

Table 248: Value Display Box Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Value Display Box. Or lets you click the Browse icon to
launch a tree browser to select the object to bind to the Value Display
Box.

Attribute Allows you to select the specific attribute to bind to the Value Display
Box. The bound attribute is initially set to the object's Default
attribute, which varies per object type, but is typically Present Value.
If an object does not have a Default attribute, the value box
displays ???? on the graphic until you change the binding to a
different attribute.
You can bind to string values or to numeric values.
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Table 248: Value Display Box Options
Field Description
Units Shows the Units for the bound object in the Value Display box.
Status Shows the Status for the bound object by color-coding the text and

background for the Value Display box.
Properties Allows you to configure the text properties for the Value Display Box

text.
OK Accepts changes.
Cancel Cancels changes.

Result  

Note: In the View mode, double clicking on the Value Display box displays the focus view for
the bound object. Right-click displays the commands.

Gauges: Analog Fill
About this task:  
To bind Analog Fill symbols to objects:

1. Double-click an Analog Fill Bar Graph icon. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.

Table 249: Analog Fill Gauge Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Analog Fill Gauge. Or, lets you click the Browse icon to
launch a tree browser to select the object to bind to the Analog Fill
Gauge.

Attribute Allows you to select the object’s attribute to bind to the gauge.
Fill Color Launches the fill color selector to select the color displayed by the bar

graph.
Orientation Chooses vertical or horizontal motion of the bar graph.
High Limit Sets the high number for the display range of the gauge.
Low Limit Sets the low number for the display range of the gauge.
Units Displays the units used by the bound object.
Status Displays the status of the object in the display box of the symbol.
Properties Allows you to configure the text properties for the text in the display

box of the gauge.
OK Accepts changes.
Cancel Cancels changes.

Gauges: Dial Gauge Symbol
About this task:  
To bind Dial Gauge symbols to objects:

1. Double-click the Dial Gauge symbol. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.
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Table 250: Dial Gauge Symbol Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Dial Gauge. Or, lets you click the Browse icon to launch a
tree browser to select the object to bind to the Dial Gauge.

Attribute Allows you to select the object’s attribute to bind to the gauge.
Gauge Color Launches the color selector for the gauge to select the color displayed

in the center of the gauge.
High Limit Sets the high number for the display range of the gauge.
Low Limit Sets the low number for the display range of the gauge.
Units Displays the units used by the bound object.
Status Displays the status of the bound object in the display box of the

gauge.
Properties Allows you to configure the text properties for the text in the display

box of the gauge.
OK Accepts changes.
Cancel Cancels changes.

Dynamics: Fans
About this task:  
To bind Fan symbols to objects:

1. Double-click the Fans symbol. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.

Table 251: Fan Dynamics Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Fan. Or, lets you click the Browse icon to launch a tree
browser to select the object to bind to the Fan.

Attribute Allows you to select the object’s attribute to bind to the fan.
Clockwise/Counter-
Clockwise

Selects if the Fan symbol spins in a clockwise or counter-clockwise
direction.

OK Accepts changes.
Cancel Cancels changes.

Dynamics: Basic Shapes
About this task:  
To bind Basic Shapes symbols to objects:

1. Double-click the Basic Shapes symbol. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.

For information on default preferences for graphics (such as status colors, fan colors, state
colors, and alarm flashing settings), see Graphic Settings Tab in the Preferences section.
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Table 252: Basic Shape Dynamics Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Basic Shape. Or, lets you click the Browse icon to launch a
tree browser to select the object to bind to the Basic Shape.

Attribute Allows you to select the object’s attribute to bind to the Basic Shape.
State 0 Allows you to set the color for State 0.

The default color is determined by the preferences. See Graphic
Settings Tab in the Preferences section for details.

State 1 Allows you to set the color for State 1.
State 2 Allows you to set the color for State 3.
State 3 Allows you to set the color for State 4.
All Other States Allows you to set the color for all other states.
Orientation For the triangle basic shape, chooses the position of the point (Up,

Down, Left, or Right).
OK Accepts changes.
Cancel Cancels changes.

Dynamics: Switches
About this task:  
To bind Switch symbols to objects:

1. Double-click the Switch symbol. The Binding Information dialog box appears.
2. Use the information in the following table to edit the fields.

Table 253: Dynamic Switch Options
Field Description
Object Allows you to type in the Item Reference of the object you want to

bind to the Switch. Or, lets you click the Browse icon to launch a tree
browser to select the object to bind to the Switch.

Attribute Allows you to select the object’s attribute to bind to the switch.
Number of States Allows you to choose the number of states (2 or 3) the switch has.
State 0/1/2 Allows you to choose the text associated with each state.
OK Accepts changes.
Cancel Cancels changes.

Monitoring and Commanding Items Using Graphics in View Mode
About this task:  

Note: The Metasys system user interface provides the capability to monitor and command the
Metasys system using graphics. To navigate through the system, see Navigating Graphics in
View Mode.

To monitor your Metasys system using graphics:

1. Display graphics to show the status/state of your system components.
2. Navigate through the system.
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3. To command objects/items using graphics, right-click on the symbol in View mode and select
the desired command.

Result  

Note: Right-clicking has no effect on Button Symbols.

Navigating Graphics in View Mode
About this task:  
To navigate graphics in View mode, double-click the symbol and navigate by one of the following
two methods:

1. Navigate to the hyperlink of a  button symbol by clicking on the button.
2. Navigate to the Focus view of an object by double-clicking a Dial Gauge or Fan symbol.

Adding Symbols to the Workspace
To add symbols to the workspace, drag the symbol from the palette and drop the symbol into the
workspace.
Notes:

• Depending on the symbol you are adding, be wary if items are selected in the navigation tree.
Some symbols automatically bind to items selected in the tree. See the Symbols topics for
more information on drag and drop capabilities.

• For more information on drag and drop binding shortcuts, see Drag and Drop Shortcuts.

Deleting Symbols from the Graphics Workspace
To delete symbols from the workspace, select the symbol and press Delete on your keyboard or
right-click on the symbol and select Delete from the menu.

Adding Text Blocks
About this task:  
To add text blocks in Edit mode:

1. Click the Text icon on the UGT Toolbar.
2. Click the workspace to select a location for the text. The text block appears.
3. Click the Select icon from the toolbar and double-click on the text block. The edit text box

appears.
4. Type in the text box and click OK.
5. Select the Select icon on the UGT Toolbar.
6. Select the text block and drag the sides to resize the block.

Editing Text Blocks
About this task:  
To edit text:

1. With the selection pointer tool, double-click on the block. The block opens for editing.
2. Change the text and click OK.
3. To change the text properties, right click on the text block and select Properties from the

menu.

Result  

Note: You can change the font (type, size, bold, italic, bold italic), text color, background color,
and border visibility/color.
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Editing a Background Image
About this task:  
Use this procedure if you want to edit a background of a graphic by exporting it from the UGT. Use
this method when a copy of the existing background image is not available.

1. Drag the desired graphic from the Navigation Tree to the display panel.
2. Click the Edit button on the UGT Toolbar to enter Edit Mode.
3. Click the Save Background Image icon on the UGT toolbar to save the static background

image to a location on your hard drive. The Save dialog box appears.
4. Enter a name for the background image, select the desired location on your hard drive, select

JPG or SVG format, and click Save.
5. Open the background image file in the desired graphic editing program. Edit the background

image as desired and save the file in SVG, SVGZ, or JPG format. See the Static background
image section for information on supported file formats.

Note: You can only save a background image under its original file type. For example, if
the background image was originally a JPG, you can save it only as a JPG now. You can
save SVG and SVGZ files as SVG or SVGZ.

6. Return to the graphic in the UGT.
7. Click the Set Background Image icon on the UGT toolbar to import the revised background

image file into the graphic.
8. Save the graphic.
9. Download the graphic to the online device (if you have created the graphic with the Metasys

software offline using the SCT). Upload the graphic to the archive database of the SCT (if you
have created the graphic with Metasys software online mode).

Result  

Note: Save a copy of the background image file in a folder on your hard drive as a backup
method. If you decide to edit that background image later, you can edit your hard drive copy
and use the Set Background Image icon to re-import the background into the graphic in the
UGT. You also can use your hard drive copy in the event that you lose your databases and need
to recover the background image.

Creating Aliases
About this task:  
See Alias for more information on aliases.

Note: Do not set the Graphic attribute for an alarm extension to an aliased graphic. Aliased
graphics do not display properly when displayed from the Alarms Window or Event Viewer.

1. Create a graphic with an appropriate background image, and add value boxes to represent
common field points.

2. For each value box, edit the bound reference and use a wildcard character (*) to replace the
portion of the reference specific to a particular supervisory device, field trunk, and/or field
controller.
For example, change the bound object reference for a Zone Temperature AI from
ADS1:NAE1/N2 Trunk 1.VMA-1.ZN-T to *.ZN-T. This is your aliased graphic.

Note: One wildcard character is allowed per reference, and all wildcard characters used
in bindings for a particular aliased graphic must represent the same string.

3. Create a separate main graphic to use as the access point for your aliased graphic.
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4. On the main graphic, add a button bound to the aliased graphic. Give the button a name
indicating the field device it represents (see Tip below).

5. Set the alias string for the button to the text that should replace the wildcard in the reference
for the value boxes on the aliased graphic.
For the example above, the alias string would be:
ADS1:NAE1/N2 Trunk 1.VMA-1

6. Repeat Step 4 and Step 5 to add buttons for additional field controllers, setting the alias string
appropriately for each.
For example, ADS1:NAE201/N2 Trunk 2.VMA-43.

Tip: You can use the following shortcut steps to quickly create the buttons for your
aliased graphic on your main graphic:

a. Display your main graphic in the Display panel, and click Edit.
b. Select the aliased graphic in the All Items navigation tree, then use Ctrl + click or Shift +

click to select the items to use with the aliased graphic.
For the example given earlier, select VMA-1 under N2 Trunk on NAE1, and VMA-43
under N2 Trunk 2 on NAE 201.

c. With the aliased graphic and other items selected in the navigation tree, drag the
Button from the UGT palette into the graphic display area. A new button appears in the
main graphic for each item. Each button is labeled with the item name, bound to the
aliased graphic, and has its alias string set to the full reference of the selected item (for
example, ADS1:NAE1/N2 Trunk 1.VMA-1).

d. Find the button on the main graphic that has its alias string set to the aliased graphic
(labeled with the name of the aliased graphic). This button is no longer needed, so you
may delete it.

e. Save your changes.

Result  
Once you have finished configuring your main and aliased graphic, display the main graphic in the
online UI. Use the buttons on the main graphic to open the aliased graphic for each field device.
See Figure 61 and Figure 62.

Saving a Graphic
To save a graphic, click the Save button on the Toolbar.

Trend Study
Menu Selection: Insert > Trend Study
Inserts a trend study into the site.

Tip: With the Trend Study tab selected on the Configure Screen, select the plus icon to add
trend items, or click the minus icon to remove trend items.

Tip:  Select the Configuration tab on the Configure screen for further configuration.

See one of the following sections for more information:
• Trend Studies
• Trend Extensions

Trend Studies
Menu Selection: Insert > Trend Study
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Inserts a trend study into the site.

Tip:
• With the Trend Study tab selected on the Configure Screen, click the plus icon to add

trend items, or click the minus icon button to delete trend items.
• Select the Configuration tab on the Configure screen for further configuration.

The Metasys Historical Data Management feature allows you to collect and store historical samples
of Engine object data. Metasys Trend Studies allow you to view the historical data. Using this
information, you can manage energy usage, bill tenants, prove compliance to standards, and
diagnose problems in your Metasys system. You can also trend attributes of system objects. With
the addition of an ADS Device Object or ODS Device Object to your network, the Metasys system
provides long-term storage of historical data and you dramatically increase storage capabilities.
See the Site Object and Engine Device Object.
The Engine allows you to add Trend Extensions to objects. The Trend Extension contains all of
the trend definition information associated with the object. Each trend is associated with a single
attribute of that object and collects historical data samples of that attribute. With Trend Extensions,
data is collected in the Engine only, but you can configure the Engine to transfer the data to the
Metasys server for long-term storage. For more information on extensions, see Extensions.
Do not confuse the trend study with the Trend Viewer or Trend Extension. For information on
Trend Extensions or the Trend Viewer, refer to the Trend Extensions and Trend Viewer sections in the
Metasys SMP Help (LIT-1201793).
For performance information on trends, refer to the Metasys System Configuration Guide
(LIT-12011832).

Trend Studies Concepts

Historical Data Overview
Basic Historical Data Management begins with the Engine trend extension. Each Engine attribute
that can be trended can store historical data samples about the attribute. Sample storage in
the Engine is limited to the size of the individual Trend Buffer. For storage of long-term or large
numbers of samples, configure your system to store historical data in the Metasys server. Use the
Trend Extension to view and configure trends in the Engine and the Trend Study to view trend data
from the Engine and/or Metasys server.

Note: Although multiple trend extensions can be added to an object on an NxE, these
extensions will be combined as a single trend if sent to a Historical Data Repository. This may
not yield the expected result. To use multiple trends on a single object in an Historical Data
Repository, create duplicate AV or BV objects and that map to the point in question, then
create a new trend on the parallel AV or BV.

Historical Data Management in a Metasys Server
When you add a Metasys server to your Metasys system, trend data can be placed in a Historical
Data Repository for long-term storage. If your Engine is configured to route trends to the Metasys
server, the Metasys server stores the trends in the Historical Data database. The Metasys server
utilizes a standard database management system that supports archival storage.

Trend Studies
Accessible through the navigation tree, Trend Studies display trend sample data from trends
in Engine trend buffers and/or Metasys server repositories. A Metasys server on the site is not
required to retrieve trend data from the Engine.
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When you create a Trend Study, you use the Trend Study wizard to choose the sources for the
trends and the display properties.
An Audit Trail message is created whenever you create, delete, or edit a Trend Study. Trend Studies,
graphics, and folders are the only items you can create under a Metasys server on the navigation
tree.
The main advantages to using Trend Studies are that you can:

• view multiple trends at once (from both Engine and Metasys server)
• view Metasys server historical trend data
• configure the Study Range with flexible parameters

Note: You do not need a Metasys server on the site to forward trend samples to a Metasys
server. You can forward trend samples to a Metasys server on a different Metasys site. See the
Metasys Server for Metasys server information.

Views
There are three views in the Trend Study: Chart View, Table View, and Definition View.
Table 254: Views
Button View Description

Chart View Allows you to view trend data in a chart format.

Table View Allows you to view trend data in a table format.

Definition View Allows you to view the Trend Study setup and display
options.

Trend Study Chart View
The Chart view allows you to view data samples in a graphical format and retrieve new trend data.
You can zoom, unzoom, and pan within the Chart. You can also specify the X-axis and Y-axis ranges.
You can change the Y-axis type to view the chart using stacked Y-axis or single Y-axis.
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Table 255: Chart View
Button Name Description

Update Retrieves the most recent data samples for the displayed
trends.

 (Zoom)

 (Normal)

Zoom Toggles the mouse behavior for the chart between zoom
mode and normal mode.
While in zoom mode:

• drag the mouse over an area of the chart to zoom in
on that area.

• click Zoom to exit zoom mode and restore the mouse
to normal mode.

• left-click to zoom out one level.

When you exit zoom mode, the chart remains at the
current zoom level. Use the Restore button to fully zoom
out on the chart.

Note:

• You cannot pan while the mouse is in zoom
mode.

• You can also zoom and unzoom in normal mode
by using the Shift key and the mouse. To zoom,
hold the Shift key down while dragging the
mouse across the chart. To zoom out one level,
left-click the mouse while holding the shift key
down.

Restore Allows you to return to an unzoomed view and Allows you
to return to an unzoomed view and switches the mouse
back to normal mode if the chart's zoom mode is active.

Pan Allows you to pan the view of the chart vertically or
horizontally by dragging the mouse across a zoomed
chart. Panning is not available for unzoomed charts or
when zoom mode is active. To pan left or right, drag
the mouse over the X-axis. To pan up or down, drag the
mouse over the Y-axis.

Points Line Displays the data using lines and point markers. The
Points Line chart is the default chart type in chart view.

Area Displays the data using an area chart.

Bar Displays the data using a bar chart.
Note: Only use the bar chart when the number of data
samples can reasonably be expected to display as bars. If
too many data samples exist when you click this option, the
display becomes unstable and fails to properly update the
screen. To recover, select any other display option.

Points Displays the data using markers, with no lines.

Line Displays the data using lines, with no markers.
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Table 255: Chart View
Button Name Description

Stacked Y-axis Displays a separate Y-axis for each trend.

Single Y-axis Displays the trends using a single Y-axis.

Chart Right-Click Menu
You can access a right-click menu from the Chart view. Place your cursor in the chart and right-click
in the panel to display the menu.
Table 256: Chart View Right-Click Menu
Menu Item Description
Background Color Opens the Select a Color dialog box and allows you to configure the

background color.
Y-axis Scale Displays the Y-axis Range Configuration dialog box.
X-axis Scale Displays the X-axis Range Configuration dialog box.
Gridlines Allows you to select what type of gridlines to appear on the chart. You

can choose: None, X and Y, X Only, and Y Only.
Chart Type Allows you to select what type of chart to display. You can choose:

Points Line, Area, Bar, Points, and Line.
Stacked Y-axis Displays the chart on a stacked Y-axis.

Chart Legend
The Chart Legend appears below the graphical charting area. The Chart Legend displays the list of
trend items for the Trend Study in a table, and includes information about each item.
Table 257: Legend
Button/Field Name Description

Select All Selects the maximum number of trend items for display in
the chart.

Remove All
Selections

Deselects all trend items in the chart Legend.

Show Indicates if the trend item appears in the Chart. When
checked, the data appears on the chart and in the table.
When unchecked, the data does not appear in the chart or
table.

Historical Trend
Icon

Indicates the trend was selected from the Metasys server
Historical Database folder.

Marker Indicates the appearance of the marker style and color for
the trend item on the Chart.

Color Palette Displays the Select a Color dialog box. Allows you to
change the color used to chart the trend data.

Name Displays the trend item name based on the Name
attribute.

Reference Displays the trend item’s full reference.
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Chart Legend Right-Click Menu
You can right-click an item in the Chart Legend to access item-specific menu options. The right-click
menu content is based on the type of item you click on. For example, if you right-click a trend item
from a historical database, you can only Refresh the Trend Study display.

Trend Study Table View
The Table view of the Trend Study allows you to view data for the selected trends in a table format.
You can copy the trend data to the clipboard for pasting into other applications such as Microsoft
Excel.
Table 258: Table View
Button Name Description

The Historical Trend Icon
appears in the Table
View column headings
when applicable.

Update Updates the data samples with new trend data
immediately.

Copy to
Clipboard

Allows you to copy selected trend data to the system
clipboard for pasting into other applications such
as Microsoft Excel. You can also use Ctrl + C to copy
selected trend data.

Trend Study Definition View
Use the Definition View to edit the Trend Study configuration. You can choose which trends are
viewed, choose the Study Range, and edit the display properties. You can view more than one trend
item at a time on the same graph. The following table details the fields in the Definition View.
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Table 259: Definition View
Field Description
General Allows you to edit the refresh rate and display precision.

• Refresh rate: specifies the amount of time, in seconds, for automatic refresh
of data. You must configure this attribute with a value of 0 seconds, 60
seconds, or greater than 60 seconds. Values 1 to 59 are invalid and not
allowed. 0 means manual refresh. If the refresh rate is 0, click the Update
button to display new data.

• Display precision: specifies the decimal point rounding and the number
of decimal places used to format real values that do not report a display
precision. If the value reports a display precision, this Trend Viewer attribute
is ignored in favor of the value’s native display precision.

Range Start
and Range
End

Specifies the Start Time and End Time for the Trend Study.
• Radio Buttons: allows you to choose relative time or absolute time for the

Study Range (start and end times). The fields enable depending on which
one you select.

• Date: displays the date for the Study Range.
• Absolute Time: allows you to select a specific date and time for the Study

Range. This selection creates a fixed range of time when the Study is viewed.
• Relative Time: allows you to select either Today or Now. If you select Today,

enter the Relative Time. If you choose Now, specify an Offset. This selection
creates a moving range that is relative to the time the Study is viewed.

• Offset: represents a combination of a whole number of days, hours, minutes,
and seconds before or after (- or +) the current date and time.

Chart Display Allows you to add gridlines, stack the Y-axis, and choose the chart style for the
Trend Study.

Definition View Trend Items Table
The Trend Items table appears at the bottom of the Definition view. The Trend Items table displays
the list of the Trend Study’s trend items.
Table 260: Trend Items Table
Button Name Description

Historical Trend
Icon

Indicates the trend was selected from the Metasys server
Historical Database folder.

Add Opens the Select Item dialog box and allows you to add
trend items to the Trend Study. This button only enables
when the view is in edit mode.

Note: All items and navigation trees appear in the Select Item
window; however, you can only select trends. All other items
appear dimmed.

Remove Allows you to remove a trend item from the Trend Study.
This button only enables when the view is in edit mode.

Name Displays the name of the trend item.

Reference Displays the trend item’s reference information.
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Table 260: Trend Items Table
Button Name Description

Aggregate Function Allows you to select the aggregate function to use on the
trend sample data (NONE, Average, Minimum, Maximum,
Standard Deviation, Range, Sum, and Variance). You can
sample the same point for different aggregate functions
and display them on a single chart. Aggregate functions
group multiple values together to construct a single value
that has significant meaning or measurement. Descriptions
of available aggregate functions are as follows:

• Average: the sum of values divided by the total
number of values

• Minimum: the lowest value of a set of values
• Maximum: the highest value of a set of values
• Standard Deviation: the amount of variation or

dispersion of a set of data values
• Range: the difference between the lowest and highest

values on a particular scale
• Sum: the addition of two or more numbers
• Variance: the quantity equal to the square of the

standard deviation

The aggregate functions of the trend study apply to
information in the Historical Data at the Metasys server
server and do not apply to data in the NAE buffer.

Aggregate Interval Specifies the time, in minutes, over which the aggregate
function should be applied (for example, 60 for an hourly
calculation, or 1,440 for a daily calculation).

Plotting Style Allows you to select the plotting method for the trend item.
• Continuous - straight line between data samples.

Continuous plotting connects samples with the
shortest possible line, giving an appearance of a set of
diagonal ramps as samples change value.

• Discrete - line stays at the same value until the next
data sample is taken (good for binary data). Discrete
plotting has 90-degree angles at the time when
samples change value. The chart appears to be a series
of steps.

Study Range
The Study Range is the time period used to filter trend data. The Trend Study gathers and displays
the trends that are taken during this time period.

Default Destination
The ADS Repository defines where trend samples are sent when the local trend buffers reach their
defined Transfer Setpoint (see the Trend Extensions section), the Engine defined ADS Delivery Time
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(see the Engine Device Object) is reached, or the user initiates a transfer. You can initiate a transfer
by using the Trend Extension’s Route command.

Notes:
• You do not need a Metasys server on the site to forward trends to a Metasys server. You

can forward trend samples to a Metasys server on a different Metasys site. The off-site a
Metasys server that receives forwarded trend samples must be the Site Director of its site.

• You can define only one repository as the default destination for each Engine.

For more information on a Metasys server default trend destinations, see Configuring the Metasys
Server/ODS as the Destination for Trend Data.

Trend Studies Steps

Setting Up Trend Studies (Overview)
1. Create a Trend Extension.
2. Configuring the Metasys Server/ODS as the Destination for Trend Data or Configure an ODS

as the destination for trend data.
3. Configure the trend extension to pass trends to the ADS/ADX or pass trends to the ODS.
4. Configure the ADS/ADX to forward trends to another ADS/ADX or ODS to forward trends to

another ODS trend repository (if desired).
5. Create a Trend Study.

Result  

Notes:
• If you have a site with a Metasys server and engines, and you create a Trend Study on

an engine (rather than on the Metasys server), any trend items added to the trend study
from the Metasys server’s Historical DB folder is listed with the current site name in their
references instead of their actual site names.

• When referencing trend items that were forwarded from an off-site device, create the
trend study object on the Metasys server, rather than on the engine.

Configuring the Metasys Server/ODS as the Destination for Trend Data
About this task:  

Notes:
• You can define only one repository as the default destination.
• If you need to provide long-term storage for trend samples from an Engine, follow these

steps to configure the Trend Repository of a Metasys server as the Default Destination.

To configure the a Metasys server Trend Repository as the Default Destination for trend samples
from an Engine:

1. Select the Engine device in the navigation tree.
2. View the Engine. See Displaying Information About an Item for more information on how to

display an item.
3. Select the Focus tab and click the Advanced radio button to display additional item

information.
4. Select Edit.
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5. Edit the Metasys server Repository and the Metasys server Delivery Time. (The Engine Device
Object attributes table contains Default Value and Values/Options/Range information for the
attributes.)

6. Click Save.

Note: If you want to define the a Metasys server attributes for the entire site instead of
at the individual Engine level, select the Site in the navigation tree and edit the Metasys
server Repository and the Metasys server Delivery Time. (The Site Object attributes table
contains Default Value and Values/Options/Range information for the attributes.)

Configuring the Trend Extension to Pass Trend Data to the Metasys server
To configure the Metasys server as a default destination for trends, you must configure the
Repository Enabled and Transfer Setpoint attributes in the Trend Extension. See the Object Help
section.

Configuring a Metasys Server/an ODS to Forward Trend Data to Another Metasys
Server/ODS Trend Repository

1. View the original Metasys server.
2. Select the Focus tab and click the Advanced radio button to display additional item

information.
3. Select Edit.
4. Scroll down to the Repository Storage section.
5. Edit the Metasys server Device Object's attribute.
6. Click Save.

Creating Trend Studies (Overview)
About this task:  

Note: Before creating a Trend Study, create a Trend extension. See Setting Up Trend Studies
(Overview) for details.

1. From the Insert Menu, select Trend Study.
2. Follow the Trend Study’s wizard steps. The new study appears in the Navigation Tree.
3. Drag the study to the Panel Layout.
4. On the Definition View, click Edit and configure the fields (see Trend Study Definition View)

as you want them.
5. Add trend items to the Trend Item table using the add button. The Select Item window

appears.
6. Select one or more trend items.

Notes:
- Multiple selection adds multiple items.
- All non-trend items appear dimmed. If everything appears dimmed in the Select

Item tree, check to see if you have at least one object with a Trend Extension and/
or that Engine devices from other sites are storing samples in the Metasys server (if
applicable).

7. Click OK. See Adding New Trend Items to the Trend Study.
8. Click Save.
9. Click the Chart or Table buttons to see trended data in the specific format.

Note: If nothing appears in the chart or table, check to see if you have samples in your
study range and adjust if necessary.
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Editing Trend Studies
1. View the Trend Study.
2. Click the Definition View button.
3. Click the Edit button.
4. Make your changes using the table in the Trend Study Definition View section, including

adding new Trend Items.
5. Click the Save button to save the changes.

Viewing Trend Studies
About this task:  

Note: To create Trend Studies, see Creating Trend Studies (Overview).

1. From the navigation tree, drag the Trend Study you want to view to the Panel Layout.
2. Select the Definition View button to edit the Trend Study. Select the Chart View or Table

View buttons to view the trend data.

Result  

Notes:
• The UI limits the number of data samples you can retrieve. Therefore, you may not see

the full range specified. The most recent data samples are always retrieved first.
• If the chart appears to flicker, you have too many trend samples in the Trend Study.

Reduce the number of displayed trends or change the trending date/time range to
display fewer samples and improve performance. See Deleting Trends from the Trend
Study.

Deleting Trend Studies
1. Select a Trend Study in the navigation tree.
2. Select Edit > Delete Items and answer Yes to the Confirm Delete box.

Adding New Trend Items to the Trend Study
1. View the Trend Study.
2. If necessary, click the Definition View button.
3. Click the Edit button in the upper left of the Trend Study tab.
4. Click the Add icon in the Trend Items table. The Select Item dialog box appears.
5. Select the trend(s) that you wish to add from the Select Item dialog box.

Notes:
- Multiple selection adds multiple items.
- All non-trend items appear dimmed. If everything appears dimmed in the Select

Item dialog box, check to see if you have at least one object with a Trend Extension
and/or that Engine devices from other sites are storing samples in the Metasys
server (if applicable).

6. Click the OK button in the Select Item dialog box.
7. Click the Save button in the Definition View to save the changes.

Deleting Trends from the Trend Study
1. View the Trend Study.
2. Click the Definition View button.
3. Click the Edit button.

467SCT: System Configuration Tool Help



4. Select a trend in the Trend Item table.
5. Click the Remove icon. The Remove confirmation dialog box appears asking if you want to

remove the trend item. Click Yes.
6. Click Save.

Configuring the X-axis
About this task:  
To configure the X-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the X-axis Scale. The Range Configuration dialog box appears.
3. Specify whether to Use Automatic Range Calculation. The automatic range is determined

automatically based on the set-up in the Definition View.

Notes:
- You are limited to dates and times between the start and end dates configured in

the Trend Study definition.
- When you select Use Automatic Range Calculation, you do not fill in the Range

fields.

4. Specify the Start Time, Start Date, End Time, and End Date.
5. Click OK.

Result  

Note: You can also configure the X-axis range by changing the start and end dates and times
in the Definition View. See the table in the Trend Study Definition View.

Configuring the Y-axis
About this task:  
To configure the Y-axis in the Chart view:

1. Place your cursor on the chart and right-click.
2. Select the Y-axis Scale menu item. The Range Configuration dialog box appears.
3. If you are using stacked Y-axis, choose the trend item to which the Y-axis range should be

applied from the item drop-down list.
4. Specify whether to Use Automatic Range Calculation. The Range is determined

automatically based on the trend items.

Note: When you select Use Automatic Range Calculation, you do not fill in the Range
fields.

5. Specify the minimum and maximum values for the Y-axis.

Note: When you use stacked Y-axis, click Apply to apply the changes to a specific
trend item. You can continue setting the ranges for other trend items in the Range
Configuration dialog box.

6. Click OK.

New User View
Menu Selection: Insert > User View
Inserts a user navigation view (also referred to as user view, user-defined navigation tree, and user-
defined tree) item into the All Items navigation tree. In online mode, the user view appears as a
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separate tab in addition to the All Items navigation tree if the user has permission for the user view.
In online and offline modes, the user view appears in the User Views folder under the Site in the All
Items tree.
Assign permissions to user views using the Security Administrator System in the online mode. You
cannot assign permissions to user views in the SCT.

Tip: On the Configure screen, click the Configuration tab for further configuration.

User Views
User views (user-defined navigation trees) contain references to selected items found in the All
Items navigation tree (the default navigation tree). For example, you could create a user navigation
tree with all the AIs grouped together, or a navigation tree that contains only points for a certain
area of a building. User views are useful for restricting access for certain users and grouping
commonly used items/graphics together. You can use the user view edit capabilities to easily
consolidate small user views into a larger view, or to break large user views into multiple smaller
views. Specify the User View navigation display as either a set of tabs (Tabbed) or a drop-down list
(List) in the Default navigation display preference in the Display Settings Tab in the Preferences
section. We recommend list view if the system has many user views, as list view takes up less space
in the navigation tree pane. User views provide a mechanism for viewing Tailored Summaries. See
the Tailored Summary Concepts section for more information.
User views are easy to create. The system supports drag-and-drop functionality of items from the
Global Search Results table to add them as references in a User View. To do this, view both the
Global Search Viewer and the User View in the display frame (using a multiple panel view). Click Edit
in the User View. Then drag the desired items from the Search Results table to the User View. The
system also supports drag-and-drop functionality to add references to items from the navigation
frame (User View [online] or All Items tree) to a User View in Edit mode. In addition, to add an
entire tree (only from the navigation frame) to a User View, press the Ctrl key and drag and drop
the tree to a User View in Edit mode.
For more information on the wizard used to create a user view, see the New User View section. For
more information on the object created by this wizard, see User Navigation Tree.
The Security Administrator System allows administrators to assign user view permissions to specific
users (in the Online UI only). For information on the Security Administrator System, see Related
documentation.

User Views Concepts

User View Behavior by Mode
User views appear and function differently, depending on what mode you are in (Table 261).
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Table 261: User Views in Modes
Mode Location in UI Behavior Notes
Offline (SCT) • User Views folder

in the All Items
navigation tree

• create, edit, and delete user views
• copy and paste user views
• drag and drop the user view into the Display

frame for editing
Online (SMP) • User Views folder

in the All Items
navigation tree

• User View tab
• Security

Administrator
System

• create, edit, and delete user views
• drag and drop the user view into the Display

frame for editing
• click a user view tab to display the user view

as an actual tree in the navigation frame.
In this tree, you can view and navigate to
items.

• assign permissions to the user views
(through Security Administrator System)

Simulation • User Views folder
in the All Items
navigation tree

User View Structure
User views provide graphical, functional, and geographical organizations of your Metasys system.
For example, you might create a user view comprised only of nested references to graphics. Or you
may organize your user view with separate levels for campus, building, floor, room, and so on. You
may even create a separate user view for each user, to provide that user a focused view into the
system or to restrict the user’s access.
Table 262: User View Structure Icons
Button Icon Button Name Description

User view folder A folder created in the user
view.

Reference to a folder A reference in the user view
to a folder from the All Items
view.

The structure, or hierarchy, of a user view is based on the following general rules:
• User view folders may contain any number of additional child folders or other references. For

example, you can add multiple Summary Definition objects for the Tailored Summary feature
to a user view folder.

• You cannot nest anything under a reference to a folder.
• Graphic references may contain any number of additional graphic references.
• With the exception of graphics, references may only be nested under user view folders (that is,

a non-graphic reference cannot be a child of a reference). References do not need to be nested
to exist in the User View.

• Any item may be referenced any number of times within the user view hierarchy.
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Tree View Tab
The Tree View tab appears when you are adding a user view with the New User View or when you
display an existing user view for editing.
Table 263 shows the buttons in the Tree View tab and when to use them. All the functions
represented by buttons in Table 263 are also accessible through the right-click menu. Table 264
describes the functionality available in the Tree View tab.
Table 263: Tree View Tab Buttons/Right-Click Menu
Button Icon Button Name Description

Add Reference(s) Adds one or more items to the user view. When you add a
reference to an item that has children in the navigation tree,
the children are not included in the user view.

Add Tree(s) Adds an entire user view, an entire folder hierarchy, or single
item reference to a user view. When you add an item using
this button, you add the item and all of its children to the
user view.

New Folder Creates a new folder in the user view. Use this button to add
a folder to a user view.

Remove Removes anything you select from the user view. The
Remove button removes not only what you select, but all
children of the item you select.

Move Up Moves a selected user view item up in the user view. This
button changes the order of items in the navigation tree but
does not nest items. See Drag and Drop in the Table 264.

Move Down Moves a selected user view item down in the user view. This
button changes the order of items in the navigation tree but
does not nest items. See Drag and Drop in the Table 264.

Sort Ascending Sorts the items in the user view in ascending, alphanumeric
order. You can sort items at any level in the user view (for
example, the folders directly under the User View or the
contents of a folder). The items are sorted only one level
down (not subsequent levels).

Sort Descending Sorts the items in the user view in descending, alphanumeric
order. You can sort items at any level in the user view (for
example, the folders directly under the User View or the
contents of a folder). The items are sorted only one level
down (not subsequent levels).
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Table 263: Tree View Tab Buttons/Right-Click Menu
Button Icon Button Name Description

Edit Label Changes the label used for an item within a specific user
view. Changing the label for an item in the user view does
not affect the item’s Name attribute or reference, and does
not affect the label used for other occurrences of the item in
the same or other user views.
To change the label for an item, triple-click the item or right-
click the item and select Rename.

Find and Replace Repairs or updates site, Engine, or Metasys server identifiers
in the references of items stored in the user view. The
references are used to identify the items in the view, and
updates from this feature do not affect the items themselves.
You cannot use this feature to find and replace field device
identifiers within references. See Find and Replace.

Table 264: Tree View Tab Functionality
Functionality Description
Ctrl/Shift Keys Selects multiple items in the Select Item dialog box, which is displayed when

you click Add Reference or Add Tree.
Drag and Drop Moves the selected reference or folder, and its nested items, to a new location

within the user view. When you are dragging an item to a collapsed folder,
hover the mouse pointer over the collapsed folder for a moment and it
automatically expands. To change the order in which items appear within a
parent folder or under a graphic, see Move Up and Move Down in Table 263.

Note: You can drag and drop objects from the all items tree or any other user
view into the user view you are editing. When you drag/drop an object with chil-
dren, only the parent object is added to the user view.

Find and Replace
The Find and Replace button appears on the Tree View Tab. You can use the Find and Replace
option after renaming a site/device to update references to the new site/device name. This feature
resolves any references that may have become broken due to the name change. See the following
table for search options.
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Table 265: Search Options
Button Description
Full Reference Updates the first occurrence of the specified text in all references with the

replacement (Replace with) text. Enter the reference text and the new text
and click Find. A list of references is generated. Click Replace All to update
all references, or select a reference and click Replace to update a reference
individually.

Site Name Only Updates the site identifier in all references to the site name where the user
navigation view resides. This value comes from the user navigation view’s full
reference and is not editable in this dialog box. Click Find. A list of references
is generated. Click Replace All to update all references, or select a reference
and click Replace to update a reference individually.

Device Name Only Replaces the Engine or Metasys server device identifier in item references
with a different device identifier. All Device Names is entered by default, but
you can specify a specific device name if desired. Enter the new name and
click Find. A list of references is generated. Click Replace All to update all
references, or select a reference and click Replace to update a reference
individually. The device identifier updates in the references for the selected
item and its children.

You also can use the Find and Replace option in online mode to quickly duplicate user view
hierarchies for supervisory devices with similar configurations.

Note: The Select Item dialog box contains the set of views that appear in your navigation
frame. Because user views do not appear in the navigation frame in the SCT, these steps work
only in online mode.

For example, perhaps you have several NAEs on your site that have the same set of N2 controllers
and field points under their N2 trunks. You can create a user view to group your field devices and
field points for NAE-1 into a logical system-based or geographical hierarchy. You can then duplicate
the NAE-1 user view to create the same references and hierarchy for NAE-2.
Follow these steps:
1. Create a user view referencing NAE-1 items (for example, field devices and/or field points),

organizing the items in folders as desired.
2. Refresh all tabs in the navigation frame to update the navigation views displayed in the UI.
3. Create and edit a new user view for NAE-2, or edit the user view you created for NAE-1.
4. Add items to the new NAE-2 user view.

a. Click Add Trees (see Table 263) to display the Select Item dialog box.
b. In the dialog box, select the tab for the user view you created for NAE-1.
c. Select the items you wish to duplicate (choose the root node to duplicate the entire

navigation view).
d. Click OK. The Select Item dialog box closes, and the selected items and their children

appear in the NAE-2 user view.
5. Use the Find and Replace feature (Device Name Only in the Table 265) to replace the NAE-1

identifier with NAE-2 in the references for the duplicated items.
6. Save your changes when finished.

User Views Steps
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Creating a User View
About this task:  
To create a user view:

1. On the Insert menu, click User View.
2. Follow the wizard instructions. See New User View for information on the wizard. See Table

263 and Table 264 for details on using the Tree View tab.

Editing a User View
About this task:  
Notes:

• The Edit menu or Right-click > Delete functions are not used to delete items from a User View
while the User View Editor is open. Using either function permanently deletes selected items
from the archive.

To edit a user view:

1. Browse to the user view (in either the User Views folder in the All Items navigation tree or by
selecting the user view tab).

2. Double-click the user view. The user view editor appears in the Display frame.
3. Click Edit and work with the user view as follows:

- Use the New Folder button to add a folder.
- Use the Add Reference(s) and Add Tree(s) buttons to add references to items.
- Use drag-and-drop functionality to add references to items from the navigation frame

(User View [online] or All Items tree) to a User View in Edit mode.
- Use drag-and-drop functionality to add references to items in a User View from the

Global Search Results table. View both the Global Search Viewer and the User View in the
display frame (using a multiple panel view). Click Edit in the User View. Then drag the
desired items from the Search Results table to the User View.

- Press the Ctrl key and drag and drop a tree (only from the navigation frame) to a User
View in Edit mode to add an entire tree to the User View. This functionality does not
apply to the Global Search Results table.

- Select one or more items and use the Remove button to remove items.
- Sort the items in the user view using the Sort Ascending and Sort Descending buttons.
- Use the Move Up and Move Down buttons to reorganize the order of the items.
- Use the Edit Label button to rename items.
- Use the Find and Replace button to resolve broken references after changing the

Site Director or to duplicate user view hierarchies for supervisory devices with similar
configurations. For details, see Find and Replace.

For information on the buttons and functionality in the Tree View tab, see the Tree View Tab
section.

4. Click Save when finished.

Deleting a User View
About this task:  
To delete a user view:

1. Select the user view in the User Views folder of the All Items navigation tree.
2. On the Edit menu, select Delete Items.
3. Click Continue in the Delete Items wizard dialog box. The user view disappears.
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Consolidating User Views
About this task:  
You can consolidate multiple small user views into one larger user view.

Note: You must be in online mode to consolidate user views.

To consolidate user views:

1. Create a new user view, or edit an existing user view. This is the user view to which you add
other views to consolidate them.

2. With the user view in Edit mode, select the location (root or existing folder) where you would
like to add the contents of another user view.

3. Click Add Tree. The Add Tree(s) dialog box appears.
4. In the Add Tree(s) dialog box, select the tab for the user view you would like to add.
5. Select the root node of the user view you would like to add.
6. Click OK.

Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation
frame) to a User View in Edit mode to add an entire tree to the User View.

A new folder, which contains the contents of the user view you selected, appears in the user
view you are editing. If you would like to rename the folder or move the children to another
location within the user view, see Table 264.

7. Repeat Step 1 through Step 6 if you would like to consolidate other user views into the user
view you are editing.

8. When you are finished consolidating user views, click Save.
9. Refresh the tabs in the navigation frame and delete any user views you no longer need.
10. Have a Metasys Administrator adjust the navigation permissions for the consolidated user

view (if necessary).

Breaking Up User Views
About this task:  
You can break up a large user view into several smaller views.

Note: You must be in online mode to break up user views.

To break user views:

1. Create a new user view, or edit an existing user view.
2. Click Add Tree. The Add Tree(s) dialog box appears.
3. In the Add Tree(s) dialog box, select the tab for the user view you would like to break into

several smaller views.
4. Select the items from the large user view you would like to add to the new smaller view.
5. Click OK.

Note: You also can press the Ctrl key and drag and drop a tree (only from the navigation
frame) to a User View in Edit mode to add an entire tree to the User View.

The items you selected and their children appear in the new user view. If you would like to
rename the folder or move the children to another location within the user view, see Table
264.

6. Repeat Step 1 through Step 7 if you want to move more content from the large user view to
the new smaller user view.
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7. When you are finished with this new smaller user view, click Save.
8. Repeat Step 1 through Step 7 to create additional smaller user views with content from the

large user view.
9. Refresh the tabs in the navigation frame and review the user views to make sure they contain

the correct items.
Edit the new smaller user views as necessary.
Edit the large user view and remove the items that are now located in the new smaller views,
if desired.

10. Refresh the tabs in the navigation frame.
11. Have a Metasys Administrator adjust the navigation permissions for the consolidated user

view (if necessary).

User Navigation Tree
The user navigation tree object defines the attributes that represent the navigation tree.
For information on the Tree View and the User View feature, see User Views.

User Navigation Tree Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Object Attributes section. See the Object and Feature Tabs section
for information on the attributes that appear on the other tabs of this object (for example, the
Hardware and Options tab appear on point objects).
See Tree View Tab section for details on the buttons of the tab.

Summary Definitions
Tailored Summaries allow you to view, command, and modify large quantities of similar data in
a tabular format. Tailored Summaries are essentially summary views of Metasys system items
where the rows and columns of the summary are tailored to contain information of interest. Similar
data, for example, may be all VAV boxes on a floor of a building, showing current temperatures,
setpoints, flows, and minimum and maximum settings. This feature allows you to quickly analyze
the operation of your facility.
The Summary Definition object is an integral part of the Tailored Summary feature. It allows you
to view and edit the columns and key data values used in a Tailored Summary based user view.
The contents of the user view folders are the rows in the Tailored Summary. The following figure
illustrates the interaction between the User View, Summary Definition object, and the Tailored
Summary.
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Figure 63: User View, Summary Definition, and Tailored Summary Interaction

In this example, a user view named HVAC contains a folder named VAV Boxes - VMA 1400s. In
the VAV Boxes folder are two Summary Definition objects named Monitoring - VMA1400 and
Configuration - VMA1400 Flow. The VAV Boxes folder also has item references to several VAVs in the
system.
In the Tailored Summary, the Monitoring - VMA1400 Summary Definition object is selected, and its
data appears in the view. The referenced VAVs appear as rows in the table. The Label defined in the
Summary Definition object appears as the column heading named Controller for the referenced
VAV items in the Tailored Summary. The columns defined in the Summary Definition object (for
example, Zone Temperature and Supply Temperature) appear as columns in the Tailored Summary
view. The Key Data in the Tailored Summary is defined in the Focus view of the Summary Definition
object.
See Tailored Summary User Interfaces for details on the views described in this example.
You can create and edit Summary Definition objects for the Tailored Summary feature in the SCT
or the online Site Management Portal UI for the Site Director, but you must be in the online Site
Management Portal UI or the Ready Access Portal UI to view the Tailored Summary.
The Tailored Summary feature requires minimal memory for the Summary Definition objects;
however, the objects do increase the object count.
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Tailored Summary Concepts

Tailored Summary User Interfaces

Summary Definition Editor
On a Site Director, the Summary Definition Editor allows you to define and edit a Summary
Definition object. The Summary Definition Editor appears when you view a Summary Definition
object. Summary Definition objects always reside on a Site Director in the Summary Definitions
folder of the All Items tree (that is, you cannot put a Summary Definition object in another location).

Summary Definition Tab
The Summary Definition Editor’s Summary Definition tab allows you to define the table that
appears in the Tailored Summary view.

Figure 64: Summary Definition Editor - Summary Definition Tab
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Table 266: Summary Definition Editor - Summary Definition Tab
Button/Field Description
Label Defines the label to display in the first column (that is, the row

header column) in a Tailored Summary. The label is limited to a
maximum of 50 characters. This field also can be left blank.

Add/Plus Allows you to add a column at the end of the column
configuration table.

Note: You can define up to a maximum of seven columns. This
button is disabled if seven columns already exist.

Remove/Minus Allows you to remove the currently selected column from the
column configuration table.

Note: To select a column, click the column heading. You must
define a minimum of at least one column.
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Table 266: Summary Definition Editor - Summary Definition Tab
Button/Field Description
Column Configuration Table Lets you configure the columns that appear in the Tailored

Summary:

• Column Heading - Defines the name of the column
heading. The name can have a maximum of 50 characters.

• Child Item -
Indicates the item for which the column data is
retrieved based on its item name attribute. You can
use the Select Item dialog box to pick a name, or type
in the text box. The name must match a user-specified
pattern (such as ZN-* or ZN-T, Zone-T). You can define
an unlimited number of wildcards.
Use the asterisk (*) wildcard for partial name
matching (for example, ZN-T* finds items named ZN-T
and ZN-Temp).
Use a comma (,) to separate the wildcard search
criteria (for example, ZN-T, Zone-T finds items named
ZN-T or items named Zone-T).
Use the Backslash (\) wildcard to indicate a character
does not have a special meaning (for example, ZN\*T,
ZN\, T, ZN\\T finds items named ZN*T, ZN, T, and ZN
\T).
The first item found that matches this item name
pattern appears in the Tailored Summary view column.
To display an attribute of the row item, leave this field
blank. Otherwise, specify the name of the child item to
display.

• Attribute - Defines the attribute information for the
column. To display the default attribute, no change is
required (that is, leave the Attribute box set to Default). The
attributes are grouped into categories for easy selection. To
specify an attribute, select a category in the Attribute Filter
section of the Select Column Attribute dialog box, and then
select the desired attribute from the list.

Notes:

• To change the order of the columns, select a column
and drag it to the desired placement.

• When you display a Tailored Summary (see Viewing
a Tailored Summary), the system searches for data
within all levels of a field device (VMA, for example).
For all other objects (NAE, for example), the system
searches for data only one level down (not subsequent
levels).
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Table 266: Summary Definition Editor - Summary Definition Tab
Button/Field Description
Browse (Child Item) Opens the Select Item dialog box where you can specify the item

name.
Note: This dialog box provides an easy way to fill in the item name
of a child item. It does not mean that the selected item displays in
that column.

Browse (Attribute) Opens the Select Column Attribute dialog box where you can
select the attribute to display in the column of the table. This
process is necessary only when selecting an attribute other than
the default attribute.
This dialog box has two list boxes to aid in selection:

• Attribute Filter - Allows you to filter the items appearing
in the Attribute list using common attribute categories.
If you filter on Alarms, for example, the supported alarm
attributes appear in the list for selection.

• Attribute - Lists the available attributes for selection.
Note: To display the default attribute of the row item, leave the
Attribute box set to Default (Attribute Filter: Common Attributes
and Attribute: Default).

For an example of the attributes available for display in the
Tailored Summary feature, see the Tailored Summary Attributes
section.

Focus Tab
The Summary Definition Editor’s Focus tab allows you to define the Key Data that appears outside
the main table in the Tailored Summary view, as well as other common Metasys object attributes.
To define Key Data, click the Browse button of the Key Data attribute on the Focus tab. This action
opens the Modify List dialog box.
The Object Name attribute on the Focus tab provides the name shown in the Summary Definition
folder in the All Items tree.

Figure 65: Modify List Dialog Box
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Table 267: Modify List Dialog Box
Button/Field Description
Key Data List (Listof[x]) Displays the added Key Data items. You can use the Select Item dialog

box to pick the Key Data item, or type in the text box. You also can
use wildcards (asterisks * only), where the system searches for the
matching item in the user view folder. You can define up to four Key
Data items.

Note: The default attribute of the Key Data item appears in the Key Data
table of the Tailored Summary view.

Browse Opens the Select Item dialog box for selection of the Key Data item.
Add Adds an undefined item to the Key Data list.
Remove Removes the currently selected item from the Key Data list.
Move Up Moves the currently selected item up one place in the Key Data list.
Move Down Moves the currently selected item down one place in the Key Data list.
Cancel Closes the dialog box without accepting the changes.
OK Accepts the changes and closes the dialog box.

User View Editor
The Tailored Summary feature relies on the User View feature to provide a mechanism for viewing
Tailored Summaries. See the Workflow section for details.

Note: The Edit menu or Right-click > Delete functions are not used to delete items from a User
View while the User View Editor is open. Using either function permanently deletes selected
items from the archive.

The following figure shows the User View Editor configured with folders holding specific Summary
Definition objects and references.
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Figure 66: User View - Tree View Tab

For more information on User Views, see the Defining User Views with Summary Definitions
section.

Tailored Summary View
The data that appears in the Tailored Summary view is the result of analysis based on the row and
column definition of the Summary Definition object. Access the Tailored Summary view by viewing
the associated user view folder containing the Summary Definition objects and references. The
Tailored Summary view allows you to view, command, or modify the data. The Tailored Summary
view is only available in the online Site Management Portal UI for the Site Director, or in the Ready
Access Portal UI.
The items in the Key Data and Tailored Summary tables use the graphic status colors defined by the
preferences.
Guidelines and tips:

• There is no limit to the number of rows or columns, but performance is resource-dependent
and may be affected by large queries.

• Items must be mapped (for example, appear in the All Items tree) to appear in the Tailored
Summary.

• If the search does not find a match for an item, or the defined attribute does not apply to the
item found, dashes (---) appear in the Tailored Summary.

• Wireless TECs do not appear in a Tailored Summary (that is, this feature cannot use Wireless
TECs as rows in the Tailored Summary).
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• The Tailored Summary feature displays data from engines at Release 2.2 or later.
• IP addresses for devices at releases prior to Release 5.0 appear differently in the Site

Management Portal UI's Tailored Summaries than in the Ready Access Portal UI; this is
expected behavior. At releases prior to Release 5.0, IP addresses for devices appear as the
appropriate value when viewed in the Site Management Portal UI Tailored Summaries. When
you view a Tailored Summary in the Ready Access Portal UI, the value shown for IP addresses
of devices prior to Release 5.0 is: (Complex). IP addresses for devices that are running
Release 5.0 or later display correctly.

The following figure shows a Tailored Summary view with two Summary Definitions and two Key
Data items. Notice the items with alarm conditions appear with the graphic status colors defined in
the System Preferences.

Figure 67: Tailored Summary Tab
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Table 268: Tailored Summary Tab
Field Description
Available Tailored
Summaries List Box

Lists the available Tailored Summaries to view (that is, the list of
Summary Definitions that appear directly within the selected user
view folder).

Key Data Table Displays the default attribute value of the defined Key Data items.
See the Using a Tailored Summary section for the actions you can
take on the Key Data table (such as view, command, and modify).

Tailored Summary Table Displays the attribute value data according to the configuration of
the selected Summary Definition.
The list of user view items appears in the first column (row header
column) with the following exceptions:

• folders and user view folders do not appear
• Summary Definition objects do not appear

The data appears in the other columns.
See the Using a Tailored Summary section for the actions you can
take on the Tailored Summary table (such as view, command/global
command, and modify/global modify).

Create New Summary Definition Wizard
Use the Create New Summary Definition Wizard to create a Summary Definition object from
scratch. Access this wizard using the Summary Definition option on the Insert menu.
Table 269: Create New Summary Definition Wizard
Screen Description
Identifier Allows you to enter a name for the Summary Definition object.
Configure Allows you to define the data of the Summary Definition and

Configuration tabs.
Note: The Configuration tab in this wizard contains the same data as the
Focus tab of the Summary Definition Editor.

See the Editing an Existing Summary Definition and Defining Key Data
sections for details on how to edit these items.

Summary Displays the summary data of the Summary Definition object.

Workflow
About this task:  
The following diagram shows a high-level workflow for creating and using Tailored Summaries. See
the steps following the diagram for more detailed workflow information.
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Figure 68: Tailored Summary Workflow

The workflow to create and use Tailored Summaries is as follows:

1. Import the pre-built Summary Definitions. See Importing a Summary Definition for
procedural details and the location to access the pre-built Summary Definitions. After you
import the Summary Definitions, they appear in the Summary Definitions folder in the All
Items tree.
OR
Use the Summary Definition wizard to create a new Summary Definition (Creating a New
Summary Definition).
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Note: As best practice, edit a pre-built Summary Definition that is similar to what you
need. You may want to use the same Summary Definition as the basis for slightly
different groups of items (for example, a VAV with two AHUs having different key data).
Copy the existing Summary Definition to create the new Summary Definitions. See the
Reusing an Existing Summary Definition for Different Key Data section.

2. Edit the Summary Definitions and define key data, if required (Editing an Existing Summary
Definition):
a. Double-click a Summary Definition in the Summary Definitions folder of the All Items

tree.
b. On Summary Definition tab, click Edit. Make the necessary changes and click Save.
c. On the Focus tab, click Edit. Make the necessary changes (for example, define the Key

Data following the instructions in Defining Key Data), and click Save.
3. Create a user view or edit an existing one (Defining User Views with Summary Definitions):

a. Drag the Summary Definitions from the Summary Definitions folder in the All Items
tree to a folder in the user view. You can also use the add reference option in the user
view editor.

b. Drag the Site Director object and items to reference (for example, supervisory devices
or points) from the All Items tree or from the global search results table to the folder
in the user view (or use the user view editor’s add reference option). The referenced
items appear as rows in the Tailored Summary.

4. View the Tailored Summary (Viewing a Tailored Summary and Using a Tailored Summary):
a. Click the user view tab in the navigation pane or refresh if already selected.
b. Double-click the folder that contains the Summary Definitions and devices.
c. If more than one Summary Definition appears in the list, click the Tailored Summary

you want to view in the Available Tailored Summaries list box.
d. View the key data and the table data. Use the right-click menu options to command,

modify, or otherwise work with the data.

Summary Definitions Library
You can access a set of pre-built Summary Definitions through the Johnson Controls License Portal.
You can download the Summary Definitions when you download the SCT software, or as a separate
download. To download the Summary Definitions to your computer, log on to the License Portal,
click the Download icon for the System Configuration tool, select the SCT Summary Definitions
check box, and then click Download. To use the pre-built Summary Definitions, import the pre-built
Summary Definition files into your site. For details, see Importing a Summary Definition.
We designed the pre-built Summary Definitions to meet the needs of the users based on common
tasks and functions. The Summary Definitions fit into the following main categories: Configuration,
Diagnostics, and Monitoring (HVAC). The Site Administrators are the intended audience for the
Device and Network Diagnostics definitions. Service Professionals will find the links to graphics and
Key Point definitions in the Mechanical Equipment definitions especially useful.
The following table lists and describes the pre-built definitions, including the definition name,
default columns (in English only), and overview description indicating typical rows, key data, and
other useful information. Click an attribute under Default Columns to view its description.
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - Analog
Alarms Main

Displays analog alarm configuration data.
The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Trends

• Present Value
• Alarm Priority
• Differential
• Low Alarm Limit
• High Alarm Limit
• Alarm Ack Required
• Normal Ack Required

Config - Analog
Alarms Refs

Displays the Setpoint and Occupancy References
in the alarm extension. These points are used
to configure the behavior of a Room Control
Module symbol.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

• Present Value
• Unoccupied State
• Occupancy Reference
• Cooling Setpoint

Reference
• Heating Setpoint

Reference
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - Analog
Alarms Warning

Displays the warning alarm configuration data.
The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Trends

• Present Value
• Warning Priority
• Low Warning Offset
• High Warning Offset
• Warning Reference
• Warning Ack

Required
• Report Delay

Config - Analog
Points

Displays the key attributes of an analog point
that may require modifying using the Global
Modify feature or commanding using a Global
Command (see Modify Dialog). The typical rows
are any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on).
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends
• Config - BACnet Point Info

• Present Value
• Device Type
• Min Value
• Max Value
• COV Increment
• Out of Service
• Relinquish Default
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - BACnet
Controller Info

Displays the key network configuration
attributes of any FEC controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - FEC Controllers
• Diag - FEC Controllers

• BACnet Object Name
• Model Name
• Description
• Object Identifier
• Instance Number

Config - BACnet
Engine Info

Displays the key BACnet configuration attributes
of any NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - Engine Summary
• Config - Engine Network Info
• Diag - Engines

• BACnet Object Name
• Model Name
• Network Address
• BACnet IP Port
• Object Identifier

Config - BACnet
Point Info

Displays the key BACnet configuration attributes
of any points on an FEC controller.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

• Present Value
• BACnet Object Name
• Object Identifier
• Intrinsic Alarm

Defining

Config - Binary
Output Points

Displays binary output configuration data.
The typical rows are any key output points (for
example, fans or pump commands).
You can modify the attributes from the Tailored
Summary view using the Global Modify feature.
See the Modify Dialog section.
This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - BACnet Point Information

• Present Value
• Min On Time
• Min Off Time
• Heavy Equip Delay
• Out of Service
• Relinquish Default
• Device Type
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - Engines
Network Info

Displays the key network configuration
attributes of any NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - Engine Summary
• Config - BACnet Engine Info
• Diag - Engines

• Model Name
• Status
• Version
• JCI IP Address
• IP Mask
• Ethernet MAC

Address
• DHCP Enabled

Config - Engine
Summary

Displays the key configuration attributes of any
NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - Engine Network Info
• Config - BACnet Engine Info
• Diag - Engines

• Description
• Model
• Status
• ADS Repository
• Last Archive
• Local Time
• Local Date

Config - FEC
Controllers

Displays the key network configuration
attributes of any FEC controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - BACnet Controller Info
• Diag - FEC Controllers

• Model
• Status
• Description
• Version
• Address
• Trunk Number
• Auto Alarm

Config - LON
Controllers

Displays the key network configuration
attributes of any LonWorks controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

• Status
• Description
• Neuron ID
• Program ID
• DSN 1
• XIF Present
• Message Entry Count
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - LON Points Displays the key configuration attributes of any
points in a LonWorks based controller.

• Present Value
• Interface Value
• Field Units
• Manual Control
• Update Interval
• Target Reference
• Priority

Config - Multistate
Value Alarms

Displays multistate alarm configuration
data. The typical rows are any key multistate
points (for example, modes of operation, fan
status, and so on) that have alarm, trend, and
averaging extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Config - Trends

• Present Value
• Normal State
• Alarm Priority
• Capture Changes
• Report Delay
• Report Delay Active
• Alarm Message Text

Config - N2
Controllers

Displays the key network configuration
attributes of any N2 controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

• Status
• Description
• Controller Type
• Trunk Number
• Auto Alarm
• Item Reference
• Version

Config - NCM Info Displays the key configuration attributes of any
NCM. The NCMs are integrated with an NIE.

• Name
• Status
• Gate Number
• Network Name
• Node Number
• Object Count
• Poll Delay
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Config - Schedules Displays the key configuration information and
current status about the listed schedule objects.
You can use the Global Command feature
to enable or disable all the schedules in the
Tailored Summary view.
You also can use this Summary Definition for
features other than schedules.

• Description
• Present Value
• Enabled
• Item Reference
• Authorization

Category
Config - TEC
Controllers

Displays the key network configuration
attributes of any TEC controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - BACnet Controller Info

• Model
• Status
• Version
• Auto Alarm

Config - Trends Displays the trend extension configuration
data. The typical rows are any key analog points
(for example, Energy Essentials meter points,
key zone or discharge air temperatures, key
static pressures, and so on) that have trend and
averaging extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Monitoring - Analog Points
• Config - Analog Points
• Config - Analog Alarms Main

• Present Value
• Description
• Buffer State
• Enable
• Repository Enabled
• Sample Interval
• Transfer Setpoint
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Diag - Engines Displays the key diagnostic attributes of any
NxEs.
This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - Engine Summary
• Config - BACnet Engine Info
• Config - Engine Network Info

• CPU Usage
• Battery Condition
• % Flash Utilized
• Estimated Flash

Available
• % Memory Utilized
• Object Count
• Board Temperature

Diag - FEC
Controllers

Displays the key diagnostic attributes of any FEC
controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Config - FEC Controllers
• Config - BACnet Controller Info

• Model
• Status
• Memory Usage
• CPU Usage
• Object Count
• Object Memory

Usage
• Flash Usage

Diag - LON Trunks Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.

Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information.

• Lost Messages
• Missed Messages
• Transmit Errors
• Transmits Per Minute
• Transaction Timeouts

Diag - MSTP Trunks Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.

Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information.

• Bus Health Index
• Bus Performance

Index
• Data CRC Errors
• Framing Errors
• Token Loop Time
• Lost Token
• Buffer Overflows
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Diag - N2 Trunks Displays the key diagnostic attributes of this
communication trunk’s Diagnostic tab.

Note: You can use the Global Command feature
to send Clear Statistics and Latch Statistics from
the Tailored Summary view to capture the most
current diagnostic information.

• Command Count
• Message Timeouts
• Acknowledgement

Errors (NAK Errors)
• Offline Occurrences
• Poll Scan Time
• Retries
• Transmits Per Minute

Diag - VAV Box Error
Analysis

Displays the occupied zone temperature status
(ZNT-State) value along with the absolute error
values from all of the possible output controllers
(for example, CLG-ABSERROR, HTG-ABSERROR,
or SAFLOW-ABSERROR). Allows you to easily
compare EWMA to identify devices with poor
relative performance.
The rows for this Summary Definition are the
VAV controllers associated with an air handling
system. The absolute error columns indicate all
the possible values available. We recommend
you remove columns not needed for your
specific application.

Note: Depending on the module instance used
by your application, the attributes used for each
column may differ. Refer to the Output Controller
chapter of the Controller Tool Help (LIT-12011147)
for details.

When using this Summary Definition, first
observe the value in the Current State column.
Then refer to the other columns as appropriate.
For example, if the Current State column
indicates that cooling is taking place, refer to the
cooling error columns for more details on the
cooling process.
This Summary Definition is typically packaged
in a user view with the following Summary
Definitions:

• Monitoring - VMA1600 Overview
• Monitoring - VMA1600 Flow
• Diagnostic - VAV Box Effort Analysis
• Configuration - FEC Controllers

• Description
• Current State (ZNT-

State)
• Zone Temp Prmy Clg

Error
• Zone Temp Box Htg

Error
• Box Htg Output Error
• Supp Htg Output

Error
• Supply Flow Error
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Diag - VAV Box
Effort Analysis

Displays the occupied zone temperature status
(ZNT-State) value along with the absolute effort
values from all of the possible output controllers
(for example, CLG-ABSEFFORT, HTG-ABSEFFORT,
or SAFLOW-ABSEFFORT). Allows you to easily
compare EWMAs to identify devices with poor
relative performance.
The rows for this Summary Definition are the
VAV controllers associated with an air handling
system. The absolute error columns indicate all
possible values available. We recommend you
remove columns not needed for your specific
application. Keep in mind that only one absolute
error column is active at any point in time based
on the present value of ZNT-State.

Note: Depending on the module instance used
by your application, the attributes used for each
column may differ. Refer to the Output Controller
chapter of the Controller Tool Help (LIT-12011147)
for details.

This Summary Definition is typically packaged
in a user view with the following Summary
Definitions:

• Monitoring - VMA 1600 Overview
• Monitoring - VMA1600 Flow
• Diag - VAV Box Error Analysis
• Config - FEC Controllers

• Description
• Current State (ZNT-

State)
• Zone Temp Prmy Clg

Effort
• Zone Temp Box Htg

Effort
• Box Htg Output

Effort
• Supp Htg Output

Effort
• Supply Flow Effort

Monitoring - AHUs Displays the key point information based on
standard naming conventions for a Mixed Air
Single Duct systems. The rows for this Summary
Definition are FEC or TEC Series controllers.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated central plant
systems or weather data is typically added to
unique instances of this Summary Definition.

• Supply Fan Status
• Return Fan Status
• Mixed Air Temp
• Zone Temp
• Discharge Temp
• Cooling Command
• Heating Output
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Monitoring - Alarm
History

Displays the current key status information
of analog points along with the date and
time that the last alarm and return to normal
transitions occurred. The typical rows for this
Summary Definition include any key analog
points (for example, key zone or discharge
air temperatures, key static pressures, and
so on) that have alarm, trend, and averaging
extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Analog Points
• Config - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

• Present Values
• Alarm Ack Pending
• Alarm Ack Required
• Late Alarm Date
• Back to Normal Date
• Last Alarm Time
• Back to Normal Time
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Monitoring - Analog
Points

Displays the minimum/maximum/average
values from the averaging extension and the
key description attributes for the item’s Focus
tab. The typical rows for this Summary Definition
include any key analog points (for example, key
zone or discharge air temperatures, key static
pressures, and so on) that have alarm, trend,
and averaging extensions.

Note: The Name attribute of alarm, trend, or
averaging extensions must be unique across all
extensions on the item (that is, the alarm and
trend item extensions cannot both have a Name
attribute of Present Value). You can modify the
Name attributes from the Tailored Summary
view using the Global Modify feature. See the
Modify Dialog section.

This Summary Definition is typically used
in a user view with the following Summary
Definitions:

• Monitoring - Alarm History
• Config - Analog Points
• Config - Analog Alarms Main
• Config - Analog Alarms Warning
• Config - Trends

• Present Value
• Averaging Value
• Min Value
• Max Value
• Reliability
• Item Reference

Monitoring -
VMA1400 Flow

Displays the key flow setup and monitoring
information for a typical single duct, pressure-
independent VAV Box application. The rows for
this Summary Definition are VMA14 controllers
that are associated with an air handling system.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - VMA 1400 Overview

• Box Area
• Pickup Gain
• Flow
• Cooling Max Flow

Setpoint
• Cooling Min Flow

Setpoint
• Heating Flow

Setpoint
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Monitoring -
VMA1600 Flow

Displays the key flow setup and monitoring
information for a typical single duct, pressure-
independent VAV Box application. The rows for
this Summary Definition are VMA16 controllers
that are associated with an air handling system.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - VMA 1600 Overview

• Box Area
• Pickup Gain
• Flow
• Cooling Max Flow

Setpoint
• Cooling Min Flow

Setpoint
• Heating Flow

Setpoint
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Table 270: Pre-Built Tailored Summary Library
Summary
Definition Name

Description Default Columns

Monitoring -
VMA1400 Overview

Displays the key point information for a
typical single duct, pressure-independent VAV
Box application. The rows for this Summary
Definition are VMA14 controllers that are
associated with an air handling system.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - VMA 1400 Flow

• Zone Temperature
• Supply Temperature
• Setpoint
• Flow
• Flow Setpoint

Monitoring -
VMA1600 Overview

Displays the key point information for a
typical single duct, pressure-independent VAV
Box application. The rows for this Summary
Definition are VMA16 controllers that are
associated with an air handling system.

Note: You can use the Global Modify feature
to add an associated graphic to all the device
objects. See the Modify Dialog section.

Key data from the associated air handling
system is typically added to unique instances of
this Summary Definition.
This Summary Definition is typically used
in a user view with the following Summary
Definition:

• Config - VMA 1600 Flow

• Zone Temperature
• Supply Temperature
• Setpoint
• Flow
• Flow Setpoint
• Damper Output
• Heating Output

Tailored Summary Attributes
The Select Column Attribute dialog box allows you to select the attributes to display in the Tailored
Summary columns. See the Editing an Existing Summary Definition section for details on accessing
and using this dialog box.
You can filter the available attributes by category using the Attribute Filter list box. The attributes
of that category appear in the Attribute list box. If you filter on Alarms, for example, the alarm
attributes appear in the list for selection.
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Figure 69: Select Column Attribute Dialog Box

The following table lists examples of the attributes available for display in the Tailored Summary
feature according to the attribute filter.

Note: Click an attribute in the table to view its description. For information on other attributes
that do not appear in this table, search for the attribute using the Help system's Search
function, or search within the PDF of the Help system.

Table 271: Example Tailored Summary Attributes
Attribute Filter Example Attributes
Alarms • Alarm Message Text

• Alarm Priority
• High Alarm Limit
• Low Alarm Limit

Averaging and Totalization • Average Value
• Minimum Value
• Maximum Value
• Totalize Limit

BACnet • BACnet IP Port
• Instance Number
• Intrinsic Alarming Defined
• Object Name
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Table 271: Example Tailored Summary Attributes
Attribute Filter Example Attributes
Common Attributes • Alarm State

• Authorization Category
• Present Value
• Status

Field Devices (General) • Disable Automatic Alarming
• Offline

Field Devices (LON) • DSN1
• Neuron ID
• Program ID
• XIF Present

Field Devices (MSTP) • Memory Usage
• Object Count
• Trunk Number

Field Devices (N1) • Device Status
• NCM Name
• Object Count
• Poll Delay

Field Devices (N2) • Controller Type
• Trunk Number

Field Points (General) • Device Type
• Max Value
• M in Value
• Out of Service

Field Points (LON) • Command Status Mapping Table
• Interface Value
• Target Reference
• Update Interval

Field Points (N1) • Feedback
• Setpoint
• Value: Present Value

Integrations (MSTP) • APDU Retries
• Buffer Overflows
• Bus Health Index
• Bus Performance Index

SCT: System Configuration Tool Help502



Table 271: Example Tailored Summary Attributes
Attribute Filter Example Attributes
Integrations (LON) • Missed Message

• Transmit Error
• Transaction Timeout
• Transmits Per Minute

Integrations (N2) • Command Count
• Message Timeout
• NAK Errors
• Transmits Per Minute

Supervisory Devices • ADS or ODS Repository
• IP Address
• Model Name
• Object Count

Trends • Buffer State
• Enable
• Sample Interval
• Transfer Setpoint

Tailored Summary Steps

Importing a Summary Definition
1. In the All Items tree, right-click the Summary Definitions folder and then click Import

Definition.
2. Browse to the location on the computer where the Summary Definitions are stored.

Note: You can download a set of pre-built Summary Definitions from the Johnson
Controls License Portal and save these files to your computer. You also can import
previously exported Summary Definitions. See the Exporting a Summary Definition
section.

3. Select one or more Summary Definitions to import.
4. Click Import. The Notice dialog box appears, indicating the results of the import after all

imports complete.
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Figure 70: Notice Dialog Box

5. Click OK. The imported Summary Definitions appear in the Summary Definitions folder in the
All Items tree.

Exporting a Summary Definition
1. In the Summary Definitions folder of the All Items tree, right-click the Summary Definition

and select Export Definition. The Export dialog box appears.
2. Browse to the location on the computer to store the Summary Definition.
3. Click Export. The Notice dialog box appears, indicating the results of the export.

Figure 71: Notice Dialog Box

4. Click OK.

Result  

Note: You can now share the Summary Definition with others and import it to other sites as
desired. If you import the Summary Definition to another site, you may need to update the key
data references.

Editing an Existing Summary Definition
About this task:  

Note:
• You can perform this task in SCT or the online Site Management Portal UI for the Site

Director.
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• See the Summary Definition Editor section for information on the editor and attributes
appearing on the Summary Definition.

1. In the Summary Definitions folder of the All Items tree, double-click the Summary Definition.
The Summary Definition appears in the display panel.

2. On the Summary Definition tab, click Edit.
3. In the Label text box, enter the text to display as the label for the row header column (that

is, the first column that contains the user view items). Leave the label blank for an empty
heading.

4. Add, remove, and rearrange columns in the table:

- Click the Add/Plus icon to add a column at the end of the column configuration table.
- Select a column by clicking the column header and click the Remove/Minus icon to

remove it from the table.
- To change the order of the columns, select a column and drag it to the desired

placement.

Note: You can define up to a maximum of seven columns. The Add button is disabled if
seven columns already exist. You must define a minimum of at least one column.

5. In the Column Heading text box, enter the text to display as the label for the column header
(maximum of 50 characters).

6. In the Child Item text box, leave this field blank to display an attribute of the row item, or add
a child item name using any of the following methods:

- Enter the name of the child item to display.
- Select an item in the All Items tree, user view, or other view (for example, global search

results table) and drag it to the Child Item text box. This functionality is not available in
the Create New Summary Definition wizard.

- Click the browse button. The Select Item dialog box appears. Select an item name and
click OK.

Notes:
- The child item is just an item name, not a Fully Qualified Reference (FQR).
- You can define an unlimited number of item names in a comma-delimited list.
- You can define an unlimited amount of wildcards. The first item found that matches

this item name pattern is displayed in the Tailored Summary view column. See
the table footnote in the Summary Definition Tab section for more information on
wildcards.

- - Prior to Release 5.0, the Name attribute of extensions was typically labeled
Present Value. When you create an extension at Release 5.0 and later, the
Name attribute automatically includes the extension type in the label (for
example, Alarm - JCI System Status or Trend - Memory Usage).
If you select the Name attribute of an alarm or trend extension created at
a previous release for the attribute, we recommend renaming the Name
attribute to indicate the type of extension so that it is apparent in the Tailored
Summary view (for example, Present Value versus Alarm - Present Value or
Trend - Present Value). Perform a global search and global modification to add
Alarm or Trend to the name; then define the Tailored Summary Child Item as
*Alarm* or *Trend* (see Global Search and Modify Dialog).
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Another option is to add *Present Value* as a filter to the Child Items in the
summary definition. This option makes the existing trend extension names
compatible if the default name of Present Value was used. This option is
a quick modification to the summary definition only so the existing trend
extensions do not require modification.

7. In the Attribute text box, select the attribute to display as follows (only when selecting an
attribute other than the default attribute):
a. Click the browse button. The Select Column Attribute dialog box appears.
b. In the Attribute Filter list box, select a filter category. The attributes of that type appear

in the Attribute list box. If you filter on Alarm, for example, the alarm attributes appear
in the list for selection.

c. In the Attribute list box, select an attribute.
d. Click OK.

Notes:
- To display the default attribute of the row item, leave the Attribute box set to

Default (Attribute Filter: Common Attributes and Attribute: Default).
- See the Tailored Summary Attributes section for more information on this dialog

box and examples.

8. Click Save.
9. On the Focus tab, click Edit.
10. Make the necessary attribute changes (for example, define the Key Data following the

instructions in Defining Key Data).
11. Click Save.

Defining Key Data
About this task:  
Notes:

• You can perform this task in SCT or the online Site Management Portal UI for the Site Director.
• See the Focus Tab section for information on the Key Data attribute of the Summary Definition.

1. In the Summary Definitions folder of the All Items tree, right-click the Summary Definition
and click View. The Summary Definition appears in the display panel.

2. On the Focus tab, click Edit.
3. In the Key Data list box, click the browse button. The Modify List dialog box appears.
4. Add Key Data as follows:

a. Click Add. An undefined item appears in the list.
b. Click the Browse button of the item. The Select Item dialog box appears.
c. Select an item.
d. Click OK.

Notes:

- You also can type in the text box and use wildcards (asterisks * only) to search
for the item within the user view folder.

- You can define up to four Key Data items.
5. Select an item and click Remove to delete the item from the Key Data list.
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6. Select an item and click Move Up or Move Down to rearrange the order the items appear in
the list.

7. Click OK.
8. Click Save.

Creating a New Summary Definition
About this task:  

Note: You can perform this task in SCT or the online Site Management Portal UI for the Site
Director.

1. On the Insert menu, select Summary Definition. The Create New Summary Definition wizard
appears.

2. On the Identifier screen, enter a name for the Summary Definition.
3. Click Next.
4. On the Configure screen, define the data of the Summary Definition and Configuration tabs.

See the Editing an Existing Summary Definition and Defining Key Data sections for details on
how to edit these items.

5. Click Next.
6. On the Summary screen, click Finish. The new Summary Definition appears in the Summary

Definitions folder of the All Items tree.

Defining User Views with Summary Definitions
1. Create a user view or edit an existing one (for example, an HVAC user view).
2. Add a folder to the user view to hold the Summary Definitions. For example, add a Summary

Definitions folder, or a folder named according to function (such as VAV Boxes - VMA1400s,
Key Point Information, Engines, or MSTP Trunk Diagnostics).

3. Drag the definitions from the Summary Definitions folder in the All Items tree to the folder
you created in the user view (or use the user view editor’s add reference option).

4. Drag the items to reference (for example, supervisory devices or points) from the All Items
tree or from the global search results table to the folder in the user view (or use the user view
editor’s add reference option).

5. Save the user view.

Viewing a Tailored Summary
About this task:  

Note: You can perform this task in the online Site Management Portal UI for the Site Director.

1. Click the desired user view tab in the navigation pane.
2. Double-click the user view folder containing the Summary Definitions and referenced items

(for example, the Summary Definitions folder). The Tailored Summary appears in the display
panel. See the Viewing a Tailored Summary section for a description of the Tailored Summary
View user interface.

Note: If the user view does not contain a Summary Definition, only the standard
Summary appears.

3. Click the Tailored Summary you want to view from the Available Tailored Summaries list
box if more than one Summary Definition appears in the list. By default, the first authorized
Summary Definition in the list is automatically selected.

4. View the key data and the table data.
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5. Use the right-click menu options to command, modify, or otherwise work with the data. See
Using a Tailored Summary.

Using a Tailored Summary
About this task:  

Note: You can perform this task in the online Site Management Portal UI for the Site Director.

1. View the Tailored Summary as described in the Viewing a Tailored Summary section.
2. Work with the Tailored Summary table and Key Data table as outlined in the following

table:
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Table 272: Working with Tailored Summaries
Type of Table Available Operations

To issue commands, select one or more items (that is, select
the table cells), then right-click and select Command. To
command all items in a column, right-click the column header
and select Command. For example, use this process to send
an operator override command to multiple items.
To make modifications, select one or more items, then right-
click and select Modify. To modify all items in a column, right-
click the column header and select Modify. See the Modify
Dialog section for details. For example, use this process to
change the Authorization Category for multiple items.
To view an item, select an item and right-click and select View.
The item appears in the display panel.
To resize a column, place the cursor between the column
headers so that the cursor is a double-sided arrow. Click and
drag the column to the desired width.
To sort the column data alphanumerically, click a column
header. Click the column header again to sort in the reverse
order.
To rearrange the order of the columns while viewing the
Tailored Summary, select a column header and use drag-and-
drop to move it to the desired location.
To keep a snapshot of the Tailored Summary’s data for later
comparison, select and copy the table data. Then paste it
into a program such as Microsoft Excel®. Use the keyboard
shortcuts Ctrl+A, Ctrl+C, and Ctrl+V.

Tailored Summary table

To view a graphic associated with field controller, double-click
the graphic icon that appears in the second column of the
table (by default). The graphic appears in the display panel.
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Table 272: Working with Tailored Summaries
Type of Table Available Operations

To link a graphic to multiple field controllers, select the field
controllers, then right-click and select Modify. The Global
Modify dialog box appears. Edit the Graphic and Graphic Alias
attributes as desired and click Send. This procedure applies
only to field controllers. See Performing a Global Modify in the
Modify Dialog section for details.

Figure 72: Viewing a Graphic from a Tailored Summary

To issue a command, select one item and right-click and select
Command.
To make modifications to an item, select one item and right-
click and select Modify. See the Modify Dialog section for
details.
To view an item, select one item and right-click and select
View. The item appears in the display panel.
To resize a column, place the cursor between the column
headers so that the cursor has double-sided arrows (  ).
Click and drag the column to the desired width.
To rearrange the order of the columns, select a column
header and use drag-and-drop functionality to move it to the
desired location.
To view a graphic associated with a field controller, double-
click the graphic icon that appears in the first column of the
table (by default). The graphic appears in the display panel.

Key Data table

To link a graphic to a field controller, select the field controller,
then right-click and select Modify. The Modify dialog box
appears. Edit the Graphic and Graphic Alias attributes as
desired and click Send. This procedure applies only to field
controllers. See the Modify Dialog section for details.

Note: You cannot perform global commands/modifications or
sort the data in the Key Data table.
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Retaining Summary Definitions when Changing the Site Director
1. Export the Summary Definitions. See Exporting a Summary Definition.
2. Promote or demote the Site Director.
3. Import the Summary Definitions. See Importing a Summary Definition.
4. Add the Summary Definitions to the user view folder. See Defining User Views with Summary

Definitions.
5. Fix the references in the Key Data, if needed. See Defining Key Data.

Reusing an Existing Summary Definition for Different Key Data
About this task:  
Use this procedure if the key data is the only thing that is different between two different views (for
example, establishing the key data for individual Air Handlers with their associated VAV boxes).

1. Export an existing Summary Definition. See the Exporting a Summary Definition section.
2. Rename the Summary Definition.
3. Import the renamed Summary Definition. See the Importing a Summary Definition section.
4. Make the necessary Object Name and Key Data changes. See the Defining Key Data section.
5. Add the Summary Definition to the desired user view. See the Defining User Views with

Summary Definitions section.

Tailored Summary Troubleshooting

Table 273: Tailored Summary Troubleshooting
Problem Solution
In the Tailored Summary view,
the child item does not display
data from an object after editing
its Object Name attribute.

If you change the Object Name attribute of an object after
configuring the Summary Definition object, the link to the Child
Item breaks. Change the Child Item wildcards in the Summary
Definition object to match the new Object Name attribute.

With a Release 5.0 NAE45 Site
Director, points in a Tailored
Summary display slowly and may
time out.

This issue was resolved in Release 5.1. If this delay is
problematic, we recommend you upgrade to Release 5.1 or
later.

When running a Tailored
Summary, user views with large
point counts display red Xs.

On a summary view with more than 500 objects from a single
NxE, you may occasionally see red Xs if the device is busy. As
the view continues to update data, the red Xs disappear.

SCT Summary Definition
The SCT Summary Definition object is an integral part of the Tailored Summary Viewer feature. This
object allows you to view and edit the columns and key data values used in the Tailored Summary
Viewer. In SCT, the SCT Summary Definitions used in the Tailored Summary Viewers are summary
views of Metasys system items where the rows and columns of the summary are tailored to contain
information of interest.

Summary Definition Wizard
Menu Selection: Insert > Summary Definition
Inserts a Summary Definition into the system. The Summary Definition object is used by the
Tailored Summary feature.
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SCT Summary Definition Attributes
This object contains attributes common to many Metasys system objects. These common attributes
are described in the Common Attributes section. For information on the Tailored Summary Viewer
feature, see Tailored Summary Viewer.
Click the attribute name in the table for a description of the attribute.

Note: In the notes column, attributes marked with the letter C are configurable, attributes
marked with the letter N do not require a value, and attributes marked with the letter W are
writable.

Table 274: SCT Summary Definition Object Attributes - Focus/Configuration Tab
Attribute Name Data Type Notes Initial Value Values/Options/

Range
Name Text CW Maximum Length

of 400 characters
Description Text CN Maximum Length

of 40 characters
prior to Release
8.0 and 64
characters at
Release 8.0 and
later.

Authorization
Category

One type from a
set

C General HVAC, Fire,
Security, Services,
Administrative,
General Lighting,
Refrigeration,
Critical
Environment, Air
Quality, Power,
Energy, System
Custom 1-150

Table 275: SCT Summary Definition - Summary Definition Tab
Attribute Name Data Type Notes Initial Value Values/Options/

Range
Column Heading List of Structures C Column Heading,

Child Item,
Attribute

Row Headings
Column Text

Text CN Label
Maximum Length
of 50 characters

SCT Summary Definition Attribute Details
Column Definition defines the columns displayed in the Tailored Summary Viewer in the SCT.
You can define up to seven columns (list of structures). Each structure contains the following
information:

• Column Heading - Defines the name of the column header.
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• Child Item - Indicates item for which the column data is retrieved based on its name attribute,
which must match a user-specified pattern (such as ZN-* or ZN-T, or Zone-T). To display an
attribute of the row item, leave this field blank. Otherwise, specify the name of the child item
to display.

• Attribute - Defines the attribute information for the column. The attributes are grouped into
categories for easy selection. Select a category in the Attribute Filter section of the Select
Column Attribute dialog, and then select the desired attribute from the list.

Select Column Attribute: User Definable Attribute IDs
The Select Column Attribute window offers a drop-down list of all applicable User Definable
Attributes to assist in configuring the Attribute columns of SCT Summary Definitions. To quickly
search user definable attributes, in the Select Column Attribute window, begin typing the attribute
name you want to add to your Summary definition.

Figure 73: Select Column Attribute Window

Child Item Field Syntax for Summary Definitions
In the Child Item Field of a Summary Definition, the standard query searches against the itemName
attribute of the object. Now you have the option to enter a different attribute to search against by
using the format: ::attribute:query.
For example, searching for a child item with *Trend*  returns the same result as searching with
::itemName:*Trend*. You can now also search specific trend class IDs such as ::classid:155, which
returns the first trend regardless of the naming structure.
You can also search for a count of results instead of the standard selected attribute query results.
For example, ::classid:155 finds the first trend, but you could also select the attribute of Name
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from the list to display the trend name. This search can also be performed manually by entering
a specific attribute ID to any defined attribute of the trend. Entering an attribute ID of Count
Of generates a count of results list that matches your query. This process can be a little time
consuming and is not intended to give an object count on the site or NxEs within the site.
For more information on the Summary Definition tab see, Table 43 and the Tailored Summary
Viewer User Interfaces in SCT section.
Table 276: Valid Child Item Attribute Search Options
Attribute
These attributes are not the Metasys attribute
you are displaying in the SCT Summary
Definition. They are the data that is being
queried to find the matching child item.

Query

type The object type: folder, device, extension,
integration, object, point

reference The object's fully qualified reference
label The last part of the object's fully qualified

reference
itemName The object's user-defined name
classid The classID of the object

Tools Menu

User Profile
Menu Selection: Tools > User Profile
Launches the current user’s properties for managing the user’s language, default navigation view,
and other profile settings.

Change Password
Menu Selection: Tools > Change Password
Changes the current user’s password. The password you select must meet the requirements
for complex passwords. For details, refer to the Network and IT Guidance Technical Bulletin
(LIT-12011279).

Note: For Active Directory users, the Change Password menu remains disabled.

Administrator
Menu Selection: Tools > Administrator
Launches the Security Administrator System. This menu item is only available for users in the
ADMINISTRATOR role. Within the Security Administrator System, Administrators manage user
accounts by creating roles/profiles; setting user passwords; assigning category-based, system-
level, and navigation view permissions/access; and performing other duties. The same set of
administrative management is available in Metasys UI Online, which is now preferred over the
Security Administrator System in SMP.
For more information on the Security Administrator System in SMP, refer to the Security
Administrator System Technical Bulletin (LIT-1201528). For more information on the Security
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Administrator System in Metasys UI Online, refer to the Settings, Security, and Authorization for
Metasys UI section in Metasys UI Help (LIT-12011953).

Configure Preferences
Menu Selection: Tools > Configure Preferences
Launches the Metasys Preferences dialog box.
The Metasys system provides customized preferences for the user interface. The preferences allow
you to configure how the user interface behaves, including the sounds and colors, the startup
view, and the ability to add links to external applications that can be accessed from within the user
interface.

Preferences
The Metasys system provides customized preferences for the user interface. The preferences allow
you to configure how the user interface behaves, including its sounds and colors, startup views,
alarm priorities, and the ability to add links to external applications that can be accessed from
within the UI.
Some of the preferences defined in the Metasys Preferences dialog box also apply to the Metasys
UI. The Metasys Preferences Dialog Box section calls out such preferences.

Metasys Preferences Dialog Box
The Metasys Preferences dialog box is accessed through the Tools menu (Configure Preferences)
and allows you to configure system and user preferences. Users authorized to edit system
preferences can edit all preference fields using the Metasys Preferences dialog box. See Users
Authorized to Edit System Preferences. Unauthorized users can edit only user preferences.
Some of the preferences defined in the Metasys Preferences dialog box also apply to the Metasys
UI. The following table calls out the tabs with such preferences. See the specific tab section for
details.
Click the tab name in the table for a description of the Metasys Preferences tabs. For more
information on the modes of operation, see Metasys Modes.

Table 277: Metasys Preferences Dialog Box Tabs for SCT, Metasys UI, and SMP
Tab SCT Applies to

Metasys UI
Applies to SMP UI Authorization

Required
Information Tab X X

Graphic Settings
Tab

X X X X

Display Settings
Tab

X X X X

Applications Tab X X

Preferences Concepts

System and User Preferences
Preferences are divided into two categories: system preferences and user preferences.

System Preferences
System preferences apply to all users who log in to the site or device. System preferences affect the
performance and operation of the system and require authorization to configure. A change to the
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audible alarm notification is an example of a system preference. Only the users defined in the Users
Authorized to Edit System Preferences section are authorized to configure system preferences.
To synchronize system preferences within a site or to reuse the system preferences on another
site, refer to the Configuring and Maintaining Preferences appendix of the ADS/ADX Commissioning
Guide (LIT-1201645), ODS Commissioning Guide (LIT-12011944), or the NAE Commissioning Guide
(LIT-1201519).

User Preferences
User preferences apply to a specific Metasys system user. User preferences define how the
information is displayed in the user interface, and do not affect the operation for other users of the
system. The colors and marker styles of a trend display are examples of user preferences.
Beginning at SCT Release 11.0 and later, user preferences and object lists are included in uploads
and downloads.
At Release 8.0 or later, user preferences (and object lists) that are created on the Metasys server/
ODS are saved in the archive database by SCT. They are part of the archive upload/download
process, so you no longer need to save these xml files before an upgrade. This feature is dependent
on the Metasys server/ODS version, and is not applicable for releases earlier than Release 8.0.
To synchronize user preferences within a site or to reuse the user preferences on another site,
refer to the Configuring and Maintaining Preferences appendix of the ADS/ADX Commissioning
Guide (LIT-1201645), ODS Commissioning Guide (LIT-12011944), or the NAE Commissioning Guide
(LIT-1201519).

Users Authorized to Edit System Preferences
Any user whose account is assigned to the Administrator role is authorized to configure system
preferences.

Information Tab
The Information tab displays messages regarding the current state of the preferences. This tab
does not contain configurable preferences.

Graphic Settings Tab
The Graphic Settings tab allows you to configure the status colors, fan colors, and state colors that
appear in standard and dynamic graphics, along with alarm flash settings. These settings apply to
the Site Management Portal UI (online mode), SCT, and the Metasys UI. The status color settings
may also be used by summaries or other views (Tailored Summaries, for example) to provide a
consistent indication of an object’s status.
The following table describes the attributes of the Graphic Settings tab.
Table 278: Graphic Settings Tab
Field Names/
Attribute

Description

Browse button Accesses the Select a Color dialog box. The Select a Color dialog box allows
you to select a custom color from three color palettes and to preview the
color for the attribute.

Status Colors Applies to value boxes, cells in Tailored Summaries, basic shapes (circle,
triangle, and square), and the Room Status symbol used in floor plan-based
graphics. See the Analog Alarm Extension for details on how these states are
calculated.

Normal Specifies the color used to indicate a status of Normal. The default color is
white: RGB(255, 255, 255).
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Table 278: Graphic Settings Tab
Field Names/
Attribute

Description

Out of Service Specifies the color used to indicate a status of Out of Service. The default
color is orange: RGB(255, 142, 25).

Overridden Specifies the color used to indicate a status of Overridden. The default color
is orange: RGB(255, 142, 25).

Trouble/Warning Specifies the color used to indicate a status of Trouble, Low Warning, High
Warning, or SAB Device Warning. The default color is yellow: RGB(255, 255,
0).

Offline Specifies the color used to indicate a status of Offline. The default color is
black: RGB(0, 0, 0).

Value Inaccessible Specifies the color used to indicate a status of an inaccessible value (for
example, communications failed). The default color is gray: RGB(190, 190,
190).

Alarm Specifies the color used to indicate a status of High Alarm, Low Alarm, Alarm,
or SAB Device Alarm. The default color is red: RGB(255, 0, 0).

Above Setpoint Specifies the color used to indicate a status of Above Setpoint. The default
color is pink: RGB(191, 0, 95).

Below Setpoint Specifies the color used to indicate a status of Below Setpoint. The default
color is blue: RGB(0, 0, 255).

Unoccupied Specifies the color used to indicate an Unoccupied status. The default color is
dark gray: RGB(150,150,150).

Fan Status Allows you to customize the fan status color of the attribute that appears in
system graphics. The Fan Status colors apply only to fans.

Stopped Defines the background color used for a fan symbol when its bound object’s
value indicates the fan is stopped.
Stopped is defined as State 0 (for binary/multistate objects) or as zero (for
analog objects).
The default color is red: RGB(255, 0, 0).

Running Defines the background color used for a fan symbol when its bound object’s
value indicates the fan is running.
Running is defined as State 1+ (for binary/multistate objects) or as non-zero
(for analog objects).
The default color is green: RGB(0, 153, 51).

Default State Colors Allows you to customize the default state color of the attribute that appears
in system graphics. The Default State Colors apply to basic shapes (circle,
triangle, square) that are bound to a binary/multistate object. These default
state colors can be changed for each shape after it is added to a graphic.

State 0 Specifies the color used for the State 0 setting of a dynamic graphic symbol.
The default color is white: RGB(255, 255, 255).

State 1 Specifies the color used for the State 1 setting of a dynamic graphic symbol.
The default color is green: RGB(0, 153, 51).

State 2 Specifies the color used for the State 2 setting of a dynamic graphic symbol.
The default color is red: RGB(255, 0, 0).
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Table 278: Graphic Settings Tab
Field Names/
Attribute

Description

State 3 Specifies the color used for the State 3 setting of a dynamic graphic symbol.
The default color is blue: RGB(0, 0, 255).

All Other States Specifies the color used for the All Other States setting of a dynamic graphic
symbol. The default color is light gray: RGB(204, 204, 204).

Simple Symbol
Flash Settings

Allows you to customize simple UGT shapes (such as circles and squares) to
flash when their bound object is in alarm.

Flash Type Defines the type of flashing applied to basic shape symbols:
• Disabled (No Flashing)
• State Color/Alarm Color (Flashes between the State Color and Alarm

Color)
• State Color/Alternate Color (Flashes between the State Color and

Alternate Color)

The default value is 0: Disabled (No Flashing).
Alternate Flash
Color

Defines the color used when flashing between the current color and an
alternate flash color. The default color is white: RGB(255, 255, 255).

Flash Rate Defines the flash rate for graphics symbol flashing. The range is from 100 to
1,000 ms. The default value is 250 ms.

Display Settings Tab
The Display Settings tab allows you to configure other properties related to the user interface
display. These settings apply to the Site Management Portal user interface and the SCT.
The following table describes the attributes of the Display Settings tab.
Table 279: Display Settings Tab
Field Name Description
View Settings
Server time
synchronization
interval

Specifies how often (in minutes) the local time is synchronized with the server
time. The range is 5–60 minutes. The default value is 30 minutes.

Hide
unauthorized
commands

Indicates whether the Command window hides the unauthorized commands
for the logged in user. The default value is False, in which case the
unauthorized commands appear dimmed.

New entry
timeframe

Indicates the amount of time that audits/events are considered new (based
on their time of occurrence in the Metasys system). The default value is 15
minutes. New audits/events are marked with a blue star in the Event Viewer
and Audit Viewer.

Query Results
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Table 279: Display Settings Tab
Field Name Description
Maximum results
in global search

Indicates the maximum number of rows displayed in the Global Search results
view.
If you are logged into an NAE, the range is 10–500 and the default value is 500.
If you are logged into a Metasys server, the range is 10–2,000 and the default
value is 500.

Note: If you display more than 500 results while logged into a Metasys server,
Data Refresh disables.

If you are logged into SCT, the range is 10–10,000 and the default value is
5,000.

Note: Increasing the number of results in global search may have a negative
impact on performance.

Print Settings
Default paper size Specifies the default paper size (Letter or A4) to be used for printing. The

default value is Letter.
General Display Settings
Default to
Advanced View

Indicates whether the Advanced View is the default view when opening an
item in the display panel or a wizard. The default value is False.
If the user is not authorized to access the Advanced View, the Advanced View
is not shown.

Extended labels
enabled on Login

Indicates whether extended labels are displayed in the navigation tree on
login. The default value is False.

Default command
set

Specifies which types of commands are shown by default when the Command
window opens. The options are All Commands (default), Primary Commands,
Secondary Commands, and Alarming Commands.

Note: We recommend using Primary Commands as the default command set to
reduce errors by lower level operators.

Default schedule
display

Indicates the initial display mode shown in the scheduling feature:

• Today’s Schedule (default)
• Weekly Schedule
• Exception Schedule
• Scheduled Items

Default navigation
display

Specifies the User View navigation display as either a set of tabs (Tabbed) or a
drop-down list (List). The default is Tabbed.

Note: List is recommended if the system has many user views, as this takes up
less space in the navigation tree pane.

Applications Tab
The Applications tab allows you to specify links to external applications, such as a spreadsheet or
Microsoft Word document, that can be launched from the Tools menu or from within graphics. The
following table describes the attributes of the Applications tab.
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Table 280: Applications Tab
Field Name Description
Add button Allows you to add a new external application that can be accessed from within

the Site Management Portal (SMP) UI. Once you click Add, the lower pane allows
you to enter application information. If you are authorized to change system
preferences, an Add Application dialog box appears first and allows you to specify
whether the application is to be a system or user preference.

Note: If you are not authorized to change system preferences, the application is auto-
matically added as a user preference.

For more information, see System and User Preferences.
Remove
button

Removes the selected application from the list.

Application
Name

Enter the name of the application as you want it to appear on the Tools menu or
within graphics.

Application
Path

Enter the full path of the application, including the command line arguments.
The path is based on the local file system (where you are browsing from), not on
the path of the device you are logged in to. The application path can also use any
mapped network drives.
Click the Browse button to access a Browse dialog box and select the application
and path.
To launch a specific file, select the path to the application that opens the file,
followed by a space and the path to the specific file in quotation marks. Use the
following format:
C:\Application Path\Application.exe “C:\filename path
\filename.extension”
For example, to launch a Microsoft Word document named Worksheet_01:
C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE "C:
\Documents and Settings\username\Desktop\Worksheet_01.doc"

Note: The Application you add is specific to the computer you are using when you
add it. The application may not launch from a different computer unless the applica-
tion exists on that computer in the same location.

Tools Menu Indicates whether the application appears on the Tools menu in the SMP UI.
Select True (default) to have the application appear on the Tools menu. Select
False if you do not want it to appear on the Tools menu.

Note: You must log out of the SMP UI and then log back in for new items to appear in
the Tools menu.

Graphics Indicates whether the application can be hyperlinked to and launched by a button
in a standard graphic. The application name you specify appears on the Hyperlink
Information Application drop-down menu for buttons in graphics. See Buttons.
Select True to enable this functionality. Select False (default) if you do not want
the application to provide graphics.

Note: This hyperlink capability is supported in the Graphics+ as well as the User
Graphics Tool (UGT).
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Table 280: Applications Tab
Field Name Description
Mnemonic Allows the application to be launched from a navigation key.

For example, if you add the Calculator to the Tools menu and specify the letter C
as the mnemonic, you can access the Calculator in the following way:
From the SMP UI, press Alt+T to access the Tools menu. Press C to highlight
Change Password. Press C again to highlight the Calculator application. Press
Enter to start the Calculator application.

Type Specifies whether the application is available for the system or the user. This
is specified when you first click Add to add a new application to the list. Once
specified, this attribute cannot be changed.

Certificate Management 
Certificate Management is an option in SCT that you use to manage trusted certificates that are
stored in network engines. Enhancements at Metasys Release 8.1 provided for improved security
by enabling encrypted communication between Metasys servers and network engines. These
enhancements included the option to configure encrypted and trusted communication for the SCT,
Metasys servers (ADS/ADX/OAS/ODS), all network engines, Metasys UI, and Launcher. Then, starting
at Release 9.0, encrypted and trusted communication is available between the Metasys server and
network engines. The Site Security Level attribute in the Site object controls this capability. For
details, refer to the ADS/ADX Commissioning Guide (LIT-1201645).
When you install or upgrade a Metasys site to Release 8.1 or later, self-signed certificates are
installed for the ADS/ADX/OAS/ODS and network engines by default. Self-signed certificates for
network engines have three-year durations; for Metasys servers, certificates are valid until the
year 2039. Once devices are installed or upgraded, Metasys system communication is encrypted.
If a customer is satisfied with encrypted communications, no Certificate Management steps
are required. System components come online and communicate as they would at any Metasys
software release.
Optionally, if trusted communications is desired, the customer's IT department can generate
trusted certificates or obtain trusted certificates from a Certificate Authority (CA) for the Metasys
server and network engines. You use IIS Manager in the operating system to manage trusted
certificates for the Metasys server. You use the Certificate Management option in SCT to manage
trusted certificates for network engines. Trusted certificates that contain wildcards (for example,
*.jci.com) are not permitted for the Metasys server and network engines.

Note: If you are implementing certificate management on an existing Metasys system, keep in
mind that adding a trusted certificate may require you to add a domain name to the original
host name of a server or engine. This action requires you to rename all data in the Metasys
historical databases. You can perform the renaming operation within SCT, but be aware that
this procedure requires intensive database operations that significantly prolong a system
upgrade. Therefore, be sure to allocate extra time if you are renaming historical data as part of
an upgrade to Metasys Release 9.0. For details about renaming a network engine, refer to the
Download section in Metasys SCT Help (LIT-12011964).

The connection status currently active on the computer is indicated by a security shield icon that
appears on the Metasys SMP and SCT login windows, and SMP and SCT UI main screens. If the site
or engine is using trusted certificates, a green shield icon with a checkmark appears. If the site or
engine is using self-signed certificates, an orange shield icon with an exclamation mark appears.
And finally, if the certificate chain to the site or engine is broken, the certificate is misnamed, or the
certificate has expired, a red shield icon with an X appears. The Metasys UI login screen does not
indicate the active connection status.
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To help you remember when server certificates installed on network engines expire, the Site object
has an attribute called Certificate Renewal Reminder. This attribute regulates when certificate
expiration reminders begin. It specifies the number of days prior to security certificate expiration
before operators are notified daily that an engine certificate is about to expire. For example, if you
use the default period of 60 days, and a server certificate on a network engine expires on January 1,
beginning on November 1, an event requiring acknowledgment is sent to operators once a day or
until the self-signed certificate is renewed or a new trusted certificate is installed.
The sections that follow describe how to manage security certificates for network engines with
SCT 12.0 and later, including how to request, upload, and download certificates. You also use
Certificate Management to add each Metasys server certificate so that SCT can push the server's
root certificate to network engines. Without the root certificate, network engine communication
to the Metasys server works, but it is untrusted. For setting up root, intermediate, and server
certificates on a Metasys server (ADS, ADX, ODS, or NxE85), refer to the appropriate document:
Metasys Server Installation and Upgrade Guide (LIT-12012162), ODS Installation and Upgrade Guide
(LIT-12011945), or NxE85 Installation and Upgrade Instructions (LIT-12011530).
From Metasys Release 10.1, network engines require additional security certificates to be stored
locally on the devices. This includes SCT’s root CA certificate. Network engines require the
certificates to maintain an Encrypted and Trusted status for communication. Therefore, from
Metasys Release 10.1, when you include certificates in a download, all of the certificates stored in the
SCT archive are transferred to a network engine. After you complete the download, in the Devices
tab of Certificate Management, the additional certificates are listed in the Details section for a
network engine.

Note: If you remove a certificate from an SCT archive, and then include certificates in an
upload from a device that has a copy of the deleted certificate, the certificate is restored in
the SCT archive. To permanently delete a certificate, remove it from the SCT archive and then
perform a download to all devices with certificates included.

Figure 74 shows an example of the Certificate Management window in SCT. Open it by clicking
Tools > Certificate Management. The window has a Certificates tab that includes details about each
certificate in the archive. From this window, you can request, export, or delete a certificate. You can
also replace an existing certificate with a self-signed certificate.
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Figure 74: Certificate Management Main Screen

The following table explains each column in the Certificates window. Click inside a column header
to sort the column.
Table 281: Description of Certificates Table
Column Name Description
Status A security shield icon that indicates the connection status afforded by the

certificate.
Green shield with tick icon: encrypted and trusted
Orange shield with exclamation mark icon: encrypted and self-signed
Red shield with cross icon: encrypted, but either the certificate chain to
the site or engine is broken, the certificate has a name mismatch, or the
certificate has expired.

Checkbox Icon A check box to select the device that you want to work with.
Issued To The name of the device to which the certificate is issued.
Type The type of certificate: root, intermediate, or server.
Device The device to which the certificate is bound (single or multiple for

intermediate and root certificates).
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Table 281: Description of Certificates Table
Column Name Description
Expiration The date on which the certificate expires. The certificate management

tool highlights all certificates that will expire within the number of days
specified by the Certificate Renewal Period attribute of the Site object (or
have already expired). Also, the Certificate Renewal Period attribute in the
Site object controls when certificate expiration reminders begin. It specifies
the number of days prior to security certificate expiration before the
operator is notified daily that a certificate is about to expire. This attribute is
synchronized to all child devices. Certificate Renewal Period applies only to
devices at Release 8.1 or later.

Details A clickable arrow that opens an expanded panel with more detailed
information about the certificate.

Certificate Signing Request (CSR)
Menu Selection: Tools > Certificate Management
SCT can generate a certificate signing request (CSR) on behalf of a network engine. However, SCT
cannot act as a certificate authority (CA) for signing certificates. Requesting a certificate is a multi-
step process that involves specifying the following information:

• common name
• email address
• name of organization
• name of organizational unit
• city
• state or province
• name of country

The CSR steps are different depending on the device type: server or network engine.
Summary of Steps for Metasys Server:
1. Use the Windows operating system of the Metasys server to create a CSR and an associated

private key.
2. Send the CSR for the server to the internal IT department or CA for signing. The internal IT

department or CA returns the signed certificate file.
3. Use IIS Manager on the Metasys server to complete the CSR, which includes importing the

certificate.
4. Use IIS Manager to bind the certificate to the server.
5. Export all certificate files and store them in a safe and secure location in case you need to re-

import them.

Note: If the Metasys Server and Metasys UI are installed on the same computer, they share the
same certificate.

Summary of Steps for Network Engine:
1. Verify that the device name in the SCT archive and the subject common name for the device

match.
2. Use SCT to create a CSR and an associated private key for each network engine. See

Requesting a Certificate.
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3. Send the CSR for each engine to the internal IT department or CA for signing. The internal IT
department or CA returns the signed certificate files.

4. Import the signed certificate files for each network engine into the SCT archive. See Importing
a Certificate.

Note:  You need to import the root certificate, the server certificate, and an intermediate
certificate file (if provided). The combination of one root certificate, one or more
intermediate certificates, and one server certificate is known as a certificate chain. The
certificate chain must be complete for both the server and each network engine to
successfully configure a site.

The CSR is complete and SCT removes the certificate request from the Requests table. The
private key that SCT previously created is paired with the imported certificate.

5. Export all certificate files and store them in a safe and secure location in case you need to re-
import them. See Exporting a Certificate.

Note: You cannot request a CSR for a device if an existing CSR is still pending. You must delete
the existing CSR first.

Important: The private key that is generated when the CSR is created can be associated with
the new certificate only if the device name in the SCT archive and the subject common name
for the device match. Therefore, before requesting a device CSR, verify that the device name is
correct. If not, the newly purchased certificate could be worthless because of the device name
mismatch. A common mistake is to forget to include the company domain name with the CSR.
No workaround is available that can recover the use of the new certificate.

Requesting a Certificate
About this task:  
To request a certificate for a network engine in an archive database:

1. Open the archive database.
2. Verify that the network device name in the archive matches the subject common name of the

online network engine. If not, change the network device name in the archive to match the
online network engine name.

3. On the Tools menu, select Certificate Management. The Certificate Management screen
appears.

4. Click the Devices tab. The Devices screen appears.
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Figure 75: Request Certificate - Devices Tab

5. Click the network engine for which you want to request a certificate. Click Request
Certificate(s). The Request Certificate(s) form appears.
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Figure 76: Request Certificate(s) Form

6. Complete all the fields on the form. Click Save CSR Details. An Export CSR(s) confirmation
window appears.

Figure 77: Export CSR(s) Confirmation

7. Click Yes to continue. The Export CSR(s) - Select Folder window appears.
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Figure 78: Export CSR(s) - Select Folder

8. Browse to a folder where you want to save the CSR file and click Export. The certificate
request file with a .PEM extension is exported to the selected folder. For example, the
certificate request file for a network engine called NAE-1 on a computer called ADX-1 would
be ADX-1_NAE-1_CSR.PEM for a network engine with a fully qualified name of ADX-1:NAE-1.

9. Send the certificate request file to the IT department to obtain your trusted certificate. When
you receive the file, go to Importing a Certificate to import the certificate into SCT for the
network engine.

Import Certificate
Use SCT to import certificates and private keys from the local file system. Three file formats are
supported: *.pem, *.cer, and *.crt. Typically, each device has two or three certificate files to import:
one root, one intermediate, and one server certificate. Some devices may have more than one
intermediate certificate. Whatever the case, always import every certificate file that the customer's
IT department or CA provides from the CSR you sent them.
SCT supports the import of only one certificate at a time. For example, if the root and intermediate
certificate information comes in a single file, you need to split it into two different files, one for the
root and the other for the intermediate certificate.
When you import a server certificate, SCT pairs the imported server certificate with the private
key from the associated CSR. If a server certificate is imported that contains an identical Issued
To Common Name (CN) as an existing certificate, the imported certificate replaces the existing
certificate, but the private key is retained; it is not replaced.
An imported server certificate of a Metasys server does not require a private key. In this case, the
certificate chain of these devices is needed by the SCT only to determine the set of root certificates
required by the child devices.

Importing a Certificate
About this task:  
To import a certificate for a network engine in an archive database:

1. Open the archive database.
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2. On the Tools menu, select Certificate Management. The Certificate Management screen
appears.

3. Click Import Certificates. The Import Certificates dialog box appears.

Figure 79: Request Certificate Screen

4. Select the certificate file. The file has a .crt, .cer, or .pem extension. Click Import. The
certificate for the network engine is imported.

Figure 80: Import Certificates Screen

5. Click the Certificates tab to view the newly imported certificate.

529SCT: System Configuration Tool Help



Figure 81: Newly Imported Certificate

Export Certificate
Use SCT to export certificates and private keys to the local file system. Exporting certificates is an
optional precautionary measure that allows you to export and store certificates to a computer or
removable media for safekeeping. Keep in mind that certificates with private keys are sensitive
information that you should treat as highly confidential files.
Three file formats are supported: *.pem, *.cer, and *.crt. Typically, each device has two or three
certificate files to export: one root, one intermediate, and one server certificate. Some devices may
have more than one intermediate certificate. Whatever the case, always export every certificate file
that the customer's IT department or CA provides from the CSR you sent them.

Exporting a Certificate
About this task:  
To export a certificate for a network engine in an archive database:

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Click the Devices tab. A table of devices with certificates appears. Select the device whose

certificate you want to export.
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Figure 82: Exporting a Certificate

4. Click Export Certificate(s). The Export Certificates dialog box appears.

Figure 83: Export Certificate(s) - Select Folder Screen

5. Click Export Certificate(s). The certificate file is exported to the selected folder location. For
example, if the name of the NAE is NAE-1, the certificate file would be called NAE-1.pem.

Certificate List View
Use the certificate list view to determine if all certificates required by each device reside in the
archive. The certificate list view provides these features:

• Indication of an expired certificate.
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• Indication of whether a certificate is required in one or more certificate chains used by a device
in the archive. The list view also makes clear which certificates are not needed and may be
deleted.

• Information about the certificate, including: Issued To, Type, Device Name (server certificates),
Expiration Date, Details (for example, SHA1 Thumbprint).

• Clickable column headers that sort the rows by the data in that column.
• Options for importing, exporting, and deleting root, intermediate, or server certificates.

Figure 84: Viewing Certificate Details

Viewing a Certificate
About this task:  
To view a certificate of a network engine in an archive database:

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Click the Details arrow for the certificate you want to view. Details of the certificate appear.

Certificate Tree View
Use the certificate tree view to verify the certificate chain, which is the combination of root,
intermediate, and server certificates required by the device. This information is important because
the certificate chain must be complete to successfully configure a site. The certificate tree view
displays the following:

• Root certificate: the highest level certificate; only one for each device.
• Intermediate certificate: one level for each intermediate; there may be none, one, or

multiple.
• Server certificate: the lowest level certificate; only one for each device.
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The certificate tree view indicates if the certificate chain is missing or incomplete for any device. For
each certificate, the following data is shown:

• Issued To: the common name (CN) field. For server certificates, the common name must
exactly match the device’s computer name (hostname).

• Expiration: date when the certificate is set to expire.
• Details: drop-down box that contains the SHA1 Thumbprint to distinguish certificates with the

same common name.

Figure 85: Certificate Chain View

The following example shows the certificate chain view when a certificate is missing.
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Figure 86: Missing Certificate Example

Download Certificate
Use the Download Certificate option to download server certificates independently from other
actions. This method is much faster than if you were to download the full database with the
Download To Device option in the Manage Archive wizard.
When you download certificates to a site device, SCT determines the correct set of certificates
required by that device for successful site configuration. If any certificates are missing, SCT includes
the set of certificates that it recognizes during the download, but the missing certificates need to be
imported before trusted connections can be established. Also, no certificates are downloaded if the
server certificate and private key for that device are not present in the SCT archive.

Note: From Metasys Release 10.1, network engines require additional security certificates to be
stored locally on the devices. When you download certificates, all of the certificates stored in
the SCT archive are transferred to a network engine.

Downloading a Certificate
About this task:  
To download a certificate to a network engine from an archive database:

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
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Figure 87: Downloading a Certificate

3. Select the device that has the certificate you want to download. (If you need to download the
certificates of multiple engines, you can select more than one from the devices table.) Click
Download. The Certificate Download wizard appears.
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Figure 88: Certificate Download wizard

4. Specify the username and password of the network engine (or click Communicate via
Site Director to use the Site Director's credentials). Click Test Login. When the login is
confirmed, click Next to complete the remaining steps in the Certificate Download wizard.
The ActionQ window appears to indicate the progress of the download. A completion status
of OK indicates that the certificate download process was successful.

5. Close the ActionQ window.

Upload Certificate
Use the Upload Certificates option to upload server certificates for network engines independently
from other actions. This method is much faster than if you were to upload the full database with the
Upload To Device option under Manage Archive.
When you upload a certificate from a network engine, SCT associates the engine's certificate with
the engine in the archive. Any previously existing certificates remain in the archive, but are no
longer associated to the network engine that you uploaded. If the certificates are the same, no
changes are made to the SCT certificates for the engine.

Uploading a Certificate
About this task:  

SCT: System Configuration Tool Help536



To upload a certificate from a network engine to an archive database:

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Click the Devices tab. A table of devices with certificates appears. Select the device that has a

certificate you want to upload. (If you need to upload the certificates of multiple engines, you
can select more than one from the devices table.)

Figure 89: Uploading a Certificate

4. Click Upload. The Certificate Upload wizard appears.
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Figure 90: Certificate Upload wizard

5. Specify the username and password of the network engine (or click Communicate via Site
Director to use the Site Director's credentials). Click Test Login. When the login is confirmed,
click Next to complete the remaining steps in the Certificate Upload wizard. The ActionQ
window appears to indicate the progress of the upload. A completion status of OK indicates
that the certificate upload process was successful.

6. Close the ActionQ window.

Deleting a Certificate
About this task:  
To delete a network engine certificate from an archive database:

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Select the device whose certificate you want to delete. Click Delete. A confirmation message

appears.
4. Click OK to delete the certificate. The certificates list refreshes indicating that the certificate is

removed.
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Deleting a Certificate Request
About this task:  
Follow these steps to delete a network engine certificate request from an archive database.

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Select the device whose certificate request you want to delete. Click Delete. A confirmation

message appears.

Figure 91: Delete CSR Confirmation Message

4. Click OK to delete the certificate request. The certificate requests list refreshes indicating that
the certificate request has been removed.

Replacing a Self-Signed Certificate
About this task:  
Follow these steps to replace an existing certificate with a new self-signed certificate for a network
engine in the archive database. This procedure is useful if you need to replace an expired or
compromised trusted certificate with a self-signed certificate.

1. Open the archive database.
2. On the Tools menu, select Certificate Management. The Certificate Management screen

appears.
3. Click the Devices tab. A table of all devices with certificates appears.
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Figure 92: Devices Tab in Certificate Management

4. Select the device and click Replace Self-sign.

Backing Up a Certificate
About this task:  
To back up a certificate for a network engine, select Tools > Certificate Management, then click
Export Certificate(s). For details, see Exporting A Certificate.

SCT also backs up and stores certificates if you export or backup an archive database. To create a
backup of an archive and a certificate, adhere to the following steps:

1. Select Tools > Database > Create Backup. See Create Backup for more information.
2. Select Tools > Database > Export Database. See Export Database for more information.

Important: As an important restriction for creating and restoring database archive backups
that contain network engine certificates, you must use the same SCT computer for both
operations. Do not restore the archive using a different SCT computer, or the certificate data is
deleted. This is a security precaution that protects against certificate theft.

All Items Organizer
Menu Selection: Tools > All Items Organizer
Launches the Metasys All Items Organizer.
Allows an authorized user to specify the order of any items in the All Items tree. You can order all
devices below the site (for example, NxEs) and nodes within devices.

Select Ethernet Adapter
Menu Selection: Tools > Select Ethernet Adapter
Selects the Ethernet adapter that the SCT computer uses to perform the following operations to a
supervisory engine:

• upload/download supervisory engines (applies to software images, uploads, and downloads)
• apply patches to supervisory engines
• upload/download field controllers via Trunk Utilities
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The drop-down box lists all active Ethernet adapters on the SCT computer. The Select Ethernet
Adapter dialog box reports the following: name of connection type, description of selected Ethernet
adapter, MAC address, IPv4 address, and IPv6 address. If the computer has wired and wireless
Ethernet adapters, for best results, we strongly recommend that you select a wired Ethernet
adapter.
For details on how to apply patches to supervisory devices, see Patch Device.

Database

Create Backup
Menu Selection: Tools > Database > Create Backup
Creates a backup file for the active archive database, including network engine self-signed
and trusted certificates, if in use. If needed, the archive database can be restored using the
Tools > Database > Restore Backup menu option. See the Restore Archive.
The backup file is always named <archive>.backup, where <archive> is the name of the open
archive visible at the top of the SCT navigation tree. Do not rename the backup file (renaming a
backup file causes a subsequent restore to fail). To save different versions, copy the backup file to
different subdirectories.
The default path is C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles.

Backing up an Archive Database
About this task:  
Backups are saved as .backup files and stored in the following directory:

C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles

To back up an archive database:

1. Open an archive database.
2. On the Tools menu, select Database.
3. Select Create Backup.

A message appears telling you that the backup was successful.
4. Click OK.

Note: Make a copy of each backup file and store it in a safe location. The copy is
intended as a second backup in case the original backup file is deleted. Do not rename
the backup file because it does not restore properly using a different name (it is case
sensitive).

Restore Archive
Menu Selection: Tools > Database > Restore Backup
Restores a backup (archive) database that was created using the Tools > Database > Create Backup
menu option in the SCT.
The default path is C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles.
Alternatively, use the Export/Import database feature in the Tools menu to create and restore a
backup of an archive database. See Importing an Archive Database for further information.

Note: The database Restore Archive feature cannot restore an archive to a version of SQL
Server that is earlier than the SQL Server version used to create the backup file. The Import
Database and Export Database features must be used to restore a database without SQL
Server limitations.
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Note: The database Restore Archive feature also restores the self-signed and trusted
certificates for network engines if they were part of the archive backup. A network engine
certificate is only restored if the archive was backed up on the same SCT computer. If you
restore the archive using a different SCT computer, the certificate data is deleted. This is a
security precaution that protects against certificate theft.

Restoring a Backup Database
About this task:  
To restore the database backup file, you must place the file in the following directory:

C:\ProgramData\Johnson Controls\MetasysIII\DatabaseFiles

Note: The database backup file automatically created when you upgrade SCT is located in the
following directory:

C:\Program Data\Johnson Controls\MetasysIII\Database Files\PreUpgrade Archives

When you restore an archive database, you can keep the supervisory devices at their current
release.

Note: The Archive Upgrade Tool used to upgrade and restore a backup database is now a part
of the Restore Backup process. Once the archive has been restored, the Open Archive process
is used to begin the upgrade process.

To restore an archive database:

1. On the Tools menu, select Database.
2. Select Restore Backup. The Restore Archive wizard appears.

You can restore a backup of an archive database file only when it is not in use. Archive data-
base files that are in use are locked and unavailable.

3. Select the database and click Restore. If the archive currently exists, the Confirm Delete and
Restore message appears.

4. Click Yes to Delete the current archive with the name selected in Step 1 and replace it with the
most recent backup of that archive.

5. Open the restored archive if desired. The version now available in the Open Archive wizard is
the last version that was backed up.

Note: Do not rename the backup file.

Re-index
Menu Selection: Tools > Database > Re-index
Using the Re-index feature improves SCT performance against large archive databases. The Re-
index feature removes fragmentation from the archive database. A clock appears during the re-
indexing process.

Note: Re-index works against any size archive and is especially recommended for sites
containing more than 100 NxEs.

Re-indexing an Archive Database
Using the Re-index feature improves SCT performance against large archive databases. The Re-
index feature removes fragmentation from the archive database. Re-index works against any size
archive and is especially recommended for sites containing more than 100 NxEs.
To re-index the archive database:
On the tools menu, select Database Re-index. A clock appears during the re-indexing process.
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Import Database
Menu Selection: Tools > Database > Import Database
Imports an archive database into the SCT. The import function imports a previously exported
archive, regardless of the version of SQL Server software in which the archive was originally
created. Archives can contain devices at Metasys system Release 5.2 or later.
The import file is a name given to the archive when it was exported, plus the .dbexport extension.
The Import Database option also imports the self-signed and trusted certificates for network
engines only if they were part of the database export. If you want to include certificates, you need
to specify the password that was entered when the database was exported. Without the password,
you can import the database, but the certificate data is excluded.

Importing an Archive Database
About this task:  
Imported databases are .dbexport files that were previously exported with SCT.

Note: Importing a large archive database (greater than 1 Gb size) may take from 15 minutes
to several hours to complete, depending on the number of objects. Therefore, you may wish to
schedule a large database import during off-hours.

To import an archive database:

1. On the Tools menu, select Database > Import Database. The Import wizard Source screen
appears.

Figure 93: Import wizard - Source Screen

2. Select a previously exported archive database. The file has a .dbexport extension.
3. Click Next. The Import wizard Destination screen appears.
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Figure 94: Import wizard - Destination Screen

4. Select an existing archive or specify a new archive.
5. Click Next. The Import wizard Summary screen appears.

Figure 95: Import wizard - Summary Screen

6. Click Finish. An animated clock appears while the import is occurring.
If the database contains certificates, a Decrypt Certificates window appears before the import
starts. If you want to decrypt certificates, specify the password that was entered when the
database was exported. If you do not want to decrypt certificates, unmark the Include Cer-
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tificates in Import? check box; no password is then required. Click OK to continue. An ani-
mated clock appears while the import is occurring.

Figure 96: Decrypt Certificates Question

7. Click OK on the message box that appears to indicate the import has completed successfully.

Export Database
Menu Selection: Tools > Database > Export Database
Exports an archive database from SCT into a file. The export database function exports an archive
database to a file. This database can be imported later using any local SCT, regardless of the version
of SQL Server software.
During an export, the entire archive is exported and no change is made to the Instance number,
Host name, or IP address of a device. This feature facilitates the migration of field controller device
information to an engine during upgrade.
The export file is always named with a .dbexport file extension. You can provide any name you
want, but we recommend that you use the archive name and the release version of SCT (for
example, MyServerRel11.dbexport).
Export Database can include or exclude security-related information, including security database,
certificates, and private keys. If the export file includes certificates and private keys, the process
prompts for a certificate password. Then when the database is later imported, the process prompts
for the certificate password that you specified. If the export excludes certificates, no certificate
password is required. If the correct certificate password is unknown at the time of import, the
imported database does not include the certificate information from the .dbexport file.

Note: Exported database files are not backward compatible. For example, you cannot import a
Release 10.0 .dbexport file into a Release 7.0. However, you can import a Release 7.0 .dbexport
file to a Release 10.0 SCT server instance.

Exporting an Archive Database
About this task:  
Exported databases are saved as .dbexport files and stored in any location accessible by the
computer.

To export an archive database:

1. Open the archive database with SCT.
2. On the Tools menu, select Database > Export Database. The Export dialog box appears.
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Figure 97: Export Dialog Box

3. Pick a location for the export file. You may want to create a folder where all exported
databases are maintained (for example, MyExports).

4. Accept the default name or enter a different unique name for your export file.

Note: If an exported file name of the same name already exists, a message appears to
verify that you want to overwrite the existing file. Click Yes to overwrite or No to cancel
the save process.

5. Click Export. An animated clock appears while the export is occurring.
If the database contains certificates, an Encrypt Certificates window appears before the
export starts. If you want to include certificates, specify a password and confirm the pass-
word. If you do not want to include certificates, unmark the Include Certificates in Export?
check box. Click OK to continue. An animated clock appears while the export is occurring.

Figure 98: Encrypt Certificates Question

6. Click OK to the message box that appears to indicate the export has completed successfully.

SCT: System Configuration Tool Help546



Manage Archive
Menu Selection: Tools > Manage Archive

Figure 99: Manage Archive Wizard

Functions of the Manage Archive Wizard include the following:

• Upload Devices
• Upload CAF from Field Controllers (Release 6.0 or later)
• Download Devices
• Download Only Metasys UI Spaces and Equipment
• Download Supervisory Device Images (Code Download)
• Device Synchronization
• Device Upgrade and Migration
• Patch NxE55 Supervisory Devices

The Manage Archive Wizard uses the Action Queue (ActionQ) to initiate and monitor the load or
backup/restore process. Access the Manage Archive Wizard by selecting Manage Archive from the
Tools Menu. The Manage Archive Wizard collects information necessary to perform the load such as
load type, controller names, and load time. Once you complete the wizard, the load commands are
added to the ActionQ in the SCT. The ActionQ initiates and monitors the load.

Archive Database
An archive database holds the configuration information for the field devices and field points that
make up a single site or multiple sites. The archive database contains information about controllers,
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input/output points, alarms, and device certificates. A single server can contain multiple SCT archive
databases, Configuration Data, SCT Summary Definitions, and Controller Templates.

Archive Database Creation
Use SCT to create a new archive database offline. To create a new archive database, copy an
existing archive database, or generate a new archive database. Then add or edit information and
references to sites, controllers, communications trunks, and objects (such as schedules, energy
management objects, and operators).
You can also generate a database online in a single engine and upload the information to SCT for
editing and archiving. See Archive Database Creation.

Archive Database Backup
An archive database backup is a backup file of the archive and security databases. You must restore
the archive backup into an archive database before you can use it. You can optionally back up the
archive database as a step when preparing a site for a Metasys system upgrade. You can also create
and move a backup to another computer with SCT. See Backing up an Archive Database.
When you upgrade SCT, an archive database backup is automatically created and stored in the
following directory:
C:\Program Data\Johnson Controls\MetasysIII\Database Files\PreUpgrade Archives

Uploading, Downloading, Upgrading/Migrating Device or Synchronizing a Database

Important: Before uploading, downloading, upgrading/migrating device, or synchronizing a
database, verify that the Item Reference of the device in the SCT matches (case-sensitive) the
Item Reference of the same device in the online mode.

Important: During a load, the database files are sent to C:\ProgramData\Johnson
Controls\MetasysIII\download.

This location string and the item reference string make up the file name string. If the entire file
name string exceeds the 256 character limit, the load fails.

For example, if you are downloading NAE-1, the location of the download files is C:
\ProgramData\Johnson Controls\MetasysIII\download\NAE-1NAE-1\*.*

This location string is already 102 characters long. If the location string and the item reference
string (*.*) exceed the 256 character limit for the entire file name string, the download fails.

Note: If you change names in your system, we recommend using the upload or download
process. If you add or delete points, use the upload, download, or synchronize process.

To Upload, Download, Synchronize, or Patch Device a device:
1. Select Manage Archive from the Tools Menu. The Manage Archive appears. See Wizards for

help on using wizards.
2. 3. Follow the wizard instructions. See Table 282.

The ActionQ appears after clicking Finish on the Summary screen of the manage archive
wizard.
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Notes:
- If the download freezes with the load status of Establishing Communications and no

error message appears, then wait a few minutes to allow the download to complete.
Then, refresh the SCT display to update the screen. The updated status message
appears when the download completes. The size of the database determines the
amount of time it takes to download, but typically just a few minutes. In addition, you
can determine that the database downloaded properly by waiting for the device to
come online after the download completes.

- When synchronizing databases, make sure the SCT computer remains running and
online until the synchronization process completes. This action helps to prevent
failures such as duplicate device databases.
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Table 282: Manage Archive Wizard Tips
Wizard Screen Tips
Action • Select the radio button for the type of load: Upload From Device,

Download To Device, Synchronize, or Upgrade/Migrate Device.
• • Select the desired check boxes under Options:

- Include Field Controllers (Upload from Device)
- Supervisory Device, Local Application (.caf file), Download Code,

Include UI on N40 Class Devices (Download to Device)
- Patch Supervisory Devices (Upgrade Device)
- Include HTTPS Certificates (Upload from Device and Download to

Device)

Selecting Include Field Controllers uploads the .caf files from all
field devices on a supervisory device that is at Release 6.0 or later.
A Resource extension is automatically created in the archive for the
field controller.
For an NCE, the load automatically pulls the archive database and
application during an upload.
To perform successful NCE downloads, you must first add the
Controller Application File (.caf file) as a resource file of the NCE
using the Resource File wizard. For details, see Resource File
Extensions.
Selecting Include HTTPS Certificates uploads or downloads all
trusted certificates associated with a supervisory device. You do not
need to select this option if only self-signed certificates are used in
the device.

Notes:

• When synchronizing the NCE, the load only synchronizes the database.
The application file is not part of the synchronization process.

• Before patching an NxE55 device, upload the device with SCT, which
preserves any recent object and the security database changes to the
archive database.

Select Devices • Select one or more devices to upload, download, upgrade/migrate
device, or synchronize.

• Use the Ctrl or Shift keys to select multiple items.

Notes:

• If you are upgrading device and the Site Director is not already
upgraded, include it to allow upgrades to the current SCT Version.

• If you are upgrading a device with the Patch Supervisory Devices option,
the Select Devices screen lists the release level and available software
patches for NxE55 supervisory devices. Only NxE55 supervisory devices
are selectable on the All Items tree. To patch supervisory devices of
different models and of earlier release levels, use the traditional patch
method.
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Table 282: Manage Archive Wizard Tips
Wizard Screen Tips
Load Schedule • Select either the Upload/Download/Synchronize/Upgrade now or

Schedule upload/download/synchronize/upgrade radio button.
• If you select Schedule upload/download/synchronize/upgrade, a date

and time selector appears.

Note: If you schedule multiple loads to begin at the same time, some loads may
not begin at the specified time because they are waiting for other loads to com-
plete. You cannot define a load order for devices scheduled together. If you
must load a certain device first, schedule that device separately with an earlier
load time.

Site Login • Enter the username and password for the load.
• Click the Test Login button to test if the username and password

entered allow you to communicate with the device. The device must be
online to perform this test successfully.

Note: The device does not need to be online for the Device Upgrade
process.

• Select the Communicate via Site Director check box if the device is not
on the LAN.

Notes:

• From Metasys Release 10.0, you can use the credentials of any admin
user to log in to the Site Director or destination device.

• If the SCT username and password do not match the Site Director or the
destination device username and password, Authorization Failure
error appears. You must enter the correct username and password on
this screen.

• From Metasys Release 10.0, if in the SCT you enter an incorrect password
five times within an allotted time period, the account is locked for five
minutes.

• If you perform a download, and log in to an engine using the default
username and password, you are immediately prompted to enter a new
password.

• Active Directory users may not be used to log on to the site.
• After the login status has been determined, a colored shield icon

appears in the status field to indicate the communication level. Red
indicates encrypted but untrusted, orange indicates encrypted only
(self-signed), and green indicates encrypted and trusted. SCT permits
communication with site devices despite potential certificate issues
(for example, incomplete certificate chain, expired certificate, or
mismatched host name).
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Table 282: Manage Archive Wizard Tips
Wizard Screen Tips
Repeat Upload • Appears only in the Upload Wizard.

• To repeat the upload automatically, enter the number of days between
uploads. Enter 0 if you do not want to repeat the load.

Note: Use this option only if all changes are being made online to the engine
or Metasys server database. The engine or Metasys server is always locked in the
SCT archive database because once a scheduled load completes, another load
is automatically scheduled. You can delete all scheduled loads for the engine or
Metasys server to clear the database lock.

Device Change • Appears only in the Download Wizard when only one device is selected
for download.

• To change the Name and Computer Name of a device during the
download, click Use this option to rename a device via download and
enter the current device name in the text box.

• To change the IP address of a device during the download, click Use
this option to change a device address via download and enter the
current device IP address in the text box.

Note: You cannot use this Device Change option to change the name of a Meta-
sys server. The name of the Metasys server object is the same as the computer
host name. For information on how to change the name of the Metasys server
object, refer to the ADS/ADX Commissioning Guide (LIT-1201645) or the ODS Com-
missioning Guide (LIT-12011944).

Summary View the final information for the load or upgrade/migration and click Finish.

Upload
The Manage Archive wizard upload option transfers a copy of the engine or Metasys server archive
database into the archive database of SCT. Perform an upload to update the SCT archive database
with changes made in the online mode. The engine or Metasys server database overwrites the SCT
archive database for the device being loaded. The direction of an upload is from the engine or
Metasys server to SCT.

Note: You can schedule uploads for various devices at a specific time. However, the software
can only run one device upload simultaneously until the request is completed.

Upload options include:
• • Include Field Controllers

The upload function lets you upload the .caf files from field controllers into the archive
database. If you want to upload the .caf files from field controllers reporting to the
engine, the supervisory device must be at Release 6.0 or later. During the upload
process, SCT creates or updates the Resource extension for the field controller. The View
Status window in ActionQ reports the field controllers whose .caf files were uploaded
successfully or unsuccessfully. After a .caf file is imported, you can use the Export .Caf File
option to export the file to a location on your computer, then edit or commission the file
with CCT.

Note: When you perform an upload from an ADS, do not select the Include Field
Controllers check box. To upload a full site, include field controllers in a separate upload
to any upload that includes ADSs.

SCT: System Configuration Tool Help552



• • Include Security
SCT gives you the option to include the security database when you perform an upload.
To include a security database upload, select the Include Security box. By default, the
box is selected for a standard device upload.

• • Include HTTPS Certificates
The upload function lets you upload HTTPS certificates from a network engine. By default,
the box is not selected for an engine upload. If no engine certificate is currently stored in
the archive, the upload adds the certificate to the archive if one exists.

Note: If the field controller contains Metasys Release 6.5 or later code, the Focus view of the
field controller records the date and time of the most recent .caf file upload.

Figure 100: Manage Archive wizard - Upload

Figure 101: Upload Workflow Diagram
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To Upload from a Device:
Notes:

• A Site Director's archive-defined software version must match the physical versions, or the
upload fails.

• At Release 11.1 and later, supervisory devices with firmware at an earlier release than what is
specified in the SCT are automatically upgraded to the SCT archive database release during
the upload. For example, a device listed as Release 8.0 in the SCT that is actually loaded with
Release 7.0 firmware will convert the Release 7.0 data to Release 8.0 as specified in the SCT.
Following the conversion, perform a code download to synchronize the device firmware
release to the SCT archive database release so that you can execute future downloads to the
device.

1. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Upload from Device.
3. 4. If you want to upload the .caf files from all field controllers defined on the engine, click

Include Field Controllers.
Notes:

- When you select the Include Field Controllers option, an indication of the field
controller upload progress appears in the Actions in Progress window.

5. 6. If you want to exclude the security database, click the Include Security check box to
deselect the option.

Note:  By default, the Include Security check box is selected.

7. If you want to include supervisory device certificates, click the Include HTTPS Certificates
check box.

8. Select the devices to upload and click Next.
9. Select the upload Schedule method and click Next.
10. 11. Select the Site Login method.
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Figure 102: Site Login Screen

To communicate through the Site Director:
a. Select the Communicate via Site Director check box.
b. Enter the username and password for an administrator account for the Site

Director.
c. Click Test Login. When login has passed, click Next.

To communicate through individual devices:
a. Enter the username and password for an administrator account on each physical

device.
b. Select the check box for the devices you want to communicate with.
c. Click Test Login. If the Status column contains Login ID is not OK for any

devices, repeat steps 8a through 8c until all devices have a Login ID is OK
status. Devices with a blank status indicate that you have not attempted Site Login
through the Manage Archive wizard.

Note: Successful logins are no longer able to be re-checked after they have
reached a Login ID is OK status.

12. Select upload reoccurrences and click Next.
13. Review the upload Summary and click Finish to perform the upload.
14. After the upload process is complete, verify that the Completed Actions window reports OK in

the Completion Status column.

Note: After the upload process completes, the View Status window in ActionQ reports the
number of field controllers whose .caf files were uploaded successfully or unsuccessfully.
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Table 283: Manage Archive wizard Screens
Screen Purpose
Action Select Upload From Device as the type of action and select the upload

options.
Select Devices Select one or more devices to upload. Use the Ctrl and Shift keys to

select more than one device.
Schedule To upload now, click Upload Now. To upload a device at a later date,

click Schedule Upload and select the date and time you want to upload
the device.

Site Login Select Communicate via Site Director if the destination device is not
accessible on the SCT server's local area network.

Note: This option slows down the operation if used unnecessarily.
If a different user name and password are required, enter the user
name and password.

Repeat Upload If you want the upload process to automatically repeat, enter the
number of days between uploads. Enter 0 if you do not want to
automatically repeat uploads.

Note: Use this option only if all changes made to the device are online.
Summary View the basic parameters of the device or devices just uploaded.

ActionQ Processing of Uploads:

Figure 103: Upload Process

SCT: System Configuration Tool Help556



Table 284: Upload Process Callouts and Description
Number Process Description
1 After you configure an upload in the Manage Archive wizard, the Manage Archive

wizard sends the upload command to the ActionQ feature in the SCT.
3 1. The ActionQ begins the upload process at the time defined for uploading the

engine or Metasys server database.
2. The engine or Metasys server creates an archive file of its database.

4 1. The ActionQ transfers the engine or Metasys server archive file to the SCT archive
database. If you selected the Include Field Controllers option, ActionQ also
copies the .caf file of each field controller into the archive for engines at Release
6.0 or later. If you selected the Include HTTPs Certificates option, ActionQ also
copies the certificate file of the supervisory device into the archive for engines at
Release 8.1 or later.

2. The ActionQ replaces the existing archive database with the engine or Metasys
server archive file.

5 The final status of the upload is displayed in the ActionQ.

Download
You can use the Manage Archive wizard download option to transfer a copy of the archive database
from the SCT to the engine or Metasys server database. During the download process, the SCT
archive database overwrites the engine or Metasys server database. At the end of the download,
the engine or Metasys server restarts and does not control or monitor the system until the restart
is complete. However, for network engines at Release 10.1 or later, a Background File Transfer
feature is built into SCT 14.0. During a Background File Transfer, an engine remains online and
continues to control the building. The Background File Transfer feature is available with the
Activate Immediately and Enable SNC Logic options on the Action window (Figure 104).

Important: If you do not manually set the Advanced Security Enabled attribute for a Site to
False before you upgrade to Metasys Release 11.0, a previous default value of False changes
to True after you upgrade. When the value is set to True, after you perform a download, a Site
Director at Metasys Release 11.0 or later discards all communication attempts from network
engines prior to Metasys Release 11.0. For more details, see Site Attributes.

Important: From Metasys Release 10.0, if you enable DHCP for a site, and a supervisory
device is in a different domain to the Site Director, add the domain of the Site Director to the
Completion Domains attribute of the supervisory device. See Engine Attributes. If you do not
add the domain of the Site Director, then the supervisory device loses connection to the Site
Director after you perform a download.

Note: You can use SCT to schedule downloads for various devices at a specific time. However,
SCT can only run ten device downloads simultaneously. For instance, if you select 20 devices to
download, SCT processes the first 10 downloads simultaneously and continues to pick up the
other 10 engine downloads one at a time as the first downloads complete.

Download options include:

• • Include Security
You can choose to include the security database when you perform a download. To
include a security database, select the Include Security check box. However, only include
the security database if one exists in the archive. To transfer a security database to the
archive, perform an upload. If you include the security database, the download time
increases.
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Important: If your security database includes Active Directory users, you must
always select Include Security when you upgrade the engine or Metasys server
database. Otherwise, the Active Directory users are no longer present and the
option to select Active Directory users on the Metasys SMP UI log in screen no longer
appears. To retrieve your Active Directory users, download the database again, but
this time select Include Security.

Note: From Metasys Release 10.1, network engines require additional security certificates
to be stored locally on the devices. When you download certificates, all of the certificates
stored in the SCT archive are transferred to a network engine. For more information, see
Certificate Management .

• • Download Code
Use the Download Code option to update the software disk image of a supervisory device
(Metasys Release 5.2 or later), and as a convenient alternative to the NAE Update Tool. The
software image of the supervisory device that you want to download must be stored in
the default location used when the file is unzipped. That location is C:\NAEUpdateTool
\tftpfiles. If you use the SCT to update an NxE to a Release 10.0 or later image, a PXE
download is performed. Therefore, the SCT computer must be on the same subnet as the
NxE. After you use the SCT to update the software disk image of the supervisory engine,
the archive database is automatically downloaded to the supervisory engine.

Important: You cannot use Release 9.0.7 image files in a code download. Also, if more
than one image file is installed on the SCT computer, SCT selects the most recent image
file for the model of NxE that you are downloading. If the SCT does not support the image
that you want to download, either use the Reflash Device option in SCT Pro, or use the
NAE Update Tool to perform a code download. Both methods require the SCT computer
and the NxE to be on the same subnet. For Release 9.0.7 images and later, select the PXE
Only option in the NAE Update Tool for the update process. Lastly, if for any reason SCT
or SCT Pro fails to download code to a network engine, use the NAE Update Tool over the
same subnet using the PXE Only method.

Note: If you use the NAE Update Tool feature of SCT at a release before SCT 10.0, the NAE
Update Tool and SCT must match release versions. For SCT 10.0 and later, the NAE Update
Tool and SCT are part of a common installation, so the tools are the same release.

• • Only Metasys UI Spaces and Equipment

Note: You can use this function instead of Synchronize when only updating the server
with Metasys UI changes.

At SCT Release 11.0, you can download Metasys UI spaces and equipment information
to your server-class device with the Manage Archive wizard. The Metasys UI Spaces and
Equipment download option allows you to easily transfer SCT-configured Metasys UI
spaces, equipment definitions, and equipment objects to an ADS, ADX, or ADS Lite that
is configured at Metasys Release 8.0 or later. The new spaces and equipment download
option does not include graphics and is not intended to replace a full download to your
server; instead, it offers a specific and simplified download for offline UI configuration.

Note: After an Only Metasys UI Spaces and Equipment download, the Metasys UI needs to
re-initialize and users need to login again.

• • Include UI resource files on N40 Class Devices
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N40 Class devices include NCE25s, NIE29s, NAE35s, NIE39s, NAE45s, and NIE49s. You can
clear this check box to reduce the time required for the download, and to save memory
space on the engine. You must include UI resources on an engine to log in to it directly
using SMP. However, after you log in to an engine, the UI resources are cached in the
Launcher application. You can log in to a different engine of the same model and Release
to cache the required UI resources.

• • Include HTTPS Certificates
The download function lets you download HTTPS certificates to a network engine.

• • Activate Immediately
When you use SCT Release 13.2 or later to perform a download to an NAE55-2, NAE55-3,
SNE, or SNC at Metasys Release 10.1 or later, you can choose when to activate the
downloaded files. If you select this check box, the files activate after the download
completes. If you clear this check box, you download the files but do not activate them. To
manually activate files, use the SMP to issue an Apply staged files command. For more
details, see Background File Transfer.

• • Enable SNC Logic
Select this check box to enable logic on the SNC device after the download activates. Clear
this check box to disable logic after the download activates. To enable logic at a later time,
edit the Focus window for the Program object, change Enabled to equal True, and then
save the change. To control when the download activates, see the Activate Immediately
check box.

Figure 104: Download to Device
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Figure 105: Download Workflow Diagram

To Download Changes to a Device:
1. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Download to Device.
3. If you want to exclude the security database, select the Include Security check box to deselect

the option.

Note:  By default, the Include Security check box is selected at SCT Release 10.0 or later.

4. If you want to include the UI on N40 devices, select the Include UI on N40 Class Devices check
box. This option is only available if you select the Download Code check box.

5. If you want to include HTTPS certificates, select the Include HTTPS Certificates check box to
select the option.

6. Click Next.
7. Select the devices to download and click Next.
8. Select the download Schedule method and click Next.
9. Select the Site Login method.

Note: Do not select Communicate via Site Director for a network engine that was newly
updated with the NAE Update Tool. For more information, see Table 285.
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Figure 106: Site Login Screen

10. To communicate through the Site Director:
a. Select the check box.
b. Enter the username and password for an administrator account for the Site Director.
c. Click Test Login.
d. If you use the default username and password to log in, you are prompted to enter a

new password for the Site Director. However, if you select to include security, and the
archive contains a security database for the Site Director, the account details stored in
the security database override the new password that you enter.

e. When the log in is successful, click Next.
To communicate through individual devices:

a. Enter the username and password for an administrator account on each physical device.
b. Click Test Login.
c. If you use the default username and password to log in, you are prompted to enter a

new password. All engines that use the default credentials are updated to use the new
password. However, if you select to include security, the account details stored in a
security database override the new password that you enter.

d. If the Status column has a Login ID is not OK for any devices, repeat steps 9a
through 9c until all devices have a Login ID is OK status. Devices with a blank status
indicate you have not attempted Site Login through the Manage Archive wizard.

Note: Successful logins are no longer able to be re-checked after they have reached
a Login ID is OK status.

e. When Login ID is OK is shown for all devices, click Next.
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11. Optional: Pair NxEs at Metasys Release 10.0 or later with a Site Director (see Pairing NxEs with
Site Director During a Code Download).

12. Review the download Summary and click Finish to perform the download.
13. After the download process is complete, verify the Completion Status column in the Completed

Actions window reports OK.

Note: After you perform a download to a device, some changes do not appear in active
sessions of the SMP connected to that device. For example, if you perform a download to an
ADX, the Signature and Annotation settings shown in the SMP remain unchanged. After a
download completes, close any active sessions of the SMP, restart the SMP, then reconnect to
the device.

Download Only Metasys UI Spaces and Equipment:

Note: The Metasys UI Spaces and Equipment download option allows a user to transfer SCT-
configured spaces, equipment definitions, and equipment objects to an ADS, ADX, ADS-Lite,
or OAS at Release 8.0 or later. This download does not include graphics and is not intended to
replace a full download to your server.

1. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Download to Device.
3. Click Only Metasys UI Spaces and Equipment and click Next.

Note: The Metasys server must be at Release 8.0 or later to select Only Metasys UI
Spaces and Equipment.

4. Select your Metasys server Site Director and click Next.

Note: Metasys UI Spaces and Equipment download only supports ADX, ADS, ADS-Lite, and
OAS servers. If you attempt to download Metasys UI to an NAE, the download fails.

5. Select Download now and click Next.
6. Select the Site Login method.

Note: Do not select Communicate via Site Director for a network engine that was newly
updated with the NAE Update Tool. For more information, see Table 285.

7. To communicate through the Site Director:
a. Select the check box.
b. Enter the username and password for an administrator account for the Site Director.
c. Click Test Login.
d. If you use the default username and password to log in, you are prompted to enter a

new password for the Site Director. However, if you select to include security, and the
archive contains a security database for the Site Director, the account details stored in
the security database override the new password that you enter.

e. When the log in is successful, click Next.
To communicate through individual devices:

a. Enter the username and password for an administrator account on each physical device.
b. Click Test Login.
c. If you use the default username and password to log in, you are prompted to enter a

new password. All engines that use the default credentials are updated to use the new
password. However, if you select to include security, the account details stored in a
security database override the new password that you enter.
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d. If the Status column has a Login ID is not OK for any devices, repeat step 6a and 6c
until all devices have a Login ID is OK status. Devices with a blank status indicate you
have not attempted Site Login through the Manage Archive wizard.

Note: Successful logins are no longer able to be re-checked after they have reached
a Login ID is OK status.

e. When Login ID is OK is shown for all devices, click Next.
8. Review the download summary and click Finish to perform the download.

Note: After an Only Metasys UI Spaces and Equipment download, the Metasys UI needs to
re-initialize and users need to log in again.

Table 285: Manage Archive wizard Screens
Screen Purpose
Action Select Download To Device as the type of action and select the

download options.
Select Devices Select one or more devices to download. Use the Ctrl and Shift keys to

select more than one device.
Schedule To download now, click Download Now. To download a device at a later

date, click Schedule Download and select the date and time you want to
download the device.

Device Change • Appears in the Download wizard when only one device is selected
for download.

• To change the Name and Computer Name of a device during the
download, click Use this option to rename a device via download
and enter the new name in the text box.

• To change the address of a device during the download, click Use
this option to change a device address via download and enter
the new address in the text box.

Note: You cannot use this Device Change option to change the name of a
Metasys server. The name of the Metasys server object is the same as the
computer host name. To change the name of the Metasys server object, you
must follow the rename procedure defined in the ADS/ADX Commissioning
Guide (LIT-1201645)  or the ODS Commissioning Guide (LIT-12011944).

Site Login Select Communicate via Site Director if the destination device is
not accessible on the local area network. This option slows down the
operation if used unnecessarily.

Note: A network engine download may fail with the error Device Type
Mismatch if you select Communicate via Site Director for a network
engine that was newly updated with the NAE Update Tool. By design, a
newly updated engine is its own Site Director, so you do not need to select
the Communicate via Site Director option.

If a different user name and password are required, enter the user name
and password. For example, on a newly updated engine, specify the
default user name (MetasysSysAgent) and default password. If you log
in using the default credentials during a download, you are prompted to
change the password.
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Table 285: Manage Archive wizard Screens
Screen Purpose
Device Pairing You have the option to pair NxEs at Metasys Release 10.0 or later with a

Site Director during a code Download (see Pairing NxEs with Site Director
During a Code Download)

Summary View the basic parameters of the device or devices to be downloaded.

ActionQ Processing of Downloads:

Figure 107: Download Process

Table 286: Download Process
Number Process Description
1 After configuring a download in the Manage Archive wizard, the Manage Archive

wizard sends the download command to the ActionQ in the SCT.
2 1. The ActionQ polls for progress during the download process.

2. The ActionQ begins the download process at the time defined for the
download.
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Table 286: Download Process
Number Process Description
3 The ActionQ transfers the SCT archive database file to the engine or Metasys server

database. If you selected the Download Code option, the software image for the
engine is transferred first before the database. If you selected the Only Metasys
UI Spaces and Equipment option, SCT-configured Metasys UI spaces, equipment
definitions, and equipment objects are transferred to the Metasys server at Release
8.0 or later. If you selected the Include HTTPS Certificates option, ActionQ also
sends down the certificate file of the supervisory controller stored in the archive
for engines at Release 8.1 or later.
Notes:

• If there are multiple versions of a disk image on the site, SCT selects the most
recent image of any given release.

• If you need to update an NCE25, follow a two-step process: download its code
first, then download its local application.

4 The ActionQ displays the final status of the download.

Pairing NxEs with Site Director During a Code Download
If a Site Director is at Metasys Release 10.0 or later, you must pair all child NxEs that are also at
Metasys Release 10.0 or later with the Site Director. After you pair an NxE with a Site Director, the
two devices use unique credentials to authenticate communication between them. You can pair
NxEs with a Site Director during a code download. For more information about device pairing, see
Pair Network Engine with Site Director.

Note: Select Do not Pair child devices to choose not to pair during download. For example,
you cannot pair child devices if the Site Director is offline. Unpaired NxEs are not able to
communicate with a Site Director, but you can use SCT to complete the pairing process at a
later time (see Pair Network Engine with Site Director). You can also pair devices through the
Site Management Portal of a Site Director or engine. For more information, refer to the Metasys
Site Management Portal Help (LIT-1201793).
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Figure 108: Device Pairing Screen

To pair NxEs with a Site Director during a code Download, complete the following steps:
1. In the top username and password fields, enter an administrator account user's credentials

for the Site Director, and then click Test Login. If the log in is successful, Login ID is OK
appears next to the Test Login button and in the Selected Action column.

2. If the Selected Action column of the Device table shows Login ID is not OK for any
device, complete the following steps:

a. Select the device.
b. Enter the username and password for that device's security database, and click Test

Login. When the log in is successful, Login ID is OK appears next to the Test Login
button, and in the Selected Action column for that device.

Note: If Pairing not needed is shown in the Selected Action column, then the device
is at a release earlier than Metasys Release 10.0, and does not need to be paired.

3. Click Next.

Important: After you complete the code download, perform an upload for paired devices and
the Site Director, and select the option to include security. This practice ensures that the SCT
archive contains accurate, up-to-date security details. For more information, see Upload.

Note: After pairing a device, a green arrow appears next to it in the device tree. A blue
strikethrough icon appears next to unpaired devices.

Downloading Disk Image
About this task:  
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The device you want to update must be at Metasys Release 5.2 or later and the image files must
exist on the SCT computer at this default location:

C:\NAEUpdateTool\tftpfiles

Use the Metasys Engine Importer to install engine image files. For more information, refer to the
Extracting the Disk Images to Your Computer section of the NAE Update Tool Help (LIT-12011524).

Important: To update a Release 9.0 or earlier NIE55 to Release 10.0 or later, first use the
ChangeModel tool to convert the NIE55 to an NAE55. For more information, refer to the
ToggleTunnel and ChangeModel Technical Bulletin (LIT-12011531).

If more than one image file exists on the SCT computer under this folder location, SCT selects the
most recent image file for the model of NAE that you are downloading. SCT does not provide a
method for selecting which image file to download. To select an image file other than the most
recent, use either the NAE Update Tool or the reflash option in SCT Pro. After SCT updates the
software disk image of the supervisory engine, SCT downloads the archive database into the
supervisory engine.

Figure 109: Download to Device: Code Download
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Update the Disk Image of a Supervisory Engine:

1. For NIE29, NIE39, NIE49, or NIE59 engines only, upload (backup) the integration driver and
license files using the NIEx9 Driver Manager tool before you proceed to the next step. For
details, refer to the NIEx9 Driver Manager Application Note (LIT-12011919).

Important:  If you skip this step, the Modbus, M-Bus, and KNX integrations for the NIEx9
become unlicensed and unusable after the update completes.

2. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
3. Select Download to Device.
4. Click Download Code. If at least one of the engines you are updating is an NCE25, NIE29,

NAE35, NIE39, NAE45, or NIE49 also click Include UI on N40 Class Devices.
Notes:

- By default, if you have at least one NCE25, NIE29, NAE35, NIE39, NAE45, or NIE49, the
Included UI on N40 Class Devices check box is selected. To exclude the UI download for
the N40 class devices, click to deselect the Included UI on N40 Class Devices check box.

- An example of when to deselect Included UI on N40 Class Devices is a case where
downloading a .zip file of approximately 30MB to your engine would exceed its total
available memory.

- By default, the Include Security check box is selected for a code download. To exclude
the security database in a download, click to deselect the Include Security check box.

5. Click Next. Select the devices you want to update. Use Shift+click to select and deselect
devices in the tree.

6. Click Next. Follow the prompts on each subsequent screen in the Manage Archive wizard.
7. Click Finish on the last screen. The Manage Archive wizard Code Download Summary window

includes device type, unique image version information, and image version tool tips.

Note: The download progress bar is based on the number of steps completed, not a
percentage of total time.
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Figure 110: Manage Archive wizard Code Download Summary

Unknown text warnings in the Summary window indicate the device has not been uploaded
previously. To resolve this issue, upload the device, and then repeat the process to update the
disk image on the affected device. No Image Found text warnings in the Summary window
indicate that the image is not available for download to the device. SCT downloads the latest
disk image to the device based on the image version displayed in the Summary window. To
resolve this issue, install the required firmware image on the SCT computer.
The ActionQ window opens with the Actions in Progress tab selected. After a few seconds,
ActionQ indicates the progress of the update (Figure 111). The percentage complete and the
current action appear during the process, including Initiating Code Download, Erasing Flash,
Processing Code Download, Download in Progress, and Waiting for Device Reset.
If you want to monitor the full details of the download in real time, open the Archive Log
located at Tools > Diagnostics > Archive Log.
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Figure 111: Device Update in Progress

8. After the update process is complete, verify the Completion Status column in the Completed
Actions window reports OK.

Figure 112: Device Update Completed Successfully

9. Log in to the NAE that you just updated and open its Focus window. Click the Advanced tab
and verify the Firmware Version indicates the new version.

10. For NIE29, NIE39, NIE49, or NIE59 engines only, restore (download) the integration driver
and license files to the NIEx9 using the NIEx9 Driver Manager tool before you proceed to the
next step. For details, refer to the NIEx9 Driver Manager Application Note (LIT-12011919).
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Renaming a Network Engine During a Download
1. Open the archive database.
2. Select in the network engine in the All Items tree that you want to rename.
3. Click Action > Rename. A Rename dialog box appears.
4. Write down the name that appears in the Old Name field. You need that information in a later

step.
5. Type a new name for the engine. Click OK. For large archives, the rename option may take a

while to complete.
6. Click Tools > Manage Archive. The Manage Archive wizard appears.
7. Select Download to Device. Clear all other options. Click Next.
8. Select the device that you just renamed. You can only select one device to rename at a time.

Click Next.
9. Select Download Now for the Schedule method. Click Next.
10. Click Use this option to rename a device via download on the Device Change screen. Enter

the current name of the device, which is the name you recorded in Step 4. Click Next.

Figure 113: Device Change Page
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11. Select the Site Login method and use Test Login to verify communication. If you log in using
the default credentials, you are prompted to change the password. However, if you include
a security database in the download, the password stored in the security database overrides
the new password that you enter. Click Next.

12. Review the download summary and click Finish to perform the download. The ActionQ
window opens to indicate the progress of the download. The device is renamed during the
download process.

13. To verify the rename, log in to the network engine and verify the Name field of the engine's
focus window is correct.

Synchronize

Note: Read this section thoroughly before using the Synchronize feature to fully understand
the implications of synchronizing databases. We recommend that you create a backup of the
SCT database before proceeding with a synchronization.

The Manage Archive wizard Synchronize option synchronizes an engine or Metasys server
database with the SCT archive database. In synchronization, changes made since the last load
process in the online database merge with changes made in the SCT database since the last
load process, resulting in two databases that contain the same information. One of the benefits
of the Synchronization feature is that the engine and server do not have to restart after the
synchronization is complete. The synchronize process should only be performed on relatively small
change sets, not on large change sets (such as after an upgrade).
If changes made since the last load process conflict, the SCT data supersedes the engine or server
data. For example, if a Relinquish Default attribute of a set point is changed to 77° in the SCT and
the same attribute is changed to 78° in the engine or Metasys server device, the attribute after
synchronization is set to 77° in both databases.
Notes:

• The UI does not indicate where discrepancies exist between the SCT data and the engine or
Metasys server data. Use care when using the synchronize option.

• When synchronizing an NCE, the load only synchronizes the object database. The local
application .caf file is not part of the synchronization process.

• If the archive database you want to synchronize was imported with the Import Database
option, you must first upload or download the database before you synchronize. If not, a
database merge error may occur. This requirement only applies to the first synchronization
after import; subsequent synchronizations do not require the upload or download step.

• When only updating the server with Metasys UI changes, you can use the Only Metasys UI
Spaces and Equipment procedure in Download.
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Figure 114: Synchronization Workflow

To Synchronize a Device

1. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Synchronize.
3. For SNCs, select the Enable SNC Logic check box to enable logic after the synchronization

completes, or clear the check box to disable logic after the synchronization completes.
4. Click Next.
5. Select the devices to synchronize to and click Next.
6. Select the synchronize Schedule method and click Next.
7. Select the Site Login method.

Figure 115: Site Login Screen
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8. To communicate through the Site Director:
a. Select the Communicate via Site Director check box.
b. Enter the username and password for an administrator account for the Site

Director.
c. Click Test Login. When login has passed click Next.

To communicate through individual devices:
a. Enter the username and password for an administrator account on each physical

device.
b. Select the check box for the devices you want to communicate with.
c. Click Test Login. If the Status column has a Login ID is not OK for any devices,

repeat steps 5a through 5c until all devices have a Login ID is OK status. Devices
with a blank status indicate you have not attempted Site Login through the Manage
Archive wizard.

Note: Successful logins are no longer able to be re-checked after they have
reached a Login ID is OK status.

9. Select Synchronize Reoccurrences and click Next.
10. Review the synchronize Summary and click Finish to perform the synchronize.
11. After the synchronize process is complete, verify the Completion Status column in the

Completed Actions window reports OK.
Table 287: Manage Archive wizard Screens
Screen Purpose
Action Select the Synchronize option. Choose to enable or disable logic for

SNCs after the synchronization completes.
Select Devices Select one or more devices to be synchronized. Use the Ctrl and

Shift keys to select more than one device.
Schedule To synchronize now, click Synchronize Now. To synchronize a

device at a later date, click Schedule Synchronize, and select the
date and time you want to synchronize the device.

Site Login Select Communicate via Site Director if the destination device is
not accessible on the local area network.

Note: This option slows down the operation if used unnecessarily.
If a different user name and password are required, enter the user
name and password.

Summary View the basic parameters of the device or devices just
synchronized.

Table 288: Synchronization Scenarios
Change in SCT Change in Device Final Result after Synchronization
Delete an Object No Change Object is deleted from both databases.
No Change Delete an Object Object is deleted from both databases.
Add an Object No Change Object is added to both databases.
No Change Add an Object Object is added to both databases.
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Table 288: Synchronization Scenarios
Change in SCT Change in Device Final Result after Synchronization
No Change Edit an Attribute Attribute value is changed in both

databases.
Edit an Attribute No Change Attribute value is changed in both

databases.
Edit an Attribute Edit Same Attribute to a

Different Value
SCT attribute value is used in both
databases.

Add an FEC to the FC Bus
with an Address of 11

Add an IOM to the Same FC
Bus with an Address of 11

The FEC with an address of 11 is added to
both databases.

Add Object to the XYZ
Folder

Delete the XYZ Folder The databases stay the same as they
were prior to the synchronization
attempt.

Note: Structural errors like this cause
the synchronization process to fail with
an error.

Copying and Pasting a
Logic Controller Tool
(LCT) Process and its LCT
Child

No Change LCT processes are empty.
Note: It is recommended that you per-
form a full download for LCT Process and
their LCT Child Processes.

Creating New User View
folder and downloading
ADS/ADX

No Change The User View Folder remains marked
with green change arrows.

ActionQ Processing for Synchronization

Figure 116: Synchronize Process
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Table 289: Database Synchronization Process
Number Process Description
1 After configuring a synchronization load in the Load wizard, the Manage Archive

wizard sends the synchronization command to the ActionQ in the SCT.
2 1. The ActionQ locks the engine or Metasys server in the archive database.

2. The ActionQ polls for progress during the synchronization process.
3, 4 1. The ActionQ begins the synchronization process either immediately or at the

time that you select. To start the synchronization, the ActionQ uploads the
engine or Metasys server database into the SCT archive database.

2. The SCT archive database saves a copy of the engine or Metasys server
database and then uses the new file to rebuild the engine or Metasys server
database.

3. The SCT archive database applies all changes from the engine or Metasys
server database to its own archive database.

4. If the SCT detects structural errors, it restores the saved copy of the original
database to the engine or Metasys server, an error message appears, and the
both the device and SCT databases remain unchanged.

Note: A structural error is a change made to one database that invalidates the
other database. For example, a structural error occurs if you add an object to a
folder in the SCT, but delete the corresponding folder online from the engine or
Metasys server database.

5. If structural errors are not detected, the ActionQ continues and downloads
the new file from the SCT to the engine or Metasys server database. However,
the engine or Metasys server applies the changes from the new file to the
database and goes through the startup process without resetting.

6. The ActionQ unlocks the engine or Metasys server in the archive database.
7. The ActionQ displays the final status of the synchronization.

Upgrade/Migrate
Use the SCT Manage Archive Wizard to upgrade devices and security databases in site archives.
You can also use the Manage Archive Wizard to migrate a device to a different model number.
You cannot select a migration option for a supervisory device that would promote it to become the
Site Director. For example, if your Site Director is an NAE45 with an NAE45 child, the child cannot be
migrated to be an NxE55 because that would promote the child to become the Site Director. In this
example, migrate the Site Director to a higher model before you migrate the child device.

Note: Additional steps are required to migrate an NCE to an SNC. For more information, refer
to the SNC Commissioning Guide (LIT-12013295). To migrate an NCE to a new SNC, the Site
Director must be at release 11.0. Previous generation NCEs must remain at 9.0.

Note: The Upgrade/Migrate Device process does not communicate with the physical device on
your site; the upgrade/migrate process only performs the action within your site archive. To
communicate with the physical device, you must perform a Download. When you migrate a
device, replace the hardware before you perform a code download.

SCT: System Configuration Tool Help576



Figure 117: Device Upgrade Release Options

Figure 118: Upgrade Workflow Diagram

To Upgrade/Migrate a Device
You do not need to enter Site Login information in the Manage Archive wizard in the following
situations:

• You upgrade a device to a release before 8.0.
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• You upgrade a device to Release 8.0 or later but no security database exists in the archive.
• You migrate a device but not upgrade it.

To upgrade and migrate devices, use the following steps:

1. On the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Upgrade/Migrate Device and click Next.
3. On the Select Devices page, configure the update and migration options:

a. To add a device, click the plus sign, select the device, and then click OK.

Note: If you add multiple devices, the SCT user interface may take longer
to respond to your actions. After you progress to the summary page, the
responsiveness of the user interface returns to normal.

Note: In the Instructions area, a red warning informs users that all devices under
the site director must be at the same release.

b. To remove a device, select the device, and then click the minus sign.
c. From the lists in the New Model column, select a model number for each device that

you want to migrate.
d. From the Upgrade Selected Devices to Release list, select a release version for the

device upgrade.
e. Click Next. If the Next button is disabled, then the combination of upgrade and

migration options that you have selected is not valid. Adjust any selections highlighted
in red before you continue.

4. Select the upgrade Schedule and click Next.
5. If you are upgrading a device to Release 8.0 or later, and a security database exists in the

archive, use the following steps:
a. Enter the MetasysSysAgent password for each archive device and click Authenticate

For Upgrade. If the login for the device fails, the device remains in the Devices
Requiring Action table.

b. Repeat the above step until all devices have been moved to the Selected Action table.
c. In order to complete the upgrade of the security database some older passwords that

cannot be updated are reset to the Default Reset Password. When you perform the
reflash, you are responsible for setting the Default Reset Password for the affected
users. After the users log on with the Default Reset Password to authenticate to the
destination device they are prompted to change password. The administrator has the
option of notifying the affected user group by email that their password will be changed
to the Default Reset Password on their first login attempt.
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Figure 119: Manage Archive wizard: Upgrade Device Site Login

Notes:
- To upgrade a device with an unknown MetasysSysAgent password, set the selected

action to Clear Security Database.
i. Select the device in the Devices Requiring Action table.
ii. Open the Clear Security Database tab and click Set to be cleared.

- A device with a clear security database status is upgraded, but the security database
is removed from the archive. To add another security database to the device after an
upgrade, perform a Security Copy, and then upload the device to store the security
information in the SCT archive.

- A status of No Security Database to Upgrade indicates that you have not
uploaded the device to the archive. A status of No Credentials needed for
Upgrade indicates that you are upgrading to a release earlier than 8.0.

6. Click Next.
7. Review the upgrade Summary and click Finish to perform the upgrade.
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8. Click Finish in the Manage Archive wizard and Refresh All Tabs in the navigation tree for your
changes to appear.

Table 290: ActionQ Processing For Device Upgrade/Migration
Number Process Description
1 After configuring an upgrade device in the Manage Archive wizard, the Manage

Archive wizard sends the upgrade command to the ActionQ feature in the SCT.
2 The ActionQ locks the engine or Metasys server in the archive database.
3 1. The ActionQ begins the upgrade/migration process at the time scheduled in

the upgrading/migrating device wizard.
2. The device within the archive database is upgraded/migrated.

4 The ActionQ displays the final status of the upgraded/migrated device.

Patch Device
The Upgrade/Migrate Device option provides the opportunity to patch supervisory devices. You
can only patch NxE55-2, NxE55-3, NIE59-2, and NIE59-3 supervisory engines that are currently at
Release 6.5 (6.5.25 for NIE59-2) or later. Upgrading an engine with SCT only updates information
in the archive. Patching an engine affects the files inside of the engine. When you select the Patch
Supervisory Devices option, the Select Devices screen lists the release level and available software
patches for NxE55 supervisory devices. Only NxE55 supervisory devices are selectable on the All
Items tree. To patch supervisory devices of different models and of earlier release levels, use the
traditional patch method. Refer to the Metasys System NCE25/NAE35/NAE45 Quick Patch Installation
Instructions (LIT-12011313) and Metasys System Quick Patch Installation Instructions (LIT-12011188).
Notes:

• The NxE55-1, NxE3x, NxE4x, and NxE2x engines require the full image download using a
Download Code option.

• You must make sure the patch file on the SCT computer is located in this folder: C:
\ProgramData\Johnson Controls\MetasysIII\PatchData\<release>\N50. This folder
must contain only one patch file. If more than one patch file exists in this folder, SCT cannot
differentiate the multiple files and No Patches appear in the Select Devices window.

• Upload the supervisory device before you apply a patch to preserve objects and the security
database with SCT. You may schedule a delayed load and patch installation by selecting the
Schedule upgrade button and entering a date and time.

Important: For NIE29, NIE39, NIE49, or NIE59 engines only, upload (backup) the integration
driver and license files using the NIEx9 Driver Manager tool before you proceed. If you skip
this step, Modbus, and KNX integration for the NIEx9 become unlicensed and unusable
after the update completes. For details, refer to the NIEx9 Driver Manager Application Note
(LIT-12011919).
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Figure 120: Patch Device Workflow

To Patch a Supervisory Device

1. In the Tools menu, select Manage Archive. The Manage Archive wizard appears.
2. Select Upload From Device, then click Next. Select the device you want to patch. Click Next.
3. Complete the Manage Archive wizard steps to upload the supervisory device to the archive

database. This action preserves any recent object and security database changes with SCT.
4. In the Tools menu, select Manage Archive again. Select Upgrade/Migrate Device and click

the Patch Supervisory Devices option. Click Next.
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Figure 121: Patching Supervisory Devices

5. Select the NxE55 or NIE59 devices listed in the Select Devices table that you want to patch. Use
the + and – buttons to add and remove devices from the table.

Note: If the message Download Required appears in the Patch Version column, the
device you selected cannot be patched; you must update the device with the full image.
If the message Upload Required appears in the Patch Version column, click Cancel,
upload the device first, then apply the patch. If the message No Patches appears in
the Patch Version column, either no patch files or multiple patch files exist under the
PatchData directory. The PatchData directory must contain only one patch file, the one
that you want to apply to the NxE.
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Figure 122: Select Devices to Patch

6. Click Next.
7. On the Schedule screen, click Upgrade Now to patch the device now. To patch a device at a

later date, click Schedule Upgrade and select the date and time that you want to patch the
device.

8. Click Next.
9. Select the Site Login method.
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Figure 123: Site Login Screen

10. To communicate through the Site Director:
a. Select the Communicate via Site Director check box.
b. Enter the username and password for an administrator account for the Site

Director.
c. Click Test Login. When login has passed, click Next.

To communicate through individual devices:
a. Enter the username and password for an administrator account on each physical

device.
b. Select the check box for the devices you want to communicate with.
c. Click Test Login. If the Status column has a Login ID is not OK for any devices,

repeat steps 9a through 9c until all devices have a Login ID is OK status. Devices
with a blank status indicate you have not attempted Site Login through the Manage
Archive wizard.

Note: Successful logins are no longer able to be re-checked after they have
reached a Login ID is OK status.

11. Review the patch Summary and click Finish to perform the patch.
12. Click Finish.
13. After the patch process is complete, verify the Completion Status column in the Completed

Actions window reports OK. Now the device is also updated in the SCT archive.
14. Log in to the NAE that you just patched and open its Focus window. Switch to the Advanced

view and verify the Firmware Version indicates the new patched version.
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Table 291: ActionQ Processing For Device Patching
Number Process Description
1 After configuring a device to patch in the Manage Archive wizard, the Manage

Archive wizard sends the patch command to the ActionQ feature in the SCT.
2 The ActionQ locks the engine or server in the archive database.
3 1. The ActionQ begins the patch process at the time scheduled in the upgrading/

migrating device wizard.
2. The supervisory device within the archive database is updated with the patch

file located on the SCT computer and the supervisory device is upgraded to a
new release in the SCT archive.

4 The ActionQ displays the final status of the patched device.

Trunk Utilities
The Trunk Utility functionality previously only available in the NAE Point Schedule and CCT, is now
integrated within SCT. This powerful feature allows you to transfer field controller files via NAE
pass-through to MSTP or IP devices, transfer files with direct Ethernet connection for IP devices, or
transfer files with a MAP 4.2 connection.

Note: IP field controllers do not support a BTCVT connection type or an integration through
the legacy NAE Point Schedule.

The Trunk Utilities feature supports viewing and editing device parameters on field controller
trunks. Parameters can be edited in offline or online mode. Along with the ability to view and
edit device parameter options, Trunk Utilities also has an enhanced download workflow which
provides the ability to modify, command, and view the status of, field controllers on a live
system. For additional information see the CAF Parameters  section or visit uLearn at https://
jcpublic.kzoplatform.com/library to watch educational videos.

Uploading a CAF to SCT Through Trunk Utilities

1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Upload Applications.
3. In the Connection Type section, select the connection type: NxE Passthru, Direct Ethernet, or

MAP 4.2+/BACnet Router. Click Next. The Trunk Utilities Select Devices window appears.

Note: Direct Ethernet connections are only compatible with IP devices. If you have
multiple Ethernet adapters, you may experience connection issues. Go to Tools  > Select
Ethernet Adapter and verify that the correct adapter is selected. See Select Ethernet
Adapter for more information.

Note: If you apply power to a MAP Gateway before you connect it to the SA Bus of a
device, devices on the trunk are not discovered. To initiate an automatic discovery of
devices, log in to the MAP Gateway UI. If you are already connected to the MAP Gateway
UI, on the Device List page, click Rediscover Devices.

4. Select the Integrations for the field device(s) and click Next.
5. Enter the connection parameters specific to your connection type and click Next.

a. For NxE Passthru connections, to connect directly to a device, clear the Communicate
via Site Director check box, select the device from the list, enter your user credentials,
then click Test Login. To connect through the Site Director, select the Communicate via
Site Director check box, enter you user credentials, then click Test Login.
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b. For Direct Ethernet connections, enter the UDP port of the device and an available
Ethernet network interface adapter (if selected, verify you are on the same subnet as
your IP controllers) to use.

c. For MAP 4.2+ / BACnet Router connections, enter the IP address and UDP port of the
router (47808), the network number (BACnet Instance) of the MS/TP trunk (1-65,534),
and an available Ethernet network interface adapter to use (if selected, all IP traffic
intended for the router travels through this interface).

Note: Do not use 1001 for the MS/TP Network Number. The number 1001 is
reserved for Johnson Controls BACnet/IP network connections.

6. Validate information in the Trunk Utilities Summary window and click Finish. The progress of
the transfer can be monitored using the Actions in Progress tab of the ActionQ.

Downloading a CAF to Devices Through Trunk Utilities

Note: To use the Download Applications feature in Trunk Utilities, you must have licensed
Field Controller package files. For more information on controller package licensing, refer to
the Software Manager Help (LIT-12012389).

1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Download Applications.
3. In the Connection Type section, select the connection type: NxE Passthru, Direct Ethernet, or

MAP 4.2+/BACnet Router.

Note: Direct Ethernet connections are only compatible with IP devices. If you have
multiple Ethernet adapters, you may experience connection issues. Go to Tools > Select
Ethernet Adapter and verify that the correct adapter is selected. See Select Ethernet
Adapter for more information.

Note: If you apply power to a MAP Gateway before you connect it to the SA Bus of a
device, devices on the trunk are not discovered. To initiate an automatic discovery of
devices, log in to the MAP Gateway UI. If you are already connected to the MAP Gateway
UI, on the Device List page, click Rediscover Devices.

4. The When to Activate options control when the transferred application is activated in
a controller. If you select After transfer, the application is transferred and immediately
activated. If you select Wait for manual activation, the application is transferred but not
activated. To activate the application at a later time use the Activate pending files command
in Trunk Utilities > Commands.

5. The When activated options modify the runtime logic of an activated application. Select
Enable Logic to enable or Disable Logic to disable the runtime logic of an activated
application. If you want to disable the logic of an application, you can enable it later by
selecting the command Enable Logic in Trunk Utilities > Commands.

Note:
- Use of the Disable Logic option depends on the controller product. Refer to your

product documentation for more information. This feature is only available at Tools
Release 13.0, and Firmware 8.0 and later. If the option is selected for an incompatible
controller, the download will fail for that controller.

- For information about how to apply the disable and enable logic features, see the
Application Options Workflow.

6. Select the Integrations for the field device(s) and click Next.
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7. Enter the connection parameters specific to your connection type and click Next.
a. For NxE Passthru connections, to connect directly to a device, clear the Communicate

via Site Director check box, select the device from the list, enter your user credentials,
then click Test Login. To connect through the Site Director, select the Communicate via
Site Director check box, enter you user credentials, then click Test Login.

b. For Direct Ethernet connections, enter the UDP port of the device (if selected, verify you
are on the same subnet as your IP controllers).

c. For MAP 4.2+ / BACnet Router connections, enter the IP address, the UDP port of
the router (47808), and the Network Number (BACnet Instance) of the MS/TP trunk
(1-65,534). If selected, all IP traffic intended for the router travels through this interface.

Note: Do not use 1001 for the MS/TP Network Number. The number 1001 is
reserved for Johnson Controls BACnet/IP network connections.

8. Validate the information in the Trunk Utilities Summary window and click Finish. The progress
of the transfer can be monitored using the Actions in Progress tab of the ActionQ.

Note: To view the status of devices, and to modify and issue commands after a Trunk Utilities
download, see CAF Parameters.

Application Options Workflow
Use the Download Applications feature of Trunk Utilities as an enhanced download workflow to:
(a) control when transferred files are activated in a field device, and (b) modify the runtime logic
of applications activated in a device. Once you enable this feature, you can access the Application
Options  parameter sheet to view the status of an application and modify it accordingly.

Selecting the After Transfer and Enable Logic Options
If you select the After Transfer and Enable Logic options in Trunk Utilities, the application is
transferred to the device and activated immediately. The runtime logic is enabled and executes
immediately.
To immediately activate an application in a device with runtime logic enabled, complete the
following steps:
1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Download Applications.
3. Specify a Connection Type.
4. In the When to Activate section, select After transfer.
5. In the When activated section, select Enable Logic. Click Next.
6. Select the Integrations for the field devices. Click Next.
7. Enter the connection parameters specific to your connection type. Click Next. For an overview

of connection types and parameters, see Downloading a CAF to Devices Through Trunk
Utilities.

8. Validate the information in the Trunk Utilities Summary window and click Finish.

After the Trunk Utilities download completes, you can view the status of an application by selecting
the appropriate integration or device.

To view the status of an application in an integration, complete the following steps:
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk that you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
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3. In the Select Parameter Sheet window, select the Application Options view and switch the
parameter sheet mode to Online.

4. Specify a connection type and, if prompted, enter a username and password. Click Test Login
to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration.

To view the status of an application in a device, do the following:
1. In the All Items tree, double-click the field device that you want to view. To view multiple field

devices, hold down shift while clicking each field device.
2. Click View > Parameter Sheet Viewer.
3. In the Parameter Sheet window, select the Application Options view and switch the

parameter sheet mode to Online.
4. 4. Specify a connection type and, if prompted, enter a username and password. Click Test

Login to test the login credentials, or click Open to open the Application Options parameter
sheet for the integration

Figure 124: After Transfer and Enable Logic Options - Parameter Sheet View

Note:  If you selected the After transfer and Enable Logic options in Trunk Utilities, the
parameter sheet column Logic Enable (Enabled) column shows the status True and the
Status (Pending Files) column displays a series of dashes (---).

Selecting the After Transfer and Disable Logic Options
If you select the After transfer and Disable Logic options in Trunk Utilities, the application is
transferred to the device and immediately activated. The runtime logic is disabled immediately.
As a best practice, use this option during equipment commissioning. With runtime logic disabled,
you can edit and download an application repeatedly to complete hardware-level testing.
To activate an application in a device with runtime logic disabled, complete the following steps:
1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Download Applications.
3. Specify a Connection Type.
4. In the When to Activate section, select After transfer.
5. In the When activated section, select Disable Logic. Click Next.

Note:  Use of the Disable Logic option depends on the controller product. Refer to your
product documentation for more information. This feature is only available at Tools
Release 13.0, and Firmware 8.0 and later. If the option is selected for an incompatible
controller, the download will fail for that controller.
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6. Select the Integrations for the field devices. Click Next.
7. Enter the connection parameters specific to your connection type and click Next.
8. Validate the information in the Trunk Utilities Summary window and click Finish.

After the Trunk Utilities download completes, you can view the status of an application by selecting
the appropriate integration or device.

To view the status of an application in an integration, complete the following steps:
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk that you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
3. In the Parameter Sheet window, select the Application Options view and switch the

parameter sheet mode to Online.
4. Specify a connection type and, if prompted, enter a username and password. Click Test Login

to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration.

To view the status of an application in a device, do the following:
1. In the All Items tree, double-click the field device that you want to view. To select multiple field

devices, hold down shift while clicking each field device.
2. Click View > Parameter Sheet Viewer.
3. In the Parameter Sheet Window, select the Application Options view and switch the

parameter sheet mode to Online.
4. Specify a connection type and, if prompted, enter a username and password. Click Test Login

to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration

Figure 125: After Transfer and Disable Logic Options - Parameter Sheet View

Note:
• If you selected the After transfer and Disable Logic in Trunk Utilities, the Application

Options parameter sheet column Logic Enable (Enabled) shows the status False and
the Status (Pending Files) column displays a series of dashes (---).

• The Logic Enable (Enabled) column will display a series of dashes (---) if the controller is
not supported. The disable logic feature is only supported for firmware at 8.0 or later.

Complete the following steps to enable the runtime logic of an application:
1. In the Application Options view, select the desired devices, right-, then click Access Trunk

Utilities to open the Trunk Utilities wizard. The Commands radio button is automatically
selected.
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2. In the Commands section, select Enable Logic.
3. Specify the Connection Type and click Next.
4. Verify that the correct devices are selected and click Next.
5. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

6. Validate the information in the Trunk Utilities Summary window and click Finish.
Selecting the Wait for Manual Activation and Enable Logic Options
If you select the Wait for manual activation and Enable Logic options in Trunk Utilities, the
application is transferred to the device but not activated. The runtime logic is enabled on the device
after you activate the application.
As a best practice, use this option when you download a large number of application files. If
you enable this feature, you can stage applications to devices without reducing the efficiency of
other activities. You can then use the Applications Options parameter sheet later to validate and
manually activate files.
To stage an application to a device with logic enabled, complete the following steps:
1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Download Applications.
3. Specify a Connection Type.
4. In the When to Activate section, select Wait for manual activation.
5. In the When activated section, select Enable Logic. Click Next.
6. Select the Integrations for the field device(s) and click Next.
7. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

8. Validate the information in the Trunk Utilities Summary window and click Finish.
After the Trunk Utilities download completes, you can view the status of an application by selecting
the appropriate integration or device.

To view the status of an application in an integration, complete the following steps:
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk that you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
3. In the Parameter Sheet window, select the Application Options view and switch the

parameter sheet mode to Online.
4. Specify a connection type and, if prompted, enter a username and password. Click Test Login

to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration

To view the status of an application in a device, do the following:
1. In the All Items tree, double-click the field device that you want to view. To select multiple field

devices, hold down shift while clicking each field device.
2. Click View > Parameter Sheet Viewer.
3. In the Parameter Sheet Window, select the Application Options view and switch the

parameter sheet mode to Online.
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4. Specify a connection type and, if prompted, enter a username and password. Click Test Login
to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration

Figure 126: Wait for Manual Activation and Enable Logic Options - Parameter Sheet View

Note:  If you selected the Wait for manual activation and Enable Logic options in Trunk
Utilities, the Application Options parameter sheet column Logic Enable (Enabled) shows the
status True and the Status (Pending Files) column shows the status Files are Staged.

To disable the runtime logic of an application prior to activating it, complete the following steps:
1. In the Application Options view, select the desired devices, right-click, then click Access

Trunk Utilities to open the Trunk Utilities wizard. The Commands radio button is
automatically selected.

2. In the Commands section, select Disable Logic.

Note:  Use of the Disable Logic option depends on the controller product. Refer to your
product documentation for more information. This feature is only available at Tools
Release 13.0, and Firmware 8.0 and later. If the option is selected for an incompatible
controller, the download will fail for that controller.

3. Specify the Connection Type and click Next.
4. Verify that the correct devices are selected and click Next.
5. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

6. Validate the information in the Trunk Utilities Summary window and click Finish.
Complete the following steps to activate an application in a device:
1. In the Application Options view, select the desired devices, right-click, then click Access

Trunk Utilities to open the Trunk Utilities wizard. The Commands radio button is
automatically selected.

2. In the Commands section, select Activate pending files.
3. Specify the Connection Type and click Next.
4. Verify that the correct devices are selected and click Next.
5. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

6. Validate the information in the Trunk Utilities Summary window and click Finish.
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Selecting the Wait for Manual Activation and Logic Disabled Options
If you select the Wait for manual activation and Disable Logic options in Trunk Utilities, the
application is transferred to the device but not activated. The runtime logic is disabled on the device
after you active the application.
As a best practice, use this option when you require all equipment to stop before you activate a new
application.
To stage an application to a device with logic disabled, complete the following steps:
1. On the Tools menu, select Trunk Utilities. The Trunk Utilities wizard appears.
2. Select Download Applications.
3. Specify a Connection Type.
4. In the When to Activate section, select Wait for manual activation.
5. In the When activated section, select Disable Logic. Click Next.

Note:  Use of the Disable Logic option depends on the controller product. Refer to your
product documentation for more information. This feature is only available at Tools
Release 13.0, and Firmware 8.0 and later. If the option is selected for an incompatible
controller, the download will fail for that controller.

6. Select the Integrations for the field device(s) and click Next.
7. Enter the connection parameters specific to your connection type and click Next.
8. Validate the information in the Trunk Utilities Summary window and click Finish.

After the Trunk Utilities download completes, you can view the download status of an integration or
device.

To view the status of an application in an integration, complete the following steps:
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk that you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
3. In the Parameter Sheet window, select the Application Options view and switch the

parameter sheet mode to Online.
4. Specify a connection type and, if prompted, enter a username and password. Click Test Login

to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration

To view the status of an application in a device, do the following:
1. In the All Items tree, double-click the field device that you want to view. To select multiple field

devices, hold down shift while clicking each field device.
2. Click  View > Parameter Sheet Viewer.
3. In the Parameter Sheet Window, select the Application Options view and switch the

parameter sheet mode to Online.
4. Specify a connection type and, if prompted, enter a username and password. Click Test Login

to test the login credentials, or click Open to open the Application Options parameter sheet
for the integration
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Figure 127: Wait for Manual Activation and Disable Logic Feature - Parameter Sheet View

Note:
• If you selected the Wait for manual activation and Disable Logic options in Trunk

Utilities, the Application Options parameter sheet column Logic Enable (Enabled)
shows the status False and the Status (Pending Files) column shows the status Files
are Staged.

• The Logic Enable (Enabled) column will display a series of dashes (---) if the controller is
not supported. The disable logic feature is only supported for firmware at 8.0 or later.

If you wish to enable the runtime logic of an application prior to activating it, complete the
following steps:
1. In the Application Options view, select the desired devices, right-click, then click Access

Trunk Utilities to open the Trunk Utilities wizard. The Commands radio button is
automatically selected.

2. In the Commands section, select Enable Logic.
3. Specify the Connection Type and click Next.
4. Verify that the correct devices are selected and click Next.
5. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

6. Validate the information in the Trunk Utilities Summary window and click Finish.

Complete the following steps to activate an application in a device:
1. In the Application Options view, select the desired devices, right-click, then click Access

Trunk Utilities to open the Trunk Utilities wizard. The Commands radio button is
automatically selected.

2. In the Commands section, select Activate pending files.
3. Specify the Connection Type and click Next.
4. Verify that the correct devices are selected and click Next.
5. Enter the connection parameters specific to your connection type and click Next. For an

overview of connection types and parameters, see Downloading a CAF to Devices Through
Trunk Utilities.

6. Validate the information in the Trunk Utilities Summary window and click Finish.
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Field Device Tools
You can commission N2 devices remotely from SCT using the Passthru mode. To perform Passthru,
N2 configuration tools must reside on the computer with an SCT installed. You can launch Passthru
applications from SCT or the online Metasys Site Management Portal UI. In addition, you can attach
resource files, which are files created by N2 configuration tools, to field devices as extensions to
assist with generating and mapping field points. See Table 292 for the file extension of the legacy
tools supported by the engine.

Note: The File Name Expected during Import is the file required by the N2 Integration
import utility for generating XML. The original Configuration Tool files are not stored in the
engine.

Table 292: Supported Legacy Tools
Device/Controller Type Configuration Tool (M-Tool) File Name Expected during

Import
ASC HVAC PRO, LoaderUI PRN

Note: When generating PRN
files from the HVAC PRO, use
the long format.

VMA HVAC PRO PRN
Vendor Vendor PRN
XP XTM Configurator, LoaderUI HMC
DX GX-9100 Tool, LoaderUI DX

Commissioning Tool
DMO

MIG Metasys Integrator unit VCT

Passthru Wizard
Modes: Available in online and offline mode only
Menu Selection: Tools > Field Device Tools
Accesses tools such as HVAC PRO, GX-9100, XTM Configurator, DX Commissioning, N2 Device
Loader, and CCT.

Note: The Field Device Tools menu selection replaces the N2 Tools menu selection available at
Release 2.0 and earlier.

tips:
• You must have N2 Tools and SCT installed on the same PC that is running Passthru with

HVAC PRO, GX-9100, XTM Configurator, DX Commissioning, or N2 Device Loader passthru.
• The Passthru wizard does not always appear when you are connected to the NAE or

Metasys server online if you are already logged on to the site. The selected tool loads
automatically after you select it from the Tools menu.

• On the Passthru Site Login screen of the wizard, enter your username and password as
defined by your User Profile. To verify access, click Login to check if your login parameters
are valid to access the tools.
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• As a best practice, if you have a Site Director NAE with child NAEs, do not initiate CCT
Passthru at the Site Director to commission field controllers on the child NAE. File
transfers between the Site Director NAE and its child NAE may terminate prematurely.
This behavior only affects NAEs that have been updated with Release 9.0.7; earlier
releases are not affected. Instead, commission the field controllers directly at the
child NAE. However, if you have no other option, you may add a parameter to the CCT
configuration file to increase the time allowed for transfers. This file is located on the CCT
computer in this folder: C:\ProgramData\Johnson Controls\MetasysIII\CCT\UI. Open the
ApplicationConfiguration.properties file with a text editor and add this parameter at the
end of the file on a separate line: da.SyncAgent.Download.ReadAttrTimeout=30. Even
with this parameter added, successful transfers between network engines at Release 9.0.7
is not guaranteed.

Passthru Features and Requirements

Launching N2 Configuration Tools and CCT in Passthru Mode
About this task:  
N2 Devices are configured using N2 configuration tools in Passthru mode in the SCT. To use the N2
configuration tools in Passthru mode, install the N2 configuration tools on the SCT computer.

CCT devices are configured using CCT in Passthru mode. To use CCT in Passthru mode, install CCT
on the SCT computer.

To launch N2 configuration tools and CCT in Passthru mode:

• Open the archive database in SCT or log in to the engine.
• On the Tools menu, select Field Device Tools, then click the N2 configuration tool you want to

use or CCT (MS/TP). The selected tools open in Passthru mode.
• If you are launching a Passthru session from the SCT, you are guided through a login sequence

to log in to the Site Director that contains the devices that contain the N2 controllers or MS/TP
controllers.

• Any offline conditions/actions in the Site Director (such as a download to the Site Director)
interrupts N2 and MS/TP Passthru communications.

- When you use the GX-9100 tool in Passthru mode, engines appear as N30 devices in the
UI of the GX-9100 tool.

- If you use Passthru on a Windows 8 or Windows 7, you must turn off the user access
control (UAC). To turn off UAC, go to Control Panel and click System and Security > Action
Center. The Action Center window appears. Click Change User Account Control settings,
then move the slider bar to the bottom position called Never notify. Click OK and restart
the computer.

User Defined States Text
Prior to Release 6.0, States Text was auto generated for third-party BACnet® Objects devices during
the online discovery process within the Metasys system. Once the states text was discovered online,
the information could be uploaded into an SCT archive for storage.
At Release 6.0 and later, User Defined States Text sets can be created both online or offline in SCT.
The new Custom Enumeration tab has been added to the Site Object, which allows the creation of
new enum sets that can be applied to any Binary or Multi-Value Objects.

Note: If you create a custom enumeration set that has only two members, the set does not
appear in the list of sets for a Multistate Value Object.
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Passthru Requirements
For installation requirements, refer to the Metasys Server Installation and Upgrade Instructions
(LIT-12012162) or ODS Installation Instructions (LIT-12011945).

Note: Computers with Windows 8 and Windows 7 require the use of Passthru. To use CCT,
HVAC PRO™ software, or the GX-9100 tool software in Passthru mode from SCT, you must
disable user account control in Control Panel. If you do not disable user account control,
Passthru mode does not work. To disable user account control, go to Control Panel > System
and Security > Action Center. Locate User Action Control under the Security section and click
Choose Your UAC level. On the left side of the screen, drag the slide bar to Never Notify.
Click OK and restart the computer.

HVAC PRO
HVAC PRO configures the ASC: VMA14, VAV, AHU, and UNTs.
In Passthru mode, you can use the HVAC PRO software to download, upload, and commission ASC
devices through an engine.
In addition, Passthru mode makes it easier to identify and manage controllers for common tasks
by showing the user a complete list of controllers currently mapped to an engine. The first step in
any Passthru operation from HVAC PRO is to select a controller from a list. Subsequent Passthru
operations, such as Controller Information and Upload/Download, are performed on the selected
controller.
HVAC PRO restricts the number of characters allowed in each controller name. See HVAC PRO Name
Restrictions in Passthru Mode.

HVAC PRO Name Restrictions in Passthru Mode
HVAC PRO Release 8.06 and later restricts the number of characters allowed in each controller
name. HVAC PRO does not download, upload, commission, or retrieve information about the
controller if the item name or controller name exceeds the 157 maximum characters limit.
The controller’s full name consists of the following: domain name, site name, equipment name,
trunk name, and the actual controller’s name. The controller name appears in the following format:
Site_name:device_name.domain_name/N2 Trunk #.controller_name

The following table describes the controller name restrictions.

Note: The component column lists each of the components represented in a Full Item
reference. The Maximum Viewable Characters column lists the restrictions on the Component
names when entered through SCT or a web-based user interface of the Metasys supervisory
controller. The Maximum Characters Allowed by HVAC PRO column shows the maximum
number of characters in a Full Item Reference allowed in HVAC PRO.
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Table 293: Controller Name Restrictions
Component Maximum Number of

Characters Allowed
by the Engine or SCT

Maximum Viewable
Characters

Maximum Characters
Allowed by HVAC PRO

Site Name fewer than or equal to
32

Device Name fewer than or equal to
15

Domain Name fewer than or equal to
64

30

N2 Trunk Name fewer than or equal to
32

Controller Name fewer than or equal to
32

-

47 Total 157

HVAC PRO Naming Recommendations
Use the following list of naming conventions to assist you while naming your controllers. If you
follow these recommendations, 61 additional characters are available.

• Choose a site name under 15 characters.
• Choose a device name (network name) under 15 characters.
• Leave the default N2 Trunk name unchanged, so it only consists of 10 characters (for example,

N2 Trunk 1 or N2 Trunk 2).
• Choose a controller’s name under 15 characters.

GX-9100 Tool
The GX-9100 tool configures the DX-9100 and DX-9200 controllers.
In Passthru mode, you can use the GX-9100 software to download or upload the DX configurations.
When you use the GX-9100 through an engine, the LoaderUI application launches to initiate the
upload or download.

XTM Configurator
The XTM Configurator supports building configuration files for XTMs.

Note:  The XTM Configurator tool does not support N2 passthru but can be used to download
XTMs using a serial connection.

DX Commissioning
Opens the DX Commissioning Tool.

N2 Device Loader
Opens the N2 LoaderUI window. You can browse to the location of the DX-9100 device file and other
N2 device files to upload and download. All devices found on the selected engine appear with the
Address, Device Type, and Object Name. You can open the device file in the GX-9100 or HVAC PRO
tool.

Controller Configuration Tool (CCT)
You can use CCT to configure, simulate, load, and commission devices on a BACnet/IP or MS/TP
bus. The list of devices that you can configure in CCT includes CVEs, CGEs, CVMs, CGMs, FECs, FACs,
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IOMs, NCEs, NIE29s, VMA16s, and VAVs. You can operate CCT in three modes of operation that
provide key functionality for your system: Configuration, Simulation, and Commissioning.

Edit CAF in Archive
Select Tools > Field Device Tools > Edit CAF in Archive to modify a CAF in CCT and update the archive
with these changes.

Note: To use this feature, you must install both CCT and the SCT on the local computer. If you
connect to a remote installation of the SCT, you cannot use this feature.

After the CAF opens in CCT, the status Archive-Connected appears in the status bar. If you close
the CAF or choose to disconnect from the archive, you invalidate the Archive-Connected state and,
when saved, the CAF is not written back to the archive. You can use CCT to save a copy of the CAF
and retain the Archive-Connected state.

MAP Export
You can use the MAP Export feature in SCT to share crucial information pertaining to sites, engines,
and trunks for advanced mobile commissioning from the SCT archive to the MAP Gateway device.
To learn more about the MAP Export feature, visit uLearn at https://jcpublic.kzoplatform.com/
library.

Security Copy
The Security Copy function copies a source security database to the security databases of one
or more supervisory device. The security database source is typically the security database of a
supervisory device defined on the site. The process of copying security to a supervisory device also
synchronizes the MetasysSysAgent passwords for the Metasys applications and the supervisory
device’s operating system.
SCT no longer shares a security database with a Metasys server even when you install the SCT
on the same server platform. SCT and a Metasys server always have unique security databases.
The Security Copy process requires that you specify the MetasysSysAgent password for the Site
Director. This ensures that only a key administrator of a site makes decisions about user security
management. For more information on security, including setting up roles and users, refer to the
Security Administrator System Technical Bulletin (LIT-1201528).

Security Copy Wizard
Menu Selection: Tools > Security Copy

To access the wizard, select Security Copy from the Tools menu in the SCT. Use the Security Copy
Wizard to select a security database source and then either copy or restore the source database to
other devices on the site.

MetasysSysAgent Password Syncing for Security Copy
During the security copy process, the MetasysSysAgent password credentials are copied to
the supervisory devices and application-level security database. Credentials are also used to
synchronize the MetasysSysAgent user and password for the supervisory device's operating
system. The MetasysSysAgent user ID and password for the supervisory device's operating system
is required when you need to retrieve device debug (crash) files using the SCT Device Debug Files
menu item.
The following table summarizes the rules for how the application and operating system passwords
for the MetasysSysAgent user are managed by Security Copy at multiple SCT releases.
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Table 294: MetasysSysAgent Release-Specific Application and Operating System Passwords
MetasysSysAgent Application Password Device Release

Version
MetasysSysAgent Operating
System Password

Release 9.0
Release 8.1
Release 8.0
Release 7.0
Release 6.5

MetasysSysAgent password
is synced with the application
password

Release 6.1

MetasysSysAgent password from SCT security
database or from a selected device is copied
and used

Release 6.0
MetasysSysAgent password from the Site
Director's security database is copied to the
devices

Release 5.2

Default password from the
original NAE/NIE Update Tool
download

Security Copy Summary

The Summary window of the Security Copy wizard lists the load options for each device that you
selected in a previous window.

Figure 128: Security Copy wizard Summary Window
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The Security Copy process uses Action Queue (ActionQ) to initiate and monitor the load and restore
processes. For more information on ActionQ, see ActionQ Overview.

Manage Archive Process for Security Database
Security databases are automatically uploaded and downloaded from the site's devices through
the Manage Archive process. Upload all devices into the site's archive database after a successful
security copy to the device.

Copying Security Databases
About this task:  

Important: Before copying a security database, verify that the Item Reference of the device in
the SCT matches (case-sensitive) the Item Reference of the same device in the online mode.

1. Select Security Copy from the Tools Menu in SCT. The Security Copy wizard appears.
2. Select the source security database to be copied or restored and click Next.
3. Select the devices to copy the security database to.
4. Select the security copy schedule method and click Next.
5. Enter the physical Site Director's current MetasysSysAgent account password in the Site Login

window. Click Test Login to verify credentials.

Figure 129: Security Copy Site Login
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6. If the source security database you are copying is at Release 8.0 or later, enter the
MetasysSysAgent password from the archive and click Test Login.

7. Specify the operation retry value and click Next.
8. Review the security copy summary information and click Finish. The ActionQ window

appears after clicking Finish on the Summary screen of the wizard. See ActionQ Overview for
information on monitoring the progress of the copy.

9. After copying a security database on an Engine only, log in to the Site Director Engine as
the MetasysSysAgent or BasicSysAgent user and change the password as desired using
the Change Password option from the Tools menu. The password you select must meet the
requirements for complex passwords. For details, refer to the Network and IT Guidance for the
BAS Professional Technical Bulletin (LIT-12011279).

Security Copy Best Practices
Maintaining and Managing a Separate SCT Security Database: SCT's security database is always
separate from the Metasys server security. Create a small set of named users in the SCT's security
database. You can use a copy of the MetasysSysAgent user to create these users since the user
functions are the same when using SCT.
Security Databases for Supervisory Devices: Sites with 10 or more active users that log in to the
Site Director typically do not require all the users to have login access to the individual supervisory
devices that are under the Site Director. Create a unique, small set of users (typically 10 or fewer)
for the supervisory device's local security databases.
For sites where the Site Director is a network engine, you can copy the security from the Site
Director engine to all the other engines if the total number of users is 10 or less. When a network
engine-based Site Director's security database is larger than 10 users, then create users for the
child devices using these steps:

Note: You only need promote/demote to change user permissions if your engine firmware is
before Release 8.0.

1. Log in to an engine while it is a child device.
2. Create a small set of users in that child engine's security database.
3. Re-add the engines to the site.
4. Use the Site Director as the Security Copy source for all the other engines under the Site

Director.
For sites where the Site Director is a Metasys server, you can use the security database from the
SCT that is used as part of the site's overall management process as the source for all the network
engines on the site.
Changing Site Directors: Before changing Site Directors, use the Manage Archive wizard in SCT to
upload the archive database to the SCT, which includes the security system database of the current
Site Director. After changing the Site Director, use the Manage Archive wizard in SCT to download
the archive database to the new Site Director. The new Site Director then administers the security
settings for the site.

Note: When you add or change the Site Director late in the configuration process, the
database takes a while to rename all the data to reflect the change. The time required to
rename the data depends on the size of your database.

Example Workflows to Preserve Site Security Data
Supervisory Engine is the Site Director
Follow these steps when you upgrade a supervisory engine that is the Site Director.
1. Make password definition changes online at the Site Director (which is the supervisory engine).
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2. Upload the Site Director device with SCT (which includes the security database).
3. Using Security Copy in SCT, copy the security database from the Site Director to all other

devices with SCT. (This action restores the backed-up security database to a device or devices
that you then upload in the next step.)

4. Upload all devices to preserve objects and security databases with SCT.
5. Create a backup of the archive database.
6. Locate the backup file just created.
7. Zip the backup file and append the current date to its name (for example,

MyADS_20130712.zip).
8. Copy the zipped backup file to external media.

ADS/ADX/ODS as Site Director with SCT and SMP User Interface Installed
Follow these steps when the ADS/ADX/ODS is the Site Director and the SCT and SMP UI are installed
on the ADS/ADX/ODS computer.
1. Make password definition changes using the SMP UI. SCT and SMP now have separate

databases when installed on the same computer or server.
2. Upload the Site Director device (which includes the security database) with SCT.
3. Using Security Copy in SCT, copy the security Site Director database to one of the child network

devices.
4. Upload all devices to preserve objects and security databases with SCT.
5. Create a backup of the archive.
6. Locate the backup file just created.
7. Zip the backup file and append the current date to its name (for example,

MyADS_20130712.zip).
8. Copy the zipped backup file to external media.

Supervisory Device with Locally Inaccessible Security Database (NAE35/45/NCE25 Only)
Follow these steps when a supervisory engine is accessible from the ADS/ADX/ODS Site Director,
but inaccessible locally (that is, cannot log in to the engine directly because of a Security database
issue). These steps apply to NAE35s, NAE45s, and NCE25s at Release 5.2 only.
1. Try to log into the Release 5.2 engine directly using the MetasysSysAgent user.
2. If the login fails, reset the Release 5.2 engine.
3. Using SCT, use Security Copy to download a small security database into the engine with SCT

Security selected as the source.
4. Try to log into the Release 5.2 engine directly using the MetasysSysAgent user.
5. If the login works, go to Step 7. If the login fails, reimage the Release 5.2 engine, then go to

Step 6 of these instructions. For details on reimaging a device, refer to the NAE/NIE Update Tool
Online Help PDF (LIT-12011524).

6. If your engine is to remain at Release 5.2, use Security Copy to download a small security
database into the engine, then go to Step 7. If your engine is being upgraded to a later release,
follow the site policy for security.

7. Upload the engine with the small security database with SCT.
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8. Using Security Copy in SCT with SCT Security selected, copy the security database from the
engine to all other engines, which duplicates the small set of users to all engines. (This action
restores the backed-up security database to a device or devices that you then upload in the
next step.)

9. Upload all devices to preserve objects and security databases with SCT.
10. Create a backup of the archive.
11. Locate the backup file just created.
12. Zip the backup file and append the current date to its name (for example,

MyADS_20130712.zip).
13. Copy the zipped backup file to external media.

Security Copy Tips

Important: When performing a Security Copy using the Security Copy Wizard, we
recommended that you schedule no more than 10 simultaneous security copies at one time.

Notes:

• Security Copies are not forward-copy compatible. For example, if you have a Release 7.0
security database, you cannot use the Security Copy Wizard to replace the database with a
Release 6.5.25 database.

• Do not attempt to copy more than 10 user credential profiles to the security database of an
N40-class device.

• If a Security Copy operation to multiple network engines fails, retry Security Copy, but for only
one engine at a time. This practice applies mostly to N40-class network engines that were
updated with Metasys system Release 9.0.7.

Table 295: Security Copy Wizard Tips
Wizard Screen Tips
Select Source • A list of devices that have backed up their security databases appears.

• Select one source device that has the security database you want to copy
to one or more devices.

Select Devices • Select one or more devices for which you want to copy the security
database.

• Use the Ctrl or Shift keys to select multiple items.
Schedule
Operation

• Click either the Perform Operation Now or Schedule Operation option.
• If you select Schedule Operation, use the date, hour, and minute menus

to select the date and time for the restore.

Note: If you schedule multiple copies to begin at the same time, some copies
may not begin at the specified time because they are waiting for others to com-
plete. You cannot define a copy order for devices scheduled together. If you must
copy a certain device first, schedule that device separately with an earlier copy
time.
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Table 295: Security Copy Wizard Tips
Wizard Screen Tips
Site Login • Select the Communicate via Site Director check box if the device is not

on the LAN. Only use this option if necessary because it slows down the
copy process.

• Enter the Username and Password to log in to the Site Director to
perform the copy.

• Click the Test Login button to test if the Username and Password
entered allow you to communicate with the device. The device must be
online to perform this test successfully.

Notes:

• If the SCT Username and Password do not match the Site Director or the
destination device Username and Password, the copy fails and returns
an Authorization Failure error. You must enter the correct Username and
Password on this screen.

• Active Directory users and RADIUS users may not be used to log in to the
site.

Specify Retries • Enter the number of times you want to retry the copy if communication
failure occurs.

Summary • View the final information for the copy and click Finish.

Pair Network Engine with Site Director
Menu Selection: Tools > Pair NxE with Site Director
Launches the Pair NxE with Site Director wizard option to force device pairing between a network
engine and its Site Director. Beginning at Metasys Release 10.0, a more secure authentication
process has been implemented between updated NxEs and the Site Director that involves device
pairing. After you pair an NxE with a Site Director, the two devices use unique credentials to
authenticate communication between them. Unpaired NxEs are not able to communicate with
a Site Director. Normally, the pairing operation occurs for you when the engine's database is
downloaded with SCT. However, in cases when the pairing between devices is lost, the Pair NxE with
Site Director option is available. For example, use this function in the following scenarios:

• If you change the Site Director of any network engine and the device pairing for some reason
does not occur automatically as it should, perhaps due to a sudden communication loss. If this
occurs, use this option to force the device pairing.

• If you reinstall or upgrade the Metasys server from Release 10.0 to a newer release or to a
newer build of Release 10.0. Communication between the two devices may be lost until you
pair the devices.

• If pairing is lost for some unknown reason and the network engine shows Item Not
Found when you open its Focus window. Forcing a device pairing can often reestablish
communication.

However, do not use this option for network engines that are running Release 9.0 software or
earlier, because these older engines do not have this capability.
To pair an NxE with a Site Director, complete the following steps:
1. From the Tools menu, select Pair NxE with Site Director. The NAE Pairing wizard appears.
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2. Select the devices that you want to pair with the Site Director. Click Next. The Device Pairing
window appears.

3. Specify an administrator account user's credentials of the Site Director. Click Pair Device(s). If
pairing is successful, Paired appears in the Device Paired column for each device.

Note: If Pairing not needed appears in the Device Paired column, the device is at
a release earlier than Metasys Release 10.0, and does not need to be paired. If Failed
to Pair appears in the Device Paired column, the device is pointing to a different Site
Director.

4. Click Next. The Summary window appears that lists which devices have been successfully
reauthenticated to their Site Directors. Click Finish.

Diagnostics
SCT diagnostic reports are available to improve setup and commissioning time. The Archive
Statistics report quickly shows how each NxE’s resources have been used by way of number and
type of objects. The Unbound References report identifies instances where one object references
a nonexistent object. Diagnostics help you discover problems with your Metasys system. The
following areas have diagnostic information available:

• Hardware (found under the Diagnostic tab of an object) N2, N1, and BACnet trunk statistics
or other integration type statistics NAE and NxE (all engine types) statistics Metasys server
communication statistics Field device statistics BACnet Protocol Engine statistics per NxE
Ethernet IP Datalink statistics per NxE

• Software error logs viewed through Audit Trails. unbound/duplicate references (Engine Device
Object) events viewed through information trends viewed through Trend Studies and Trend
Extensions

For Ethernet statistics and task-utilization data, use off-the-shelf diagnostic tools. Refer to the
manuals shipped with these tools for more information.

Archive Reports
Menu Selection: Tools > Diagnostics > Archive Reports
Launches the two-tab Archive Report window in the SCT. Each tab generates a different archive
report. The Statistics tab generates a .csv file of statistical archive data from the archives selected
in the archive list. The References tab generates a .csv file of unbound reference data from the
archives selected in the archive list.

Generating an Archive Report
About this task:  
To view an archive report, you first need to generate a CSV file. You then can view the report in
Microsoft Excel.

Note: You can only generate a report for an archive that is stored on your local computer. If
you connect to a remote installation of the SCT, the Archive List only displays the archives on
your local computer, if any.

To generate an archive report, complete the following steps:

1. From the Tools menu, click Diagnostics > Archive Reports. The Archive Report window
appears.

2. In the Archive List section, select the archive you want to view. To select all archives, click
Select All. To clear all selections, click Deselect All.
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3. In the Statistic Sets section, select the type of report you want to view:

- Object Count By Type
- Object Count By Device
- Object Count By Device by Class
- Field Controller Type By Device

4. The Results File section displays the file location for the generated report. If you want to
change the file location of the report, click Browse and select the location you want.

5. Click Generate.

Viewing an Archive Report
About this task:  
After you generate a CSV file in SCT, you can view archive reports in Microsoft Excel.

To view an archive report:

1. In Microsoft Excel, open the CSV file that you generated from SCT.
2. Save the report.

Object Count by Type Report
To view the Object Count by Type report, open the generated CSV file in Microsoft Excel. We
recommend you create a pivot table in Excel to view the report.
The Object Count by Type report displays the following information in a report:

• Type: Types are the high-level information in the archive. They are Controllers, Devices,
Extensions, Folders, Integration, NavList, Object, Points, Servers, and Site.

• Class Name: Class names refer to the specific name of the associated Type. For example, if an
archive Type is Device, two class names for Device would be NAE35 and NAE45.

• Total: Total refers to the count total for the archive. The Object Count by Type report displays
the total count for each individual Class Name and the total count for each Type.

Figure 130: Object Count by Type (Pivot Table)
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Object Count by Device Report
To view the Object Count by Device report, open the generated CSV file in Microsoft Excel.
The Object Count by Device report displays the following information in a report:

• Archive: name of the archive.
• Device Name: name assigned to the supervisory device (engine) in the archive.
• Device Release: Metasys system release of the supervisory device in the archive.
• Object Count: total number of objects defined under the supervisory device.
• Firmware Version: firmware version of the supervisory device.
• Model Name: name assigned to the device (unknown if no model name is defined).

Figure 131: Object Count by Device Report

Object Count by Device by Class Report
To view the Object Count by Device by Class report, open the generated CSV file in Microsoft Excel.
We recommend you create a pivot table in Excel to view the report.
The Object Count by Device by Class report displays the following information in a report:

• Type: Types are the high-level information in the archive. They are Controllers, Devices,
Extensions, Folders, Integration, NavList, Object, Points, Servers, and Site.

• Class Name: Class Names refer to the specific names of the associated Type. For example, if
an archive Type is Device, two class names for Device could be NAE35 and NAE45.
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• Device Name: Device Name refers to the specific name of the device (engine). For example, a
device name could be ADX-1:507-B1F0-NAE01.

• Class Count: Class Count refers to the total count specific to the device.

Figure 132: Object Count by Device by Class (Pivot Table)

Object Types and Class Names

Note: The devices NIE29, NIE39, NIE49, and NIE59 engines appear with the Class Name of
NCE25, NAE35, NAE45, or NAE55, respectively.

Table 296: Archive Reports -Type and Class Names
Type Class Name
Controller Controller (N2 Controller)

FEC Family BACnet Device
LON Controller
NCM

Non-FEC BACnet Device
VND Controller
Wireless Receiver

Device NCE25 (includes NIE29)
NAE35 (includes NIE39)
NAE45 (includes NIE49)

NAE55 (includes NIE59)
NIE55
NAE85

NIE89
CIE19
LCS85

Extension Analog Alarm
Analog Load
Analog Totalization

Event Totalization
JCI Averaging
JCI Trend Log

Multistate Alarm
Resource File
Multistate Alarm
Runtime Totalization

Folder Folder
Integration BACnet

Field Bus
LON Trunk
N1 Migration

N2 Trunk
VND Integration
Wireless Supervisor
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Table 296: Archive Reports -Type and Class Names
Type Class Name
NavList User View
Object Async Delay

Auto Shutdown
Boolean
Broadcast Management
Comparison
Conn
DLLR
DP
Electric Demand Monitoring
ENTH
Enum Constant
Flex Accumulator
Global Data
Graphic

Interlock
JCI AV
JCI BV
JCI Calendar
JCI Event Enrollment
JCI MV
JCI Notification
JCI Schedule
Latch
Math
Multiple Command
Mux
Numeric Constant
Optimal Start

Pulse Meter
Rate Limiter
Release Object
RH
Sequencer
Signal Select
Summary Definition
System
Time
Timer
Trend Study
Trigger Object
XAML Graphic

Point AI Mapper
AO Mapper
AV Mapper
BACnet AI
BACnet AO
BACnet AV
BACnet BI
BACnet BO
BACnet BV
BACnet Grp
BACnet MI
BACnet MV
BACnet Notification
BI Mapper

BO Mapper
BV Mapper
GIO
LON AI
LON AO
LON MSI
LON MSO
MS/TP Pulse Counter
MSV Mapper
N1 AI
N1 AO
N1 BI
N1 BO
N1 Calendar
N1 MSO
N1 PC

N1 PID Loop
N1 Schedule
N2 AI
N2 AO
N2 BI
N2 BO
N2 MSI
N2 MSO
N2 Pulse Counter
VND AI
VND AO
VND BI
VND BO
Wireless Sensor

Server ADS
ODS

Site Site

Unbound Reference Report
The Unbound Reference Report generates a CSV file of unmatched points for archives.

Figure 133: Unbound Reference Report
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To create the Unbound References Report:

1. Log in to SCT and select Tool > Diagnostics > Archive Reports. The Metasys Archive Reports
window appears.

2. Select the Unbound References tab in the Metasys Archive Reports window.
3. Select the archives you want to report by selecting the check boxes in the Name column.
4. Click Browse to select the file storage location.

Notes:
- By default, Unbound Reference Reports are stored in C:\Users\<username>
\Documents as an UnboundReferences.csv file.

- The UnboundReferences.csv is overwritten each time the report is run if the same
file name is used.

5. Click Generate. After the report generates, close the Metasys Archive Report window.
To view the Unbound Reference Report, open the generated CSV file in Microsoft Excel. The
Unbound Reference report displays the following information:

• Archive: The name of the archive containing the object.
• Reference Type: The general reference type for the point containing an unmatched point. For

example, attribute or object.
• Referring Item: The Fully Qualified Reference (FQR) for the object being linked to the

unbound reference.
• Referring Attribute: The specific attribute that is linked to an unmatched point references.

For example, source or action table 1.
• Referenced Item: The FQR location of the missing object reference from the archive.
• Reference Attribute: The attribute name of the unbound reference if it were to exist in the

archive.

Space and Equipment Report
To view the Spaces and Equipment report, open the generated .csv file in Microsoft Excel. We
recommend you create a pivot table in Excel to view the report.
The Spaces and Equipment report displays the following information in a report:

• Equipment: Each piece of equipment is displayed individually by row for a Space. A Space can
have multiple pieces of equipment associated with it.

• Space Levels: Space levels for the site are captured in unique columns within the report. There
is a limit of ten nested levels under any given space object.

• Equipment Name: Equipment Names refer to the specific identification name of the device or
engine.

• Equipment Fully Qualified Reference (FQR): Equipment FQRs refer to location of the piece of
equipment in the Equipment Tab.

Object ID Report
The Object ID report generates the list of archive BACnet Object Identifier names.
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Figure 134: Object ID Report

To create the BACnet Object ID report:

1. Log in to SCT and select Tool > Diagnostics > Archive Reports. The Metasys Archive Reports
window appears.

2. Select the Object ID tab from Metasys Archive Reports window.
3. Select the archive you want to report by selecting the check box in the Name column.
4. Click Browse to select the file storage location.

Note: By default, Object ID Reports are stored in C:\Users\<username>\Documents as
a BACnet Object Id.csv file.

5. Click Generate. After the report is generated, close the Metasys Archive Report window.
To view the Object ID report, open the generated .csv file in Microsoft Excel. The Object ID report
displays the following information:

• Archive: The name of the archive the objects are stored in.
• Object Identifier: The BACnet Object Identifier name.
• Reference: The Fully Qualified Reference (FQR) for the object.
• Name: The object name as defined in the archive.
• Description: The object description from the archive.

Archive Log
Menu Selection: Tools > Diagnostics > Archive Log
Starting at SCT Release 10.0, the Upgrade Log is renamed to Archive Log and features a redesigned
table format to include the results of all ActionQ archive database activities (such as upload,
download, and sync). The Archive Log Viewer in SCT displays log messages directly correlated to
the ActionQ operations, and content is displayed in types that are selected from the type options
(Information, Warning, or Error). A valid time range is selected in the Date Range area and can be
reset by pressing the Reset button. Available archives can be selected in the Archives area.
The entries are displayed in table format with type, date, archive, version, messages, source
column, and reference. Starting at Release 10.0, the Reference resource column has been added to
the Archive Log providing the fully qualified reference (FQR) for the logged operational device. You
can now view similar code upload and download information in the Archive Log Viewer as you can
in the NAE/NIE Update Tool. Warning entries are highlighted in yellow, and errors are highlighted in
red.
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Figure 135: Archive Log Viewer: Code Upload Failed

Note: Code-specific entries such as warnings or errors are not fully language translated and
appear in partial English.

To sort the rows in ascending or descending order, click the column headings. Highlight and
double-click an entry to bring up the View Archive Log Entry dialog box. Navigational arrows allow
you to navigate through entries forward and backward and from beginning to end.
Click the Copy button to copy one or more selected entries; copied entries can be pasted into
Excel, WordPad, or other similar application. Click the Purge button to delete selected entries in
the archive log. Before purging entries, a dialog box appears warning you that this option clears all
entries in the archive log and cannot be undone.
To refresh the archive log view, right-click the panel header and click Refresh, or click the Action
menu and click Refresh. Refresh also expands any columns that are not accommodating the text
within.

Note: The information displayed in the Archive Log Viewer can be copied from the local
device at the location: ProgramData\Johnson Controls\MetasysIII\SQLData
\ArchUpgradeLogEntries.txt.

Device Discovery
Menu Selection: Tools > Diagnostics > Device Discovery
Launches an eight-column diagnostic information window in the SCT. Each column generates
device specific information when you click Start Discovery. Device Discovery generates individual
device names, MAC addresses, IP addresses, DHCP statuses, product codes, software versions,
operating system versions, and battery statuses.

Note: If Device Discovery returns a No Device Found error, verify that port 9911 is open in
the SCT computer's firewall. The Device Discovery functionality of SCT requires the opening
of port 9911. The SCT Installation and Upgrade Instructions (LIT-12012067) includes the steps
on how to open port 9911 and other port addresses used by SCT. Also, SCT may not receive
discovery messages if you cancel Device Discovery before it completes or if no network
engines are found on the same network segment.

Device Debug
Menu Selection: Tools > Diagnostics > Device Debug Files
Launches a Device Debug Files wizard from the SCT that prompts the necessary completion
steps for device debug (crash) file retrieval. You can select the target device from the open
archive, the hostname, or the IP address. The Device Debug Files wizard requires device password
authentication before retrieving crash file information.
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Note: For Release 9.0.7 engines or greater, use SCT Pro in lieu of SCT for device debug file
retrieval.

Before Release 7.0, the Device Debug functionality is only available through external use of the
NCT's Finding Crash Files feature. The Device Debug file retrieval for SCT requires ports 67, 68,
69, 80, 162, and 9911 are open in the Windows Firewall. Refer to the SCT Installation and Upgrade
Instructions (LIT-12012067) for complete instructions on opening these Windows Firewall ports.

Displaying Diagnostic Data
1. Drag and drop the object for which you want diagnostic data in the display frame.
2. Click the Diagnostic tab. Diagnostic data appears.

For example, see the Diagnostic tab table in the Attributes section of the following objects for
more information:

- NAE Object (Engine Device Object)
- N2 Trunk (N2 Master Datalink Object (N2 Trunk))
- NCM Object
- BACnet IP Integration Object
- BACnet Protocol Engine Object

Renaming a Computer in an Out-of-Place Upgrade
When you upgrade the Metasys server on a computer that is running different from the computer
that is currently running Metasys server software, you must rename the Site Director in SCT to
match the new computer name. (This operation is also referred to as an out-of-place upgrade.)
After you rename the Site Director in SCT, use the Metasys Database Manager to update the names
of the Site Director and the devices in the JCI databases. Performing the rename process in both
the SCT and the Metasys Database Manager ensures that your upgraded site can continue to access
historical data.

Note: If you have large historical databases, the rename procedure may takes several hours
to complete. We recommend that you purge your databases in advance in order to speed the
rename process. For more information on purging databases, refer to the Purging a Database
section in the Metasys Database Manager Help (LIT-12011202).

Important: This is an overview of the rename process. It is intended to illustrate how the
SCT and Metasys Databases Manager work together in this process. For complete rename
instructions, refer to the appropriate document for your computer:

• Appendix: Changing the ADS or ADX Name and the Computer Name on an ADS and Unified ADX
in the ADS/ADX Commissioning Guide (LIT-1201645)

• Appendix: Changing the ADS or ADX Turnkey Name and the Computer Name in the ADS/ADX
Turnkey's User's Guide (LIT-12011177)

Table 297: Steps for Renaming a Computer in an Out-of-Place Upgrade
St
ep

Instruction Reference

1 Install SCT on the new computer. SCT Installation and Upgrade Instructions
(LIT-12012067)

2 Install Metasys Database Manager on the new
computer.

Metasys Databases Manager Installation
Instructions (LIT-12011553)

3 Copy the SCT archive backup from the old
computer to the new computer.

Copying an Archive Database
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Table 297: Steps for Renaming a Computer in an Out-of-Place Upgrade
St
ep

Instruction Reference

4 Start SCT on the new computer and restore the
backup.

Restoring a Backup Database

5 Rename the Site Director in SCT to match the
new computer name.

Security Scenarios

6 Route any remaining historical data on the old
computer to the Metasys server.

Trend Studies Concepts

7 Start Metasys Database Manager on the old
computer and back up the JCI databases.

Backing up a Database in the Metasys
Database Manager Help (LIT-12011202)

8 Copy the JCI database backup files from the old
computer to the new computer.

Restoring a Database in the Metasys Database
Manager Help (LIT-12011202)

9 Start Metasys Database Manager on the new
computer and restore the JCI Database.

Restoring a Database in the Metasys Database
Manager Help (LIT-12011202)

10 Use Metasys Database Manager on the new
computer to rename field contents in the JCI
Databases.

Renaming Field Contents in Metasys Databases
in the Metasys Database Manager Help
(LIT-12011202)

11 Install the Metasys server software on the new
computer.

ADS Software in the Metasys Server Installation
and Upgrade Instructions (LIT-12012162)
or ODS Software in the ODS Installation
and Upgrade Instructions Wizard Help
(LIT-12011945)

12 Download the Metasys server from SCT on the
new computer.

See the Download section.

Facility Menu
The Facility Menu Tab is only available in SCT and is not supported in SMP or the ODS.

High-Level Workflow for Facility Menu Features
About this task:  
The following general workflow is a high-level process for creating spaces and equipment serving
spaces. At certain sites and under certain circumstances, you may complete Step 6 through Step 8,
and then go back to Step 6 several times before completing the entire process.

Note: As a best practice, open the site in SMP and the archive in SCT at the same time to help
with configuration of spaces and equipment serving spaces.

Note: At SCT Release 13.0, all device types, including Johnson Controls' devices, N2 devices,
and third-party devices support Metasys UI configuration.

1. Open the SCT archive.
2. Use the Facility > MUI Config > Edit Spaces Tree option to add spaces to your site's Spaces

Tree. For more information, see Using the Spaces Tree Editor.
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3. Create equipment definitions (Facility > Prepare Rapid Archive > Insert Equipment Definition)
for the equipment that serves the spaces you have configured, starting at the lowest node
of equipment (for example, terminal units). For each equipment definition that you create,
repeat Step 7 and Step 8. Then continue creating equipment definitions for the highest node
of equipment (for example, central heating and cooling plants). For more information, see
Using Equipment Definitions.

4. Discover equipment that belongs to the equipment definitions or import pre-built equipment
definitions. For more information, see Using Equipment Definitions and Adding Display Data
to the Equipment Definition.

5. Create Served By relationships. For more information, see Assigning Spaces Served By
Equipment Relationships.

6. Associate Graphics+ graphics and Standard graphics to spaces and equipment.

Note: In Metasys UI 2.1 and later, you can associate your Graphics+ graphics, Standard
graphics, and native graphics to spaces, equipment, or equipment definitions (called
alias graphics) in the Graphics Manager of the Metasys UI or Metasys UI Offline. For
more information, refer to Metasys UI Help (LIT-12011953) or Metasys UI Offline Help
(LIT-12012116).

7. Open the Metasys UI Offline and validate your spaces, equipment, and graphics associations.
8. When you are satisfied with how the spaces, equipment, and graphics associations look in the

Metasys UI Offline viewer, download your archive to the ADS/ADX.
9. Browse to the Metasys UI to view your site's spaces and equipment serving spaces.

Spaces Overview
Use SCT to configure your Metasys site into spaces and equipment serving spaces and other
equipment. In SCT, three objects are used to build spaces and equipment relationships: space
object, equipment definition object, and equipment object.
Space objects are logical representations of sites. Spaces include generic large spaces (for example,
a campus, complex, wing, or a single building or group of buildings with floors, rooms, and even
spaces within rooms). A generic space object can represent a physical site or campus (or any other
physical space within a site or campus) depending on where the object is located in your Spaces
Tree. You can use a Spaces tree to configure multiple generic spaces, such as a parent space object.
You can configure an unlimited number of buildings within a generic parent space object, as well
as floors in a building and rooms on a floor. You can also configure spaces within rooms. However,
the recommended limit is 20,000 spaces, as a larger number of spaces can cause upload, download,
and performance issues. The same 20,000 limit applies to equipment.

Note:  A site can only have one parent-level root space object. Consider future expansions
when you configure your site. For example, if you are configuring your site for a single-
building campus that may expand to include multiple buildings in the future, then we
recommend naming the parent-level root space "Campus" to accommodate potential growth.

You configure your Metasys site into a Spaces Tree using the Spaces Tree Editor. After you configure
your site as spaces, you can then configure your equipment definitions and equipment. For more
information on Equipment Definitions, see Insert Equipment Definition.
The following figure shows the visualization and workflow of Spaces, Equipment, and network
relationships for a Metasys site.
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Figure 136: Customer Workflow Versus Commissioning Workflow

Configuring the Metasys UI with SCT Overviews

Figure 137: Configuring New Sites with the Metasys UI
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Figure 138: Configuring Existing Sites with the Metasys UI

Note: With Metasys UI Release 2.1, you can associate all graphic types in the Graphics Manager
of Metasys UI Offline and Metasys UI. Refer to the Metasys UI Offline Help (LIT-12012116) for
more information.

For more information about room schedules, controller templates, and the Rapid Archive Field
Controller wizard, see the Rapid Archive Creation section. For more information about associating
graphics, see the Graphics Association section.

Spaces Prerequisites
To configure spaces, you need Metasys Release 7.0 or later installed on the Metasys server Site
Director. You can use SCT 7.0 or later to configure spaces, but as best practice use the most recent
version of SCT to leverage productivity enhancement features.
Table 298: Version Requirements for Spaces and Equipment
SCT Release Metasys Core

Releases Supported
Metasys UI

Releases Supported
7.0 7.0 1.5–1.5.1
10.0 7.0 1.5–1.5.1
11.0 7.0–8.0 1.5–1.5.1 (Metasys Core 7.0)

2.0 (Metasys Core 8.0)
11.1 8.1 2.1
12.0 9.0 3.0
13.0 10.0 4.0
13.2 10.1 4.1
14.0 11.0 5.0

Note: You can only use an archive from the Metasys server Site Director to configure spaces.
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To configure spaces, install the following software components in the following order:
1. Uninstall the stand-alone NAE/NIE Update tool, if present.
2. Install the SCT 14.0 software, which also installs the Metasys UI Offline 5.0.
3. Install the Metasys Server software, which also includes Metasys UI.

For more information about installing the Metasys UI and the ADS/ADX software, refer to the
Metasys Server Installation and Upgrade Instructions (LIT-1202162). For more information about
installing Metasys UI Offline, refer to the Metasys UI Offline Help (LIT-12012116).

Planning for Spaces Configuration
Before you begin configuring spaces and equipment for your site, we recommend that you follow
these steps to plan your configuration:

1. Take inventory of your Metasys site, your physical site, and the items within your All Items tree
in SMP. Consider how you would like your site to be configured as spaces.

- Determine what physical spaces should be configured into spaces. Examples of physical
spaces include campuses, complexes, buildings, floors within buildings, and rooms within
floors, and even spaces within rooms. Depending on the physical site, you may not want
to configure the whole site into spaces.

- Work with your site's operations staff to ensure that the equipment is configured to the
relevant space or spaces and that the setup of the Spaces Tree is logical and easy to use
and manage for the users.

- Consider how you want schedules, graphics, and equipment associated to your spaces.
2. Examine the access permissions given to users in the security database in SMP or your archive

on the ADS/ADX in SCT. Note the permissions given to site users. In the Metasys UI, users are
only allowed to see or command objects for the equipment that serves a space or another
piece of equipment when they have access permissions to a given object's Authorization
Category (for example, HVAC).

3. Display SMP on one monitor and SCT on a separate monitor to expedite and verify your site
configuration.

Note: With Metasys UI Release 2.1 and later, you can associate all graphic types in the
Graphics Manager of Metasys UI Offline and Metasys UI. Refer to the Metasys UI Offline Help
(LIT-12012116) for more information.

Download Archive on Site Director for Spaces Tree
About this task:  
Before you can browse to the Metasys UI on a client device, you must first download your archive to
the ADS/ADX Site Director.

Note: The Download function is required for the initial setup of Spaces and Equipment for a
site. After you create a base set of Spaces and Equipment on a site, you can use the Download
Only Metasys UI Spaces and Equipment feature to make the updates.

1. Click Tools > Manage Archive.
2. Select Download to Device and click Next.
3. Follow the prompts in the Manage Archive wizard.
4. Browse to the Metasys UI on a client device. The web address is https://[Host Name or

IP address]/UI, where [Host Name or IP address] is the server name or server IP
address.

SCT: System Configuration Tool Help618



Insert Equipment Definition
Menu Selection: Facility > Prepare Rapid Archive > Insert Equipment Definition
Opens the Equipment Definition wizard.
Equipment Definition Introduction
Equipment definitions help define equipment so that the Metasys UI displays the most important
data from equipment that serves a space or another piece of equipment. When you create
equipment definitions and then add equipment to those definitions, the Equipment tab appears
in SCT. The Equipment tab lets you easily manage your equipment related to the equipment
definitions.

Using Equipment Definitions
Equipment Definition objects are created and managed in the Definitions folder under the ADS/
ADX object in the All Items tree. Equipment Definitions are similar to templates and help normalize
typical equipment types and data points. The Description and Name of the Equipment Definition
object are used as a filter for equipment in the Metasys UI.
We recommend you do the following when you create Equipment Definitions:

• Have as few equipment definitions as possible. Having fewer variations in equipment
definitions allows the Equipment Summary views in the Metasys UI to have more equipment
listed, increasing usability. Exceptions may exist for single duct versus dual duct VAVs.

• Know what equipment is serving another piece of equipment and what space the equipment is
serving.

• Create folders for Equipment Definitions within the Definitions folder of the All Items tree.
For example, you can create a folder for all VAV Equipment Definitions in. Or you can create
a folder for all VAVs in a floor within a building (or those for a building). Create and organize
your folders in a manner that best suits your needs.

Important: Do not create an Equipment folder or Definitions folder manually
(Insert > Folder). The Equipment folder and Definitions folder are created when you
upgrade an archive to Metasys Release 7.0 in SCT. Before upgrading your archive to
Release 7.0, ensure an Equipment folder or Definitions folder does not exist in the All
Items tree. If these folders exist, rename or delete the folders.

• Create definitions for equipment starting from the lowest level of equipment to the top level
of equipment. For example, create Equipment Definitions for VAVs, then for air handlers, and
finally for central plant equipment.

• Do not add Group objects to equipment definitions. Group objects are not supported in the
Metasys UI.

Equipment Definition Object Attributes
An Equipment Definition object can only be created through the Facility > Prepare Rapid  > Insert
Equipment Definition option.
Table 299: Equipment Definition Object – Configuration Tab
Attribute Name Data Type Initial Value Values/Options/

Ranges
Name Text Blank Maximum length of

400 characters
Description Text Blank Maximum length of 64

characters
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Table 299: Equipment Definition Object – Configuration Tab
Attribute Name Data Type Initial Value Values/Options/

Ranges
Authorization Category One type from a set HVAC HVAC, Fire,

Security, Services,
Administrative,
General, Lighting,
Refrigeration, Critical
Environment, Air
Quality, Power, Energy,
System Custom 1–150

System Subtype Set One type from a set Subsystem Category Various
System Subtype One type from a set Terminal Units Terminal Units, Air

Handlers, Central
Plants, other types

Graphic Graphic Object Blank Various

Note: Use System Subtype to determine which On-Premise Fault Detection faults can run
against this equipment

Table 300: Equipment Definition Object - Equipment Definition Tab
Column Description
Display Data Select the check box to select a row for display data point in the Metasys

UI.
Label Contains the description of the point (for example, Zone Setpoint).
Short Name Contains an abbreviated name of the point (for example, Flow Percent).

Note: Do not leave the Short Name field blank.
Type Displays the semantic data point model name mapped to short name by

the Point Setting dataset. See Updating point settings.
Instance Displays the Instance Number of the object on the remote field device.

The Instance number, along with the object type, defines the remote
object’s BACnet Object Identifier. The BACnet Object Identifier is used to
establish communication with the object.

Note: Points are matched by their instance number before matching on the
Search Column criteria.
Important: If you create an Equipment Definition for a third-party device,
and there are duplicate instance numbers, you must use the Search Crite-
ria column. Only use the Instance column if the instance number for a net-
work point on a controller is unique.

Net Point Address Contains the Metasys N2 Point Address associated with a point. This is a
comma-delimited list of instance number.

Net Point Type Contains the Metasys N2 Point Type associated with the point.
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Table 300: Equipment Definition Object - Equipment Definition Tab
Column Description
Search Criteria Contains user-defined search criteria for points. Search criteria can

contain the following:

• An asterisk (*) before and after the search criteria text lets you
search that portion of the text in the short name. For example, *ZN-
T*.

• ? in the search criteria text lets you search Names or Short Names
for the numerals zero or one. For example, Hum?-C returns results
including Hum1-C.

• % in the search criteria text lets you search for numerals 0 through
9. For example, Hum%-C returns results including Hum1-C and
Hum7-C. You can enter multiple % to search for text that contains
multiple numerals. For example, Hum%%-C returns results
including Hum26-C.

• # in the search criteria text lets you search for a string of one or
more numerals. For example, #BoxHtg-C returns results including
1BoxHtg-C and 34BoxHtg-C.

• * in the search criteria text lets you search for zero or more of any
character. For example, ZN-T* returns results including ZN-T.

• Normal text in the search criteria returns results that match the
characters exactly without matching case. For example, zn-t returns
results for ZN-T and zn-t.

Category Displays the category number of the point.

Creating Equipment Definitions
About this task:  
Follow these steps to create basic equipment definitions.

Note: To make the process of creating equipment definitions effective and efficient, we
recommend that you create Equipment Definitions that normalize all equipment types into
one definition. For example, try to maintain a single VAV Box definition for the entire site.

1. Create folders for equipment definitions in the Equipment Definitions folder in the All Items
tree, as doing so expedites the process. You can also create folders during Equipment
Definition creation in the Insert Equipment Definition wizard Destination window.

2. Click Facility > Prepare Rapid Archive > Insert Equipment Definition.
3. The Insert Equipment Definition wizard appears. Select the Definitions folder under the

ADS/ADX in the All Items tree as the destination for the equipment definition. You can create
new folders for a definition by entering a name for the folder in the lower-right panel of the
Destination window. Click New Folder to create a folder. Click Next to proceed to the next
window.

4. Name your equipment definition. Click Next.
5. Configure your equipment definition. Use Table 301 to assist in configuration.
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Table 301: Descriptions of Object Attributes for Equipment Definitions
Object Attribute Description
Name Enter the name of the equipment definition.

Note: When naming equipment definitions, use plain text. Do
not use text with HTML tags.

Contains a user-defined name for the equipment definition
object that is independent of the item reference. Functions
like the Name object attribute for the All Items tree.

Description Enter a description of the equipment definition.
Contains a user-defined description of the equipment
definition object.

Object Type Indicates the Object Type as displayed in the Metasys
software and as exposed to a BACnet network.

Authorization Category Choose the category for the equipment definition from the
drop-down list.
Examples: HVAC, Fire, Security
Classifies the object by the category of system or equipment
that it monitors to help determine user access privileges and
alarm routing.

Note: Select the most appropriate access privileges for users
in the Authorization Category. A user without access to an
Authorization Category does not have access to the object.

System Subtype Set Choose the system subtype set for the equipment definition
from the drop-down list.

System Subtype Select a system subtype from the drop-down list.
Begin creating equipment definitions with terminal units,
then air handlers, and finish with central plant equipment.

Note: Use System Subtype to determine which On-Premise
Fault Detection faults can run against this equipment

Graphic Indicates the graphic associated with the object.
Graphic Alias Indicates a portion of the graphic’s item reference, up to

and including the name of the folder containing this object
or the controller containing this point.

Notes:
- Graphics and Graphic Alias attributes have been added to accommodate Metasys UI

graphics association.
- Graphics+ and standard graphics are only supported for viewing in the Metasys UI

and Metasys UI Offline.

6. Click Next.
7. The Summary window appears. Click Finish.

To add display data to the equipment definition, continue to Adding Display Data to the
Equipment Definition.
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Creating and Modifying Equipment Definitions through Drag and Drop
You can easily create and modify equipment definitions through improved drag-and-drop
capabilities. Follow these steps to create equipment definitions based on your Tailored Summary
Viewer through use of the Equipment Definition editor.

Important: To complete the following steps the archive must contain an SCT summary
definition object. If the archive does not contain an SCT summary definition object, you can
import one or click Insert > SCT Summary Definition to create one. How you configure this
object does not affect the process.

1. Click View > Panel Layout.
2. Select a Two Panel Horizontal layout.
3. In the All Items tree, select the field point objects to include in the equipment definition. You

can use Shift+select or Ctrl+select to select multiple field points.
4. Click View > Tailored Summary Viewer.
5. In the Select Summary Definition window, select any tailored summary, and then click Open.

Note: If you want to modify an Equipment Definition, skip to Step 10.

6. Click Facility > Prepare Rapid Archive > Insert Equipment Definition. After the Insert
Equipment Definition wizard appears, select the Equipment Definitions folder under the
Metasys server in the All Items tree.

7. Click Next.
8. Name your equipment definition and click Next.
9. Continue through the Equipment Definition wizard.
10. Open the equipment definition in the second panel. Click Edit in the Equipment Definition

window.
11. Drag points from the first column of the Tailored Summary viewer into the Equipment

Definition editor to add points to the definition.

Note: If you select multiple points in the Tailored Summary viewer and then drag them
to the Equipment Definition editor, you must hold Ctrl while you move the points. If you
do not hold Ctrl then your select changes.

Adding Display Data to the Equipment Definition
About this task:  
After you create an equipment definition, configure the display data.

1. Open the equipment definition from the All Items tree.
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Figure 139: Equipment Definition in All Items Tree

2. Click Edit.
3. In the All Items Tree, find the equipment that contains the display data points. Select the

engine or device and drag it into the equipment definition.

Note: An equipment definition can have a maximum of 200 data points.

Figure 140: Drag Display Data to Equipment Definition

Figure 140 is an example of display data points for an Equipment Definition. Table 302
describes the columns of data shown in the Equipment Definition window.
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Table 302: Descriptions of Columns in Equipment Definition
Column Description
Display Data Select the check box to select a row for display data point in the

Metasys UI.
Label Contains the description of the point (for example, Zone Setpoint).
Short Name Contains an abbreviated name of the point (for example, Flow

Percent).
Note: Do not leave the Short Name field blank.

Type Displays the semantic data point model name mapped to short
name by the Point Setting dataset. See Updating point settings.

Instance Displays the Instance Number of the object on the remote field
device. The Instance number, along with the object type, defines
the remote object’s BACnet Object Identifier. The BACnet Object
Identifier is used to establish communication with the object.

Note: Points are matched by their instance number before matching
on the Search Column criteria.
Important: If you create an Equipment Definition for a third-party
device, and there are duplicate instance numbers, you must use the
Search Criteria column. Only use the Instance column if the instance
number for a network point on a controller is unique.

Net Point Address Contains the Metasys N2 Point Address associated with a point. This
is a comma-delimited list of instance number.

Net Point Type Contains the Metasys N2 Point Type associated with the point.
Search Criteria Contains user-defined search criteria for points. Search criteria can

contain the following:

• An asterisk (*) before and after the search criteria text lets you
search that portion of the text in the short name. For example,
*ZN-T*.

• ? in the search criteria text lets you search Names or Short
Names for the numerals zero or one. For example, Hum?-C
returns results including Hum1-C.

• % in the search criteria text lets you search for numerals 0
through 9. For example, Hum%-C returns results including
Hum1-C and Hum7-C. You can enter multiple % to search for
text that contains multiple numerals. For example, Hum%%-C
returns results including Hum26-C.

• # in the search criteria text lets you search for a string of one
or more numerals. For example, #BoxHtg-C returns results
including 1BoxHtg-C and 34BoxHtg-C.

• * in the search criteria text lets you search for zero or more of
any character. For example, ZN-T* returns results including ZN-
T.

• Normal text in the search criteria returns results that match the
characters exactly without matching case. For example, zn-t
returns results for ZN-T and zn-t.
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4. Ensure that all display data points are valid (no cells are red). Select the items to display the
data points in Metasys UI.
The display data appears in the bottom pane. You can then sort the items in the order you
would like the data to display in Metasys UI.

5. Click Save.
Continue to Using Equipment Discovery.

Importing Equipment Definitions
About this task:  
Importing equipment definitions lets you share standard equipment definitions.

1. In the All Items tree, right-click the Definitions folder and click Import. Or go to
Item > Import Item.

2. Select the equipment definition to import.

Note: You can import duplicate equipment definitions (same name or same fully
qualified reference). The imported duplicate equipment definition adjusts to have a new
fully qualified reference.

Exporting Equipment Definitions
About this task:  
Exporting equipment definitions lets you share standard equipment definitions.

1. In the All Items tree, right-click the equipment definition and click Export. Or go to
Item > Export Item.

2. Save the equipment definition to your computer.

Rapid Archive Creation
Menu Selection: Facility > Rapid Archive
The Rapid Archive feature of SCT offers simplified configuration of the SMP/SCT navigation trees
and the Metasys UI by leveraging CAF, room schedule, and point schedule files. The wizard uses
room schedules, controller templates, and equipment definitions to mass create equipment,
spaces, and serving relationships with one click.
The following information describes how you can use the Rapid Archive to create a new site. For
information on using the Rapid Archive to update an existing site with space and equipment
information, see Rapid Archive Merging.
If you are a Johnson Controls employee, you can view informational videos about Rapid Archive
Creation on the uLearn site: https://jc.kzoplatform.com/containers/928995312607959016.

Rapid Archive Field Controller wizard
The Rapid Archive Field Controller wizard is automatically populated by importing a Rapid Archive
Schedule .xls file, or can be manually populated using the Add New Equipment (plus symbol) icon.
This wizard allows you to easily view field controller configuration information, hardware
specifications, equipment configuration, fully qualified references, controller template associations,
and CAF parameters in one table format. When the new equipment setup columns are completed
and no red cells are displayed in the wizard, click Save to generate the devices in the All Items,
Equipment, and Spaces tree. For more information on populating the Rapid Archive wizard, see
Creating an Archive with the Rapid Archive Feature and Room Schedules.
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Notes:

• Only columns with valid site information are displayed. For example, sites with only JCI Family
BACnet Class IDs do not display the Controller Type, Instance Number, or Net N2 address
columns because they are associated with other device types and are not populated.

• The Equipment subset of columns for the Rapid Archive Field Controller wizard does not
populate for sites without an ADS/ADX at Release 7.0 or later.

Figure 141: Rapid Archive Field Controller wizard - Controller Definition Screen

Table 303: Rapid Archive Field Controller wizard Controller Definition Column Descriptions
Column Description
Item Reference Defines the Fully Qualified Reference (FQR) of the object, which is a Metasys

fixed name used internally by the system.
Configuration Contains a group of subset-columns that appear when you define an object

in the SCT Configuration tab.
Name Defines the name of the object as it appears in the SCT and SMP.
Supervisory Device Defines the name of the parent item for the field controller integration.
Integration Defines the type of integration for the field controller and the direct parent

item the field controller can be found under in the All Items Tree.
Class ID Contains the type of object this information is represented as in the archive.
Description Contains a user-defined description of the object.
Authorization
Category

Classifies the object by the category of system or equipment that it monitors
to aid in the determination of user access privileges and alarm routing. The
value for the Authorization Category is taken from the Equipment Definition.

Object Identifier The BACnet Object Identifier is used to establish communication with the
object.
Indicates the instance number of the Object Type used in the BACnet Object
ID as exposed to a BACnet network. The object ID must be unique within the
host device. The object ID of the Device object must be unique within the
BACnet network.

Hardware Contains a group of subset-columns that appear when you define an object
in the SCT Hardware tab.

JCI MAC Address Indicates the MAC address (4 to 127) of the device on the field bus.
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Table 303: Rapid Archive Field Controller wizard Controller Definition Column Descriptions
Column Description
Instance Number Displays the Instance Number of the object on the remote field device. The

Instance number, along with the object type, defines the remote object’s
BACnet Object Identifier (0 to 4,194,302).

Net N2 Address Defines the host controller Address (1 to 254) on the N2 bus.
Controller Type Defines the integration's controller type assigned to this object.
Equipment Contains a group of subset-columns that appear in the Metasys UI that

define space and equipment association.
Name Defines the name of the object as it appears in the Metasys UI
Space Defines the space the equipment serves.
Served by Defines the list of equipment that serves this equipment.
Controller Template Contains a list of linked Controller Templates used for point reference. Points

under the chosen Field Device are created based on the selected template.

In the Edit-mode of Rapid Archive Field Controller wizard, users can edit the field controller
configuration information on a variety of site levels. Select pre-determined or custom views of the
field controller configuration from the View drop-down list to modify and view objects, hardware
specifications, equipment configuration, controller templates, and CAF parameters. The Create
Points and Create Metasys UI Spaces and Equipment check boxes provide customizable mass-
edit and saving permissions. For more information regarding the Rapid Archive Field Controller
wizard Edit-mode functionality, see Table 304.

Figure 142: Rapid Archive Field Controller wizard - Edit Mode

Table 304: Rapid Archive Field Controller wizard - Edit Mode Callouts
Description Function
View list Displays the list of field controllers on a selected engine or

full site.
Controller Definition selection Displays the traditional layout of your Metasys field controller

configuration. Use the Controller Definition view to configure
the mapper objects of the selected engine in order to
communicate with the field controllers. The Controller
Definition view is the default window displayed when the
Rapid Archive Field Controller wizard opens.
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Table 304: Rapid Archive Field Controller wizard - Edit Mode Callouts
Description Function
Parameter Sheet selection Displays the Item Reference, Configuration, Controller

Template, and the five default CAF Parameter columns of
the Metasys field controller configuration. Use the Parameter
Sheet view to make data modifications to the CAF files within
the field controllers.

Manage Views selection Displays the Select Column Attribute window that Allows
users to create custom CAF Parameter columns based on
their Metasys field controller configuration. Users can create
multiple custom views that will then display as a selectable
view in the View drop-down list.

Add (plus) icon Adds new devices to an existing archive.
Remove (minus) icon Removes the selected devices from the archive.
Import Imports the Rapid Archive spreadsheet file.
Cancel Cancels changes made to the archive.
Save Saves changes made to the archive.
Create Spaces and Equipment
check box
Create Points check box

Determines which template updates are applied to the
field controller and/or Metasys UI Spaces and Equipment.
Together, the check boxes offer users three methods of
saving controller template modifications:
Select both Create Metasys UI Spaces and Equipment and
Create Points to save newly selected controller templates to
the device and update the Equipment and Spaces for Metasys
UI. Both check boxes are selected by default when the Rapid
Archive Field Controller wizard opens.
Unselect both Create Metasys UI Spaces and Equipment
and Create Points to replace a device's current controller
template and associated points with a new template
selected. This does not update the Metasys UI Spaces and
Equipment.
Unselect Create Metasys UI Spaces and Equipment and
select Create Points to display the name of the existing
controller template assigned to the device in the Controller
Template column. Prior to Release 11.2, users were unable
to view the existing template associated with a device in the
Controller Template column. In SCT Release 12.0 and later,
you can select this check box combination to view assigned
templates in their existing archives.

Rapid Archive Schedule Population in the Rapid Archive Wizard
To streamline archive configuration, use the Rapid Archive wizard to generate archives based
on .xls Rapid Archive Schedule files. You import the Rapid Archive Schedule files into the Rapid
Archive Field Controller wizard.

Important: Use version 3 of the Rapid Archive Schedule with SCT Release 13.0 and later. At
Release 13.0 the Rapid Archive Schedule spreadsheet is installed on the SCT computer at C:
\Users\Public\Public Documents\RAC.
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If you are a Johnson Controls employee, you can view informational videos about Rapid Archive
Creation (RAC) on the uLearn site: https://jc.kzoplatform.com/containers/928995312607959016.

Figure 143: Sample Rapid Archive Schedule

Keep in mind the following recommendations when working with Rapid Archive Schedules:

Important: The Rapid Archive Field Controller wizard is case-sensitive.

• You must not edit Column headings in the Rapid Archive Schedule file that are used by the
Rapid Archive Field Controller Creation wizard feature. At SCT Release 13.0 you can reorder the
columns and insert custom columns for your own reference, and not affect the import.

• You can alter columns not specifically called out in the following table and not impact the
Rapid Archive Field Controller Creation wizard process.

• You can pre-select the supervisory devices that you want to edit in the all Items tree, prior to
opening the rapid archive feature. If you do not pre-select any supervisory devices, the Select
Scope window appears after launching the rapid archive feature.

• As best practice, create multiple Rapid Archive Schedules based on device-level hierarchy, for
example, individual room schedules for chillers, boilers, air handling units, and terminal units.

• If you are required to enter a name, use the Name attribute of the Object.
Table 305: Rapid Archive Schedule Requirements and Descriptions
Rapid Archive Schedule
Column Heading

Used by RAC Requirements and Description

Space Information
Site/Building/Floor Yes Enter the full Spaces location for the device to

be added to ensure proper Spaces tree auto-
creation. For example, BE Headquarters/
Campus 507/Building 9/Floor 2 creates
the four space parent space hierarchy levels BE
Headquarters, Campus 507, Building 9, and Floor
2.
This column populates the Spaces tree
information in SCT.

Room Number Reference Only The Room Number is provided as a local
reference column and does not populate the
Space tree in SCT.

Leaf Space (e.g. Room) Yes
Not required if the
equipment serves
the whole campus.

Enter the Leaf Space for the
Site > Building > Floor hierarchy that is associated
to the Equipment being created.

All Items / Equipment Tree Information
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Table 305: Rapid Archive Schedule Requirements and Descriptions
Rapid Archive Schedule
Column Heading

Used by RAC Requirements and Description

Device Name Yes Enter the Controller Name as you want it to be
displayed in the All Items tree and Equipment
tree.
This column populates the Name column in the
Rapid Archive wizard.

Device FQR Reference Yes Enter the Controller's FQR as you want it to
appear in the SCT UI and tool tips.
We recommend that you copy the Controller
Name as written in the Device Name column
over to the Device FQR Reference column.
The key purpose of a different FQR name is
for existing sites that had standard naming
processes established for the FQRs in SMP and
SCT.

Device Description Yes (optional) Enter an optional description. This column
populates the Description column in the Rapid
Archive wizard.

Equipment Name Yes Enter the Controller Name as you want it to be
displayed in the Metasys UI's Equipment views.

Served By Equipment
Name

Yes (optional) Enter the exact name of the pre-existing device
serving your controller.
This column populates the Served By relationship
in the Rapid Archive wizard.

Note: The device serving your controller must
already be created in the SCT archive, or the serv-
ing relationship is not created through the Rapid
Archive wizard.

Controller Part # Reference Only The Controller Part # column is provided as a
local reference column that does not populate
any columns in the Rapid Archive wizard but can
be used to display whether the device is JCI family
or Generic family.

Network Information
Engine Name Yes Enter the name of the parent NAE exactly as it

appears in SCT.
This column populates the Supervisory Device
column in the Rapid Archive wizard.

Note: The parent NAE to your controller must
already be created in the SCT archive, or the rela-
tionship is not created through the Rapid Archive
wizard.
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Table 305: Rapid Archive Schedule Requirements and Descriptions
Rapid Archive Schedule
Column Heading

Used by RAC Requirements and Description

Trunk Name Yes Enter the Trunk Identifier for the integration
trunk for your device. Integration trunk IDs are
populated based on their port assignments on
the physical field devices.
This column populates the Integration column in
the Rapid Archive wizard.

Notes:

• The trunk for your controller must
already be created in the SCT archive,
or the integration relationship is not
created through the Rapid Archive
wizard.

• For MSTP Trunks, remember to set the
Trunk Number in the Hardware Tab of
the MSTP Integration when the trunk is
created. This is required to support both
the hardware and remote field buses.

- MSTP trunks also have their own
MAC Address column that must be
filled in.

• For IP Trunks, you can only create and
name one IP integration per engine.

- IP trunks also have their own IP
Controller Number column that
you must fill in.

Controller Host Name
(Future)

Reference Only The Controller Host Name column is provided as
a local reference column that does not populate
any columns in the Rapid Archive wizard but can
be used to display the network host name of the
device.

JCI MAC Address Yes Enter the MAC address for the device. The
uniqueness of the MAC Addresses per MSTP
integration is be validated in Rapid Archive after
you import.
This column populates the JCI Mac Address
column in the Rapid Archive wizard.

Note: For MSTP Trunk, a unique MAC Address
per engine per MSTP Trunk is required. The MAC
Address is 8 position dip switch setting on the
MSTP controllers.
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Table 305: Rapid Archive Schedule Requirements and Descriptions
Rapid Archive Schedule
Column Heading

Used by RAC Requirements and Description

IP Controller Number Yes Enter the combined value of rotary switches set
on the device. The uniqueness of the Controller
Numbers is be validated by the Rapid Archive
wizard after you import.
This column populates the IP Controller Number
column in the Rapid Archive wizard.

ZigBee PANs Offset Reference Only The ZigBee PANS Offset column is provided as a
local reference column for users configuring a
WNC mesh and does not populate any columns in
the Rapid Archive wizard.

Instance # (BACoid) Yes Enter a unique device identifier number based
on the entire site. The uniqueness of the Instance
# (BACoid) is be validated by the Rapid Archive
wizard after you import.
If you leave this cell blank, SCT assigns the device
the next available instance number.
This column populates the Instance Number
column in the Rapid Archive wizard.

N2 Address Yes

DHCP Enabled Yes Enter True or False to enable or disable DHCP for
each controller.

IP Address Yes Enter the IP Address for the device.
This column populates the IP Address Column in
the Rapid Archive wizard

Subnet Mask Yes (optional) Enter the Subnet mask used for the IP address.
This column populates the IP Mask column in the
Rapid Archive wizard.

IP Router Yes (optional) Enter the Router's IP address for the device.
This column populates the Router IP Address
Column in the Rapid Archive wizard

ETH-1 Reference Only The ETH-1 column is provided as a local reference
column for the controller's input and does not
populate any columns in the Rapid Archive
wizard.

ETH-2 Reference Only The ETH-2 column is provided as a local reference
column for the controller's output and does
not populate any columns in the Rapid Archive
wizard.

Definitions and Templates
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Table 305: Rapid Archive Schedule Requirements and Descriptions
Rapid Archive Schedule
Column Heading

Used by RAC Requirements and Description

Equipment Definition
Name

Reference Only The Equipment Definition Name column is
provided as local reference column and does not
populate the Equipment or All Items tree.

Note: Only Equipment Definitions linked to Con-
troller Templates in your SCT archive prior to
importing the Rapid Archive Schedule are used to
populate the Equipment Tree.

We recommend one equipment definition be
used to create many Equipment Instances of the
same type. For example, one Single Duct VAV
definition could be created for all Single Duct VAV
Boxes that are cooling only, cooling with reheat,
or fan powered.

Controller Template
Name

Yes Enter the controller template name as displayed
in the SCT UI.

Note: The controller templates must exist in SCT
prior to importing the Rapid Archive Schedule for
proper linking.

This column populates the Controller Template
column in the Rapid Archive wizard.

Parameters
SA-AREA No Enter the Supply Area value to write to the

controller's CAF.
SA-KFACTOR No Enter the default K Factor value to write to the

controller's CAF.
CLG-MAXFLOW No Enter the Cooling Max Flow value to write to the

controller's CAF.
CLGOCC-MINFLOW No Enter the occupied cooling minimum flow

setpoint value to writer to the controller's CAF.
HTGOCC-MINFLOW No Enter the occupied heating minimum flow

setpoint value to write to the controller's CAF.
<CUSTOM CAF
PARAMETERS>

No Enter additional parameters manually following
the Rapid Archive Schedule's format for
customized parameters.
To view all available attributes for custom
parameters view the CAF Parameter Sheet.

Creating an Archive with the Rapid Archive Feature and Room Schedules
When using the Rapid Archive feature to create your archive, use a top-down device hierarchy
approach. For example, use the Chiller and Boiler room schedules with the Rapid Archive
Field Controller wizard first. This allows the wizard to automatically create equipment serving
relationships when you create your AHUs and Terminal Units.
We recommend creating multiple Room Schedules based on device-level hierarchy. For example,
individual room schedules for Chillers or Boilers, Air Handling Units (AHU), and Terminal Units.
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Note: This procedure requires that your equipment definitions, controller templates, and
room schedule files are already created.

Use the following steps for every device-hierarchy level in your site.
1. Create a new archive in SCT.
2. Add a Site, Site Director, Supervisory Devices, and Integrations to the new archive using the

Insert Device wizard.
3. Import equipment definitions to the Equipment Definitions folder of your Site Director.
4. Import Controller Templates to the SCT Controller Templates folder under your site

Configuration Data.
5. Verify that your controller templates are linked to the correct equipment definitions.

Note:  This step creates Equipment objects that are used by the Metasys UI. If you do not
link to the equipment definitions, the Rapid Archive Field Controller wizard automatically
generates equipment definitions and the Equipment objects based on the auto-created
equipment definitions.

6. On the Facility menu, select Rapid Archive. The Rapid Archive Field Controller wizard appears.

Note: For improved Rapid Archive Field Controller wizard loading, pre-select the devices
that you are editing in the All Items tree before opening the wizard.

7. Click Edit and then click Import to import the Rapid Archive spreadsheet.
8. Click OK when the Import Room Schedule dialog appears.

Note: You must have an ADS, ADX, or ADS Lite as your Site Director for the Metasys UI
Equipment columns to populate. If no compatible Metasys UI Site Director exists on the
site, then the columns are hidden.

9. Click Save and refresh the All Items tree to verify that your controllers and points populated
correctly.

10. Repeat Step 5 through 9 for each device-level in your system.

Note: When importing each device-level in your system, if you close and re-open the
Rapid Archive wizard after each import, the Space and Served By columns for the last
added device show a blank result. This occurs even though the information resides in
the archive. However, if you keep the Rapid Archive wizard open during each device-level
import, this issue does not occur.

Equipment Definitions and Rapid Archive
Equipment Definitions are used to display information about a piece of equipment and include
common points like zone temp and supply air temp. Equipment definitions are used to populate
equipment summaries in the Metasys UI.
The Rapid Archive feature builds equipment definitions for each controller template existing in
your archive that does not have a linked equipment definition. Importing equipment definitions
allows you to bind the same definition to multiple controller templates, which simplifies the data
that appears in the Metasys UI.
Linking Equipment Definitions to Controller Templates
Tips for linking equipment definitions to controller templates:

• We recommend Rapid Archive users create generic equipment definitions that cover multiple
devices such as singular AHU, VAV, or CHWS definitions.
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• If you do not link equipment definitions to controller templates before using the Rapid Archive
wizard, the wizard automatically creates equipment definitions for each controller template
with linked definitions.

1. Open the controller template in a focus window and select the Configuration tab.
2. Click Edit.
3. Click the Browse icon to open the Select Item wizard.
4. Navigate to the equipment definition and select the definition.
5. Click OK.
6. Click Save.

Controller Templates
Controller Templates are used as a generic model by the Rapid Archive feature to create equipment
definition configurations and populate generic point lists for all new equipment linked to the
template. Controller Templates can be created four different ways:

• Creating Controller Templates with CAF Files
• Creating a Controller Template Based on Existing Controllers
• Manually Adding Points to Controller Templates

Working in the Controller Template UI

Figure 144: Controller Template UI Icons

Table 306: Controller Template UI Icon Callouts
Callout Name Function
1 Add a new point Adds a new point to the Point List table rows.
2 Remove

selected
point(s)

Removes selected points from the Point List table rows.

3 Move selected
point(s) up

Changes the position of selected points or folders in the Point List
by moving them up incrementally.

4 Move selected
point(s) down

Changes the position of selected points or folders in the Point List
by moving them down incrementally.

5 Add folder Adds folders for improved point organization.
6 Add trend

extension
Adds trend extension to selected points in the Point List table.

7 Add alarm
extension

Adds alarm extension to selected points in the Point List table.
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Table 306: Controller Template UI Icon Callouts
Callout Name Function
8 Add totalization

extension
Adds totalization extension to selected points in the Point List table.

9 Expand tree Expands the folder or point tree.
10 Collapse tree Collapses the folder or point tree.
11 Help Opens the Controller Template Help shortcut key commands.

Creating Controller Templates with CAF Files
About this task:  
Controller templates are used by the Rapid Archive Creation Field Controller wizard to generate
points on a controller. You can create points within controller templates by importing points from
a .caf file, importing from existing controllers, or manually adding points.

1. On the Insert Menu, click Object. The Select Object Type dialog appears.
2. Select Controller Template and click Next.
3. Set the Destination of the Controller Template as Configuration > SCT Controller Templates

and click Next.
4. Enter a unique identifier for the Controller Template and click Next.
5. To create a Definition Link with an Equipment Definition for your site, click the Browse icon,

then navigate to a definition in the All Items tree.
6. Configure the Point Name Display settings for point name clarification in the SMP and SCT

UI's All items tree. For more information on Point Name Display, see the Rapid Archive Tips
and Rapid Archive Troubleshooting sections.
Notes:

- The Point Name Display attribute naming structure does not appear in the Metasys UI.
Metasys UI names are based on Equipment Definitions.

- The Point Name Display attribute includes up to 10 levels of space information and the
parent Controller Name. For more information, see Rapid Archive Tips.

7. Click Next and then Finish. The Extension wizard window appears. To skip adding a .caf
Resource file to your Controller Template, click Done. Otherwise, follow these steps to add
a .caf Resource file to your Controller Template.

Note: BACnet Alarms and BACnet Trends in a .caf file are not generated when
populating the points list with a .caf file.

a. Click New. The Select File window appears.
b. Click Browse to navigate to the location and open the Resource file from your

workstation.
c. Click Next. Configure your Resource file by adding descriptions or status information,

or changing the file name.
d. Click Next and then click Finish. The Insert Resource File wizard closes.
e. Click Done in the Extension wizard window.
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Creating a Controller Template Based on Existing Controllers

Note: This procedure populates points for a new template. For existing templates that have
points, the point list is deleted and repopulated based on the existing controller.

1. Select a controller template from the All Items tree. If you do not have a pre-existing controller
template, create a new template through the Insert > Object > Object Type > Controller
Template wizard.

2. Open the controller template with a double-click or right-click and select View.
3. Select the Point List tab and click Get Points. The Select Field Controller window appears.
4. Select the field controller you want to copy a point list from and click OK. The Get Points dialog

box appears.
5. Click Create point list. The point list is repopulated from the selected field controller.

Manually Adding Points to Controller Templates
1. Open the controller template from the All Items tree.
2. Select the Point List tab and click Edit to enter edit mode. Edit mode allows you to add points,

folders, alarm extensions, trend extensions, totalization extensions, and arrange points.
3. Click the Add icon to add a new point row to the Point List.

Note: If points already exist when you click the Add icon, a new instance based on the
original point selected is created.

4. Enter point information until all red box requirements have been fulfilled.
5. Click Save.

To make additional manual edits to your point list, see Figure 144 for descriptions of all icon
functions in the controller template window.

Assigning Controller Templates with the Rapid Archive Field Controller wizard
About this task:  
Users can assign controller templates to controllers using the Rapid Archive Field Controller wizard.

1. Open the Rapid Archive Field Controller wizard.
2. Click Edit, then navigate to the controller you want to assign a template to.
3. In the Controller Template column, click the drop-down arrow. The drop-down menu appears.
4. Select the template you want to assign the controller.
5. Repeat steps 3 and 4 for all controllers you want to assign controller templates to.

Note: If a controller has an existing template assigned, an asterisk will appear to the left
of the template name (Figure 145). Leave the current controller template selection in
place to maintain the current point structure for the controller. To modify the template,
see Modifying Controller Templates with the Rapid Archive Field Controller wizard.

Figure 145: Existing Controller Template Selection

6. Click Save.
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Modifying Controller Templates with the Rapid Archive Field Controller wizard
1. Open the Rapid Archive Field Controller wizard.
2. Click Edit.
3. Select the Create Points check box and clear the Create Metasys UI Spaces and Equipment

check box.
4. Navigate to the controller you want to modify.
5. In the Controller Template column, click the drop-down arrow, and do one of the following:

- Select a different controller template. This selection removes the existing controller
template and deletes associated points, including any extensions, and recreates the
points indicated by the new template.

- Select the duplicate controller template of the current template selection from drop-
down menu. For example, if * vavsd is currently listed, select vavsd (Figure 146). This
selection deletes all of the existing points under the controller and recreates them based
on the current state of the selected controller template.

Figure 146: Duplicate Controller Template Selection

6. Click Save.

Importing Controller Templates
1. Navigate to the SCT Controller Templates folder in the All Items tree.
2. Open the Action menu and click Import Template.
3. Browse to the file location of the template you are importing and select the file.
4. Click Import. The Notice dialog box appears.

Figure 147: Import Notice Dialog Box

Note: Verify the equipment definition association after import. If the definition does
not exist, the controller template's Definition Link could be referencing an unbound
equipment definition.

Exporting Controller Templates
1. Navigate to the SCT Controller Templates folder in the All Items tree.
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2. Right-click the controller template file that you want to export. The Export window appears.
3. Browse to the file location and click Export. The Notice confirmation box appears. Click Ok.

Figure 148: Export Notice Confirmation Box

Adding Extensions to Controller Template Points

Note: These procedures assume you have already created a controller template and added
points to the template.

Multi-select points in the Rapid Archive Point List Editor to quickly add multiple extensions at one
time. For detailed procedures, see:

• Adding Alarms to Controller Template Points
• Adding Totalizations to Controller Template Points
• Adding Trends to Controller Template Points

Adding Alarms to Controller Template Points
About this task:  
This section describes the workflow for adding an alarm extension to points. The procedure
assumes you have already created and added points to a controller template. For more information
on creating a controller template, see Controller Templates.

1. Navigate to the SCT Controller Templates folder in the All Items tree.
2. Drag a Controller Template into the Display Frame, or right-click the template and select

View.
3. Click the Points List tab.
4. Click Edit, then select the points for which you want to add an alarm extension.
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Figure 149: Edit Point List

5. Click the Add Alarm Extension icon. The selected points are populated with an alarm
extension.

Figure 150: Add Alarm Extension Icon

6. If desired, edit the description column and the default values for properties in the Alarm field
columns.

Figure 151: Alarm Properties

Note: This allows you to edit the key properties of the Alarm Extension. Other properties
associated with the Alarm Extension are set to the default SCT values.

7. Click Save.

Adding Totalizations to Controller Template Points
About this task:  
This section describes the workflow for adding a totalization extension to points. The procedure
assumes you have already created and added points to a controller template. For more information
on creating a controller template, see Controller Templates.

1. Navigate to the SCT Controller Templates folder in the All Items tree.
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2. Click and drag a controller template into the focus window.
3. Click on the Points List tab.
4. Click Edit and then select the points that you want to add totalization extensions to. Hold

down the Shift or Ctrl key to select multiple points.

Figure 152: Edit Point List

5. Click the Add Totalization Extension icon. The selected points are populated with a
totalization extension.

Figure 153: Add Totalization Extension Icon

6. If desired, edit the description and the default value properties in the Totalization field
columns.

Figure 154: Totalization Properties
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Notes:

- Only a small subset of Totalization Extension properties are editable through the Rapid
Archive. Other properties associated with the Totalization Extension are set to the
default SCT values.

- If a totalization extension is added to a non-analog point, you can utilize a drop-down
menu in the Class ID column to specify its type.

7. Click Save.

Adding Trends to Controller Template Points
About this task:  
This section describes the workflow for adding a trend extension to points. The procedure assumes
you have already created and added points to a controller template. For more information on
creating a controller template, see Controller Templates.

1. Navigate to the SCT Controller Templates folder in the All Items tree.
2. Click and drag a controller template into the focus window.
3. Click on the Points List tab.
4. Click Edit, then select the points to which you want to add trend extensions.

Figure 155: Edit Point List

5. Click the Add Trend Extension icon. The selected points are populated with a trend
extension.

Figure 156: Add Trend Extension Icon

6. If desired, edit the description and the default values for properties in the Trend field
columns.
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Figure 157: Trend Properties

Note: Only a small subset of Trend Extension properties are editable through the Rapid
Archive. Other properties associated with the Trend Extension are set to the default SCT
values.

7. Click Save.

Replacing Resource Files in Controller Templates
1. Open the controller template in a focus window and select the Resource tab.
2. Click Delete. The Confirm Delete dialog box appears.

Figure 158: Confirm Delete

3. Click Yes and wait for the resource file to be removed.
4. Click New. The Insert Resource File wizard appears.
5. Click Browse in the Insert Resource File wizard to navigate to the location of the .caf file. Click

Open and verify that the file name appears in the File Name box.
6. Click Next. Configure your Resource file by adding descriptions or status information, or

changing the file name.
7. Click Next and then click Finish.
8. Open the Point List tab and click Get Points.

Populating Existing Controller Templates with .caf Files
About this task:  
The following procedure for populating controller templates adds new resource files to controller
templates that previously did not have resource files.

Note: BACnet Alarms and BACnet Trends in a .caf file are not generated when populating the
points list with a .caf file.

1. Right-click an existing controller template in the All Items tree and click Show Extensions.
2. Click New.
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3. Click Browse in the Insert Resource File wizard to navigate to the location of the .caf file. Click
Open and verify that the file name appears in the File Name box.

4. Click Next. Configure your Resource file by adding descriptions or status information, or
changing the file name.

5. Click Next and then click Finish. When the Insert Resource File wizard closes, drag the
controller template into a focus window and verify that a Resource tab now exists for the
controller template.

6. Select the Point List tab and click Get Points. The Get Points dialog box appears.

Note: For existing controller templates that have points, the point list is deleted and
repopulated based on the .caf file.

Figure 159: Get Points Dialog Box

Note: Controller templates do not support N2 or FX .caf files as resources.

a. Select Display Data to import only display data points you configured in the Controller
Configuration Tool (CCT).

Note: Special character display data names are not supported in controller
templates.

b. Select BACnet Exposed Points to import all point information.

Rapid Archive Tips
Product Enhancement:

• You can pre-select the supervisory devices that you want to edit in the all Items tree, before
you launch the rapid archive feature. If you do not pre-select any supervisory devices, the
Select Scope window appears after you launch the rapid archive feature.

• You can add new controllers to any network engine — not just those selected when opening
the Rapid Archive. Duplicate name/address checking does not occur in this case.

Drag and Drop Functionality
In Controller Templates:

• Click any cell in a row to reorganize and drag the selection to another location to reorder the
row.

• Click any cell in a row and drag the selection into folder structures to reorganize points in
folders.
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In the Rapid Archive Field Controller wizard:

• Click and drag equipment from the Equipment tree to the Served By column to create serving
relationships.

• Click and drag spaces from the Spaces tree to the Space column to associate item references
with spaces.

Enhanced Point Naming
To clearly define point names in the SMP and SCT All Items tree, controller templates offer
enhanced naming selections through the Configuration tab. The Point Name Display attribute
includes up to 10 levels of Space information and the parent Controller Name.
Notes:

• By default, the parent controller name is set to True, and 0 levels of space information are
applied to point name displays. Point names are generated based on hierarchy order. For
example a point name with 3 levels and a controller would be Bldg1.Flr2.AHU1-VAV1.ZN-T,
instead of ZN-T.

• Point Name Displays truncate the beginning name strings when the entire name exceeds the
400 character maximum.

• The Point Name Display attribute naming structure does not appear in the Metasys UI. Metasys
UI names are based on Equipment Definitions.

To change Space level and Controller Name information in display names:
1. Open the controller template in the focus window.
2. Click Edit in the Configuration tab.
3. Enter a numerical value of 0 to 10 in Include Space Level Value cell.
4. Select True or False from the Include Controller Name drop-down list.

Rapid Archive Troubleshooting
Table 307: Troubleshooting the Rapid Archive Creation Feature
Error or Error Message Tips
When importing each
device-level using the
Rapid Archive wizard, the
Space and Served By
columns of the last added
device show a blank result.

This issue occurs if the Rapid Archive wizard is closed and re-opened
after each import. The information still exists in the archive even
though it is not displayed. If you wish to view these details during the
entire import process, please ensure that the Rapid Archive wizard
remains open.

Unable to repopulate
due to communications
or server error: FX
field controllers are
not supported.

Controller templates do not support FX files as resources for Release
11.0.

Unable to repopulate
due to communications
or server error: N2
field controllers are
not supported.

Controller templates do not support N2 files as resources for Release
11.0.
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Table 307: Troubleshooting the Rapid Archive Creation Feature
Error or Error Message Tips
Failed to save # out
of # changes.
Unable to save the
object order for
following:
Equipment Definition
(Operational problem)
Would you like to
retry?

The controller template has no link to an equipment definition. All
points and item references are created, but the equipment is not
populated in the equipment tree.

Note: To prevent future instances of this error appearing, edit your con-
troller template's Definition Link in the Configuration tab.

To resolve this issue:
1. Click No in the Rapid Archive Field Controller wizard dialog box

that appeared.
2. Click Cancel in the Rapid Archive Field Controller wizard focus

window.
3. Create the Equipment in the Equipment tree.

Failed to save # out
of # changes.
Unable to save the
object order for
following:
Object name already
exists
Would you like to
retry?

You have already created this controller.
This issue may occur if a controller is created with the same Mac
Address or Instance number as an existing controller that was
not loaded in Rapid Archive. It is recommended that all existing
controllers on NAE's in the Rapid Archive Schedule are loaded into
Rapid Archive to facilitate easier identification of duplicates.

Failed to discover
equipment:
Error: Reference Not
Resolved (403)
Message: Object
reference not set
to an instance of an
object

The controller template's Definition Link is referencing an unbound
equipment definition. To resolve the issue, update the Definition Link
in the Configuration tab.

Red Cell Errors in
the Rapid Archive
Creation Field
Controller wizard

Item Reference column information failed to import properly from
the Room Schedule .csv file. For more information about Room
Schedule name enhancements and file importing for the Rapid
Archive Creation Field Controller wizard, see the Rapid Archive
Schedule Population in the Rapid Archive Wizard section.

Room Schedule import
completed. File
contained one or more
entries which were
not imported due to
missing data.

The file contains valid data, but entries are missing information
needed to make them usable. Consult the error log for the specific
data that caused the entries to be skipped.

File contains invalid
data. Import has been
canceled.

The file contains invalid data that caused the process to fail. Consult
the error log for the specific data that caused the failure.
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CAF Parameters
The SCT Trunk Utilities feature allows you to view and edit device parameters per field controller
trunk. You can edit parameters in offline or online mode. Later, you can push offline edits to the
field controller through the Trunk Utilities Integration Download feature.
A new feature of Trunk Utilities is an enhanced download workflow which allows for customized
interaction with field controllers. Users can access the live devices using the Application Options
parameter sheet to view the status of devices and command them accordingly.

Editing CAF Parameters
You can edit CAF file data using the All Items tree or the Rapid Archive wizard.

To edit CAF Parameters through the All Items tree
1. In the All Items tree, select the MS/TP or IP Integration Trunk for the devices you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
3. In the Parameter Sheet window, select Parameter Sheet.

Note: It is also possible to edit CAF file data for a selected number of devices. See Parameter
Sheet Viewer  for further information.

To edit CAF Parameters through the Rapid Archive wizard
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk you want to edit.
2. On the Facility menu, select Rapid Archive. The Rapid Archive Field Controller wizard appears.
3. In the View drop-down, select Parameter Sheet.

To modify CAF file data in the SCT archive, in either CAF Parameter Sheet view, click Edit. By
default the Parameter Sheet displays five standard VAV CAF parameters: SA-Area, SA-KFactor, CLG-
MaxFlow, CLGOCC-MinFlow, and HTGOCC-MinFlow. You can create custom CAF parameter columns
and views using the Manage Views selection from the View drop-down list.

Figure 160: Rapid Archive Field Controller wizard - Parameter Sheet View

Commanding CAF Parameters
After a Trunk Utilities download completes, CAF files can be commanded using the Application
Options parameter sheet. For information on how to download a CAF file, see Downloading a CAF
to devices Through Trunk Utilities.

Viewing the Status of Commanded CAF Files
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To view the status of existing CAF commands:
1. In the All Items tree, select the parent engine for the MS/TP or IP trunk you want to edit.
2. Select the Parameter Sheet tab in the focus window for the trunk.
3. In the Parameter Sheet Window, select the Application Options view and switch the

parameter sheet mode to Online.

Figure 161: Application Options Parameter Sheet View

Table 308: Application Options Parameter Sheet Overview
Item Reference Contains the reference of the object to which a command is sent.
Controller Template Contains a list of linked Controller Templates for point reference.
Logic Enable Logic Enable status indicates if runtime logic is enabled.

Note:

• In the case of staged files, the status of the logic value
is not exposed to the SCT. The device will only use the
logic value once it is commanded to load the staged file.

• The disable logic feature is not supported for firmware
prior to 8.0. The Parameter Sheet Logic Enable
(Enabled) column will display a series of dashes (---) if
the controller is not supported.

Download Status (State of
Application)

Indicates the status of the download.
Idle - Indicates that the applications are transferred and loaded
immediately.
Files Are Staged - Indicates that the applications are transferred
but not immediately loaded.

Connection Refreshes the connection results.

Issuing Commands to CAF Files
To modify CAF commands or to load staged files:
1. In the Application Options view, select the desired devices and click Edit to open the Trunk

Utilities wizard. The Commands radio button is automatically selected.
2. Specify the Commands and the Connection Type and click Next. Select one command to

perform against selected devices. For an overview of connection specifications and command
features, see Downloading a CAF to Devices Through Trunk Utilities.

3. Verify that the correct devices are selected and click Next.
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4. Enter the connection parameters specific to your connection type and click Next.
5. Validate the information in the Trunk Utilities Summary window and click Finish.

Note: It is also possible to modify CAF commands for a selected number of devices. See
Parameter Sheet Viewer for further information.

Rapid Archive Merging
Facility > Rapid Archive
You can use the Rapid Archive feature in SCT Release 13.0 and later to add space and equipment
information to an existing site. Use this feature to create objects for the Metasys UI. You can export
Rapid Archive data to a Rapid Archive Schedule file, and edit the data in a spreadsheet application,
such as Microsoft® Excel®. After you edit the Rapid Archive Schedule file, you can merge the
information back into SCT.
For instructions on how you can use Rapid Archive to create a new site, see Rapid Archive Creation.

Exporting Device Information from SCT
1. From the Facility menu, click Rapid Archive.
2. In the Select Scope window, select the Supervisory Devices to export information from, then

click Open. The Rapid Archive Field Controller Wizard appears.
3. Click Export.
4. Navigate to the location where you want to save the file, enter a file name, then click Export.

The file is saved with a .csv extension.
5. If the export is successful, a confirmation message appears. Click OK.

Loading Device Information into the Rapid Archive Schedule
1. Use Excel to open the Rapid Archive Schedule Master file.

Important: Use version 3 of the Rapid Archive Schedule with SCT Release 13.0 and later.
At Release 13.0 the Rapid Archive Schedule spreadsheet is installed on the SCT computer
at C:\Users\Public\Public Documents\RAC.

2. Click the File tab.
3. Click Unprotect.
4. Press the Esc key.
5. Click the Data tab.
6. In the Get External Data group, click From Text.
7. Navigate to the exported Rapid Archive file, select it, then click Import.
8. In the Text Import Wizard, click Delimited, then click Next.
9. In the Other field, enter the vertical bar character. To enter the vertical bar character with a

North American or British keyboard, hold down the Shift key and press the backslash key. The
Other check box is selected.

10. Click Next, then click Finish.
11. Select the first unshaded cell in column A (see Figure 162), then click OK. The Rapid Archive

data is added to the spreadsheet.
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Figure 162: Import Data in Excel

Defining Space Information in the Rapid Archive Schedule
1. If you do not want to define spaces and equipment for a field device, delete its row from the

spreadsheet.
2. Enter space and equipment information for the controllers. You must complete the columns

included in the table below. Do not modify the information in any other columns. For a full
description of columns in the Rapid Archive Schedule, see Table 305.

Note: Each row in the spreadsheet represents a pairing of a field device and a piece of
equipment. If a field device controls multiple equipment, then that field device is listed in
multiple rows: once for each piece of equipment that it controls.

Table 309: Rapid Archive Schedule Requirements for MUI Import and Descriptions
Rapid Archive
Schedule Column
Heading

Used by RAC
Merge

Enhancement Requirements and
Description

Space Information
Site/Building/Floor Yes Enter the full Spaces location for the device to

be added to ensure proper Spaces tree auto-
creation. For example, BE Headquarters/
Campus 507/Building 9/Floor 2 creates
the four space parent hierarchy levels BE
Headquarters, Campus 507, Building 9, and
Floor 2.
This column populates the Spaces tree
information in SCT.
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Table 309: Rapid Archive Schedule Requirements for MUI Import and Descriptions
Rapid Archive
Schedule Column
Heading

Used by RAC
Merge

Enhancement Requirements and
Description

Leaf Space (for
example, Room)

Yes Enter the Leaf Space associated with the Site/
Building/Floor hierarchy that is associated to
the Equipment being created.
To define multiple spaces, enter the space
names separated by double ampersand
characters. For example, to configure the
controller to serve both the Mens Bath space
and the Womens Bath space, enter Mens
Bath && Womens Bath.

All Items / Equipment Tree Information
Equipment Name Yes Enter the field device name as you want it to

display in the Metasys UI's Equipment views.
If there is a definition for the equipment in
the archive, this cell contains the asterisk
character. If you import this row of data, you
do not create new equipment.

Served By Equipment
Name

Yes (optional) Enter the exact name of the pre-existing
device serving your controller.
To define multiple devices, enter the device
names separated by double ampersand
characters.
This column populates the Served By
relationship in the Rapid Archive Wizard.

Note:

The device serving your controller must
already exist in the SCT archive. If the
device does not exist, the Rapid Archive
Wizard does not create the serving
relationship.

The SCT finds the serving equipment
based on their Name. Set a unique
name for equipment in order to prevent
unwanted matches. For information on
renaming multiple pieces of equipment
at the same time, see Updating Object
Labels.

3. Click the File tab.
4. Click Save As.
5. Click Computer, and then click Browse.
6. From the Save as type list, select CSV (Comma delimited).
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7. Navigate to the location where you want to save the file, enter a file name, and then click
Save.

8. In response to the warning that multiple sheets are not supported, click OK.
9. In response to the warning that some features might be lost, click Yes.

Add Metasys UI Objects
About this task:  
To import a Rapid Archive Schedule file to create a new site, see Creating an Archive with the Rapid
Archive Feature and Room Schedules. To import a Rapid Archive Schedule file and add Metasys UI
objects to an existing site, complete the following steps:

1. In the Rapid Archive Field Controller Wizard, click Add MUI Objects.
2. Navigate to a Rapid Archive Schedule file that contains space and equipment information,

then click Import.

Note: You must save the Rapid Archive Schedule as a .csv file. See Defining Space
Information in the Rapid Archive Schedule.

3. SCT processes the Rapid Archive schedule, and identifies any errors.
- If there are errors in the Rapid Archive Schedule, a message appears that describes the

error. The SCT archive is not updated. You do not need to undo any changes, or restore
the archive. Click OK, correct the errors in the Rapid Archive Schedule, and then import
the file again.

- If there are no errors, a message appears indicating that the import is successful. Click
OK.

Result  
If the spaces that you define in the Rapid Archive Schedule do not exist in the archive, they are
created.

Edit Spaces Tree
Menu Selection: Facility > MUI Config > Edit Spaces Tree.
Opens the Spaces Tree Editor.

Using the Spaces Tree Editor
To begin configuring your Metasys site into spaces, go to Facility > MUI Config > Edit Spaces Tree.
You can create spaces for your Spaces Tree using one of three methods:

• Manually add each space using the buttons described in Table 310.
• Drag folders from a User View into the Spaces Tree.
• Create multiple spaces at once by using a spreadsheet.

Figure 163: Spaces Tree Editor Buttons

In the Spaces Tree Editor, click Edit. The button bar appears. Table 310 describes the Spaces Tree
Editor's button bar functionality.
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Table 310: Spaces Tree Editor Buttons
Button Description

Save a Spaces Tree

Cancel editing or adding a Spaces Tree

Add new space (space object) to Spaces Tree

Remove selected Spaces Tree object

Move selected Spaces Tree object up in the tree

Move selected Spaces Tree object down in the tree

Sort Spaces Tree in ascending order

Sort Spaces Tree in descending order

Space Object Attributes
Create a Space object with the Facility > Edit Spaces Tree option. This object contains attributes
common to many Metasys system objects.
Table 311: Space Object – Focus/Configuration Tab
Attribute Name Data Type Initial Value Values/Options/

Ranges
Name Text Blank Maximum Length of

400 characters
Description Text Blank Maximum Length of 64

characters
Authorization Category One type from a set HVAC HVAC, Fire,

Security, Services,
Administrative, General
Lighting, Refrigeration,
Critical Environment,
Air Quality, Power,
Energy, System Custom
1–150

Type One type from a set Generic Generic, Building,
Room, Floor

Served By Equipment Object Blank Various
Graphic Graphic Object Blank Various
Graphic Alias Reference Strings (fully

qualified references)
Blank Maximum 256

characters

Creating a Spaces Tree Using the Spaces Tree Editor
About this task:  
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Follow these steps to manually create a basic Spaces Tree. In addition to the manual method
described here, you can create a Spaces Tree using a Microsoft® Excel® spreadsheet (see Creating
a Spaces Tree Using a Spreadsheet). You can also add folders from a user view into a Space Tree
(see Adding Spaces to the Spaces Tree Using User Views).

1. On the Facility menu, select MUI Config > Edit Spaces Tree.

Figure 164: Edit Spaces Tree

2. The Spaces Tree Editor opens in the right pane. Click Edit.

Figure 165: Spaces Tree Editor

3. Select the Site Object in the tree on the left side of the panel. Click the Add New Space icon to
add the first space object.

Figure 166: Add the First Space

4. Click the plus sign next to the Site Object to expand the Site node. Then click the space object.
The first space object added is a generic space object.

Note:  A site can only have one parent-level root space object. Consider future
expansions when you configure your site. For example, if you are configuring your site
for a single-building campus that may expand to include multiple buildings in the future,
then we recommend naming the parent-level root space "Campus" to accommodate
potential growth.
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Figure 167: Parent-Level Generic Space Object

5. Select the parent-level generic space object to edit the object attributes. Use Table 312 to edit
the object attributes.

Figure 168: Edit Parent-Level Generic Space Attribute Objects

Table 312: Space Object Attribute Descriptions
Attribute Description
Name Enter the name of the space.

Contains a user-defined name for the object that is independent of
the item reference. Functions like the Name object attribute for the
All Items navigation tree.

Note: Enter plain text only.

Description Enter a description of the space.
Contains a user-defined description of the object.

Note: Enter plain text only.
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Table 312: Space Object Attribute Descriptions
Attribute Description
Object Type Indicates the Object Type as displayed in the Metasys software and

as exposed to a BACnet® network.
Authorization Category Choose the Authorization Category for the equipment in the

Spaces Tree from the drop-down list options.
Examples: HVAC, Fire, Security
Classifies the object by the category of system or equipment that
it monitors to help determine user access privileges and alarm
routing.

Note: Keep in mind the access privileges of users per Authorization
Category and select the most appropriate category. A user without
access to an authorization category does not have access to objects
for spaces in the Metasys UI.

Type Choose the type of space object from the drop-down list:

• Generic—used as a campus-level space. You can add any
number of Complex space objects (such as Buildings, Floors,
Rooms) to a Spaces Tree; however, you can only add Complex
space objects when you initially create a Spaces Tree.

• Building—used as a building-level space. You can add any
number of Building space objects to a Spaces Tree.

• Floor—used as a floor-level space. You can add any number of
Floor space objects to a Spaces Tree.

• Room—used as a room-level space. You can add any number
of Room space objects to a Spaces Tree.
Note: You can add up to ten spaces levels from the Site object.

Served By List of equipment serving the space or another piece of
equipment.

Note: We recommend that you configure the Served By equipment
later in the workflow. Complete the equipment definition first and
then configure the Served By equipment. For more information, see
Using Equipment Definitions and Assigning Spaces Served By Equip-
ment Relationships.

Graphic List of object references you can associate with space objects.

6. Click the Add New Space icon to add another space object. Depending on your site, you can
continue by adding nested space objects, such as buildings, or you can add additional parent-
level generic space objects.
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Figure 169: Building Level Space

7. Select the Building-level space object to edit the object attributes. Use Table 312 to edit the
object attributes.

8. Click the Add New Space icon to add Floor-level space objects or select the parent-level
generic space object to continue adding Building-level space objects. If you are adding a
Floor-level space object, see Figure 169 and continue to Step 9.

Figure 170: Floor Level Space

9. Select the Floor-level space object to edit the object attributes. Use Table 312 to edit the
object attributes.

10. Click the Add New Space icon to add Room-level space objects or select the Building-level
space object to continue adding Floor-level space objects. If you are adding a Room-level
space object, see Figure 171 and continue to Step 11.
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Figure 171: Room Level Space

11. Continue adding spaces. You can add a nested space object under a room by following the
same general guidelines given in the steps in this section. Once you complete adding space
objects to your Spaces Tree, click Save.

Figure 172: Spaces Tree Next to All Items Tree in SCT

12. Continue to Using Equipment Definitions.

Creating a Spaces Tree Using a Spreadsheet
About this task:  
Another method of creating a Spaces Tree is to drop data from a spreadsheet (Microsoft Excel 2007
and later). This method uses room and point schedule information to build a Spaces Tree.

This procedure assumes you have already set up your spaces in a spreadsheet. In general,
use Figure 173 as an example of a spreadsheet setup. In the spreadsheet example used in this
document, column 1 is the Parent-level generic space; column 2 is the Building-level space; column
3 is the Floor-level space; column 4 is the Room-level space.

Note: Your spreadsheet can have up to 10 columns, with column 4 through 10 initially set to
Room-level spaces.

1. Click Facility > MUI Config > Edit Spaces Tree.

659SCT: System Configuration Tool Help



2. The Spaces Tree Editor opens in the right pane. Click Edit.
3. In Excel, select the columns and rows of data. Make sure your cursor is the click and drag

cursor - four arrows pointing outwards.
4. Drag the data to the ADS/ADX in the base tree in the Spaces Tree Editor.

Figure 173: Example of Data from Spreadsheet in SCT

5. Click Save.
Continue to Using Equipment Definitions.

Adding Spaces to the Spaces Tree Using User Views
About this task:  
A third method of creating a Spaces Tree is to drag folders in a User View from the All Items tree
into the Spaces tree within the Space Tree Editor.

1. Click Facility > MUI Config > Edit Spaces Tree to edit the existing Spaces tree.
2. The Spaces Tree Editor opens in the right pane. Click Edit.
3. Click View > Panel Layout and select the two panel option. In one of the panels, open the user

view. Select Edit.
4. Select the folders in the User View that you would like in the Spaces Tree.

Note: When you select a folder that has nested folders, only the root folder is selected
(nested folders are not selected). We recommend that you expand folders with nested
folders before you select the folders to drag to the Spaces Tree Editor. Folders dragged
into the Spaces Tree are placed in a flat hierarchy. See Figure 174 for an example.

5. Drag the folders to the space object in the Spaces Tree. The folders from the User View
become child objects of the space object you dropped the folder into.
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Figure 174: Dragging User View Folders into the Spaces Tree

6. Repeat Step 3 through Step 5 as necessary.
7. Click Save.
8. Go to Using Equipment Definitions.

Editing an Existing Space Object
Table 313 through Table 317 describe several methods to edit a single space object or multiple
space objects. For instructions on how to relabel multiple space objects simultaneously using
Microsoft Excel, see Updating Object Labels.
Table 313: Editing Space Object from the Spaces Tree
Step Description
1 Select and drop a space object from the Spaces tree to the Display panel.
2 The Spaces Tree and the space object attribute details appear in the Display panel. Click

Edit.
3 Modify the attributes of the space object as desired.
4 Click Save.

Table 314: Right-Click Menu from the Spaces Tree
Step Description
1 Right-click one or more space objects in the Spaces tree and click Modify. The Modify

dialog box appears. If you select multiple space objects, the Item tab in the Modify dialog
box lists the space objects selected.

2 Modify the attributes of the space object as desired.
3 Click Send. To view the results of the modify, ensure you select Show Modify Results

before clicking Send.
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Table 315: Find and Replace from the Spaces Tree Editor
Step Description
1 Open the Space Tree Editor (Facility > MUI Config > Edit Spaces Tree > ).
2 Select the Spaces in the tree on the left side of the panel.

Note: To select multiple Spaces in the tree, Ctrl+click multiple spaces individually or Shift+click
to select spaces sequentially.

3 Right-click your selections in the Spaces Tree and select Find and Replace.
4 Enter the criteria for the Find field and the Replace field. To replace all matching text, select

Matching Text. To replace all non-matching text, select Non-Matching Text.

Figure 175: Replace All

5 Click Replace All.
6 Click Save in the Spaces Tree Editor to save your changes to the Spaces tree.

Table 316: Global Modify Space Object from the Tailored Summary Viewer
Step Description
1 Create an SCT Summary Definition for spaces. For more information on SCT Summary

Definitions, see the Tailored Summary Viewer section.
If an SCT Summary Definition for spaces already exists, proceed to the next step.

2 Select multiple space objects from the Spaces tree. Click View > Tailored Summary Viewer.
Select the SCT Summary Definition for spaces in the Available Tailored Summaries list. The
Tailored Summary view of spaces appears.

3 Select multiple space objects from the Tailored Summary view of the spaces. Right-click
and select Modify.
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Table 316: Global Modify Space Object from the Tailored Summary Viewer
Step Description
4 Modify the attributes of the space objects as desired.

Figure 176: Example of Global Modify Multiple Space Objects from the Tailored
Summary Viewer

5 Click Send. To view the results of the modify, ensure you select Show Modify Results
before clicking Send.

Table 317: Single or Global Modify from Global Search Results
Step Description
1 Go to Query > Global Search.
2 Add a search location to the Search Location field. Click Add and select search locations

from the Select Item window and click OK.
Or, drop a search location to the Search Location field.

3 Enter the search criteria. For example, you can search the term building. Click Search.
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Table 317: Single or Global Modify from Global Search Results
Step Description
4 Right-click one or more spaces objects in the Global Search results and select Modify.

Figure 177: Example of Global Modify Multiple Space Objects from Global Search
Results

5 Click Send. To view the results of the modification, ensure you select Show Modify Results
before clicking Send.

Exporting Spaces
About this task:  
Exporting a space or spaces lets you share or quickly create spaces.

1. Go to Item > Export Item.
2. In the Export Archive wizard, select a space from the Spaces Tree tab.

Note:  You can export any space available. However, to import the space into an
archive, the ADS/ADX structure must be the same between the source archive and the
destination archive. The ADS/ADX name and version must be the same as well.

3. Follow the wizard screens. Click Finish.

Importing Spaces
About this task:  
Importing a space or spaces lets you share or quickly create spaces.

1. Go to Item > Import Item.
2. In the Import wizard, select the space to import. Click Import.
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Discover Equipment
Menu Selection: Facility > MUI Config > Discover Equipment
Opens Equipment Discovery.

Please note the following when using Equipment Discovery:
• Equipment Discovery Search Criteria searches the display name attribute of the points.
• If duplicate Instance numbers are created during Equipment Definition, it will cause issues for

Equipment Discovery.

Using Equipment Discovery
1. Click Facility > MUI Config > Discover Equipment.
2. Click the Browse icon to select an equipment definition for the equipment. The Select Item

window appears.
3. Select an equipment definition. Click OK.

Figure 178: Select Equipment Definition

4. In the All Items tree, select the engine or device (or multiple engines and devices). Drag the
engine or device to the Equipment Discovery pane.

Figure 179: Drag Engine or Device to Equipment Discovery
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5. If you have spaces created, create Served By relationships by clicking the Browse icon in the
Serving column. You can also drag a space object or equipment (or multiple space objects or
equipment) from the Spaces Tree into the Serving column.

6. Click Create. A message appears confirming you have successfully created equipment
objects.

7. Click OK. The equipment objects are now added to the Equipment folder in the All Items tree.

Figure 180: Created Equipment Objects

Equipment Object
An Equipment object is created through the Facility > MUI Config > Discover Equipment option and
through equipment discovery when creating Equipment Definitions. Equipment objects are listed in
the Equipment tree in SCT. This object contains attributes common to many Metasys system objects.
These common attributes are described in the Common Object Attributes section.

Note: In the Notes column, attributes marked with the letter C are configurable and attributes
marked with the letter W are writeable.

Table 318: Equipment Object – Focus/Configuration Tab
Attribute Name Data Type Notes Initial Value Values/Options/

Ranges
Name Text C Maximum length

of 400 characters
Description Text C Maximum length

of 64 characters
Object Type One type from a set C Equipment Undefined
Authorization
Category

One type from a set C HVAC HVAC, Fire,
Security, Services,
Administrative,
General Lighting,
Refrigeration,
Critical
Environment, Air
Quality, Power,
Energy, System
Custom 1–150

Served By List of C Listof[0]

Definition Link Reference C Blank or Object
Name and
Reference of
Equipment
Definition

Blank or Object
Name and
Reference of
Equipment
Definition
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Table 318: Equipment Object – Focus/Configuration Tab
Attribute Name Data Type Notes Initial Value Values/Options/

Ranges
Graphic Object Reference C W Blank or Object

Name and
Reference

Graphic Alias Reference Strings
(fully qualified
references)

Maximum 256
characters

Defining Equipment or Space Serving Relationships
About this task:  

Note:  If you are using Global Modify to edit serving relationships, understand that this
function replaces all serving relationships for the selected spaces or equipment. To add or
minimally edit serving or Served By relationships for spaces or equipment without replacing all
relationships, use the following procedure:

1. Go to the All Items tree.
2. Right-click the Equipment Definition for the equipment that needs a serving relationship.

Figure 181: Equipment Definition Action Menu

3. Select Open in Discovery. The Equipment Discovery window opens.
4. Go to the Spaces or Equipment Tree.
5. Select all spaces or equipment that need Served By relationships.
6. Drag the selected spaces to the Serving column of the Equipment Discovery window.
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Figure 182: Drag Spaces to Serving Column

7. Click Save.

Assigning Served By Relationships during Equipment Discovery
About this task:  

Tip: You can drag a space object or equipment (or multiple space objects or equipment) from
the Spaces Tree into the Serving column.

1. In the Equipment Discovery pane, add Served By relationships by clicking the Browse icon in
the Serving column. The Select Item window appears.

2. Click the Spaces tab and select a space object.
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Figure 183: Select Item

3. Click OK.
4. Repeat as necessary for all Served By relationships.

Assigning Spaces Served By Equipment Relationships
1. Go to the Spaces Tree.
2. Double-click to open the space in the panel and click Edit.
3. In the Equipment tree, select the serving equipment and drag it into the Space. The Served By

field is updated with the selected equipment.

4. Click Save.

Assigning Equipment Served By Equipment Relationships
1. Go to the Equipment Tree.
2. Double-click to open the equipment in the panel and click Edit.
3. In the Equipment tree, select the serving equipment and drag it into the Configuration tab's

Served By field.
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4. Click Save.

Auto-Discovery Serving Relationships
The Equipment Discovery window features auto-discovery capabilities to identify serving
relationships based on Equipment Name, Equipment Description, and Space Names matches.
Additional features, including Find and Replace and Serving Match Tolerance, assist in creating
serving relationships.
Equipment matched to Spaces in auto-discovery is determined in a contextual Space environment.
For example, the NxE parent must first match its Name or Description attribute to a Space Name.
Only then does the Serving auto-discovery take place for the field controller within that pre-
determined NxE associated space.
The equipment serving values are determined by a Fuzzy Search Tolerance value, which is used
in a fuzzy string matching algorithm between the three columns. This fuzzy search tolerance
value is set in the frameworkproperties.properties file located under C:\inetpub\wwwroot
\MetasysIII\ToolUI\com\jci\framework. The fuzzy search tolerance value needs to be
between 0.0 and 1.0—the smaller the number, the greater the number of incorrect matches that
may be returned. For example, a value of 0.0 matches any two strings, while a value of 1.0 only
matches identical strings. By default, the search tolerance is set to 0.95.
To identify serving relationships:
1. Click Facility > MUI Config > Discover Equipment.
2. In the All Items Tree, select one or more pieces of equipment you want to edit, and drag them

to the Equipment Discovery window.
3. Click the Browse icon to select the corresponding Equipment Definition for your equipment

selection and click OK. All fields of the Equipment Definition table populate due to auto-
discovery.

Find and Replace to Assist Auto-Discovery Serving Relationships
About this task:  
If serving relationship fields do not auto-discover:

1. Right-click the Equipment Name or Equipment Description column heading. Click Find and
Replace.

Note: To make single edits, select the individual equipment, right-click the Equipment
Name or Equipment Description column headings, and click Find and Replace (in
selection).
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2. The Find and Replace window appears. Enter the criteria for the Find field and the Replace
field. To replace all matching text, select Matching Text. To replace all non-matching text,
select Non-Matching Text.
Table 319: Find and Replace Search Criteria
Character Search Description and Application
An asterisk (*) Use before and after the search criteria text to search that portion of the

text. For example, *ZN-T*.
Use in the search criteria text lets you search for zero or more of any
character. For example, Z*-T returns results including ZN-T and ZONE-T.

A question
mark (?)

Use in the search criteria text to search for zero or one instance of any
character. For example, Hum?-C returns results including Hum1-C and
Hum-C.

A percent
symbol (%)

Use in the search criteria text to search for numerals 0 through 9. For
example, Hum%-C returns results including Hum1-C and Hum7-C. You can
enter multiple % to search for text that contains multiple numerals. For
example, Hum%%-C returns results including Hum26-C. This also matches
the percent symbol itself, such as in: % Humidity.

A pound sign
(#)

Use in the search criteria text to search for a string of one or more
numerals. For example, #BoxHtg-C returns results including 1BoxHtg-C
and 34BoxHtg-C. This search also matches the pound sign itself, such as in:
BLDG #1.

Normal Text Use in the search criteria to return results that match the characters exactly
without matching case. For example, zn-t returns results for ZN-T and zn-t.

3. Click Replace All.
4. Right-click the Serving column heading. Click Rediscover Spaces.
5. Repeat Steps 1 through 4 for each equipment that you wish to create serving relationships.

Serving Match Tolerance
The default value for Serving Match Tolerance is 0.95, which you can set in the
frameworkproperties.properties file located under C:\inetpub\wwwroot\MetasysIII
\ToolUI\com\jci\framework. The value needs to be between 0.0 and 1.0, where a smaller
number may return a greater number of incorrect matches.
Clicking Rediscover Spaces provides a slider bar for adjusting Serving Match Tolerance. The slider
bar has a range of 0% to 100% with a default value that correlates with the range of 0.0 to 1.0 and
the default value in the frameworkproperties.properties file.
If you are not satisfied with the results generated by following the Find and Replace to Assist
Auto-Discovery Serving Relationships workflow, follow these steps to adjust Serving Match
Tolerance.
1. Right-click on the Serving column heading or a row and select Rediscover Spaces.
2. Use Ctrl+click or Shift+click to select the rows that are missing the serving relationship.
3. Drag the value on the slider bar from the default. A smaller number increases the likelihood of

finding a new serving relationship, but may return a greater number of incorrect matches.
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Note: This changes default value for the active session. After logging out and
closing the SCT user interface, the default will revert to the value assigned in the
frameworkproperties.properties file.

4. When you release the slider bar, the software automatically rediscovers spaces and update the
Serving column. You may continue to change the value using the slider bar until satisfactory
relationships have been discovered.

Note: If you do not have rows selected when you release the slider the software
automatically rediscovers spaces for all rows.

Auto-Discovery Guidelines and Workflow

guidelines:
• Spaces must be created for auto-discovery to properly function; however, Served By

relationships do not need to be pre-defined.
• Field Controllers' name or description fields must contain the name of their associated

Space name.
• NAE description fields must contain the parent-space name. For example, the name must

include the building name or room names.
• Equipment Definition objects must have display points set up and checked out.

Follow these steps to use the NAE Drag and Drop feature of the Auto-Discovery Serving
Relationship.
1. On the Facility Menu, select Discover Equipment to complete the auto-discovery of equipment

and serving relationships.
2. Drag the NAEs into the Equipment Discovery window. Controllers with mapped points appear

in the table.
3. Check the list of controllers and remove any additional selections.
4. Right-click the Serving column heading and select Rediscover Spaces. Spaces that match the

NAE and controller description fields are auto-discovered and populated in the table.
5. Verify the Serving relationships, and if needed, add any additional space association manually.
6. Save the Equipment Discovery window.

Exporting Equipment
About this task:  
Exporting equipment lets you share or quickly create equipment.

1. Go to Item > Export Item.
2. In the Export Archive wizard, select the equipment from the Equipment tab.

Note: You can export any available equipment. However, to import the equipment into
an archive, the ADS structure of the source archive and the destination archive must be
identical. The ADS name and version must be the same as well.

Importing Equipment
About this task:  
Importing equipment lets you share or quickly create equipment.

1. Go to Item > Import Item.
2. In the Import wizard, select the equipment to import. Click Import.
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Changing Equipment's Equipment Definition
About this task:  

Note: When performing an Equipment Discovery Search, the criteria searches Username
attributes of the points.

1. Create or locate the equipment definition you would like the equipment to reference.
2. Using the equipment tab, find the equipment whose equipment definition you want to

change. You can select more than one equipment item by using Ctrl+click or Shift+click.
You can also use global search to find the equipment. Go to Global Search > Query. Search for
the equipment and then multi-select the equipment in the search results.

3. Right-click the selected equipment and click Modify.
4. In the Global Modify window, select the Definition link and click the Browse button. The

Select Item window appears.
5. Select the desired definition. Click OK.
6. Click Send.
7. In the All Items tree, right-click the newly referenced equipment definition and click Open in

Discovery.
8. Select the equipment you changed the equipment definition for and click Rediscover.
9. Click Save.

Find and Replace in Equipment Discovery

Table 320: Find and Replace in Equipment Discovery
Step Description
1 Click an Equipment Definition in the All Items Tree.
2 Open an Equipment Discovery (Facility > MUI Config > Discover Equipment).
3 Click the Add icon to add Field Controllers to the Equipment Discovery Window.
4 Click OK to populate the Equipment Discovery window.
5 For single edits:

Click one equipment object row, and then right-click the column heading to select Find
and Replace (in selection).
For multiple edits:
Ctrl+click or click and drag across one or more rows to create a selection. Then right-click
the column heading to select Find and Replace (in selection).
For full column edits:
Right-click the column heading and select Find and Replace.
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Table 320: Find and Replace in Equipment Discovery
Step Description
6 Enter the criteria for the Find field and the Replace field. To replace all matching text, select

Matching Text. To replace all non-matching text, select Non-Matching Text.

Figure 184: Replace All

7 Click Replace All.

Table 321: Find and Replace Search Criteria
Character Search Description and Application
An asterisk (*) Use before and after the search criteria text to search that portion of the text.

For example, *ZN-T*.
Use in the search criteria text lets you search for zero or more of any character.
For example, Z*-T returns results including ZN-T and ZONE-T.

A question
mark (?)

Use in the search criteria text to search for zero or one instance of any character.
For example, Hum?-C returns results including Hum1-C and Hum-C.

A percent
symbol (%)

Use in the search criteria text to search for numerals 0 through 9. For example,
Hum%-C returns results including Hum1-C and Hum7-C. You can enter multiple
% to search for text that contains multiple numerals. For example, Hum%%-C
returns results including Hum26-C. This also matches the percent symbol itself,
such as in: % Humidity.

A pound sign
(#)

Use in the search criteria text to search for a string of one or more numerals. For
example, #BoxHtg-C returns results including 1BoxHtg-C and 34BoxHtg-C. This
search also matches the pound sign itself, such as in: BLDG #1.

Normal Text Use in the search criteria to return results that match the characters exactly
without matching case. For example, zn-t returns results for ZN-T and zn-t.

Deleting Points from an Existing Equipment Definition
About this task:  
You are unable to remove and sort Display Points in equipment definitions because equipment
objects are discovered and linked to the equipment definition during creation. The following
procedure explains how to remove and sort Display Points from equipment definitions by first
removing the equipment objects.
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Figure 185: Remove and Sort Functions Grayed Out

1. Upload the ADS/ADX server with SCT.
2. Create a backup of the Archive database.
3. Right-click the equipment definition in the All Items tree and select Open in Discovery.
4. Take screen captures of the Equipment Name, Equipment Description, and Serving

relationships in the Equipment Discovery window.
5. Open each equipment object that you want to delete by double-clicking the equipment object

in the Equipment tree and take screen captures of the Served By relationships.

Figure 186: Screen Captured Served By Relationship for Reference

6. In the Equipment tree, select the equipment objects that you want to remove. Click
Edit > Delete Items, then click Continue.

7. Right-click the equipment definition in All Items tree and select Open in Discovery. Verify the
equipment objects have been removed.

8. Double-click the equipment definition in the All Items tree to show the Display Data points.
Click Edit.
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Figure 187: Display Data Points

9. The Remove and Sort icons are now available.
10. Sort and remove points in the Display Data list. Click Save.
11. Right-click the equipment definition and select Open in Discovery.
12. Discover the equipment objects that were deleted.
13. Create the Serving relationships that were deleted. Click Save.

Figure 188: Creating Serving Relationships

14. Refresh All Tabs, then open the Equipment tree.
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Figure 189: Refresh All Tabs

15. Double-click the new equipment object and create the Served By relationships that were
deleted.

Figure 190: Creating Served By Relationships

16. Download the ADS/ADX server with SCT.
17. Log in to the Metasys UI and verify your points have been removed or resorted.
18. Create a new backup of Archive database.

Adding Points to an existing Equipment Definition
1. Upload the ADS/ADX server with SCT.
2. Double-click the equipment definition in the All Items tree to show the Display Data points.

Click Edit.
3. Drag and drop the Display Data points you want from the All Items tree to the focus window.

Note: Points are sorted in the order they are added. If you need to resort points, see the
Deleting Points from an Existing Equipment Definition section.
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Figure 191: Adding Display Data Points

4. Select the check box for points you want in the bottom Display Data window that will
populate in the Metasys UI.

Note: Points appear in the Metasys UI in the order they are added to the bottom Display
Data window. If you need to resort points, then deselect the check boxes and select
them in the order you want.

5. Right-click the equipment definition in All Items tree and select Open in Discovery.
6. Use the horizontal scroll bar to find the columns with your new objects.
7. Use one or both of the following discovery options:

- If the point came from the same equipment as other points, right-click on the point
name header and select Rediscover Points.

Figure 192: Rediscover Points

- If the point came from different equipment or parent, select the  button and choose
the point manually in the Select Item wizard.

8. Click Save.
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9. Log in to the Metasys UI Offline to verify that your points have been added.

Note: You need to Download your changes from SCT to your ADS/ADX before they
appear in the Metasys UI.

10. Create a new backup of the Archive database.

Updating Object Labels
Use the Update Object Labels feature to update the display name and description attributes of the
following objects in an archive:

• Equipment
• Spaces
• Controllers
• Controller templates
• Equipment definitions

You can export each category of objects to a file, edit the file in a spreadsheet application such as
Microsoft Excel, and then import the file to update the archive. If you update an object's display
name attribute, its FQR is not altered, and no references or object relationships are changed.

Exporting Object Labels
1. Select Facility > Update Object Labels > Export to file. The Select Scope window appears.
2. Select the category of object labels to export, then click Open. The Create Spreadsheet

window appears.
3. Navigate to the location where you want to save the file, enter a file name, then click Export.
4. A dialog box appears confirming the export. Click OK.

Updating an Object Labels Export File
1. Open the exported file in Microsoft Excel.
2. In the New Name column, enter new names for any objects that you want to update. If you

leave a cell in the New Name column empty, the object is not relabeled.
3. In the Description column, modify the existing description or enter a new description.

Note: If you leave the New Name cell empty, an object's description field is not
updated. To update an object's description without changing the object's name, copy
the existing name to the New Name cell.

4. Click File, then click Save.
5. A dialog box appears warning that some features may be lost. Click Yes.

Importing Updated Object Labels
1. Select Facility > Update Object Labels > Import update file. The Select Spreadsheet to

Relabel objects window appears.
2. Navigate to the file location, select the file, then click Import.
3. A dialog box appears confirming the import. Click OK.

Updating point settings
Beginning at SCT Release 14.0 a semantic data point model is supported with a Metasys 11.0, or
later, site director. Using SCT 14.0 with Metasys 10.1 does not support this feature. Data point
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modelling facilitates sharing data and its meaning across applications and business processes
through simplified aggregation.
Use the Update Point Settings feature to update the following points in an archive:

• Internal ID - Do not modify
• Display Name - Do not modify
• Description - Do not modify
• Factory Shortnames - Do not modify
• Custom Shortnames

You can export point data to a file, edit the file in a spreadsheet application such as Microsoft Excel,
and then import the file to update the archive.

Exporting point settings
1. Select Facility > Update Point Settings > Export to file.
2. Navigate to the location where you want to save the file, enter a file name, then click Export.
3. A dialog box appears confirming the export. Click OK.

Updating a point settings export file
1. Open the exported file in Microsoft Excel.
2. Modify the Custom Shortname as required to include non-standard short names for your

site. Do not modify other information.
3. Save the file.
4. A dialog box appears warning that some features may be lost. Click Yes.

Importing updated point settings
1. Select Facility > Update Point Settings > Import updated file.
2. Navigate to the file location, select the file, then click Import.
3. A dialog box appears confirming the import. Click OK.

Graphics Association
Table 322 lists the types of graphics you can associate with the types of objects. In SCT, you can
associate graphics to a space object, equipment object, and field controller.
Table 322: Graphics Association by Type
Object Type Standard Graphic Using SCT Graphics+ Graphic Using SCT
Space Object Yes Yes
Equipment Object Yes Yes
Field Controller Yes Yes

You can associate multiple graphics of the same type or of varying types to each object or field
controller. If an object has multiple graphics associated with it, a count of the number of the
graphics appears in the Graphics widget.

Note: Do not place graphics in the Facility Graphics folder or folders nested within it in the All
Items tree. Graphics saved in this folder are Metasys UI graphics saved by the system that you
should not edit in SCT. Equipment and graphics are not viewable in SMP, therefore, the Facility
Graphics folder is not displayed in SMP.
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Figure 193: Facility Graphics Folders

At Metasys UI Release 2.1 and later, graphics associations can be managed in the Graphics Manager
of the Metasys UI and Metasys UI Offline. For more information, refer to the Metasys UI Offline Help
(LIT-12012116).

Associating Graphics+ Graphics

Note: In  Metasys® UI 2.1 and later, you can associate Graphics+ graphics to spaces or
equipment in the Graphics Manager of the Metasys UI or Metasys UI Offline. You can also
associate Metasys UI graphics to spaces, equipment, or Equipment Definitions. For more
information, refer to Metasys UI Help (LIT-12011953) or Metasys UI Offline Help (LIT-12012116).

Associating Graphics+ Graphics to a Space Object
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and Graphics+ graphics configured for the site.

Any graphics associations performed in SCT require a download to the ADS/ADX to view the
graphics in the Metasys UI. A download is not required to view the graphics in the Metasys UI Offline.

To associate a Graphics+ graphic to a Space object in SCT:

1. Select the Space object in the Spaces tree.
2. In the Configuration tab of the Space object, click Edit.
3. Select the Graphics+ graphic from the All Items tree. Drag the Graphics+ graphic to the

Graphic attribute field.

Note: You can have several graphics associated to a Space object.

4. Click Save.

Associating a Graphics+ Graphic to an Equipment Object
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and Graphics+ graphics configured for the site.

Any graphics associations performed in SCT require a download to the ADS/ADX to view the
graphics in the Metasys UI. A download is not required to view the graphics in the Metasys UI Offline.

To associate a Graphics+ graphic to an Equipment object in SCT:

1. Select the Equipment object in the Equipment tree.
2. In the Configuration tab of the Equipment object, click Edit.
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3. Select the Graphics+ graphic from the All Items tree. Drag the Graphics+ graphic to the
Graphic attribute field.

Note: You can have several graphics associated to an Equipment object.

4. Click Save.

Associating a Graphics+ Graphic to a Field Controller
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and Graphics+ graphics configured for the site.

Any graphics associations performed in SCT require a download to the ADS/ADX (and the engine,
if changes were made to the engine) to view the graphics in the Metasys UI. A download is not
required to view the graphics in the Metasys UI Offline.

To associate a Graphics+ graphic to field controller in SCT:

1. Select the field controller from the All Items tree.
2. In the Configuration tab of the field controller, click Edit.
3. Select the Graphics+ graphic from the All Items tree. Drag the Graphics+ graphic to the

Graphic attribute field.

Note: You can have several graphics associated to a field controller.

4. Click Save.

Associating Standard Graphics

Note: In Metasys® UI 2.1 and later, you can associate Standard graphics to spaces or
equipment in the Graphics Manager of the Metasys UI or Metasys UI Offline. You can also
associate Metasys UI graphics to spaces, equipment, or Equipment Definitions. For more
information, refer to Metasys UI Help (LIT-12011953) or Metasys UI Offline Help (LIT-12012116).

Associating a Standard Graphic to a Space Object
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and Standard graphics configured for the site.

Any graphics associations performed in SCT require a download to the ADS/ADX to view the
graphics in the Metasys UI. A download is not required to view the graphics in the Metasys UI Offline.

To associate a Standard graphic to a Space object in SCT:

1. Select the Space object in the Spaces tree.
2. In the Configuration tab of the Space object, click Edit.
3. Select the Standard graphic from the All Items tree. Drag the Standard graphic to the Graphic

attribute field.

Note: You can have several graphics associated to a Space object.

4. Click Save.

Associating a Standard Graphic to an Equipment Object
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and standard graphics configured for the site.
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Any graphics associations performed in SCT require a download to the ADS/ADX to view the
graphics in the Metasys UI. A download is not required to view the graphics in the Metasys UI Offline.

To associate a Standard graphic to an Equipment object in SCT:

1. Select the Equipment object in the Equipment tree.
2. If graphics are not already associated to device objects, then go to the Configuration tab of

the Equipment object and click Edit.
3. Select the Standard graphic from the All Items tree. Drag the Standard graphic to the Graphic

attribute field.

Note: You can have several graphics associated to an Equipment object.

4. Click Save.

Associating a Standard Graphic to a Field Controller
About this task:  
The following steps presume that you are logged into SCT and your archive has spaces, equipment,
Equipment Definitions, and Standard graphics configured for the site.

Any graphics associations performed in SCT require a download to the ADS/ADX (and the engine,
if changes were made to the engine) to view the graphics in the Metasys UI. A download is not
required to view the graphics in the Metasys UI Offline.

To associate a Standard graphic to field controller in SCT:

1. Select the field controller from the All Items tree.
2. In the Configuration tab of the field controller, click Edit.
3. Select the standard graphic from the All Items tree. Drag the standard graphic to the Graphic

attribute field.

Notes:
- Only one Standard graphic or Graphics+ graphic can be associated to a field

controller.
- If a graphic is associated to a field controller, you do not need to associate the

graphics to equipment that was derived from the controller.

4. Click Save.

Enabling Advanced Auditing
About this task:  
The Equipment Activity widget captures audits of commands performed by Schedule objects,
Multiple Command objects, and Interlock objects that are tied to equipment configured to the
Metasys UI. To use this feature, you must make sure that the Engine object is at Metasys Release
8.0 or later and the Enable Application Generated Audits attribute is set to True.

1. In SCT, open the Engine object's Configuration tab.
2. Select Advanced.
3. Click Edit.
4. Under the Audit Trail section, change the Enable Application Generated Audits value to True.
5. Click Save and perform a download to update the online configuration of the device.
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Query Menu

Global Search
The Global Search feature allows you to search the Metasys system for multiple items that meet
specific criteria based on naming and object type. Use global search to manage lists of objects,
which other features can use for commanding, trending, reporting, modification, and object
selection. For example, you can create a list of all discharge air temperatures for the AHU in a
building. Or, you can easily create new User Views and Summary Definitions by using drag and drop
to add items from the search window.
See Using Global Modify with Global Search in the Modify Dialog section for steps on using this
feature.

Global Search Overview
The Global Search feature allows you to search for objects from an entire site or from a portion of a
site (for example, one or more trunks or devices). Use the Global Search Viewer to add and remove
items from the search scope and search by object name and type. During a search, the items found
appear in the results table immediately, and the status bar shows the current search location. The
status bar also shows the number of items found.
With the Global Search feature, you can view information about multiple items at once. The Global
Search Viewer lets you view summary data for multiple objects and allows multiple selection for
Global Modifying.
See the Global Search Viewer Screen section.

Global Search Viewer Screen
You can access the Global Search Viewer from the Query Menu by selecting Global Search. The
Global Search Viewer opens in the Panel Layout of the Metasys System Configuration Tool.
You can have multiple Global Search Viewers open, but can only initiate one search at a time within
the same UI. If you try to start another search in the same UI, then an error message appears
stating that you must either stop the search in progress or wait until it completes before initiating
another search.
The Global Search feature displays 5,000 items by default and can be increased to 10,000 in user
preferences.
SCT does not support dynamic updating for search values with the Global Search feature. If the
search results reach the maximum number of items, then a message appears stating the current
search is too broad, and you should change the search criteria to narrow the search and try again.
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Figure 194: Global Search Viewer Screen

Table 323: Global Search Viewer Screen Components
Screen Area/Item Description
Instructions Area Provides tips to help you perform a search.
Search Locations List
Box

Lists the parts of the Metasys system navigation view you selected to
search.
When you initially invoke the Global Search feature, any items currently
selected in the navigation view appear in the Search Locations list box.
If no items are selected in the navigation view, then the box appears
blank. You can drag and drop items from the navigation trees into the
Search Locations List Box to make or change selections most efficiently.
You can also use the Add and Remove buttons to make or change
selections.
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Table 323: Global Search Viewer Screen Components
Screen Area/Item Description
Add Button Opens the Select Item dialog box and allows you to select the parts of

the system that you want to search. Though the preferred method to
make or change selections is the drag and drop functionality, you can
select items from available views (All Items tab or User View tabs)
depending on your user authorization.
You can search the entire site, one or more devices, one or more trunks
on a device, one or more User Views, and so on. Hold down the Ctrl or
Shift keys when clicking to select multiple items. After completing the
dialog box, the items you selected appear in the Select Scope box.

Remove Button Removes selected items from the Search Locations list box.
Object Name Box Allows you to type the full or partial name of the object you want to find.

You can leave it blank for a more expansive search. You also can use one
or more wildcards (* or ?) to aid in your search.
Wildcard Examples:

• LCP-2*
• ZN-T*
• OCC-S*
• N?E* (searches for all items named NAE*, NIE*, and so on)

The object name search is not case-sensitive.
The search looks at the Name attribute. For searches against user
navigation views, the search also considers the user-defined label
assigned to the item within that particular navigation view and includes
the item, if the Name attribute or label matches the search criteria for
object name.

Object Type Drop-Down
List

Allows you to select a specific type of object to search for or allows a
search for all object types. Options include:

• All (excluding extensions)
• Trend Extensions
• Totalization Extensions
• Alarm Extensions
• Schedules
• Calendars
• Field Devices
• Field Points

Include child objects
Check Box

Includes all child objects of any items found when searching the Search
Locations. That is, it includes the nested child objects.
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Table 323: Global Search Viewer Screen Components
Screen Area/Item Description
Include search location
objects Check Box

Includes the location items in the search results if they meet the search
criteria, as well as any items found when searching in those locations.
For example, if you initiate a search on an N2 Trunk named N2 Trunk
1 to search for all objects named *2*, and you check Include search
location objects, then the results include the N2 Trunk in the results. If
you do not check the option, then the search results only include items
under the N2 Trunk (along with their child objects, if the Include child
objects option was checked) and does not include the N2 Trunk itself.

Search Button Begins the search.
Stop Search Button Cancels a search in progress; no more new objects appear in the Search

Results table.
Search Results Table Displays the results of the search (object list).

• If you select an item in the Search Results and place your cursor
over the item within each column, then tooltips appear and
provides more information, if available.

• Any data that does not fit within the columns is identified by an
ellipsis (. . .). You can resize the column or place your cursor over
the table cell to see its tooltip text.

• If the search finds an object in more than one location (for
example, in the All Items navigation view and in a user navigation
view), then the object is listed twice in the Search Results Table. If
the same location is searched a second time or if search locations
overlap, then the object is not repeated in the table. Items are only
repeated in the table if their location differs.

See the Working with Search Results section for more information on
manipulating and using the table data.

Icon Column Displays the icon of the object as it appears in the navigation tree.
Name/Label Column Displays the name of the object as defined by its Name attribute. The

object’s full reference identifier appears in a tooltip when the cursor is
placed over the name.

Location Column Displays the object’s context, specifically its location within a particular
navigation view.

Type Column Displays the object’s type (for example, NAE55).
Select All Selects all rows in the Search Results table.
Clear List Removes all of the objects from the Search Results table.
Remove From List Removes selected objects from the Search Results table.
Add New Allows you to manually add one or more objects to existing search

results (where the added objects append to the bottom of the existing
Search Results table).

Copy to Clipboard Copies the selected search results in a tab-delimited format to the
Clipboard for pasting into other applications, such as Microsoft Excel®
or Word®.

Status Bar Displays the current location of the search in progress, the status of the
search, and the number of objects found.
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Query Menu Procedures

Performing a Global Search
About this task:  
To perform a global search:

1. From the Query Menu, select Global Search. The Global Search Viewer appears in a display
panel. Any items currently selected in the navigation view appear in the Search Locations list
box.

2. To add other areas to search, in the Search Locations section, click Add. The Select Item
dialog box appears.
Notes:

- You can also use the drag-and-drop feature to set search locations from objects in the All
Items tree.

- Any item you select in the All Items tree before you launch Global Search is added to the
Search Location.

Figure 195: Select Item Dialog Box

3. You can search the entire site, the All Items navigation tree, a User View, one or more devices,
one or more trunks on a device, and so on. Use the Ctrl or Shift keys when clicking to select
multiple items.

4. Click OK.

Note: To remove items from the Search Locations box, select the item and click Remove.

5. Select the Include child objects check box if you want to include all child objects of any items
found when searching the Search Locations.

6. Select the Include search location objects check box to include the Search Locations in the
results.

7. In the Object Name box, type the full or partial name of the object you want to find or leave it
blank. You can use one or more wildcards (* or ?) to aid in your search (for example, N?E*).
The object name search is not case-sensitive.
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8. From the Object Type menu, select the type of object to search or select All (excluding
extensions).

9. Click Search. The search begins and the Search Results table fills with any matching object
information. When finished, the status section displays Search Completed and the number of
objects found.

Result  

Note: If you rename an object, then you must remove the old name from the Search Locations
list before the object can appear in the results list under its new name.

See the Working with Search Results section.

Stopping a Search
To stop a running search, click Stop Search.

Working with Search Results

Selecting and Using the Search Results
Use the drag-and-drop functionality to add items from the Global Search Results table to a User
View, a Scheduled Items List, or the Action Tables of an Interlock or Multiple Command Object.
You can also use the Search Results with the Tailored Summary Viewer found in the View Menu.
Highlight the desired set of results from the list and follow these steps to use the drag-and-drop
functionality to apply the desired Summary Definition against the results set:
1. Click Edit in the User View or Tailored Summary Definition.
2. Drag items from the Search Results table to the User View or Tailored Summary Viewer.

You also can drag an item from the Global Search Results table and drop it into an empty display
panel to view the item or perform a Global Modify to the search results.

Selecting Objects in the Search Results
To select objects in the search results, click an individual object in the Search Results table or hold
down the Ctrl or Shift keys when clicking to select multiple items.
To select all of the search results, click Select All.

Note: Click and drag your cursor over objects in the Search Results table to select objects that
appear consecutively.

Removing Objects from the Search Results
1. Click an individual object in the Search Results table or hold down the Ctrl or Shift keys when

clicking to select multiple items.
2. Click Remove From List. The Confirm Delete dialog box appears asking if you want to delete

the selected item from the list.
3. Click Yes.

Note: You also can use the Delete key to remove selected objects from the Search
Results table.

Manually Adding Objects to Existing Search Results
About this task:  

Note: The added objects append to the bottom of the existing Search Results table.

1. Click Add New. The Select Item dialog box appears.
2. Select the object to add to the search results. Hold down the Ctrl or Shift keys when clicking to

select multiple items.
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3. Click OK.

Clearing All Search Results
1. Click Clear List. The Confirm Delete dialog box appears asking if you want to delete all the

items from the list.
2. Click Yes.

Sorting Search Results
To sort search results, click the heading of a column. The results sort and a small red triangle
appears indicating the order of the sort (ascending or descending). Click the column heading again
to change the sort order.

Expanding and Collapsing the Global Search Viewer Display Areas
To expand and collapse the Search Locations, Search Criteria, and Search Results table display areas
of the Global Search Viewer, click one of the splitter bar arrows located between the display areas to
show and hide the section. Continue to click until the desired display is achieved.

Figure 196: Splitter Bar Arrows Icon

Reordering Columns in the Search Results Table
To reorder the columns in the Search Results table, drag the heading of the column to the preferred
location.

Adding New Search Results to Existing Search Results
About this task:  
To add new search results to existing search results (where the results of the new search append to
the bottom of the existing Search Results table):

1. In the Search Locations box, remove the existing location, if desired, by selecting it and
clicking Remove. The existing search results remain in the Search Results table.

2. Perform Step 2 through Step 9 in the Performing a Global Search section to add the new
search criteria and execute the search. The results appear at the bottom of the Search Results
table.

Printing the Search Results Table
To print the Search Results table (object list), follow the Printing Specific Help Topics instructions.

Modifying Objects in the Search Results Table
1. Select one or more objects following the instructions in the Selecting Objects in the Search

Results section.
2. If you selected one object, then right-click and select Modify. The Modify dialog box appears.

If you selected two or more objects, right-click and select Modify. The Global Modify dialog
box appears. See the Modify Dialog section.

Copying Search Results to the Clipboard
1. Select the results according to the Selecting Objects in the Search Results section.
2. Click Copy to Clipboard.

Note: You also can use Ctrl+C to copy the data.

3. Open the program to paste the results (for example, Microsoft Excel or Word).
4. Paste the results according the program’s conventions (generally, Edit > Paste).
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Help Menu
The Metasys Help files provide shared system information and individualized, mode-dependent
information for the Metasys Site Management Portal (SMP) or the System Configuration Tool (SCT).
The Metasys SMP Help (LIT-1201973) and Open Data Server Help (LIT-12011942) provide information
about alarming, commanding, auditing live data values, and other online features. The Metasys
SCT Help (LIT-12011964) provides information about offline operations such as managing archives,
creating spaces, simulating systems, and establishing equipment and serving relationships.
In either SMP or SCT mode, the Metasys System Help menus provide Help files in PDF format. Refer
to the QuickLIT website for the most up-to-date version of the Metasys Help files.
For more information on the modes of operation, see Metasys Modes. For a description of the
Authorized Required column, see Authorized Menu Items.

Metasys Graphics Help
Menu Selection: Help > Metasys Graphics Help
Launches the Metasys Graphics+ Runtime Help.

Metasys Help
Menu Selection: Help > Metasys Help
Launches the Metasys System Help for the Site Management Portal User Interface.

SCT Help
Menu Selection: Help > SCT Help
Launches the Metasys SCT Help.
Starting at Release 10.0, you can also launch the Metasys SCT Help using the question mark icon
located in the upper right-hand corner in the Space Tree Editor, Modify Dialog, and All Items
Organizer windows of the Metasys SCT user interface. Click the icon to open the topic related
chapter of the Help PDF in a web browser.

Note: We recommend setting your default web browser to Goggle Chrome for proper
functionality of this feature.

Try New Version
Try New Version is the menu item that permits you to open the SCT Pro login screen from generic
SCT.
Select Try New Version > Dashboards to launch SCT Pro.

About Metasys
Menu Selection: Help > About Metasys
Displays the Metasys software version, UI version, Graphics+ runtime software version, copyright,
Metasys version compatibility, and UI version. Click Terms & Conditions to view terms and
conditions information.

Printing the Help

Printing the Entire Help System
About this task:  
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The entire Help system is available for printing in Adobe PDF format.

To print the entire Help system:

1. If necessary, download Adobe Reader® (required to view the PDF file) from the Adobe Reader
site.

2. Go to the QuickLIT Product Information website.
3. In the tree on the left, browse to Metasys System > General System Information.
4. On the right side of the window, click Metasys System Help (PDF format). The Help PDF

opens in Adobe Reader.
5. On the File menu of Adobe Reader, select Print.

Result  

Note: This file is large (approximately 800 pages). Allow adequate time for downloading and
printing.

Printing Specific Help Topics
About this task:  
To print a specific Help topic:

1. Click the Print button in the Help or click the Options button and select Print.
2. If the Contents tab is currently active, choose between printing the selected topic only or the

selected heading and all sub-topics. The content prints.
If another tab is active, select a printer and the Help prints the current content displayed on
the right side.

Result  

Note: Information in drop-down lists prints only if you have the list open on the screen. Pop-
up content does not print in the pop-up window.

SCT Troubleshooting
Table 324: Troubleshooting
Error or Error Message Description
SCT installer responds with:
PPKInitConsole.exe crash

Error typically occurs if IIS 5.0 is installed after
the .NET Framework. Uninstall .NET, IIS, and
SCT. Reinstall in the following order: IIS, .NET,
SCT.

SCT upgrade tool fails with the following archive
upgrade log error for a restored database:
In ConvertArchives: Error in reading
archive data for fixbuild1, Empty
Archive

Verify the name of the backup matches the
name of the archive. To verify the backup and
archive names match, log in to the Site Director.
The name at the top of the tree is the archive
name. Rename the SCT backup database to
match the archive name, restore the database,
and execute the archive upgrade again.

SCT: System Configuration Tool Help692

http://www.adobe.com/products/acrobat/readstep2.html
http://www.adobe.com/products/acrobat/readstep2.html
http://cgproducts.johnsoncontrols.com/default.aspx


Table 324: Troubleshooting
Error or Error Message Description
An SCT install fails to install on a
virtual machine and the SCT Install
Log references a timeout error for the
999_MetasysTranslationDictionary.sql
script.

Dynamic RAM of virtual environments can be
problematic with some SQL Server instances.
You can increase the MemToLeave on the
SQL server to 384mb. For more information on
memory errors refer to the Microsoft Knowledge
Base Article ID: 969962.
https://support.microsoft.com/en-us/
kb/969962?wa=wsignin1.0
If your issue persists after changing the
MemToLeave value see Microsoft Knowledge Base
Article ID: 956893 for Microsoft SQL Server virtual
environment support.
https://support.microsoft.com/en-us/
kb/956893

The SCT installed without error, but the SCT UI
window freezes or stalls while Java is loading.

A connection manager may be installed
on the computer. If present, uninstall the
connection manager. Refer to Microsoft
Knowledge Base Article ID: KB910435 (http://
support.microsoft.com/kb/910435).

SCT responds with:
You do not have permission to use the
System Configuration Tool

This error occurs when you attempt to log in to
the SCT without proper permissions assigned. If
you are an Active Directory user, then this error
occurs when attempting to start the SCT.
Verify that System Configuration Tool is
an assigned privilege for the user in the
System Access Permissions of the Security
Administrator System.

The Software Manager Notice dialog box
appears when you launch SCT.

To resolve this problem, complete the following
steps:
1. Open the Software Manager software

installed with SCT.
2. Validate SCT and your field controller

package files are listed with a Licensed
status.

3. If SCT or the field controller packages are
listed as Unlicensed, select Activate New
in the Choose Action drop-down list or
click the Add License button.

4. Follow the on-screen prompts through the
License Portal or upload an offline License
Activation File. When your software is
licensed, open the SCT software.

693SCT: System Configuration Tool Help

https://support.microsoft.com/en-us/kb/969962?wa=wsignin1.0
https://support.microsoft.com/en-us/kb/969962?wa=wsignin1.0
https://support.microsoft.com/en-us/kb/956893
https://support.microsoft.com/en-us/kb/956893
http://support.microsoft.com/kb/910435
http://support.microsoft.com/kb/910435


Table 324: Troubleshooting
Error or Error Message Description

A user may be denied access to the ADS/ADX/
OAS/ODS/SCT computer over the network. From
Control Panel > Administrative Tools, check the
Local Security Policy properties on the ADS/
ADX/OAS/ODS/SCT computer and make sure
that the user’s name is not listed under the User
Rights Assignment called Deny access to this
computer from the network.
An Active Directory user is denied access to
the SCT because their user name has not
been added to the MSEA-SSO user group on
the SCT computer. For details, refer to the
Security Administrator System Technical Bulletin
(LIT-1201528).
Verify the JRE proxy settings are disabled. To
verify proxy settings are disabled:

1. On the Start menu, select
Settings > Control Panel.

2. Select the Java icon. The Java Control Panel
appears.

3. Select the Proxies tab.
4. Click to clear the Use browser settings

check box.
5. Click OK.

SCT must be completely uninstalled. You may
also have to uninstall IIS 5.0 and the .NET
Framework. Reinstalling SCT should fix this
problem. If error messages output from the
Installer, then you may encounter issues at
runtime.

Login responds with:
Unable to Login. Unexpected Error.

If you change the ADS/ODS password, then you
must reboot your computer for the password
change in SCT to take effect.

SCT does not log in to allow HVAC PRO to load
despite already being logged in to the engine.
SCT (offline) allows you to log in and run HVAC
PRO, but you receive a ZSWHPRO crash when
you try to do anything over Passthru.

The Site Director is offline. Log in and verify it is
online.

HVAC PRO gives the item reference of the
engine, but fails to get any controllers and
causes ZSWHPRO.EXE to crash.

Only the second N2 Trunk is integrated.
Integrate the first N2 Trunk, even if it has no
controllers on it. You must integrate the first
N2 Trunk if N2 Trunk 2 is being used in HVAC
PRO, even if there are no devices on the first N2
trunk.
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Table 324: Troubleshooting
Error or Error Message Description
After patching SCT, the following window
appears when you attempt to open an archive:
This Archive needs to be upgraded to
the current version before it can be
opened. The upgrade can be monitored
through the Action Queue.

Click Upgrade Archive to upgrade the archive
to the current version.

The upgrade of an archive database fails. If an archive database upgrade fails, then the
database is in an unknown state. To recover,
open the database again. SCT detects the failed
upgrade and runs the restore process, which
overwrites the failed database with a copy of
the original database. After the restore process
is complete, open the archive database and
initiate the upgrade process again.

Downloading and uploading the database of an
NxE in SCT causes a Communication Error (521).

Check that the engine is online.

Downloading and uploading the database of an
engine in SCT causes a Communication Error
(521).

SCT is case sensitive for the names of the
engines. Create a new Supervisory device in SCT
and give it the exact same name of the engine.
For example, the name nae is different from
NAE in SCT.

Downloading/Uploading the database of an
engine in SCT causes a Communication Error
(521) or error (522).

This error occurs when the engine have domain
names defined for them, but the domain names
are not defined in SCT. When you define a new
Site or a new Supervisory device in SCT, you
must include the domain name as part of the
name (for example, NAE.cg.jci.com instead
of just NAE). It is also possible to use the IP
address of the device that the archive is being
taken from.

When downloading a device or server, one of
the following messages appears:
Communication Lost after Reset
Communication error (521)

This error may occur due to problems with
network connectivity or the unavailability of the
target devices. Check the following:

• The device (engine, ADS, ADX, or ODS) to
which you are downloading is powered,
operational, and has network connectivity
to the computer running SCT.

• In an ADX split configuration, both the
ADX web/application server and the
ADX database server are powered and
operational, and the ADX web/application
server has network connectivity to the
computer running SCT and to the ADX
database server.

695SCT: System Configuration Tool Help



Table 324: Troubleshooting
Error or Error Message Description
The SCT download freezes with the load status
of establishing communications. No error
message appears.

If this problem occurs while performing
downloads in the SCT, wait a few minutes
to allow the download to complete, and
then, refresh the SCT display. The updated
status message appears when the download
completes.
Notes:

• The amount of time it takes to download
depends on the size of the database but is
usually a few minutes.

• In addition, you can determine that the
database downloaded properly by waiting
for the device to come online after the
download completes.

The download seems to progress correctly,
but the SCT UI reports that the load still is
establishing communications. No errors appear.

This issue can occur at any Metasys release
and is a result of a problem with the ActionQ.
With this issue, the load executes successfully,
but the UI does not show the status of the
download correctly. If you suspect the download
is complete, then refresh the screen and verify
that the status of the download is complete.

You inadvertently download an ADS/ADX
database to an ODS, and receive the following
text within a View Status window message:
Version mismatch

Do not download an ADS/ADX database to an
ODS.

You perform a code download for SCT, the
download fails, and you receive the following
generic error text:
Communication Error (521)

This problem occurs when necessary
communication ports are not open to complete
proper software functionalities.
SCT functionality requires only port 80 needs
to be open; however, for increased efficiency,
an open port 9911 allows updates to complete
faster for devices on the same subnet.
The Device Debug Files retrieval and the Device
Discovery functionalities of SCT require the
opening of ports: 67, 68, 69, 80, 162, 9910, and
9911.

You perform a download to an OAS and receive
a Device Internal Error.

Check the Trunk Number attribute for any MS/
TP integrations on the OAS. Although you can
enter trunk number values of 1 and 2 in the SCT,
on an OAS these values are reserved for the USB
ports. Change all MS/TP trunk number values on
the OAS to 3 or above.

Download Code error. (12061) This error code response occurs in a variety of
scenarios. Go to the Archive Log for additional
information, or contact the nearest Johnson
Controls representative.
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Table 324: Troubleshooting
Error or Error Message Description
Download Code error. (34645) This error code response is displayed in the

ActionQ Completion Actions table when a
variety of error scenarios occur. See the
download code error scenarios in the following
table for some potential causes and solutions:
Potential Cause Solution
Unable to read MAC
address from device
Aborting code load
because no valid disk
image file found for
release

This error occurs
because the NAEs
images were not
extracted and placed
in their proper hard
disk location.

Needed socket is used
by another process.

Close the NAE Update
Tool if it is running to
open the socket.

Unexpected exception,
code download
aborted prematurely
Code download
aborted because
corresponding disk
image file is not found

See the solution for
aborting code load
above.

Please select an
Ethernet adapter from
the tools menu

On the Tools menu,
select the Select
Ethernet Adapter
option and select
the adapter through
which the Engine,
ADS, or ADX can be
communicated with.

Code download
aborted because the
NAE Update Tool is not
installed

Install the NAE
Update Tool before
performing code
download.

Engine has not made
a response to start an
update

Diagnose with the NCT
tool and reattempt.

Load Authorization
failed because unable
to login to load
destination for user:
MetasysSysAgent
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Table 324: Troubleshooting
Error or Error Message Description
After you perform a download to an engine at
Metasys Release 10.0, the engine reports as
offline to the Site Director.

Add the domain of the Site Director to the
Completion Domains attribute of the engine,
then perform the download again. See Engine
Attributes.

During the Upload process, an Upload Aborted
Error (512) occurs.

For SCT to upload a device such as an NCE with
an associated .caf file, CCT must be installed.

You use the Upload from Device option with
SCT for an NIE29, and receive the following
error:
File transfer error (524).
LoadApplication failed for MS-NIE29.
All the points and controller information are
represented in the UI, but the .caf file failed to
upload.

The NIE29 device is not available as a supported
supervisory device in the CCT.
As a workaround, configure the NIE29 as an
NCE25 in CCT. Preserve the CAF file of the NIE29
by first uploading the device files with a site
upload to the SCT. Using the site upload within
SCT prevents generating an error within the
process.

You use the Upload From Device option within
SCT and receive the following error:
Error uploading files for ADX01//
ADX01:ADX01: Upgrade the Site
Director before any devices. at
JohnsonControls. MetasysIII. ActionQ.
N50Upload. Upload()

Starting at Release 10.0, a Site Director's archive
defined software version must match the
physical version, or the upload fails. Uploads
no longer replace the defined archive device
version with the version of the physical device.

You perform an upload from a network engine,
the Action Queue reports that the process
completes successfully, but the site object and
engine are removed from the archive database.

The Site Director settings on a network engine
are different to the settings stored in the SCT
archive database for that engine. For example,
the network engine is configured as the Site
Director, but the network engine's Local Site
Director attribute references a different device.
To resolve this issue, complete the process to
demote the network engine. If the network
engine is a Release 10.0 or later then pair the
network engine with the new Site Director.
For more information, refer to the appropriate
section in the relevant commissioning guide. For
example, the Designating an NAE as a child of a
Site Director section of the NAE Commissioning
Guide (LIT-1201519).
Alternatively, to configure the network engine
as the Site Director, update the network
engine's Local Site Director attribute to
reference the network engine.

When you attempt to use one of the N2
Passthru tools, the following error message
appears:
Supervisory Device Offline

M-Tools may have been installed while running
the N2 Passthru. Shut down all active N2 Tools
and SCT. Reinstall SCT.
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Table 324: Troubleshooting
Error or Error Message Description
A DX9100 device may remain offline after exiting
the GX9100 Commissioning tool. This occurs
when the tool is run in passthru mode from an
ADS. In the engine, the DX9100 N2 Device tab
shows: Offline = True and Enabled = True

The GX9100 device is disabled at the GX9100.
To enable the GX9100 device, you must first
command the DX9100 N2 Device to Disable,
then command the DX9100 device to Enable.

N2 applications respond with no information, or
lock up.

Two N2 Passthru Applications may not run at
the same time when used in Passthru mode.
Close all of the N2 Passthru applications and
restart. Run one N2 Passthru application at a
time.
Date or time may be incorrect. Verify that
all dates and times are correct. For more
information, refer to Appendix: Time Zone,
Date, and Time Management in the ADS/ADX
Commissioning Guide (LIT-1201645) or ODS
Commissioning Guide (LIT-12011944).

When you attempt to execute any N2 Passthru
tool (for example, HVAC PRO) from the ADS,
ADX, ODS, or engine user interface, the
following error appears:
The Supervisory Controller does not
contain any supported devices.

Item name may be too long. See the HVAC PRO
Name Restrictions in Passthru Mode.

The N2DeviceLoader/LoaderUI
(LoaderUIG3.exe) crashes when you try to
connect to the site.

The error typically occurs when you have a
child engine listed above the Site Director.
When the child engine appears offline (with a
red or blue X), the N2DeviceLoader/LoaderUI
crashes. Right-click the offline engine and
choose Remove from Site.

Problems launching cTools from a passthrough
session using Windows 8 or Windows 7.

If the User Access Account is turned on, you
cannot launch any of the cTools from the
NxE, ADS, ODS, or SCT Field Device menu. The
applications do not launch.
If the User Access Account is turned off, then
the Field Device menu works correctly in SCT,
NxE, ADS, and ODS.
You need to create a Run as Administrator
function on the cTool applications that are
launched. You also should add a Run As
Administrator function to all the applications in
the Start Menu > Configuration Tools folder.

After trying to update the disk image on a
supervisory device, the following message
appears in the ActionQ View Status window:
Unexpected exception, code download
aborted prematurely. The update is
cancelled since all communication
failed.

The code download feature does not work if
the SCT computer is behind a Network Address
Translation (NAT) server, or you are running a
virtual machine with a network configured for
NAT access.
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Table 324: Troubleshooting
Error or Error Message Description
In SCT, device names start with sync_copy after
synchronizing databases.

The synchronization failed. This problem may
occur when the SCT computer disconnects
from the network before the synchronization
completes.
Under normal synchronization behavior, the
SCT creates a copy of your device database. For
example, a database named NAEname has a
copy called sync_copy_NAEname. Then, the SCT
creates a fresh copy of the database NAEname.
If a problem occurs with the synchronization
while SCT has control, then the SCT deletes the
fresh copy NAEname database and renames the
sync_copy_NAEname database to NAEname. No
data is lost.
When problems such as the SCT computer
disconnecting from the network before the
synchronization completes, both copies of the
database appear in the SCT.
To resolve sync_copy device databases:
1. Delete both the device and its

copy (for example, NAEname and
sync_copy_NAEname) from the SCT
database.

2. Upload the device (NAEname) if you have
only made changes in the online Site
Management Portal UI; otherwise, restore
the backup of the SCT database and
download the device.

Note: Make sure the SCT computer remains
running and online until the synchronization
process completes to prevent future failures.
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Table 324: Troubleshooting
Error or Error Message Description
In SCT, when trying to save a standard user
graphic from a restored database, the following
error appears:
Failed to communicate to the server or
device.

This problem occurs when the user graphic size
is over 4 MB, which is the default maximum
allowed size for a IIS message as defined by
Microsoft Corporation.
The workaround is to increase the default
size using the <httpRuntime> element in the
system.websection of the web.config file.
Change the values of the maxRequestLength
and executionTimeout attributes.

Note: maxRequestLength is defined as the
number of KB allowed, so the default is 4,096
KB (4 MB); executionTimeout is the number of
seconds until the request is killed.

For example, a maxRequestLength of 100 MB
and executionTimeout of 60 minutes appears
as follows (see the bold text in this sample
web.config file snippet):
 
... 
<configuration> 
<appSettings>  
<!-- The following settings are used by
 the GenericItem Capability. -->  
<add key="GenericItemDb.AssemblyName"
 value="C:\inetpub\wwwroot\MetasysIII
\Tool\bin\Subsystems.Database.dll"/>  
<add key="GenericItemDb.ClassName"
 value="JohnsonControls.MetasysIII.Databa
se.GenericItemDbFactory"/>  
...  
</appSettings>  
<system.web>  
<httpRuntime executionTimeout="3600"
 maxRequestLength="102400"/>   
</system.web>  
</configuration> 

Applications (including Windows tools such as
IIS Manager and Windows Event Viewer) do
not run with Administrative privileges even
though you are logged in to the computer as an
administrator.

Manually run the application as an
administrator:
Right-click the application and select Run As
Administrator.

When you are using Windows Authentication
to access a SQL database with SQL Server
Express Management Studio (or another user-
driven application), you do not have sysadmin
permissions in the SQL database even though
you are logged in to the computer as Built-in/
Administrators and have sysadmin permissions
in the SQL database.

Manually run the application as an
administrator:
Right-click the application and select Run As
Administrator.
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Table 324: Troubleshooting
Error or Error Message Description
You cannot view log files. To view the log files, manually run Windows

Explorer as an administrator:
Right-click the Windows Explorer icon and select
Run As Administrator.

You cannot access protected folders (such as
Program Data) even though you are logged in
to the computer as an administrator.

Manually run Windows Explorer as an
Administrator:
Right-click the Windows Explorer icon and select
Run As Administrator.

You cannot find the Add/Remove programs
option in Control Panel.

Add/Remove Programs is now called Programs
and Features. In Control Panel, select Control
Panel Home on the left-hand pane. Then, in the
right-hand pane, select Programs > Programs
and Features.

You cannot locate where to change the folder
settings, such as showing file extensions and
showing system files.

In Control Panel, select Appearance and
Personalization > Folder Options.

Note: This task is done on an individual user
basis.

The operating system does not prompt for your
consent or credentials.

This situation happens when you are logged
in as the built-in Administrator account. The
built-in Administrator account provides a
full administrator access token, unlike other
administrative users who are logged in with only
standard access tokens that require elevation to
perform administrative tasks. In Windows 8 and
Windows 7, the built-in Administrator account is
disabled.

You try to update the disk image on an NxE55
supervisory device, and receive the following
message in the View Status window:Code
update failed for <Site Director
Name:NxE55 Name>. Needed Socket is
used by another process. Close the NUT
if it is running.

The Code Download option requires that the
NAE/NIE Update Tool is not running at the same
time and on the same computer as the SCT.
Close the NAE/NIE Update Tool and try the
download again.
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Table 324: Troubleshooting
Error or Error Message Description
You use the Manage Archive wizard, attempt
to log in to a network engine, and then see the
following error:Could not retrieve the
classid for the online device. ClassID
is NO_CLASS.

If you use the NAE Update Tool to update a
Release 9.0 or earlier NIE55 to Release 10.0, you
must first use the ChangeModel tool to convert
the NIE55 to an NAE55. Otherwise the engine is
not assigned a valid ClassID.
To resolve this problem, complete the following
steps:
1. Use the NAE Update Tool to install a

Release 9.0 or earlier image on the NIE55.
For more information, refer to the NAE
Update Tool Help (LIT-12011524).

2. Use the ChangeModel tool to convert the
NIE55 to an NAE55. For more information,
refer to the ToggleTunnel and ChangeModel
Technical Bulletin (LIT-12011531).

3. Use the NAE Update Tool to install
a Release 10.0 or later image on the
converted network engine.

Modifying the ActionQueue.exe.config file
invalidates the SCT license.

To resolve the issue, restart the computer.

When you send Activate Pending Files to an
IP controller, SCT fails and you receive the
following error: Communication Error (521)
FieldControllerCommand : Apply Staged
Files for 0 Field Controllers. 0
completed, 0 failed

There are two possible solutions for this issue:

• Restart the SCT Action Queue.
• Use CCT instead of SCT to send Activate

Pending Files to an IP Controller. See
the Using the Activate Files option in
CCT in Controller Provisioning with Tools
(LIT-12013247) for instructions.

When you add an IP controller to an SCT archive,
the controller comes in without a model name,
vendor name, or firmware version and because
these are missing, does not allow the use of
trunk utilities. You receive the following error:
FieldControllersUpload: Fail (12062)
Model Name not found in SCT.

To solve this issue, use RAC to add the
controller.
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Appendix: Facility Explorer
This appendix contains information on how to use the SCT software within the Facility Explorer (FX)
system network. This appendix also contains links to the most relevant sections of the Help file.
Throughout this Help, the term Site Management Portal (SMP) refers, for Facility Explorer users, to
the user interface of the online F4-SNC Supervisory Controller. The Metasys system uses the word
Engine rather Supervisory Controller but these designations are interchangable. Finally, the term
Site Director means that device which is designated to maintain the site information, including
the logical organization of data about your facility, user password administrative information, and
overall master time and date.

Related Documentation
Table 325: SCT related documentation
For information on See document
SCT features, benefits, and requirements System Configuration Tool Catalog Page

(LIT-1900198)
Licensing SCT and field controller packages Software Manager Help (LIT-12012389)
General use of the Facility Explorer system, and
database backup/restore

Facility Explorer Site Management Portal Help
(LIT-12013520)

Commissioning the SNC F4-SNC Commissioning Guide (LIT-12013549)

uLearn training videos
uLearn training videos are available to anyone who wants to learn about how to use Johnson
Controls® products, including Facility Explorer software and tools such as SCT. Customers can
access these videos at this link: https://jcpublic.kzoplatform.com/library. Johnson Controls
employees can find the videos at this link: https://jc.kzoplatform.com/library.

SCT and supervisory device package licensing
You need to import the FX Field Controller Package Files and the Johnson Controls SA Bus Device
Packages files using the Software Manager, an application that is installed with SCT. For further
information on software licensing, refer to the Software Manager Help (LIT-12012389).
Once you obtain the supervisory device package, import the package by double-clicking on the
package collection .jcpkg file or use the Package Importer, located in the Start menu. The
Package Importer displays the message Finished importing when the import completes.
To license SCT software and supervisory packages, open the Software Manager from the Start
menu. To add a license, click Add License and then choose an activation method, either: Online
with a Product Key, or Offline with a License Activation File. Once added, SCT software and
supervisory device package licenses display in the License Inventory.
If SCT is licensed, the first time you open the application you must accept the End User License
Agreement before you can use SCT. If SCT is not licensed, the Software License Check displays
the following message: This software is currently unlicensed. Click the Open Software
Manager button to launch Software Manager and license SCT software.
If you do not license supervisory device packages, certain limitations occur:

• The transfer of CAFs to devices is disabled for unlicensed devices.
• Manage Archive operations are restricted through licensing. Upload, Download, Sync,

Upgrade, all are restricted.
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System Overview
The major components of the Facility Explorer system are:
SNC:
The SNC is a family of devices that supervise field controllers. The SNC combines the network
supervisor capabilities and IP network connectivity of an Supervisory Controller with the Input/
Output (I/O) point connectivity and direct digital control capabilities of a field controller. The SNC is
a cost-effective solution designed for central plants and large built-up air handler applications. All
SNC models include IP Ethernet network connectivity and the Site Management Portal. The F4-SNC
supports BACnet/IP and BACnet MS/TP communication protocol.
SCT:
You can use the System Configuration Tool in all phases of engineering, installing, and
commissioning of devices that make up the Facility Explorer SNC system. You can use the SCT
offline to create archive databases that can be downloaded to an F4-SNC. You can also use the SCT
to upload and archive databases that were created or edited online from an F4-SNC. With the SCT,
you can view and configure multiple sites in one archive.

Important: The term F4-SNC system references either a particular F4-SNC and its subordinate
devices or two or more F4-SNCs networked as peers. This definition does not include the FX
Servers or the FX80 supervisory controller as part of such a system.

SCT in a FX Network
The following shows SCT as part of an overall Facility Explorer network. The SCT is installed on, and
can be accessed by, a computer on the building network.

Figure 197: SCT as Part of a Facility Explorer Network

Prerequisite Software Checklist for SCT Installation
The computer operating system that you want to use for SCT software must have the proper
components installed. SCT software does not install or function correctly if any of these
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components is missing. The SCT Installation wizard verifies that the computer has these
prerequisites, but make sure you carefully review the software requirements listed in the
following table before you install SCT. The table also indicates where you can obtain each software
component. For detailed information about installing the SCT software, refer to the SCT Installation
and Upgrade Instructions (LIT-12012067).
Table 326: Prerequisite software checklist for SCT
Software component Where to obtain
Operating system (select one)
Windows®10 Pro and Windows 10 Enterprise Editions
versions 1903, 1909, and 2004 (64-bit). For all future
Windows 10 updates after version 2004, we will evaluate
and certify that Facility Explorer software can support the
updates before we provide guidance on support.
Windows® 8.1 Pro and Windows 8.1 Enterprise Editions
with Update (KB2919355) (64-bit)

Microsoft Corporation

Operating System (OS) components (select all)
Internet Information Services (IIS) (included with OS)
Microsoft Message Queuing (MSMQ)

OS media

Miscellaneous (select all)
Daylight Savings Time (DST) Patch for OSs http://www.microsoft.com/downloads
Microsoft .NET Framework 3.5 SP1 or 3.5.1
For Windows 8.1, Windows 8, Windows 7, Windows
Server 2012 R2, and Windows Server 2012, the required
Microsoft .NET Framework version is 3.5.1 and is built
into the operating system and installed as a Windows
component.

http://www.microsoft.com/downloads

Microsoft .NET Framework 4.6.1 SCT Media. Microsoft .NET Framework
4.6.1 is installed with the Facility
Explorer System Configuration Tool
Setup if it does not already exist on
the computer.

Database (select one)
• SQL Server 2019 Standard, Enterprise, and Express CU6 (64-bit)
• SQL Server 2017 Standard, Enterprise, and Express CU21 (64-bit)
• SQL Server 2016 Standard, Enterprise, and Express SP2 CU14 (64-bit)
• SQL Server 2014 Standard, Enterprise, and Express SP3 CU4 (64-bit)

Database Tools (select if required)
Microsoft SQL Server Management Studio Express

Launcher
The Launcher manages the SNCs and SCT computers at your facility and with it, you can access any
release of the F4-SNC system.
The Facility Explorer system relies on a private internal Java Runtime Engine (JRE) that is installed
when you download the Launcher application. This private JRE is not exposed to the same security
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risks as the public version of the JRE.To install the Launcher application, complete the following
steps:

1. Open your web browser and enter the URL for the Site Management Portal. The Windows
Launcher Download screen appears.

2. Click Full Launcher Installer to access SCT, which allows you to run or download the Launcher
installation file.

3. Click Run to start the installer. For more details, refer to the Launcher Installation Instructions
(LIT-12011783).

4. After installation, close the web browser. By default, the Launcher screen appears after
installation.

Launching and to log on to the SCT UI
To launch and log on to the SCT UI, complete these following steps:
1. On the SCT computer, double-click the Launcher icon on the computer desktop, or go to

Start > Programs > Johnson Controls >  Launcher. The Launcher application appears.
2. Click the SCT tab to launch the local application select localhost.

Figure 198: Local application select localhost

3. Select the device you want and click Launch. The Welcome screen appears.

Note: If the device is not listed, click Add to add the device that you want to use.

4. Type your user name and password.
5. If the Login to list box appears, choose your domain.
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Note: The Login to list box appears only if the Microsoft Active Directory service is
enabled. Refer to the Security Administrator System Technical Bulletin (LIT-1201528) for
details

6. Click Login.
7. If more than one archive database is available, the Open Archive window appears. Select the

desired database and click OK. The SCT screen appears.

Note: If only one archive database is available, the database automatically opens and the SCT
screen appears. If an archive database has not been created, the Create New Archive wizard
starts. See Creating a New Archive Database in this document.

Logging out
Save your changes before you log out. Logging out closes the Alarms window and all other open
windows except the login screen and Help. If your system is configured with a timed logout, the
system times out after a specific period of inactivity. For more information on exiting, see Exiting.
To log out, click the Logout button on the menu bar.

Note: If you are editing an item in a display panel, the Facility Explorer software cancels the
logout process and notifies you that you cannot exit or log out while in Edit mode. You must
exit Edit mode by saving or canceling your changes before you can log out of the application.

Exiting
Save changes before exiting. Exiting closes all open windows (except the Help) associated with the
session, including the Alarms Window and login screen. For more information on logging out, see
the Logging Out topic.
To exit, click the Exit button in the menu bar.

Note: If you are currently editing an item in a display panel, the Facility Explorer software
cancels the exit process and notifies you that you cannot exit or log out while in Edit mode. You
must exit Edit mode by saving or canceling your changes before you can exit the application.

Working in the SCT
Objects in the SCT user interface are now easily searchable in the navigation trees through the
Locate in Tree feature. The Locate in Tree feature displays the expanded Equipment, Spaces, or All
Items tree location for an object selected from the focus window.
To use this search feature, right-click one of the following object name locations and select Locate
in Tree:

• Global Search table rows
• An object's Focus window title bar

User Interface object icons and class IDs
The SCT user interface shows object icons in the All Items tree based on class IDs and use cases. For
example, some class IDs display differently if the device is a Site Director. If a class ID does not have
a designated icon, the default icon is used. See Table 4 for all class ID icons.

Important:
The table contains a number of icons that pertain solely to the Metasys system. These include the
NAE, NCE, and SNE Engine icons and the ADX/ODS/OAS Server icons.
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Navigation Tree
The navigation frame can display several navigation trees in offline mode (the All Items tree, the
Equipment tree, and the Spaces tree). The All Items tree is generated during system configuration
and represents the network layout of your system. You can add additional user-defined navigation
trees (also referred to as user views) that provide navigation capabilities for viewing particular parts
of your system.

Note: The navigation trees that appear for a particular user, including the All Items tree, are
defined by the system administrator when the user's access permissions are created.

Navigation trees support standard browsing concepts such as the plus sign (+) for expanding
items in the tree and the minus sign (-) for collapsing or hiding items in the tree. The maximum
number of items that you can nest under an item in the All Items tree is 7. User-defined trees have
no restrictions on the number of nested items.

Click the Detach icon  to detach the navigation frame. You can minimize and maximize the
navigation frame, but if you click the X button, the frame is restored to its default position.

Drag and drop
You can drag items into various content areas of the SCT. See Table 5 for a summary of the source
items and their destinations.

Navigating to an Item
To navigate to and select an item, click the plus (+) and minus (-) signs in the Navigation Tree to
expand and collapse folders until the desired item appears on the tree. Use the Ctrl or Shift key to
select multiple items.

Pop-up menus
Pop-up menus provide an efficient way to quickly access important item information. Pop-up
menus are also referred to as right-click menus. To access pop-up menus, right-click an item in the
Navigation Tree.
Content of the menu depends on the type of selected item and your level of authorization. For
example, point object pop-up menus usually show the options View, Command, Modify, and Show
Extensions. For Engines, pop-up menus usually show View, Event Viewer, Audit Viewer, Command,
Modify, Show Extensions, Alarm Report, Offline Report, Disabled Report, Operator Override Report,
Supervisory Override Report, Trouble Report, Out of Service Report, and Remove from Site.

Screen layout and frames
The screen contains four frames and provides a consistent look and feel in every mode (online or
offline). Your access to certain features depends on the mode in which you are operating and your
assigned access type and privileges. See Table 6 for further details on the UI screen frames

Items
The Facility Explorer system uses the term item as a generic reference to an object or selection in
the navigation tree. Items in the All Items navigation tree include the site, devices, control systems
(logic), graphics, objects, integrations, schedules, files, trend studies, field points, user-defined
navigation trees, and other system data. Each item can have another item under it, and so on as
the system hierarchy continues. Items have right-click pop-up menusthat provide commanding and
viewing options. A symbol represents each item in the navigation tree, and status symbols indicate
the status of each item.
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Status indicators
Status indicators show the status of items in the system on the user interface. For example, these
status indicators appear in the navigation tree, in a column on Summary views, and in a column
on the Global Search Viewer’s Search Results table. Also, a connection status indicator appears on
the SCT login screen and Main screen to denote the current security level of the certificate. If you
place the cursor over the icon, a tooltip appears to further describe the certificate. See Table 7 for
examples of the status indicators and the mode in which they may appear.

User-defined navigation trees
User-defined navigation trees (also referred to as user views, user navigation views, and user-
defined trees) allow you to organize items and folders for specific users or functions.

Display panel tabs
User-defined navigation trees (also referred to as user views, user navigation views, and user-
defined trees) allow you to organize items and folders for specific users or functions. See Table 8 for
a list of panel tabs found in most of the point objects.

Display panel buttons
Table 9 shows the display panel buttons.

Displaying information about an item
To display information about an item you selected in the navigation tree do one of the following
and click the desired tab:

• Drag and drop the item from the navigation tree into a display panel.
• Select an item in the navigation tree, open the View Menu, and click Selected Item. The data

displays in the default display frame.
• Double-click the item in the navigation tree; it displays in the default display panel.
• Right-click an item in the navigation tree or a feature in the display panel (such as Global

Search or a Tailored Summary) and select View.

Notes:
• When you display information in a panel that already contains data, the older data is

replaced and added to the panel history. To access up to five previously displayed items in
the panel history, click the back button in the display panel.

• If all available panels are locked and you try to display information about an item, a
message appears stating that all panels are locked. Click OK and unlock a panel to display
other item information.

Wizards
Wizards make complex tasks easy and guide you through creating and configuring objects and
features. A wizard typically consists of a series of steps, each corresponding to a screen presented
to the user.
A wizard may appear when you select an option from the Insert menu and when you prompt
certain actions such as copying and pasting an item in the Navigation Tree. For example, a wizard
appears when you select Object from the Insert menu.
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Wizard navigation buttons
See Table 10 for the buttons that are common to most of the wizards and allow you to move
through wizard screens.

Creating items with wizards
1. Select the item to create. The corresponding wizard appears. If more than one type of item is

available, select the desired type. Click Next.
- Select Action menu > Show Extensions to launch the Extension Wizard to create

extensions to objects that support them.
- Select Tools menu > Manage Archive to launch the Manage Archive Wizard within SCT.

The following options are available within the archive databases: Upload from Device,
Download to Device, Synchronize, and Upgrade Device. The Upload function has an
option to upload the CAF files of connected field controllers into the archive database.
The Download function has an option to download the code of the supervisory device.
The Upgrade Device function has an option to patch the supervisory device. Also, for
a network engine only, both the Upload and Download options have an option for
uploading and downloading certificates.

- Select Tools menu > Security Copy to launch the Security Copy Wizard within SCT.
- Select Tools menu > Database to launch the Restore Archive Wizard in the SCT.
- Select Insert menu > Site, Supervisory Device, Integration, Field Device, Field Point,

Folder, Control System, Object, Graphic, Trend Study, User View, or Summary
Definition to launch their respective wizards.

2. Complete the information on the wizard screens, using the navigation buttons to move
through the screens. The screens vary depending on the item you are creating. See the Using
Wizards section for information specific to each wizard.

Note: All items appear in the wizard, not just valid destinations. When you click an item
that is not a valid destination for the item being added, an error message appears on the
right side of the wizard and the Next button is disabled.

3. Select Finish on the summary page to create the item. If an error occurs, a message displays
and the wizard returns to the summary page. If the item supports extensions, the Extension
Wizard displays after the item is successfully created.

Right-click menus
The contents of the menus vary depending on the item or feature selected. The contents are
either feature-specific based on the active panel or item-specific based on the selected item in
the navigation tree. See Table 11 for menu items that may appear in a right-click menu and their
equivalent in the menu bar.

Object help
The Object Help describes each object in the system, the attributes of the objects, and the
characteristics and functions of each attribute. The Object Help provides detailed information
to aid in creating objects, entering values for configuring attributes, understanding how to read
attributes, and defining the interaction between objects in regard to the attributes. See the Object
Help section for further details.

Important: When referencing the SNC, the term 'Metasys system' within this section is
interchangable with the 'Facility Explorer' system.
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Software terms
Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted
services applicable to this product, if any, is subject to applicable end-user license, open-
source software information, and other terms set forth at www.johnsoncontrols.com/
techterms. Your use of this product constitutes an agreement to such terms.

Product warranty
This product is covered by a limited warranty, details of which can be found at
www.johnsoncontrols.com/buildingswarranty.

Patents
Patents: https://jcipat.com

Contact information
Contact your local branch office: www.johnsoncontrols.com/locations
Contact Johnson Controls: www.johnsoncontrols.com/contact-us

© 2021 Johnson Controls. All rights reserved. All specifications and other information shown were current as of document
revision and are subject to change without notice.
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